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1,2,3,4 (File Menu)

You can use the filenames listed near the bottom of the File menu to open one of the documents recently worked on. Choose the 
number or name that corresponds to the document you want to open. For more information, see Opening documents from disk.

Tip
You can change the number of files listed in the General Options.



About Xara Ltd
Xara was set up by Computer Concepts Ltd (UK) to develop Xara X. Computer Concepts have been developing mainstream 
application software since 1981. CC was one of the pioneer microcomputer software houses of the early eighties in the UK 
developing applications such as the Wordwise word processor which sold a quarter of a million copies. 

With over fifteen years of development experience, more than six of which have been developing 32-bit windowing based 
applications for RISC based computers, this has given us an unrivaled experience of developing microcomputer application 
software. This experience predates the arrival of 32-bit Windows based environments by many years. 

The arrival of 32-bit Windows programming environments (Windows 95, NT and Win32s) meant we could exploit that experience 
in the wider PC and Windows market, rather than the more niche markets we occupied before.

Web Links
Xara Home Page - www.xara.com    
Xara Ltd.    

Gaddesden Place, the mansion home of Xara Ltd.    

Xara Ltd.
Gaddesden Place
Hemel Hempstead
HP2 6EX
United Kingdom

Tel +44 1442 350000
Fax +44 1442 350010
Email info@xara.com



About Xara X (Help Menu)

About Xara X on the Help menu opens a dialog box containing the following information:
Xara X Version Number
Xara X Licensee
Licensee
Organization
Xara X Serial Number

For more information about Xara Ltd who developed Xara X, click here.



Add Folder Dialog Box

With the Add Folder dialog box you can add folders of your own clipart and fills to the Clipart Gallery and the Fill Gallery. You can 
also use this dialog to add the fonts on the CD to the Font Gallery. For more information, see Adding clipart to the clipart gallery or 
Adding fills to the fill gallery.

Add
Update
Find CD

_______________

{button ,KL(`galleries',0,`',`')}    Related topics



Add Folder Dialog Box - Add Button

Add inserts the selected folder into the gallery. If it contains an index and thumbnails a section (or sections) appears in the gallery 
showing the folder's contents. If the folder does not contain an index or thumbnails you are asked if you would like to create them.



Add Folder Dialog Box - Find CD Button

FindCD attempts to find the Xara X CD on your computer so you can add the folders of fonts, clipart and fills supplied on it.



Add Folder Dialog Box - Update Button

Update renews all the index and thumbnail information for a folder where necessary. This is generally most useful where you have 
changed files, added files to a folder or changed the CD in your CD drive and you want the updated images to appear in the 
gallery.



 Add Shapes (Arrange Menu) (Ctrl+1)

Add shapes turns the selected objects into a new, single shape. The new shape is much like a shadow of the original as it covers 
the entire area taken up by the combined objects. For more information, see Adding shapes.



Add more colors to a multi-stage fill

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow. You have full control over the colors used and where the colors change.

To add more colors to a multi-stage fill

This is the same as creating a multi-stage fill:
1. Select the object (see Selecting objects).
2. Choose the Fill Tool - this displays the Fill arrow.
3. Drag-and-drop colors from the Color Line or Color Gallery onto the Fill arrow (see Notes.)

Notes:
Conical fills have a semicircular Fill arrow. Other fill types have straight Fill arrows. Always drag-and-drop colors onto the 

arrow.
Elliptical and Diamond fills have a pair of Fill arrows. You can apply colors to only one of these arrows. (The arrow that 

was horizontal when you created the fill - this is the "primary" arrow.)
The Selector Tool can also display the Fill arrow. See Enabling fill handles.

Movies

{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________
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Creating multi-stage fills
Changing multi-stage fills
Fill Tool



Adding a lighting highlight to a drawing

If you want to draw a picture of a shiny 3D object in most drawing programs you have to draw highlights as part of the object. Xara 
X makes this much easier as you can draw a separate object for the highlight. Then you can use transparency to modify the colors 
of the dull object underneath.

To add a lighting highlight
1. Create your drawing without the highlights. (The drawing should look matt and dull.) Include enough shading and shadows so 

that the object looks three-dimensional.
2. Decide where a light source would bounce off the object into the viewer's eye and draw a shape over that area. Set the color of 

the object to the color of the light source (see Tips).
3. Using the Transparency Tool, apply a suitable transparency. See Applying transparency.

Tips
The most realistic highlights are achieved by either using linear fills and circular fills in the highlight object or drawing 

several highlight objects and blending them together (see Blending objects). You can alter the color of the light source producing the 
highlights by altering the fill color of the transparent highlight objects.

White highlight objects look as if the light source is white. Slightly yellow highlights look as if the light source is the sun. 
Orange highlights can make the object look as if it's being viewed at sunset.

_______________
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Adding an outline to a bitmap

You can easily add an outline to a bitmap in any color with any thickness. To add the outline, you need to convert the bitmap into a 
rectangular shape with a bitmap fill, you can then change the outline of the rectangular shape as you would normally.

To add an outline to a bitmap
1. Select the bitmap (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes. This converts your bitmap into a rectangle filled with the original 

bitmap.
3. Right-click on the outline color you want on the Color Line. See Changing an object's line color.
4. Choose a line thickness from the line thickness drop-down list on the control bars. For more information, see Changing line 

thicknesses.



Adding arrowheads to lines

The Line Gallery contains several styles and sizes of arrowheads and tails. The size of arrowheads and tails is relative to the line 
width. Making the line thicker automatically makes the arrowhead or tail bigger.

To add an arrowhead to a line
1. Select the line (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the Arrowheads section.
4. Double-click on the arrowhead or tail in the gallery.

Tips
Double-clicking on an arrowhead applies it to the end of the line. Double-clicking a tail applies it to the start of the line. To 

apply to the other end of the line, hold down CTRL and double-click. Alternatively you can reverse the line direction.
You can also drag-and-drop an arrowhead or tail from the gallery onto the start or end of any line (selected or unselected).
Arrowheads are the same color as the line. Making the line invisible, also makes any arrowheads on the line invisible.

Note:
You cannot apply arrowheads to a line with a brush or stroke shape already applied. 

_______________
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Adding clipart to the clipart gallery

You can easily add folders of your own clipart to the Clipart Gallery. The Clipart Gallery automatically creates thumbnail images for 
any folder containing graphics files so you can see your files in the gallery. You can add both vector and bitmap files to the Clipart 
Gallery. Once you have added a folder of files to the gallery, you can add more files to the folder, see Adding files to a gallery.

To add a folder of clipart to the clipart gallery
1. Copy the files you want to add to a folder.
2. From the Utilities menu, choose Clipart Gallery.
3. Click the Disk Clipart button to open the Add Folder dialog box.
4. Browse until you reach the folder.
5. Click Add.

Xara X creates thumbnails for each of the files and places them in a folder called XaraInfo. If you add clipart from a CD other than 
the Xara X CD, the XaraInfo folder is placed in your temporary folder.

Tips
If you want to add the clipart from the Xara X CD to the Clipart Gallery, follow the instructions above and browse to the 

"clipart" folder on the CD.
You can add keywords, titles and descriptions to your clipart which is displayed in the Clipart Gallery. See Adding titles, 

descriptions and keywords to documents.
You can add a PhotoCD of images to the Clipart Gallery. See Importing PhotoCD files.

Movie

{button ,EF(`xarademo.exe',`ClipGal Clipart Gallery',1,`')} Clipart Gallery

_______________
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Adding curved corners to polygons

Polygons created using the QuickShape Tool can have either sharp or rounded corners. After choosing rounded corners, you can 
change the radius of the corners to increase or decrease the curvature. For more details on changing the curved corners, see 
Changing curved corners on a polygon.

To add curved corners to a polygon
1. Select the polygon (see Selecting objects).
2. Choose the QuickShape Tool.
3. Click the Curved Corners button on the QuickShape Tool Infobar.

To remove curved corners, click Curved Corners again.

Tips
You can also apply curved corners to star-shaped polygons.
You can also make the corners rounded by double-clicking on the corner.

_______________
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Adding curved corners to rectangles

Rectangles created using the Rectangle or QuickShape Tool can have either square or rounded corners. After choosing rounded 
corners, you can change the radius of the corners to increase or decrease the curvature. For more details, see Changing curved 
corners on a rectangle.

To add curved corners to a rectangle
1. Select the rectangle (see Selecting objects).
2. Choose the Rectangle Tool or the QuickShape Tool.
3. Click the Curved Corners button on the QuickShape Tool Infobar.

To remove curved corners, click Curved Corners again.

Tip
You can also make the corners rounded by double-clicking on the corner.

_______________

Related Topic

Rectangle Tool

QuickShape Tool

Rectangles

Squares



Adding dash patterns to lines

The Line Gallery includes a wide range of dash patterns that you can apply to lines and the outlines of shapes.
To add a dash pattern to a line

1. Select the line or shape (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the Dash Patterns section.
4. Double click on a dash pattern.

Tip
You can also drag-and-drop a dash pattern from the gallery onto any line or shape (selected or unselected).

Note:
You cannot apply a dash pattern to a line with a brush or stroke shape already applied. 

_______________
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Adding files to a gallery

Once you have added a folder of files to the Clipart Gallery or the Fill Gallery, you can add more files.
To add files to a gallery

1. Copy the files to the appropriate folder.
2. From the Utilities menu, choose Clipart Gallery or Fill Gallery.
3. Click the Disk Clipart or Disk Fills button (as appropriate) to open the Add Folder dialog box.
4. Browse to the folder.
5. Click the Update button.

Notes
Clicking Add does not include the new files in the gallery. You must use Update.
For details on adding folders to these galleries, see Adding clipart to the clipart gallery and Adding fills to the fill gallery.

_______________
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Adding fills to the fill gallery

You can easily add folders of your own bitmaps to the Fill Gallery so you can use them as bitmap fills. The Fill Gallery 
automatically creates thumbnail images for any folder containing bitmap files so you can see your files in the gallery. You can only 
add bitmap files to the Fill Gallery, not vector files. Once you have added a folder of files to a gallery, you can add more files, see 
Adding files to a gallery.

To add a folder of bitmaps to the fill gallery
1. Copy the bitmaps you want to add to the gallery to a folder.
2. From the Utilities menu, choose Fill Gallery.
3. Click the Disk Fills button to open the Add Folder dialog box.
4. Browse to the folder containing the bitmaps.
5. Click the Add button.

Xara X creates thumbnails for each of the bitmaps and places them in a folder called XaraInfo. If you add bitmaps from a CD other 
than the Xara X CD, the XaraInfo folder is placed in your temporary folder as it cannot be written to the CD.

Tips
If you want to add the fills from the CD to the Fill Gallery, follow the instructions above and browse to the "fills" folder on 

the CD.
You can add a PhotoCD of images to the Fill Gallery. See Importing PhotoCD files.

_______________
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Adding points to lines and shapes

When you have drawn a line or shape, you can add extra point handles to it.
To add points to lines and shapes

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool or the Pen Tool.
3. Click on the line to add a new point handle. Important: click on the line. Don't drag it - this reshapes the line.

Click to add a point handle

Movies

{button ,EF("XaraDemo.exe","CurvEdit Editing Lines and Shapes with the Shape Editor Tool",1,`') } Editing lines with the 
Shape Editor Tool

{button ,EF("XaraDemo.exe","PenEdit Editing Lines and Shapes with the Pen Tool",1,`') } Editing lines with the Pen Tool

_______________
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Shape Editor Tool

Pen Tool



Adding shapes

You add objects together to combine then into a single shape. The new shape covers the same area as all the objects you added.

To add objects together
1. Select the objects (see Selecting objects).
2. From the Combine Shapes submenu on the Arrange Menu, choose Add Shapes (or press CTRL+1).

Tips
The new shape uses the colors, line width and other attributes of the top shape. You can change the stacking order of 

objects. For details see Moving objects backwards and forward.
You can use all object types including bitmaps.

_______________
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Combining

Moving objects backwards and forwards



Adding titles, descriptions and keywords to documents

You can add a title, description and keywords to your drawings document. If the files are then added to the Clipart Gallery this 
information is used during searches and for displaying the document in the gallery. 

To add titles, descriptions and keywords to documents

You enter the information in the Comment field of the Document Info dialog box. The first line of the Comment field is taken as a 
description of the file, unless it starts 'KEY:' or 'TITLE:' in which case the item is assumed not to have a description.

If a line starts with 'TITLE:' the rest of the line is taken as the title for the drawing. If a line starts with 'KEY:' the rest of the line is 
taken as a list of keywords separated by commas or vertical bars ('|'). For example, a picture of a dog might contain the following 
information in the Comments section of the Document info dialog box (<ENTER> is where the user would have pressed 
<ENTER>): 

A large great dane<ENTER>
KEY:Dog,Large,Animal,Mammal<ENTER>
TITLE:Great dane

Note
 Comments are only added to the indexes when creating or updating them. Only .XAR & .WEB files are checked for these 

comments. 



Adding web addresses to objects

You can add a web address attribute to any object. You can then use these addresses to create an image map.
To add a web address to an object

1. Select the object (see Selecting objects). You can select more than one.
2. From the Utilities menu, choose Web Address.
3. Type in the web address (URL).
4. Click Add (or Change if the object already has a web address).

For details on what web addresses look like and how they work, see the Web Address Overview.

Tips
You can create navigation bars using the Button & NavBar Tool. These let you navigate between web pages by clicking 

the buttons. If you add web addresses to the buttons, these are used in the HTML created when exporting the buttons. For more 
information see Creating Navigation Bars.

You can add a web address to an object quickly by right-clicking on the object to open the pop-up menu and choosing 
Web Address.

You can add a web address to any type of object.
Xara X does not check the validity of web addresses you type in.
You can create an invisible object with a web address which still works when you click on it. Just make the object 100% 

transparent.
If you add a web address to text it usually best to assign the web address to the rectangle surrounding the text so you can 

click anywhere over the text to activate the link.

Movies

{button ,EF("XaraDemo.exe",`WebAdd Assigning Web Addresses',1,`') } Creating hot-spots

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps

_______________
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Web address overview
Removing web addresses
Image map overview



Aligning and distributing objects

You can easily move objects on the page so they are aligned along an edge or their center. You can also move objects so they are 
distributed across the page or between other objects.

To align or distribute objects
1. Select all the objects you want to move.
2. From the Arrange menu, choose Alignment.
3. In the dialog box, choose whether you want to move the objects within the bounding box of the selection, the page or the spread 

(if you have more than one page).
4. From the Vertical Position drop-down list, choose how you want the objects to move vertically.
5. From the Horizontal Position drop-down list, choose how you want the objects to move vertically.
6. When the diagram at the top of the dialog box shows what you want, click Apply.

Movie

{button ,EF("XaraDemo.exe","AlgnDist Aligning and Distributing Objects",1,`') } Aligning and distributing objects

Tips
For more information on the options available, click the Help button in the dialog box.
You can quickly align the selected objects to an edge or corner by clicking in the upper part of the Alignment dialog box.



Aligning text on a curve

If you type several lines of text on a curve, the text slopes following the angle of the the start of the curve. You can control the 
direction the edge of the text follows by adding a very small segment onto the start or end of the curve.

To align text on a curve
1. Draw the curve you want the text to follow.
2. Zoom in to the end of the line, preferably to maximum zoom level.
3. Choose the Shape Editor Tool.
4. Click on the end point handle on the curve to select it.
5. Click the Straight Lines button on the Shape Editor Tool Infobar.
6. Click to create a new, very short line segment. This line segment should be perpendicular to the direction you want the left-

hand edge of the text block to follow. If you need the segment to be exactly horizontal or vertical, CTRL-drag the new point.
7. Now type the text on the curve as normal.

_______________

Related Topics

Drawing Lines
Fitting text to a line
Shape Editor Tool



Aligning the centers of QuickShapes

If you draw two or more QuickShapes, you can move them so their centers are exactly on top of each other.
To align the centers of QuickShapes

1. From the Window menu, choose Snap To Objects.
2. Drag the QuickShape by the cross in its center over the point you wish to align it with. The center locks onto the edges of all 

objects and the centers of QuickShapes.

_______________
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    Alignment (Arrange Menu)
 CTRL+SHIFT+L

You can use the Alignment dialog box to align and distribute the selected objects The two drop-down lists allow you to set how the objects are moved horizontally and vertically. The diagram at the top shows how the objects will move.

The options in the 'Within' section allow you to set whether the objects move relative to the boundary of the selected objects (the bounding box), the page or the spread (a pair of pages). For example, if you select "Align Left" and have the Within Page(s) option set, the objects move so their left edges all rest on the left hand side of the page. For more details, see Aligning objects.

You can quickly align the selected objects to an edge or corner by clicking in the upper part of the dialog box.

Horizontal Positions

No Change leaves the objects in the same horizontal position.

Align Left moves the objects so their left hand edges are aligned vertically.
Align Center moves the objects so their centers are aligned vertically. 
Align Right moves the objects so their right hand edges are aligned vertically.
Distribute Left Edges moves the objects so their left edges are evenly spaced horizontally.
Distribute Centers moves the objects so their centers are evenly spaced horizontally.
Distribute Right Edges moves the objects so their right hand edges are evenly spaced horizontally.
Distribute Equi-spaced moves the objects so the spacing between them is even horizontally.

Vertical Positions

No Change leaves the objects in the same vertical position.
Align Bottom moves the objects so their bottom edges are aligned horizontally.
Align Centrally moves the objects so their centers are aligned horizontally.
Align Top moves the objects so their top edges are aligned horizontally.
Distribute Bottom Edges moves the objects so their bottom edges are evenly spaced vertically.
Distribute Centers moves the objects so their centers are evenly spaced vertically.
Distribute Top Edges moves the objects so their top edges are evenly space vertically.
Distribute Equi-spaced moves the objects so the spacing between them is even vertically.



Altering point handles

The join of two curved line segments can be either smooth or sharp (a sharp join is sometimes called a cusp join). If a point handle 
is sharp, you can control the two curve handles independently. If it is a smooth point, the curve handles move together.

To alter point handles

1. If necessary, select the line (see Selecting objects).

2. Choose the Shape Editor Tool.

3. Select the point handle by clicking on it.

4. Click the Sharp Point button or the Smooth Point button on the Shape Editor Tool Infobar. Note that clicking Sharp point does not reshape the line but you can now move the curve handles independently.

Tips

You can quickly swap the state of a point handle by double clicking it.

You can select several points and then change the join shape in one operation (see Selecting Several Point Handles).

With the Shape Editor Tool, you can also press Z to make the point a sharp join or S for a smooth join.

CTRL-clicking Sharp point reshapes the line to show a sharp point. Note that this is the opposite of how clicking and CTRL-clicking worked in CorelXARA.

_______________
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Alternative names

The page lists some names used by other programs and the equivalent names used in this program.

Drawings called Document

Fountain Fills called Fills

Radial Fills called Circular Fills

Visual Selectors called Color Models

Shearing called Skewing

In-betweening called Blends

Interpolation called Blends

Morphing called Blends

Tweening called Blends

Active Layer called Current Layer

Inter-line Spacing called Line Spacing



Always on Top

Always On Top is available from the Document Control Menu. If Always On Top is selected for a view, it always remains on top 
of all other views. This could be used, for example, to edit one view of a document with a smaller higher Quality view set to always 
be on top. The edits made in the first, larger view would be reflected in the smaller view which would always be visible.



Animated GIF Export Dialog Box

With the Animated GIF dialog box you can choose how your animated GIF files are created. 

Note that there is an easier way to create animated GIFs using the Frame Gallery. For information see Creating animated GIF 
files.

Bitmap Size
Color Depth
Interlacing
Transparency
Palette
Dithering
Animation Delay
Animation Restore
Animation Loop

_______________
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Animated GIF Export Dialog Box - Animation Delay

This option sets the time delay between frames in the animation. The units are hundredths of a second, so if you want a delay of a 
second between each frame, enter a value of 100. Many browsers display the frames quite slowly and may not be able to keep up 
with the value you set.



Animated GIF Export Dialog Box - Animation Loop

This value defines the number of times the animation repeats. If you enter a value of zero, the animation loops continuously.



Animated GIF Export Dialog Box - Animation Restore

This sets what happens after each frame has been displayed. Nothing means no action is taken, though many Internet browsers 
take this as meaning the same as the Background option. Leave As Is displays the frames one on top of another - this leaves 
many frames visible in a stack if some are transparent. Background restores the area covered by the graphic to the background 
color of the GIF (except where the frame is transparent). Restore Previous restores the area covered by the frame to what it was 
before the frame was displayed.

Note that the way browsers interpret these values can vary, you may need to experiment to achieve the desired result.



Animation (Utilities Menu) 

This option is dimmed for Drawing documents. It displays a submenu of animation options:
Animation Properties
Preview All Frames
Preview Animation in Browser



Animation Properties (Utilities Menu)

This option is dimmed for Drawing documents.

With this dialog box you can change the options for the animation and for each frame. The dialog box has several sections:
Frame
Animation Colors
Animation Loop and Speed
Preview in Browser



Animation Properties Dialog Box - Animation Colors

Palette Colors

Global Browser Palette uses the 216 colors of the Netscape Navigator/Internet Explorer palette. This is probably gives the best 
results for graphics that use a lot of colors and that you want to display in a browser.

Global Optimized Palette is best for graphics that use relatively few colors. You can specify how many colors to include in the 
graphic. You may need to experiment to get the best results. This option usually gives the smallest file size.

Optimized Palette per Frame often gives the best results as the palette includes the best colors for each frame. You can specify 
how many colors are included in each palette. Because each frame has its own palette, this option can produce the largest files.

There is an issue with Optimized palette per frame with Macintosh web browsers. Unfortunately they all seem to have a serious 
bug that prevents per frame optimization working. If you know your audience consists of Mac viewers then we advise you not to 
use per frame palette optimization.

Number of colors in palette

(This option is available only when using optimized palettes.) For simple graphics you can reduce the number of colors in the 
palette. This can produce much smaller files without losing quality. You may need to experiment to find the right balance between 
file size and quality.

Dithering

You can select between three types of dithering with these options. Choosing None means there no dithering, Ordered uses an 
ordered (regular) dithering pattern and Error diffusion uses error-diffused dithering (a more complex dithering technique). In 
general, Error diffusion gives the best results, but to only use dithering when really necessary as it prevents the file compression 
working so well and so makes files larger.

If you turn off dithering, you'll find the images contain perfectly flat areas of color, but where you have graduated color, you will 
almost certainly see 'steps' because without dithering there aren't enough colors to accurately represent your drawing. You may 
need to experiment to obtain the right effect.

You cannot use Ordered dithering if you are using an optimized palette.



Animation Properties Dialog Box - Animation Loop and Speed

Loop

This lets you specify how many times the animation should repeat itself. Note that Netscape Navigator takes any value other than 
1 to mean 'loop forever'. Therefore, in Navigator your animation either plays once or forever. Other browsers may take more notice 
of this field.

Display each frame for

If you want the same delay between each frame in the animation enter a value here. To specify a different delay for individual 
frames, use the Frame tab.

This field reads ‘many’ if the animation has more than one inter-frame delay time.



Animation Properties Dialog Box - Frame

These are options for the current frame (the frame shown highlighted in the Frame Gallery).

Name

When you create a frame it is allocated a default name. Use this field if you want to give the frame a different name. (For example, 
to remind yourself what the frame shows.) Frame names are only used in this program; they do not appear in the Animated GIF.

Background/Overlay

These duplicate the buttons on the Frame Gallery. See Background and Overlay Settings for more details.

Display frame for

This lets you specify how long you want this frame displayed before moving onto the next frame in the sequence. You can also set 
a global delay that applies to all frames in the animation using the Loop & Speed tab.

Show Frame

Select this option to include the frame in the final animation. If you want to exclude the current frame from the animation, deselect 
it. You can also change this setting using the pop-up menu in the Frame Gallery, just right-click on a frame.



Animation Properties Dialog Box - Preview in Browser

With this option you can select options suitable for the graphic and then load it into your browser so you can preview it. For more 
details, see Previewing bitmaps.

Background Options
Plain background - This uses the regular background of the browser; that is, gray for Internet Explorer and white for 

Netscape Navigator.
Document background - This is dimmed unless you have specified a page background (see Changing the background) 

for Xara X. This option uses the Xara X background behind the graphic.
Checkered background - This displays the graphic against a checker pattern. The main use is verifying that transparent 

areas of the graphic appear correctly.

Additional Information
Include Image Information - The browser displays information on the file which is useful as a check as to what 

parameters you have set.

Browser Preview

Click this button to see your animation in your browser.



Anti-aliasing steps in blends

If you have a dense blend, it may be useful to turn off the anti-aliasing in the blend so the document redraw faster. You turn off the 
anti-aliasing individually for any blend object. When anti-aliasing is disabled in a blend, only the original blended shapes are anti-
aliased, not the steps.

To turn anti-aliasing of blend steps on and off
1. Select the blend (see Selecting objects).
2. Choose the Blend Tool.
3. Click the Anti-alias button on the Blend Tool Infobar.

_______________
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Apply/Remove ClipView (Arrange Menu)

This option reads:
Apply ClipView when there are two or more objects selected.
Remove ClipView when there is a ClipView selected.

Apply ClipView:

The rear object in the selection (the object behind the other selected objects) "clips" or "masks" the other objects. (The effect is 
similar to viewing the other objects through a window the shape of the rear object.) See Using ClipView for more details.

Remove ClipView:

Remove any clipping applied to the objects in the ClipView.

Movie

{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView



Applying a bevel

Bevels give objects an appearance of depth instead of being flat on the page. Objects cannot have both a contour and a bevel.
To apply a bevel

1.    Select the object (see Selecting objects).
2.    Choose the Bevel Tool.
3.    Choose the bevel shape you want from the Bevel Type list. Note that None removes any applied bevels.
You can alter the bevel to suit your needs - see Modifying bevels.

For rounded bevels we recommend a light elevation of 30º. At this angle the bevel blends smoothly with the object.

Tip:
Applying a bevel to several objects: 
If the objects are grouped, overlapping bevels merge together. The bevel color is the same as the rear-most object in the 

group.
If the objects are ungrouped, each object has a separate bevel. The bevel color is the same as the object color.

Note:
You can apply bevels to any type of object. The exceptions are:

part of a block of text (such as a single letter) - this applies the bevel to all the text
to the curve in text along a curve.
contoured objects.

Bevels are created using bitmaps. The default bitmap resolution is 96dpi which is correct for on-screen work but may be too low 
for printed work. You can change the default resolution in View in the Options dialog box. Note that any change applies to new 
bevels, not existing ones.

Notes on bevels and feathering.

Movie

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

_______________

Related Topics

Modifying bevels
Removing a bevel
Bevel Tool



Applying a shadow

The Shadow Tool creates soft shadows, which fade out to totally transparent at the edges. This looks more realistic than a solid 
shadow.

To apply a shadow
1.    Select the object (see Selecting objects). (See note.)
2.    Choose the Shadow Tool.
3.    For a Wall shadow you can drag from the center of the object in the direction of the shadow.

For other shadow types, click one of the buttons on the Shadow Tool Infobar.
You can alter the shadow to suit your needs - see Modifying shadows.

Tip:
Applying a shadow to several objects: 
If the objects are grouped, overlapping shadows merge (they do not get darker if they overlap).
If the objects are ungrouped, each object has a separate shadow. Overlapping areas of shadow are darker.

Note:
You can also use the Shadow Tool to select objects - more details.
Shadows are created using bitmaps. The default bitmap resolution is 96dpi which is correct for on-screen work but may 

be too low for printed work. You can change the default resolution in View in the Options dialog box. Note that any change applies to 
new shadows, not existing ones.

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

____________

Related Topics

Modifying shadows
Removing a shadow
Shadow Tool



Applying an object's color to another object

You can copy colors from one object to another. This is particularly useful if you have edited the color to create a particular shade.
To apply an object's color to another object

1. Select the object that has the color you want to copy (Selecting objects).
2. Drag the 'current color' indicator patch (from the left-hand end of the Color Line) and drop it onto the object you wish to color.
Or:

To apply an object's color to the selected object
1. Open the Color Editor (Color Editor on the Utilities menu).
2. Drag the color picker (the "eye-dropper") off the Color Editor.
3. Stop dragging when the color picker is over the object you want to copy the color from.

Tips
You could also drag the color from the Color Editor or the Color Gallery (selecting the object automatically selects the 

color in the gallery).
You can also copy color using Paste Attributes (see Pasting attributes from the clipboard).
You can drag either the line color or the fill color off the Color Line.

_______________

Related Topics

Color Line overview
Color Editor overview



Applying attributes to a selected region of text

By selecting a region of text inside a text object you can apply attributes to a small section of it. For example you could change the 
point size of one word in a line of text.

To apply attributes to a region of text
1. Select the text region (see Selecting text).
2. Apply the required attributes. For example, drag-and-drop a color from the Color Line or change the font size.

Tip
If you drag-and-drop an attribute onto the selected region, it will only be applied to the selected region. Note that attributes 

can be applied to the selected region by dragging and dropping the attribute onto the selected region.

_______________

Related Topics

Text Tool
Color Line



Applying attributes to a whole text object

If you apply an attribute to a whole text object, it will affect every character in the text. If you want to apply text-specific attributes 
(like font size), you must select the Text Tool first.

To apply attributes to a whole text object
1. Select the text object (see Selecting objects).
2. Apply the required attributes. For example click on a color on the Color Line or choose the Text Tool and change the font size.

Tips
If the text cursor is visible, pressing Escape removes it. You can then apply attributes to the whole text object.
You can apply attributes to a text object using drag-and-drop,. If you do this, you do not need to select the text object first. 

For example you can change the color of text by dragging a color from the Color Line onto the text object.

_______________

Related Topics

Text Tool
Color Line



Applying attributes to individual text characters

You can easily apply attributes to a single character inside a text object.
To apply attributes to a single character in a text object

1. Select the text character (see Selecting text).
2. Apply the attributes. For example, choose the Text Tool and change the font size or click on a color on the Color Line.

Tip
You can also apply attributes to a single character by holding CTRL and using drag-and-drop. For example, dragging a fill 

from the Fill Gallery and dropping it on a character whilst holding down CTRL will apply a bitmap fill to one character rather than the 
whole text object. See apply inside for more details on applying attributes inside objects.

_______________

Related Topics

Text Tool
Color Line



Applying attributes to text

You can apply any attribute to a whole text object, a single character inside it or a selected region of it. This includes fills, line 
attributes and transparency.

What do you want to do?

Apply attributes to a whole text object

Apply attributes to a selected region of text

Apply attributes to individual text characters

Apply attributes to the text cursor



Applying attributes to the text cursor

If attributes are applied when the text cursor is present in a text object, the attributes are applied to the text cursor and used for all 
the text you type in that text object. When the text cursor is moved, it takes on the attributes of the character to its left.

To apply attributes to the text cursor
1. Choose the Text Tool.
2. Insert the text cursor in the document.
3. Apply the attributes. For example, click on a color on the Color Line or choose a font size from the Text Tool Infobar.

Tips
If you want to change the attributes for all text objects you create in future, select the Text Tool (ensuring the text cursor is 

not visible in the document) and set the attributes.
You have to type something for the change of attribute to have any effect. Moving the cursor without typing discards the 

change of attribute.



Applying bitmap fills

You can use any of the bitmaps in the Bitmap Gallery or Fill Gallery to fill an object. You can then scale, recolor or skew the bitmap 
fill as required.

To apply a bitmap fill
1. Select the object (see Selecting objects).
2. On the Utilities menu, select Fill Gallery or Bitmap Gallery to open the gallery.
3. In the gallery click on the bitmap to be used as a fill. This selects it.
4. Click the Fill button in the gallery.

You can then use the Fill Tool to adjust the bitmap fill; see Changing bitmap fills.

Tips
If you apply a bitmap fill using the Fill Gallery, Xara X imports and adds the bitmap to the Bitmap Gallery for you.
You can double-click on a bitmap in either gallery to apply it to the selected object. (CTRL-double-click closes the gallery 

afterwards.)
You can also drag-and-drop a bitmap from either gallery onto any object, selected or unselected. 
You can also choose bitmaps using the Fill Tool. This is particularly useful is the bitmap is already used in the document.
To apply the bitmap fill to an object inside another object, hold down CTRL as you drop the bitmap. See apply inside.

Movie

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

_______________

Related Topics

Fill Tool
Bitmap Gallery
Fills Gallery
Fills overview



Applying bitmap transparency

You can use any of the bitmaps in the Bitmap Gallery or Fill Gallery to control the transparency of an object. You can then change 
the amount of transparency or scale, recolor or skew the bitmap transparency, as required. The transparency is set by the 
brightness of the pixels in the bitmap (as if it were grayscale).

To apply bitmap transparency
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Bitmap from the Transparency Shape drop-down list on the Transparency Tool Infobar.
4. Choose a bitmap from the Bitmap list.

Or click More to open the Fill Gallery to choose from a wider range of bitmaps.

You can then use the Transparency Tool to adjust the bitmap transparency.

Tips
You can also use the Fill Gallery or Bitmap Gallery    to select a bitmap. Then click Trans (Transparency) in the gallery to 

use the selected bitmap.
Using the Fill Gallery imports the bitmap and also adds it to the Bitmap Gallery.
For details of how to edit a bitmap transparency, see Changing bitmap transparency.

_______________

Related Topics

Transparency overview
Transparency Tool
Bitmap Gallery
Fill Gallery



Applying circular fills

You can fill objects with any of Xara X's different fill types. Circular fills are useful for creating highlights and making circles look 
three dimensional.

To apply a circular fill
1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. SHIFT-drag from where you want the center of the fill to where you want the fill circle to end.
4. If you want a repeating fill pattern (like concentric rings), select Repeating from Fill Tiling on the Fill Tool Infobar.

Tips
You can also select Circular from the drop-down list on the Fill Tool Infobar.
You can edit the position and radius of the fill by dragging the fill handles. See Changing circular fills.

Movie

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

Related Topics

Fills overview
Fill Tool



Applying circular transparency

Circular transparency is one of the types of transparency you can use.
To apply circular transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. SHIFT-drag from where you want the center of the transparency to where you want the transparency to end.
4. If you want a repeating transparency pattern (like concentric rings), select Repeating from Transparency Tiling on the 

Transparency Tool Infobar.

Tips
You can also choose Circular from the Transparency Shape drop-down list on the Transparency Tool Infobar. A fill arrow 

shows you the radius of the transparency
You can edit the position and radius of the transparency by dragging the transparency handles. You can also change the 

transparency levels. See Changing circular transparency for details.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying conical fills

You can fill objects with any of Xara X's different fill types. Conical fills are useful for creating the illusion of a cone or other object lit 
from the side.

To apply a conical fill
1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Choose Conical from the Fill Type drop-down list on the Fill Tool Infobar.
4. Drag from where you want the center of the fill in the direction of the light source.

A semicircular fill arrow shows you the angle of the fill.

Tip
You can edit the position and angle of the fill by dragging the fill handles. See Changing conical fills for details.

Movie

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

Related Topics

Fills overview
Fill Tool



Applying conical transparency

Conical transparency is one of the types of transparency you can use.
To apply conical transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Conical from the Transparency Shape drop-down list on the Transparency Tool Infobar.
4. Drag from the center of the transparency (the point of the cone) to create the conical transparency. During the drag a 

semicircular transparency arrow shows you the direction of the conical transparency.

For details of how to edit the conical transparency, see Changing conical transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying diamond fills

You can fill objects with any of Xara X's different fill types including diamond fills.
To apply a diamond fill

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Choose Diamond from the Fill Type drop-down list on the Fill Tool Infobar.
4. Drag from the center of the fill to create the diamond shape the way you want it. This creates a square diamond fill, drag the fill 

handles to stretch or squash the fill.
5. If you want a repeating fill pattern, select Repeating from the Fill Tiling drop-down list.

Tip
You can later edit the position, extent and angle of the fill by dragging the fill handles. See Changing diamond fills for 

details.

_______________

Related Topics

Fills overview
Fill Tool



Applying diamond transparency

Diamond transparency is one of the types of transparency you can use.
To apply diamond transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Diamond from the drop-down list on the Transparency Tool Infobar.
4. Drag from the center of the transparency. This creates a square transparency. Drag the transparency handles to stretch and 

squash the diamond. A pair of transparency arrows shows you the angles of the sides and size of the diamond transparency.
5. If you want a repeating transparency pattern, select Repeating from the Transparency Tiling drop-down list

For details of how to edit the diamond transparency, see Changing diamond transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying elliptical fills

You can fill objects with any of Xara X's different fill types. Elliptical fills are useful for creating highlights.
To apply an elliptical fill

1 Select the object (see Selecting objects).
2. Choose the Fill Tool
3. Choose Elliptical from the drop-down list on the Fill Tool Infobar.
4. Drag from the center of the fill to create the fill. This creates a circular fill. Drag the fill handles to create an elliptical fill.
5. If you want a repeating fill pattern (like concentric rings), select Repeating from Fill Tiling on the Fill Tool Infobar.

Tip
You can later edit the position, extent and angle of the fill by dragging the fill handles. See Changing elliptical fills for 

details.

Movie

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

Related Topics

Fills overview
Fill Tool



Applying elliptical transparency

Elliptical transparency is one of the types of transparency you can use.
To apply elliptical transparency

1. Select the object (Selecting objects).
2. Choose the Transparency Tool.
3. Choose Elliptical from the Transparency Shape drop-down list on the Transparency Tool Infobar.
4. Drag from the center of the transparency. This creates a circular transparency. Drag the transparency handles to create the 

ellipse. A pair of transparency arrowsshows you the angle and size of the elliptical transparency.
5. If you want a repeating transparency pattern (like concentric rings), select Repeating from the Transparency Tiling drop-down 

list

For details of how to edit the elliptical transparency, see Changing elliptical transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying fills

The Fill Tool can be used to apply fills to any text, shape or QuickShape object. For information on fills, see the Fills Overview.
Applying linear fills
Applying circular fills
Applying elliptical fills
Applying conical fills
Applying diamond fills
Applying three color fills
Applying four color fills
Applying bitmap fills
Applying fractal fills
Creating multi-stage fills

Movies

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Fractals Fractal Fills",1,`') } Using fractal cloud fills

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

Related Topics

Changing fills
Fill Tool



Applying flat transparency

Flat transparency is one of the types of transparency you can use.
To apply flat transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. If the object already has transparency applied, choose Flat from the drop-down list on the Transparency Tool Infobar.
4. Drag the Transparency Slider on the Infobar to select the required level of transparency.

Tips
Applying flat transparency to an object with an outline (or a line) also applies the transparency to the line. To remove the 

line transparency, change the object's line color. See Coloring objects for details.
To change the transparency, just select the object and move the slider on the Infobar. See Changing flat transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying four color fills

You can fill objects with any of Xara X's different fill types. Four color fills are useful for creating highlights and other more complex 
effects.

To apply a four color fill
1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Choose Four Color from the Fill Type drop-down list on the Fill Tool Infobar.
4. Drag across the object to apply the fill.
5. If you want a repeating fill pattern, select Repeating from Fill Tiling on the Fill Tool Infobar.

Tips
You can edit the positions of the points in the fill by dragging the fill handles. See Changing four color fills for details.
You can create a variety of pattern fills using four color fills, see Creating simple fill patterns.

_______________

Related Topics

Fills overview
Fill Tool



Applying four point transparency

Four point transparency is one of the types of transparency you can use.
To apply four point transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Four point from the Transparency Shape drop-down list on the Transparency Tool Infobar.
4. Drag from the center of the transparency. This creates a square of four transparency handles, each with their own transparency 

levels. A pair of transparency arrows shows you the angles of the sides of the square. The four handles will always stay in the 
form of a parallelogram.

5. If you want a repeating transparency pattern, select Repeating from the Transparency Tiling drop-down list.

For details of how to edit four point transparency, see Changing four point transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying fractal fills

You can fill objects with any of Xara X's different fill types including Fractal Cloud and Fractal Plasma. Each fractal fill is unique. 
After applying a fractal fill you can then edit it to create exactly the effect you want.

To apply a fractal fill
1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Choose Fractal Clouds or Fractal Plasma from the Fill Type drop-down list on the Fill Tool Infobar.

A pair of fill arrows shows you the extent and angle of the fill. For details of editing a fractal fill, see Changing fractal fills.

Movie

{button ,EF("XaraDemo.exe","Fractals Fractal Fills",1,`') } Using fractal cloud fills

_______________

Related Topics

Fills overview
Fill Tool



Applying fractal transparency

You can use Fractal Cloud transparency or Fractal Plasma transparency to create the effect of mist or clouds or a random pattern. 
Each fractal pattern is unique. After applying fractal transparency you can then edit it to create exactly the effect you want.

To apply fractal fill
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Fractal Clouds or Fractal Plasma from the drop-down list on the Transparency Tool Infobar.

For details of how to edit fractal transparency, see Changing fractal transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying linear fills

You can fill objects with any of Xara X's different fill types. Linear fills are useful for simple shading.
To apply a linear fill

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Drag from where you want the fill to start to where you want the fill to end. During the drag a fill arrow shows you the start and 

end of the linear fill.
4. If you want a repeating fill pattern (like a series of bars), select Repeating from Fill Tiling on the Fill Tool Infobar.

Tips
This method does not work if the object already has a (non-linear) fill applied. In this case, choose Linear from the Fill 

Type drop-down list on the Fill Tool Infobar.
You can later move the start and end points and change the colors of the fill - see Changing linear fills.

_______________

Related Topics

Fills overview
Fill Tool



Applying linear transparency

Linear transparency is one of the types of transparency you can use.
To apply linear transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool
3. Drag from where you want the linear transparency to start to where you want it to end. During the drag a transparency arrow 

shows you the start and end of the linear transparency.
4. If you want a repeating transparency pattern (like bars), select Repeating from the Transparency Tiling drop-down list

Tips
This method does not work if the object already has a (non-linear) transparency applied. In this case, choose Linear from 

the Transparency Shape drop-down list on the Transparency Tool Infobar.
You can later move the start and end points and change the transparency of the two points - see Changing linear 

transparency for details.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying molds

Molds let you distort objects to create either a perspective effect (perspective mold) or stretched and squashed effect (envelope 
mold).

To apply a mold
1.    Select the object to be molded (see Selecting objects).
2.    Choose the Mold Tool.
3.    Choose the required envelope or perspective mold shape from the Mold Tool Infobar.

Tips
If you need a specific mold shape that isn't provided, choose the default perspective or envelope mold and reshape as 

required.
You can apply perspective molds to bitmaps.
You can also use the shape on the clipboard as a mold. For use as an envelope mold, the shape must have four sides 

(straight or curved). For use as a perspective mold, the shape must have four, straight sides.

Movies

{button ,EF("XaraDemo.exe","Envelope Envelope molds",1,`') } Using envelope molds

{button ,EF("XaraDemo.exe","Perspect Perspective molds",1,`') } Using perspective molds

_______________

Related Topics

Molds
Mold Tool



Applying special effects to bitmaps

These special effects are supplied with Xara X:
Custom
Isolate Points
Edge Detection
Laplacian
Dilation
Robert's Cross
Sharpen
Blur

You can also use plug-ins from other companies to extend the range of effects available to you. See Bitmap effects plug-ins for 
more details.

To apply one of Xara X's special effects
1. Select the bitmap (see Selecting objects).
2. From Bitmap Effects & Plug-ins on the Utilities menu, choose Bitmap Effects.
3. Choose Special Effects.
4. Select the effect you want.
5. Move the slider.
6. Click OK to insert the new, altered bitmap into the document.

Tips:
You can also select a bitmap in the Bitmap Gallery and then click the Plug-ins button on the Gallery.

Movie

{button ,EF("XaraDemo.exe",`Beffects Bitmap special effects',1,`') } Bitmap special effects



Applying three color fills

You can fill objects with any of Xara X's different fill types. Three color fills are useful for creating highlights and other more 
complex effects.

To apply a three color fill
1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Choose Three Color from the Fill Type drop-down list on the Fill Tool Infobar.
4. Drag across the object to apply the fill.
5. If you want a repeating fill pattern, select Repeating from Fill Tiling on the Fill Tool Infobar.

Tips
You can edit the positions of the points in the fill by dragging the fill handles. See Changing three color fills for details.
You can create a variety of pattern fills using three color fills, see Creating simple fill patterns.

_______________

Related Topics

Fills overview
Fill Tool



Applying three point transparency

Three point transparency is one of the types of transparency you can use.
To apply three point transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose Three point from the Transparency Shape drop-down list on the Transparency Tool Infobar.
4. Drag from the center of the transparency. This creates a triangle of three transparency handles, each with their own 

transparency levels. A pair of transparency arrows shows you the angles of the sides of the triangle.
5. If you want a repeating transparency pattern, select Repeating from the Transparency Tiling drop-down list.

For details of how to edit three point transparency, see Changing three point transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



Applying transparency

With the Transparency Tool you can make any object transparent using a wide range of transparency shapes. For information 
about transparency, see the Transparency Overview.

Applying flat transparency
Applying linear transparency
Applying circular transparency
Applying elliptical transparency
Applying conical transparency
Applying diamond transparency
Applying three point transparency
Applying four point transparency
Applying bitmap transparency
Applying fractal transparency

Note:
Shadows created with the Shadow Tool use bitmap transparency to create the shadow effect. This means you cannot 

apply transparency to a shadow.

Movie

{button ,EF("XaraDemo.exe","Transpar Simple Transparency Effects",1,`') } Using transparency

_______________

Related Topics

Transparency Tool
Removing transparency



Arrange Control Bar

Bring to Front

Put to Back

Move Forwards

Move Backwards

Move to Layer in Front

Move to Layer Behind

Group

Ungroup
Alignment

Convert to Editable Shapes

Join Shapes

Break Shapes
Add Shapes

Subtract Shapes

Intersect Shapes

Slice (cut) Shapes

Fit Text to Curve

_______________

{button ,KL(`control bars,list of default control bars',0,`____No_Topics_Found',`')}    Related Topics



Arrange Icons (Window Menu)

Arrange Icons arranges the icons of all minimized documents at the bottom left-hand corner of the main Xara X window.



Arrange Menu

Move to Layer in Front/Move to Next Frame
Bring To Front
Move Forwards
Move Backwards
Put To Back
Move to Layer Behind/Move to Previous Frame
Group
Ungroup
Apply ClipView (or Remove ClipView)
Alignment
Join Shapes
Break Shapes
Combine Shapes
Convert Line to Shape
Convert to Editable Shapes
Create Bitmap Copy
Fit Text to Curve (or Remove Text From Curve)



Arrange Views (Window Menu)

Arrange Views tiles all the open document views to fill the main Xara X window.



Attributes Overview

Attributes are properties or characteristics of the objects in your drawings. There are many types of attribute, the most common is 
color. When you drag a color from the Color Line onto an object in your drawing, you are giving it a new color attribute. With color 
there are two types of attribute, the fill color (the color filling the middle of the shape) and the line color (the color out the line or 
outline). You can apply any type of attribute to any type of object, but some objects will ignore some attributes. For example if you 
apply a font size to a rectangle. Some other examples of attributes are font size, line width (thickness) and transparency.

When you draw a new object, the attributes the new object uses are the current attributes. For example, if the current attributes 
include a red fill color and a yellow line color, all the objects you draw will first appear filled with red with a yellow outline.

You can easily change the current attributes so all the new objects you draw have the same characteristics. To change the current 
attributes, change the attribute with no objects selected. For more information, see Setting the current attributes. Remember the 
current attributes for text are separate from those for other types of object.

You can set the program up so each new object uses the attributes from the previous object you changed. So for example if you 
draw a rectangle and fill it with green, the next object you draw will be green. To change the program in this way, choose Give New 
Objects Most Recent Attributes in the General Options (see General Options).

_______________

Related Topics

Fill Tool
Transparency Tool
Color Line overview



BMP Export Dialog Box

The BMP (Windows Bitmap) export bitmap dialog box is opened by selecting BMP as the exported file format from the Export 
dialog box. It allows the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in 
the bitmap. For details of how to create a BMP file, see Creating BMP files.

Preview boxes
Palette Options
Bitmap Options - this tab is blank for BMP format
Bitmap Size
Image Map
Browser Preview
Export/Apply Button (see Note)

Note

This button reads Apply when setting options in the Name Gallery (because you are setting options prior to Exporting a sliced 
image). Otherwise it reads Export. 



Bar Properties Dialog Box

This dialog box has two uses:
Creating a new navigation bar (click New on the Button & NavBar Tool Infobar). For this, you create the design for a single 

button and use this dialog box to create the other buttons.
Editing an existing navigation bar (click Edit properties on the Button & NavBar Tool Infobar). This lets you change the 

number of buttons and so on in the navigation bar.

You can also use this dialog box to create a BackBar. (A graphic that appears behind the buttons.)
 To display the Bar Properties dialog box
1. Select the Button & NavBar Tool
2. Select the entire button design - see Selecting navigation bar objects.
3. Click New or Edit properties. For more information see Creating Navigation Bars and Creating Rollovers.

Number of buttons - the number of buttons to create
Direction of bar - horizontal, vertical or custom
Button spacing - the distance between buttons
Button stretching - how you want buttons to stretch
Buttons are all... - different width or same width buttons
Groups are prevented from stretching

When creating bars:

Any changes you make apply when you click Create
Make BackBar from backmost object
Create
Cancel

When modifying bars:

Any changes you make immediately update the buttons.
Create/Redefine (a BackBar)
Close

Movie

{button ,EF("XaraDemo.exe",`NavBar Creating Navigation Bars',1,`') } Creating Navigation Bars

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties dialog box - Make BackBar

A BackBar appears behind the navigation bar buttons. Changing the number or size of buttons automatically resizes the BackBar. 
For more information see Creating a BackBar.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties Dialog Box - Bar Direction

Used when creating multibutton navigation bars. These bars can be displayed vertically or horizontally both in Xara X and on the 
web page. Alternatively you can define your own positioning of the buttons (User defined). This option has no effect on the 
bitmaps of the buttons, only the HTML code that is automatically created when you click Export. For more information see 
Creating Navigation Bars.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties Dialog Box - Button Spacing

Dimmed for User defined bar direction (because the buttons can then have unequal spacing).

Lets you space the buttons when displayed in a web page navigation bar. This option affects the HTML code exported when you 
export the buttons. It has no effect on the exported buttons themselves. For more information see Creating Navigation Bars.

Technical note: this adds a VSPACE or HSPACE attribute to the HTML IMG tag.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties dialog box - Button stretching

You can create navigation bar buttons that stretch as you change the amount of text on them.

Is static

Changing the text does not change the size of the button.

Extends

As you change the text, the button stretches from its center. 

Scales

As you change the text, the button stretches - the same effect as stretching the object using the Selector Tool). 

An example of the difference between Extend and Scales is a rectangle with rounded ends. Extend stretches the center of the 
rectangle; the corner radius is unchanged. Scales elongates the entire rectangle and the round corners become elliptical.

If you want some objects in the button non-stretching, group them and then select Groups are prevented from stretching in the 
dialog box.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties dialog box - Buttons are all...

You can create navigation bar buttons that stretch as you change the amount of text on them.

The same size

Stretching one button in the navigation bar changes the size of all buttons.

Independent size

Stretching a button does not change the other buttons.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties Dialog Box - Create button

Create and display a bar using the current settings in the dialog box. For more information see Creating Navigation bars.



Bar Properties dialog box - Group stretching

You can create navigation bar buttons that stretch as you change the amount of text on them. You might not want all objects to 
stretch and this option marks groups as non-stretching. (A group can consist of a single object.) Thus you can group objects you 
want as non-stretching and then select this option.

Note:

The Button Stretching option controls whether the button stretches as you change the text. This option just controls stretching of 
groups.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bar Properties Dialog Box - Number of Buttons

This field lets you specify the number of buttons you want on your navigation bar. For more information see Creating Navigation 
Bars.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Bars (Window Menu)

The Bars submenu of the Window menu controls the enabling/disabling of the Color Line, Status Line, Scrollbars and Rulers.
Color Line
Status Line
Scrollbars
Rulers

_______________

Related Topics

Color Line
Status Line



Batch exporting bitmaps

You might create a drawing containing a set of themed graphics (such as all the graphics on a web site). These may use a 
common color. In the future you might decide to change the color, which means you need to reexport all the graphics. In Xara X 
you can use batch exporting to update all the graphics.

To batch export graphics

This assumes you have already exported the graphics to disk. (The Name Gallery stores the file names used and the export 
parameters - this information is used when batch exporting.) 
1. Make any required changes to the graphics.
2. Open the Name Gallery.
3. If you want to change the file format or export parameters, do so at this stage. See Export parameters.
4. In the Used names section click on the first name you want to export.
5. To select another names, SHIFT-click on the last name.

Or to select a block of names, SHIFT-click on the last name.
6. Click Export in the Name Gallery.

_______________

{button ,KL(`exporting,documents',0,`____No_Topics_Found',`')}    Related Topics



 Bevel Tool - Bevel settings

The slider and text box let you control the bevel size, contrast, or light angle or elevation. Use the Slider type list to select which 
option the slider/text box currently controls.
You can either drag the slider or, for precise values, type into the text box.

_______________

{button ,KL(`bevels',1,`____No_Topics_Found',`')} Related Topics



 Bevel Tool - Bevel Type

This control lets you select the shape of the bevel. Choose from the drop-down list.
Choose None to remove any applied bevel.

_______________

{button ,KL(`bevels',1,`____No_Topics_Found',`')} Related Topics



 Bevel Tool - Inner/Outer bevel

Bevels can be:
Inner - displays the bevel inside the object. The size of the objects remains the same.
Outer - displays the bevel outside the object and makes it bigger.

Which you use depends on the effect you want to create.

_______________

{button ,KL(`bevels',1,`____No_Topics_Found',`')} Related Topics



 Bevel Tool - Join style

These buttons control the shapes of corners for the bevel. Options are: miter, round and beveled. Note that these buttons duplicate 
options on the Contour Tool Infobar and the Line Gallery.

_______________

{button ,KL(`bevels',1,`____No_Topics_Found',`')} Related Topics



 Bevel Tool - Slider Type

To save space on the Infobar, the slider can control several options. Select which from this list. Options are:
Size - the bevel size; see Changing the bevel size
Contrast - the contrast between light and dark areas
Light angle - the direction of the light that creates the bevel effect
Light elevation - the angle of the light to the surface of the document

For how to use Contrast, Light Angle and Light Elevation see Changing the bevel light source.

_______________

{button ,KL(`bevels',1,`____No_Topics_Found',`')} Related Topics



 Bevel Tool Overview    CTRL+F3
Bevels give objects an appearance of depth instead of being flat on the page. Bevels are resolution independent so you can scale 
them without losing quality. 

Bevel Tool Infobar controls:

Bevel type

Slider type

 Bevel settings

Inner/Outer bevel
Join style

Tip:
Applying a bevel to several objects: 
If the objects are grouped, overlapping bevels merge together. The bevel color is the same as the rear-most object in the 

group.
If the objects are ungrouped, each object has a separate bevel. The bevel color is the same as the object color.

Movie

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

Bevel Tool operations:
Applying a bevel
Removing a bevel
Modifying a bevel



Bevel direction

Bevels can be inside the object or outside. Outside bevels make objects larger; inside bevels do not change the object size.

To change bevel direction:

1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. If necessary apply a bevel (see Applying a bevel).
4. Click either the Inner or Outer button.

Tip:
If you have several beveled objects selected, any changes apply to all the bevels.

Movie

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

_______________

Related Topics

Applying a bevel
Modifying a bevel
Removing a bevel
Bevel Tool



Bevel Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a bevel, it contains the following options:
Bevel Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effect & Plug-ins (Utilities Menu)

You can open this menu from:
the Utilities menu - this lets you apply an effect to the bitmap selected in the document
right-clicking on a bitmap - this lets you apply an effect to the bitmap you clicked on
the Bitmap Gallery - this lets you apply an effect to the bitmap selected in the Bitmap Gallery.

CorelXARA users: please note that this option is now on the Utilities menu.

The menu is split into sections:

Bitmap Effects submenu:

Xara X includes these effects as standard:
Brightness and Contrast
Color Depth
Flip and Rotate
Resize
Special Effects

Configure plug-ins:

This opens the Plug-ins Options tab.

The other two sections control any Photoshop plug-ins you have installed. See Bitmap effects plug-ins for more details.
The next item shows the name of the last plug-in effect you applied. This is a quick way of applying the same effect to 

other bitmaps.
The last section displays the names of any Bitmap Effects plug-ins installed in Xara X. See Installing plug-ins.



Bitmap Effects - Brightness and Contrast

You can use this dialog box to create a new bitmap that has a different brightness or contrast from the original. For more details, 
see Changing the brightness and contrast of bitmaps.

The original bitmap is always shown in the panel on the left, and the proposed result on the panel on the right.

When opened, the dialog box shows, on the left-hand side:
If you opened this dialog box from the Plug-ins button on the Bitmap Gallery, the bitmap you selected in the Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

You can choose a different bitmap using the drop-down list.

Click OK to add the altered bitmap (displayed on the right-hand side) to the Bitmap Gallery. The original bitmap is unchanged.

The altered bitmap replaces any selected bitmaps in the document.

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effects - Color Depth

The Color Depth dialog box lets you change the number of colors in a bitmap. For more information on changing the number of 
colors in a bitmap, see Changing the number of colors in bitmaps.

The original bitmap is always shown in the panel on the left, and the proposed result on the panel on the right.

When opened, the dialog box shows, on the left-hand side:
If you opened this dialog box from the Plug-ins button on the Bitmap Gallery, the bitmap you selected in the Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

You can choose a different bitmap using the drop-down list.

Click OK to add the altered bitmap (displayed on the right-hand side) to the Bitmap Gallery. The original bitmap is unchanged.

The altered bitmap replaces any selected bitmaps in the document.

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effects - Flip and Rotate

The Flip and Rotate dialog box can be used to flip and rotate bitmaps by multiples of 90 degrees. For more details, see Flipping 
and rotating bitmaps.

The original bitmap is always shown in the panel on the left, and the proposed result on the panel on the right.

When opened, the dialog box shows, on the left-hand side:
If you opened this dialog box from the Plug-ins button on the Bitmap Gallery, the bitmap you selected in the Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

You can choose a different bitmap using the drop-down list.

Click OK to add the altered bitmap (displayed on the right-hand side) to the Bitmap Gallery. The original bitmap is unchanged.

The altered bitmap replaces any selected bitmaps in the document.

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effects - OK Button

This button add the altered bitmap (displayed on the right-hand side) to the Bitmap Gallery. The original bitmap is unchanged.

The altered bitmap replaces any selected bitmaps in the document.



Bitmap Effects - Resize

The Resize dialog box provides facilities to alter the size (resolution) of a bitmap. For more details, see Scaling bitmaps.
Lock Aspect Ratio: If the Lock Aspect Ratio option is set, only one of the values for the new size of the bitmap need be 

entered as the aspect ratio of the original bitmap is retained. De-selecting this makes it possible to stretch and squash the bitmap.
Linear Interpolation: It is recommended that Linear Interpolation is left selected as it will result in a much smoother end 

result. If it is de-selected the resulting bitmap is likely to be 'chunky'.

The original bitmap is always shown in the panel on the left, and the proposed result on the panel on the right.

When opened, the dialog box shows, on the left-hand side:
If you opened this dialog box from the Plug-ins button on the Bitmap Gallery, the bitmap you selected in the Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

You can choose a different bitmap using the drop-down list.

Buttons:
Test
OK

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effects - Special Effects

The Special Effects dialog box provides various effects that can be applied to bitmaps. For more details, see Applying special 
effects to bitmaps.

The original bitmap is always shown in the panel on the left, and the proposed result on the panel on the right.

When opened, the dialog box shows, on the left-hand side:
If you opened this dialog box from the Plug-ins button on the Bitmap Gallery, the bitmap you selected in the Gallery.
The currently selected bitmap.
The default bitmap if no bitmap is currently selected.

You can choose a different bitmap using the drop-down list.

Click OK to add the altered bitmap (displayed on the right-hand side) to the Bitmap Gallery. The original bitmap is unchanged.

The altered bitmap replaces any selected bitmaps in the document.

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Effects - Test Button

To see the result of applying the bitmap effect, click the Test button. When using the brightness and contrast tab, the display is 
interactive and you need not use this button



Bitmap Effects Plug-ins

Xara X already includes a range of bitmap effects but you extend this range using plug-ins from other companies. Suitable plug-ins 
are 32-bit PC plug-ins designed for Adobe Photoshop (Apple Mac plug-ins are not suitable.) There is a wide range of plug-ins 
available. These can be described as import, export, filter or effects. Xara X can use effects plug-ins, not the other types.

Applying plug-in effects
To the selected bitmap: use Bitmap Effects & Plug-ins on the Utilities menu.
To any bitmap: right-click on the bitmap and choose Plug-ins from the pop-up menu.
To a bitmap in the Bitmap Gallery: select the bitmap in the Gallery then click the Plug-ins gallery button.

For more information on a plug-in, refer to the documentation supplied with it. We have not tested all plug-ins suitable for use with 
Xara X (there are hundreds), but you can find details on those we have tried on the Xara web site:

Plug-ins page 

Related Topics

Installing plug-ins
Removing plug-ins
Plug-ins troubleshooter



Bitmap Export Dialog Box

This dialog box is used when exporting GIF, JPEG, PNG and BMP files. The range of options and tabs you see depends on which 
bitmap format you chose.

Preview boxes
Palette Options
GIF Options Tab
JPEG Options Tab
PNG Options Tab
Bitmap Size Tab
Image Map Tab
Browser Preview
Export Button

Movies

{button ,EF("XaraDemo.exe",`Bexport Exporting Bitmaps',1,`') } Bitmap export

{button ,EF("XaraDemo.exe",`Palette Bitmap Export - Palette Optimization',1,`') } Bitmap Export - Palette optimization

{button ,EF("XaraDemo.exe",`Bxoption Bitmap Export - Option tab',1,`') } Bitmap Export - Options tab

{button ,EF("XaraDemo.exe",`Bxsize Bitmap Export - Size tab',1,`') } Bitmap Export - Size tab

{button ,EF("XaraDemo.exe",`Bxpview Bitmap Export - Preview tab',1,`') } Bitmap Export - Preview tab

_______________

Related Topics

Bitmaps overview
Internet bitmap overview



Bitmap Export Dialog Box - Area to Save

The bitmap can be created using one of three areas of the document:

Spread The whole page or spread area. Caution: this can create very large bitmaps.

Drawing The area covered by objects.

Selection The area covered by the objects in the selection. Dimmed unless there are selected objects.



Bitmap Export Dialog Box - BMP Compression

No longer used.

You can export 16 color (4bpp) and 256 color (8bpp) BMP files in compressed format. Types of compression available:

RLE Run length encoding compression.

RGB No compression.



Bitmap Export Dialog Box - Bitmap Size

Enter the width and height of the bitmap here (in pixels).

Tip
This bitmap format does not store the resolution information in the file. This is why the resolution drop-down list is 

dimmed.



Bitmap Export Dialog Box - Bitmap Size (and Resolution)

This section is not present when saving from the Bitmap Gallery, as you cannot resize the bitmap.

Bitmap Size and Resolution

The size of the exported bitmap can be set in two ways:

Resolution Type the resolution into the dpi field. The Width and Height are calculated from this to ensure the aspect ratio of the 
area being exported is fixed.

Size Type the required width or height into one of the fields. Note that the aspect ratio of the drawing is fixed so only one 
dimension can be set - the other is calculated automatically.

Tip
Choosing a resolution of 96dpi ensures the bitmap is the same size as the objects on screen (at 100% magnification).

Area to Save

The bitmap can be created using one of these areas of the document:

Page The whole page area.

Drawing The area covered by objects.

Selection The area covered by the objects in the selection. Only available when objects are selected.

Anti-aliasing

Anti-aliasing improves the appearance of graphics by smoothing jagged edges.
Maintain Screen Anti-aliasing Create the bitmap using the anti-aliasing displayed on the monitor screen. (That is, do not 

change the anti-aliasing.) This is useful if you have positioned the objects to create a precise anti-aliasing effect.
Minimize Visible Anti-aliasing On export, reposition the objects by up to a pixel to minimize the anti-aliasing required for 

good results. If in doubt which option to use, select this. (Note for CorelXARA 2.0 [and earlier] users: this is how CorelXARA 
2.0 exported bitmaps.)

Put HTML Image Tag on Clipboard

This lets you save out the basic HTML IMG tag information when you save the bitmap. You can then paste the tag into an HTML 
page using a text editor and modify it if necessary. The tag is saved like this:

<img src="name" width=xxx height=xxx>

Where "name" is the filename and xxx are the width and height in pixels. If you save the graphic to a different folder to the HTML 
page, you need to edit the filename to point to that folder.

Notes
Putting the tag on the clipboard overwrites any existing contents of the clipboard.
There is an option on the Image Map tab to save an image map to the clipboard. Selecting either of these clipboard 

options automatically deselects the other option.

Movie

{button ,EF("XaraDemo.exe",`Bxsize Bitmap Export - Size tab',1,`') } Bitmap Export - Size tab



Bitmap Export Dialog Box - Browser Preview

Using the Preview boxes in the Export dialog box, you can select the best compromise of file size and quality for web graphics. 
However the best test is checking how the graphic looks in a web browser. This option lets you select options suitable for the 
graphic and then load it into your browser. For more details, see Previewing bitmaps.

This testing is particularly useful when the graphic has clickable areas (image maps). You can load the graphic and quickly check 
that that the areas are defined as you expect and the addresses are correct.

Background Options
Plain background - This uses the regular background of the browser; that is, gray for Internet Explorer and white for 

Netscape Navigator.
Document background - This is dimmed unless you have specified a page background (see Changing the background) 

for Xara X. This option uses the Xara X background behind the graphic.
Bitmap as background - This displays the graphic as the background on the browser and tiles (repeats) the graphic as 

required. It lets you check that the graphic tiles seamlessly.
Checkered background - This displays the graphic against a checker pattern. The main use is verifying that transparent 

areas of the graphic appear correctly.

Additional Information
Include Image Information - The browser displays information which is useful as a check as to what parameters you 

have set.
Include Image Map - This also exports the associated image map. This lets you test that clickable areas in the graphic 

work correctly. For more information on Image Maps, see the Image Map Overview.

Show all previews in browser

Select this option to automatically update the browser preview every time you change the bitmap export options. Note that 
changing the Background and Additional Information options do not automatically update the browser preview - click the Browser 
Preview button to update the preview.

Browser Preview

Click this button to preview your bitmap in your web browser.

Movie

{button ,EF("XaraDemo.exe",`Bxpview Bitmap Export - Preview tab',1,`') } Bitmap Export - Preview tab



Bitmap Export Dialog Box - Color Depth

Color Depth

You can create bitmaps with the following number of colors:

24 bit Millions of colors

8 bit 256 colors

4 bit 16 colors

1 bit 2 colors

Many bitmap formats support only some of these color options. For example, the GIF format supports 256, 16 or 2 colors. Other 
options are dimmed.



Bitmap Export Dialog Box - Colors

The dialog box shows you the range of colors for the current settings. (For 256 or fewer color formats only; formats above 256 
colors use a fixed palette of colors. Not all bitmaps formats support more than 256 colors.) Each colored square can give you extra 
information about that color:

(white surround) the selected color.
(small square in the center) "web-safe" color. These are the 216 colors in the Netscape Navigator and Microsoft Internet 

Explorer browser palette. On 256-color displays the browser dithers other colors and there may be a quality loss. If your bitmap has 
large areas of flat color, it is worth making sure that these areas use web-safe colors. You can also snap to web-safe colors when 
using the Color Editor to edit colors - more details.

(small square bottom left) "locked" color. This color always appears in the bitmap palette (unless you select Browser 
palette) even if you change the number of colors. To lock a color, select it and then select the Lock button.

(small square bottom right) edited color - you have changed the color definition of this color. To edit a color, select it and 
then enter new values in Edit color.

(small square top left) transparent (GIF & PNG formats, up to 256 colors only). These formats allow simple on-off 
transparency by making the entry in the palette transparent. To make an entry transparent, select it then click Make transparent. 
Note that this applies to PNG format up to 256 colors only; the True color option allows full alpha-channel (variable) transparency.

(hatched square) deleted color. To delete a color, select it and click the Delete button. To restore a color, select it and click 
the Restore button.



Bitmap Export Dialog Box - Control Buttons

These buttons are between the two Preview windows on the Bitmap Export and Create Bitmap Copy dialog boxes.

Zoom - click on a preview to zoom in. SHIFT-click to zoom out. Drag over an area of the preview to zoom into that area.

Push - lets you drag the image around in the Preview window.

Zoom to Fit - scales the preview image to fit the window.

100% - scales the image to full-size (100%)

Color Selector - dimmed for Color Depth greater than 256 colors (BMP & PNG formats). Moving the pointer over the image 
highlights the color under the pointer. Click to select that color in the palette.

Note:
The Zoom options just change your view onto the preview. They do not change the dimensions of the bitmap exported to 

disk. Use Bitmap Size if you need to change the size of the exported bitmap.



Bitmap Export Dialog Box - Dithering

You can select between three types of dithering with these options. Choosing None means there will be no dithering, Ordered 
uses an ordered (regular) dithering pattern and Error diffusion uses error-diffused dithering (a more complex dithering technique). 
In general, error diffusion will give the best results, but only use dithering when really necessary as it prevents the file compression 
working so well and so makes files larger. You cannot use ordered dithering if you are using an optimized palette.

Note that you can set the dithering type for the screen display too, see Changing the screen dithering.



Bitmap Export Dialog Box - Export/Apply Button

This button reads Export A or Export B depending on which is the selected Preview. Click a Preview to select it and then click this 
button to export the bitmap.

In the Name Gallery:

When you are setting image slicing options, this button reads Apply A or Apply B because you are setting options prior to export.



Bitmap Export Dialog Box - Bitmap Options tab

Interlacing

Select this option if you want an interlaced bitmap.

Movie

{button ,EF("XaraDemo.exe",`Bxoption Bitmap Export - Option tab',1,`') } Bitmap Export - Options tab



Bitmap Export Dialog Box - Bitmap Options tab

Transparency

This button duplicates Transparent background on the Palette Options tab. It provides compatibility for CorelXARA users.

With transparency enabled, the bitmap is 'transparent' in all areas not covered by a selected object. This makes it easy to remove 
the white background from exported pictures and makes them ideal for publication on the Internet (see Internet Bitmaps 
Overview).

If the Quality setting is high (anti-aliasing is turned on) the edges of the drawing will be anti-aliased with whatever is behind it (as 
normal). Normally the anti-aliasing is to the paper color of white.

When transparency is enabled, the selected items are used to determine what is going to be transparent in the GIF, but all objects 
are rendered. This makes it simple to create bitmaps which anti-alias to the background they will eventually be on, by placing that 
background behind the drawing. Then when the bitmap is exported ensure that the background is not selected but the drawing is 
and that the selection option is used. 

Note that if you create a transparent GIF file, one of the palette colors is used as the transparency. This means (for example) that a 
2 color GIF contains one color and transparency.

Note that GIF transparency has a different meaning to the transparency in the Transparency Tool. This process does not take into 
account any of this type of transparency applied to objects in the document.

Interlacing

Select this option if you want an interlaced bitmap.



Bitmap Export Dialog Box - Image Map Tab

An Image Map lets you have 'clickable' areas on the graphic when displayed in a browser. Clicking one of these areas jumps to a 
new web page. If you want to create an Image Map, use Web Address on the Utilities menu to add web addresses (URLs) to the 
different parts of your drawing. For general information on Image Maps see Image Map Overview.

This tab lets you export the associated Image Map at the same time as you export the bitmap. You can also export the Image Map 
separately by selecting Image Map as the export type in the Export dialog box. If you don’t want to export an Image Map, deselect 
both Export Image Map to Clipboard and Export Image Map to File.

Export Image Map to Clipboard

This copies the text to the clipboard so you can use a text editor to paste it into an HTML page. Note that this overwrites anything 
already on the clipboard. There is an option on the Bitmap Size tab to save the HTML IMG tab to the clipboard. Selecting either of 
these clipboard options automatically deselects the other option.

Export Image Map to File

This copies the Image Map text to a file. This is a quick way of automatically inserting the image map into an HTML file.

You can either:
Insert Image Map into Existing File: this inserts the Image Map into the specified file.
If the file already contains an Image Map with the same name, the existing Image Map is replaced.
If this is a new Image Map, it is inserted at the end of the file.
Replace Existing File: this overwrites any existing contents of the file. This option is useful if you want to save the image 

map text for use later.
Note that opening this file in Browser displays a blank window; that is, you don't see the graphic. The reason is that the file 

does not include the IMG tab needed to display the graphic. The IMG tag might look like this: <IMG SRC="filename.gif" 
USEMAP="#example">.

Dreamweaver integration
This is dimmed unless (a) you have Macromedia Dreamweaver installed on your computer and (b) you have saved the document.

With this option selected, the bitmap in Dreamweaver is linked to the original Xara X document. If you later need to edit the bitmap, 
Dreamweaver can load Xara X and display the original document. For more information see Macromedia Dreamweaver 
integration.

Image Map Options
Name

Image maps are named. (Names must be unique within a document.) Include this name in the <IMG USEMAP=> attribute to 
identify the associated image map. (USEMAP="#example" for an image map called "example".)

If you are merging this image map into an existing file, you can either type in a new map name or choose the name of an existing 
map. This lets you replace an existing map with new data.

Approximate curves with lines

Image map polygons are a series of straight lines and this option lets you select how closely any curves in the clickable areas are 
followed. (Note that circles are a special case in image maps.) Very closely gives the best approximation. This increases the size 
of your web page and so makes it slower to download. Only you can decide which is the best option.

Save all clickable areas as rectangles

Ignore the shape of clickable areas. Save all clickable areas as simple rectangles that totally enclose the clickable area.

Movie

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps



Bitmap Export Dialog Box - Bitmap Options

JPEG Quality

This setting is specific to JPEG output. A low setting will result in a small file with a loss in quality whereas a high value will give 
only slight file size reduction, but high quality. Note that a setting of 100% will still compress the file.

As an example, a setting of 75% gives good compression without causing a noticeable loss in quality for most uses.

Progressive

Selecting this option creates a 'progressive JPEG'. This is similar to an interlaced GIF and means that when the JPEG is displayed 
by a web browser that understands progressive JPEG files, it slowly comes into focus as it is downloaded. If the browser doesn't 
support progressive JPEG files, the JPEG is displayed only when the whole file has been downloaded, just as if the JPEG wasn't 
progressive.



Bitmap Export Dialog Box - Bitmap Options

Interlacing

If interlacing is enabled the bitmap file produced will be interlaced.



Bitmap Export Dialog Box - Bitmap Options

Transparency

This button duplicates Transparent background on the Palette Options tab. It provides compatibility for CorelXARA users.

If transparency is enabled the bitmap will be 'transparent' in all areas not covered by a selected object. If the selection has been 
chosen then this will be only the visible and selected objects. This makes it easy to remove the white background from exported 
pictures and makes them ideal for publication on the Internet (see Internet Bitmaps Overview).

If you create a transparent PNG file, one of the palette colors is used as the transparency. This means (for example) that a 2 color 
PNG file contains one color and transparency.

Note that PNG transparency has a different meaning to Xara X transparency. This process does not take into account any Xara X 
transparency applied to objects in the document.

Interlacing

If interlacing is enabled the bitmap file produced will be interlaced.



Bitmap Export Dialog Box - Palette

Choose between browser palette and optimized palette



Bitmap Export Dialog Box - Palette Options

Dithering

Dimmed for True Color (PNG or BMP).

You can select between three types of dithering with these options. Choosing None means there will be no dithering, Ordered 
using an ordered (regular) dithering pattern and Error diffusion uses error-diffused dithering (a more complex dithering 
technique). In general, error diffusion will give the best results, but only use dithering when really necessary as it prevents the file 
compression working so well and so makes files larger. You cannot use Ordered dithering with an optimized palette.

Note that you can set the dithering type for the screen display too, see Changing the screen dithering.

Palette

Dimmed for True Color (PNG or BMP).

Choose between browser palette, WebSnap palette and optimized palette

Color Depth

Choose the number of colors your bitmap requires. The more colors, the larger the bitmap file. (Except PNG format where True 
color may give smaller files than 256 colors).

Transparent bitmaps with 256 colors or less use one of the colors for the transparency. This means a 2 color transparent bitmap 
has one color plus transparency.

Colors used

Dimmed for BMP format and PNG True Color.

With this field, you can specify how many colors in the palette of the bitmap are actually used. This means you can create, for 
example, an 256 color bitmap where only 100 of the 256 palette entries are used. The least used colors are discarded first. This 
can mean that distinctive colors are discarded (for example a small area of red in a largely blue graphic). If this happens, you can 
restore the color to the palette using Restore.

With some experimentation you can alter this setting to create bitmaps that are very small by reducing the number of colors until 
the quality is just at the level you will accept.

Palette colors

GIF, PNG & BMP (up to 256 colors only)

This displays the range of colors in the current palette. Click on a color to select it.

You can edit any of the colors if you want extra control - see Editing colors in the export palette. 

To check where colors are used in the bitmap, select the Color Selector button (between the two previews). Then, as you move 
over the image in the Preview window, the color under the pointer is highlighted in the palette.

Small squares on the colors give you extra information about the color.

Buttons

Dimmed for True Color (PNG or BMP).

These buttons (except Transparent background) apply to the selected color: click on a color in the palette (above the buttons) to 
select it. You can also select these options by right-clicking on a color, then selecting from the pop-up menu.

(Lock): always include this color in the palette. This is useful if you are reducing the number of colors in the palette. For more 
information see Locking a color.

(Web-safe): snap this color to the nearest color in the 216-color Netscape Navigator and Microsoft Internet Explorer palette. 
This means the color isn't dithered on 256-color displays and so looks better. For more information see Making a color web-
safe.

(Transparent background): dimmed for BMP format and PNG True Color.    Make transparent any areas not covered by the 
selected objects. Selecting this option automatically makes one entry in the palette transparent. Note to CorelXARA users: 
this duplicates Transparent on the Options tab.

(Transparent): make this color entry transparent. GIF and PNG (256-colors or fewer) can have simple on-off transparency by 
making entries in the palette transparent. Note the difference between this option which makes parts of the selected objects 
transparent and Transparent background which makes transparent those areas behind the selected objects. For more 
information see Making a color transparent.

(Delete): delete this color from the palette. Any areas in the bitmap that use the deleted color then use the nearest color in the 
palette. The fewer colors in the palette the smaller the bitmap file. Click R to undo a delete. For more information see 
Deleting a color.



(Restore): undelete this color.

(Add system colors): dimmed for BMP format and PNG True Color. Adds 28 colors to the palette. These colors are the regular 
Windows system colors and a number of primary colors. This ensures the palette includes a spread of colors and may 
improve the quality of the image, particularly if it contains a wide range of colors. You may need to experiment with this 
option to get the best results.

Sort By:

Controls the order in which colors are displayed in the palette. This option applies only to the display in this dialog box. It has no 
effect on the exported bitmap nor on the actual colors. Options:

Importance - arranged by the contribution each color makes to the appearance of the bitmap.
Popularity - arranged by the area each color covers.
Luminance - arranged by the RGB brightness of the colors.
Hue - arranged by hue.



Bitmap Export Dialog Box - Preview Button

No longer exists.

Click this button to display the bitmap in the selected Preview Box. This is useful for finding the best settings for a particular 
bitmap. For more details, see Previewing bitmaps.



Bitmap Export Dialog Box - Preview boxes

These let you preview the appearance of the graphic before you export it. This is particularly important for web graphics where 
selecting suitable parameters reduces the file size without significantly reducing image quality. You can also swap between 
different bitmap formats (GIF, PNG, BMP, & JPEG) to check which works best. The Preview Boxes make this checking quick and 
easy. For more details see Previewing bitmaps.

More information on the Zoom, Push and Color Picker buttons.

In the various tabs set the options you want to try. This automatically updates the preview.
If these options are worse than the previous settings, you can try again and overwrite the last preview image.
If the options are better and you want to try to get further settings, click on the other Preview Box to overwrite that image. 

This preserves the current best settings. 

When you are satisfied with the results, select the best preview and click Export.

You can also preview the graphic in your browser using the Browser Preview tab. This is useful as a final check or when testing 
image maps.



Bitmap Export Dialog Box - Size (and Resolution)

This section is not present if you are exporting a bitmap from the Bitmap Gallery. If you are exporting an existing bitmap, you 
cannot resize it.

Bitmap Size and Resolution

The size of the exported bitmap can be set in two ways:

Resolution Type the resolution into the dpi field. The Width and Height are calculated from this to ensure the aspect ratio of 
the area being exported is fixed.

Size Type the required width or height into one of the fields. Note that the aspect ratio of the drawing is fixed so only 
one dimension can be set - the other is calculated automatically.

Tip
Choosing a resolution of 96dpi ensures the bitmap is the same size as the objects on screen (at 100% magnification)..



Bitmap Export Dialog Box - TIFF Compression

You can export TIFF files in compressed format. Available compression types are:

24bpp None, LZW

8bpp None, LZW

4bpp None

1bpp None, Huffman, Group 3 Fax, Group 4 Fax, Packbits



Bitmap Export Dialog Boxes

Xara X can create bitmaps from the selected document and export them in a variety of different formats. The following list contains 
links to all the pages describing the dialog boxes used for exporting bitmaps. If you want to know how to create bitmaps, see 
Creating bitmaps.

JPEG Export dialog box
GIF Export dialog box
BMP Export dialog box
TIFF Export dialog box
DCX Export dialog box
PCX Export dialog box
PICT Export dialog box
PNG Export dialog box
RAS Export dialog box
TARGA Export dialog box
WPG Export dialog box

_______________

Related Topics

List of Supported File Formats



 Bitmap Gallery (Utilities Menu)    F11

Bitmap Gallery on the Utilities menu and the Bitmap Gallery button open the Bitmap Gallery if it is closed and close it if it is 
open. The button remains pressed in if the gallery is open. For more details, see the Bitmap Gallery Overview.



Bitmap Gallery - Background Button

Clicking this button sets the selected bitmap as the page background. For more details, see Changing the background.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Bitmap Properties Button

Click the Properties button to open the Bitmap Properties dialog box. With this dialog box you can change the smooth scaling 
setting for a bitmap.

You can also set the delay and restore settings for a bitmap to be exported as a frame in an animated GIF file. We recommend 
using the Frame Gallery (not the Bitmap Gallery) to create animations.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Delete Button

The Delete button in the Bitmap Gallery deletes the bitmaps selected in the gallery, from the document. This operation cannot be 
undone, though Delete is generally unnecessary as unused bitmaps are automatically deleted when the document is closed or 
saved. You can also delete a bitmap using the pop-up menu.

Note
You cannot delete the default bitmap.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Fill Button

The Fill button in the Bitmap Gallery applies the bitmap selected in the gallery as a bitmap fill to the selected objects. If no objects 
are currently selected, the current fill attributes are set to use this bitmap as a fill. This means all objects drawn from then on will be 
filled with the bitmap.

You can also drag-and-drop the bitmap onto an object to apply it as a bitmap fill (CTRL-drag to apply inside) , double-click it to 
apply it to the selection (CTRL-double-clicking closes the gallery afterwards) or right-click on the bitmap in the gallery to open the 
pop-up menu and choose Apply as a Fill.

For details of editing the bitmap fill afterwards, see Editing a bitmap fill.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Insert Button

The Insert button in the Bitmap Gallery inserts the currently selected bitmap into the selected document. Any bitmap in the gallery 
can be inserted into the selected document, even from other sections of the gallery. This means this button can be used to copy 
bitmaps between documents.

You can also drag-and-drop the bitmap onto a blank part of the page to insert it or open the pop-up menu over the bitmap and 
choose Insert. Note that if you drop the bitmap onto an object it will be applied as a bitmap fill - drop it on a blank area of the page 
to insert it.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Options Button

The Options button in the Bitmap Gallery opens a menu containing the single option, Find. By selecting this option you can 
search the Bitmap Gallery. For more details, see Searching a gallery.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Plug-ins Button

This button opens the Bitmap Effects & Plug-ins menu ready to edit the bitmap selected in the gallery.

_______________

Related Topics

Bitmap Gallery Overview
Applying bitmap special effects
Installing plug-ins



Bitmap Gallery - Pop-up Menu

Right-clicking on the Bitmap Gallery opens a pop-up menu which contains the following options:

Insert Identical to the Insert Button.

Apply as a Fill Identical to the Fill Button.

Apply as Transparency Identical to the Transparency Button.

Delete Identical to the Delete Button.

Save Identical to the Save Button.

Trace Identical to the Trace Button.

Plug-ins Identical to the Plug-ins Button.

Properties Opens the bitmap properties dialog box. Click the Help button in the dialog box for more 
details.

Set Page Background Sets the page background using the selected bitmap. See Changing the background.

Options Identical to the Options Button.

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.

Right-clicking on a bitmap in the gallery selects that bitmap, so opening the pop-up menu over a bitmap allows you to operate on it 
directly.



Bitmap Gallery - Preview Button

Click this button to preview the selected bitmap. If you have multiple bitmaps selected, you see a scrolling display of the selected 
bitmaps.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Save Button

The Save button in the Bitmap Gallery opens the Export dialog box so you can save the selected bitmap in any of the supported 
bitmap export formats (see the List of Supported File Formats). Note that you will not be able to alter the size (resolution) or color 
depth (number of colors) of the bitmap when you export it.

Tip
To save a bitmap more quickly, right-click on it to open the pop-up menu (this also selects the bitmap) and choose Save.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Trace Button

The Trace button in the Bitmap Gallery opens the Bitmap Tracer dialog box ready to trace the bitmap selected in the gallery. The 
tracing process converts a bitmap to a set of shapes. To trace a bitmap quickly, right-click on it to open the pop-up menu (this also 
selects the bitmap) and select Trace. To find out how to use the tracer, see Bitmap Tracer.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Gallery - Transparency Button

The Transparency button in the Bitmap Gallery applies the bitmap selected in the gallery as a bitmap transparency to the 
selection. If no objects are currently selected, the current transparency attribute is set. This means all objects drawn will have the 
bitmap applied as a bitmap transparency. For details of editing the bitmap transparency, see Changing bitmap transparency.

You can also apply a bitmap as transparency by opening the pop-up menu. over the bitmap (this also selects it) and choosing 
Apply as Transparency.

_______________

{button ,KL(`bitmap gallery,bitmap gallery overview',0,`____No_Topics_Found',`')}    Related Topics



 Bitmap Gallery Overview
 F11

The Bitmap Gallery shows all the bitmap objects that are currently being used in each of the loaded documents. It is used to view, 
insert, delete, and apply bitmaps as fills or transparency. It can also be used to choose bitmaps for use with other Xara X features 
such as the Tracer and bitmap plug-ins. The gallery is divided into sections, one for each document currently open.

Insert Insert the bitmap into the selected document.

Fill Apply the bitmap as a bitmap fill to the selection.

Transp Apply the bitmap as a bitmap transparency to the selection.
Delete Delete the bitmap from the document.

Background Sets the background of the document
Trace Open the Bitmap Tracer to trace the bitmap.
Plug-ins Apply Bitmap Effects to the bitmap.
Options Bitmap Gallery options.
Save Save the bitmap.

Properties Opens the bitmap properties dialog box.
Preview Displays a full-size preview of the selected bitmap(s).

Many operations using the Bitmap Gallery are made easier by the Bitmap Gallery pop-up menu.

Display Options

The Bitmap Gallery has only one mode available - Full Information.

Note

If you delete a bitmap from a document it remains in the Bitmap Gallery until you close the document. To remove it from the 
gallery, select it and click the Delete button.

_______________

Related Topics

Applying bitmap fills
Applying bitmap transparency
Selecting items in galleries
Galleries overview
Bitmaps overview



Bitmap Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a bitmap, it contains the following options:
Plug-ins
Bitmap Tracer
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting

- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



Bitmap Properties Dialog Box

This dialog box shows the information about the selected bitmap. To display it, select the bitmap in the Bitmap Gallery then click 
Properties.

Name
Format
Size (K)
Dimensions (Pixels)
Colors
Transparent

GIF Animation
Delay (the time this frame is left on screen)
Restore
Smooth when scaled up



 Bitmap Tracer (Utilities Menu)

The Bitmap Tracer dialog box allows you to convert a bitmap image into a set of shapes. The tracer would typically be used to 
trace two types of artwork, photographs and line art (for example a logo). If you have trouble producing what you want, see Bitmap 
Tracer Troubleshooting.

When you open the tracer it shows a bitmap on the left-hand side. This bitmap will be the one you selected in the Bitmap Gallery, the one selected in your document or the default bitmap. If you want to change the bitmap, select one from the drop-down list under the bitmap. You can change the bitmap using the drop-down list. For more details on how to trace a bitmap, see Tracing a bitmap.

Bitmap Tracer Buttons
Insert
Trace
Reset Settings
Save Settings
Defaults

Bitmap Tracer Settings
Trace Mode
Passes
Remove Noise
Minimum Area
Initial Color Tolerance
Final Color Tolerance
Accuracy
Smoothing



Bitmap Tracer Dialog Box - Accuracy

This controls how accurately the tracer follows the outlines of the original bitmap. The more accurately it traces the outlines, the 
more control handles are required on each shape and hence more memory is required for the final object.

This setting does not affect the corners of shapes, only smooth curves.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Defaults Button

This button restores the tracer settings to the 'factory default'.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Final Color Tolerance

Color tolerance is how great a color change is required before the tracer considers two areas to be a different color.

This setting is used for the final pass. It is similar to merging the edges of color transitions to simulate shading.

As a trace proceeds, the color tolerance is reduced from the initial value to the final value, so the initial value must be the larger.

For a trace using only a single pass only this value is used - Initial Color Tolerance is ignored.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Initial Color Tolerance

Color tolerance is how great a color change is required before the tracer considers two areas to be a different color.

This setting is used for the first of multiple passes. It is similar to the broad brush strokes used to create the underlying colors on a 
conventional painting.

As a trace proceeds, the color tolerance is reduced from the initial value to the final value, so the initial value must be the larger.

For a trace using only a single pass this value is ignored - see Final Color Tolerance.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Insert Button

This button inserts the current tracer output into the current document. This button is dimmed if you have not yet traced the bitmap.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Minimum Area

Areas smaller than the size (in pixels) set in Minimum area are ignored by the tracer. An example of its use would be a photo 
containing large amounts of fine details (for example grass).

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Passes

The greater the number of passes, the longer the trace operation takes, the greater the resultant file size, but the final result is 
closer to the original bitmap.

With each pass the tracer attempts to more closely match any shading in the original bitmap. Obviously this increases the memory 
required for the final object. You may require an object with minimum shading and just broad areas of color. Use one pass for such 
bitmaps.

If you require the shading to be represented accurately, use multiple passes. the greater the number of passes, the longer the 
trace operation takes, the greater the resultant file size, but the final result is closer to the original bitmap.

With each pass the tracer attempts to more closely match any shading in the original bitmap. Obviously this increases the memory 
required for the final object. You may require an object with minimum shading and just broad areas of color. Use one pass for such 
bitmaps.

If you require the shading to be represented accurately, use multiple passes.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Remove Noise

Noise is very common in bitmaps. It can occur because of random interference or possibly through techniques such as dithering.

When tracing bitmaps containing noise, you should set Remove Noise to a high setting. This control removes noise by ignoring 
very small areas of color.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Reset Setting Button

This button restores the settings to those saved using the Save Settings button.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Save Settings Buttons

This button saves the current tracer settings. The saved settings will be used the next time the tracer is opened. The settings are 
saved between Xara X sessions.

The settings are saved separately for each color 'mode' so the monochrome mode tracing settings are separate from those saved 
for the True Color mode and so on.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Smoothing

This controls how accurately corners (sharp changes in direction) are traced. Increasing the smoothing takes longer to trace the 
image, but can reduce the final object size.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Trace Button

This button starts the tracer. A trace can be stopped at any time by pressing ESC (Escape).

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Dialog Box - Trace Mode

This drop-down list lets you specify the maximum number of colors in the final object. The color depths available are:
Monochrome - 2 colors
Grayscale  - 256 shades of gray
256 color  - 256 colors
Photographic - 16 million (24 bit) colors

Selecting more colors than exist in the original bitmap wastes memory and is not recommended. The only time increasing the 
colors is useful is when tracing a heavily dithered 256 color bitmap and you want near-photographic quality.

Each of these modes has its own set of parameters which are all saved using the Save Settings button.

_______________

Related Topics

Bitmap Tracer



Bitmap Tracer Troubleshooter

With the Bitmap Tracer (Bitmap Tracer on the Utilities menu) you can convert a bitmap into a series of lines and shapes. To get the 
best results with complicated bitmaps you may need to fine tune the tracer, here's a few hints and tips to help you get the results 
you want.

What's the problem?

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Too_Many_Handles')}    Too many handles on each shape

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Too_Many_Shapes')}    Too many shapes

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Trace_Not_Accurate_Enough')}    Trace not accurate enough

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Trace_missing_small_areas')}      Trace missing small areas  

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Tracing_is_too_slow')}      Tracing is too slow  

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Sharp_edges_look_blurred')}      Sharp edges look blurred  

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Thrashing')}      Tracing accesses the disk frequently or runs out of memory  

{button ,JI(`',`IDH_How_Tracer_Troubleshooting_Too_much_detail')}      Tracer spends too long on the detail  



Sharp edges look blurred

Try the following:
Use the 256 Colors mode if currently using True Color.
Use the Monochrome mode if currently using Grayscale.
Reduce the Noise Removal setting.
Increase the Final Color Tolerance setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Too many handles on each shape

If the bitmap uses dithering - increase the Remove Noise setting.
If the handles are evenly spaced along the lines - reduce the Accuracy setting.
If the handles are clustered around the corners - increase the Smoothing setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Too many shapes

Too many small shapes - increase the Minimum Area setting and possibly increase the Reduce Noise setting.
Too many shapes of a similar color - increase the Final Tolerance setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Trace Not Accurate Enough

... at the corners - decrease the Smoothing setting.

... in smooth areas (along lines) - increase the Accuracy setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Trace missing small areas

Reduce the Minimum Area setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Tracer spends too long on the details

Try the following:
Reduce the number of Passes.
Increase the Initial Color Tolerance setting.
Decrease the Minimum Area setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Tracing accesses the disk frequently

Reduce the bitmap size using Bitmap Resize
You have selected too many colors for the bitmap.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Tracing is too slow

Try the following:
Decrease the Passes setting.
Reduce the Smoothing setting.
Reduce the bitmap size using Bitmap Effects (Utilities menu).
Increase the Minimum Area setting.

{button Return,JI(`',`IDH_How_Tracer_Troubleshooting')}



Bitmaps Overview

A bitmap is a picture composed, of small 'dots' called pixels. Bitmaps are created using a variety of programs such as Microsoft 
Paintbrush, CorelPaint and Photoshop or taken from scanners or CD. You can import and export all common bitmap formats and 
provides a variety of methods of manipulating and using them.

Importing and Exporting Bitmaps

You can import and export a very large range of different types of bitmaps. For a full list, see the List of Supported File Formats. 
Xara X supports many features which make it ideal for creating bitmaps for publication on the Internet. For more details, see 
Creating bitmaps (or the Internet Bitmaps Overview). Exported bitmaps are limited in size to 16,000 pixels by 16,000 pixels.

Changing Bitmaps

Bitmaps can be resized, rotated and reflected. When you resize a bitmap, Xara X smooths (interpolates) between the individual 
pixels to give a smooth look to the bitmap. Usually this gives the best result. However you might not want this effect - in this case 
you can turn off smoothing for either all bitmaps in the document or a single bitmap.

You can change their brightness, contrast and the number of colors they contain. You can also apply a wide variety of effects to 
them including blurring and sharpening. For more details, see Plug-ins. You can also change the colors in a bitmap (contoning). 
See Changing bitmap palettes for more details.

Masking Bitmaps

You can remove unwanted areas of bitmaps very easily. See Masking a bitmap for more details.

Using Bitmaps As Fills

Any bitmap can be used to fill other objects. For example, you can fill shapes or text with a tessellating bitmap. This is called a 
bitmap fill. For details on how to apply a bitmap fill to an object, see Applying bitmap fills.

Making Bitmaps Transparent

You can make any object transparent and this includes bitmaps. You can use any of the different shapes of transparency (flat, 
linear, circular and so on).

This picture consists of two bitmaps. The top bitmap has a linear transparency allowing you to see the other bitmap through it.

Using Bitmaps to Set Transparency

Xara X includes a wide range of shapes of transparency, one of which is bitmap transparency. If you apply a bitmap transparency 
to an object, its transparency is set by the brightness of the pixels in the bitmap.

The top shape in this example is a black rectangle with a bitmap transparency applied to it. Note how the amount of the image you 
can see underneath is set by the level of gray of the bitmap used for the transparency. For more details, see Applying bitmap 
transparency.

Movies

{button ,EF("XaraDemo.exe","Bitmaps Bitmap Editing",1,`') } Changing bitmaps

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Tracer Tracing Bitmaps",1,`') } Using the bitmap tracer



{button ,EF("XaraDemo.exe",`Beffects Bitmap special effects',1,`') } Bitmap special effects

_______________

Related Topics

Bitmap effects
Bitmap Gallery
Fill Gallery



Blend Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a blend, it contains the following options:
Blend Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Anti-alias Button

The Anti-alias button on the Blend Tool Infobar sets whether the intermediate shapes in the currently selected blends are anti-
aliased. For more details see Anti-aliasing steps in a blend.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Attribute Profile

This lets you select how attributes (such as transparency, colors or line thickness) change in a blend. You can have a regular rate of 
change, greater change at one end, or greater change in the center. For more information, see Changing the blend attribute profile.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Blend along a curve

Dimmed unless you have either (a) a blend and a line, bitmap or shape selected or (b) a blend along a curve selected.
If you have a blend and a line, bitmap or shape selected: fit the blend to the line or outline of the shape. Note that this converts 
QuickShapes to simple shapes (that is, you cannot later use the QuickShape Tool to edit them). Also select Rotate along Curve if 
you want the blend objects to orient with the curvature of the line or shape. See Blending along a curve.

If you have a blend along a curve selected: separate the blend from the line or shape.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Effect Field

The Effect field on the Blend Tool Infobar provides control of the way the colors in the currently selected blend change through the 
blend. For more details, see Changing the way color fade in a blend.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Steps Field

The Steps field on the Blend Tool Infobar controls the number of intermediate steps used in the currently selected blend. You can 
either:

specify the number of steps
or specify the average distance between steps (see Notes). 

To change the number or distance between steps, select one of the two options then enter a new value and press RETURN. For 
more information, see Changing the number of steps in a blend.

Notes on distance:
The Distance option is dimmed except for a blend along a curve.
If the end object is not on an exact multiple of the distance, Xara X moves the end object. (For example, if the distance 

between the start and end objects is 1 inch and you enter a distance of 0.3 inches, Xara X moves the end object to 0.9 inches from 
the start object [3x0.3 inches].)

The distance between steps varies if you use a non-linear Position Profile. The value shown is the average distance.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - One to One Button

The one to one setting on the Blend Tool Infobar only has an effect when both objects in the selected blend have the same number 
of point handles (if the objects are not shapes, the number of point handles they would have if they were converted must be the 
same).
When the one to one preference is not set, Xara X will add or removes points, as necessary, to blend one shape to another. When 
blending shapes with the same number of handles, this can produce unwanted effects. Selecting this button ensures that no points 
are added or removed during the blend.

    

          1-1 Mapping            No 1-1 Mapping (points added)

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Position Profile

This lets you select how to space the intermediate steps in a blend. You can have regular spacing or closer at one end than the 
other or closer in the center. For more information, see Changing the blend position profile.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Remove Button

The Remove button on the Blend Tool Infobar removes any applied blends from the selection. For more information, see Removing 
a blend.

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 Blend Tool - Rotate along Curve

Dimmed unless you have a blend along a curve selected.
With this button selected, the objects in the blend follow the curvature of the line or shape:

With this button unselected, the objects retain their original orientation:

_______________

{button ,KL(`tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



 

 Blend Tool    F7
You can use the Blend Tool to blend between objects creating several intermediate shapes. For more details on what you can do 
with blends, see the Blends Overview.

Blend Tool Infobar Controls
Distance between Steps/Number of Steps

Remove
Effect

Position Profile
Attribute Profile
One to One
Anti-alias

                                                  Blend along a curve  

Rotate along a curve 

Blend Tool Operations

Blending objects

Removing a blend

Creating a two-way blend

Changing the number of steps in a blend

Creating multi-stage blends

Changing the way colors fade in a blend

Anti-aliasing steps in a blend

Blending along a curve

Removing a blend from a curve

Movies

{button ,EF("XaraDemo.exe","Blend Simple Blending",1,`') } Blending objects

{button ,EF("XaraDemo.exe","BlendFun Advanced Blending",1,`') } Blending objects - Advanced

Tips
You can blend between any type of objects.
Objects used in blends can be edited without removing the blend first. See Selecting objects inside objects.
You can apply attributes to an object inside a blend by holding down CTRL when you drop the attribute on the object.
You can also choose the Blend Tool using the Blend Pop-up Menu.



Blending along a curve

After creating a blend you can make it follow a curved line or shape.
To blend along a curve

1. Select both the blend and the line or shape (see Selecting objects).

2. Select the Blend Tool.
3. Select the Blend along a curve button.

4. If you want the blend objects oriented with the curve also select Rotate along curve.

Tips:
You can use lines, shapes (including QuickShapes) and bitmaps. Note that QuickShapes and bitmaps are automatically 

converted to ordinary shapes.
The start of the blend (where you dragged from) is fitted to the start of the line or shape (where you started creating the 

line or shape from).
You can edit the curve using the Shape Editor Tool.
You can make the line or shape invisible; see Hiding the curve.
For blend along a curve, you change either the number of steps or the distance between steps - more details.

_______________

Related Topics

Blends
Blend Tool



Blending bitmaps

Using transparency and blending it is possible to create simple pseudo-morphing effects with Xara X.
To morph bitmaps

1. Convert both bitmaps to simple shapes (see Converting bitmaps to shapes).
2. Resize the bitmaps so they are the same size and shape (see Scaling objects).
3. Group the bitmaps (see Grouping objects).
4. Duplicate the group (CTRL+D.)
5. Move the duplicate group away from the original group (see Moving objects).
6. CTRL-click on the new group to select the top shape in it (see Selecting objects in objects).
7. Use the Transparency Tool to give it 100% transparency (see Applying flat transparency). You should now be able to see the 

lower shape.
8. Blend the two groups together (see Blending objects).

Tip
If you only require one 'frame' from the sequence, apply Convert to Editable Shapes to the blend, ungroup and remove 

the required section. See Converting blends to shapes.



Blending objects

Blends let you merge one object into another using a series of intermediate objects (called ‘steps’). This process is sometimes 
called 'morphing' or 'tweening'. The two objects can be any of Xara X's object types including bitmaps and even other blends. The 
intermediate steps are calculated by Xara X when the object is displayed on screen so blends take up virtually no memory.

To blend between objects
1. Choose the Blend Tool.
2. Move the pointer over the first object.
3. Drag to and release over the second object.

Tips
When blending between two objects with the same number of points you may find selecting the 1 to 1 Button on the Blend 

Tool Infobar gives better shaped results. See One to One Node Mapping button for more details.
Sometimes the steps are not the shape you want. For extra control, you can drag from a corner (or handle) on one object 

to the corner of the second. Blending between different corners produces different blends. This is how you can put twists in blends.
The blend steps are not separate objects. To make them selectable, you need to convert the blend to simple editable 

shapes. See Converting blends to shapes.
Blending objects in different layers moves the objects into the same layer.
If you blend between two bitmaps, the blend shows the first bitmap for all steps except the last. (See Blending bitmaps for 

a way of getting round this).
For details on how to blend between two blends, see Creating two-way blends.

Movie

{button ,EF("XaraDemo.exe","Blend Simple Blending",1,`') } Blending objects

_______________

Related Topics

Blends
Blend Tool



Blends Overview

You can use the Blend Tool to blend between two objects. The program creates a set of intermediate objects so you get a 
transition from the start object to the end object. you can change the number of steps in the blend and also have more than one 
stage so you can blend between several objects.

Simple Blends

These are quite simple blends. A simple transition from one object to another. Notice how you can blend from any type of object to 
any other type of object (the bottom example includes a letter X). To blend two object, just choose the Blend Tool and drag from 
one object to another. For more details, see Blending objects.

Highlights

If you blend from one object to another which is on top of and smaller, you can easily create highlights. These are a sort of custom 
graduated fill.

Two-dimensional Blends

Using a special trick, you can create one blend and then blend between a copy of it to create an object which blend in two 
directions. For more details, see Creating two-way blends.

Movies

{button ,EF("XaraDemo.exe","Blend Simple Blending",1,`') } Blending objects

{button ,EF("XaraDemo.exe","BlendFun Advanced Blending",1,`') } Blending objects - Advanced

_______________

Related Topics

Blends
Blend Tool



Blur the edges of the shadow

This changes the size of the shadow. A small blur gives the effect of a sharp light source; a large blur, a diffuse or distant light 
source. We recommend always blurring the shadow slightly as this is more realistic.

To blur the shadow edge
1. Select the object (see Selecting objects). (See Notes.)
2. Choose the Shadow Tool. 
3. On the Shadow Tool Infobar either drag the Blur slider or type a value into the text box to the right.

Notes:
You can also use the Shadow Tool to select objects - more details.
You can change the opacity of the center of the shadow (and hence the opacity of the inner edge of the blur) - more 

details. The outer edge of the blur is always totally transparent.
You can profile how the transparency changes across the blur. See Changing the shadow profile.
If you have several shadowed objects selected, any changes apply to all the shadows.

Movies

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



 Break Shapes (Arrange Menu)

Break Shapes splits any selected shapes previously joined with Join Shapes (see Join Shapes) into their individual component 
shapes.



Breaking lines and shapes apart

You sometimes want to break a line into two separate lines or break a shape to create a line.
To break a line or shape apart

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool or the Pen Tool.
3. Click on the point handle where you want the line or shape to break (this selects the handle).
4. Click on the Break Button on the Shape Editor Tool Infobar or press B.

Tip
You may want to break the line where there is no existing point handle. If so, in step 3 click on the line where you want the 

break. This creates a new point handle. Then click the Break Button.

_______________

Related Topics

Shape Editor Tool
Pen Tool



 Bring To Front (Arrange Menu)    CTRL+F

Moves all the selected objects to the front of the layer or frame. For more details, see Moving objects backwards and forwards.



 Button & NavBar Tool - Button State

This lets you view the different button states in rollovers. (Navigation bars without rollovers have just one state - MouseOff.)
Xara X creates layers named MouseOff, MouseOver, MouseDown and Selected for the button states. You can view these layers 
using either this drop-down list or the Layer Gallery.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - Bar Properties

Clicking Bar properties opens the NavBar Properties dialog box ready for editing the current navigation bar. You can change a 
range of properties including the number of buttons in the bar and the button spacing.
Drawings can have multiple navigation bars so, if necessary, select the required navigation bar before clicking Bar properties.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - Edit States

This lets you change single-state buttons into multistate rollover buttons. The existing button design becomes the MouseOff state 
button. Clicking the button opens the Edit States dialog box, which lets you create and delete MouseOver, MouseDown and 
Selected button states. (Rollovers create more complicated HTML code on the web page. If you are an Internet novice, we suggest 
using only simple bars.)

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - Export Button

Clicking this button exports the graphics for the selected toolbar and associated HTML code. You can view the HTML page in your 
regular browser to check the appearance of the buttons. You can then copy parts of the HTML page into your web page. For more 
information see Creating Navigation Bars.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - Live Stretching

Normally buttons automatically stretch as you type in more text. (Or shrink if you remove text.) If you want to disable this auto-
stretching, deselect Live stretching.
Note that this also switches off linked stretching for button objects. More details of linked stretching.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - New

This button is dimmed if you select an existing navigation bar or if nothing is selected.
New lets you turn the design for a single button into a multibutton navigation bar. Clicking New opens the NavBar Properties dialog 
box ready for creating the new bar.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool - Set new design

Dimmed unless the drawing contains a navigation bar.
This button saves you the trouble of editing each button individually. All you have to do is make the required changes to one button, 
select it and then click Set new design. This displays the Set Design dialog box. In that dialog box click Set design - this updates 
all the other buttons to the new design.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 Button & NavBar Tool    CTRL+F8
Dimmed for Animated documents.

This tool lets you create a series of buttons for use in web page navigation bars. Optionally you can make the buttons rollovers. 
You can then modify the individual buttons as required (for example by changing any wording) and then export them plus the 
associated HTML code. (For rollovers, the required JavaScript is also exported.)

Button & NavBar Tool Infobar Controls

New

Bar properties
 Edit states

Set new design
    Button State

Live stretching
Export the Bar

Against objects in the drawing:

The objects are not part of a navigation bar. You see this before creating a navigation bar.

Either: You have selected a part of a button. Or one of the objects has a name associated with it.

Either: You have selected the entire button. Or (before creating a navigation bar) one of the objects has a name associated with 
it.

Movies

{button ,EF("XaraDemo.exe",`NavBar Creating Navigation Bars',1,`') } Creating Navigation Bars

{button ,EF("XaraDemo.exe",`Rollover Creating JavaScript Rollovers',1,`') } Creating JavaScript rollovers

{button ,EF("XaraDemo.exe",`Dreamwv Dreamweaver integration',1,`') } Dreamweaver integration

Button & NavBar Tool Operations
Creating Navigation Bars
Creating Rollovers



Button Palette Control Bar

The button palette is a special control bar which contains a copy of every button in the program. If you want to create a custom 
bar, you can use the button palette to do it.

To open the button palette
1. From the Window menu, choose Control Bars.
2. In the Control Bars dialog box, scroll down the list until you see Button Palette.
3. Click the switch next to Button Palette.

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Cascade (Window Menu)

Cascade shows all the open document views stacked diagonally.



Change a Name Dialog Box

This dialog box lets you change the selected name in the Name Gallery. Type the name and click OK. This only affects the name 
shown in the Name Gallery; it has no effect on the appearance of the document. For more details, see Naming objects overview.



Changing the tiling of circular fills

You can change circular fills so the outer color extends out to infinity or so the fill repeats as a series of rings.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying circular fills
Changing circular fills



Changing the size or direction of the shadow

After applying a shadow you can change its size.
Changing the direction (position) of a Wall shadow
Changing the size or direction of a Floor shadow
Changing the size of a Glow shadow (Glow shadows are directly behind the object so there is no "direction" to change)

Tip:
If you have several shadowed objects selected, any changes apply to all the shadows.

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



Change the transparency of the center of the shadow

A semitransparent shadow is more realistic than a solid shadow. You can change the transparency of the center of a shadow; the 
outer edge is always totally transparent.

To change the transparency:
1. Select the object (see Selecting objects). (See Notes.)
2. Choose the Shadow Tool. 
3. On the Shadow Tool Infobar either drag the Transparency slider or type a value into the text box on the right.

Notes:
You can also use the Shadow Tool to select objects - more details.
You can profile how the transparency level changes across the blur. See Changing the shadow profile.
If you have several shadowed objects selected, any changes apply to all the shadows.
The shadow is always more transparent than the object casting the shadow. For example if the object is 50% transparent, 

then the shadow can be 50% to 100% transparent.

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_____________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



Changing the position of a color in a multi-stage fill

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

To change the position of a color in the fill

The Fill arrow shows a handle for each color in the fill.
1. Drag the color handle along the arrow.

Notes:
Conical fills have a semicircular Fill arrow. Other fill types have straight Fill arrows. Always drag colors along the arrow.
Elliptical and Diamond fills have a pair of Fill arrows. You can apply colors to only one of these arrows. (The arrow that 

was horizontal when you created the fill - this is the "primary" arrow.)
The Selector Tool can also display the Fill arrow. See Enabling fill handles.

_______________

Related Topics

Creating multi-stage fills
Changing multi-stage fills
Fill Tool



Changing the properties of a brush stroke

Brush strokes control the appearance of lines (for example, to apply an air-brush effect). You can modify Brush Strokes for 
example by rotating the pattern along the line.

To change the brush stroke properties
1. Select the Freehand & Brush Tool.
2. Either:

if the selected line uses the brush design, skip to Step 3,
click on an unselected line that uses that brush design,
or select the brush design in Select brush on the Freehand & Brush Tool Infobar. 

4. Click Edit brush on the Freehand & Brush Tool Infobar. This opens the Edit Brush dialog box.

_______________

{button ,KL(`brush strokes',0,`',`')}    Related Topics



Changing transparency type

Xara X has several different transparency types, which control how colors in underlying objects appear. You can change between 
these types at any time. Mix is the most commonly used. The other types are usually used as filters to modify the colors of 
underlying objects. 

How to change transparency type
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose from the drop-down list on the Transparency Tool Infobar.

List of transparency types

Normal blends the object color with the color of underlying objects or the background. Other types give different effects such as 
darkening underlying objects or color shifts. These are commonly used as filters or overlays.

Mix
Stained Glass
Bleach
Contrast
Saturation
Darken
Lighten
Brightness
Luminosity
Hue

Tip
See Changing transparency for information on changing other features of transparency

_______________

Related Topics

Transparency overview
Transparency Tool



Closing a line to make a shape

A shape is a line where the end points touch. So changing a line into a shape just means either drawing a new segment between 
the start and end points or joining the start and end points together. You can use any of the line drawing tools (Shape Editor Tool, 
Pen Tool or Freehand & Brush Tool) to do this. The mouse pointer changes to show a '+' to show you when the ends will join.

You can also change a line into a shape - details.
To change a line into a shape (Shape Editor Tool)

1. If necessary select the line (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Click on one end point handle to select it.
4. Press RETURN. This adds a new line segment between the two end points

Tips
You can also select one end point handle and click on the other end point handle. This adds a new line segment between 

the two end points.
You can also drag one end point handle over the other end point handle.
To change a line into a shape (Freehand & Brush Tool)

1. If necessary select the line.
2. Choose the Freehand & Brush Tool.
3. Place the pointer over one end of the line (the mouse pointer shows a '+').
4. Drag to the other end of the line. The mouse pointer shows a '+' when you are over the end point.

Tip
You can draw a shape with the Freehand & Brush Tool simply by drawing a line and finishing it at the start point.
To change a line into a shape (Pen Tool)

1. If necessary select the line.
2. Choose the Pen Tool
3. Click on one end point handle to select it.
4. Click on the other end point handle. (The mouse pointer shows a '+' when you are over the end point.)

_______________

Related Topics 

Shape Editor Tool
Pen Tool



Changing a mold without it redrawing

As you edit a mold, the molded object and the mold are redrawn on screen every time you change it. This redraw may be slower 
than usual if the object is complicated. To speed up redraws you can 'detach' the mold from the object. The mold is redrawn after 
each edit but not the object.

To change the mold without it redrawing
1. Select the molded object (see Selecting objects).
2. Choose the Mold Tool.
3. Click the Detach Mold button on the Mold Tool Infobar.
4. Edit the mold as normal (see Reshaping envelope molds or Reshaping perspective molds).
5. Click the Detach Mold button again to redraw the molded object on the screen.

_______________

{button ,KL(`tools,mold tool',0,`____No_Topics_Found',`')}    Related Topics



Changing a polygon into an ellipse

You can easily change a polygon created by the QuickShape Tool into an ellipse.
To change a polygon into an ellipse

1. Select the polygon (see Selecting objects). 
2. Select the QuickShape Tool
3. Double-click on the X in the center of the polygon. 

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



Changing a rectangle into an ellipse

You can easily change a rectangle created by the QuickShape Tool or Rectangle Tool into an ellipse.
To change a rectangle into an ellipse

1. Select the polygon (see Selecting objects)
2. Select the QuickShape Tool
3. Double-click on the X in the center of the rectangle. 

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



Changing a transparency bitmap

Bitmap transparency is one of the transparency options available in Xara X. At any time you can change to a different bitmap to 
control the transparency.

To change a transparency bitmap 
1. Select the transparent object (see Selecting objects).
2. From the Utilities menu, choose Bitmap Gallery to open the Bitmap Gallery.
3. Select the new bitmap in the gallery (see Selecting items in a gallery).
4. Click the Transp button in the gallery.

Tips
You can use fill bitmaps from the Fill Gallery.
You can also use Bitmap name in the Transparency Tool to select a different bitmap.
If the bitmap you want to use is not in the Bitmap Gallery, use Import on the File menu to import it.

_______________

Related Topics

Bitmap transparency
Bitmap Gallery
Fill Gallery



Changing an ellipse into a polygon

You can easily change an ellipse created by the Ellipse Tool or QuickShape Tool into a polygon.
To change an ellipse into a polygon

1. Select the ellipse (see Selecting objects).
2. Select the QuickShape Tool.
3. Double-click on the X in the center of the ellipse. 

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



Changing an object's fill color

You can easily change the color of the center of objects.
To change an object’s fill color

1. Select the object (see Selecting objects).
2. Click on a color on the Color Line (at the bottom of the window).

Tips
There are several other ways of changing the fill color which you may prefer to use:

Drag-and-drop a color from the Color Line or the Color Gallery onto any object (selected or unselected).
Select the object, select the color in the Color Gallery and click the Apply button in the gallery.
Select the object, open the Color Editor and change the color. Note that this makes the object's color a local color.
Select the object and double-click on the current fill color panel on the Color Line. If the object is filled with a local color, 

you can then change it. If the object is filled with a named color, you can edit the named color.
Select the object and open the Color Editor. Then use the Color Picker (the "eye-dropper") to select any color on the 

screen (even colors in other windows).
To remove the fill color of an object (to make it hollow), apply 'No Color' (the hatched square on the Color Line) to the 

object. 
Colors from the Color Line or Color Gallery: any subsequent changes to these colors automatically changes the color of 

the object. See Changing named colors.
If the object is inside another object (for example, as part of a group), hold down CTRL and drag-and-drop from the Color 

Line or Color Gallery. See Apply inside.

When you drag a color, the pointer shows what will happen if you drop it:

The color will be applied as a (flat) fill color or to a color handle of a multi-stage fill.

The color will be applied as a line color.

    The color will be used to set the current fill color attribute. See Setting the current attributes.

Movie

{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

_______________

Related Topics

Color Line
Color Gallery
Color Editor
Colors overview
Changing line color



Changing an object's line color

This lets you change the color of any line including the line around objects. You can also use this to make a line invisible.
To change an object’s line color

1. Select the object (see Selecting objects).
2. Right-click or SHIFT-click on a color on the Color Line.

Note:

If you apply a brush stroke to a line, settings in the Edit Brush dialog box control the types of color (if any) you can change. To 
display the Edit Brush dialog box:
1. Select the Freehand & Brush Tool.
2. Click Edit stroke.
3. Go to the Fill properties tab.

For more information on the Edit Brush dialog box, click its Help button.

Tips

There are several other ways of changing the line color which you may prefer to use:
Drag-and-drop a color from the Color Line (or the Color Gallery) onto the edge of any object (selected or unselected).
Select the object, select the color in the Color Gallery and then CTRL-click on the Apply button in the gallery.
Select the object, open the Color Editor and select "Local Line Color" from the drop-down list. Note that this makes the 

object's line color a local color if it was not already.
Select the object and double-click on the current line color on the swatch on the Color Line. If the object is outlined with a 

local color, you can then change it. If the object is outlined with a named color, you can edit the named color.
Select the object, open the Color Editor and select "Local Line Color" from the drop-down list. Then use the Color Picker 

(the "eye-dropper") to select any color on the screen (even colors in other windows).
To make the line invisible right-click or drag-and-drop 'No Color' (the hatched square on the Color Line). 
Colors from the Color Line or Color Gallery: any subsequent changes to these colors automatically changes the line color 

of the object. See Changing named colors.
If the object is inside another object (for example, as part of a group), hold down CTRL and drag-and-drop from the Color 

Line or Color Gallery. See Apply inside.

When you drag a color, the pointer shows what will happen if you drop it:

The color will be applied as a line color.

The color will be applied as a (flat) fill color.

    The color will be used to set the current fill color attribute. See Setting the current attributes.

_______________

Related Topics

Color Line
Color Gallery
Color Editor
Colors overview
Changing fill color



Changing bitmap fills

Bitmap fills are controlled using a pair of fill arrows joined at one end with three associated fill handles. The arrows point from the 
center of the bitmap to its top and right-hand edges and so control its position and the angles of the sides of the bitmap. The 
central fill handle controls the position of the bitmap. You can change the fill by moving the fill handles (to change the position, 
direction and stretching of the fill), applying different colors to the bitmap (to achieve a contone effect), altering the way the bitmap 
is tiled and changing the resolution (size) of the bitmap. You can also use the Transparency Tool Transparency Type options to 
alter the color of objects underneath the filled object.

What do you want to do?
Change the bitmap
Move bitmap fill handles
Change the colors of a bitmap fill
Change the bitmap fill resolution
Change the bitmap fill tiling
Reduce the resolution of the bitmap in the fill

_______________

{button ,KL(`bitmap fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing bitmap palettes

You can create contone bitmaps by altering their palette. You can use any two colors so you can create, for example, sepia effects.
To change a bitmap palette:

1. Select the bitmap (see Selecting objects).
2. Click on the first color on the Color Line. 
3. SHIFT-click on the second color on the Color Line. 

Tips
If you find the two colors are reversed (black is white and white is black), reapply them from the Color Line the other way 

around.
You can also change the colors using drag-and-drop from the Color Line or Color Gallery onto the center and edge of a 

bitmap.
You can also open the Color Editor and edit the line and fill colors of the bitmap directly. 
An easy way to create a grayscale image from a color one is to drag white from the Color Line and drop it onto the bitmap.
You can also change the brightness and contrast of bitmaps.

Movie

{button ,EF("XaraDemo.exe","Bitmaps Bitmap Editing",1,`') } Changing bitmaps

_______________

Related Topics

Bitmaps overview
Brightness
Color Gallery
Color Line
Colors overview
Contoning



Changing bitmap transparency

Bitmap transparency produces a pattern across the selected objects. You can alter the 'grain' of the bitmap to produce a smooth or 
'lumpy' transparency texture. You can alter the angle, direction and degree of transparency.

What do you want to do?
Change the bitmap
Move bitmap transparency handles
Change the transparency levels
Change the bitmap transparency resolution
Change the bitmap transparency tiling
Change the transparency shape
Change the Transparency Type

_______________

Related Topics

Applying bitmap transparency
Bitmap Gallery
Fill Gallery



Changing circular fills

Circular fills are controlled using a single fill arrow with a fill handle on either end. Each end of the arrow has a color associated 
with it and the fill graduates from the color at the start handle (in the center ) to the end handle on the radius. You can change the 
fill by moving the fill handles (to change the position and direction of the fill), applying different colors to each end or altering the fill 
effect (the way the color changes across the fill). You can also use the Transparency Tool Transparency Type options to alter the 
color of objects underneath the filled object.

What do you want to do?
Move fill handles
Change the colors of a circular fill
Change the fill tiling
Change the fill profile
Change the fill effect
Create a multi-stage fill
Change a multi-stage fill

_______________

{button ,KL(`circular fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing circular transparency

A circular transparency applied to an object is a graduation of transparency from one level to another in a radial fashion. The single 
transparency arrow (pointing from the center of the circle outwards) used to control it has a handle on either end. The length of the 
arrow defines the radius of the transparency graduation and the transparencies at either end defined by the levels applied to the 
handles.

What do you want to do?
Move transparency handles
Change transparency shape
Change the transparency levels
Change the Transparency Type

_______________

{button ,KL(`circular transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing colors in multi-stage fills

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

To change an existing color in the fill

The Fill arrow shows a handle for each color in the fill.
1. Drag-and-drop the new color from the Color Line or Color Gallery onto the appropriate color handle.
or
1. Click the color handle to select it.
2. Choose a color on the Color Line or Color Gallery. Or use the Color Editor to change the color.

To change the start or end colors, see Changing the colors in fills.

Notes:
Conical fills have a semicircular Fill arrow. Other fill types have straight Fill arrows. Always drag-and-drop colors onto the 

arrow.
Elliptical and Diamond fills have a pair of Fill arrows. You can apply colors to only one of these arrows. (The arrow that 

was horizontal when you created the fill - this is the "primary" arrow.)
The Selector Tool can also display the Fill arrow. See Enabling fill handles.

_______________

Related Topics

Creating multi-stage fills
Changing multi-stage fills
Fill Tool



Changing conical fills

Conical fills are controlled using a single semicircular fill arrow with a fill handle on either end. Each end of the arrow has a color 
associated with it and the fill graduates radially from the color at the start handle to the end handle on the opposite side. There is a 
third fill handle in the center of the fill controlling its position. Drag the center handle to move the fill. You cannot select this center 
handle or apply color to it. Dragging the outer fill handles lets you resize the semicircle. Changing the size of the semicircle does 
not affect the fill itself - only rotating the semicircle alters the fill. You can change the fill by moving the fill handles (to change the 
position and direction of the fill), applying different colors to each side or altering the fill effect (the way the color changes around 
the fill). You can also use the Transparency Tool Transparency Type options to alter the color of objects underneath the filled 
object.

What do you want to do?
Move fill handles
Change the colors of a conical fill
Change the fill effect
Change the fill profile
Create a multi-stage fill
Change a multi-stage fill

_______________

{button ,KL(`conical fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing conical transparency

A conical transparency applied to an object is a graduation of transparency from one level to another swept out in a radial fashion. 
The single semicircular transparency arrow used to control it has a handle on each end with an additional handle in the center. The 
handles on the ends of the arrow define the levels on either side of the conical transparency.

What do you want to do?
Move a transparency handle
Change the transparency levels
Change transparency shape
Change the Transparency Type

_______________

{button ,KL(`conical transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing contour size

You can set the size when you create a contour. This page describes changing the size after creation.
To change the contour size

1. Select the contoured object (see Selecting objects). (See Notes.)
2. Choose the Contour Tool.
3. Drag any of the eight handles that surround the selected objects,

or for more precise control, either drag the Width slider,
or type a new value into the text box.
As you drag, you see the outline of the contour.

Notes
You can also use the Contour Tool to select objects - more details.
Dragging the handles lets you swap between inside and outside contours. (Drag the handles inside or outside the objects 

to swap.) For the other options see Swapping between inside and outside contour. Note that lines can have only outside contours.
If you have several contoured objects selected, any changes apply to all the contours.

Movies

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

_______________

Related Topics

Contours
Contour Tool



Changing curved corners on a polygon

Polygons created using the QuickShape Tool can have either sharp or rounded corners.
To change the corner curvature of a polygon

1. Select the polygon (see Selecting objects).
2. Choose the QuickShape Tool.
3. Drag one of the curvature handles. The QuickShape corners become more or less curved as you drag the handle.

_______________

Related Topics

QuickShape Tool
Polygons



Changing curved corners on a rectangle

Rectangles created using the QuickShape Tool can have either sharp or rounded corners.
To change the corner curvature of a rectangle

1. Select the rectangle (see Selecting objects).
2. Choose the QuickShape Tool or the Rectangle Tool.
3. Drag one of the curvature handles. The QuickShape corners become more (or less) curved as you drag the handle.

_______________

Related Topics

QuickShape Tool
Rectangle Tool
Polygons



Changing curved lines and shapes

After drawing a line or shape with curved segments, you can change the angle and direction of the curve.
To change a curved line or shape

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Click on a point handle.
4. Drag either of the two curve handles to reform the line segment.

or
1. Select the line or shape.
2. Choose the Shape Editor Tool or the Pen Tool.
3. Move the mouse pointer over the line. (The pointer changes to an arrow, see below).
4. Drag to reform the line segment.

Drag to reform the line.

Tips
You can use the Selector Tool to move point handles if you have enabled edit handles. See Enabling edit handles.
If the pop-up menu is opened with the pointer over a point handle, it can be used to edit lines and shapes without the 

need to choose the Shape Editor Tool. See Point Handle Pop-up Menu.

_______________

{button ,KL(`point handles;tools,shape editor tool;tools,pen tool',0,`',`')}    Related Topics

Point handles
Shape Editor Tool
Pen Tool



Changing the tiling of diamond fills

You can change diamond fills so the colors extend out to infinity or so the color pattern repeats.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying diamond fills
Changing diamond fills



Changing diamond fills

Diamond fills are controlled using a pair of fill arrows with fill handles on the ends and at the center. The center handle controls the 
position of the fill and one of the two colors. The outer two handles control the size of the fill and the other color. Diamond fills are 
very similar to elliptical fills. You can change the fill by moving the fill handles (to change the position and direction of the fill), 
applying different colors or altering the fill effect (the way the color changes across the fill). You can also use the Transparency Tool 
Transparency Type options to alter the color of objects underneath the filled object.

What do you want to do?
Move fill handles
Change the colors of an diamond fill
Change the fill tiling
Change the fill effect
Change the fill profile
Create a multi-stage fill
Change a multi-stage fill

_______________

{button ,KL(`diamond fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing diamond transparency

An diamond transparency applied to an object is a graduation of transparency from one level to another in a square pattern 
radiating out from the center. The pair of transparency arrows used to control it have a handle on one end and one at their joining 
point. The length of the arrows defines the width and height of the diamond. The transparencies of the center and outer edge are 
defined by the levels applied to the handles. By moving the outer handles you can stretch and squash the diamond. Moving the 
center handle moves the whole transparency.

What do you want to do?
Move a transparency handle
Change the transparency levels
Change transparency shape
Change the Transparency Type

_______________

{button ,KL(`diamond transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing the tiling of elliptical fills

You can change elliptical fills so the outer color extends out to infinity or so the fill repeats as a series of rings.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying elliptical fills
Changing elliptical fills



Changing elliptical fills

Elliptical fills are controlled using a pair of fill arrows with fill handles on the ends and at the center. The center handle controls the 
position of the fill and one of the two colors. The outer two handles control the size of the fill and the other color. Elliptical fills are 
very similar to circular fills, except that the second fill arrow gives extra control over the shape of the fill. You can change the fill by 
moving the fill handles (to change the position and direction of the fill), applying different colors or altering the fill effect (the way the 
color changes across the fill). You can also use the Transparency Tool Transparency Type options to alter the color of objects 
underneath the filled object.

What do you want to do?
Move fill handles
Change the colors of an elliptical fill
Change the fill tiling
Change the fill profile
Change the fill effect
Create a multi-stage fill
Change a multi-stage fill

_______________

{button ,KL(`elliptical fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing elliptical transparency

An elliptical transparency applied to an object is a graduation of transparency from one level to another in a radial fashion. The pair 
of transparency arrows used to control it have a handle on one end and one at their joining point. The length of the arrows defines 
the radii of the transparency graduation and the transparencies of the center and outer edge are defined by the levels applied to 
the handles.

What do you want to do?
Move a transparency handle
Change the transparency levels
Change transparency shape
Change the Transparency Type

_______________

{button ,KL(`elliptical transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Change an existing color in a multi-stage fill

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

To change an existing color in the fill

The Fill arrow shows a handle for each color in the fill.
1. Drag-and-drop the new color from the Color Line or Color Gallery onto the appropriate color handle.
or
1. Click the color handle to select it.
2. Choose a color on the Color Line or Color Gallery. Or use the Color Editor to change the color.

To change the start or end colors, see Changing the colors in fills.

Notes:
Conical fills have a semicircular Fill arrow. Other fill types have straight Fill arrows. Always drag-and-drop colors onto the 

arrow.
Elliptical and Diamond fills have a pair of Fill arrows. You can apply colors to only one of these arrows. (The arrow that 

was horizontal when you created the fill - this is the "primary" arrow.)
The Selector Tool can also display the Fill arrow. See Enabling fill handles.

_______________

Related Topics

Creating multi-stage fills
Changing multi-stage fills
Fill Tool



Changing fills

The Fill Tool and Selector Tool can be used to edit a fill which has been applied to an object. For information on fills, see the Fills 
Overview.

Changing linear fills
Changing circular fills
Changing elliptical fills
Changing conical fills
Changing diamond fills
Changing three color fills
Changing four color fills
Changing bitmap fills
Changing fractal fills
Creating multi-stage fills

_______________

Related Topics

Applying fills
Fill Tool



Changing flat transparency

A flat transparency applied to an object give the same level of transparency over the whole object. You can change the 
transparency of the whole object or the type of transparency used.

What do you want to do?
Change the transparency level
Change the transparency shape
Change the Transparency Type

_______________

{button ,KL(`flat transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing four color fills

Four color fills are controlled using a pair of fill arrows joined at one end with a fourth fill handle forming a parallelogram. You can 
move all four fill handles by dragging the handle at the base of the arrows. You can change the fill by moving the fill handles (to 
change the position, direction and stretching of the fill) and applying different colors to the four handles. You can also use the 
Transparency Tool Transparency Type options to alter the color of objects underneath the filled object.

What do you want to do?
Move the fill handles
Change the colors of the fill
Change the tiling
Change the fill profile

_______________

{button ,KL(`four color fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing four point transparency

Four point transparency applied to an object produces graduations of transparency between four points, each with its own 
transparency level. The transparency is controlled using a pair of transparency handles which form two sides of a parallelogram. 
Moving the handle at the base of the arrows moves the whole transparency. You can set the transparency levels of the four 
handles to any values you like.

What do you want to do?
Move a transparency handle
Change the transparency levels
Change transparency shape
Changing the tiling
Change the Transparency Type

_______________

{button ,KL(`three point transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing fractal fills

Fractal Cloud fills and Fractal Plasma fills are controlled using a pair of fill arrows joined at one end with three associated fill 
handles. The arrows point from the center of the fractal to its top and right-hand edges and so control its position and the angles of 
the sides of the fractal. The central fill handle controls the position of the center of the fractal. A fractal fill repeats a square of 
fractal texture to fill an object - it is very similar to a bitmap fill. You can change the fill by moving the fill handles (to change the 
position, direction and stretching of the fill), applying different colors to the fractal, altering the way the fractal is tiled and changing 
the resolution (size) of the fractal. You can also use the Transparency Tool Transparency Type options to alter the color of objects 
underneath the filled object.

What do you want to do?
Move fractal fill handles
Change the colors of a fractal fill
Change the fractal fill resolution
Change the fractal fill tiling
Change the fill effect
Change the fractal grain

_______________

{button ,KL(`fractal fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing fractal transparency

Fractal Cloud transparency and Fractal Plasma transparency produces random, varying transparency levels across the selected 
objects. This is similar to a fractal fill except that the fractal values alter the level of transparency rather than the color. You can 
alter the 'grain' of the fractal to produce a smooth or 'lumpy' transparency texture. You can alter the angle, direction and exact 
degree of transparency.

What do you want to do?
Change the transparency shape
Change the transparency levels
Move the transparency handles
Change the fractal grain
Change the fractal resolution
Change the fractal tiling
Change the Transparency Type

_______________

{button ,KL(`fractal transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing line ends

The shape of line ends can be butt cap, round cap or square cap.
To change a line end

1. Select the line (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Select the type of line-end from the drop-down list. This changes both ends of the line.

Note:
You cannot change the line end if a brush or stroke shape is already applied. 

_______________

Related Topics

Line Gallery
Changing join style
Adding arrowheads



Changing join style

The joins between segments in lines, contours, bevels and outlines of shapes, QuickShapes and text can be changed between 
miter joins, round joins and beveled joins.

To change a join style
1. Select the object (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Select the join style from the drop-down list. This changes all joins on the selected line or shape.

Note:
You can also select a join style using buttons in the Bevel Tool or Contour Tool

_______________

Related Topics

Line Gallery
Changing line ends



Changing line thicknesses

You can change the thickness of lines and outlines of shapes, text and QuickShapes. This changes the thickness of the entire line. 
You cannot change the thickness of just a part of a line.

To change the line thickness
1. Select the object (see Selecting objects).
2. Either:

select a thickness from the drop-down list on the control bars,
or type a thickness into the field on the control bars (for example "2cm" or "0.1in") and press RETURN.

You can also use Stroke shapes in the Line Gallery or Freehand & Brush Tool to profile lines. (For example to create a 
tapering line.) See Changing the stroke shape.

Tips
If you want to make a line invisible, choose None from the line width drop-down list. This sets the outline color of the 

object to No Color (See Changing an object’s line color.) 
You can also choose Line Gallery from the Utilities menu and then double-click on a line thickness in the gallery or drag-

and-drop a line thickness from the Line Gallery onto the object.
If you want to change the line thickness for future objects, change the line width with no objects selected. See Setting the 

current attributes for more information.
Changing the line thickness of a compound object (for example a group) changes the line thicknesses of all the objects in 

the compound object. To change the line thickness of one object inside a compound object, select the object inside and choose a 
line width. See Selecting objects in objects.

Changing the line thickness of a line or outline that is transparent removes the transparency and colors the line black so 
you can see it.

_______________

{button ,KL(`line',0,`____No_Topics_Found',`')}    Related Topics



Changing the tiling of linear fills

You can change linear fills so the colors extend out to infinity or repeat as a series of bands.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying linear fills
Changing linear fills



Changing linear fills

Linear fills graduate from one color to another. They are controlled using a single fill arrow with a fill handle on either end. Each 
handle has a color associated with it. You can change the fill by moving the fill handles (to change the position and direction of the 
fill), applying different colors to the handles or altering the fill effect (the way the color changes across the fill). You can also use the 
Transparency Tool Transparency Type options to alter the color of objects underneath the filled object.

What do you want to do?
Move fill handles
Change the colors of a linear fill
Change the fill tiling
Change the fill profile
Change the fill effect
Create a multi-stage fill
Change a multi-stage fill

_______________

{button ,KL(`linear fills,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing linear transparency

A linear transparency applied to an object is a graduation of transparency from one level to another in a linear fashion. There is a 
single transparency arrow for control. Dragging the handles at the ends of this arrow changes the direction and start and finish of 
the transparency graduation. You can also change the transparency levels applied to each handle.

What do you want to do?
Move the transparency handles
Change the transparency levels
Change the transparency shape
Change the Transparency Type

_______________

{button ,KL(`linear transparency,applying',0,`____No_Topics_Found',`')}    Related Topics



Changing molded text

Text which has been molded cannot be edited directly in Xara X, but described below is a simple process which allows you to 
easily remove the mold, edit the text and reapply the mold.

To edit molded text
1. Select the molded text object (see Selecting objects).
2. Choose the Mold Tool.
3. Click the Copy Mold button on the Mold Tool Infobar.
4. Click the Remove Mold button on the Infobar to remove the mold from the text.
5. Edit the text object as normal (see Editing text.)
6. Choose the Mold Tool again.
7. Click either Paste Envelope or Paste Perspective button on the Infobar.

Tips
Don't use Cut or Copy while you're editing the text as this overwrites the mold on the clipboard.
You could make it easy to change the colors in the text by using named colors. You can then change the colors without 

having to remove the mold. 

_______________

Related Topics

Mold Tool
Text Tool



Changing multi-stage fills

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

What do you want to do?
Add more colors
Change an existing color in the fill
Change the position of a color in the fill
Delete a color

Movies

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

Related Topics

Creating multi-stage fills
Fill Tool



Changing named colors

You can edit named colors if required. All the objects that use that color automatically show any changes you make. Any shade 
colors, tint colors or linked colors based on the edited color also change.

To change a named color
1. From the Utilities Menu, choose Color Editor.
2. Choose the named color from the drop-down list in the Color Editor.
3. Alter the color using the Color Editor. You can alter the color value, or its type.

Tips
You can also drag-and-drop the color from the Color Line or Color Gallery onto the Color Editor.
You can also select the color in the Color Gallery then click the Edit button in the gallery or just double-click on the color. 

(See Color Gallery)
Selecting an object and then editing the color shown in the Color Editor creates a local color. You must specifically choose 

a named color before you can edit it.
You can also select the color from an object visible on screen. Select the object and drag the color from the swatch on the 

left of the Color Line onto the Color Editor.
You can see more options in the Color Editor if you click the Show Advanced Options button.

_______________

Related Topics

Named colors
Color Editor
Color Line
Color Gallery
Creating Shade colors



Changing shade colors

You can change a shade color to make it lighter or darker than its parent color. To change its basic color (its Hue) you must edit the 
parent color.

To change a shade color
1. From the Utilities menu choose Color Editor.
2. Drag-and drop the shade from the Color Line onto the Color Editor. (The Color Editor then shows the name of the shade.) You 

can only alter the Saturation and Value - the Hue is fixed by the parent color. All objects that use this shade automatically 
change as you change the color in the Color Editor. For more information, see Color Editor - Shade Colors.

3. When the color is correct close the Color Editor.

Tip
The parent color is shown in the Color Editor as a small white X.
When you are editing a shade you can display the parent color by right-clicking on the editor to open a menu and 

selecting Edit parent. Editing the parent automatically changes all shades based on it. 

_______________

Related Topic

Shade colors
Color Editor



Changing text font

Once you have created a text object, you can change the font used by all of it or part of it. If you want to create a new text object 
using a particular font, just place the text cursor in the document and choose the font from the Text Tool Infobar.

To change text font
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Select the font from the drop-down list on the Infobar.

Tips
You can also choose the font from the Font Gallery. Double-click on a font in the gallery to apply it to the selected text.
The symbol on the left of the font name in the font drop-down list shows whether the font is a TrueType font or an ATM 

font.

_______________

Related Topics

Text Tool
Font Gallery



Changing the brush stroke design of lines

See also Editing brushes.

The Freehand & Brush Tool and Line Gallery include a wide range of brush stroke designs that you can apply to lines and the 
outlines of shapes.

To change the brush stroke design using the Freehand & Brush Tool

This is often the easier method as the start of the list shows the most recently used brush designs.
1. Select the Freehand & Brush Tool.
2. If necessary click on the line to select it
3. Choose from the Select brush list.

To change the brush stroke design using the Line Gallery
1. Select the line or shape (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the Brush Strokes sections.
4. Double click on a stroke design.

Tip
You can also drag-and-drop a brush stroke from the gallery onto any line or shape (selected or unselected).
You can also create your own brush strokes designs - see Creating custom brush strokes.
You can change the properties of brush strokes. See Changing brush stroke properties.
Some brush strokes are directional (for example, the footprints). Their direction depends on the direction of the line. If 

necessary you can reverse the line direction.
You can use brushes to "paint" with bitmaps - more details.

Note:
Applying a brush removes any arrowhead/tail or dash pattern already applied to the line.

_______________

{button ,KL(`line',0,`',`')}    Related Topics



Changing the aspect ratio of text

Once you have created a text object, you can change the aspect ratio of all the characters in it or just some of them. If you want to 
create a new text object using a particular aspect ratio, just place the text cursor in the document and change the aspect ratio on 
the Text Tool Infobar.

To change the aspect ratio of text
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Change the aspect ratio on the drop-down list on the Infobar.

Tips
An aspect ratio of 80% gives narrow (condensed) text whereas a ratio of 120% gives wide text. (Values below 80% and 

above 130% can make the text look distorted.)
You can also change the size of whole text objects using the Selector Tool. See Scaling objects.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Changing the background

With Xara X you can create bitmaps that are anti-aliased to a background. This means the drawing blends seamlessly with the 
background and avoids any obvious border around the edge of the bitmap. To make this easier, you can give the Xara X 
background the same background as the final web page will have.

You can use either a flat color or a bitmap as the background. You can use any color in the Color Gallery (including those in other 
documents) for a background color or create a custom color. You can use any bitmap in the Fill or Bitmap Gallery as a 
background. Bitmaps are automatically tiled if necessary, exactly as they are in web browsers.

Using a color as a background
1. Open the Color Gallery.
2. Click on the color you want as your background. This selects the color.
3. Click the Background button.

Use a bitmap as the background
1. From the Utilities menu choose either Clipart Gallery or Fill Gallery.
2. Select the bitmap you want to use.
3. Click the Background button in the gallery.

Tips
 You can also drag the color from the Color Gallery or a bitmap onto the background of the page whilst holding down the CTRL 

key.
 Use the Color Editor to create a custom color. Create the color you want and then CTRL+drag the color patch in the Color Editor 

onto the background of the page.
 Immediately after applying a background color you can use the Color Editor to modify it. You can do this until you use the Color 

Editor to edit another color.
 To set the background back to white, right-click on the page and select Default Page Background.

_______________

Related Topics

Color Editor
Color Gallery
Bitmap Gallery
Background



Changing the baseline shift of text

Once you have created a text object, you can change the vertical position (baseline) of any piece of text inside the text object. If 
you want to create a new text object using a specific baseline shift, just place the text cursor in the document and set the baseline 
shift on the Text Tool Infobar. The baseline shift is displayed in the default text units (usually points - pt).

To change the baseline shift
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the buttons on the Line Spacing control on the right hand side of the Text Tool Infobar.

Tips
You can also set the line spacing by typing a value into the line spacing field and pressing RETURN.
You can enter values using any unit, for example you can enter '4pt' or '2cm'. If you type a value with no units, it uses the 

text units.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Changing the bevel color or fill effect

After applying a bevel to an object, you can change the bevel's color or fill effect. You can apply any of Xara X's color effects 
including multi-stage fills.

How to change the bevel color:
The easiest way is to drag-and-drop a color from the Color Line onto the bevel. (Make sure you drop the color onto the bevel and 

not the object.)
Alternatively:
This method is slightly more complex but you have full control over the color.
1. Select the bevel using the Selector Tool. (Make sure you select the bevel and not the object.)
2. Use the Color Editor to edit the color.

How to change the bevel color:
1. Select the bevel using the Selector Tool. (Make sure you select the bevel and not the object.)
2. Use the Fill Tool to edit the fill effect.

Tip:
If you have several beveled objects selected, any changes apply to all the bevels.

Movies

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

____________

Related Topics

Bevel Tool overview
Modifying a bevel
Applying fills



Changing the bevel join style

After applying a bevel to an object, you can change the shape of the corners (joins). Options are miter, round and beveled.
How to change the bevel join style:

1. Select the object (see Selecting objects).
2. Click the appropriate Join button on the Bevel Tool Infobar. Note that changing the join style also changes the joins of any 

contours and lines in the selected objects.

Tip:
If you have several beveled objects selected, any changes apply to all the bevels.

____________

Related Topics

Bevel Tool overview
Modifying a bevel



Changing the bevel light source

The bevel effect is created by a light shining across the object and highlighting the shape (profile) of the bevel. You can change the 
direction and height of the light and its strength (the contrast).

Changing the light angle (horizontal direction):
1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. If necessary apply a bevel (see Applying a bevel).
4. Drag the arrowhead to change the position of the light source.

Notes:
You cannot move the center of the arrow, only the arrowhead.
For precise angles, select Light angle from the Slider Type list. Then drag the slider or type into the text box.
If you have several beveled objects selected, Light angle changes all bevels. Dragging the arrow changes just the bevel 

(or bevels) that the arrow refers to.
Changing the light strength (contrast)

1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. If necessary apply a bevel (see Applying a bevel).
4. Select Contrast from the Slider Type list. Then drag the slider or type into the text box.

Notes:
If you have several beveled objects selected, any changes apply to all the bevels.
The colors used in the bevel affect the contrast. For example strong (saturated) colors require more contrast than weak 

colors to get the same effect. For best results you will probably have to adjust the contrast for each object.
Changing the light elevation (vertical angle)

This lets you move the light anywhere from immediately above the object (90º) to the side of the object (0º).
1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. If necessary apply a bevel (see Applying a bevel).
4. Select Light elevation from the Slider Type list. Then drag the slider or type into the text box.

Notes:
If you have several beveled objects selected, any changes apply to all the bevels.
For rounded bevels we recommend a light elevation of 30º. At this angle the bevel blends smoothly with the object.

Movies

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

_______________

Related Topics

Applying a bevel
Modifying a bevel
Removing a bevel
Bevel Tool



Changing the bevel size

This describes how to change the size of the bevel at the edge of objects.
How to change the bevel size:

1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. If necessary apply a bevel (see Applying a bevel).
4. From the Slider Type list choose Size.
5. Either drag the slider or type a value into the text box.

Tip:
If you have several beveled objects selected, any changes apply to all the bevels.

Movies

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

_______________

Related Topics

Applying a bevel
Modifying a bevel
Removing a bevel
Bevel Tool



Changing the bitmap in a bitmap fill

If an object already has a bitmap fill you can change the bitmap used. It is often easier to change the bitmap by reapplying the 
bitmap fill (see Applying bitmap fills).

To change the bitmap in a bitmap fill
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Select a new bitmap from the drop-down list on the Fill Tool Infobar.

Or click More to open the Fill Gallery to choose from a wider range of bitmaps.

Tip
You can also directly use the Bitmap gallery or Fill Gallery. Select the required bitmap and click Fill.

_______________

Related Topics

Bitmaps overview
Fills overview



Changing the bleed setting

Bleed-off allows your document to be printed over the edge of the page. The standard bleed-off distance is 0.3cm, but If in doubt 
ask your print shop.

To change the bleed setting
1. From the Utilities Menu, choose Options (see Options).
2. Click the Page tab.
3. Select the bleed option and enter a value for the bleed size.

Tip
Note that bleed-off may require a larger paper size and increase costs. 



Changing the blend attribute profile

After creating a blend you can change how the attributes (such as transparency, colors or line thickness) change. You might want 
a regular rate of change or a more pronounced change towards one end or the center.

To change the attribute profile
1. Create the blend - see Blending objects.
2. In the Blend Tool click Attribute profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a regular rate of change.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the end of the transition than at the start.
+1 for more change at the start.
Move the bottom slider towards:
-1 for more change at the start and end than in the center.
+1 for more change in the center.

Note
The profile dialog box affects all attributes of the objects.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

_______________

Related Topics

Blends
Blend Tool



Changing the blend position profile

After creating a blend you can change how the intermediate steps are spaced. You can have regular spacing or closer at one end 
than the other or closer in the center.

To change the position profile
1. Create the blend - see Blending objects.
2. In the Blend Tool click Position profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates regular spacing.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the start of the blend.
+1 for more change at the end of the blend.
Move the bottom slider towards:
-1 for more change at the start and end than in the center.
+1 for more change in the center.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

_______________

Related Topics

Blends
Blend Tool



Changing the brightness and contrast of bitmaps

Xara X lets you change the brightness, contrast and color (saturation) of a bitmap. The controls are similar to those on a domestic 
television.

To change the brightness, contrast or color
1. Select the bitmap (see Selecting objects).
2. From Bitmap Effects & Plug-ins on the Utilities menu, choose Bitmap Effects.
3. Choose Brightness & Contrast.
4. Move the sliders as required.
5. Click OK to insert the new, altered bitmap into the document.

Tips
The results of changes using the sliders will be shown instantly in the preview on the right-hand side of the dialog box. 

There is no need to use the Test button.
You can also select a bitmap in the Bitmap Gallery and then click the Plug-ins button on the Gallery.



Changing the color of guides

Depending on the colors used in your drawing, you may want to change the color of guide objects and guidelines so they are more 
clearly visible.

To change the color of guides
1. Right-click on the guides layer in the Layer Gallery to open the pop-up menu.
2. Choose Properties to open the Layer Properties dialog box.
3. If necessary select the Guides tab.
4. Select a suitable color from the drop-down list at the bottom of the dialog box.

Tip
Guides are displayed with a colored, dotted outline.

_______________

{button ,KL(`guides;layers,layer gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Changing the color units

When you are editing a color in the Color Editor, you can use either percentages or values from 0 to 255. These color units are 
also used to make up the names for colors imported from color and palette files, for example R126G0B0 or R85%G0%B0% 
depending on the color units setting.

To change the color units
1. From the Utilities Menu, choose Options.
2. Click the Units tab.
3. In the Color Units section, choose Percent or 0-255.

Tip
If you need to enter a value in the other format from the one you have chosen, you can force the units by typing (for 

example) "25%" (for a percentage) or "25d" (for 0 to 255 value).

_______________

{button ,KL(`color editor overview',0,`____No_Topics_Found',`')}    Related Topics



Changing the colors in bitmap fills

You can create a contone or duotone bitmap fill by applying colors to the fill handles. You can also use the Transparency Tool 
Transparency Type options to alter the color of objects underneath the filled object.

To change the colors of a bitmap fill
1. Choose the Fill Tool.
2. Click on a fill handle to select it
3. Click on a color on the Color Line.

Tips
In step 3, you can also apply the color from the Color Gallery. Select a color and click Apply. 
You can also drag-and-drop colors onto the fill handles.
You must select a fill handle before applying color. Otherwise you create a flat fill.
To return a bitmap fill to its original colors, drag the 'no color' patch off the Color Line onto each of the fill handles. 
If you have several objects selected, you can select all fill handles of a particular type (for example all center handles) by 

CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying bitmap fills



Changing the colors in circular fills

After creating a circular fill you can easily change the start and end colors. Alternatively you can create a multi-stage fill.
To change the colors in a circular fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows whether the color will be applied to the center or outside of the fill circle:

Dropping the color will apply it to the outside (end handle) of the circular fill

Dropping the color will apply it to the center (start handle) of the circular fill

Tips
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:

click on a color on the Color Line.,
or double-click a color in the Color Gallery.,
or select a color in the Color Gallery and click Apply. 

Caution: if there are no fill handles selected, these methods create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all center handles) by 

CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying circular fills



Changing the colors in conical fills

After creating a conical fill you can easily change the start and end colors. Alternatively you can create a multi-stage fill.
To change the colors in a conical fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows which side of the cone the color will be applied to:

Dropping the color will apply it to the end handle (one side) of the conical fill

Dropping the color will apply it to the start handle (the other side) of the conical fill

Tips
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:

click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply. 

Caution: if there are no fill handles selected, these methods create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all the start handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying conical fills



Changing the colors in diamond fills

After creating a diamond fill you can easily change the start and end colors. Alternatively you can create a multi-stage fill.
To change the colors in a diamond fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows whether the color will be applied to the center or outside of the fill ellipse:

Dropping the color will apply it to the outside (end handle) of the diamond fill
Dropping the color will apply it to the center (start handle) of the diamond fill

Tips
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:

click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply.

Caution: if there are no fill handles selected, this method creates a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all the start handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying diamond fills



Changing the colors in elliptical fills

After creating a elliptical fill you can easily change the start and end colors. Alternatively you can create a multi-stage fill.
To change the colors in a elliptical fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows whether the color will be applied to the center or outside of the fill ellipse:

Dropping the color will apply it to the outside (end handle) of the elliptical fill
Dropping the color will apply it to the center (start handle) of the elliptical fill

Tips
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:

click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply.

Caution: if there are no fill handles selected, these methods create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all the start handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying elliptical fills



Changing the colors in a fill

After creating a fill you can easily change the start and end colors.
To change the colors in a fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows whether the color will be applied to the start or end of the fill:

Dropping the color will apply it to the start of the fill
Dropping the color will apply it to the end of the fill

Tips
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:

click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply.

Caution: if there are no fill handles selected, these methods create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all end handles) by 

CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying fills



Changing the colors in a four color fill

After creating a four color fill you can easily change the colors of any of the four handles.
To change the colors in a four color fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows which handle the color will be applied to.

Tips
Click on a fill handle to select it and then either:

click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply.

Caution: if there are no fill handles selected, these methods create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all the start handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying four color fills



Changing the colors in fractal fills

After creating a Fractal Cloud fill or Fractal Plasma fill you can easily change the start and end colors.
To change the colors of a fractal fill

1. Choose the Fill Tool.
2. Click on a fill handle to select it.
3. Click on a color on the Color Line.

Tips 
In step 3, you can also apply the color from the Color Gallery. Select a color and click Apply. 
You can also drag-and-drop colors onto the fill handles.
You must select a fill handle before applying color. Otherwise you create a flat fill.
If you have several objects selected, you can select all fill handles of a particular type (for example all center handles) by 

CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying fractal fills



Changing the colors in three color fills

After creating a three color fill you can easily change the colors of any of the three handles.
To change the colors in a three color fill

Simply drag a color from the Color Line or the Color Gallery onto the filled object. When over the object, the shape of the mouse 
pointer shows which handle the color will be applied to.

Tips
If you have several objects selected, you can select all fill handles of a particular type (for example all the start handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.
You can also apply colors direct to the fill handles. Click on a fill handle to select it and then either:
click on a color on the Color Line,
or double-click a color in the Color Gallery,
or select a color in the Color Gallery and click Apply.

Caution: if there are no fill handles selected, these methods create a flat fill.

_______________

Related Topics

Fill Tool
Fills overview
Color Line
Color Gallery
Applying three color fills



Changing the constrain angle

When you move, rotate and skew objects or move handles, you can use the CTRL key to constrain the angle of movement. 
To change the constrain angle

1. From the Utilities Menu, choose Options (see Options).
2. Click the General tab.
3. In the Angle Constraint section, choose a value from the drop-down list.

Tip
If the value you want is not listed, type the value (in degrees) into the field and press RETURN.



Changing the contour attribute profile

After creating a contour you can change how the attributes (such as color or line thickness) change. You might want a regular rate 
of change or a more pronounced change towards one end or the center.

To change the attribute profile
1. Create the contour - see Contouring objects.
2. In the Contour Tool click Attribute profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a regular rate of change.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the outer edge of the contour.
+1 for more change at the inner edge.
Move the bottom slider towards:
-1 for more change in the center than at the edges.
+1 for more change at the edges.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

_______________

Related Topics

Contours
Contour Tool



Changing the contour color

After applying a contour to an object, you can change the contour's color.
How to change the contour color:

The easiest way is to drag-and-drop a color from the Color Line onto the contour. (Make sure you drop the color onto the contour 
and not the object.)

Alternatively:
This method is slightly more complex but you have full control over the color.
1. Select the contour using the Selector Tool. (Make sure you select the contour and not the object.)
2. Use the Color Editor to edit the color.
Note that you can also select the contour using the Contour Tool. Click on the contour to select it.

Tip:
If you have several contoured objects selected, any changes apply to all the contours.

Movies

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

____________

Related Topics

Contour Tool
Modifying a contour



Changing the contour position profile

After creating a contour you can change how the intermediate steps are spaced. You can have regular spacing or closer at one 
end than the other or closer in the center.

To change the position profile
1. Create the contour - see Contouring objects.
2. In the Contour Tool click Position profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates regular spacing.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the outer edge of the contour.
+1 for more change at the inner edge.
Move the bottom slider towards:
-1 for more change at the edges than in the center.
+1 for more change at the center.

Tip:
If you have several contoured objects selected, any changes apply to all the contours.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

_______________

Related Topics

Contours
Contour Tool



Changing the default page size

You may prefer new documents to use, for example, A4 page size. To do this, change the template document.
To change the default page size

1. From the File menu, choose Open. This opens a new blank document.
2. From the File menu, choose Page Options.
3. From the Paper Size menu, select the new page size. For example A4.
4. Click OK to close the dialog box.
5. From the File Menu, choose Save Template. 
6. Select Use as Default Template. This saves the template document with the new paper size.

This change applies to all new documents. It has no effect on existing documents.

Tips
To change the page size for only the document you are working on, skip step 5.
Similarly, you can also change the page orientation from landscape to portrait.
To discard any changes you have made to the default document, you can return to the original default document supplied 

with Xara X (the factory default). To do this, delete the template.xar file in your Xara X folder. Xara X recreates the factory default 
document the next time you run Xara X.

_______________

Related Topics

Template documents
Drawing and Animation documents



Changing the default measurement units

You may prefer new documents to use, for example, inches for measurements. To do this, change the template document.
To change the default units

1. From the File menu, choose Open. This opens a new blank document.
2. From the Utilities menu, choose Options.
3. Click the Units tab.
4. From the Page units drop-down, select the required units. For example inches.
5. Click OK to close the dialog box.
6. From the File Menu, choose Save Template. 
7. Select Use as Default Template. This saves the template document with the new paper size.

This change applies to all new documents. It has no effect on existing documents.

Tips
To change the page size for only the document you are working on, skip step 6.
In the same way, you can change the font measurement units.
To discard any changes you have made to the default document, you can return to the original default document supplied 

with Xara X (the factory default). To do this, delete the template.xar file in your Xara X folder. Xara X recreates the factory default 
document the next time you run Xara X.

_______________

Related Topics

Template documents
Drawing and Animation documents



Changing the duplication distance

Duplicate creates a copy of the selected objects which is offset from the original object. The horizontal and vertical offset can be 
changed.

To change the duplication distance
1. From the Utilities Menu, choose Options (see Options).
2. Click the General tab.
3. Enter the horizontal distance in the X field (positive values move it to the right).
4. Enter the vertical distance in the Y field (positive values move it up).

_______________

{button ,KL(`copying,objects',0,`____No_Topics_Found',`')}    Related Topics



Changing the feathering profile

After applying feathering you can change the transition across the feather. You might want a regular rate of change or a more 
pronounced change towards one end or the center.

On an 800x600 display the feathering profile button may be off the edge of the display. You may need to move the feathering 
control bar - see Moving control bars.

To change the feathering profile
1. Create the feather - see Feathering objects.
2. On the Feathering Control Bar click Profile. This opens the Profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a regular rate of change.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the outer edge of the feather.
+1 for more change at the inner edge of the feather.
Move the bottom slider towards:
-1 for more change in the center than at the edges.
+1 for more change at the edges.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

{button ,EF("XaraDemo.exe",`Feather Using Feathering',1,`') } Using feathering

_______________

{button ,KL(`feathering',0,`____No_Topics_Found',`')}    Related Topics



Changing the feathering size

After applying feathering you can change the size of the feather. (You also set the size when applying feathering.)
To change the feathering size

1. On the Feathering Control Bar either drag the slider or, for precise values, type into the text box.

Note:
The size of the feather does not change if you scale the object.

Movies

{button ,EF("XaraDemo.exe",`Feather Using Feathering',1,`') } Using feathering

_______________

{button ,KL(`feathering',0,`____No_Topics_Found',`')}    Related Topics



Changing the fill effect of a fill

With some fill types you can alter the way the colors change across the fill.
To change the fill effect of a fill

1. Select the filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Select one of the following from the Fill Effect field on the Fill Tool Infobar:

Fade: a simple transition between the two colors.
Rainbow: a colorful transition along the shortest path around the Color Circle (see note).
Alternate Rainbow: blends along the longest path around the Color Circle. Very colorful.

Tips
The Color Circle runs Red-Yellow-Green-Cyan-Blue-Magenta and back to Red. So a fill between Yellow and Cyan runs 

Yellow-Green-Cyan for Rainbow and Yellow-Red-Magenta-Blue-Cyan for Alternate Rainbow.
The three options give the same results where both colors are white, black or shades of gray. Rainbow is the same as 

Fade if one color is white, black or a shade of gray.
For most fill types you can also create multi-stage fills where you have greater control over the colors used.

_______________

Related Topics

Applying fills
Changing fills
Fill Tool



Changing the fill profile

You can change the shape of the transition between the start and end of fills. This applies to all fill types except flat, three color, 
four color and bitmap (except for contone bitmaps).

To change the profile of a fill
1. Select the filled object (see Selecting objects).
2. In the Fill Tool click Profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a linear transition between the start and end of the fill.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the end of the fill.
+1 for more change at the start.
Move the bottom slider towards:
-1 for more change in the center than at the start or end.
+1 for less change in the center.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

_______________

Related Topics

Applying fills
Changing fills
Fill Tool



Changing the font units

The Font Units are the units used for text measurements. For example the Text Tool shows measurements in the font units.
To change the font units

1. From the Utilities Menu, choose Options (see Options).
2. Click the Units tab.
3. Select a unit from the drop-down list.

Tips
If you want to create your own custom units, see Creating custom units.



Changing the gallery cache size

When you open the Clipart Gallery, Font Gallery or Fill Gallery the thumbnail images are kept in a cache so as you scroll up and 
down the gallery they don't need to be loaded from disk again. This make the gallery much faster to use. If you have lots of 
memory in your machine, you might like to increase the number of images that are kept in the cache so your galleries are even 
faster.

To change the gallery cache size
1. From the Utilities menu, choose Options (see Options).
2. Click the Tune-ups tab.
3. In the Cache section, change the value (1 thru 99 ) in the Number Of Items Cached Per Gallery Group field.



Changing the grain of a fractal fill

You can fill objects with Fractal Cloud fills or Fractal Plasma fills to give them a random pattern. Changing the grain lets you make 
the fractal appear smooth and flowing or grainy.

To change the grain of a fractal fill
1. Select the fractal filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Click away from the fill handles to ensure none is selected.
4. Type a grain value into the Grain field on the Fill Tool Infobar (from 0 to 16,000).
5. Press RETURN.

Tips
If there is a selected fill handle, Grain shows the color applied to the handle.
Low values give a smooth, flowing pattern. High values give a grainy pattern.

_______________

Related Topics

Fill Tool
Fractal Fills



Changing the grain of a fractal transparency

You can fill objects with Fractal Cloud transparency or Fractal Plasma transparency to give the transparency a random pattern. 
Changing the grain lets you make the fractal appear smooth and flowing or grainy.

To change the grain of a fractal transparency
1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click away from the transparency handles to ensure none is selected.
4. Drag the slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
If any of the transparency handles are selected, the slider controls the transparency level at the handle. You must deselect 

all the handles to change the grain.
Low values give a smooth, flowing pattern. High values give a grainy pattern.

_______________

Related Topics

Transparency Tool
Transparency overview
Fractal transparency



Changing the grid spacing

Grids consist of lines of major grid points spaced a specific distance apart. Between these major grid points are a number of 
subdivisions. For example, you might have a grid with a spacing of 1cm, but with subdivisions of 1mm. Major grid points are 
marked on the page as crosses whereas subdivisions are marked as small points. The rulers use the units you use to set the grid 
spacing.

To change the grid spacing
1. From the Utilities Menu, choose Options (see Options).
2. Click the Grid and Ruler tab.
3. Enter the major spacing value.
4. Enter the number of subdivisions between the major grid points.

Tips
You can type values into the Major Spacing Field using any units, e.g. '2cm', '4in'.
If you zoom out from a document, some of the subdivisions will not be shown if they are very close together.
If you do not see the grid, you need to turn it on. See Displaying the grid.
If you are creating graphics for publishing on the Internet, you can specify the grid spacing using pixels (pix). 10 or 20 

pixels spacing gives good results.

Movies

{button ,EF("XaraDemo.exe",`Grids Using Grids and Rulers',1,`') } Using grids & rulers

_______________

{button ,KL(`grid',0,`____No_Topics_Found',`')}    Related Topics



Changing the level in flat transparency

Flat transparency is the simplest type of transparency. The only control is over the transparency level.
To change the level in a flat transparency

1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

_______________

Related Topics

Transparency Tool
Transparency overview
Applying flat transparency
Changing flat transparency



Changing the levels in bitmap transparency

You can use a bitmap to control the transparency levels of an object. After applying bitmap transparency, you can change the 
transparency levels.

To change the levels in a bitmap transparency
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on either the center transparency handle or one of the outer transparency handles to select it.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
The outer handles control the transparency level for the white areas of the bitmap and the center handle controls the black 

areas.
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying bitmap transparency
Changing bitmap transparency



Changing the levels in circular transparency

After applying circular transparency you can change the transparency levels of the center and outside of the circle.
To change the levels in a circular transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on either the center or the outer transparency handle to select it.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
The center handle sets the transparency at the center of the circle, the outer one sets the transparency at the edge.
If neither handle is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying circular transparency
Changing circular transparency



Changing the levels in conical transparency

After applying conical transparency you can change the transparency levels of the two sides of the cone.
To change the levels in a conical transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on a transparency handle to select it.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
The center handle is used to move the transparency - you cannot apply a transparency level to it.
If neither handle is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying conical transparency
Changing conical transparency



Changing the levels in diamond transparency

After applying diamond transparency you can change the transparency levels of the center and outside of the diamond.
To change the levels in diamond transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on either the center transparency handle or one of the outer transparency handles to select it.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
The center handle sets the transparency at the center of the diamond, the outer handles sets the transparency at the 

edge.
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying diamond transparency
Changing diamond transparency



Changing the levels in elliptical transparency

After applying elliptical transparency you can change the transparency levels of the center and outside of the ellipse.
To change the levels in elliptical transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on either the center transparency handle or one of the outer transparency handles to select it.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
The center handle sets the transparency at the center of the ellipse, the outer handles sets the transparency at the edge.
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying elliptical transparency
Changing elliptical transparency



Changing the levels in four point transparency

After applying four point transparency you can change the transparency levels of any of the four points.
To change the levels in four point transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on one of the transparency handles.
4. Move the Transparency slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type by CTRL+SHIFT-clicking on one of 

the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying four point transparency
Changing four point transparency



Changing the levels in fractal transparency

You can fill objects with Fractal Cloud transparency or Fractal Plasma transparency to give the transparency a random pattern. 
After applying fractal transparency, you can change the transparency levels.

To change the levels in a fractal transparency
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on either the center transparency handle or one of the outer transparency handles to select it.
4. Move the Transparency slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.

_______________

Related Topics

Transparency Tool
Transparency overview
Applying fractal transparency
Changing fractal transparency



Changing the levels in linear transparency

After applying linear transparency you can change the transparency levels of the start and end of the transparency.
To change the levels in a linear transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on a transparency handle to select it.
4. Move the Transparency slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
If neither handle is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type (for example all the center handles) 

by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying linear transparency
Changing linear transparency



Changing the levels in three point transparency

After applying three point transparency you can change the transparency levels of any of the three points.
To change the levels in three point transparency

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click on one of the transparency handles.
4. Move the Transparency Slider on the Transparency Tool Infobar. Or for precise control, type into the text box to the right.

Tips
If none of the handles is selected, moving the slider applies a flat transparency to the object.
If you have several objects selected, you can select all fill handles of a particular type by CTRL+SHIFT-clicking on one of 

the handles. Use SHIFT-click to deselect a handle or select an unselected handle. 

_______________

Related Topics

Transparency Tool
Transparency overview
Applying three point transparency
Changing three point transparency



Changing the magnetic snap distances

When you enable object snapping, handles and objects lock to each other. When you drag something near a handle on the edge 
of an object (or the center of a QuickShape) or the edge of an object, it locks to it. Guide snapping and grid snapping work in the 
same way. You can change how close an object or handle has to be to a guide, grid point or an object.

There are two settings, one for points on objects and one for their edges. The points setting is usually larger so when you drag 
something along an edge it still obviously lock on to points.

To change the magnetic snapping distances
1. From the Utilities Menu, choose Options (see Options).
2. Click the Mouse tab.
3. Change the settings for the point and line distances.

Movies

{button ,EF("XaraDemo.exe","Magnet Object Snapping",1,`') } Using object snapping

_______________

Related Topics

Object snapping
Guides overview
Grid



Changing the nudge size

You can change the distance objects and handles move when you nudge them.
To change the nudge distance

1. From the Utilities Menu, choose Options (see Options).
2. Click the General tab.
3. Enter a nudge distance in the Nudge Size field.

Tip
You can enter the nudge distance using any units. e.g. '1mm' or '0.2cm'.

_______________

{button ,KL(`nudging',0,`____No_Topics_Found',`')}    Related Topics



Changing the number of colors in bitmaps

You can convert bitmaps to Monochrome (2 colors), Grayscale (256 shades of gray), 16 colors or 256 colors. Increasing the 
number of colors in a bitmap will not increase its quality and uses more memory. Reducing the number of colors uses less memory 
and disk space, but the quality of the bitmap may be reduced. As a change in the number of colors of a bitmap creates a new 
bitmap, the original (unchanged) image has to be deleted before the memory is freed - see the Bitmap Gallery for more details.

Monochrome: These convert the bitmap to black-and-white. They can produce moiré (interference) patterns. Therefore 
only use these where really necessary. They are not needed for printing to monochrome printers as Xara X automatically screens 
images. The three monochrome operations are simply different conversion methods. Diffusion will generally give the best quality 
output.

Grayscale: This is useful for converting colored images to shades of gray.
16 Color: These produce 16 color bitmaps. Diffusion generally gives the best quality results.
256 Color: These produce 256 color bitmaps. Octree gives the best results but the extra dithering may produce larger 

files than Popularity.
To change the number of colors

1. Select the bitmap (see Selecting objects).
2. From Bitmap Effects & Plug-ins on the Utilities menu, choose Bitmap Effects.
3. Choose Color Depth.
4. Select the number of colors you want.
5. Click the OK button to insert the new, altered bitmap into the document.

Tips:
You can also select a bitmap in the Bitmap Gallery and then click the Plug-ins button on the Gallery.



Changing the number of sides of a polygon

You can use the QuickShape Tool to easily create regular polygons. At any time you can change the number of sides.
To change the number of sides of a polygon

1. Select the polygon (see Selecting objects).
2. Choose the QuickShape Tool.
3. Choose the number of sides from the drop-down list on the Transparency Tool Infobar.

Tip
If the number of sides you want is not on the list, type a value into the field on the Infobar and press RETURN. Any value 

from 3 to 99 is valid.

_______________

Related Topics

QuickShape Tool
QuickShapes overview
Polygons



Changing the number of steps in a blend

Blends are initially created with five intermediate steps. You can increase the number of steps to make each less obvious. 
Alternatively you can reduce the number of steps so you can clearly see each step. You can either enter the number of 
intermediate steps or enter the distance between steps.

To change the number of steps in a blend
1. Select the blend object (see Selecting objects).
2. Choose the Blend Tool.
3. Select either Distance or Number of steps.
4. Type the required value into the Steps field on the Blend Tool Infobar and press RETURN.

Tip
To create irregular spacing between the blend steps see Changing the blend position profile.
If a blend is slow to redraw, you can turn off anti-aliasing in the blend rather than reducing the number of steps. See Anti-

aliasing steps in a blend.

Notes on distance:
Distance is dimmed except for a blend along a curve.
If the end object is not on an exact multiple of the distance, Xara X moves the end object. (For example, if the distance 

between the start and end objects is 1 inch and you enter a distance of 0.3 inches, Xara X moves the end object to 0.9 inches from 
the start object [3x0.3 inches].)

The distance between steps varies if you use a non-linear Position Profile. The value shown is the average distance.

_______________

Related Topics

Blends
Blend Tool



Changing the number of steps in a contour

Contours are initially created with five intermediate steps. You can increase the number of steps to make each less obvious. 
Alternatively you can reduce the number of steps so you can clearly see each step. You can either enter the number of 
intermediate steps or enter the distance between steps.

To change the number of steps in a contour
1. Select the contoured object (see Selecting objects). (See Note.)
2. Choose the Contour Tool.
3. Select either Distance or Number of steps.
4. Type the required value into the Steps field on the Contour Tool Infobar and press RETURN.

Tip
To create irregular spacing between the Contour steps see Changing the contour position profile.
If you have several contoured objects selected, any changes apply to all the contours.

Notes on distance:
If required, Xara X rounds the distance to give a whole number of steps.
The distance between steps varies if you use a non-linear Position Profile. The value shown is the average distance.

Note:
You can also use the Contour Tool to select objects - more details.

_______________

Related Topics

Contours
Contour Tool



Changing the page size

You can produce drawings on virtually any size page.
To change the page size

1. From the File menu, choose Page Options (see Page Options).
3. From the Paper Size drop-down list, select the new page size. For example A4.

Tips
For details of changing the paper size for all new documents, see Changing the default paper size.
If you want to use a paper size not listed, select the Custom option from the drop-down list and enter the width and height



Changing the page units

The Page Units are the units used for most measurements in Xara X. For example the Status Line and the Selector Tool Infobar 
show measurements in the page units.

To change the page units
1. From the Utilities Menu, choose Options (see Options).
2. Click the Units tab.
3. Select a unit from the drop-down list.

Tips
The units used for the grid and rulers are set using the Grid and Ruler Options.
If you want to create your own custom units, see Creating custom units.
For a list of the standard measurement units see the Units Overview.
You can change the default units used by Xara X - see Changing the default units



Changing the position of a Wall shadow

You can the shadow relative to the object casting the shadow.

To change the direction (angle)
1. Select the object (see Selecting objects). (See Note.)
2. Choose the Shadow Tool.
3. Either:

drag the shadow
or type values into the Horizontal/Vertical position text boxes on the Shadow Tool Infobar.

Notes:
If you select multiple shadows, a target 

 appears in the center of the selection. Drag the target to move all the shadows. Or you can drag on a shadow to move just that 
shadow.

You can also use the Shadow Tool to select objects - more details.
Changing the Blur changes the size of the shadow (changing the Blur size).
If you have several shadowed objects selected, any changes apply to all the shadows.

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



Changing the program's memory requirements

Xara X uses memory to build up the image on your screen (and when you print and export bitmaps). You can change the amount 
of memory used if your machine does not have much memory.

To reduce the memory used
1. From the Utilities Menu, choose Options.
2. Click the Tune-ups tab (see Tune-ups Options).
3. Click the Use Limited Memory button.
4. Enter a value into the field on the right.

Tips
This will slow the program down. If you find it very slow, you might want to consider upgrading the memory in your 

machine.
You can enter values in megabytes, kilobytes or bytes. For example "1M" (1Megabyte), "200K" (200 Kilobytes), "4000" 

(4000 bytes)
The Automatic option allocates as much memory as possible. (The amount depends on the memory in your computer.) 

Selecting Automatic always gives the best performance.



Changing the resolution of a bitmap fill

Changing the resolution lets you resize the bitmap used in a bitmap fill.
To change the resolution of a bitmap fill

Drag the outer fill handles. SHIFT-dragging preserve the aspect ratio of the bitmap. (See Moving bitmap fill handles.) Alternatively, 
if you want to set the resolution to a precise value you can use the Fill Tool Infobar:
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Click away from the fill handles to ensure none is selected.
4. Enter a value in DPI into the Resolution field on the Infobar.
5. Press RETURN.

Tips
If there is a selected fill handle, Resolution shows the name of the handle.
At low resolutions (below 70 dpi) the individual pixels of the bitmap may be noticeable.

_______________

Related Topics

Fill Tool
Fills overview
Applying bitmap fills
Changing bitmap fills



Changing the resolution of a bitmap transparency

Changing the resolution lets you resize the bitmap used in a bitmap transparency.
To change the resolution of a bitmap transparency

Drag the outer transparency handles. SHIFT-dragging preserve the aspect ratio of the bitmap. (see Moving bitmap transparency 
handles.) Alternatively, if you want to set the resolution to a precise value:
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click away from the transparency handles to ensure none is selected.
4. Type the required resolution (in DPI) into the Resolution field on the Transparency Tool Infobar.
5. Press RETURN.

Tips
If there is a selected fill handle, Resolution shows the name of the handle.
At low resolutions (below 70 dpi) the individual pixels of the bitmap may be noticeable.

_______________

Related Topics

Transparency Tool
Transparency overview
Applying bitmap transparency
Changing bitmap transparency



Changing the resolution of a fractal fill

Changing the resolution lets you resize the fractal used in a Fractal Cloud fill or Fractal Plasma fill.
To change the resolution of a fractal fill

Drag the outer fill handles. SHIFT-dragging preserve the aspect ratio of the fractal. (See Moving fractal fill handles.) Alternatively, if 
you want to set the resolution to a precise value:
1. Select the fractal filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Click away from the fill handles to ensure none is selected.
4. Enter a value in DPI into the Resolution field on the Fill Tool Infobar.
5. Press RETURN.

Tips
If there is a selected fill handle, Resolution shows the name of the handle.
At low resolutions (below 70 dpi) the individual pixels of the fractal may be noticeable.

_______________

Related Topics

Fill Tool
Fills overview
Applying fractal fills
Changing fractal fills



Changing the resolution of a fractal transparency

Changing the resolution lets you resize the fractal used in a Fractal Cloud transparency or Fractal Plasma transparency.
To change the resolution of a fractal transparency

Drag the outer transparency handles. SHIFT-dragging preserve the aspect ratio of the fractal. (see Moving transparency handles.) 
Alternatively, if you want to set the resolution to a precise value:
1. Select the fractal filled object (see Selecting objects).
2. Choose the Transparency Tool.
3. Click away from the transparency handles to ensure none is selected.
4. Type the required resolution (in DPI) into the Resolution field on the Transparency Tool Infobar.
5. Press RETURN.

Tips
If there is a selected fill handle, Resolution shows the name of the handle.
At low resolutions (below 70 dpi) the individual pixels of the fractal may be noticeable.

_______________

Related Topics

Transparency Tool
Transparency overview
Applying fractal transparency
Changing fractal transparency



Changing the screen dithering

You can change the type of dithering used to display your document on the screen.
To change the screen dithering

1. From the Utilities menu, choose Options.
2. Click the View tab.
3. In the dithering section, choose None, Ordered or Error-diffused.

None means there will be no dithering, Ordered uses an ordered (regular) dithering pattern and Error diffusion uses diffusion 
dithering (a more complex dithering technique). In general, Error diffusion will give the best results, but is slower to redraw than 
the others. Choosing no dithering will give the fastest redraw times.

Tip
Other drawing packages use ordered dithering. If you enable error-diffused dithering your pictures generally look better 

than those produced with other packages.



Changing the screen quality of documents

You can change the way a document appears on screen by altering the screen quality setting. You can also change the dithering 
pattern. For more details, see Changing the screen dithering.

 The Set View Quality slider.

 Outline. On this setting, no solid colors shown - only outlines even for bitmaps and objects with no outline color). If the Quality 
slider is moved to a fraction above outline bitmaps are shown in full.

 Simple. On this setting, graduated fills are shown in flat color, anti-aliasing is not used and lines are all shown one pixel wide.

 Normal. On this setting all detail is shown, but anti-aliasing is not used.

 Anti-aliased. On this quality setting all edges are anti-aliased to reduce on-screen jaggies and graduated fills are shown with 256 
steps.

To change the quality setting

1. Drag the Set View Quality slider on the control bars.

Tips
You can also change the Quality setting using the Quality submenu on the Window menu or by right-clicking on the 

document page to open the pop-up menu.
If you want to edit in outlines but see still bitmaps, drag the quality slider so it is a tiny amount to the right of the outline 

setting.
The Quality setting defines how bitmaps are exported as well as how they appear on the screen. See Creating bitmaps.
You can control the anti-aliasing of the steps in blends individually, see Anti-aliasing steps in blends.



Changing the selection with the Tab key

You can use the Tab key and the Home and End keys to select objects using the stacking order of the objects.

To select the front object

Press Home

To select the back object

Press End

To select the object in front of the selected object

Press SHIFT-Tab

To select the object behind the selected object

Press Tab

Note:
Normally Tab steps through all the objects in the document. However, if you select a member of a group (see Select 

inside), Tab steps through the objects in the group.



Changing the shadow color or fill effect

After applying a shadow to an object, you can change the shadow's color or fill effect. You can apply any of Xara X's color effects 
including multi-stage fills.

How to change the shadow color:
The easiest way is to drag-and-drop a color from the Color Line onto the shadow. (Make sure you drop the color onto the 
shadow and not the object.)

Alternatively:

This method is slightly more complex but you have full control over the color.
1. Select the shadow using the Selector Tool. (Make sure you select the shadow and not the object.)
2. Use the Color Editor to edit the color.

Note that you can also select the shadow using the Shadow Tool. Click on the shadow to select it.

Tip:
If you have several shadowed objects selected, any changes apply to all the shadows.

Movies

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

____________

Related Topics

Shadow Tool
Modifying a shadow



Changing the shadow profile

After applying a shadow you can change how the shadow transparency changes across the blur. You can have a linear transition 
(which usually gives the most realistic results) or a profiled transition.

To change the shadow profile
1. Create the shadow - see Applying a shadow.
2. In the Shadow Tool click Profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a linear transition.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the inner edge of the shadow.
+1 for more change at the outer edge.
Move the bottom slider towards:
-1 for more change in the center than at the edges.
+1 for more change at the edges.

Tip:
If you have several shadowed objects selected, any changes apply to all the shadows.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Shadows
Shadow Tool



Changing the shape of the grid

You can use one of two types of grid. With a rectangular grid the grid lines run vertically and horizontally (the grid forms rectangles 
over the document). With an Isometric grid the grid lines run vertically and at thirty degrees to the horizontal. Isometric grids are 
useful for doing technical and perspective drawings. Isometric grids form triangular shapes over the document.

To change the grid shape
1. From the Utilities menu, choose Options (see Options).
2. Click the Grid and Ruler tab.
3. n the Grid Type section, choose Rectangular or Isometric.
4. Click Apply.

Tip
If you do not see the grid, you need to turn it on. See Displaying the grid.

Movies

{button ,EF("XaraDemo.exe",`Grids Using Grids and Rulers',1,`') } Using grids & rulers



Changing the size or direction of a Floor shadow

1. Select the object (see Selecting objects). (See Note.)
2. Choose the Shadow Tool.
3. Drag towards or away from the object to change the size

or radially to change the direction. The angle can be 0-70 degrees from the vertical.

Notes:
If you select multiple shadows, a target 

 appears in the center of the selection. Drag the target to move all the shadows. Or you can drag on a shadow to move just that 
shadow.

You can also use the Shadow Tool to select objects - more details.
Changing the Blur also changes the size of the shadow (changing the Blur size).

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



Changing the size of a Glow shadow

1. Select the object (see Selecting objects). (See Notes.)
2. Choose the Shadow Tool.
3. Drag one of the eight handles around the shadow. 

Notes:
Glow shadows are directly behind the object so there is no "direction" to change.
If you select multiple shadows, a target 

 appears in the center of the selection. Drag the target to resize all the shadows. Or you can drag on a shadow to resize just that 
shadow.

You can also use the Shadow Tool to select objects - more details.
Changing the Blur also changes the size of the shadow (changing the Blur size).

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



Changing the size of text

Once you have created a text object, you can change the size of all the characters in it or just some of them. If you want to create 
a new text object using a particular font size, place the text cursor in the document and choose the font size from the Text Tool 
Infobar.

To change text size
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Select the font size from the drop-down list on the Infobar.

Tips
You can also change the size of whole text objects using the Selector Tool. See Scaling objects.
You can type any value into the field on the Infobar using any of the units available, e.g. '1cm' or '10pt'. Press RETURN 

after you have typed in the size.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Changing the size of the Color Line

You can make the Color Line smaller or larger than the regular setting.
To change the size of the Color Line

1. From the Utilities menu, choose Options (see Options).
2. Click on the View tab.
3. In the Color section, select a new size from the Color Line Size drop-down list.

Tips
If the Color Line is wider than the window, you may find it easier to apply colors using the Color Gallery. You can resize 

the gallery to form a compact palette of colors.
For Medium you can optionally display a scrollbar. A scrollbar makes it easier to scroll through the colors but takes up a 

small amount of extra space on the screen.

_______________

Related Topics

Color Line
Color Gallery



Changing the size of the pasteboard

On the screen, the gray pasteboard is shown around the white document page. You can change the width of the pasteboard 
margin around the document.

To change the size of the pasteboard
1. From the File Menu, choose Page Options.
2. Click the Page tab.
3. Change the Outer Margin value in the Spread section.

Tip
You can turn off the shadow under the page if you want. See Hiding the page shadow.



Changing the spacing between lines of text

Once you have created a text object, you can change the spacing between the lines of text. If you want to create a new text object 
using a specific line spacing, just place the text cursor in the document and set the line spacing on the Text Tool Infobar. Line 
Spacing is displayed as a percentage of the character size. '100%' spaces the lines as closely as possible without lines coming 
into contact. "200%" is double-spaced text.

To change the line spacing of text
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the buttons on the Line Spacing control on the right hand side of the Text Tool Infobar.

Tips
If you only select part of a line, changing the line spacing will affect the whole line.
You can also set the line spacing by typing a value into the line spacing field and pressing RETURN.
You can enter a value as a percentage of the size of the largest character in the line or an absolute value using any unit, 

for example you can enter '4pt' or '2cm'.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Changing the stroke shape of lines

The    Freehand & Brush Tool and Line Gallery let you change the contour (shape) of lines and the outlines of shapes.
To change the stroke shape using the Freehand & Brush Tool

This is often the easier method as the start of the list shows the most recently used stroke shapes.
1. Select the Freehand & Brush Tool.
2. If necessary click on the line to select it
3. Choose from the Select stroke list.

To change the stroke shape using the Line Gallery
1. Select the line or shape (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the Stroke Shapes section.
4. Double click on a shape.

Note:
Applying a stroke shape removes any arrowhead/tail or dash pattern already applied to the line.

Tip
You can also drag-and-drop a stroke shape from the gallery onto any line or shape (selected or unselected).
You can also change the appearance of the line using brush strokes. (For example to create an air brush effect.) See 

Changing the brush stroke design.

Movie

{button ,EF("XaraDemo.exe",`Linstroke Line stroking',1,`') } Line strokes

_______________

{button ,KL(`line',0,`',`')}    Related Topics



Changing the tiling of bitmap fills

You can use any bitmap from the Fill Gallery or Bitmap Gallery as a bitmap fill and then change the tiling of the fill. The fill can use 
either a single copy or multiple copies (or tiles) of the bitmap.

            

To change the tiling of a bitmap fill
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Select one of these from the Fill Tiling drop-down list on the Fill Tool Infobar:

Single Tile. This fills the object with only one copy of the bitmap.
Repeating Tile. This fills the object with a repeating copy of the bitmap.
Repeat Inverted. This is identical to the Repeating Tile option, but inverts (reflects) alternating copies of the bitmap.

Tip
If your bitmap doesn't quite tile correctly (you can see the joins) try the other Repeat option. Note that some bitmaps do 

not tile satisfactorily.

_______________

Related Topics

Fill Tool
Applying bitmap fills
Changing bitmap fills



Changing the tiling of bitmap transparency

You can use any bitmap from the Fill Gallery or Bitmap Gallery to control a bitmap transparency. You can then change the tiling of 
the transparency. The transparency can use either a single copy or multiple copies (or tiles) of the bitmap.

To change the tiling of a bitmap transparency
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Transparency Tool.
3. Select one of these from the Transparency Tiling drop-down list on the Transparency Tool Infobar:

Single Tile. This uses only one copy of the bitmap.
Repeating Tile. This uses repeating copies of the bitmap.
Repeat Inverted. This is identical to the Repeating Tile option, but inverts (reflects) alternating copies of the bitmap.

Tip
If your bitmap doesn't quite tile correctly (you can see the joins) try the other Repeat option. Note that some bitmaps do 

not tile satisfactorily.

_______________

Related Topics

Transparency overview
Transparency Tool
Applying bitmap transparency
Changing bitmap transparency



Changing the tiling of four color fills

You can change tiling of three color fills and four color fills so the colors extend out to infinity or so the color pattern repeats.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying four color fills
Changing four color fills



Changing the tiling of four point transparency

You can change the tiling of three point transparency and four point transparency so the transparency extends out to infinity or so 
the transparency pattern repeats.

To change the tiling
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Select Simple or Repeating from the menu on the Transparency Tool Infobar.

_______________

Related Topics

Transparency overview
Transparency Tool
Applying four point transparency
Changing four point transparency



Changing the tiling of fractal fills

You can fill objects with Fractal Cloud fills or Fractal Plasma fills to give them a random pattern. The object can contain a single or 
multiple copies (or 'tiles') of the fractal. you can easily change this tiling.

To change the tiling of a fractal fill
1. Select the fractal filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Select one of these from the Fill Tiling drop-down list on the Fill Tool Infobar:

Single Tile. This fills the object with only one copy of the fractal.
Repeating Tile. This fills the object with a repeating copy of the fractal.
Repeat Inverted. This is identical to the Repeating Tile option, but inverts (reflects) alternating copies of the fractal.

Tips
Each option gives different results. Choose the option that gives the effect you are looking for.

_______________

Related Topics

Fill Tool
Applying fractal fills
Changing fractal fills



Changing the tiling of fractal transparency

Fractal Cloud transparency or Fractal Plasma transparency gives a random pattern to the transparency. The transparency can use 
either a single or multiple copies (or 'tiles') of the fractal. You can easily change this tiling.

To change the tiling of a fractal transparency
1. Select the fractal filled object (see Selecting objects).
2. Choose the Transparency Tool.
3. Select one of these from the Transparency Tiling drop-down list on the Transparency Tool Infobar:

Single Tile. This fills the object with only one copy of the fractal.
Repeating Tile. This fills the object with a repeating copy of the fractal.
Repeat Inverted. This is identical to the Repeating Tile option, but inverts (reflects) alternating copies of the fractal.

Tip
Each option gives different results. Choose the option that gives the effect you are looking for.

_______________

Related Topics

Transparency overview
Transparency Tool
Applying fractal transparency
Changing fractal transparency



Changing the tiling of three color fills

You can change three color fills and four color fills so the colors extend out to infinity or so the color pattern repeats.
To change the tiling

1. Select the object (see Selecting objects).
2. Choose the Fill Tool.
3. Select Simple or Repeating from the menu on the Fill Tool Infobar.

_______________

Related Topics

Fill Tool
Applying three color fills
Changing three color fills



Changing the tiling of three point transparency

You can change three point transparency and four point transparency so the transparency extends out to infinity or so the 
transparency pattern repeats.

To change the tiling
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Select Simple or Repeating from the menu on the Transparency Tool Infobar.

_______________

Related Topics

Transparency overview
Transparency Tool
Applying three point transparency
Changing three point transparency



Changing the tracking of text

Once you have created a text object, you can change the horizontal spacing between characters (letters). If you want to create a 
new text object using a specific tracking value just place the text cursor in the document and set the tracking on the Text Tool 
Infobar. Tracking is measured in thousandths of em's.

To change the tracking of text
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the buttons on the Tracking control on the right hand side of the Text Tool Infobar.

Tip
You can also set the tracking by typing a value into the tracking field and pressing RETURN.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Changing the transparency profile

You can change the shape of the transition between the start and end of transparency. (This applies to all transparency types 
except flat, three color and four color.)

To change the profile of a fill
1. Select the filled object (see Selecting objects).
2. In the Transparency Tool click Profile. This opens the profile dialog box.
3. You either select a predefined profile from the drop-down list or drag the sliders to create a custom profile. The top option in the 

drop-down list (the straight line) creates a linear transition.
When creating a custom profile:
Move the top slider towards:
-1 for more change at the end of the transparency than at the start.
+1 for more change at the start.
Move the bottom slider towards:
-1 for more change in the center than at the start or end.
+1 for less change in the center.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

_______________

Related Topics

Applying transparency
Changing transparency
Transparency Tool



Changing the type of fill

When you create a shape it is automatically filled with the default fill type. This is usually a flat fill. You can change the fill type at 
any time.

To change the type of fill
1. Select the filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Select the new fill type from the drop-down list on the Fill Tool Infobar.

Tip
You often need to adjust the more complex fill types slightly. For more information see Changing fills.

_______________

Related Topics

Fill Tool
Applying fills



Changing the undo size

Xara X uses memory to store a list of all the operations you have performed so it can undo them. You can set the undo so it is 
unlimited in size, or limit it.

To change the undo size
1. From the Utilities Menu, choose Options.
2. Click the Tune-ups tab (see Tune-ups Options).
3. Select Unlimited Undo Size or click the Limited Undo Size button and enter a maximum size.

Tips
You can enter values in megabytes, kilobytes or bytes. For example "1M" (1Megabyte), "200K" (200 Kilobytes), "4000" 

(4000 bytes).
When the undo buffer is full, the oldest information is discarded first.



Changing the way colors fade in a blend

Often the two objects in a blend use different colors. You can control how one color fades into the other.
To change the way colors fade in a blend

1. Select the blend object (see Selecting objects).
2. Choose the Blend Tool.
3. Select one of these from the Blend Effect drop-down list on the Blend Tool Infobar:

Fade: a simple transition between the two colors.
Rainbow: a colorful transition along the shortest path around the HSV Color Circle (see note).
Alternate Rainbow: fades along the longest path around the HSV Color Circle. Very colorful.

Notes
The Color Circle runs Red-Yellow-Green-Cyan-Blue-Magenta and back to Red. So a blend between Yellow and Cyan runs 

Yellow-Green-Cyan for Rainbow and Yellow-Red-Magenta-Blue-Cyan for Alternate Rainbow.
The three options give the same results where both colors are white, black or shades of gray. Rainbow is the same as 

Fade if one color is white, black or a shade of gray.
The three options give the same results if either color is a spot color.
Attribute Profile also affects the transition. You can have more change towards the ends or in the center by choosing 

suitable profiles. For more information, see Changing the blend attribute profile.

_______________

Related Topics

Blends
Blend Tool



Changing the way colors fade in a contour

Often the two objects in a contour use different colors. You can control how one color fades into the other.
To change the way colors fade in a contour

1. Select the contoured object (see Selecting objects). (See Notes.)
2. Choose the Contour Tool.
3. Select one of these from the Contour Effect drop-down list on the Contour Tool Infobar:

Fade: a simple transition between the two colors.
Rainbow: a colorful transition along the shortest path around the HSV Color Circle (see note).
Alternate Rainbow: fades along the longest path around the HSV Color Circle. Very colorful.

Notes
You can also use the Contour Tool to select objects - more details.
The Color Circle runs Red-Yellow-Green-Cyan-Blue-Magenta and back to Red. So a contour between Yellow and Cyan 

runs Yellow-Green-Cyan for Rainbow and Yellow-Red-Magenta-Blue-Cyan for Alternate Rainbow.
The three options give the same results where both colors are white, black or shades of gray. Rainbow is the same as 

Fade if one color is white, black or a shade of gray.
The three options give the same results if either color is a spot color.
Attribute Profile also affects the transition. You can have more change towards the ends or in the center by choosing 

suitable profiles. For more information, see Changing the contour attribute profile.
If you have several contoured objects selected, any changes apply to all the contours.

_______________

Related Topics

Contours
Contour Tool



Changing the way galleries look

You can change the way in which information is displayed in most of the galleries.
To change the way galleries look

1. Open the gallery from the Utilities menu.
2. Click the Options button on the gallery.
3. Choose Properties to open the Gallery Properties dialog box.
4. Choose the required display format from the drop-down list in the gallery. The options available depend on the gallery.

Tip
You cannot change the look of the Layer, Line or Name Galleries.

_______________

{button ,KL(`galleries',0,`____No_Topics_Found',`')}    Related Topics



Changing three color fills

Three color fills are controlled using a pair of fill arrows joined at one end with three associated fill handles. You can move all three 
handles by dragging the handle at the base of the arrows. You can change the fill by moving the fill handles (to change the 
position, direction and stretching of the fill) and applying different colors to the handles.

What do you want to do?
Move the fill handles
Change the colors of the fill
Change the tiling
Change the fill profile

_______________

{button ,KL(`three color fills;tools,fill tool',0,`____No_Topics_Found',`')}    Related Topics



Changing three point transparency

Three point transparency applied to an object produces graduations of transparency between three points each with its own 
transparency level. The transparency is controlled using a pair of transparency handles with a line shown between their ends to 
form a triangle. Moving the handle at the base of the arrows moves the whole transparency. You can set the transparency levels of 
the three handles to any values you like. You can also use the Transparency Tool Transparency Type options to alter the color of 
objects underneath the filled object.

What do you want to do?
Move a transparency handle
Change the transparency levels
Change transparency shape
Changing the tiling

_______________

{button ,KL(`three point transparency;tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



Changing transparency

You can use the Transparency Tool and Selector Tool to change an object's transparency. For information about transparency, see 
the Transparency Overview.

Changing flat transparency
Changing linear transparency
Changing circular transparency
Changing elliptical transparency
Changing conical transparency
Changing diamond transparency
Changing three point transparency
Changing four point transparency
Changing bitmap transparency
Changing fractal transparency
Removing transparency

Movies

{button ,EF("XaraDemo.exe","Transpar Simple Transparency Effects",1,`') } Using transparency



Changing transparency shape

Applying transparency to an object initially uses the default transparency shape. This is usually a flat transparency. You can 
change the transparency shape at any time.

To change transparency shape
1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose a new shape from the drop-down list on the Transparency Tool Infobar.

Tip
You often need to adjust the more complex transparency shapes slightly. For more information see Changing 

transparency.

_______________

Related Topics

Transparency overview
Transparency Tool



 Clear Selection (Edit Menu)    ESC (Escape)

Clear Selection deselects all selected objects. This can be useful to:
See the document without any handles visible.
Reset the transformation center.
Quickly clear the selected points on a line or shape so a new line or shape can be started (see Drawing a line with the 

Shape Editor Tool).

For more details, see Deselecting all objects.



 Clipart Gallery (Utilities Menu) SHIFT+F10

The Clipart Gallery item on the Utilities menu and the Clipart Gallery button on the control bars open the Clipart Gallery if it is 
closed and close it if it is open. The button remains pressed in if the gallery is open. For details of the Clipart Gallery, see the 
Clipart Gallery Overview.



Clipart Gallery - Disk Clipart Button

The Disk Clipart button in the Clipart Gallery opens a dialog box which you can use to choose a folder to add to the gallery or 
update an existing folder. This would usually be used to open the clipart folder on the Xara X CD, though any folder containing 
clipart can be added to the gallery. See Adding clipart to the clipart gallery for more details.

_______________

Related Topics

Adding descriptions to clipart
Clipart Gallery overview



Clipart Gallery - Empty web clipart cache

When you download files from the Internet with the galleries, the files are kept in a 'cache'. If you later use a file you have 
previously downloaded it is taken from the cache rather than being downloaded again. If you want to free up some disk space, you 
can empty the cache for the Clipart Gallery using this option.



Clipart Gallery - Get Clipart Button

Click this button to download clipart from the Internet. Click it every so often to download any new clipart that has been added.

_______________

Related Topic

Downloading items



Clipart Gallery - Import Button

The Import button in the Clipart Gallery imports the selected image into the selected document. You can also import a clipart file 
by dragging it from the Clipart Gallery and dropping it on a document.

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Clipart Gallery - Open Button

The Open button in the Clipart Gallery opens a new document and imports the selected picture into it. You can also open a clipart 
file by double-clicking on it in the gallery (CTRL-double-click to close the gallery afterwards).

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Clipart Gallery - Options Button

Clicking the Options button in the Clipart Gallery opens a menu containing the following options:
Add Clipart from disk Add a clipart folder to the Clipart Gallery.
Empty web clipart cache Empties the cache of downloaded clipart
Find Search the Clipart Gallery.
Sort Sort the Clipart Gallery.
Icon size Change the size of the icons in the Gallery.

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Clipart Gallery - Pop-up Menu

Right-clicking on the Clipart Gallery opens a pop-up menu which contains the following options:

Open Identical to the Open button.

Import Identical to the Import button.

Remove Section Identical to the Remove button.

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.

Note

Right-clicking in the gallery selects the picture under the mouse pointer, so using the pop-up menu is a quick way to select a 
picture and operate on it in one go.

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Clipart Gallery - Remove Button

The Remove button in the Clipart Gallery removes the selected sections from the Clipart Gallery. You will be asked to confirm the 
operation. You can add the sections again using the Disk Clipart button. See Adding clipart to the clipart gallery.

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Clipart Gallery - Stop Loading Button

If Xara X is downloading thumbnails from the Internet it can take some time. If you want to stop it downloading and carry on later, 
click this button.



 Clipart Gallery Overview
 SHIFT+F10

The Clipart Gallery lets you easily incorporate clipart from a folder into your document. The folder is usually on the Xara X CD but 
you can change to a different drive if necessary. You can also add your own clipart to the gallery if you wish.
    Open Open a new file.

    Import Import a file into the document
    Get Clipart Downloads more clipart from the Internet.
    Options Clipart Gallery Options

    Remove Remove the selected sections from the gallery.

    Disk Clipart Add a folder of clipart to the gallery from a disk or CD.

    Stop Loading Stops downloading clipart from the Internet.

 Clipart/Web themes View regular clipart or themed template sets.

Many operations using the Clipart Gallery are made easier by the Clipart Gallery pop-up menu.

Display Options
Large Icons
Full Information
Small Icons

Movie

{button ,EF(`xarademo.exe',`ClipGal Clipart Gallery',1,`')} Clipart Gallery

_______________

Related Topics
Clipart
Galleries overview
Selecting items in galleries



Clipart Gallery - Drop-down list

This lets you select either the regular clipart graphics or sets of themed templates for use on the web and elsewhere. More 
information on templates.



 Clone (Edit Menu)    CTRL+K

Clone creates a copy of the selection. and places it in the document in the same place as the original. Unlike Duplicate, no offset is 
used. For more details, see Copying objects.

Tip
You can remember the key shortcut by thinking of Clone as 'Klone'!



 Close (File Menu)

Close on the File menu closes the selected document and all views onto it. If you attempt to close a document which has been 
altered but not saved Xara X will ask whether the document should be saved or not before closing it.

If you have multiple views open for a single document, one of the views can be closed using Close on the document control menu. 
Alternatively, double click on the application control button (the top-left corner of the document window).

If you are editing a drawing which is embedded in a document in another program, this menu item reads Close and Update 
DocumentX where DocumentX is the document you are editing in the other program. Selecting this item closes the document and 
returns you to the other program.



Closing a gallery

Click on the icon in the top right-hand corner of the gallery.

Alternatively, when a gallery is open, its button on the control bars is pressed in - clicking the button closes the gallery.

_______________

{button ,KL(`galleries',0,`____No_Topics_Found',`')}    Related Topics



 Color Editor (Utilities Menu)    CTRL+E

The Color Editor is used to edit the color of objects (local colors) and to create and change named colors. It allows you to edit 
colors using a range of color models and even allows you to create colors which are linked to other colors (their 'parent' color) so 
that when the parent color changes, all connected colors will also change - see Color Editor - Advanced. For information about 
colors in Xara X, see the Colors Overview.

You can open the Color Editor by:
Selecting Color Editor from the Utilities menu or the selection pop-up menu.
Clicking the Edit Color button on the Color Line to edit the current fill color (SHIFT-click for line color)..
Selecting the Edit button in the Color Gallery.
Drag-and-drop a color from the Color Line or Color Gallery onto the Edit Color button on the Color Line.

What Makes Up the Color Editor?

Choose a Color to Edit

New Named Color

Snap to Browser Palette
Color Swatches

Color Picker

Show Advanced Options This provides the extra options that advanced users require.

Movies

{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

{button ,EF("XaraDemo.exe","EditCol Defining Your Own Colors",1,`') } Creating your own colors

{button ,EF("XaraDemo.exe",`Tints Using Tints',1,`') } Using tints

_______________

Related Topics

Color Line
Color Gallery
Importing colors
Named colors



Color Editor - 3D

When editing normal colors and linked colors using the RGB and CMYK models, the Color Editor can show a projection of the 
color space. This button enables this pseudo-3D display.



 Color Editor - Advanced

When the Show Advanced Options button in the Color Editor is clicked, the Editor expands to show additional options at the 
bottom of the dialog. The first section shows the exact values for the components of the color (dependent on the color model), the 
second shows the color model and the third displays the color type.

What do the controls do?

Show Only Simple Options

Color Swatches

Component Values

3D

Color Model

No Color button

Make local to frame/layer

Rename color

Color Type

Movies

{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

{button ,EF("XaraDemo.exe","EditCol Defining Your Own Colors",1,`') } Creating your own colors

{button ,EF("XaraDemo.exe",`Tints Using Tints',1,`') } Using tints



Color Editor - Choose a Color to Edit

The drop-down list shows the color being edited. If the color is a local color, the name field shows either Local Fill Color or Local 
Line Color (or Current Fill Color or Current Line Color if no objects are selected). Spot colors are shown as circles in the list, other 
colors are shown as squares.

You can choose the color to be edited by:
Choosing from the drop-down list. The first two items let you edit the current fill and line colors.
Selecting an object (or objects) to edit their local color. See Selecting objects.
Drag-and-drop a color from the Color Line or Color Gallery onto the Editor. 
Use the Color Picker on the Color Editor to select from colors used in the document.

If an object with a named color applied is selected and the Color Editor opened, making changes in the Editor will result in the 
object's color becoming a local color. The changes will not affect the named color originally used. For more information, see 
Coloring objects.



Color Editor - Color Model

When the Editor is opened, it displays a color model. The model used can be either the model used when the color was created or 
the current model. This setting is defined by Automatic Color Model Selection in the View Options. You can alter the Color 
Model using the Color Editor Menu. The color models available allow:

Editing colors in RGB (regular or web color model)

Editing colors in CMYK

Editing colors in HSV

Editing colors in grayscale



Color Editor - Color Picker

In the top-left corner of the color editing area is an "eye-dropper". You can use it to select any color visible on the screen (even 
those in other windows). Drag the eye-dropper across the screen; the color editor updates as you move over different colors. 
Release the mouse button when over the color you want to select. (This also changes the color of any objects that use the color 
shown in the Color Editor.)



Color Editor - Color Swatches

In the top-right corner of the color editing area are two color swatches. One shows the edited color and the other shows the 
original, unedited color. Either of the swatches can be drag-and-dropped onto objects to apply them as local colors. When you first 
open the Editor, both swatches show the same color.



Color Editor - Color Type

This drop-down list sets whether the named color is a normal color, a shade color, a tint color or a linked color. For more details on 
editing a color type, click on the type:

Color Editor - Normal Colors

Color Editor - Spot Colors

Color Editor - Shade Colors

Color Editor - Tint Colors

Color Editor - Linked Colors



Color Editor - Component Values

These fields define the values for the components of the color. The components shown depend on the color model in use. Note 
that when linked colors, tints and shades are being edited, some of these fields are dimmed and cannot be altered directly.

The values can be edited in one of two units, percentages (0% to 100%) or values (0 to 255). Which is used is set by the Color 
Units setting in the Units Options. If you need to enter a value in the other format, you can force the units by typing (for example) 
"25%" (for a percentage) or "25d" (for 0 to 255 value). There are two exceptions: (a) Hue in the HSV color model is an angle 
around the color circle and (b) the RGB Web color model defines colors as six hex digits (0-9, a-f).



Color Editor - Linked Colors

Xara X supports the editing of linked colors in exactly the same way as for normal colors (See Color Editor - Normal Colors) except 
those components which have been inherited from the parent color cannot be altered. Any changes to the parent color will be 
reflected in the inherited components of its linked children. The marker defining the color is constrained according to the 
inheritance - see in the diagram above how the marker is constrained to only moving in the vertical (Value) axis and the Hue 
marker is fixed in place due to the inheritance from the parent of Hue and Saturation.

The values can be edited as either percentages (0% to 100%) or values (0 to 255). More details.

_______________
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Color Editor - Make Local to Frame/Layer

When you click this button, a new named color is created, identical to the one you have selected. This new color is then applied to 
all objects in the current frame or layer that use the selected named color. This means that with one click, you can localize a color 
to the frame/layer. You can then independently edit the original color and this localized color.

This feature is useful when you are creating animations and you want an object's color to change part way through the animation.

This button is dimmed unless you are editing a named color that is also used in another frame or layer.



    Color Editor - New Named Color Button

Clicking this button opens the New Named Color dialog box. The new color is applied to the selected objects, so if you just wish to 
create a new color and not use it, make sure there are no objects selected. For more details on creating named colors, see 
Creating named colors. If you click this button whilst holding down keys, you can skip past the dialog box and specify what you 
want to do more quickly:

SHIFT Create a copy of the current color.
CTRL Create a shade of the current color.
SHIFT+CTRL Use the current settings in the New Named Color dialog box.



 Color Editor - No Color button
With this button you can set the color of an object or its outline to 'no color' so it disappears. Click it just like you would select a color 
in the Color Editor normally.



Color Editor - Normal Colors

Xara X supports the editing of normal colors in all four color models:

Editing colors in RGB

Editing colors in CMYK

Editing colors in HSV

Editing colors in grayscale

_______________
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Color Editor - Rename Color button

Click this to open the Rename Color dialog box ready to change the name of this named color. The actual color does not change.



Color Editor - Shade Colors

Shade colors are not edited using one of the four normal color models, but using a display showing all the shades available from the 
chosen parent color. Drag the marker to set the new shade. The parent color is marked in the display as a small cross (shown 
above in the top-left corner). When the parent color is altered, the change is reflected in all shades created using it.
The two fields shown at the bottom of the Color Editor when editing a shade color allow you to set the exact position of the shade. 
When the shade is no different from its parent, the values shown are 0.0 and 0.0. Moving the shade to the left or bottom edges of 
the editing area moves one of the values towards -100% and moving the shade to the top or right edges gives 100%. The first field 
controls the X (relative saturation) direction, while the other controls the Y (relative lightness/darkness) direction. 

Note

A color model can be selected, but this changes only the display of the color components.

_______________

Related Topics

Shade colors
Color Editor overview



Color Editor - Shades

The definition of a shade sets how much lighter/darker the shade is than the parent and so is edited differently from the normal 
color models, see Editing Shade Colors.



Color Editor - Show Only Simple Options

Clicking this button closes the lower part of the Color Editor, hiding the advanced options.



 Color Editor - Snap to Web Browser Palette
When you create images for the web, many people will look at them using a 256 color screen mode. In this mode web browsers use 
dithering to try and simulate more colors on the screen. This can mean you get a dotted pattern effect as the browser tries to create 
the exact color you have chosen. However, the browser palette contains 216 colors you can use which are guaranteed not to be 
dithered by Netscape Navigator and Microsoft Internet Explorer and so appear perfectly smooth on the screen. To use one of these 
colors, choose the color you want in the Color Editor as normal and then click this button. The color snaps to the nearest of the 216 
smooth colors. All 216 colors are also in the Color Gallery so you can drag and drop them straight onto your objects.

If you use transparency or import clipart that uses graduated fills or other more complex objects that generate new colors when 
they are shown on the screen, colors may be dithered.



Color Editor - Spot Colors

You can edit spot colors in any of the four color models:

Editing colors in RGB

Editing colors in CMYK

Editing colors in HSV

Editing colors in grayscale

_______________
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Color Editor - Tint Colors

Tint colors are not edited using a graphical color model display as you only need to set the percentage of the tint. The display 
shows the full range of tints available, simply move the marker to select the required color. Any change to the parent color will be 
reflected in the tint. For example if a pink tint is created with Red as a parent and the Red then altered to Orange, the tint would 
become a light orange.

A color model can be selected, but this changes only the display of the color components.

Movie

{button ,EF("XaraDemo.exe",`Tints Using Tints',1,`') } Using tints
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Color Editor Menu

Right-click on the Color Editor to open this menu:

Rename Opens the Rename Color dialog box.

Edit Parent Selects the parent (if any) of the current color so it can be edited.

HSV Selects the HSV color model.

RGB Selects the RGB color model.

CMYK Selects the CMYK color model.

Grayscale Selects the grayscale color model.

Help Opens the Xara X documentation on the Color Editor.

_______________
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 Color Gallery (Utilities Menu)    F9

Color Gallery on the Utilities menu and the Color Gallery button on the control bars open the Color Gallery if it is closed and 
close it if it is open. The button remains pressed in if the gallery is open. For details, see Color Gallery Overview.



Color Gallery - Apply Button

The Apply button in the Color Gallery applies the named color selected in the gallery as a flat fill color to the selection. See 
Coloring objects.

_______________
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Color Gallery - Background Button

To set the page background to a color, click on the color and click this button. For more details see Changing the background.

_______________
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Color Gallery - Delete Button

The Delete button in the Color Gallery deletes all the named colors currently selected in the gallery. If any of the selected colors 
are currently in use a warning will appear giving you the option to delete the entire set of selected colors, just delete the colors 
which are not being used or cancel the operation.

If you delete any colors which are in use in your document, any objects using those colors will not change in appearance, but the 
colors applied to them will become local colors.

Alternatively, you can right-click on the color in the gallery to open the pop-up menu and choose Delete which you may find easier.

_______________
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Color Gallery - Edit Button

The Edit button in the Color Gallery opens the Color Editor allowing you to change the named color which is currently selected in 
the gallery. Alternatively, you can right-click on the color in the gallery to open the pop-up menu and choose Edit or just double-
click on the color.

_______________
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Color Gallery
Color Editor
Named colors



Color Gallery - Name Button

The Name button in the Color Gallery opens the Rename Color dialog box which allows you to change the name of the named 
color selected in the gallery. Alternatively, you can right-click on the color in the gallery to open the pop-up menu and choose 
Rename.

_______________

{button ,KL(`color gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Color Gallery - New Button

The New button in the Color Gallery opens the New Named Color dialog box into which the name of a new named color can be 
entered. Selecting the Create button in this dialog box will then create a new color with the name you give.

If a named color is selected when the New button is pressed, the new named color will be a copy of the selected named color.

Alternatively, you can right-click on the gallery to open the pop-up menu and choose New.

_______________
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Color Gallery - Options Button

The Options button in the Color Gallery opens a menu containing the following options:
Find Search the Color Gallery
Sort Sort the Color Gallery
Icon Size Alter the way the colors are displayed in the Color Gallery.

_______________
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Color Gallery - Pop-up Menu

Right-clicking on the Color Gallery opens the pop-up menu which contains the following options:

New Creates a new named color, see New above.

Edit Opens the Color Editor, see Edit above.

Delete Delete the selected colors, see Delete above.

Redefine Redefine the select named color, see Redefine above.

Rename Renames the selected color, see Name above.

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.

Show in Color Line Displays (or hides) all the colors in this section on the Color Line.

Set Page Background Sets the page background using the selected color.

Note

When you right-click on a color the color is selected and the pop-up menu opens, so this is a quick and easy way to select a color 
and operate on it.



Color Gallery - Redefine Button

When the Redefine button in the Color Gallery is clicked, the definition of the named color selected in the gallery is set to that of 
the fill color of the currently selected object. This provides an easy way of redefining an existing named color to look like a color 
used in your document.

Alternatively, you can right-click on the color in the gallery to open the pop-up menu and choose Redefine.

_______________
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 Color Gallery Overview
 F9

The Color Gallery gives you full control over all the named colors in all the documents currently loaded. Local colors only exist on 
individual objects and are not shown in the Color Gallery. For information about colors in Xara X, see the Colors Overview.

The Color Line displays the named colors in a document in the same order as the Color Gallery, so moving colors in the gallery 
also moves them on the Color Line. The named colors on both can also be reordered either manually or using a specific sort - see 
Reordering items in a gallery. The list of named colors can also be searched (see Searching a gallery).

When a named color is not currently used in a document, it has 'Not in use' shown next to it if the Full Information display option 
(see Changing the way galleries look) has been chosen. In the same way, shade colors have "Shade of XX" written next to them 
where XX is the name of the parent color.

Apply Applying a named color to objects

New Creating a new named color
Delete Deleting a named color

Options Color Gallery options

Redefine Redefine a named color from an object
Edit Change a named color
Name Change the name of a color
Background Change the page background color

Web Browser Colors

In the Color Gallery is a library of 216 colors designed for use on the Internet - the browser palette. You can't change the colors in 
this section. To use them, just drag them into the gallery section for your document or apply them to objects in your document. If 
you just use the Web Browser colors, your images will not be dithered when they are displayed on the screen by a web browser 
and so the images will appear very sharp. If you overlay transparent objects, you are creating new colors, so the image may be 
dithered.

If you have colored an object using the Color Editor, you can set its color to the nearest web browser color by selecting the object 
and clicking the Limit to Web Browser Palette button in the Color Editor.

For details on adding your own color libraries to the Color Gallery, see Importing colors and palettes.

PANTONE® Colors

At the bottom of the Color Gallery are two color libraries. One contains a full set of PANTONE® Spot Colors. The other contains a 
full set of PANTONE® Process Colors. The colors in these sections cannot be changed. To use them, just drag them into the 
gallery section for your document or apply them to objects in your document (the color will automatically be added to your 
document and appear on the Color Line).

Note that colors in Pantone libraries are not in strict numerical order. To find a particular color you may need to search for it.

If you choose to display Icons Only in the Color Gallery, the PANTONE® colors will appear in rows of colors as they normally 
appear on the PANTONE® Solid to Process Guide. See Changing the way galleries look for details. If you move any of the colors 
by dragging or sorting them, the formatting goes back to normal until you start Xara X again.

Spot Colors

Spot colors are displayed in the Color Gallery as circles. Other colors are displayed as squares.

Color Gallery Menu

You can right-click on the Color Gallery to open a pop-up menu.

Display Options
Full information (color swatch, name and 'Not in use')
Name (color swatch and name only)
Icons only (color swatch only)

_______________
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Color Line (Window Menu)

Color Line on the Bars submenu of the Window menu allows the Color Line to be turned on and off. When it is set, the Color Line 
is enabled, otherwise it is not. This setting is stored when you quit Xara X. For more details, see Hiding the Color Line. 

For general details, see the Color Line Overview.



Color Line Overview

The Color Line shows which of the named colors (if any) have been applied to the selected object(s). It also provides a quick way 
of applying named colors and of opening the Color Editor. Note that if the selection uses local colors no markers are displayed on 
the Color Line. For information about colors in Xara X, see the Colors Overview.

Color Shapes

Diamond shaped colors are library colors - you cannot edit these. See the Color Gallery Overview and Showing library colors on the Color Line for more details.

Square colors are named colors.

Circular colors are spot colors.

The Colors in Use

You can apply the colors by dragging and dropping them from the Color Line. The fill and line colors are marked (see illustration for 
Current line and fill color):

Diamond markers show the named colors used by the selected objects. A diamond in the top-left corner of a color square 
indicates the fill color. A diamond in the top-right corners indicates the line color.

Cross-shaped markers show the current color attributes if there are no objects selected. Line color on the right, fill color 
on the left.

Triangular markers show the colors of a fill if you have applied one.

Current fill and line colors

The outer part of the color swatch on the left-hand end of the Color Line shows the line color and the center shows the fill color. 
These are:

The colors of any selected objects,
Otherwise the current color attributes.

Examples

Two way hatching indicates no color (bottom example).
One way hatching indicates multiple different colors (second example).
For a graduated fill, the center shows the two colors used in the fill (third example).
You can drag and drop colors from the swatch to apply them to objects in the drawing.

Edit Color Button

Clicking on this button opens the Color Editor. The Editor shows the current fill color. (Shown in the color swatch.) SHIFT-clicking 
also opens the Color Editor but showing the current line color.

No Color

Clicking this applies a 'no color fill'. SHIFT-clicking (or right-clicking) applies 'no color' to a line. Note that this is not the same as 
100% transparent. 'No color' and transparency are different. A shape with transparency applied remains a solid shape whereas a 
shape filled with 'no color' is effectively hollow. 

Spot Colors

If your document contains spot colors, they appear on the Color Line as circles (they also appear as circles in the Color Gallery). 
This makes it easy to distinguish them from other types of color. Note that if you select the Print Spot Colors As Process Colors 
option in the Separations Options, all spot colors are treated as normal colors and are displayed on the Color Line as squares.

_______________
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Changing the color of objects
Color Line
Color Gallery
Color Editor



Color Separating Overview

Complicated drawing use many different colors. However, color printers and printing presses are limited to just a few ink colors, 
usually the four process colors Cyan, Magenta, Yellow and Black. (Black is called the 'Key' color.) Therefore when you print out the 
drawing, the computer has to separate each color in the drawing into its process color components. For example, a light green 
separates into small amounts of Cyan and Yellow.

To print colors lighter than the pure ink color, the printer uses small dots of ink. The larger the dot, the less paper color shows 
through and the darker the printed color. The spacing between the dots (the screen frequency) determines how easily the human 
eye sees individual dots. Closely spaced dots are less noticeable than widely spaced dots. The minimum distance between the 
dots depends on the type of printer and the type of paper. This is why you should consult your service bureau and print shop if you 
are producing imageset output.

The inks used are not pure pigment. Also dark colors are best printed by substituting black for a proportion of the other colors. This 
is allowed for during output by a process called 'color correction'. When producing separated output, Xara X uses very complex 
correction algorithms to get the best possible results.

Spot colors are output without being color separated and without color correction. Each color appears on its own plate.

Three-color, Four-color, Fractal and Bitmap fills always output as RGB bitmaps and are color-corrected. This means that any spot 
colors used in these fill types output to the CMYK separations not to the spot separation.

_______________
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Coloring objects

When you want to color an object, you have two choices. You can use colors so they each only apply to individual objects (local 
colors) or you can use named colors so when the named color is changed, all objects using the color reflect the change. Local 
colors are changed using the Color Editor, named colors are applied using the Color Line (or the Color Gallery).

What do you want to do?
Change an object's fill color
Change an object's line color
Change a bevel color
Change a shadow color
Change a contour color

_______________
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Creating named colors
Copying colors
Color Editor
Color Gallery
Named colors



Colors Overview

Xara X provides a comprehensive color system so you can alter the colors of objects directly or create your own colors, with 
names, which you can apply to multiple objects. You can also create connected colors. Connected colors are based on other 
colors so when the base color changes, the connected color also changes. It is very easy to create a drawing containing many 
shades of a color and with one alteration, change the color of the whole picture. The named colors in a document are displayed on 
the Color Line and also in the Color Gallery. You can apply colors using either and with the Color Gallery you can easily create, 
delete and change colors.

Xara X includes full sets of PANTONE® colors which appear at the bottom of the Color Gallery. You can easily drag these colors 
into your own documents and apply them directly to objects.

The following types of color are available (click for more information):
Normal Colors
Shade Colors
Tint Colors
Linked Colors
Spot Colors

Movies

{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

{button ,EF("XaraDemo.exe","EditCol Defining Your Own Colors",1,`') } Creating your own colors

{button ,EF("XaraDemo.exe",`Tints Using Tints',1,`') } Using tints
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Combine Shapes (Arrange Menu)

The Combine Shapes submenu contains four options for 'combining' objects to produce new shapes. They are:
Add Shapes
Subtract Shapes
Intersect Shapes
Slice Shapes

The Combine Shapes operations are also available from the pop-up menu - just right-click on the selected objects.

Note
The Combine Shapes operations function equally well with objects other than shapes. Bitmaps are automatically 

converted to simple shapes filled with the original bitmap.



Configuring a web server for Xara files

If you want to put Xara files on your web pages using the Xara plug-in, you will need to configure your server to use the correct 
MIME type when it transfers Xara files. MIME types are a standard way of determining the content of a file while it is transmitted 
across the Internet, and are appended to the file in a standard header. For instance, every HTML file is transmitted with the MIME 
type 'text/html', so that anything receiving it can recognize it as HTML and treat it accordingly.

The way servers are set up by default, they transmit WEB files and XAR files with a default setting of 'text/plain'. This causes the 
browser to attempt to display them on screen as text, which will generate a stream of gibberish, or a complaint from your browser 
that there isn't a plug-in for 'text/plain' files available.

You need to configure your server to recognize Xara files. Xara files have the MIME type 'application/vnd.xara' .
To configure your own server

If you run your own Web server on your machine, you will probably need to add a line to a file called mime.types or something 
similar (mime.typ on Microsoft's NT server, for example). This file is usually a list of MIME types and file extensions in the format 
"mimetype/subtype .extn". There can be more than one extension for each mime type, or no extension at all. For instance, here 
are a few typical entries in a mime.types file: 

application/postscript ai eps ps 

application/slate

application/x-csh csh 

application/x-dvi dvi 

image/gif gif 

image/jpeg jpeg jpg jpe

image/tiff tiff tif 

You will therefore need to add this line to the file:

application/vnd.xara      xar web cmx cdr

You will usually then need to restart the server. There may be a configuration utility supplied with the server to do this 
automatically. Adding to the MIME types on a server is a very common operation, and the documentation that came with your 
server will describe how to do it.

To configure someone else's server

If your Web pages are on another machine, for example one run by your Internet Service Provider, contact the Server 
administrator and ask them to add the appropriate MIME type. They will need to know the MIME type and the file extension.



Configuring the mouse buttons

You can configure the left and right mouse buttons so they work in the way you find most comfortable.
To configure a mouse button

1. From the Utilities Menu, choose Options (see Options).
2. Click the Mouse tab.
3. Use the drop-down lists to choose what you want the left and right mouse buttons to do.

Tip
If you want to set the mouse buttons back to what they did when you first used Xara X, click the Reset Defaults button.



Configuring the program so new objects have the most recent attributes

You can configure the program so when you create a new object, it is created using the last attributes you applied. This means that 
if you color a circle green and then draw another circle, it will appear green rather than black (or another color if you have changed 
the current attributes).

To change the setting
1. From the Utilities menu, choose Options (see Options).
2. Click the General tab.
3. Change the Give New Objects Most Recent Attributes option.



Configuring the program to ask before closing views

Many other programs let you have only a single document in memory and if you prefer this, you can configure the program to work 
this way.

To configure the program
1. From the Utilities menu, choose Options (see Options).
2. Click the General tab.
3. Change the Ask Before Closing Document Views option.



Configuring the program to ask before setting the current attributes

When you apply an attribute with no object selected, you will be asked if you want to change the current attributes so all objects 
you draw from then on use that attribute. You can turn this warning off.

To turn the warning off
1. From the Utilities menu choose Options (see Options).
2. Click the General tab.
3. Change the Ask Before Setting Current Attributes option.

Tip
This option is automatically unset if you click the Quiet button in the warning dialog box that appears confirming the 

setting of the current attributes. If this button has been pressed, the warnings can be re-enabled by setting this option.



Contour Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a contour, it contains the following options:
Contour Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________
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 Contour Tool - Attribute Profile

This lets you select how attributes (such as color or line thickness) change in a contour. You can have a regular rate of change, 
greater change at one end, or greater change in the center. For more information, see Changing the contour attribute profile.

_______________
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 Contour Tool - Contour Width

The slider and text box to the right control the size of the contour    Either drag the slider or, for precise adjustment, type into the 
text box.

_______________
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 Contour Tool - Effect Field

The Effect field on the Contour Tool Infobar provides control of the way the colors in the currently selected contour change through 
the contour. For more details, see Changing the way color fade in a contour.

_______________
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 Contour Tool - Inner/Outer buttons

These buttons let you apply the contour inside the shape (so the shape remains the same size) or outside (so the shape gets 
bigger).

_______________
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 Contour Tool - Inset Path

This button lets you use contours to change the size of objects. The effect on the size is the same as adding or subtracting a thick 
line to the object. This is useful especially for shapes like the letter "C". For more details see Using contours to resize objects.

_______________
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 Contour Tool - Join style
These buttons control the shape of corners for the contour. Options are: miter, round and beveled. Note that these buttons duplicate 
options on the Bevel Tool and the Line Gallery.

_______________
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 Contour Tool - Position Profile

This lets you select how to space the intermediate steps in a contour. You can have regular spacing or closer at one end than the 
other or closer in the center. For more information, see Changing the contour position profile.

_______________
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 Contour Tool - Remove Button

The Remove button on the Contour Tool Infobar removes any applied contour from the selection. For more information, see 
Removing a contour.

_______________
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 Contour Tool - Steps Field

The Steps field on the Contour Tool Infobar controls the number of intermediate steps used in the currently selected Contour. You 
can either:

specify the number of steps
or specify the average distance between steps (see Notes). 

To change the number or distance between steps, select one of the two options then enter a new value and press RETURN. For 
more information, see Changing the number of steps in a Contour.

Notes on distance:
If required, Xara X rounds the distance to give a whole number of steps.
The distance between steps varies if you use a non-linear Position Profile. The value shown is the average distance.

_______________
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 Contour Tool    CTRL+F7
You can use the Contour Tool to contour objects.

Contour Tool Infobar Controls
 Distance between Steps/Number of Steps

Remove
Effect

 Contour Width

Inner/Outer Contour
Position Profile
Attribute Profile

Inset path
Join style

Tip:
Applying a contour to several objects: 
If the objects are grouped, overlapping contours merge together. The contour color is the same as the rear-most object in 

the group.
If the objects are ungrouped, each object has a separate contour. The contour color is the same as the object color.

Contour Tool Operations

Contouring objects

Removing a contour

Modifying a contour

Movie

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

Tips
You can contour any type of object except those with bevels.
You can also choose the Contour Tool using the Contour Pop-up Menu.



Contouring objects

Contours let you create interesting effects around the edges of objects. Note that objects cannot have both a contour and a bevel.
 To contour an object:
1. Select the object (see Selecting objects) (see Notes).
2. Choose the Contour Tool.
3. Either

drag any of the eight handles that surround the selected objects,
or drag the Contour width slider,
or type a new value into the text box.
As you drag, you see the outline of the contour.

Notes
You can also use the Contour Tool to select objects - more details.
Applying a contour to several objects: 
If the objects are grouped, overlapping contours merge together. The contour color is the same as the rear-most object in 

the group.
If the objects are ungrouped, each object has a separate contour. The contour color is the same as the object color.
The contour steps are not separate objects. To make them selectable, you need to convert the contour to simple editable 

shapes. See Converting contours to shapes.
Dragging the handles lets you swap between inside and outside contours. (Drag the handles inside or outside the objects 

to swap.) For the other options see Swapping between inside and outside contour.
You can make the outline of objects thicker or thinner using contours - see Using contours to resize objects.
Notes on contours and feathering.

Movies
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Control Bars (Window Menu)

You can use the Control Bars dialog box to customize the control bars. You can also use it to set the size of the buttons on docked 
and floating control bars and the button size used for galleries. For more details, see Setting the size of buttons.

New
Delete
Reset
Large Buttons
the default set of Control Bars

_______________
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Control Bars Dialog Box - Delete Button

This button deletes the selected control bar. You will be asked to confirm deletion of the control bar. Note that you cannot delete 
the Infobar or the button palette.



Control Bars Dialog Box - Large Buttons

The icons used for the buttons on the control bars and galleries can be set to small icons or larger icons. The bottom part of the 
dialog box describes what sizes the icons on control bars at the top, left, right and bottom of the window are set to as well as the 
size of icons in floating control bars. The setting for the size of buttons on floating bars is also applied to gallery buttons. For more 
details, see see Setting the size of buttons.



Control Bars Dialog Box - New Button

This button opens a dialog box which will prompt for the name of a new control bar. Entering a new name and clicking OK will 
create a new control bar with the given name. The new control bar will be opened, floating.



Control Bars Dialog Box - Reset Button

This button resets the control bars to their 'factory' settings. It will remove all the buttons and bars you have added and replace any 
you have removed.



Convert Line to Shape (Arrange Menu)

This option converts a line into a shape. You can also convert the line around a shape into a new, separate object. See Converting 
lines to shapes.

Note:
Convert line to shape is dimmed for objects with shadows, contours or bevels.



 Convert to Editable Shapes    CTRL+SHIFT+S

Convert to Editable Shapes takes an object and simplifies it so it is built from only shapes.

For more details on what Convert to Shapes does to different types of objects, see the following pages:
Converting QuickShapes to shapes
Converting text to shapes
Converting groups to shapes
Converting molds to shapes
Converting blends to shapes
Converting contours to shapes
Converting bitmaps to shapes



Converting QuickShapes to shapes

You can convert a QuickShape into a simple shape built up from straight and curved line segments. This lets you add extra points 
to the shape or to change it in ways not possible with the QuickShape Tool. After converting to an editable shape, you cannot edit 
the shape using the QuickShape, Ellipse or Rectangle Tools.

To convert QuickShapes to shapes
1. Select the QuickShape (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a QuickShape quickly, right-click on the QuickShape to open the pop-up menu and choose Convert to 

Editable Shapes.



Converting bevels to shapes

You can convert a beveled object into a group containing the bevel and the object. The bevel is converted to a shape and, after 
ungrouping, can be edited. Note that after converting a bevel to a shape, you cannot use the Bevel Tool to edit it as it is no longer 
a bevel.

To convert a beveled object to shapes
1. Select the bevel or the object (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a bevel quickly, right-click on the bevel or the object. This opens the pop-up menu. Choose Convert To 

Editable Shapes.

_______________
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Converting bitmaps to shapes

You can convert a bitmap to a shape by converting the bitmap into a rectangular shape with a bitmap fill. Once you have done this 
you can change the shape just like any other.

To convert a bitmap to a shape
1. Select the bitmap (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a bitmap quickly, right-click on the blend to open the pop-up menu and choose Convert To Editable Shapes.

_______________
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Converting blends to shapes

You can convert a blend into a group containing all the blend steps. Each step is converted to a simple shape and can be edited. 
Note that after converting a blend to shapes, you cannot use the Blend Tool to edit it as the object is no longer a blend.

To convert a blend to shapes
1. Select the blend (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a blend quickly, right-click on the blend to open the pop-up menu and choose Convert To Editable Shapes.

_______________
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Converting contours to shapes

You can convert a contour into a group containing all the contour steps. Each step is converted to a simple shape and, after 
ungrouping, can be edited. Note that after converting a contour to shapes, you cannot use the Contour Tool to edit it as the object 
is no longer a contour.

To convert a contour to shapes
1. Select the contour (see Selecting objects). (See Note.)
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a contour quickly, right-click on the contour to open the pop-up menu and choose Convert To Editable 

Shapes.

Notes
You can also use the Contour Tool to select objects - more details.

_______________
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Converting groups to shapes

You can convert a group object into simple shapes. The result is a group consisting entirely of simple lines and shapes - the same 
as if you had converted each object in the group to shapes.

To convert a group to shapes
1. Select the group (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
Shortcut: right-click on the group to open the pop-up menu and choose Convert to Editable Shapes.



Converting lines to shapes

Lines are limited to flat color and transparency. However you can convert a line into a shape. You can then apply any of the fill or 
transparency types or reshape it. You can even add a new line around its outside. You can also convert the line (the 'outline') 
around a shape.

To convert a line to a shape
1. Select the line or shape (see Selecting objects).
2. From the Arrange menu, choose Convert line to shape.

If you convert an line around a shape: this produces an object the size and width of the line.

Movies

{button ,EF("XaraDemo.exe",`LinShape Converting lines to Shapes',1,`') } Converting lines to editable shapes

Note:
Convert line to shape is dimmed for objects with shadows, contours or bevels.
Converting an outline removes any fill applied to the original object. To retain the fill, clone the object before converting the 

line into a shape.
Because the converted line can now itself have a line applied, you can use this to create parallel lines. However there is a 

better way.

_______________
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Converting molds to shapes

You can convert a mold to simple shapes. The result is a group consisting entirely of simple lines and shapes.
To convert a mold to shapes

1. Select the mold (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
Shortcut: right-click on the mold to open the pop-up menu and choose Convert to Editable Shapes.



Converting shadows to shapes

You can convert a shadow into a group containing the shadow and the object (or objects) casting the shadow. The shadow is 
converted to a simple shape and, after ungrouping, can be edited. Note that after converting a shadow to a shape, you cannot use 
the Shadow Tool to edit it as it is no longer a shadow.

To convert a shadow to shapes
1. Select the shadow or the object (or objects) casting the shadow (see Selecting objects).
2. From the Arrange menu, choose Convert to Editable Shapes.

Tip
To convert a shadow quickly, right-click on the shadow or the object (or objects) casting the shadow. This opens the pop-

up menu. Choose Convert To Editable Shapes.

_______________
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Converting text to shapes

You can convert text into shapes. This gives you greater flexibility in changing the appearance of the characters. Each character 
becomes a separate shape and all the characters in each line are grouped. The lines are then grouped together to form an outer 
group. To edit individual characters inside the resulting group, you can Ungroup it twice or use select inside. For more details see 
Selecting objects in objects.

To convert text to shapes
1. Select the text (see Selecting text).
2. From the Arrange menu, choose Convert to Editable Shapes.

Make sure the text is correct before you convert to shapes. After converting, you cannot use the Text Tool to change characters, for 
example to correct a spelling mistake.

Tips
To convert the text quickly, right-click on the text to open the pop-up menu and choose Convert to Editable Shapes.
To print text to a PostScript printer that does not have the necessary fonts, you can force the program to treat the text as 

shapes when it is printed. To do this, right-click on the text object and choose Print Text As Shapes. See Printing text.



 Copy (Edit Menu)    CTRL+C or CTRL+INSERT

Copies the selection to the clipboard. Once the objects are on the clipboard they can be pasted back into the document any 
number of times, pasted into other documents and into other programs. For more information, see Cutting and copying objects to 
the clipboard.

Tips
You can copy an object to the clipboard quickly by right-clicking on it to open the pop-up menu and choosing Copy.
Cut is the same as Copy, but moves the objects to the clipboard removing them from the document.

_______________
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Copying frames

It is sometimes useful to make a copy of a frame and all the objects in that frame, particularly if you are creating an animation 
where one frame is only slightly different from another. Once you have copied a frame you can independently edit the original 
frame and the copy.

To copy a frame
1. From the Utilities menu, choose Frame Gallery.
2. Click on the name of the frame you want to copy. This selects the frame.
3. Click the Copy button in the gallery.

Tips
To create a new empty frame, see Creating frames.
You can quickly copy a frame by right-clicking on it to open the pop-up menu and choosing Copy Frame.

_______________
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Copying layers

It is sometimes useful to make a copy of a layer and all the objects on that layer. You can then independently edit the original layer 
and the copy.

To copy a layer
1. From the Utilities menu, choose Layer Gallery.
2. Click on the name of the layer you want to copy. This selects the layer.
3. Click the Copy button in the gallery.
4. Type in a name for the new layer. (See Note.)

Note
Layers MouseOff, MouseOver, MouseDown, Selected and BackBar are used by the Button & NavBar Tool. We do not 

recommend creating layers with these names as this could affect bar creation. For more information on bar creation see Creating 
Navigation Bars.

Tips
This makes a copy of a layer. To create a new empty layer, see Creating layers.
You can quickly copy a layer by right-clicking on it. This opens the pop-up menu. Choose Copy.

_______________
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Copying objects

There are several ways of creating a copy of an object. Which method you use depends on what you want to do with the copy.
Copy to the clipboard then paste back. This lets you easily copy objects between documents or between layers or frames. 

The object remains on the clipboard and you can paste it several times if required.
Create a duplicate (a copy slightly offset from the original). This is a quick way to create a copy in the same document 

and layer. You can change the duplicate offset. See Changing the duplication distance.
Create a clone (a copy exactly on top of the original).
To copy an object using Copy and Paste

1. Select the object (see Selecting objects).
2. From the Edit menu, choose Copy (CTRL+C).
3. If required, change document or layer.
4. From the Edit menu, choose Paste (CTRL+V). This pastes a copy into the center of the window.

To copy an object using Duplicate
1. Select the object.
2. From the Edit menu, choose Duplicate (CTRL+D).

To copy an object using Clone
1. Select the object.
2. From the Edit menu, choose Clone (CTRL+K).

To copy an object using the mouse
1. Choose the Selector Tool.
2. Drag the objects you want to copy.
3. Right-click where you want to leave a copy or press '+' on the numeric keypad.

Movie
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Tips
Instead of using CTRL+V you can press CTRL+SHIFT+V to paste the copy into the same position as the original. This is 

useful when moving objects between documents.
You cannot clone or duplicate objects selected using select inside. This includes selected regions within text objects.



Copying objects using connected colors

Complicated drawings such as cars require complex shading and highlights to appear lifelike. This is easier if you use connected 
colors (shades, linked colors and tints) all based on a parent color. Editing the parent color automatically updates all the connected 
colors. You can copy an object like this so that the new copy uses a different parent color and the colors of the two drawings can 
be controlled independently.

To create a copy of a drawing with a different parent color:
1. Select the drawing (see Selecting objects).
2. From the Edit menu, choose Copy. This copies the drawing to the clipboard.
3. Select the parent color in the Color Gallery, and rename it (see Renaming named colors).
4. From the Edit menu, choose Paste. This pastes a copy of the drawing from the clipboard into the document.

When you paste the drawing back into the document, Xara X finds that the parent color has been renamed and creates a new one. 
You now have a base color for each drawing and can alter their color independently. 

Tip
You can also copy the drawing into a different document, change the color and paste it back into the original document to 

achieve the same effect. This requires more memory, though.

_______________

Related Topics

Colors overview
Copying objects



Create Bitmap Copy (Arrange Menu)    CTRL+SHIFT+C

Create Bitmap Copy creates a bitmap version of the selected objects. When you select it, it opens the Create Bitmap Copy dialog 
box where you can set the options for the bitmap and even preview it before you insert it into the document. Click the Create 
button to create the bitmap. By using the Transparent Background option you can create non-rectangular bitmaps. For more 
information on creating bitmaps from objects, see Creating bitmaps from objects.

Preview boxes
Palette Options
Options Tab
Bitmap Size Tab
Create Button



Create Bitmap Copy - Bitmap Size Tab

Bitmap Size and Resolution

The size of the bitmap can be set in two ways:

Resolution Type the resolution into the dpi field. The Width and Height are calculated from this to ensure the aspect ratio of 
the bitmap is fixed.

Size Type the required width or height into one of the fields. Note that the aspect ratio of the drawing is fixed so only 
one dimension can be set - the other is calculated automatically.

Tip
Choosing a resolution of 96dpi creates the bitmap the same size as the objects (when viewed at 100% magnification).

Area to Save

Dimmed for Bitmap Copy.

Anti-aliasing

Anti-aliasing improves the appearance of graphics by smoothing jagged edges.
Maintain Screen Anti-aliasing Create the bitmap using the anti-aliasing displayed on the monitor screen. (That is, do not 

change the anti-aliasing.) This is useful if you have positioned the objects to create a precise anti-aliasing effect.
Minimize Visible Anti-aliasing On export, reposition the objects by up to a pixel to minimize the anti-aliasing required for 

good results. If in doubt which option to use, select this. (Note for CorelXARA 2.0 [and earlier] users: this is how CorelXARA 
2.0 created bitmaps.)



Create Bitmap Copy - Options Tab

This button duplicates Transparent background on the Palette Options tab. It provides compatibility for CorelXARA users.

If you set the Transparent option, any areas of the bitmap not covered by objects will be see-through. This generally means your 
bitmap is not rectangular. Only objects with no fill color appear see-through; objects with transparency applied are not see-through 
in the bitmap.

Tip
You can apply transparency to any bitmap, even if it does not have a background.



Create Bitmap Copy - Palette Options

Dithering

Dimmed for True Color.

You can select between three types of dithering with these options. Choosing None means there will be no dithering, Ordered 
using an ordered (regular) dithering pattern and Error diffusion uses error-diffused dithering (a more complex dithering 
technique). In general, error diffusion will give the best results, but only use dithering when really necessary as it prevents the file 
compression working so well and so makes files larger. You cannot use Ordered dithering with an optimized palette.

Note that you can set the dithering type for the screen display too, see Changing the screen dithering.

Palette

Dimmed for True Color.

Choose between browser palette, WebSnap palette and    optimized palette

Color Depth

Choose the number of colors your bitmap requires. The more colors, the larger the bitmap file.

Transparent bitmaps with 256 colors or less use one of the colors for the transparency. This means a 2 color transparent bitmap 
has one color plus transparency.

Colors used

Dimmed for True Color.

With this field, you can specify how many colors in the palette of the bitmap are actually used. This means you can create, for 
example, an 256 color bitmap where only 100 of the 256 palette entries are used. With some experimentation you can alter this 
setting to create bitmaps that are very small by reducing the number of colors until the quality is just at the level you will accept.

Palette colors

(Up to 256 colors only)

This displays the range of colors in the current palette. You can edit any of the colors if you want extra control - see Editing colors 
in the create bitmap palette. 

To check where colors are used in the bitmap, select the Color Selector button. Then, as you move over the image image in the 
Preview window, the color under the pointer is highlighted in the palette.

Small squares on the colors give you extra information about the color:
in the center - web safe
top left - transparent
bottom left - locked color
bottom right - edited color
(hatched square) deleted color.

Buttons

Dimmed for True Color.

These buttons (except Transparent background) apply to the selected color: click on a color in the palette (above the buttons) to 
select it. You can also select these options by right-clicking on a color, then selecting from the pop-up menu.

(Lock): always include this color in the palette. This is useful if you are reducing the number of colors in the palette. For more 
information see Locking a color.

(Web-safe); snap this color to the nearest color in the 216-color Netscape Navigator and Microsoft Internet Explorer palette. 
For more information see Making a color web-safe.

(Transparent background): make transparent any areas not covered by the selected objects. Selecting this option 
automatically makes one entry in the palette transparent. Note to CorelXARA users: this duplicates Transparent on the 
Options tab.

(Transparent): make this color entry transparent. Note the difference between this option which makes parts of the selected 
objects transparent and Transparent background which makes transparent those areas behind the selected objects. For 
more information see Making a color transparent.

(Delete): delete this color from the palette. Any areas in the bitmap that use the deleted color then use the nearest color in the 
palette. The fewer colors in the palette the smaller the bitmap file. Click R to undo a delete. For more information see 
Deleting a color.

(Restore): undelete this color.

(Add system colors): adds 28 colors to the palette. These colors are the regular Windows system colors and a number of 
primary colors. This ensures the palette includes a spread of colors and may improve the quality of the image, particularly if 
it contains a wide range of colors. You may need to experiment with this option to get the best results.



Sort By:

Controls the order in which colors are displayed in the palette. This option applies only to the display in this dialog box. It has no 
effect on the bitmap nor on the actual colors. Options:

Importance - arranged by the contribution each color makes to the appearance of the bitmap.
Popularity - arranged by the area each color covers.
Luminance - arranged by the RGB brightness of the colors.
Hue - arranged by hue.



Create Bitmap Copy Dialog Box - Create Button

This button reads Create A or Create B depending on which is the selected Preview. Click on a Preview to select it and then click 
this button to create the bitmap and insert it into the document.



Create a ClipView

ClipView lets you use an object as a "window" onto other objects. You see only those parts of other objects that are within the 
window. We call this creating a ClipView.

To create a ClipView
1. The window object must be behind the other objects in the ClipView. If necessary move it backwards. In this example the blue 

ellipse is the window object:

2. Select all the objects you want in the ClipView - see Selecting objects.
3. Choose Apply ClipView on the Arrange menu. All the window object remains visible plus those parts of other objects that 
cover the window object.

Movies
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Creating BMP files

BMP (Windows bitmap) format files can be used by many programs on the PC. Note that when exporting a bitmap, the current 
Xara X Quality (see Changing the screen quality of documents) setting is used. For example with Quality set to a low value, the 
bitmap is exported as an outline.

To create a BMP file
1. From the File menu, choose Export.
2. In the Export dialog box, choose BMP from the drop-down list.
3. Enter the filename and location then click Save. This opens the BMP Export dialog box.
4. Set the options in the dialog box and click Export. For more information on these options, click the Help button in the dialog 

box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the BMP Export dialog 

box.
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the BMP Export dialog box.

_______________
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Creating DCX files

You can create DCX format (multi-page PCX) bitmap files using a wide variety of options. Note that when exporting a bitmap, the 
current Xara X Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is 
set to a very low level the bitmap exported will be in outline only.

To create a DCX file
1. From the File menu, choose Export.
2. In the Export dialog box, choose DCX from the drop-down list.
3. Enter the filename and location and click Save. This will open the DCX Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the DCX Export dialog 

box.
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the DCX Export dialog box.

_______________
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Creating GIF files

You can create GIF format bitmap files using a wide variety of options including interlacing and transparency (masking). Note that 
when exporting a bitmap, the current Xara X Quality (see Changing the screen quality of documents) setting is used for the 
bitmap. For example if the Quality is set to a very low level the bitmap exported will be in outline only.

This covers creating a single GIF bitmap. For information on animated GIFs, see Creating animated GIF files.
To create a GIF file

1. From the File menu, choose Export.
2. In the Export dialog box, choose GIF from the drop-down list.
3. Enter the filename and location and click Save. This will open the GIF Export dialog box where you can change options and 

preview the bitmap before you save it to disk.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the GIF Export dialog 

box.
To make the bitmap see-through where there are no objects in your document, select Transparent in the GIF Export 

dialog box.
If you want to export a small area of a document, select the objects in that area and choose the Selection option in the 

Area to Save section of the GIF Export dialog box.

Transparent GIF Files

Xara X works differently from other graphics packages when you create transparent bitmaps. In other packages you choose the 
color in the bitmap you want to be transparent. In Xara X the exported bitmap is transparent where there are no objects in the 
original drawing. To make any area transparent in a bitmap just ensure there are no objects over it and select the Transparent 
option in the dialog box when you export the GIF file. (However you can also select a color and make that transparent if you wish.)

_______________
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Creating JPEG files

You can create JPEG format bitmap files using a wide variety of options. JPEG files are stored using compression which works 
best with photographic-type images. You may want to experiment with the JPEG quality setting to find a level that creates the files 
you want.

Note that when exporting a bitmap, the current Xara X Quality (see Changing the screen quality of documents) setting is used. For 
example if the Quality is set to a very low level the bitmap exported will be in outline only (this Quality setting is different from the 
JPEG Quality).

To create a JPEG file
1. From the File menu, choose Export.
2. In the Export dialog box, choose JPEG from the drop-down list.
3. Enter the filename and location and click Save. This will open the JPEG Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the JPEG Export dialog 

box.
If you set the JPEG quality slider to a low value the picture will not look as good but the file will be smaller.
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the JPEG Export dialog box.
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Creating Navigation Bars

Navigation Bars are sets of button graphics and some associated HTML code, often used for navigating web pages. Xara X makes 
it easy to create horizontal or vertical bars or bars with custom spacing. You create the basic button graphic, then let Xara X 
generate the other buttons and an HTML (web) page for testing the bar.

Xara X can also create rollover buttons (buttons that change state) - see Creating Rollovers. (Rollovers create more complicated 
HTML code on the web page. If you are an Internet novice, we suggest using only simple bars.)

When you create a bar you can also create a BackBar (a design that appears behind the buttons) - more details.
To create a Bar:

1. To create a bar you first need an example button. Create this button in the regular way.
This button becomes the left-hand button (for horizontal bars) or top button (for vertical bars). If your button design includes 
text, your example button can show either appropriate text for the left/top button or sample text. (Sample text is useful to gauge 
the maximum width required for the finished buttons.)

2. Select the Button & NavBar Tool.
3. If necessary, select the button - see Selecting navigation bar objects.
4. Click New. This opens the Bar Properties dialog box.
5. Select the required options in the Bar Properties dialog box - more details on these options.
6. Click Create on the Bar Properties dialog box to create the extra buttons.
7. Edit the buttons as required. (For example, by changing the text.)
If you want to use this navigation bar in Macromedia Dreamweaver, there is a separate page describing how to do this.
If you are not using Dreamweaver:
8. When you have made the changes click Export on the Button & NavBar Tool Infobar.

You can either create a new test page or insert the navigation bar into an existing .htm or .html page. (See Using the graphics 
and HTML code below.)
Xara X creates an .htm file that contains the HTML required to display the buttons, plus the bitmaps (GIFs or JPEGs) for the 
buttons.

9. Type in the name you want for the .htm file.
10. Select the file format for the button graphics. GIF is usually best but if the buttons include complex shading or photographs, 

JPEG may produce smaller files. For more information see Internet bitmaps overview.
11. Click Save. This opens the regular Bitmap Export dialog box. For more information on any of the options click Help on this 

dialog box.
You have the option of viewing the Bar in your regular browser.

Using the graphics and HTML code on a web page

To include the bar on a web page requires some HTML code in the web page. This description assumes you know how to edit a 
web page and have a basic knowledge of HTML. You have two options:

Let Xara X copy the HTML into an existing web page - this is the easiest option if the page already exists.
Let Xara X create a test page so you can test the bar before including it in the final page.

For either option you may need to move the bar to where you want it on the page. Technical Note: the bar is contained in a Table. 
This ensures correct formatting. Copy the entire Table to where you want the bar to appear. The Table starts 

<table name="XaraTable"... 
and ends

</table>

You may also need to copy the graphics files to your web server:
1. We recommend copying the graphics to the same folder as the web page. If you use a different folder to the web page, you 

need to edit the SRC attributes to point to the correct folder.
2. Copy the graphics to your web site. The buttons are named Button1.gif, Button2.gif etc. 

For complex bars there may be other graphics with names such as r2c1.gif plus a file called shim.gif. Copy all these to your 
web site. Technical note: Shim.gif is a dummy graphic used for padding.

3. Unless you assigned a web address to the button, the bar uses a dummy address to jump to when the button is clicked. You 
need to edit this to point to the correct page. The link address is in the HREF attribute of the Anchor tag:

<a href="untitled.htm" ...>

Movies
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Creating PCX files

You can create PCX format bitmap files using a wide variety of options. Note that when exporting a bitmap, the current Xara X 
Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is set to a very 
low level the bitmap exported will be in outline only.

To create a PCX file
1. From the File menu, choose Export.
2. In the Export dialog box, choose PCX from the drop-down list.
3. Enter the filename and location and click Save. This will open the PCX Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the PCX Export dialog 

box.
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the PCX Export dialog box.

_______________
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Creating PICT files

You can create Macintosh PICT format bitmap files using a wide variety of options. Note that when exporting a bitmap, the current 
Xara X Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is set to a 
very low level the bitmap exported will be in outline only.

To create a PICT file
1. From the File menu, choose Export.
2. In the Export dialog box, choose PICT from the drop-down list.
3. Enter the filename and location and click Save. This will open the PICT Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the PICT Export dialog box.

_______________
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Creating PNG files

You can create PNG format bitmap files using a wide variety of options including interlacing and transparency. Note that when 
exporting a bitmap, the current Xara X Quality (see Changing the screen quality of documents) setting is used for the bitmap. For 
example if the Quality is set to a very low level the bitmap exported will be in outline only.

To create a PNG file
1. From the File menu, choose Export.
2. In the Export dialog box, choose PNG from the drop-down list.
3. Enter the filename and location and click Save. This opens the PNG Export dialog box where you can change options and 

preview the bitmap before you save it to disk.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the PNG Export dialog 

box.
If you want to export a small area of a document, select the objects in that area and choose Selection in the Area to Save 

section of the PNG Export dialog box.

Transparent PNG Files

PNG format supports two types of transparency:
(For formats up to 256 colors) a simple on-off transparency. By default, areas not covered by objects are exported as 

transparency. However you can also select a color in the Export dialog box and make that transparent if you wish. To enable 
transparency select the Transparent option in the dialog box when you export the PNG file.

(For true color format) graduated ("alpha-channel") transparency. This preserves any transparency you applied using the 
Transparency Tool. To enable alpha-channel transparency select True color + Alpha in the Export dialog box.
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Creating RAS files

You can create RAS (Sun Raster) format bitmap files using a wide variety of options. Note that when exporting a bitmap, the 
current Xara X Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is 
set to a very low level the bitmap exported will be in outline only.

To create a RAS file
1. From the File menu, choose Export.
2. In the Export dialog box, choose RAS from the drop-down list.
3. Enter the filename and location and click Save. This will open the RAS Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the RAS Export dialog 

box.
To export a small area of a document, select the objects in that area and choose Selection in the Area to Save section of 

the RAS Export dialog box.
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Creating Rollovers

Creating Navigation Bars describes the basic operation of creating a navigation bar. This page gives information on the additional 
steps required for creating rollover buttons in that bar. You can create a standalone rollover button by creating a single button 
navigation bar.

Note that rollovers are slightly more complicated than a simple bar because they use JavaScript on web page. You do not need to 
know JavaScript but you may need to know the basics of HTML tags and attributes.

Creating rollover buttons:
After creating a simple navigation bar (which just contains the MouseOff state), you can create buttons for the other rollover states.

Details of creating a simple navigation bar
Details of creating rollover buttons
Viewing the button states:

1. Select from the drop-down list on the Button & NavBar Tool Infobar.
Any unused states appear as No states in the name field.

Assigning web addresses (URLs) to rollover buttons

To make it easier to create rollovers, you can give each set of buttons a URL. This is the web address to jump to when the user 
clicks the button on a web page. Adding the URL in Xara X means the exported HTML includes the correct anchor tags (which 
saves you having to edit them afterwards) Details of adding web addresses to objects. 

Notes: 
You only need to add the URL to one of the button states (for example, just to MouseOff); the same URL applies to all the 

other button states. 
You can add the URL to just a part of the button; in the exported HTML, the URL applies to the complete button.
If you apply different URLs to different button states, Xara X uses the last URL applied.
Exporting rollovers

This is the same as for simple bars.

If you want to use these rollovers in Macromedia Dreamweaver, there is a separate page describing how to do this.

If you are not using Dreamweaver: we suggest inserting the bar into an existing web page. This automatically copies the 
JavaScript to the correct place on the web page.

Using the graphics and HTML/JavaScript on a web page

To include a bar with rollovers on a web page requires some HTML and JavaScript on the web page. This description assumes 
you know how to edit the web page and have a basic knowledge of HTML. (You do not need to know JavaScript.) 
1. Skip this step if you inserted the bar into an existing web page. It applies only if you created a new page or overwrote an 

existing page.
Copy the JavaScript into your web page. The script starts

<!-- Navbar def -->
and ends

<!-- Navbar def end -->
Copy this entire block into the HEAD section of your web page. A convenient place is just before the </head> tag. If your web 
page already contains some JavaScript, just insert this new script after the existing </script> tag. You can have more than one 
JavaScript block on the same HTML page. 

2. You may need to move the bar to where you want it on the page. Technical Note: the bar is contained in a Table. This ensures 
correct formatting. Copy the entire Table to where you want the bar to appear. The Table starts 

<table name="XaraTable"... 
and ends

</table>

You may also need to copy the graphics files to your web server:
1. We recommend copying the graphics to the same folder as the web page. If you use a different folder to the web page, you 

need to edit the SRC attributes to point to the correct folder.
2. Copy the graphics to your web site. The buttons are named Button1.gif, Button2.gif etc. for the default MouseOff state and 

Button1MouseOver.gif, Button1Selected.gif etc. for the other states.
For complex bars there may be other graphics with names such as r2c1.gif plus a file called shim.gif. Copy all these to your 
web site. Technical note: Shim.gif is a dummy graphic used for padding.

3. Unless you assigned a web address to the button, the bar uses a dummy address to jump to when the button is clicked. You 
need to edit this to point to the correct page. The link address is in the HREF attribute of the Anchor tag:

<a href="untitled.htm" ...>

Movies
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Creating TARGA files

You can create TARGA format bitmap files using a wide variety of options. Note that when exporting a bitmap, the current Xara X 
Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is set to a very 
low level the bitmap exported will be in outline only.

To create a TARGA file
1. From the File menu, choose Export.
2. In the Export dialog box, choose TARGA from the drop-down list.
3. Enter the filename and location and click Save. This will open the TARGA Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the TARGA Export dialog 

box.
To export a small area of a document, select the objects in that area and choose Selection in the Area to Save section of 

the TARGA Export dialog box.
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Creating TIFF files

You can create TIFF format bitmap files using a wide variety of options. Note that when exporting a bitmap, the current Xara X 
Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the Quality is set to a very 
low level the bitmap exported will be in outline only.

To create a TIFF file
1. From the File menu, choose Export.
2. In the Export dialog box, choose TIFF from the drop-down list.
3. Enter the filename and location and click Save. This will open the TIFF Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the TIFF Export dialog 

box.
To export a small area of a document, select the objects in that area and choose Selection in the Area to Save section of 

the TIFF Export dialog box.
Xara X exports TIFFs in RGB format.

_______________
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Creating Tint Colors

Tint colors are based on a parent color and are lighter than their parent. They have many uses and are very easy to create in Xara 
X.

To create a tint color
1. From the Utilities menu choose Color Editor.
2. Click New Named Color in the Color Editor to open the New Named Color dialog box.
3. Enter a name for the color.
4. Click Create to create the color
5. If not already selected, click Show Advanced Options button on the Color Editor. (See Color Editor for the position of this 

button. See Color Editor - Advanced for more details of the advanced options.) 
6. Select Tint of Another Color from the Color Type menu. Color Editor - Tint Colors shows the Color Editor ready to edit a tint.
7. Select the parent color. The parent can be any named color including other tints.
8. Drag the slider or type in a value to set the exact tint color.

_______________
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Creating WPG files

You can create WPG (WordPerfect Group) format bitmap files using a wide variety of options. Note that when exporting a bitmap, 
the current Xara X Quality (see Changing the screen quality of documents) setting is used for the bitmap. For example if the 
Quality is set to a very low level the bitmap exported will be in outline only.

To create a WPG file
1. From the File menu, choose Export.
2. In the Export dialog box, choose WPG from the drop-down list.
3. Enter the filename and location and click Save. This will open the WPG Export dialog box.
4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the WPG Export dialog 

box.
To export a small area of a document, select the objects in that area and choose Selection in the Area to Save section of 

the WPG Export dialog box.
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Creating Xara WEB files

Web format files are used in Xara Webster, an earlier version of Xara X. WEB files are also ideal for archiving drawings as you can 
remove unwanted information such as unused colors.

To create a Xara WEB file
1. From the File menu, choose Export.
2. Select Xara (WEB) from the drop-down list.
3. Enter the location and name for the file and click Save.
4. In the Xara WEB dialog box, set the options. Click the Help button for more information on the options.

Tips
To produce the smallest possible files, select Remove Preview Bitmap and Remove Extra Editing Information.



Creating a Navigation Bar BackBar

The Button & NavBar Tool lets you create multi-button navigation bars for web pages. You can also create a BackBar, which is a 
design that appears behind the    buttons. Exporting the buttons also exports the BackBar.

To create a BackBar:

You can create the BackBar either when you create the buttons or separately. Use the method you prefer.

Creating the BackBar when you create the buttons:

(This is our recommended way of creating a BackBar.)
1. Create the BackBar object(s) in the regular way. 
2. The BackBar is created from the rear-most object. If you want to use several objects in the BackBar design, you must group 

them - see Grouping objects. If necessary, move the BackBar object or group behind the button design - see Moving objects 
backwards and forwards.

3. Select the BackBar object or group and the button design - see Selecting navigation bar objects.
4. Open the NavBar Properties dialog box by clicking New on the NavBar Tool Infobar. (General information on this dialog box.)
5. In this dialog box select Make BackBar from backmost object.
6. Click Create. This creates the buttons and stretches the BackBar object or group to match the size of the navigation bar.

The BackBar object or group moves to a special layer called BackBar and has the name BackBarN (where N is a number). 
You can see this name in the Name Gallery. 

Creating the BackBar separately:

You can also create the BackBar after creating the navigation bar.
1. Create the BackBar object(s) in the regular way (see Note). Using this method you do not need to group the object(s) or move 

them to the back.
2. Select the BackBar object(s) - see Selecting navigation bar objects.
3. Open the NavBar Properties dialog box by clicking Bar properties on the NavBar Tool Infobar. (General information on this 

dialog box.)
4. Click Create BackBar. The BackBar object(s) move to a special layer called BackBar and have the name BackBarN (where N 

is a number). You can see this name in the Name Gallery.

Note:
To get the positioning correct, it is usually easier to create your BackBar behind the navigation bar buttons. (Otherwise the 

BackBar is in front of the buttons and obscures them.) The buttons are in special layers called MouseOff, MouseOver, 
MouseDown, and Selected, which are usually behind the layer you are using. You therefore need to create a new layer and move it 
behind the special layers.

Movie
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Creating a custom unit

You can create your own units and use them to create your drawings. After you have created a new unit, you can enter values 
almost anywhere in the program using the new units. For example, if you define decimeters (dm) as 10 centimeters, you can enter 
values like "0.2dm" in virtually any field in the program.

To create a custom unit
1. From the Utilities menu, choose Options.
2. Click the Units tab.
3. Click the New Unit button to open the Unit Properties dialog box.
4. Enter the name and abbreviation for the new unit. The abbreviation should be different from those already in use.
5. Select whether the abbreviation should be prefixed or suffixed. e.g. "dm10" or "10dm".
6. Enter values at the bottom of the dialog box to set the ratio of the unit to one of the existing units.

Tips
If you want the Selector Tool Infobar and the Status Line to show dimension in your new units, change the Page Units. 

See Changing the page units.
You can create units that are not linear measurements. For example, you can create a measurement called US$ for 

preparing financial diagrams.
Units such as Miles or Kilometers are too large to be used directly but you can scale them down. For information see 

Setting a scale factor. This is also useful for creating scale drawings (for example, 1:100).
For details on changing the units used by the rulers, see the Grid and Ruler Options.
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Creating a double page spread

You can create a document consisting of two pages side by side. This is a double page spread.
To create a double page spread

1. From the File Menu, choose Page Options.
2. Select Double Page Spread.

Tip
For information about printing double page spreads, see the Printing Overview.

_______________
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Creating a glow effect

Creating a glow or halo behind an object can create dramatic graphics.
To create a glow effect

1. Select the object (see Selecting objects). (See Note.)
2. Choose the Shadow Tool.
3. Select the Glow button on the Shadow Tool Infobar.
You can alter the shadow to suit your needs - see Modifying shadows.

Note:
You can also use the Shadow Tool to select objects - more details.

Related Topics
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Creating a template document

When you create a new document, it is a copy of a template document. Creating a new template document is an easy way to 
customize your documents. For example, you can customize a template by adding objects to it, changing the color or changing the 
options.

To create a template document
1. From New submenu on the File menu, choose a suitable template on which to base your new template.
2. Make the changes to the document as necessary. For example by adding a logo or changing the paper size. See Options for 

details of some of the options you can change.
3. From the File menu, choose Save Template. Click Help on the Save Template dialog box for more details of available options.

Tips
You can discard any changes you have made to the default document and return to the original default document supplied 

with Xara X (the factory default). To do this, delete the template file (the top item on the New submenu shows the name of this file.) 
The factory default document gets recreated the next time you run Xara X.

Templates are regular files. You can delete unwanted templates exactly like other files. For more details of deleting files 
see the Windows Help available from the Start button.

If you accidentally delete the animation template you can either recreate it from an ordinary animation document or 
reinstall Xara X.



Creating animated GIF files

It's easy to create animated GIF files. You create the animation as a series of separate frames, edit the properties of each frame in 
the Frame Gallery and then just export the animation.

To create an animated GIF you must open the document as Animated. Refer to Creating new documents for details of how to do 
this.

To create an animated GIF
1. Open the Frame Gallery by choosing Frame Gallery on the Utilities menu. For a new document the Frame Gallery shows a 

single frame.
2. Draw what you want to appear in this first frame.
3. In the Frame Gallery click New to create the next frame.
4. Set the Background and Overlay flags as required.
5. Create the objects you want to appear in this frame.
6. Repeat steps 3 through 5 until you have built up the sequence of frames.
7. Set the delay for each frame by right-clicking on each bitmap in the gallery and selecting Properties.
8. Before saving the Animated GIF you can preview either a single frame or the complete animation. Click Preview to open the 

Preview window.
9. To save out the animation, choose Export Animated GIF from the File menu.

Movies
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Tips
You can create frames in any order then use the Frame Gallery to arrange them in the correct order.
To hide a frame (not make it part of the animation) right-click on the frame to display a pop-up menu. Deselect Show 

Frame on the menu. There’s a similar option on the Frame tab of the Properties dialog box (click Properties on the Frame Gallery).
Instead of creating a new frame you can also copy any of the existing frames by clicking Copy in the Frame Gallery. This 

is useful where you want a moving object in the animation. Copy the frame, move the object slightly, repeat this operation until you 
have built up the complete animated sequence.

You may want part of an object at the edge of the Animated GIF. You can use Intersect (on the Combine Shapes 
submenu of the Arrange menu) to cut objects.

To select objects in multiple frames select All Visible and All Editable in the Frame Gallery. 
To make the final animation a specific size: Select All Visible and All Editable; select all objects; and then use the 

Selector Tool to set the size. You can then export the animated GIF.
If an object uses a named color and you want to change that color part way though the animation, click Make Local to 

Frame on the Color Editor. This creates a new named color local to that frame. See Color Editor - advanced operations for details.
Some programs do not support animated GIF files. For example versions of Netscape before Version 2 and Internet 

Explorer before version 3.
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Creating bitmaps

You can create bitmaps in a wide variety of different formats. For more information on each of them, click below. If you want to 
create bitmaps for the Internet, see the Internet Bitmap Overview.

Creating JPEG files
Creating GIF files
Creating animated GIF files.
Creating BMP files
Creating TIFF files
Creating DCX files
Creating PCX files
Creating PNG files
Creating PICT files
Creating RAS files
Creating TARGA files
Creating WPG files

Tip
If you want to create a bitmap of some objects in a document and use the bitmap in the document, see Creating bitmaps 

from objects.

_______________
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Creating bitmaps from objects

You can create a bitmaps from objects in your document. The bitmaps can be virtually any size, use any number of colors and can 
even use a mask (include see-through areas).

To create a bitmap from objects
1. Select the objects.
2. From the Arrange Menu, choose Create Bitmap Copy.
3. In the dialog box, set the size you want the bitmap, set the number of colors and choose the dithering and palette (browser, 

WebSnap or optimized).
4. If you select the Background Transparency option in the dialog box, only the area covered by the selected objects is 

exported.. Other areas are transparent. 
Note: advanced users can also make selected colors in the bitmap transparent by selecting the color then clicking make color 
transparent. See Editing colors in the palette.

Masked (Transparent) Bitmaps

The effect of exporting the red star. On the left without background transparency - the green background and all the blue circle are 
exported. On the right, with background transparency - only the part of the blue circle covering the red star is exported.

Note that the actual bitmap is always rectangular even if it contains transparent areas.

Smooth Bitmap Edges

If your final bitmap has see-through areas, it will look better if the edges of the objects in the drawing are smoothed against the 
background color. This is easily achieved if you place a copy of the background behind the objects when you export them (do not 
select the background). This will create a bitmap with very smooth edges. Remember not to select the background object when 
you create the bitmap. You may find it useful to place the background object in a new, background layer.

In this example, in the left picture, the purple star was exported as a transparent bitmap with a black rectangle behind it. Notice 
how its edges look great on the black areas. In the right picture, the purple bitmap was exported with a white rectangle behind it, 
notice how much better it looks on the white background.

Tips
To create a bitmap copy quickly, right-click on one of the selected objects to open the pop-up menu and choose Create 

Bitmap Copy.
If you hold down SHIFT when you click the Create button in the dialog box, the bitmap will be created on top of the 

selected objects. Note that this may mean it looks like nothing has changed after the bitmap has been created.
Bitmaps can look like they are of a lower quality than normal if they are not shown at a high enough magnification.
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Creating column text

Column text is different from simple text as it has a fixed width. If a word doesn't fit in the width, it automatically moves onto the 
next line. With a simple text object, you need to press RETURN to create a new line.

To create a column text object
1. Place the pointer at the top left of the column.
2. Drag to the top-right of the column. Releasing the mouse button shows a horizontal red line under the first line of the column.
3. Set any attributes you want the text to have. For example, color, font, font size.
4. Type the required text. As each line fills, the cursor will move onto the next.

Tips
The line under the first line of text is never printed, it is only shown on the screen.
With column text you do not need to type RETURN at the end of each line as the text will automatically wrap onto the next 

line.
Once you have created the column width by dragging, you can paste text from the clipboard using CTRL+V. This is an 

easy way to import text.
A word is only ever split at the end of a line if you insert a hyphen into it.
Large columns of text can be slow to edit. If you need to edit text, you can cut it to the clipboard, edit it in another program 

and paste it back into your drawing.
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Creating custom brushes

The Freehand & Brush Tool and Line Gallery contain a range of default brush effects (such as airbrushes). You can extend the 
range of these default brushes by adding your own.

To create a custom brush
1. Draw the object or objects you want to use as the brush (see Tips).
2. If necessary select your brush design - see Selecting objects.
3. Select the Freehand & Brush Tool.
4. Click Create Brush.
5. Give the brush a name so you can identify it in the future. You can use any unique name.
6. Click OK to create the brush.

See Changing the brush stroke for details of using your new brush.

Alternatively you can edit an existing brush - see Changing brush stroke properties.

Xara X saves only brushes used in the document. It discards unused brushes when you quit the program. To ensure a brush 
always gets saved, draw a line in the gray pasteboard area and apply the brush to that line. (Items in the pasteboard area are non-
printing.)

You can add custom brushes to the default set of brushes - more details.

Movies

{button ,EF("XaraDemo.exe",`NewBrush Creating a New Brush',1,`') } Creating a new Brush

Tips
Complicated brush designs can be slow to redraw, especially on thin lines. Make the brush as simple as possible.
Creating a brush from several objects: 
To keep the objects in the same relative positions group them before creating the brush .
To create a brush where the objects appear in sequence, do not group them.
You can use both named colors and local colors in your brush design. When editing the brush, you have the option of 

allowing changes to none of the colors, all the colors or only named colors.
You can also use an existing brush as the basis for your new brush. Right-click on the brush in the Line Gallery. Select 

Copy brush graphic to clipboard then paste the shapes into your document.
You can use brushes to "paint" with bitmaps - more details.
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Creating custom fills

You can fill any object you draw with a bitmap. As you can create bitmaps of any objects in your document, you can create your 
own custom fills.

To create a custom fill
1. Draw the pattern you want to use to fill the object.
2. Create a bitmap of the objects. See Creating bitmaps from objects.
3. Select the object you want to fill.
4. Open the Bitmap Gallery and double-click on the new bitmap to apply it as a bitmap fill (see Applying bitmap fills).

Tip
You can create a variety of pattern fills using three and four color fills, see Creating simple fill patterns.



Creating custom mold shapes

You can create your own perspective mold and envelope mold shapes rather than being limited to those on the Mold Tool Infobar.
To create a custom mold shape

1. Draw the four-sided shape you want to use as a mold template using the Shape Editor Tool or the Pen Tool.
2. From the Edit menu, choose Copy (CTRL+C). This copies the shape to the clipboard.
3. Select the objects you want to mold.
4. Choose the Mold Tool.
5. Click the Paste Envelope button or the Paste Perspective button to apply the shape on the clipboard as a mold.

Tips
If you are creating a perspective mold, all four sides must be straight lines.
Envelope molds have four sides which can be straight or curved.

_______________
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Creating custom print marks

Xara X provides you with a wide range of printer marks. However you may want to add extra marks to particular jobs. These extra 
marks might be fold marks or instructions to the print shop. You can place such information in the bleed area around the outside of 
the page. Everything in the bleed area is printed by Xara X but trimmed off by the print shop after printing. Note that anything 
outside the bleed area is not printed by Xara X.

To create custom printers marks
1. From the Utilities Menu, choose Options.
2. Click the Page tab.
3. Select the bleed option and enter a value for the bleed size to allow more space to insert the print marks.
4. You can now draw the required printers marks on the bleed area.

Note
If you want the new marks to appear on all separations, right-click on the object to open the pop-up menu and choose 

Print on All Plates from the Imagesetting submenu.

_______________
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Creating custom transparencies

You can make any object transparent with the transparency being set by a bitmap. As you can create bitmaps of any objects in 
your document, you can create your own custom transparency. The bitmap should contain white areas for one level of 
transparency and black for the opposite extreme. In the example here, the bitmap transparency is made from a blend producing 
the effect of blurred holes.

To create a custom transparency
1. Draw the black and white image you want to use as transparency. Blends are very useful for this.
2. Create a bitmap of the black and white image. See Creating bitmaps from objects.
3. Select the object you want to make transparent.
4. Open the Bitmap Gallery, click on the new bitmap and click the Transp button (for more details, see Applying bitmap 

transparency).
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Creating frames

Animated GIF files are made up of a series of individual frames (like movie film). You can create more frames to build more 
complex animated GIF files.

Note that you can only create frames in Animation Documents, not Drawing Documents - see Drawing and Animation Documents 
for more details.

To create a frame
1. From the Utilities menu, choose Frame Gallery.
2. Click the New button in the gallery.

Tips
The new frame become the last frame in the animation and is shown at the top of the Frame Gallery. It is also highlighted 

to show it is the current frame. All objects are created in the current frame.
You can also click the New Frame button on the Animation Control Bar.

_______________
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Creating guidelines

You can create guidelines using the rulers or accurately, the Layer Gallery. 
Creating guidelines using the rulers

either:
drag from the ruler onto the editing window. For example to create a vertical guideline, drag from the left-hand ruler.
or double click on the ruler to create a guideline aligned at the click point. For example, to create a vertical guideline, 

double-click on the top ruler.
Create guidelines using the Layer Gallery

Note that the Layer Gallery is not available in Animation Documents - see Drawing and Animation Documents for more details.
1. Right-click on the guides layer in the Layer Gallery to open the layer pop-up menu.
2. Choose Properties to open the Layer Properties dialog box.
3. Open the Guides tab.
4. Select Horizontal or Vertical.
5. Click New.
6. Type in the required position for the new guideline.

Tips
After creating guidelines you can prevent them being accidentally moved. To do this, use the Layer Gallery to turn off the 

Editable setting for the guides layer. See Hiding Layers.
You can turn the rulers on and off using Rulers on the Window menu.

_______________
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Creating layers

Many document will only use one layer but you can easily create new layers if you need them. Note that you can only create layers 
in Drawing Documents, not Animation Documents - see Drawing and Animation Documents for more details.

To create a layer
1. From the Utilities menu, choose Layer Gallery.
2. Click the New button in the gallery.
3. Type a name for the new layer. (See Note.)

Note
Layers MouseOff, MouseOver, MouseDown, Selected and BackBar are used by the Button & NavBar Tool. We do not 

recommend creating layers with these names as this could affect bar creation. For more information on bar creation see Creating 
Navigation Bars.

Tips
The new layer is always the top layer, in front of the other layers. It is also highlighted to show it is the current layer. All 

objects are created in the current layer. 
The guides layer is automatically created when you create a guideline. If you want to create it manually, right-click in the 

Layer Gallery and choose Create Guides Layer.
To quickly create a new layer, right-click on the Layer Gallery to open the pop-up menu and choose New Layer.

_______________
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Creating multi-stage blends

Xara X lets you create blends using as many objects as you like.

To create a multi-stage blend
1. Choose the Blend Tool.
2. Create a blend from the first object to the second (see Blending objects).
3. Drag from the blend to the third object.

This creates a multi-stage blend between the three objects.

Tips
The multi-stage blend always runs from the second object to the third. (The first object is where you started dragging 

from.) If the multi-stage blend is not correct, remove the blends and retry. See Removing a blend.
You are not limited to three objects in a multi-stage blend. You can continue to blend to further objects.
You can blend two blends together. This is called a two-way blend. See Creating two-way blends for more details. 
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Creating multi-stage fills

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

To create a multi-stage fill

See Applying fills for details of creating a suitable fill.
1. Select the object (see Selecting objects).
2. Choose the Fill Tool - this displays the Fill arrow.
3. Drag-and-drop colors from the Color Line or Color Gallery onto the Fill arrow (see Notes.) This creates new color handles.

Notes:
Conical fills have a semicircular Fill arrow. Other fill types have straight Fill arrows. Always drag-and-drop colors onto the 

arrow.
To change the start or end colors, see Changing the colors in fills.
You can also double-click on the Fill arrow to create a new color handle. then either select a color in the Color Line, Color 

Gallery or Color Editor.
Elliptical and Diamond fills have a pair of Fill arrows. You can apply colors to only one of these arrows. (The arrow that 

was horizontal when you created the fill - this is the "primary" arrow.)
The Selector Tool can also display the Fill arrow. See Enabling fill handles.
You can also create multicolored fills by using rainbow and alt-rainbow effects from the Fill Tool Infobar.

Movies

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills
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Creating named colors

Named colors appear on the Color Line and in the Color Gallery. You can easily apply them to objects by clicking or by dragging. 
Xara X provides a wide range of standard colors but these might not be exactly right for some drawings. In this case, you can 
easily create new named colors.

To create a named color
1. From the Utilities menu, choose Color Gallery.
2. In the Color Gallery select an existing color that is similar to the color you want to create.
3. Click New. 
4. Enter a name for the color.
5. If you want the new color to be a shade (see shade color) of the color, select Make color a shade of.
          If you want the new color to just be a copy of the color, deselect Make color a shade of.
6. Click Create. The new named color appears on the Color Line and in the Color Gallery. 

The color is also displayed in the Color Editor so you can edit it as required. See Changing named colors.

Tips
Named colors are very useful when creating drawings that use many shades of a few basic colors (the parent colors). 

Changing the parent color changes all shades of that parent.
If you want to create a named color using the color of an existing object, see Creating named colors from objects.
The Color Gallery already includes the 216 colors that match those in Microsoft Explorer and Netscape Navigator. These 

colors give the best results. If you create your own colors, they are displayed with dithering and so do not look as good. For this 
reason we suggest you do not create extra colors. See Internet bitmaps overview.

If you want to create a PANTONE® color in your document, just drag it from either of the PANTONE® sections in the 
Color Gallery into the section for your document.

Movie

{button ,EF("XaraDemo.exe","EditCol Defining Your Own Colors",1,`') } Creating your own colors
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Creating named colors from objects

If you have an object in your document which is filled with a color, you can create a named color using that color.
To create a named color from an object

1. Select the object filled with the required color (see Selecting objects).
2. From the Utilities menu, choose Color Editor.
3. In the Color Editor, click the New Named Color button to open the New Named Color dialog box.
4. Deselect Make color a shade of. (You do not want to create a shade color.)
5. Enter a name for the new color.
6. Click Create. The new named color appears on the Color Line and in the Color Gallery. 

The color is also displayed in the Color Editor so you can edit it as required. See Changing named colors.

Tip
If you want to change your new named color, just drag it onto the Color Editor.
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Creating new control bars

You can customize Xara X by creating new control bars.
To create a new control bar

1. From the Window menu, choose Control Bars.
2. In the dialog box, click the New button.
3. Enter the name for the new control bar.

This creates a new, floating control bar. You can now move or copy buttons onto the new control bar and then drag it to the edge of 
the Xara X window to make it a docked control bar. For more details, see Moving and resizing control bars and Moving and 
copying buttons.

To restore the factory settings
1. From the Window menu, choose Control Bars.
2. In the dialog box, click Reset.

This resets all the control bar settings to how they were when you installed the software. It moves buttons back to their original 
positions, removes buttons you have added and moves all the bars to their original positions.

Movie

{button ,EF("XaraDemo.exe","MakeBars Creating Control Bars",1,`') } Creating new control bars
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Creating new default brushes

Brushes are either:
used only in the current document
or (the default brushes) available to all documents.

This page describes creating new default brushes.
To create new default brushes

1. Start a new document - more details.
2. Create the new brushes. You can either create them by drawing new objects or by modifying existing brushes.
3. For each brush, draw a line and apply the brush to the line. (Xara X does not save unused brushes - applying a brush to a line 

ensures it is used.)
4. When you have completed your brushes, save the document to the Brushes folder. To find this, locate the Xara X program 

(Xarax.exe). In the same folder as Xarax.exe is the Templates folder. Brushes is in the Templates folder.

Next time you load Xara X you will see your new default brushes. In the Line Gallery will be a new section with the name of the 
document. In the Freehand & Brush Tool your new brushes appear at the end of the brush list.

Tips
If, in the future, you want to add more brushes, you can edit this document in the regular way.
The Brushes folder already contains several documents, which contain the default brushes. You can also edit these 

documents to add or delete brushes.
Each document in the Brushes folder appears as a separate section in the Line Gallery.

_______________
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Creating new documents

This opens a blank document ready for you to start a new drawing. Xara X has two types of document:
drawing documents which are suitable for most types of drawing,
and animation documents which are suitable for created animated GIFs. 
To create a drawing document:
From the File menu, choose New. (Or choose one of your custom Drawing templates.)
To create an animation document:
From the New submenu on the File menu, choose Animation. (Or choose one of your custom Animation templates.) 
Note that this menu item shows a different file name if you have created your own default animation template.

Tip
New documents are based on template documents. The New submenu contains the default templates and any you have 

created.
You can change the default templates or create your own. See Creating a template document for details.



Creating new text

You can create text objects in many different ways. Simple text objects are very basic, each line is created by pressing RETURN. 
Column text is fully word-wrapped to form a column, or paragraph, of text. You can also type directly onto lines and shapes to 
create text that bends around a curve.

What do you want to do?
Create simple text
Create column text
Type text onto a line or shape
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Creating a rollover button state

Rollovers are multi-state buttons used in navigation bars on web pages. In Xara X, you can use the Button & NavBar Tool to create 
navigation bars and rollover buttons.

To create a rollover button state:

The MouseOff button is created when you create the navigation bar. See Creating Navigation Bars for details. To create the other 
states:
1. Open the NavBar Edit States dialog box by clicking either Create/Delete States on the NavBar Tool Infobar.
2. From the list on the left, select the state you want to create.
3. The new buttons are based on the MouseOff button. New state looks distinct automatically chooses shades of the MouseOff 

button colors (see Note). Otherwise the new button is identical to the MouseOff button. In either case you can later edit the new 
button as required.

4. Click Create. This creates a new buttons in a layer of the same name (layer MouseOver for MouseOver). 

Note:
New state looks distinct may have no effect if the MouseOff button design is a bitmap or uses a bitmap fill. Xara X 

cannot automatically alter the colors in bitmaps.

Movies

{button ,EF("XaraDemo.exe",`Rollover Creating JavaScript Rollovers',1,`') } Creating JavaScript rollovers
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Creating Shade Colors

Shade colors are based on a parent color and can be lighter or darker than their parent. They have many uses and are very easy 
to create in Xara X.

To create a shade color
1. From the Utilities menu choose Color Editor.
2. Click New Named Color in the Color Editor to open the New Named Color dialog box.
3. Select the Make color a shade of button.
4. Select the parent for the shade from the drop-down list.
5. Enter a name for the color.
6. Click Create to create the shade
7. You can then edit the color in the Color Editor. You can only alter the Saturation and Value - the Hue is fixed by the parent color. 

For more information, see Color Editor - Shade Colors.

Tips
The parent color is shown in the Color Editor as a small white X.
It is recommended that the parent color is a bright, pure color. That is, that the X in the color editor is in the top left-hand 

corner. This means all shades will be selected as lighter or darker variations of the parent's pure color. This ensures that if you 
change the lightness or darkness of the parent, all the linked shades change by the correct relative amount.

_______________

Related Topics

Named colors
Color Editor



Creating shapes with holes

To draw a shape containing holes you draw the shape and draw the outline of the hole and 'join' the shapes together.
To create shapes with holes

1. Draw the outline of your shape. See Drawing shapes.
2. Draw a shape for the outline of the hole.
3. Select both shapes. See Selecting objects.
4. From the Arrange Menu, choose Join Shapes.

Movie

{button ,EF("XaraDemo.exe","JoinBrk Joining and Breaking Lines and Shapes",1,`') } Joining and breaking shapes

Tips
You can also create shapes with holes using Slice Shapes and Subtract Shapes. See Slicing shapes and Subtracting 

shapes.
Once you have drawn a shape with holes, you can join it to more shapes to add more holes.
To separate the shapes again, use Break Shapes on the Arrange menu.



Creating simple pattern fills

Using three color fills and four color fills, you can create a variety of pattern fills. Experiment to create the effect you want!
To create a hexagonal fill pattern

1. Apply a three color fill to an object.
2. Apply one color to two handles and a second color to the third handle.
3. SHIFT-drag the arrow end of one of the fill arrows to lock the angle between the handles to 60 degrees.
4. Set the tiling to Repeating on the Fill Tool Infobar.

To create a spotted fill pattern

1. Apply a four color fill to an object.
2. Apply one color to one corner and another color to the other three corners. You can also use one color for two opposite corners 

and another color for the other two.
3. SHIFT-drag the arrow end of one of the fill arrows to force the angle between the arrows to 90 degrees.
4. Set the tiling to Repeating on the Infobar.

To create a striped fill pattern

1. Apply a four color fill to an object.
2. Apply one color to two adjacent corners and another color to the other two corners.
4. Set the tiling to Repeating on the Infobar.

_______________
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Creating simple text

Simple text objects are the best way to do headings, labels and other small areas of text. You can set the attributes of the text 
before you type the text (by applying them to the text cursor) or afterwards.

To create a simple text object
1. Choose the Text Tool.
2. Position the pointer where you want to start the text and click - a red text cursor appears.
3. Set any attributes you want the text to have. For example, color, font, font size.
4. Type the required text, pressing RETURN to create new lines if necessary.

Movie

{button ,EF("XaraDemo.exe","Text Entering Text",1,`') } Entering text
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Creating small XAR and WEB files

The XAR and WEB file formats have been designed to be very compact. If you know some of the mechanisms used to make the 
formats compact, you can create complex, colorful, high quality illustrations that are a fraction, perhaps just a tenth, of the size of 
an equivalent GIF or JPEG. And remember that a file the tenth the size, means your viewers can access your Web pages ten 
times faster!

The basic rule is that the more shapes and more complexity in the illustration, the larger the file. Using bitmaps is bad news 
because they are saved as GIF or JPEG images in the XAR or WEB file. This removes the advantages of the compact format. 
(Although you can do things with these bitmaps, like make them semi-transparent, that you cannot do with plain JPEG and GIFs.) 
The file is made up from the vector descriptions (at 72,000 dpi) of all the points in the lines or outlines of the objects. Therefore the 
more objects you have, or the more complex those shapes are (the more points on the line), the larger the file becomes.

Points to keep XAR or WEB files small
Keep the number of different shapes to a minimum.
Keep the number of points on shapes to a minimum.
Use fractal fills, and graduated fills and overlaid transparency fills to create complex shading. These all use practically no 

file space.
Use blends. Xara X uses zero-memory blends meaning all the in-between steps in the blend require no file space! 

Therefore complex shading or highlights can be done very efficiently this way. Also any repeating pattern can be done with blends.
Use duplicated, cloned or copied shapes - WEB and XAR files identify identical shapes used in the drawing and eliminate 

all the data for the copies. Xara X then reconstructs these shapes when displaying the image. Therefore liberal use of cut, copy, 
paste to create your drawing is a good thing.

Text. Use the typical system fonts that are likely to be available on the viewer machine. This means mainly Times and 
Arial (Helvetica) because these two are almost guaranteed to be available on the computer viewing the image. You can transform, 
stretch, rotate, skew, color the text or even give it thick outlines and graduated colors etc. This takes very little file space but still 
gives you a huge variety of stylistic options.

If you do use bitmaps, always save the document in WEB format as this has the option to JPEG compress any bitmaps in the 
document. Bitmap sizes can often dramatically increase the file size of XAR and WEB files if you're not careful. When viewing 
images at normal size on the computer screen, it is never necessary to have bitmaps of more than 96 dpi (the resolution of the 
screen). Often it's quite acceptable to use bitmaps of a much lower resolution . Reducing the resolution of bitmaps in your 
illustrations and then saving as WEB files with JPEG compression, makes vast savings on file size. (See Reducing the resolution 
of bitmaps and bitmap fills for information on reducing the bitmap resolution of a bitmap using Xara X's built-in facilities.)

Other points to watch

Text other than Arial, Courier or Times (or the bold and italic versions) should be converted to outlines before saving to be sure that 
another font is not substituted. When exporting as WEB format, there is a switch on the Export dialog that converts all other fonts 
to outlines. When the viewer or plug-in can't find the equivalent font, it intelligently substitutes the closest available font using the 
PANOSE font matching system.

The physical size of the drawing does not matter. A major advantage of vector formats is that an illustration occupying a large full 
screen window takes no longer to download than the same image displayed as only a few pixels across in the corner of the 
window. This completely unburdens the designer from the size constraints that restrict GIF and JPEG graphics.

If you do not want to lose detail in your bitmaps, you can use XAR file and include the bitmap at any required resolution you like. 
By creating a XAR files containing only a JPEG, you can zoom into any region using the Xara plug-in, something that you don't 
normally get with plain JPEGs. And it will not take any more file space. An alternative is to export as WEB format and switch the 
JPEG Compress bitmaps option off. This will PNG compress them instead which is a distortion-free but less efficient 
compression mechanism.

_______________
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Creating spot colors

Spot colors are a special type of named color used in work that will be litho-printed. Spot colors always have names. Spot colors 
are used in work that will be color separated for commercial printing (see Printing multiple copies). 

To create a new spot color
1. Create a new named color (see Creating named colors).
2. If necessary, click the Show Advanced Options button to display all the options on the Color Editor (see Color Editor - 

Advanced).
3. Choose Spot Color from the Color Type menu.

To convert an existing color to a spot color
1. From the Utilities menu choose Color Editor.
2. From the Color List menu choose the color you want to convert.
3. If necessary, click the Show Advanced Options button to display all the options on the Color Editor (see Color Editor - 

Advanced).
4. Choose Spot Color from the Color Type menu.

Tips
Not all printing processes can handle spot colors. Also some printing presses have a maximum number of ink colors they 

can print. Always check with your print shop before using spot colors.
There are some points you should note when using spot colors, especially for simple two and three color jobs. See 

Printing: Imagesetting Points to Note for more details.
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Creating template sets

Template sets appear in the Web themes section of the Clipart Gallery. This page describes how to produce template sets. You 
would normally do this for templates sets you want to distribution to other people but you may find it useful for sets created for your 
own use. Look in Web themes to see example template sets.

Creating a template set
1. We suggest creating a single document containing all the elements. (For example a horizontal divider, heading, button bar.) 

Save this in case you need to make edits in the future (for example by changing the basic colors).
2. Create a folder named after the theme on your computer. 
3. Save each part of the template as a separate file in this folder. Call the files Horizontal Bar, Vertical Bar, Heading, Paragraph, 

Logo, Letter, Horizontal divider, Vertical divider, and so on.

It is often better to mark up with the live stretching turned off. Turn it back on to test the button. This way you know when 
everything is in the right place and nothing will extend while you move and edit the button in creation.

Tips
Remove groups from text as ascenders and descenders in grouped text can cause the button to extend when you don't 

want it to.
Don't use molds as these don't stretch.
Avoid blended smart shapes - this can give unexpected results.
Don't just pick the default bar settings. If the item is a title or paragraph heading then pick Buttons are all 'independent 

sizes' as this is faster than 'all the same size'.
If a button has jagged edges or ovals then scaling may be better than extending. Try expanding it with both types - which 

looks best?. If you pick one of these options you can adjust it to not extend in one direction or extend one way and scale the other 
by using the Name Gallery after you have used the Bar Tool to create the button.

Remove unused layers. They may be background layers in the wrong place or imported layers.
Is the drawing overly complex? This slows down rendering and extending. Simplify if required, particularly if the shape 

isn't visible or is hidden by another shape.
Use the Button & NavBar Tool to create extending headings and paragraph headings. Rename these named items from 

"Button1" to "Heading" and the like in the Name Gallery so you can use the Name Gallery to identify objects.
Does the button has an "indicator" on it (like a blob to the left) that you don't want to extend, but you do want to move and 

remain in its relative location. Then make this item a group and remove all other groups from this button. When creating the button 
bar tick the option of Groups to not stretch.

Save after each button is complete and works - this saves tears something goes wrong later.
Are Named colors used in the document (recommended for easy editing later). Are they well named?
Dark shadows on buttons may overlap and give dark marks down the edge. Blurring the shadow more removes this.



Creating the guides layer

The guides layer is created automatically when you create a guideline using the rulers (see Creating guidelines). If you wish to 
create objects in the guides layer or move existing objects to the guides layer, you must create it manually. You can only have one 
guides layer. 

Note that you can only create layers in Drawing Documents, not Animation Documents - see Drawing and Animation Documents 
for more details.

To create the guides layer
1. From the Utilities menu, choose Layer Gallery.
2. Right-click on the Layer Gallery to open the pop-up menu.
3. Choose Create Guides Layer.

Tips
To place objects in the guides layer, click on the guides layer in the Layer Gallery (to make it the current layer) and create 

the objects as normal. For further details on creating guide objects, see Moving objects to the guides layer.
Guidelines and guide objects are non-printing.
Objects on the guides layer have red, dotted outlines. You can change the outline color. For more details, see Changing 

the color of guides.
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Creating two-way blends

Blending between two blends normally creates a multistage blend. However, by turning each of the blends into a group, you can 
create two-ways blends as shown.

To create a two way blend
1. Create two normal blends between two sets of objects (see Blending objects).
2. Select one of the blends (see Selecting objects).
3. From the Arrange menu, choose Group. This creates a group containing a single blend.
4. Do the same with the second blend.
5. Blend between the two groups.

Tip
You can use select inside (see Selecting objects in objects) to access either grouped blend object and change it as a 

blend (for example number of steps, etc.).

Movie

{button ,EF("XaraDemo.exe","BlendFun Advanced Blending",1,`') } Blending objects - Advanced

_______________

{button ,KL(`blends',0,`____No_Topics_Found',`')}    Related Topics



Customization Overview

You are using a highly customizable program. Below are the areas you can configure to your own needs.

Control Bars, Buttons and Galleries
Setting the size of buttons
Moving and copying buttons
Removing and restoring buttons
Spacing buttons on control bars
Creating new control bars
Deleting control bars
Moving and resizing control bars

Window Customization
Customizing the appearance of the program
Hiding the Status Line
Hiding the Color Line
Hiding the scrollbars
Moving colors on the Color Line

Program and Document Options
Changing the default (template) document

There are a large number of customization options in the Options dialog box. Go to the Utilities menu and choose Options. You 
can press the Help button for more details.



Customizing the appearance of the program

You can customize the appearance of your desktop and the programs you use in a variety of ways. You can change the size and 
color of ToolTips, caption buttons (the buttons on the title bar), the active title bar, inactive title bar, menu items, gallery title bars, 
selected menu items, scrollbars and the Status Line. These settings apply to all the programs you use that support this feature.

To change a setting
1. From the Settings submenu on the Start Menu, choose Control Panel.
2. Double-click Display in the Control Panel.
3. Click the Appearance tab.
4. Choose an individual setting from the drop-down list or choose a scheme.

For more information on changing the appearance of your desktop, see your Windows user guide. If you need help using the 
Appearance tab, click the '?' in the title bar and click on something in the dialog box to find out what it does.

Tips
The size of Gallery title bars is set using the Palette Title setting.
 The size of the Status Line is set using the ToolTips settings.

_______________

{button ,KL(`color line,resizing',0,`____No_Topics_Found',`')}    Related Topics



 Cut (Edit Menu)    CTRL+X or CTRL+DELETE

Cuts the currently selected objects to the clipboard. The selected objects are removed from the document. Note that you can use 
get the objects back in the same place (or use CTRL-SHIFT-V to paste the objects back in the same place). Once the objects are 
on the clipboard they can be pasted back into the document any number of times, pasted into other documents or into other 
applications. Copy is the same as Cut, but copies the objects to the clipboard leaving the selection in the document

Tip
To cut an object to the clipboard quickly, right-click on the object to open the pop-up menu and choose Cut.

_______________

Related Topics

Cutting objects to the clipboard
Pasting



Cutting and copying objects to the clipboard

You can use the clipboard to move objects within a Xara X document and between documents. You can also use it to move and 
copy objects into documents in other programs.

To cut and copy objects to the clipboard
1. Select the objects you want to put on the clipboard. (See Selecting objects).
2. From the Edit menu, choose either Cut (CTRL+X) or Copy (CTRL+C).
You can now click in another document and press CTRL+V to paste the objects. For example you could click in a Microsoft Word 

document and place the selected objects in it.

Tips
You can also Cut or Copy by right-clicking on the objects and then choosing Cut or Copy from the pop-up menu.
Cut removes the objects from the document and places them on the clipboard. Copy leaves the original objects in your 

document.

_______________

Related Topics

Pasting



Cycling which points are selected

If you have one or more point handles on a line or shape selected, you can 'cycle' which points are selected.
To cycle which points are selected

1. Select the line or shape. (See Selecting objects).
2. Choose the Shape Editor Tool.
3. Press the Tab key to 'move' the selection along the line or shape. (SHIFT-Tab 'moves' the selection in the opposite direction.) 

The Home and End keys work in a similar way with lines, but 'move' the selection to the beginning and end of the line.

Tip
Selected point handles are shown as red squares, unselected point handles as black squares.

_______________

{button ,KL(`tools,shape editor tool',0,`____No_Topics_Found',`')}    Related Topics



DCX Export Dialog Box

The DCX (multi-page PCX) export bitmap dialog box is opened by selecting DCX as the exported file format from the Export dialog 
box. With it you can set of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the 
bitmap. For details of how to create a DCX file, see Creating DCX files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



De-installing fonts

The Font Gallery provides you with an easy way of de-installing (removing) fonts from your computer.
To De-install fonts

1. From the Utilities menu, choose Font Gallery.
2. Find and select the required font in the Installed Fonts section of the gallery (see Selecting items in a gallery).
3. Click the De-install button in the gallery.

Notes
You can only de-install fonts from the Installed Fonts section of the Gallery.
Some programs continue to show a de-installed font in their font list until you quit and then reload them.

_______________

{button ,KL(`font gallery,overview;fonts',0,`____No_Topics_Found',`')}    Related Topics



Default Page Background

This command sets the page background back to white. This command is on the View pop-up menu - right-click on the page.

_______________

{button ,KL(`background',0,`____No_Topics_Found',`')}    Related Topics



Define Buttons Dialog Box

Dummy for Simon's testing.



ATM (Adobe Type Manager) fonts are PostScript fonts. ATM is a software component available from Adobe which allows the 
PostScript fonts to be rendered on screen and hence allows matching of PostScript printer fonts and screen fonts. Xara X also 
supports TrueType fonts which are supported as standard by Windows.



Alignment is the horizontal and vertical relationship of several objects to each other. For example, objects can be aligned so that 
their top-most edges all line up and they are distributed evenly horizontally. For details on how to change the alignment and 
distribution of objects, see Aligning and distributing objects.



Alpha-channel: some bitmap formats can have transparent areas in them. (For example, the background might be transparent.) 
There are two types of bitmap transparency: 

simple on-off transparency. This is the only type of transparency available in GIF bitmaps and in PNG bitmaps up to 256 
colors.

"alpha-channel" or graduated transparency. This is variable between fully transparent and fully opaque. (Similar to the 
Xara X's transparency effects.)    Alpha-channel is available for PNG true-color and TIFF bitmaps.

Xara X can import and export both simple and alpha-channel transparency.



Xara X can export animated GIF files which contain several separate images rather than just one. Programs which support this 
type of file show each image one after the other with a set time delay between each. This means you can create animations using 
Xara X. Most browsers (Netscape Navigator Version 2 and Microsoft Internet Explorer 3) support animated GIFs, so using Xara X 
it is very easy to create animations for your Internet pages. Remember, as Xara X displays images at a very high quality and has a 
wide range of dithering and palette options, your animations will look great! For more details, see Creating animated GIF files.



Xara X has two types of document: Drawing and Animated. Animated documents are designed for creating Animated GIFs. 
Animated documents cannot contain layers. You cannot create Buttons and Bars using Animated documents (as these require 
layers).



Anti-aliasing improves the quality of on-screen images by inserting extra pixels of calculated colors around the edges of objects 
on screen. This has the effect of smoothing the edges and of appearing to improve the resolution of the display. Anti-aliasing only 
occurs when the Xara X Quality setting is at its highest level. For more details, see Changing the screen quality of documents.

  



The Application Control Menu is displayed by clicking the application control button at the top left of the main Xara X window or 
pressing ALT+SPACEBAR. This menu contains application specific controls. For example Exit and Maximize.



Apply Inside allows you to apply attributes to objects that are contained inside other objects. To apply inside, hold down CTRL 
when you drop the attribute onto the object. For example to apply a color to an object in a group (not the whole group) CTRL-drag 
the color from the Color Line onto the object. For more details, see Selecting objects in objects.



ArtWorks is a vector drawing software package developed by Computer Concepts Ltd in the UK. ArtWorks runs on Acorn RISC 
machines.



The aspect ratio of an object is the ratio between its width and the height. For example, if an object has an aspect ratio of 100%, 
its width and height are the same. If an object has an aspect ratio of 50%, it is twice as high as it is wide. See Scaling objects or 
Changing the aspect ratio of text.



Attributes are the properties of objects in your drawings. For example, color and line thickness are both attributes. For more 
information, see the Attributes Overview.



When the Background Redraw option is selected (see Turning background redraw on and off), Xara X renders documents in 
background mode. In background mode the drawing is rendered in time slices and the results of this made visible in the window 
about every half second. The advantage of using background redraw is that you can continue to edit the drawing whilst it is being 
redrawn, but it is a little slower than normal redraw.



Bevels give objects an appearance of depth instead of being flat on the page. This is done by giving the objects a shaped edge 
and then applying lighting effects. For more details, see the Bevel Tool Overview.



Beveled Join is one of the options available for line and shape corners, contours and bevels. For more details, see Changing join 
style.



A Bitmap is a picture composed, of small 'dots' called pixels. Bitmaps are exported from programs such as Microsoft Paintbrush, 
CorelPaint and Photoshop or taken from scanners or a PhotoCD. Xara X can import and export all common bitmap formats. For 
more information, see the Bitmaps Overview.



A Bitmap Fill allows you to fill shapes with a bitmap. The bitmap can be tiled (repeated) to fill objects. For more information, see 
the Fills Overview.



The Bitmap Tracer produces a set of shapes that look like a bitmap. It examines a bitmap and tries to determine the shapes that 
best approximate the areas of color in the bitmap. The bitmap tracer has options to control the minimum size of the shapes, how 
many different color levels it should try to find and others. For more information, see Tracing bitmaps.



Bitmap Transparency is a type of transparency where the degree of transparency of the objects it is applied to is set by a bitmap. 
Usually, the lighter colors in the bitmap are the more transparent (You can alter the amount of transparency by selecting one of the 
Transparency handles and then dragging the Transparency slider). Bitmap transparency is particularly useful for semi-transparent 
patterning. For more information, see the Transparency Overview.



Bleach is a transparency type in the Transparency Tool. Bleach has no clear analogy in the physical world. It is useful for 
highlights when the light source is not white.

The color of the object with Bleach applied:
Gray & White - lightens the colors in underlying objects.
Black - no effect on the colors of underlying objects.
Other colors - lighten underlying colors towards unsaturated color. (Light-red over light-red gives a pale-red: green over 

red gives yellow.) If you want to use a colored object to lighten but not color-shift underlying colors, you may find Lighten 
transparency type easier to use.

Technically the process is additive in RGB color space.



Blend is a compound object made by progressively changing one object into another. A blend object consists of two or more 
objects, between which are a number of intermediate steps in the change from one end object to the other. You can control the 
number of intermediate steps. In Xara X the in-between steps are created as they are needed - they do not take up memory space 
in the document. For more details on using blends, see the Blends Overview.

Blends can be used to create complex highlights, blurred edges on objects, repetitive patterns and many other effects. In many 
ways a blend behaves like a group as it can be moved and copied like a group and you can use select-inside to select the end 
objects and edit them while they are inside the blend.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Blend Tool, the 
Infobar looks like this:



The Blur (Bitmap Effect) process is the the opposite of Sharpen. It makes the boundaries between colors in a bitmap less 
obvious. This is useful in reducing noise and patterning. There are three settings for Blur. They are Low, Medium and High - the 
value can then be set more accurately using the slider in the dialog box. For more details, see Applying special effects to bitmaps.



The Bounding Box of an object or selected set of objects is an imaginary box enclosing the whole object.



If you draw a QuickShape using bounds creation, the box you create by dragging the mouse sets the size of the shape.



Brightness is a transparency type in the Transparency Tool. Depending on the color chosen, it makes the colors of underlying 
objects lighter or darker.

The color of the object with Brightness applied:
Gray (below a 50% tint of black) & White - makes the colors of underlying objects lighter. White has maximum effect
Gray (above a 50% tint of black) & Black - makes the colors of underlying objects darker. Black has maximum effect.
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then lighten or 

darken the colors of underlying objects.



Bromide is another name for the photographic paper used in imagesetting.



The Browser Palette is the palette used by web browsers to show images on the screen in 256 color modes. If you create 
bitmaps using this palette, they will not be dithered by the browser when it displays them. If you only use web browser colors 
(using Browser Palette in the Color Editor or the colors in the Web Browser section of the Color Gallery) and export a bitmap 
using the browser palette, all flat areas of color will be displayed in 256 color modes without being dithered.



In Xara X you are not limited to plain lines. You can also use patterns or effect such as air-brush. Xara X refers to these as 
"brushes". The Freehand & Brush Tool and Line Gallery include a range of predefined brushes or you can create your own from 
Xara X objects. A brush could a simple colored circle or a complex shape made up of several objects.



Butt Caps are a type of ending which can be applied to lines. There are three types of 'cap'. For more details, see Changing line 
ends.

Butt Cap                      Round Cap                Square Cap



The Button Palette is a special control bar in Xara X which contains a copy of every button in the program. When a new, blank 
control bar is created you can ALT-drag buttons from the button palette onto the new control bar. You cannot delete the button 
palette nor the buttons on it.



The CMYK (Cyan, Magenta, Yellow and Key (black) ) color model is used by commercial printers. CMY and K are the four inks 
used in full color printing. The Key color is used to reinforce dark colors which would appear 'muddy' if printed using only C, M and 
Y. If the Key is set to 100%, the color will appear black irrespective of the settings of C, M and Y. CMYK colors are stored in 32-bit 
format. They are printed (and output in EPS) in CMYK format unless the document uses transparency or shadows when they are 
converted to RGB.



A Circular Fill consists of color graduating in a radial fashion. For more information, see the Fills Overview.



Circular Transparency graduates from one transparency to another in a radial fashion. The two transparency handles on either 
end of the transparency arrow represent the radius of the transparency. The outer handle can be used to change the outer 
transparency and alter the size of the circle, the inner one to move the circle and alter the center transparency level. For more 
information, see the Transparency Overview.



The Clipboard is a temporary store and is used like a physical clipboard. You can cut or copy part or all of your drawing onto the 
clipboard. You can then transfer the clipboard contents to another part of the document or even a completely different document or 
application. The clipboard can only hold one item or set of items at a time. Placing something on it overwrites any existing 
contents. Objects remain on the clipboard until deleted or overwritten by Xara X or another application. The contents of the 
clipboard are lost when you shut down your computer.



Color Models define the way in which a color is defined. In Xara X you can define colors using these models:
RGB (Red-Green-Blue). Most often used by video cards to define colors.
CMYK (Cyan-Magenta-Yellow-Key). Favored by commercial printers. Cyan, Magenta, Yellow and Key (Black) are the 

colors of the inks used.
HSV (Hue-Saturation-Value). The "artists" method of defining colors. Hue is the pure pigment of the color, Saturation is 

the amount of white mixed into the color and Value is the amount of Black mixed into the color. Hue is measured in degrees 
representing the angle around a color wheel that sweeps from Red through Yellow, Green, Cyan, Blue, Magenta and back to Red 
again.

Gray scale defines colors as Black, White or shades of Gray.



Compound Objects are objects in a document which contains other objects. The following are compound object types:
Group Contains one or more objects of any type
Blend Contains two or more objects of any type
Text Object Contains one or more Text Lines
Text Line Contains one or more characters



A Conical Fill fill consists of graduated color swept around a central point to form a cone. It starts at the first color, reaches the 
second half way around the circle and returns to the original color at the start position. For more information, see the Fills 
Overview.



A Conical Transparency consists of graduated transparency swept around a central point to form a cone. It starts at the first 
transparency, reaches the second half way around the circle and returns to the original level at the start position. For more 
information, see the Transparency Overview.



Contone is short for "continuous tone". The term Contone is most commonly used in relation to bitmaps. A bitmap is a contone 
bitmap when all of the colors used in it are varying mixtures of two colors. For instance, a grayscale bitmap is a contone bitmap 
because all the colors in it are a mixture of black and white. You can change the two colors of contone bitmap fills by selecting the 
fill handles and changing their color in the usual ways. You can give a bitmap an old-fashioned sepia look by setting one contone 
color to dark brown and the other to a yellow-creamy color. For more details, see Changing bitmap palettes.



Contour: a special effect created by adding evenly spaced concentric lines or rings inside or outside an object. Reshaping the 
object automatically reshapes the contour. You can also use contours to thicken or thin the outline of objects. For more details, see 
the Contour Tool Overview.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Contour Tool, the 
Infobar looks like this:



Contrast is a transparency type in the Transparency Tool.  Usually you would use it on a separate object to modify the color of 
underlaying objects (that is, you would use an object as a filter). Depending on the color chosen, it increases the contrast of 
underlying colors (make them brighter or duller).

The color of the object with Contrast applied:
Gray (below a 50% tint of black) & White - increase contrast (compress the color range) to make the underlying colors 

brighter.
Gray (above a 50% tint of black) & Black - make underlying colors duller (towards gray).
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then increase or 

decrease the contrast of underlying objects.



Control Bars are placed around the edges of the Xara X windows to make commonly used operations (in the form of buttons, 
sliders and edit boxes) more accessible. New Control Bars can be created and the size of the buttons on different bars altered. 
Control Bars can be free floating or docked (fixed) to the sides, top or bottom of the Xara X window. For more details, see the List 
of Default Control Bars.

  



CorelXARA is the old name for Xara X. It was developed by Xara and marketed by Corel.

You can import all CorelXARA files into Xara X. 

You can load Xara X files into CorelXARA 1.5 or 2.0. (CorelXARA ignores any new features in Xara X.) If you require files in 
CorelXARA 1.1 or 1.2 format, use the CorelXARA (pre-1.5) export option.



The Current Attributes are those attributes which get applied automatically to an object when it is created. For example, if the 
current line color attribute were red, the next object drawn would have a red outline. if you intend to draw many objects that are to 
share the same attributes, then it is useful to make these shared attributes Current Attributes. In Xara X, Text objects have their 
own separate set of Current Attributes. See Setting the current attributes for more details.



The Current Fill Attribute is the default setting for the fill attribute which is the type of fill that will be applied to newly created 
objects. To set the current fill attribute, apply a fill with no objects selected.



The Current Layer is that currently selected (highlighted) in the Layer Gallery. It is the layer into which all newly created objects 
are inserted. Some other packages use the term 'active layer'. See Setting the current layer.



Curve Handles are handles used on curved line segments to alter the curve shape. The curve handles for selected point handles 
are only shown if there is one selected point handle. The two curve handles for the selected point are shown plus the nearest 
curve handles for adjacent points.



Custom Bitmap Effects allow you to alter the brightness of each pixel in a bitmap depending on the brightness of adjacent pixels 
using a method known as convolution. The matrix on the right of the Bitmap Effects dialog box controls the process. Type values 
into the matrix such that the sum of all the values is 1. For more information see Applying special effects to bitmaps.

For example:

-2 -1 0

-1 1 1

0 1 2



Darken is a transparency type in the Transparency Tool. It is useful for making underlying objects darker. Usually you would use it 
on a separate object to modify the color of underlaying objects (that is, you would use an object as a filter). Darken is a grayscale 
version of Stained Glass transparency type.

The color of the object with Lighten applied:
White - no effect on the colors of underlying objects.
Gray & Black - darkens the colors of underlying objects.
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then darken the 

colors of underlying objects.



Dashing is a term used by CorelDRAW to describe patterns applied to lines and shape outlines. In Xara X these options are 
available using the Line Gallery. For more details, see Adding dash patterns to lines.



The Default Bitmap is always present in Xara X documents in the Bitmap Gallery. This default bitmap is the Xara logo in 
grayscale. You can use like any other bitmap except you cannot delete it.



If you draw a QuickShape using diameter creation, where you start the drag sets the position of one corner or edge and where 
you stop the drag sets the diameter (width) of the shape.



Diamond Fills consist of color graduating in a diamond-shaped fashion. It works in a similar way to an elliptical fill, but the pattern 
has four 'edges'. For more information, see the Fills Overview.



Diamond Transparency is a diamond-shapes graduation of transparency radiating outwards. You can move the transparency 
handles to stretch and squash the diamond to form a variety of transparency shapes. For more details, see the Transparency 
Overview.



Dilation (Bitmap Effect) widens light areas and narrows dark areas of bitmaps. Its main use is emphasizing edges after using 
Edge Detection or Isolate Points. For more details see Applying special effects to bitmaps.



Dithering is a technique where patterns are applied to areas of color in a bitmap in order to simulate a wider color range. It works 
very well in pictures which contain a large number of colors. If you use dithering when you create a bitmap, it will not compress as 
well and will probably create a larger file. Xara X offers three dithering options. For information on how to change the screen 
dithering, see Changing the screen dithering. Error-diffused dithering is a complex mathematical technique which, although slower, 
produces very high quality images.



A Docked control bar is one which is attached to one of the edges of the Xara X window and moves with the window. A docked 
control bar can be dragged away from the edge of the window so it becomes a floating control bar. See Moving and resizing 
control bars.



You can think of a Document as a conventional sheet of paper. Like a sheet of paper, you can draw lines and write text (and erase 
them later). You can save the document for later use by storing it on disk or printing it. Unlike conventional paper, the computer 
provides you with many extra options. You can move objects around on the document just by grabbing them and sliding them 
around, even over other objects. You can copy objects and reuse them, either in the same document or in a different document.



The Document Control Menu contains options for manipulating documents (for example, closing, minimizing and maximizing). To 
display the menu using the keyboard press ALT+HYPHEN.



Xara X has two types of document: Drawing and Animated. Drawing documents are suitable for most documents except 
Animated GIFs. Drawing documents can contain one or more layers to help you create complex drawings.



EPS & EPSF are Encapsulated PostScript - a variant of the PostScript language. EPS is commonly used as a file format to 
transfer data between different programs. Not all Xara X commands can be implemented in EPS format and so some information 
is lost when you export as EPS. 

PostScript is a trademark of Adobe Systems Inc. 



Edge Detection (Bitmap Effect) highlights sharp edges in bitmaps. You can detect edges with a specific orientation, for example 
vertical or 45 degrees. For more information see Applying special effects to bitmaps.



Edit Handles are used to edit objects. They appear on the object itself and are specific to the object type. Their function is 
different depending on which type of object they are on. Edit handles can be be used to edit the shape of lines, shapes and 
QuickShapes for example. Edit handles can be displayed when the Selector Tool has been chosen allowing objects of different 
types to be edited using one Tool.

Edit handles appear on each selected object and allow editing operations specific to the object type. Edit handles appear most 
object types. Edit handles are very similar to the handles used by Macromedia Freehand and Microsoft Office. See Enabling edit 
handles.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Ellipse Tool, the 
Infobar looks like this:



An Elliptical Fill consists of color graduating in a radial fashion. It is very similar to the circular fill, but uses three fill handles to 
allow the fill to be stretched in two directions. For more information, see the Fills Overview.



An Elliptical Transparency uses two transparency arrows, the transparency graduates from the center out to the edges of the 
ellipse defined by the arrows. It is very similar to the circular transparency, but uses the extra transparency handle to allow the 
transparency to be stretched in two directions. For more details, see the Transparency Overview.



Em's are used to measure tracking and kerning. One 'em' is the width of the character 'M' in the current font and font size. Hence, 
it is a relative measurement - changing the font or size, changes the absolute value.



An Envelope Mold is a shape used to mold objects. For instance a line of text could be molded into a circle using a circular 
envelope. See Applying molds for more information.



Feathering is a technique of blurring the edges of objects slightly. This makes the object merge into background objects and 
avoids a sharp line at the object boundary. This is particularly useful when overlaying bitmaps. See Feathering objects for more 
information.



File Format is the way in which information is arranged in a file. Different programs arrange the information in different ways 
depending on their requirements. This means that files from one program cannot be read by another or, if it can be read, not all the 
information can be displayed correctly. There are two major groups of graphic file formats. The first is Bitmap (a rectangle of 
colored dots) and the second Vector (a list of drawing instructions). Xara X can import and export many types of both Bitmap and 
Vector file formats.



Fills flood the center of an object. Xara X offers a range of fills - flat fills, linear fills, circular fills, conical fills, elliptical fills, diamond 
fills, three color fills and four color fills. You can also fill objects using tiling techniques. For more information, see the Fills 
Overview.



Fill Arrows are shown on filled objects and are used to edit the fills. The ends of the arrows can be clicked and dragged to move 
the fill. Some Fill Arrows have fill handles on the ends which allow colors to be applied to the fill. For most fill types you can drop 
colors onto the Fill arrow to create multi-stage fills. 

If you don't want to see fill arrows when dragging (interactive dragging), press TAB when in the Fill Tool or Transparency Tool.

For more information on Fill arrows, see Changing fills.



Fill Handles are the squares on the ends of fill arrows. To change the colors in the fill select a handle and apply a color to it. To 
easily swap between the start and end handles, press TAB (this swaps the selected status of all handles). Note that this only works 
in the Fill Tool. Fills can be edited using the Selector Tool if fill handles and fill arrows have been enabled in the Selector. See 
Enabling fill handles and fill arrows. You can change the way redraws are performed during the drag, see Enabling interactive fill 
and transparency dragging.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Fill Tool, the 
Infobar looks something like this:



Film is a photographic material used for imagesetting. One side of the film is coated with photographic emulsion which is exposed 
during processing. Depending on the requirements of your print shop, the image can be normal or reflected, positive or negative.



A Flat Fill is a solid fill of a single color. This type of coloring is applied using the Color Line or the Color Gallery. For more 
elaborate fills, use the Fill Tool. See the Colors Overview.



Flat Transparency is a fixed level of transparency applied uniformly over a whole object. For more details, see the Transparency 
Overview.



Flipping an object is as if it was reflected in a mirror. This process is sometimes called 'mirroring' or 'reflecting'. See Flipping 
objects for more information.



A control bar is a Floating Control Bar when it has been dragged and dropped away from the edges of the Xara X window. A 
floating control bar has a thick edges so it can be resized, a title bar and a close button. A floating control bar moves independently 
of the Xara X window. For more details, see Moving and resizing control bars.



A Folder is a directory on a disk containing files. You can add folders of files to some of the galleries. When you add a folder of 
files to a gallery the program creates an index for the files and creates a small 'thumbnail' image of each of the files in the folder. 
When you open the Gallery, you will see small versions of all the files in the folder you added.



A Font is a collection of characters which are all designed in a particular style. Also known as a "typeface". Many different types of 
fonts are available and often the difference between them is very slight. A font often has several variants, the commonest being 
Bold and Italic



Four Color Fills are similar to three color fills and give the effect of four colored spotlights lighting the object. The fill is controlled 
using four fill handles in a parallelogram. You can apply different colors to all four handles. The object can contain just one copy of 
the fill with the colors spreading to infinity, (Simple) or multiple copies (Repeating). See the Fills Overview for more details.



Four Point Transparency consists of four points, arranged as a parallelogram, each with its own transparency level. The 
transparency of the object is defined by the graduations between these transparency handles. In the example, the top-left and 
bottom right points (shown as black spots) are not transparent and the top-right and bottom-left points are 100% transparent. Four 
point transparency is enormously flexible and ideal for drawing highlights and complex looking transparency effects. See the 
Transparency Overview for more details.



A Fractal Cloud Fill produces a patchy random fill which is especially useful for clouds or mist. For more information, see the Fills 
Overview.



Fractal Cloud Transparency produces a patchy, random transparency similar to clouds or mist. The three transparency handles 
give control of the block of fractal texture used to control the transparency of the object. One handle moves the entire fractal and 
the other two scale, skew and rotate it. The start handles control the start transparency for the fractal, the end handle controls the 
end transparency. For more details, see the Transparency Overview.



Fractal Plasma Fill produces a patchy random fill which has more contrast than a fractal cloud fill. For more information, see the 
Fills Overview.



A Fractal Plasma Transparency produces a patchy, random transparency which has more contrast than a Fractal Cloud 
transparency. The three transparency handles give control of the block of fractal texture used to control the transparency of the 
object. One handle moves the entire fractal and the other two scale, skew and rotate it. The start handles control the start 
transparency for the fractal, the end handle controls the end transparency. For more details, see the Transparency Overview.



Frames are used to make up an animated GIF file. You create each frame using objects, change the properties of each frame in 
the Frame Gallery and then preview or export the animated GIF file. For more details, see the Frame Gallery Overview.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Freehand & 
Brush Tool, the Infobar looks like this:



Full Screen Mode gives the maximum possible screen area for the editing window. No Title Bar, Menu Bar, Scrollbars or Status 
Line are displayed. Move the pointer to the top of the screen to display the Menu Bar. The alternative to Full screen mode is 
Normal Mode. For more details, see Switching to full screen mode.



Compuserve GIF files are bitmap files compressed using lossless compression. GIF files can contain up to 256 colors. They are 
widely used for pictures on Internet pages. Xara X supports both interlacing and transparency (import and export) in GIF files. For 
more information, see Creating GIF files. You can also create animated GIF files with Xara X.



Galleries provide you with an easy way to select items from external libraries or where there is a wide range of possibilities. There 
are several galleries; for more information, see Galleries Overview.



With the grayscale color model you can edit colors so they range anywhere along the scale of grays from white to black. Note that 
grayscale colors are always gray; you cannot create non-gray colors using the grayscale color model.



A grayscale bitmap is a bitmap with a palette consisting entirely of grays. Grayscale images are often called "black and white" 
images. For more details on creating grayscale bitmaps, see Changing bitmap palettes.



A Grid is a set of regularly spaced points to which objects and points can be snapped. By setting an appropriate grid spacing and 
turning grid snapping on, it is very easy to create drawings of very precise dimensions. The grid can be shown or hidden whether 
or not grid snapping is turned on. At small zoom levels, grid points may become very close to each other. If they were all displayed, 
the screen would be covered by points and it would be difficult to see the drawing. To prevent this, Xara X leaves out some points 
if necessary. You can still snap to these invisible points. For more information, see Displaying the grid.



Group objects are compound objects which contain other objects (even groups). The group object is a single object and can be 
treated like any other, for example applying attributes to it, rotating it, etc. Note that if you want to change one object in the group 
you do not have to ungroup it, you can use select inside to select it from within the group. For more details, see Grouping objects.

      3 QuickShapes                1 Group containing 3 QuickShapes



Group Transparency lets you apply transparency to a group of objects without affecting any transparency already applied to 
individual objects. This means objects can have two different transparency effects and lets you build up complex transparency 
effects.



Guide Objects are objects placed or created in the guides layer. They can be any type of object including text and QuickShapes. 
Use guide objects to align or position objects on other layers. To make this easier you can make guide objects magnetic. Guide 
objects are non-printing and are always displayed as dotted outlines. For more information, see Guidelines and Guide Objects 
Overview.



Guidelines are horizontal and vertical dotted lines displayed across the entire width or height of the window. You can use them to 
align or position objects. To make this easier you can make guidelines magnetic. Guidelines are non-printing and live in the guides 
layer. For more information, see Guidelines and Guide Objects Overview.



The Guides Layer is a special layer containing guide objects and guidelines which are used to align and position objects 
accurately. All objects on the guides layer are shown as dotted outlines and can be made magnetic to aid positioning. If a blend 
object is placed on the guides layer the intermediate objects are ignored. The guide layer is created automatically when you create 
a guideline and can be created manually using the Layer Gallery. The guides layer would normally be used to hold objects 
providing a framework to which objects in other layers are aligned. For more details, see Guidelines and Guide Objects Overview.



Many people find HSV the easiest color model to use. The HSV color model uses Hue, Saturation and Value components to define 
colors. Hue is the pure pigment (defined as an angle round the color circle) of the color. Saturation is the amount of white added to 
the color. The smaller the Saturation value, the greater the amount of added white. Value is the amount of black added to the color 
which can be viewed as the brightness of the color. So the Saturation and Value produce all the shades of the basic Hue value.



A Handle are small squares used to edit objects. For example Fill Handles are used to edit fills and Selection Handles to 
manipulate the currently selected objects. Handles are usually dragged but can often be selected and changed.



The Hue color component is used in the HSV (Hue, Saturation, Value) color model, which is an intuitive color model most often 
used by artists.

Hue represents an angle in degrees around an imaginary color wheel, where the colors appear in a "rainbow" fashion: Red (0º), 
Yellow (60º), Green (120º), Cyan (180º), Blue (240º), Magenta (300º) and back to Red (360º). 

Black, white, and gray lie at the center of the color wheel.



Hue is a transparency type in the Transparency Tool. It is useful for color-shifting underlying objects. Its action is most easily 
understood using the HSV color model.

The color of the object with Hue applied:
Gray, White, & Black - has no effect. These colors lie at the center of the color wheel and so have no hue.
If the underlying color is gray, white, or black - Hue transparency type has no effect.
Other colors - replace the Hue of the underlying color with the Hue of this object. Use the Saturation and Value of the 

underlying color.



Image maps are used in HTML pages to create several clickable areas over images. Clicking on one of these areas takes you to 
another location on the Internet. For example, if you had a picture of the Earth, you could use an image map with a clickable area 
over each different continent. Clicking on the clickable area for a continent could take you to a page of information about that 
continent. The clickable areas can be rectangles, circles or multi sided irregular polygons. Xara X supports client-side image maps 
(it doesn't support server-side image maps). For more details on image maps, see the Image Maps Overview.



Imagesetting is the process whereby your document is converted from electronic format to high-quality output on photographic 
paper or film. The output then goes to a print shop for them to print hundreds or thousands of copies of your document. 
Imagesetting is generally done by a service bureau. For more information, see the Imagesetting Overview.



The Infobar is a context sensitive control bar which displays control relevant to the tool you are using. For more details, see the 
Infobar Overview.



Inter-line Spacing is a term used by CorelDRAW to refer to what Xara X calls Line Spacing. See Changing the spacing between 
lines of text.



Interactive dragging: this applies when creating fills and transparency by dragging. With interactive dragging, you see the fill or 
transparency update as you drag. With normal dragging, you drag the fill or transparency arrow. The fill or transparency updates 
when you stop dragging.

To swap between the two modes press TAB whilst dragging.



Interlacing is an option when you create GIF and PNG bitmap files. When an interlaced file is loaded into an application which 
supports interlacing, the picture first appears as a low resolution image. As more of the file is loaded, the resolution increases. This 
technique is used commonly on the Internet to improve the appearance of bitmaps as they are downloaded. It will almost look like 
the picture is coming into focus. If you do not use interlacing, the picture will only be displayed when the whole image has been 
downloaded.



Isolate Points (Bitmap Effect) highlights color changes in bitmaps that apply to a single pixel. It can be used to create some 
interesting effects. For more details, see Applying special effects to bitmaps.



The JPEG format allows bitmaps to be stored in compressed form. Unlike most other compression techniques, the amount of 
compression is user selectable. JPEG works by discarding redundant information (it is 'lossy') although generally there is no 
noticeable reduction of image quality. Xara X can import and export JPEG bitmaps. For more information, see Creating JPEG files.



Kerning allows you to alter the space between two characters in a line of text. Kerning is useful when two characters look 
unbalanced or too far apart. Small kerning changes between the two characters can improve their appearance. This is often 
necessary in very large headline or banner text where the "balance" of the characters is highly visible. Kerning is measured in em's 
(the width of an "M" in the current font and font size). For more details, see Kerning text.



The Key component is used in the CMYK (Cyan, Magenta, Yellow, Key) color model, which is commonly used by printers. By 
mixing various quantities of these four inks, a large range of colors can be generated. Key is black ink.



All the Xara X clipart has Keywords associated with it. Keywords are associated words which help you to find documents more 
easily. As an example a document containing a picture of a puppy might contain the keywords "animal" and "dog". For information 
on adding keywords to your own files, see Adding titles, descriptions and keywords to documents.



Laplacian (Bitmap Effect) highlights sharp color changes in bitmaps. For more details, see Applying special effects to bitmaps.



Xara X drawings can be drawn in Layers with different objects in each and with the layers laid on top of each other. For more 
details, see the Layers Overview.



Lighten is a transparency type in the Transparency Tool. It is useful for making underlying objects lighter. Usually you would use it 
on a separate object to modify the color of underlaying objects (that is, you would use an object as a filter). Lighten is a grayscale 
version of Bleach transparency type.

The color of the object with Lighten applied:
Gray & White - lightens the colors of underlying objects.
Black - no effect on the colors of underlying objects.
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then lighten the 

colors of underlying objects.



A Line can be straight, curved or contain a mixture of both straight and curved segments. A line must have a start and an end so it 
cannot be filled. (Although you can convert a line into a shape which can be filled.) You can apply a thickness, color, transparency 
and brush pattern to a line as well as line ends and patterns. When the two ends of a line are joined the line can be filled and is 
referred to as a shape. If a line has a fill applied to it, the fill will only be visible when the ends of the line have been joined. For 
more details, see Drawing lines.



A Linear Fill is a smooth, linear graduation of color. For more information, see the Fills Overview.



A Linear Transparency is a smooth, linear graduation between two transparencies. You can alter the direction of the transparency 
and the level of the transparency at either end. For more details, see the Transparency Overview.



Linked Colors are a type of named color and inherit components from another color (called the parent color). You define which 
components you want the linked color to take from the parent named color.

For example you could create a linked RGB color that shared the Red and Green components of the parent named color, but not 
the Blue. Any changes to the components of the parent named color would be reflected in the linked color. If you wish to create a 
set of shades of the same color which are all linked so their hue can be changed simultaneously, use shade colors. For more 
details, see Creating named colors.



Xara X has two types of color. They are Local Colors and Named Colors. Local colors are used in only one place in a document. 
This is useful if you want to change the color of an object without affecting other objects. Local colors are especially useful in 
simple documents that use relatively few colors. Local colors do not appear on the Color Line or the Color gallery.



Luminosity is a transparency type in the Transparency Tool. This uses the grayscale equivalent of the color to control the 
luminosity (or Value) of underlying objects. Note that Luminosity has no effect on gray, white or black underlying objects.

The color of the object with Luminosity applied:
Gray & White - increase the luminosity of underlying objects. White has the greatest effect, producing saturated color.
Black - remains as a black object.
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then increase the 

luminosity of underlying objects.



Mirroring is a term used by CorelDRAW to describe what Xara X refers to as flipping. See Flipping objects.



Miter Join is one of the options available for line corners, contours and bevels. For more details, see Changing join style.



Mix is a transparency type in the Transparency Tool. The color of the object mixes with the color of underlying objects. The effect 
is similar to spraying a thin coat of color (or paint) over underlying objects. To create an opaque object use Mix with 0% 
transparency.



Applying a Mold to an object allows it to be warped. Xara X supports two types of mold. Envelope molds have four curved sides 
and perspective molds have four straight sides. Perspective molds can also be controlled using two vanishing points. For more 
information, see Applying molds.



Mold Handles are used to control molds. They are very similar to point handles. For more information, see Reshaping an 
envelope mold and Reshaping a perspective mold.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Mold Tool, the 
Infobar looks like this:



Xara X has two types of color: Local Colors and Named Colors. Named colors are custom colors which you can use over and 
over again on many objects. The Color Gallery lets you control named colors in documents and the Color Line is a list of all the 
currently defined named colors. Any alterations made to named colors are reflected in all objects using the named color. Named 
colors can be copied between documents. You can create several types of named color: Linked Colors, Shade Colors, Normal 
Colors, Spot Colors and Tint Colors. You can easily connect your colors so changing one affects others. For more details, see 
Creating named colors.



Xara X lets you assign names to objects. You can then use those names to select all the objects with that name, to slice other 
objects on export, or stretch/shrink other named objects. Or you can just use the names as comments about the objects. Use the 
Name Gallery or the Selector Tool to give names to objects. Use the Name gallery for the other functions.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Button & NavBar 
Tool, the Infobar looks like this:



Navigation Bars are sets of buttons arranged horizontally or vertically. Usually they appear at the top or side of web pages to aid 
navigation. Using Xara X's Button & NavBar Tool makes creating a navigation bar a simple operation. For more information see 
Creating Navigation bars.



Normal Colors are a type of named color. Normal named colors are stand-alone and their color is defined independently of any 
other color. The other color types (Shade Colors, Tint Colors and Linked Colors) are linked to another color in some way.



Xara X has two screen modes - Normal Mode and Full Screen Mode. In Normal mode all the usual screen furniture is displayed 
such as a Menu Bar and Scrollbars. For more details, see Switching to full screen mode.



Objects in Xara X are the building blocks used to create drawings. Object is a general term used to describe the contents of the 
document. Objects can be contained within other objects. For example, groups, molds and blends all contain other objects. Text is 
also a type of object as each text object contains a line of text which itself contains a set of characters.



Object snapping makes one point or object snap towards another when one of them is moved. Object snapping only takes place 
when it is enabled by Snap to Objects on the Window menu or by the Magnet button on the Standard Control bar. See Object 
Snapping Overview for more details. You can specify separate snapping distances for point and lines. This makes it possible to 
snap two points together precisely.

The small magnet icon on the status line lights up and a magnet appears on the mouse pointer when the point or object being 
dragged has been snapped magnetically to a stationary object.

Guides can also be made magnetic using Snap to Guides on the Window menu.



A bitmap with an optimized palette is one where the colors in the bitmap have been chosen carefully to make the bitmap look as 
good as possible. Optimized palette bitmaps with 256 colors will usually look as good as the 24 bit equivalent (one with millions of 
colors) when you display them in a screen mode with millions of colors. If you display an optimized palette 256 color bitmap in a 
256 color screen mode it will look as good as one with a browser palette, but will look far better in screen modes with more colors.



Outlining is a term used by CorelDRAW and refers to changing the outline color of an object. Xara X refers to 'changing the line 
color' of an object. See Coloring objects.



Overprinting is a method of getting around problems caused by the inevitable inaccuracies of registration in printing. For more 
information, see the Overprinting Overview.



The Page is the area onto which drawings are placed. It is usually white, though you can change its color or cover it with a bitmap.



Panning is a term used by CorelDRAW to describe moving the page. See Moving the page.



PANOSE® is a font matching system for TrueType fonts. The PANOSE system classifies fonts according to ten characteristics. 
Each characteristic is rated on a scale, and the resulting values are used to produce a number. When a font cannot be found, it is 
replaced by the one on your machine with the closest PANOSE number to the original.



The Pasteboard is the area around the page. The pasteboard can be used just like the page area, but objects on it are never 
printed.



An object in Xara X can be placed inside a Perspective Mold. This perspectivizes the selection and ensures it is contained by the 
mold. The perspective can be edited using the four corners of the mold or by moving a vanishing point. For more details, see 
Applying molds.



PhotoCD is a Kodak proprietary process for storing photographs and transparencies in digital form on a CD. The CD can contain 
up to six copies of each image at different resolutions. For details on loading PhotoCD files, see Importing PhotoCD files.



Point Handles are the handles visible on the points of lines and shapes when the Shape Editor Tool or the Selector Tool (with Edit 
Handles enabled) is being used. Each point (point handle) on the line can be moved and if the line segments are curved, two 
curve handles are also shown which you can drag to alter the curvature of the line.



PostScript is a file format commonly used for outputting to printers and typesetters. It has the advantage of being standardized 
and so any PostScript file should be readable by any PostScript device. There are two variants: level 1 and level 2. Level 2 
includes additional commands for color handling and speed improvements. PostScript is a trademark of Adobe Systems Inc.



Print Marks are marks and text placed around the edges of imageset output to give information to the print shop. For example, 
Crop Marks tell the print shop where to trim the paper to size after printing. Registration Targets let them accurately align color 
separated output during printing. Your print shop can tell which marks are needed for your job. The Imagesetting tab of the Options 
dialog box controls Printers Marks. For information on creating your own custom printer marks, see Creating custom print marks.



The Print Shop is where your job will actually be printed. With some printing processes, they can work directly from a computer 
disk of your work. However, if they use conventional litho presses they need a printed copy (an 'original') of your work to produce 
printing plates, one plate for each ink color you have used. For simple work, a copy produced on a desktop printer may be 
suitable. More complicated or higher quality work requires the job to pass through a service bureau.



Process Colors are the colors used in four color printing: Cyan, Magenta, Yellow and Black (CMYK).



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Push Tool, the 
Infobar looks like this:



Document view Quality is the way in which documents are drawn on the screen. The Quality can range from the drawing being 
rendered in simple outline, to being edited in full color, anti-aliased mode. This is useful for altering the speed at which a document 
is redrawn as a lower quality setting will result in faster redraw times, but a higher setting will give far better results. Sometimes it is 
useful to set the Quality to its lowest level for selecting some objects which would be obscured by other objects on higher settings. 
The quality setting is also used when you create bitmaps.



QuickShapes are 'intelligent' shapes created using the QuickShape, Rectangle and Ellipse Tools. All QuickShapes can be edited 
in a very flexible manner. For instance, a circular QuickShape can be converted to a polygon QuickShape with one click using the 
QuickShape Tool. If you wish to change a QuickShape so it can be edited as a shape built from straight and curved lines, you must 
use Convert to Editable Shapes.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the QuickShape 
Tool, the Infobar looks like this:



RGB (Red, Green, Blue) is the natural model of computers. Colors would usually be defined using this model if they are to remain 
'on-screen' - for example if the Xara X were being used to create bitmaps for use on the Internet.



If you draw a QuickShape using radius creation, where you start dragging the mouse sets the center of the shape and where you 
stop dragging sets the radius (size) of the shape.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Rectangle Tool, 
the Infobar looks like this:

  



Redo allows you to redo an editing operation that has been Undone.



Redraw is the process of Xara X building up the on-screen image from the information stored about the drawing.



Some drawing packages have a special color called Registration Black which prints on all separations. See the Color Separating 
Overview. In Xara X you can specify individual objects that you want to print on all separations. Right-click on the object to open 
the pop-up menu. Then choose Print on all plates from the imagesetting submenu. Use Print on all plates with care. If you use it 
over large areas, you can flood the printing press with excess ink.



Rendering is the process used by Xara X to draw the document on the screen.



Resolution (of bitmaps): some file formats such as JPEG and PNG let you set a resolution (dots per inch or dpi) independently of 
the physical size of the bitmap. The main use of this is for printed output. A PC monitor has a resolution of 96dpi, which means 
there are 96 dots (or pixels) to one linear inch. This is adequate for on-screen work. However 96dpi is too coarse for printing, 
which requires 150dpi or higher.

Notes:
Some programs, especially web browsers, ignore resolution information and assume the bitmap is 96dpi. The result is 

that a 150dpi bitmap is displayed at 156% (150/96). This is beyond the control of Xara X.
Some file formats (especially GIF) are always 96dpi.
dpi/pixels per inch is different to Xara X's 'pix' measurement unit which is 1/96th of an inch.



The Animated GIF Restore setting sets what happens between each frame in an animated GIF:
Nothing means no action is taken. Many browsers take this as meaning the same as the Leave As Is option.
Leave As Is displays the frames one on top of another - this leaves many frames visible in a stack if some are 

transparent. Some browsers clear the animation before it loops again, some do not.
Background restores the area covered by the graphic to the background color of the GIF (usually white).
Restore Previous restores the area covered by the frame to what it was before the frame was displayed. This is 

interpreted by some browsers to mean that the frame should be cleared to the background before each frame is displayed and by 
others to mean that the frame should be shown on top of the previous frame.

As browsers interpret these values in different ways, you may need to experiment to achieve the desired result.



Robert's Cross (Bitmap Effect) lightens edges found in bitmaps. For more details, see Applying special effects to bitmaps.



Rollovers are a special type of button used on web pages. They change appearance (state) if you select them, click them, or if the 
mouse is over them (if the browser is JavaScript-enabled). This is controlled by a section of JavaScript on the web page. Xara X 
creates this JavaScript when you Export the rollover buttons. 

Rollovers have four possible states:
MouseOver - highlights the button when the mouse is over it.
MouseDown - applies when you click the button. Some early JavaScript-enabled browsers such as Internet Explorer 3 

ignore this state..
Selected (pressed in) - shows that the button is selected.
MouseOff (pressed out) - when none of the previous states apply.

You can create rollover buttons with any combination of the four states. (Xara X always creates the MouseOff button.)

For more information see Creating Rollovers.



Selection handles operate in two modes - Scale mode and Rotate/Skew Mode. The former allows the selection to be scaled, the 
latter allows it to be rotated and skewed.

      Selection handles

 in Skew/Rotate mode



Round Caps are a type of ending which can be applied to lines. There are three types of 'cap'. For more details, see Changing 
line ends.

Butt Cap                      Round Cap                Square Cap



Round Join is one of the options available for line corners, contours and bevels. For more details, see Changing join style.



Rulers are shown at the left-hand side and top of the document window. They let you know which part of the page you are 
viewing, display the current mouse X,Y position and allow the simple creation of guidelines. For more information, see Using 
rulers.



The Saturation color component is used in the HSV (Hue, Saturation, Value) color model, which is an intuitive color model most 
often used by artists. Saturation represents a mixture between the chosen Hue (color) and white. A fully (100%) saturated red 
would be red, while a 50% saturated red would be pink. Any hue appears as pure white at 0% saturation.



Saturation is a transparency type in the Transparency Tool. Usually you would use it on a separate object to modify the color of 
underlaying objects (that is, you would use an object as a filter). Depending on the color chosen, it makes the colors of underlying 
objects brighter or duller.

The color of the object with Saturation applied:
Gray (below a 50% tint of black) & White - increases saturation in the colors of underlying objects towards pure color.
Gray (above a 50% tint of black) & Black - reduces saturation (colorization) towards black.
Other colors - convert the color to the equivalent shade of gray. (Yellow gives light gray, Red dark gray.) Then increase or 

decrease the color saturation of underlying objects.



Scaling resizes or stretches something. You can scale any object using the Selector Tool. You can also scale some objects using 
the Tool they were created with (for example Ellipse Tool) and you can scale fills and transparencies using the Fill Tool or the 
Transparency Tool. For more details, see Scaling objects.



Selection Handles operate in two modes - Scale Mode and Rotate/Skew mode. The former allows the selection to be scaled - the 
latter allows it to be rotated and skewed.

 Selection handles

      in Scale mode



This applies to imageset and printed output. It has no connection with the computer’s monitor screen. Screen frequency is often 
called just 'screen'. Printers and printing machines reproduce tints of a basic ink color as small dots arranged in rows. Screen 
frequency is the spacing of these rows and is usually measured in lines per inch (lpi). A desktop laser printer often has a coarse 
screen of about 60 lpi and the individual dots are noticeable. Imageset output is normally 100 to 150 lpi and you need a magnifying 
glass to see the dots. For imageset output, your print shop can tell you the screen frequency to use.



Scrollbar

Horizontal and vertical scrollbars let you use the mouse to move the document within the window. Scrollbars are located at the 
right and bottom edges of the document window. For details on hiding the scrollbars, see Hiding the scrollbars. Scrollbars contain 
markers, called scroll boxes, that indicate the vertical and horizontal location of the section of document currently in view. For more 
information on using scrollbars, see Using scrollbars.



Select Inside can be used to select an object inside a compound object. This can be done in the Selector tool by CTRL-clicking or 
by ALT-CTRL-clicking on the object. Objects are said to be "inside" a group when they are members of the group. Normally, 
clicking on the object would select the group but a CTRL-click selects the object that you clicked on inside the group. Select inside 
works with any compound object. When any selected object is inside another one, the status line shows for example: "2 shapes 
selected ("inside")". Select-inside is just like select member, except it goes straight to the innermost object. It is a quick way to 
select the object you actually click on, irrespective of whether it is part of a group, blend, or mold. Some operations are unavailable 
when any selected object is inside another one. For more details on this, see Selecting objects in objects.



Select Member

To select an object which is a member of a group. (This is a special form of Select inside.) This can be done in the Selector Tool by 
ALT-CTRL-clicking on the object. Objects are said to be "inside" when they are members of a group. Normally, clicking on the 
object selects the group but ALT-CTRL-click selects the object inside the group containing the clicked object. That object may itself 
be a group and then further ALT-CTRL-clicks can be used to select members of that group, etc. When the last selected object was 
not a group, it cannot have any members and so the next ALT-CTRL-click will select the outermost group again. Select member 
also works inside blends, molds and text. When any selected object is inside another one the status line shows, for example "2 
shapes selected ("inside") " Some operations are unavailable when any selected object is inside another one. For more details, 
see Selecting objects in objects.



Select Under allows you to select an object which is underneath another object. This can be done in the Selector Tool by ALT-
clicking on the top object. Select under is most useful when one object is completely covered by another one. Clicking on the top 
object selects the top object - ALT-clicking on the top object selects the object underneath.

If there are several objects covering each other, repeatedly using ALT-click selects the next object underneath the one that was 
last selected. When the last selected object is the one at the back, the next ALT-click will start at the top again and select the top 
object. For more details, see Selecting objects under objects.



The Selection is all the currently selected objects. The selection is most often manipulated using the Selector Tool. For details on 
how to select objects, see Selecting objects.



Selection Handles are displayed when the Selector Tool is the current tool and selection handles have been enabled (See 
Enabling Selection Handles). They are displayed around the boundary of the selection and allow the selection as a whole to be 
scaled, rotated, skewed and stretched. They operate in two modes: Scale mode and Skew/Rotate mode.

  

    Selection Handles                    Selection Handles

          in Scale Mode                    in Rotate/Skew Mode



Selection Markers are small squares displayed on all selected objects.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Selector Tool, 
the Infobar looks like this:



The Service Bureau takes your work in electronic form and then produces high quality originals from that. In some cases the print 
shop and service bureau are part of the same company. Often though they are completely separate. For simple jobs the originals 
may be on photographic paper. Color work usually requires film which is slightly more expensive. The service bureau can usually 
provide color proofs of your job if you need it. Often a bureau offers a range of other functions such as high-quality scanning of 
photographs.



Shade Colors are a type of named color which are lighter or darker shades of a parent color. The colors are linked so when the 
parent color is altered the shades alter too. This allows you to create a range of shades where changing one parent color alters the 
hue of all of them. Creating pictures using a set of shades gives great editing flexibility. For best results with shades, always make 
sure the parent color is a 'pure' color (saturation and value should be near 100%). For more information, see Creating shade 
colors.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Shadow Tool, the 
Infobar looks like this:



A Shape is a solid (or closed) object. The difference between a line and a shape is that a shape has no start or end. Because a 
shape is a closed object it can be filled with a color. A thickness can be applied to the outline of the shape. Xara X sometimes uses 
'Shape' as shorthand for 'Line or Shape'. In PostScript terminology, a shape is a "closed path". Shapes can have two main 
attributes applied - a fill and a line color. The line color is the color used for the outline of the shape and the fill can be a simple 
color or a more complex fill (for example bitmap or fractal). For more details, see Drawing shapes.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Shape Editor 
Tool, the Infobar looks like this:



Sharpen exaggerates the boundary between colors in bitmaps. It is useful for bringing out detail. It is not useful for:
Gentle transitions between shades of the same color.
'Noisy' bitmaps. Applying sharpening to such a bitmap is likely to emphasize the noise.

The Special Effects dialog box contains three levels of Sharpening - Low, Medium and High. One of these can be selected, and 
the slider used to set the level more accurately. For more details, see Applying special effects to bitmaps.



Skewing is often called shearing and involves sliding the top (or side) of something to stretch it, without moving the opposite side. 
You skew objects using the Selector Tool. You can also skew fractal and bitmap fills and transparencies using the Fill Tool or the 
Transparency Tool. For more details, see Skewing objects.



Sliders allow values to be set by sliding a small button along a groove. They are sometimes referred to as 'trackbars'.



Snapping causes an object or point to be pulled to a certain place while it's being dragged. There are several forms of snapping: 
Grid snapping, Guide snapping and Object snapping. Snapping is useful for precisely aligning points or objects with each other. 
See Enabling object snapping.



Spot Colors can be used in work that will be printed on a litho printing press. Spot colors appear as circles on the Color Line and 
Color Gallery and each spot color produces an extra separation when you generate color separated output. For simple two and 
three color jobs you can use spot colors in place of the four process CMYK colors. This usually reduces printing costs. For 
complex, multicolor jobs, spot colors let you use special inks such a metallic or specific ink colors that CMYK cannot reproduce. 
Using spot colors like this increases the cost of printing the job. Always talk to your print shop before using spot colors. Note that 
some printing processes cannot use spot colors.

For details on how to create a spot color, see Creating spot colors.



A Spread is the name given to a number of pages that are joined together. The two pages in the middle of a magazine are often 
referred to as the 'center spread'. Xara X supports two types of spread, single-page-spreads and double-page-spreads (DPS). A 
single page spread is just one page on its own. A double-page-spread is two pages side by side. The line where two pages join on 
a double page spread is often used to fold the paper that the document is finally printed out on.



Square Caps are a type of ending which can be applied to lines. There are three types of 'cap'. For more details, see Changing 
line ends.

Butt Cap                      Round Cap                Square Cap



Stained Glass is a transparency type in the Transparency Tool. The effect is similar to viewing underlying objects through colored 
glass. It is useful for the simulation of glass and selectively darkening objects.

The color of the object with Stained Glass applied:
White - no effect on the colors of underlying objects.
Gray & Black - darkens the colors of underlying objects.
Other colors - darken underlying colors towards saturated color. (Light-red over light-red gives a mid-red: green over red 

gives black.) If you want to use a colored object to darken underlying colors, you may find Darken transparency type easier to use.

Technically the process is subtractive in RGB color space.



In Xara X you are not limited to plain lines. You can also profile the line (for example to make it tapering). The Line Gallery include 
a selection of profiles (called "stroke shapes") See Changing the stroke shape for more details.



A Template Document is a blank document that you can create regular documents from. Xara X includes templates for drawings 
and animations and you can create other templates as you need them. See Creating a template document for more details.



Xara X locates a Temporary folder using the 'TEMP' environment variable. If this variable is not set to a proper folder, various 
features of the program, such as the remote index building in the library galleries, will not work.



The Text Cursor is displayed when the Text Tool is selected. The cursor shows you where characters will appear if you start typing 
or where editing will take place if the cursor is inside an existing text object. To move the cursor click the mouse where you want 
the cursor. No cursor is displayed if there is a selected text region. You can apply attributes to the text cursor which will be used 
when you type. For more details, see Creating new text.



A Text Object is one or more lines of text which can be moved and copied like any other object. The Text Tool allows you to edit 
the contents of text objects by typing new characters, changing the font, font size, etc. You can apply all the normal attributes to 
text objects, such as thick line widths, fills, dotted lines, color and even transparency. Text objects can be fitted to a curve and they 
remain editable in the Text Tool. If you use Select Member on a text object you first select the whole object, then a line of text in it, 
then a single text character in the line. Text objects come in three forms, simple, column and fitted to a curve. For more details, see 
Creating new text or the Text Overview.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Text Tool, the 
Infobar looks like this:



Three Color Fills give the effect of three colored spotlights lighting the object. The fill is controlled using three fill handles. Unlike 
other types of fill you can apply different colors to all three handles (the center and the two end points). The object can contain just 
one copy of the fill with the colors spreading out to infinity, (Simple) or multiple copies (Repeating). For more details, see the Fills 
Overview.



Three Point Transparency consists of three points each with their own transparency level. The transparency of the object is 
defined by the graduations between these three transparency handles. In the example, the left point (shown as a black spot) is not 
transparent, the right point is 100% transparent and the bottom point is 50% transparent. Three point transparency is ideal for 
drawing highlights and quickly drawing complex looking transparency effects. For more details, see the Transparency Overview.



Tiling is the way some fills, transparencies and bitmaps are duplicated across objects or the page.

Bitmap Fills & Fractal Fills
Single Tile places a single copy of the bitmap or fractal inside the filled shape. The shape may not be entirely covered by 

the bitmap or fractal. You can scale up the bitmap or fractal to fill the shape but the individual pixels may then be noticeable.
Repeating Tile repeats the bitmap or fractal to fill the shape.
Repeat Inverted is similar to Repeating Tile, but alternate tiles are reflected.

Flat & Conical Fills

You cannot tile these types of fill.

Other fill types
Simple takes the colors of the fill and extends them out to infinity.
Repeating copies the fill over the whole shape.



Tint Colors are a type of named color. They are based on another named color (called the parent color) but with the addition of 
white, so any changes made to the parent color will be reflected in the tint. Use tints:

As a quick way to define new named colors. For example Pink could be defined as 50% Red.
To extend the range of colors available for printing inks. For example, a 75% black tint gives dark gray, a 25% black tint 

light gray. This gives three colors using just one ink.
To create highlights of the parent color.

A tint can be based on any other named color, including another tint.



A Tool is much like a tool in normal life. It is used for a specific job. This program is divided into well-defined tools each of which 
has a specific purpose. When you choose a Tool, the Infobar changes to give you a set of options specific to that Tool leaving more 
editing area available. For more information on the Tools, see The Tools.



The Toolbar is a special control bar containing buttons for all the Tools available in Xara X. For more details, see The Tools. If you 
are using a small screen mode and you cannot see all the tools buttons, click here.



Tracking uniformly changes the spacing between all the characters in a region. (Note the difference between this and Kerning 
which adjusts the spacing between a pair of characters.) Tracking is often used to expand text to exactly fit an area of a document. 
Tracking is measured in em's (the width of an "M" in the current font and font size). For more details, see Changing text tracking.



The transformation center is the point/axis around which objects are skewed, flipped and rotated using the Selector Tool. The 
transformation center is only visible when the Selector Tool is in Rotate/Skew mode. For more information, see Moving the 
transformation center.



You can change the transparency of any object in a document. (That is, you can make make it semi-opaque.) There are a wide 
range of transparency 'shapes' including circular and linear. Most are 'graduated transparencies'; this means the level of 
transparency changes across the object. By combining transparency shapes with different fill colors and transparency type, you 
can create a wide range of effects and shading. Note that documents using transparent objects take longer to redraw on-screen 
and to print. For more information, see the Transparency Overview.



Transparency Arrows let you control graduated transparency. The direction and length of the arrow directly control the direction 
and extent of the graduated transparency. The arrow has handles at either end which can usually be selected. The transparency 
set by the slider in the Transparency Tool Infobar is applied to the selected handles.

If you don't want to see transparency arrows when dragging, press TAB when in the Fill Tool or Transparency Tool.

For more details on Transparency, see the Transparency Overview.



Transparency Handles are the handles at the ends of the Transparency arrow. Drag the handles to change the direction and size 
of the graduated transparency. Select a handle and drag the slider on the Transparency Tool Infobar to change the amount of 
transparency applied. To easily swap between the start and end handles, press TAB.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Transparency 
Tool, the Infobar looks something like this:



TrueType is a type of font format. There are two main formats in use: TrueType and Adobe Type Manager (ATM). Xara X supports 
both types.



Xara X allows you to Undo your most recent changes to a document. Undo allows you to get rid of changes which you've applied 
mistakenly to your document, which went wrong or which you simply don't like the look of. Undo is a very powerful tool when 
combined with Redo because it gives you the freedom to experiment with a drawing, secure in the knowledge that you can always 
undo any changes or if you eventually decide you do actually like the changes, to redo them again.



The Value color component is used in the HSV (Hue, Saturation, Value) color model, which is an intuitive color model most often 
used by artists.

Value (sometimes called Brightness or Luminosity) represents how dark or light the color is. A value of 0% makes any color 
completely black, while a value of 100% is as bright as the color can be made.



Vector Format files describe a picture as a list of drawing instructions. This has two advantages over Bitmap formats:
The instructions can be scaled to work at any size.
The list can be edited to add, remove or alter any part of the drawing very easily.



A View is a window showing a document in a particular way. You can have more than one View open onto a document. For 
instance, you could have two Views onto different areas of the same document, two views showing the same document at different 
zoom factors or at different Quality settings. Views are sometimes called Windows.



A Web Address specifies a page on the Internet. www.xara.com is the Web Address for the Internet home of Xara Ltd. Web 
addresses are also called URL's, Shortcuts and Hotlinks. For more information, see Adding web addresses to objects. For more 
details on how web addresses work, see the Web Address Overview.



The    WebSnap optimized palette is a compromise between the Browser and Optimized palettes. Colors close to an entry in the 
Browser palette snap to that entry; other colors are unchanged.



Xara Webster was a drawing package from Xara and now replaced by Xara X.

Xara Webster owners will find much of Xara X familiar. The main difference is the extra tools and options in Xara X.

You can load and import all Xara Webster files into Xara X. 

Xara Webster can load WEB and XAR files but some Xara 9 features do not exist in Xara Webster. This can cause your drawings 
may look slightly different when viewed in Xara Webster.



The Zoom level of a View lets you see a document in close up or at a distance. You can think of the zoom level being like a 
magnifying glass whose strength you can vary. When you look at your document with a zoom level of anything other than 100%, 
you are looking at it through a magnifying glass. But note that changing the Zoom level only changes your view onto the document 
- it does not change the size of the document or anything in it.



The Infobar is a special control bar which changes depending on which tool you have selected. If you choose the Zoom Tool, the 
Infobar looks like this:



{button A,JI(`',`IDH_Definition_A')} {button B,JI(`',`IDH_Definition_B')} {button C,JI(`',`IDH_Definition_C')} {button 
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 Delete (Edit Menu)    DELETE

Delete removes the selection from the document. Unlike Cut, Delete does not copy the selection to the clipboard. The clipboard is 
not affected in any way by Delete. A Delete operation can be reversed using Undo. For more details, see Deleting objects.

Tip
To delete an object quickly, right-click on it to open the pop-up menu and choose Delete.



Deleting a color in multi-stage fills

Applies to Linear, Circular, Elliptical, Conical and Diamond fills. Multi-stage fills let you have several different colors in your fill. So, 
a fill could run red-green-red yellow; you have full control over the colors used and where the colors change.

To delete a color

The Fill arrow shows a handle for each color in the fill. You cannot delete the Start and End colors.
1. Click on a color handle to select it.
2. Press the Delete key.

Note:
The Selector Tool can also display the Fill arrow. See Enabling fill handles.

_______________

Related Topics

Creating multi-stage fills
Changing multi-stage fills
Fill Tool



Deleting a brush

The Freehand & Brush Tool and Line Gallery include a wide range of brush stroke designs that you can apply to lines and the 
outlines of shapes.

To delete a brush:
1. Open the Line Gallery.
2. Open the New brush strokes section.
3. Right-click on the brush you want to delete - this pops-up a menu.
4. Click Delete on that menu. Note that you cannot delete Default stroke.

Notes:
You can delete only those brushes unique to this document. You cannot delete default brushes (but see Notes).
Closing a document automatically deletes unused brushes. This means you only rarely need to manually delete brushes 

(perhaps to tidy up the list of brushes).
To edit or delete default brushes, load the document containing that brush. The document is in the Brushes folder. To find 

this, locate the Xara X program (XaraX.exe). In the same folder as XaraX.exe is the Templates folder. Brushes is in the Templates 
folder.

_______________

{button ,KL(`brush strokes',0,`____No_Topics_Found',`')} Related Topics



Deleting a custom unit

You can create your own custom units in Xara X. You can easily remove a custom unit you have created.
To delete a custom unit

1. From the Utilities Menu, choose Options.
2. Click the Units tab.
3. In the Unit Definition section, click on the unit you want to delete.
4. Click the Delete Unit button.

Tips
You can only delete custom units that you have you created.
You cannot delete units that are in use (for grid spacing, document scaling or as the default font or page units).

_______________

{button ,KL(`units',0,`____No_Topics_Found',`')}    Related Topics 



Deleting a navigation bar button

Navigation bars are often used on web pages to navigate to other pages. In Xara X, you can use the Button & NavBar Tool to 
create navigation bars. After creating a navigation bar you may decide it has too many buttons.

To delete a button:
1. Open the NavBar Properties dialog box by clicking Bar properties on the NavBar Tool Infobar.
2. Change the value in Number of buttons.
3. Click Close.
For rollovers you can also delete individual rollover states - more details.
You can also delete the entire navigation bar in the regular way - more details.

Movies

{button ,EF("XaraDemo.exe",`NavBar Creating Navigation Bars',1,`') } Creating Navigation Bars

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



Deleting a rollover button state

Rollovers are multi-state buttons used in navigation bars on web pages. In Xara X, you can use the Button & NavBar Tool to create 
navigation bars and rollover buttons.

To delete a rollover button state:

Note that deleting the MouseOff state deletes the entire navigation bar.
1. Open the NavBar Edit States dialog box by clicking either Create/Delete States on the NavBar Tool Infobar.
2. From the list on the left, select the state you want to delete.
3. Click Delete state.

You can also change the number of buttons in a navigation bar - more details.

Movies

{button ,EF("XaraDemo.exe",`Rollover Creating JavaScript Rollovers',1,`') } Creating JavaScript rollovers

_______________

{button ,KL(`rollovers',0,`____No_Topics_Found',`')} Related Topics



Deleting control bars

Creating, deleting and reordering control bars are an important way of customizing Xara X to your individual requirements.
To delete a control bar

1. On the Window menu choose Control Bars. This opens the Control Bars dialog box.
2. Click on the name of the control bar in the dialog box.
3. Click the Delete button. You are asked to confirm you want to delete the control bar.

Tips
A quick way to delete a control bar is to drag it away from the edge of the main window so it becomes a floating bar in its 

own window and then click the close button.
You cannot delete the Infobar or the button palette.
To restore the factory settings

1. Open the Control Bars dialog box using the Window menu.
2. Click the Reset button.

Tip
This is useful if you accidentally delete a control bar.

Movie

{button ,EF("XaraDemo.exe","MakeBars Creating Control Bars",1,`') } Creating new control bars

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Deleting frames

Xara X uses frames to create animated GIF files. Deleting a frame removes it from the animation.
To delete a frame

1. From the Utilities menu, choose Frame Gallery.
2. Click on the name of the frame you want to delete. This selects it.
3. Click the Delete button. You are warned if there are objects in the frame.

Notes
The Frame Gallery is dimmed in Drawing documents as these cannot contain frames.
You can quickly delete a frame by right-clicking on it in the Frame Gallery to open the pop-up menu and choosing Delete.



Deleting guidelines

Deleting an unwanted guideline is easy in Xara X.
To delete a guideline

Drag the guideline back onto the appropriate ruler.

Tips
You can only drag guidelines if the guides layer Editable setting is set. See the Layer Gallery Overview.
You can also delete a guideline by right-clicking on it, then choosing Delete from the guideline pop-up menu. 
You can also delete a guideline using Properties dialog box in the Layer Gallery. See the Layer Gallery Overview.

_______________

Related Topics

Rulers
Guides
Guidelines



Deleting layers

Deleting an unwanted layer is easy in Xara X (but see Notes).
To delete a layer

1. From the Utilities menu, choose Layer Gallery.
2. Click on the name of the layer you want to delete. This selects it.
3. Click the Delete button. You are warned if there are objects on the layer.

Notes
The Layer Gallery is dimmed in Animation documents as these cannot contain layers.
Layers MouseOff, MouseOver, MouseDown, Selected and BackBar are used by the Button & NavBar Tool. We do not 

recommend deleting these layers as this could affect navigation bar creation. For more information on bar creation see Creating 
Navigation Bars.

Tips
As an alternative to deleting a layer, you can also hide it (make it invisible). This is useful if you might want the layer in the 

future. See Hiding layers.
You can quickly delete a layer by right-clicking on it to open the pop-up menu and choosing Delete.

_______________

{button ,KL(`layers',0,`____No_Topics_Found',`')}    Related Topics



Deleting named colors

Xara X lets you delete one or more named colors from the Color Gallery and Color Line.

To delete a named color

1. From the Utilities menu, choose Color Gallery.
2. Select the color in the Color Gallery (see Selecting items in a gallery).
3. Click the Delete button in the gallery.

Note
If any of the selected named colors is in use in the document, you are asked to confirm the deletion. If you choose to 

delete the used colors, any objects previously using these colors will look the same, but will now have local colors applied.

_______________

Related Topics

Named colors
Colors overview
Color Line
Color Gallery



Deleting objects

You can delete any type of object to remove them from a drawing.
To delete objects

1. Select the objects (see Selecting objects).
2. From the Edit menu, choose Delete.

Tips
You can also select the objects then press the Delete key on the keyboard.
Deleting objects does not put them on the clipboard. If you want to remove an object and leave it on the clipboard, use 

Cut.
You can recover deleted objects using Undo. See Undoing and redoing operations. 

_______________

Related Topics

Cutting
Pasting



Deleting points on lines and shapes

Once you have drawn a line or shape, you can remove individual point handles from it.
To delete points on lines and shapes

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Select the point handles.
4. Click the Delete Point(s) Button on the Shape Editor Tool Infobar.

Tip
To quickly delete points, right click on one of the selected points to open the pop-up menu and choose Delete Points.

_______________

{button ,KL(`point handles',0,`____No_Topics_Found',`')}    Related Topics



Deleting the guides layer

The guides layer contains guidelines and guide objects.
To delete the guides layer.

1. Open the Layer Gallery.
2. Click the guides layer to select it.
3. Click the Delete button. You are warned if there are objects on the layer.

Notes
The Layer Gallery is dimmed in Animation documents as these cannot contain layers.
As an alternative to deleting the layer, you can also hide it (make it invisible). This is useful if you might want the layer in 

the future. See Hiding layers.

_______________

Related Topics

Layer Gallery
Layers overview
Guides



Deselect All Points

This option on the Point Handle pop-up menu deselects all point handles which are currently selected.



Deselecting all objects

Sometimes you may need to deselect every object in your drawing.
To deselect all objects

From the Edit menu, choose Clear Selection.

Tips
You can also press ESC (Escape).
You can also choose the Selector Tool and click on a blank area of the page.



Deselecting all point handles

Sometimes you may need to deselect all the point handles on the selected lines and shapes.
To deselect all point handles

1. Select the line or shape.
2. Choose the Shape Editor Tool.
3. Either:

CTRL-SHIFT-click on a selected point handle,
or SHIFT-click away from the line or shape.

Tip
If you are using the Pen Tool, SHIFT-click away from any lines and shapes to deselect all point handles.

_______________

{button ,KL(`tools,shape editor tool',0,`____No_Topics_Found',`')}    Related Topics



Deselecting objects

When you have selected objects and you no longer need them selected, you can deselect them all or deselect them one by one.

What do you want to do?
Deselect selected objects
Deselect all objects

_______________

Related Topics

Selecting objects
Selector Tool



Deselecting selected objects

If you have selected an object or several objects you can easily deselect one or more of the objects.
To deselect selected objects

1. Choose the Selector Tool (see Note).
2. SHIFT-click on each selected object to swap it from being selected to not being selected.

    SHIFT-Click to swap the object under the mouse pointer between selected and not selected

Note:
When creating bars and rollovers you can also use the Button & NavBar Tool.

_______________

{button ,KL(`tools,selector tool',0,`____No_Topics_Found',`')}    Related Topics



Displaying a document using the printer colors

Because printers use CMYK inks, there are limitations in the range of colors they can produce. It is not possible for a printer to 
exactly match all the colors that you can show on the screen. For example, the cyan shown on screen is a very light color, and 
typically comes out more of a sky blue shade when printed. Xara X can alter the colors displayed on screen to more closely match 
what you will see when the image is proofed. Note that turning this option on does not change any colors, it just shows them on 
screen so they look more like what will appear on paper.

Some software packages provide an array of complex options for correcting the color on the screen. Xara X uses one single option 
which applies in all circumstances. A screen and a printer are very different and it is never possible to see on the screen exactly 
what will appear on paper. Exact tuning of screen color correction is of very little benefit because it will never be that accurate.

To display a document using the printer colors
1. Click on the document so the title bar of the window is highlighted.
2. From the Window menu, choose Show Printer Colors.

Tips
Because this option can be set for each document, you could have two views on a document open where one uses 

regular colors and one uses the printer colors.
The Color Line, Color Gallery and Color Editor use the same setting as the selected document (the one with the 

highlighted title bar). If the selected document shows printer colors, so will the Color Line, Color Gallery and Color Editor.



Displaying and hiding control bars

You can turn any of the control bars off if you do not need them and you can also display other control bars.
To enable a control bar

1. From the Window menu, choose Control Bars.
2. In the dialog box, click the check box next to the control bar you want to display.

Tip
You can create your own, custom control bars. See Creating new control bars.



Displaying and hiding guides

Xara X uses two types of guide - guidelines and guide objects. Both live within the guides layer. To display or hide the guides you 
must display or hide the guides layer.

To display and hide guides

From the Window menu, choose Show Guides.

Tip
You can also use the Layer Gallery to make the guides layer visible or hidden. (see Hiding layers).

_______________

Related Topics

Layer Gallery
Layers overview
Guides



Displaying the Toolbar

The Toolbar displays all the tools available in Xara X. Usually it is always displayed but you might accidentally close it 
To display the Toolbar

1. Choose Control bars on the Window menu.
2. Select the check box to the left of Toolbar.

(If the check box is already selected, the Toolbar is hidden from view. Unselect and then select the check box to redisplay the 
Toolbar.)

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Displaying the grid

The grid is useful for aligning objects especially as you can make grid points magnetic.
To display the grid

From the Window menu, choose Show Grid.

Tips
You can also right-click on the page to open the pop-up menu and choose Show Grid.

_______________

{button ,KL(`grid',0,`____No_Topics_Found',`')}    Related Topics



Displaying the print borders

Before printing a document, you might want to turn on the print borders so they are shown on the screen. You can then see how 
your document will be printed and whether it fits on the page. Most printers cannot print right to the edges of the paper so there is 
usually an area around the edge of the page you cannot print onto.

To display the print borders
From the Window menu, choose Show Print Borders.

Tips
The yellow (and green on a double page spread) rectangle represents the extremes of the paper (This corresponds to the 

paper size defined in the Print Setup dialog) and the red (and blue on a double page spread) rectangle represents the area which 
can be printed.

The dark gray area around the outside is the area that will not be printed.
If no printer has been set up, no print borders are shown.
The print borders are not necessarily central on the paper (especially for ink jet printers).



Displaying the rulers

Rulers are optionally shown at the left and top of the window. 
To display the rulers

In the Window menu, open the Bars submenu and choose Rulers.

_______________
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 Document Info (File Menu)

Document Info on the File Menu opens the Document Information dialog box which displays information about the current 
document. It also contains a comments field which you can use to add a title, description and keywords to the document.

Location. The folder where the file is located.
File Name. The name given to the document.
Created. The time and date when the document was created.
Last Saved. The time and date when the document was last saved.
Memory Used. The total memory used by the document.
Undo Size. The amount of memory used by undo information. See Undo.
Undo Steps. The number of undo steps stored.
Number of Bitmaps. The total number of bitmap in the current document.
Bitmap Size. The amount of memory used by bitmaps in the current document.
Number of Fractals. The total number of fractal fills and fractal transparencies in the document.
Fractal Size. The amount of memory used by fractals
Number of Objects. The total number of objects in the document.
Number of Selected Objects. The total number of objects in the Selection.
Document Fonts. This drop-down list contains a full list of all the fonts contained in the document. If the document uses a 

font not currently installed on your PC, an asterisk ( * ) will appear next to the font name.
Comments. The comments field allows details about the file to be added to the document. It can also be used for adding 

keywords and a title to a file which is then displayed in the Clipart Gallery. Note that the first line of this field is stored as the 
description of the file and will be displayed in the Clipart Gallery if the file is added to it.

_______________

Related Topics

Adding descriptions to documents
Document information
Clipart Gallery



Downloading Items

This page describes downloading clipart, fills or fonts from our web site.

Setting up the Galleries

You only need to do this when you first install Xara X or if you want to check for new items on our web site.

You need to download the lists of items and associated thumbnails to set-up the gallery. Open the Font, Fill or Clipart gallery (as 
required) then click the Get Font/Get Fill/Get Clipart button. This starts the process of downloading. If you are a dial-up user, you 
may need to log on to the Internet first. This depends on who provides your Internet access.

When you are connected to our web site, the downloading starts. Xara X reports the progress of the download. Click Stop 
Download if you need to stop the download for any reason. You can get the remaining thumbnails later by repeating the Get 
process described above.

Downloading a file

When you want to use an item from the Font, Fill and Clipart Galleries:
1. Click on it to select it. 
2. Then 

in the Font Gallery click Apply or Install, 
in the Fill Gallery click Import or Open, 
in the Clipart Gallery click Import or Open. 

This starts downloading the selected item. Fonts download into your computer. Fills and clipart download into the document 
and are also stored in a cache (see below). 

Note:

You can download multiple items by:
1. Clicking on the first item to select it. 
2. Then 

 CTRL-clicking on another item to select that as well 
 or SHIFT-clicking to select a block of items. 

You can deselect individual items by CTRL-clicking on them. 
3. Downloading the selected items in the usual way. 

Loading multiple items is especially useful for dial-up users as some providers do not allow you to reconnect for several minutes 
after your last access. You can download fills and clipart that you think you'll want later; just delete them for the current document if 
you don't need them immediately. They remain in the cache (see below) and so are immediately available for use later. Fonts 
install on your computer and are available to Xara X and all other programs that use fonts.

The Cache

Fills and clipart download into an area on the disk called a cache. The cache contains the most recently used items. This means 
that these items are immediately available if you want to use them again; there's no need to download again.

You can change the size of the cache or flush its contents (if you become short of disk space). Use the Internet tab of the Options 
dialog box.

Tuning up Xara X's Internet settings

The Internet tab of the Options dialog box lets you configure Xara X for the fastest downloads for your type of Internet connection. 
If you are not sure which settings to use we recommend the defaults; these should give satisfactory (if not optimal) results. If you 
are connected to a network, you may need to ask your systems administrator which settings to use.



Drawing a light source

Bleach transparency type is ideal for drawing bright light sources.
To draw a light source

1. Draw a large rectangle covering the entire drawing (see Drawing rectangles & squares).
2. Flat fill it with the required light source color (see Changing an object’s fill color).
3. The rectangle should already be selected. If not, select it.
4. Choose the Transparency Tool.
5. Change the transparency type to Bleach.
6. Apply a circular transparency to the rectangle (see Applying circular transparency).
7. Clone the rectangle (this improves the look of the effect) and group with the original. 

Tip
Cover the whole drawing with the rectangle containing the light source. This lets you experiment with which area of the 

drawing is affected by the light source.

_______________

Related Topics

Transparency Tool
Copying objects
Grouping objects



Drawing and Animation Documents

Xara X has two types of document:
Drawing documents which are suitable for most types of drawing
Animation documents which are suitable for animated GIFs.

You decide the type when you create the document. See Creating new documents.

Tips
Documents are created from templates. You create and modify templates to your own requirements. See Creating a 

template document.
You cannot convert documents from one type to another. What you can do is create a new document of the correct type 

and then copy objects into it.



Drawing concentric QuickShapes

Creating concentric circles is simple in Xara X. Although this describes creating concentric circles, this works equally well for 
concentric polygons and rectangles.

To draw concentric circles

1. Choose the Ellipse Tool.
2. CTRL-drag to create a circle. (CTRL constrains the ellipse to a circle). See Drawing ellipses and circles.
3. Choose the Contour Tool.
4. Drag one of the eight handles around the object to create the contour. See Creating a contour.
5. Use the Contour Tool to change the number of steps and other settings.

_______________

Related Topics

Ellipse Tool
Contour Tool



Drawing ellipses and circles

You can draw ellipses and circles using either the Ellipse Tool or the QuickShape Tool. (The Ellipse Tool is generally more 
convenient to use.)

To draw an ellipse or circle
1. Choose the Ellipse Tool or QuickShape Tool. (If you use the QuickShape Tool, click the Ellipse button on the QuickShape Tool 

Infobar)
2. To draw an ellipse select the Bounds Creation Button on the Infobar. Drag diagonally to create the ellipse.

3. To draw a circle select either
Click the Radius Creation Button on the Infobar. Create the circle by dragging from the center outwards.
Click the Diameter Creation Button on the Infobar. Create the circle by dragging across the diameter of the circle.

Tips
Holding down CTRL during a By Bounds drag creates a circle instead of an ellipse.
Holding down SHIFT during the drag forces creation from the center of the ellipse or circle.

Movie

{button ,EF("XaraDemo.exe","ellipses Ellipses and Circles",1,`') } Drawing ellipses and circles

_______________
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QuickShapes overview
Ellipse Tool
QuickShape Tool



Drawing lines

You can use the Pen, Shape Editor or Freehand & Brush Tools to draw lines.
The Shape Editor Tool is the most flexible and can also edit lines.
The Pen Tool is provided for users familiar with programs such as CorelDRAW and Adobe Illustrator.
The Freehand & Brush Tool lets you draw and edit lines by following freehand mouse movements. You can also use the 

Freehand & Brush Tool to apply brush strokes and stroke shapes to lines.

What do you want to do?
Draw a line with the Shape Editor Tool
Draw a line with the Pen Tool
Draw a line with the Freehand & Brush Tool

_______________

Related Topics

Drawing shapes
Shapes and Lines overview



Drawing lines with the Freehand & Brush Tool

The Freehand & Brush Tool lets you draw lines that follow the movements of the mouse.
To draw a line with the Freehand & Brush Tool

1. Choose the Freehand & Brush Tool.
2. Move the mouse pointer to where you want the line to start.
3. Drag the mouse to draw a line.
4. Release the mouse button to complete the line.

Important: line drawing stops as soon as you release the mouse button.

As you are drawing the line you can do the following:
Draw straight lines sections

            Erase part of the freehand line
            Create a shape by ending the line over the start point. A ‘+’ by the mouse pointer shows when you are over the start point.

Tips
If you want to change the thickness of the line, see Changing line thickness.
The final line can follow every movement of the mouse or be a smooth following line. This is called smoothing the line. 

See Smoothing a freehand line.

Movie

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

_______________

Related Topics

Freehand & Brush Tool
Lines



Drawing lines with the Pen Tool

The Pen Tool has limited functionality but will be familiar to users of packages such as CorelDRAW.
To draw a line with the Pen Tool

1. Choose the Pen Tool
2. Move the mouse pointer to where you want the line to start. Click to start the line.
3. Move the pointer to the next position along the line.
4. Either:

 drag to add a curved segment and shape it,
 or click to add a straight segment.

5. Repeat step 4 as necessary.
6. Complete the line with a SHIFT-click.

Tips
If you want to change the thickness of the line, see Changing line thickness.
You can create a shape by ending the line over the start point. A ‘+’ by the mouse pointer shows when you are over the 

start point.
You cannot use the Pen Tool to change the shape of lines. For this use the Shape Editor Tool or Freehand & Brush Tool.
You can also create lines using the Shape Editor Tool. This has more features and you may find it easier to use.

Movie

{button ,EF("XaraDemo.exe","PenDraw Drawing Lines and Shapes with the Pen Tool",1,`') } Drawing lines with the Pen 
Tool

_______________
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Pen Tool
Lines



Drawing lines with the Shape Editor Tool

The Shape Editor is the main tool for creating and editing lines and shapes.
To create a line with the Shape Editor Tool

1. Ensure no lines or shapes are selected (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Move the mouse pointer to where you want to start the line. Click to create a point handle.
4. Move the pointer to the next position around the line. Click again. This draws a line segment between the two points.
5. Repeat step 4 as necessary to draw the complete line.

As you are drawing the shape:
To create a straight line segment, first click the Straight lines button on the Shape Editor Tool Infobar (or press S).
To create a curved line segment, first click the Curved lines button on the Infobar (or press C). 

Tips
If you do not deselect lines and shapes in step 1, you might accidentally extend an existing line. See Extending lines.
You can adjust the line by dragging the point handles either as you draw or after you finish.
Holding down CTRL as you drag, constrains movement of the handle to certain angles. For information on changing the 

constrain angle, see Changing the constrain angle. 
You can create a shape by ending the line over the start point. A ‘+’ by the mouse pointer shows when you are over the 

start point.
If you want to change the thickness of the line, see Changing line thickness.

Movie

{button ,EF("XaraDemo.exe","CurvDraw.avi Drawing Lines and Shapes with the Shape Editor Tool",1,`') } Drawing lines 
with the Shape Editor Tool

_______________

Related Topics

Shape Editor Tool
Lines



Drawing motion blur

Drawing motion blur with Xara X is easy!
To draw motion blur

1. Draw the object to be blurred (see Drawing shapes).
2. Clone the object (see Copying objects).
3. Apply a flat transparency of (for example) 85% to the clone (see Applying flat transparency).
4. Clone the transparent object.
5. Move the new object in the blur direction (see Moving objects).
6. Alter the transparency of the second object to be almost 100%.
7. Blend between the two transparent objects (see Blending objects).
8. Increase the number of blend steps as required (see Changing the number of steps in a blend).



Drawing parallel lines

Parallel lines have many uses for drawings such as maps. You can easily create accurate, parallel lines using Xara X.
To create parallel lines

1. Draw a line along the path of the parallel lines. See Drawing lines.
2. Set it to the color (red in the example) you want the two lines. See Coloring objects.
3. Set its line thickness. See Changing line thickness. The thickness should be the width across the two parallel lines. That is, the 

width of the two parallel lines plus the gap between them.
4. Clone the line. See Copying objects.
5. Set the line color of the clone to the background color. (White in the example.)
6. Reduce the line thickness of the clone to that of the gap between the parallel lines.

Tip
Group the two lines so they always move together. See Grouping objects.



Drawing polygons

The QuickShape Tool lets you create regular polygons quickly and easily. To create an irregular polygon, see Drawing shapes.
To draw a polygon

1. Choose the QuickShape Tool.
2. Set the required number of sides in the Number of sides field on the QuickShape Tool Infobar. (If there are any QuickShapes 

selected, press ESC first to deselect them.)
3. To draw a non-symmetrical polygon, select the Bounds Creation Button on the Infobar. Drag diagonally to create the polygon. 
      To draw a symmetrical polygon select either

 the Radius Creation Button on the Infobar . Create the polygon by dragging from the center outwards.

 the Diameter Creation Button on the Infobar. Create the polygon by dragging across the diameter of the polygon.
4. If you want the polygon to have rounded corners, click the Curved Corners button on the Infobar.

Tips
Hold down CTRL during a radius and diameter drags to constrain the polygon to multiples of the constrain angles. To 

change the constrain angle, see Changing the constrain angle.
Hold down CTRL during a bounds drag to create a symmetrical polygon.
Hold down SHIFT during the drag to create the polygon from the center outwards.
It may be more convenient to use the Rectangle Tool to create rectangles and squares.

_______________

Related Topics

Polygons
QuickShape Tool
Rectangle Tool



Drawing rectangles and squares

You can draw rectangles and squares using either the Rectangle Tool or the QuickShape Tool. (The Rectangle Tool is generally 
more convenient to use.)

To draw a rectangle or square
1. Choose the Rectangle Tool or QuickShape Tool. (If you use the QuickShape Tool, click the Polygon button on the QuickShape 

Tool Infobar and set the Number of sides field to 4.)
2. To draw a rectangle select the Bounds Creation Button on the Infobar. Drag diagonally to create the rectangle.
      To draw a square select either

 the Radius Creation Button on the Infobar. Create the square by dragging from the center outwards.

 the Diameter Creation Button on the Infobar. Create the square by dragging across the diagonal of the square.

Tips
Holding down CTRL during Radius and Diameter drags constrains the polygon to multiples of the constrain angles. To 

change the constrain angle, see Changing the constrain angle.
Holding down CTRL during a By Bounds drag creates a square instead of a rectangle.
Holding down SHIFT during the drag forces creation from the center of the rectangle or square. 

_______________

Related Topics

Rectangle Tool
QuickShape Tool
QuickShapes
Rectangles
Squares



Drawing shapes

You can use the Pen, Shape Editor or Freehand & Brush Tools to draw shapes.
The Shape Editor Tool is the most flexible and accurate. You can also edit lines and shapes with it.
The Freehand & Brush Tool lets you draw and edit shapes by following freehand mouse movements.
The Pen Tool is provided for users familiar with programs such as CorelDRAW and Adobe Illustrator.

What do you want to do?
Draw a shape with the Shape Editor Tool
Draw a shape with the Freehand & Brush Tool
Draw a shape with the Pen Tool

Tip
You can draw rectangles and squares using the Rectangle Tool; ellipses and circles using the Ellipse Tool and regular 

polygons and stars using the QuickShape Tool.

_______________

Related Topics

Shapes
Lines and shapes



Drawing shapes with the Freehand & Brush Tool

The Freehand & Brush Tool lets you draw shapes that follow the movements of the mouse.
To draw a shape with the Freehand & Brush Tool 

1. Choose the Freehand & Brush Tool.
2. Move the mouse pointer to where you want the line to start.
3. Drag the mouse to draw a line.
4. Release the mouse button over the start of the line to complete the shape. A ‘+’ by the mouse pointer shows when you are over 

the start point.

Important: line drawing stops as soon as you release the mouse button.

As you are drawing the outline of the shape you can do the following:
Draw straight lines sections

            Erase part of the freehand line

Tip
The final line can follow every movement of the mouse or be a smooth following line. This is called smoothing the line. 

See Smoothing a freehand line.

Movie

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

_______________
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Shapes
Lines and shapes
Freehand & Brush Tool



Drawing shapes with the Pen Tool

The Pen Tool has limited functionality but will be familiar to users of packages such as CorelDRAW. You can use it to draw and 
change lines and shapes.

To draw a line with the Pen Tool 
1. Choose the Pen Tool
2. Move the mouse pointer to where you want to start drawing. Click to create a point handle.
3. Move the pointer to the next position around the edge of the shape.
4. Either:

 drag to add a curved segment and shape it,
 or click to add a straight segment.

5. Repeat steps 3 and 4 as necessary to draw the outline of the shape.
6. To complete the shape click on the start point. A ‘+’ by the mouse pointer shows when you are over the start point. 

Tips
You cannot use the Pen Tool to change the shape of the line. For this use the Shape Editor Tool or Freehand & Brush 

Tool.
You can also create shapes using the Shape Editor Tool. This has more features and you may find it easier to use.

Movie

{button ,EF("XaraDemo.exe","PenDraw Drawing Lines and Shapes with the Pen Tool",1,`') } Drawing lines with the Pen 
Tool

_______________
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Shapes
Lines and shapes
Pen Tool



Drawing shapes with the Shape Editor Tool

The Shape Editor is the main tool for creating and editing shapes.
To create a shape with the Shape Editor Tool

1. Ensure no lines or shapes are selected (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Move the mouse pointer to where you want to start drawing. Click to create a point handle.
4. Move the pointer to the next position around the edge of the shape. Click again. This draws a line segment between the two 

points.
5. Repeat step 4 as necessary to draw the outline of the shape.
6. To complete the shape click on the start point. A ‘+’ by the mouse pointer shows when you are over the start point.

As you are drawing the shape:
To create a straight line segment, first click the Straight lines button on the Shape Editor Tool Infobar (or press S).
To create a curved line segment, first click the Curved lines button on the Infobar (or press C). 

Tips
If you do not deselect lines and shapes in step 1, you might accidentally extend an existing line. See Extending a line.
You can adjust the shape by dragging the point handles either as you draw or after you finish. If you move an intermediate 

point handle during drawing, see Extending a line for how to complete the line.
Holding down CTRL as you drag, constrains movement of the handle to certain angles. For information on changing the 

constrain angle, see Changing the constrain angle.
In step 6 you can also press RETURN to complete the shape.

Movie

{button ,EF("XaraDemo.exe","CurvDraw.avi Drawing Lines and Shapes with the Shape Editor Tool",1,`') } Drawing lines 
with the Shape Editor Tool

_______________
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Shapes
Lines and shapes
Shape Editor Tool



Drawing star-shaped polygons

The QuickShape Tool lets you create starred polygons quickly and easily. 
To draw a starred polygon

1. Choose the QuickShape Tool.
2. Click on the Star button on the QuickShape Tool Infobar (If there are any QuickShapes selected, press ESC first to deselect 

them.) 
3. To draw a non-symmetrical polygon, select the Bounds Creation button on the Infobar. Drag diagonally to create the polygon. 

To draw a symmetrical polygon select either

 the Radius Creation button on the Infobar . Create the polygon by dragging from the center outwards.

 the Diameter Creation button on the Infobar. Create the polygon by dragging across the diameter of the polygon.
4. If you want the polygon to have rounded corners, click the Curved Corners button on the Infobar.

Tips
Hold down CTRL during a radius and diameter drags to constrain the polygon to multiples of the constrain angles. To 

change the constrain angle, see Changing the constrain angle.
Hold down CTRL during a bounds drag to create a symmetrical polygon.
Hold down SHIFT during the drag to create the polygon from the center outwards.

_______________
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Polygons
QuickShape Tool



Drawing straight lines with the Freehand & Brush Tool

Normally the Freehand & Brush Tool draws a line that follows movements of the mouse. You can also draw straight sections of 
line.

Drawing straight lines with the Freehand & Brush Tool
1. Press ALT during the drag
2. Move the mouse pointer to the end of the straight section and release ALT. (To help you, the straight line is shown on screen 

while the ALT key is pressed.) 

You can then continue drawing the freehand line. Remember not to release the mouse button!

Tip
To constrain the straight line to the constrain angles, press CTRL+ALT. To change the constrain angle, see Changing the 

constrain angle. 

_______________
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Freehand & Brush Tool
Lines



 Duplicate (Edit Menu)    CTRL+D

Duplicate creates a copy of the selection a certain distance from the original. After the copy has been created, it is selected and 
the original deselected. 

Tips
To duplicate an object quickly, right-click on it to open the pop-up menu and choose Duplicate.
For information on how to change the distance, see Changing the duplication distance.

_______________
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EPS Export Dialog Box

The Xara X EPS Export dialog box allows you to control various characteristics of the EPS you export from Xara X. For more 
information on Xara X EPS, see the Xara X EPS Overview.

PostScript Language Level
Resolution
Export Text As Curves



EPS Export Dialog Box - Export Text As Curves
If the printer you are sending the PostScript to does not support all the fonts in your document, select this option. It converts all your text to simple shapes before creating the file. This means the text prints in the correct font, but you may find small text does not print as well.



EPS Export Dialog Box - PostScript Language Level
You can export Xara X EPS at PostScript Level 1 or Postscript Level 2. Normally you would use Automatic which outputs PostScript which will run on Level 1 interpreters, but which will take advantage of Level 2 interpreters. If you know your printer support Level 2 PostScript, select Level 2 (printing will be faster). Use Level 1 if difficulties occur with printing PostScript (this option is rarely needed).



EPS Export Dialog Box - Resolution
As PostScript does not support transparency, areas containing transparent objects are output as bitmaps. The resolution setting allows you to set the resolution used for these transparent areas and for any bitmaps in the document.



EPS Overview

You can export Xara X EPS files using Export on the File menu. Xara X EPS files are placeable EPS or a printing form of EPS. 
This form of EPS is intended to be sent directly to a PostScript printer, to be sent to a separating program for typesetting, or to be 
embedded in another application's files for downloading to a PostScript printer when that file is printed. Note hat this is not a 
suitable format for transferring drawings between programs.

PostScript Language Level

You can export Xara X EPS at PostScript Level 1 or Postscript Level 2. When you export the EPS file, you can choose Level 1, 
Level 2 or Automatic. The default is 'Automatic' which outputs PostScript which will run on Level 1 interpreters, but which will take 
advantage of Level 2 interpreters. Set the Level 2 option if you are sure your PostScript interpreter is Level 2 - this may result in 
faster printing, especially if your document uses bitmaps and/or transparency heavily. The Level 1 setting should be used if 
difficulties occur with printing PostScript, but should rarely, if ever, be needed, due to the auto-detection systems used by the 
'Automatic' setting. If in doubt, use the automatic setting.

Exporting bitmaps, bevels, shadows and transparency

If your drawing contains bitmaps, bevels, shadows, or transparency, Xara X stores bitmap data in the file when exporting as Xara 
X EPS (PostScript does not support transparent objects). You can control the resolution of this bitmap data. It defaults to 200 
pixels per inch. If you find this is not right, you can override this with a manual setting. Bitmap resolution is always measured in 
pixels per inch (or dots per inch if you prefer). Xara X will not let you export bitmap data in an EPS file at more than 600 pixels per 
inch, whatever method you choose. This is because 600 dots per inch is very high resolution indeed and can produce very large 
EPS files - any higher resolution is unnecessary. 300 dpi should be considered a practical maximum for exporting bitmap data to 
EPS.

Fonts

When exporting text objects in EPS files, there is the usual PostScript problem of font matching to consider. If you are using fonts 
in your document that you know or think your typesetter/printer does not have, then you can choose to export all text as shapes. 
This means all text objects will be accurately printed when the EPS is printed. However, because the text is now sent as shapes 
and not using a proper PostScript font, you may find that small text does not print well, due to lack of hinting. If this is the case, 
disable printing of text as shapes, and solve the problem using font mapping.

Some programs (such as Quark XPress) do not warn you about missing fonts - always check the printed output carefully.

Font mapping

When exporting EPS, Xara X uses a font mapping table to convert TrueType font names to PostScript font names. The most 
common font names are built in to Xara X's font mapping table, but you may add your own, if you know the name of a font that 
your typesetter/printer has, and you know which of your TrueType fonts it resembles. 

To edit Xara X's font mapping table, you must edit the registry. Do this only if you know how to edit registry values. To edit the 
font mappings, type regedit at the command prompt to open the Registry Editor. Open 
HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\EPSFontMapping\    (where XX is the version of Xara X you 
use) and add a new Value with the name of the TrueType font. Set the Data to the name of the PostScript font. The font mappings 
will look something like this:

Times-New-Roman "Times-Roman"

Times-New-Roman-Bold "Times-Bold"

Times-New-Roman-Italic "Times-Italic"

Times-New-Roman-BoldItalic "Times-BoldItalic"

Courier-New "Courier"

Courier-New-Bold "Courier-Bold"

<... rest of table deleted for simplicity...>

The font mapping is simple - the TrueType name is on the left, and the PostScript name is on the right. You can add as many new 
mappings as you like, however bear in mind the following points:

TrueType names often contain spaces - replace these with dashes when specifying these in font mappings - for example, 
"Times New Roman" has been changed to "Times-New-Roman" in the excerpt shown above.

You will need to map bold and italic variations explicitly, due to the way PostScript font names work. Again, as you can tell 
from the examples above, bold variations have "-Bold" added to the end, and italic versions have "-Italic" added to the end. If the 
font is both bold and italic, it has "-BoldItalic" added to the end, and NOT "-Bold-Italic", "-ItalicBold", "-Italic-Bold" or any other 
permutations.

Here are some examples:

Mapping the TrueType font "ZapfDingbats BT" to the PostScript font "ZapfDingbats":

ZapfDingbats-BT "ZapfDingbats"

Mapping the TrueType font "Avanti" to the PostScript font "AvantGarde":

Avanti "AvantGarde-Demi"

Avanti-Italic "AvantGarde-DemiOblique"

Avanti-Bold "AvantGard-Bold"

Avanti-BoldItalic "AvantGard-BoldOblique"

Mapping the TrueType font ZapfChancery to the PostScript version:



ZapfChancery "ZapfChancery-MediumItalic"

Mapping the TrueType font Michael to the PostScript font Palatino:

Michael "Palatino-Roman"

Michael-Bold "Palatino-Bold"

Michael-Italic "Palatino-Italic"

Michael-BoldItalic "Palatino-BoldItalic"



Edit Brush Dialog Box - Fill Properties Tab

These are miscellaneous options.

Local colors replace

The designer of the brush can use either local colors or named colors when creating the brush. The following options control what 
happens when you apply a new line color.

All brush colors
Applying a new line color changes all the colors in the brush.

Named brush colors
Applying a new line color changes any named colors in the brush. Local colors do not change.

No brush colors
You cannot change the colors of the brush objects.

Tile fills

If the brush design includes a bitmap fill you have the option of:
(option off) treating each brush repeat as a separate set of objects. The fill appears as in the original brush design.
(option on) treating the entire line as a single object. The fill tiles across the entire line.

The difference is most obvious along a curved line. With the option off, the bitmap aligns with the line. With the option on, the 
bitmap repeats horizontally and ignores the curvature of the line.

Random color changes

These two sliders let you apply random color changes to the brush.
Saturation

The slider controls the minimum saturation. (Saturation is the amount of white in the color.) Has no effect on black objects.
Hue

The slider controls the color shift around the HSV color wheel. Has no effect for black, white, or gray colors.
 Save/Save as new/Close

_______________

{button ,KL(`brush strokes',0,`____No_Topics_Found',`')}    Related Topics



Edit Brush Dialog Box - Offset Tab

These options let you alter the distance between the original line and objects in the brush.

Direction from line

Select from the drop-down list. You have options for: on the line; to one side; alternately either side; or randomly arranged either 
side.

Distance

Controls the distance from the original line to the first brush object. Dimmed if On line selected. The distance of the other objects 
is controlled by the Adding and Random controls.

Random

Gives a random distance from the line. The slider limits the distance; for example, 50-200% limits the distance to between 50% to 
200% of the original value.

Randomize

Generate a new random set of distances. If you prefer the previous values, click Undo.
 Save/Save as new/Close

_______________
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Edit Brush Dialog Box - Rotation Tab

These options let you control the rotation of objects in the brush as they follow the line.

Rotate along the line

With this option selected, the brush objects follow the curvature of the line. When deselected, all the objects have the same 
orientation.

Brush angle

Sets the angle of the objects.

Rotation changes by:
Adding

Gives an increasing rotation angle between objects by adding the value to the previous angle For example 10% increases 
the angle by 10% of the original value. For example, if the original value is 30 degrees, following angles are 33º (10% of 
30º), 36º, 39º and so on.

Random
Gives a random rotation between objects. The slider limits the rotation; for example, 50-200% limits the rotation to between 
50% to 200% of the original value.

Randomize

Generate a new random set of angles. If you prefer the previous values, click Undo.
 Save/Save as new/Close

_______________
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Edit Brush Dialog Box - Scaling Tab

These options let you progressively increase or decrease the size of objects in the brush. Use Line width to set the basic size of 
the objects.

Scaling changes by:
Random

Gives a random scaling change between objects. The slider limits the difference; for example, 50-200% limits the scaling to 
between 50% to 200% of the original size.

Pressure
This has an effect only when using a pressure-sensitive input device such as a graphics tablet. The scaling    is controlled by 
the pressure you applied when creating the line.

Randomize
Generate a new random set of scaling changes. If you prefer the previous values, click Undo.

 Save/Save as new/Close

_______________
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Edit Brush Dialog Box - Spacing Tab

These options let you alter the spacing between objects in the brush. In all cases 100% is the spacing intended by the designer of 
the brush.

Spacing

Give regular spacing. For example 110% spaces each object at 110% of its original distance.

Random

Gives a random distance between objects. The slider limits the distance; for example, 50-200% limits the distance to between 50% 
to 200% of the original distance.

Sequence progresses

Suppose you have a brush design of -->. 
Forward: the line looks like -->-->-->
Backward: the line looks like <--<--<--
Mirror: the line looks like --><----> (alternative designs reversed)
Random: random reverses.

Randomize

Generate a new random set of distances or sequence changes. (This button applies to both Random options.) If you prefer the 
previous values, click Undo.
 Save/Save as new/Close

_______________
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Edit Brush Dialog Box - Transparency Tab

Flat transparency also changes the transparency of the line. (Other transparency types have no effect on the line.) You can also 
use semitransparent objects in creating the brush. These sliders let you override any transparency applied to the brush.

Transparency 
0% - no change
positive values - increase the transparency. Has no effect on any fully transparent objects.
negative values - decrease the transparency. Affects only to transparent or semitransparent objects.

Pressure
This has an effect only when using a pressure-sensitive input device such as a graphics tablet. The transparency    is controlled 
by the pressure you applied when creating the line. the slider sets the range within which transparency can vary.

 Save/Save as new/Close

_______________
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Edit Brush Dialog Box

This dialog box lets you edit the brush stroke of a line. You can: (a) change just the selected line, (b) change the selected line (if 
any) and the current brush, or (c) the selected line (if any) and create a new brush.

Spacing Tab
Offset Tab
Scaling Tab
Rotation Tab
Transparency Tab
Fill Properties Tab

 Save/Save as new/Close

Movie

{button ,EF("XaraDemo.exe",`EdBrush Editing a Brush',1,`') } Editing a Brush

_______________
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Edit Control Bar

Cut
Copy

Paste

Paste Attributes

Paste in Same Position
Delete

Select All
Clear Selection

Duplicate
Clone

_______________
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Edit Menu

Undo
Redo
Cut
Copy
Paste
Paste Attributes
Delete
Select All
Clear Selection
Duplicate
Clone



Save as new

Create a new brush. This leaves the original brush unchanged.

Save

Update the selected brush with these changes. If you have edited one of the default brushes, clicking Save creates a new brush in 
the document.

Close

Any changes apply only to the selected line (if any). This leaves the original brush unchanged.

Notes:
Xara X saves only brushes used in the document. It discards unused brushes when you quit the program. To ensure a 

brush always gets saved, draw a line in the gray pasteboard area and apply the brush to that line. (Items in the pasteboard area are 
non-printing.)

To edit or add to the default set of brushes, see this page.



Locking a color (Create Bitmap Copy)

(Up to 256 color formats)

You can specify the number of colors you want in the palette of bitmaps. You may want to ensure that certain colors always appear 
in the palette; you can Lock these colors.

To lock a color
1. The Create Bitmap Copy dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select 

it.
2. Select the Lock button. A small square appears in the bottom left of the color to tell you it is a locked color.

Notes:
For more information on the Create Bitmap Copy dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________

Related Topics

Editing colors (Create Bitmap Copy)



Locking a color (bitmap export)

(GIF, BMP & PNG, up to 256 colors)

You can specify the number of colors you want in the palette of exported bitmaps. You may want to ensure that certain colors 
always appear in the palette; you can Lock these colors.

To lock a color
1. The Bitmap Export dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select it.
2. Select the Lock button. A small square appears in the bottom left of the color to tell you it is a locked color.

Notes:
For more information on the Bitmap Export dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________

Related Topics

Editing colors (bitmap export)



Editing a color (Create Bitmap Copy)

This gives you full control over the colors in the bitmap copy. You may for example want to exactly match the color of your web 
page background.

To edit a color
1. The Create Bitmap Copy dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on an entry to select 

it.
2. Type in new values for the color (Value:). A small square appears in the bottom right of the color to tell you it has been edited.

Notes:
You can define colors in RGB as hex (0-FF), 0-255, or 0-100%, or HSV. Use whichever you find easiest: the available 

range of colors is identical in all cases.
For more information on the Create Bitmap Copy dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________

Related Topics

Editing options (Create Bitmap Copy)



Editing a color (bitmap export)

(GIF, BMP & PNG, up to 256 colors)

This gives you full control over the colors in the exported bitmap. You may for example want to exactly match the color of your web 
page background.

To edit a color
1. The Bitmap Export dialog box displays the color palette of the bitmap. (Color Depths up to 256-color only.) Click on a color in 

the palette to select it.
2. Type in new values for the color (Value:). A small square appears in the bottom right of the color to tell you it has been edited.

Notes:
You can define colors in RGB as hex (0-FF), 0-255, or 0-100%, or HSV. Use whichever you find easiest: the available 

range of colors is identical in all cases.
For more information on the Bitmap Export dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________
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Editing options (bitmap export)



Deleting a color (Create Bitmap Copy)

(Up to 256-color formats)

For web pages you want graphics that download quickly, which means making the files small. One way to do this is to reduce the 
number of colors used in the palette. In the Create Bitmap Copy dialog box you can either:

type a new value into the Colors used field. This deletes the least used colors.
or selectively delete colors.
To selectively delete a color

1. The Create Bitmap Copy dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select 
it.

2. Click the Delete button. A cross appears in the color to tell you it has been deleted.
To undelete a color

This restores a color deleted by reducing the number of colors in the palette.
1. Click on the color to select it.
2. Click the Restore button.

Notes:
For more information on the Create Bitmap Copy dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________

Related Topics

Editing colors (Create Bitmap Copy)



Deleting a color (bitmap export)

(GIF, BMP & PNG, up to 256 colors)

For web pages you want graphics that download quickly, which means making the files small. One way to do this is to reduce the 
number of colors used in the palette. In the Bitmap Export dialog box you can either:

type a new value into the Colors used field. The least used colors are deleted.
or selectively delete colors.
To selectively delete a color

1. The Bitmap Export dialog box displays the color palette of the bitmap. (Color Depths up to 256-color only.) Click on a color in 
the palette to select it.

2. Click the Delete button. A cross appears in the color to tell you it has been deleted.
To undelete a color

This restores a color deleted by reducing the number of colors in the palette.
1. Click on the color to select it.
2. Click the Restore button.

Notes:
For more information on the Bitmap Export dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________
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Editing colors (bitmap export)



Make a color transparent (Create Bitmap Copy)

(Up to 256-color formats only)

These formats can have transparent areas in the bitmap. This is done by making one of the entries in the color palette a special 
"transparent" color. (So a 16-color bitmap with transparency contains 15 colors plus transparency.)

To make a color transparent
1. The Create Bitmap Copy dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select 

it.
2. Click the Make transparent button. A small square appears in the top left of the color to tell you it is transparent. Any parts of 

the bitmap that use this color become transparent.

Notes:
You can make multiple palette entries transparent.
There is a more advanced type of graduated transparency called "alpha-channel" rather than this simple on-off 

transparency. True-color with alpha-channel transparency is an option on the Color depth list on the Create Bitmap Copy dialog 
box.

For more information on the Create Bitmap Copy dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________
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Editing colors (Create Bitmap Copy)



Make a color transparent (bitmap export)

(GIF, & PNG up to 256 colors only)

These formats can have transparent areas in the bitmap. This is done by making one of the entries in the color palette a special 
"transparent" color. (So a 16-color GIF or PNG with transparency contains 15 colors plus transparency.)

To make a color transparent
1. The Bitmap Export dialog box displays the color palette of the bitmap. (Color Depths up to 256-color only.) Click on a color in 

the palette to select it.
2. Click the Make transparent button. A small square appears in the top left of the color to tell you it is transparent. Any parts of 

the bitmap that use this color become transparent.

Notes:
A separate button (make background transparent) makes the background transparent. (The background is any areas 

not covered by the selected objects.) This is the usual type of transparency but the Make transparent option gives you full control. 
You could for example use it to create cut-outs in the exported bitmap.

In Xara X you can make multiple palette entries transparent. However PNG & GIF files can have only one transparent 
palette entry so Xara X merges together all transparent entries when exporting the file. Thus, if the palette in this dialog box contains 
five colors and three transparent entries, the exported bitmap palette contains six entries: the same five colors and one transparent 
entry.

PNG (true-color) has a more advanced type of graduated transparency called "alpha-channel" rather than this simple on-
off transparency. True-color with alpha-channel transparency is an option on the Color depth list on the Bitmap Export dialog box.

For more information on the Bitmap Export dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________

Related Topics

Editing colors (bitmap export)



Making a color web-safe (Create Bitmap Copy)

(Up to 256-color formats, optimized palette only)

Both Netscape Navigator and Microsoft Internet Explorer have a common palette of 216 colors (called the "web-safe" colors). 
When displayed in 256-color screen modes, these colors are not dithered and so look better than dithered colors. This is 
particularly important for large areas of flat color. (Dithering uses a pattern of colored dots to give the illusion of extra colors.)

To make a color web-safe
1. The Create Bitmap Copy dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select 

it.
2. Select the Web safe button. A small square appears in the center of the color to tell you it is web-safe.

Notes:
For more information on the Create Bitmap Copy dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________
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Editing colors (Create Bitmap Copy)



Making a color web-safe (bitmap export)

(GIF, BMP & PNG, up to 256 colors; optimized palette only)

Both Netscape Navigator and Microsoft Internet Explorer have a common palette of 216 colors (called the "web-safe" colors). 
When displayed in 256-color screen modes, these colors are not dithered and so look better than dithered colors. This is 
particularly important for large areas of flat color. (Dithering uses a pattern of colored dots to give the illusion of extra colors.)

To make a color web-safe
1. The Bitmap Export dialog box displays the bitmap palette. (Color Depths up to 256-color only.) Click on a color to select it.
2. Select the Web safe button. A small square appears in the center of the color to tell you it is web-safe.

Notes:
For more information on the Bitmap Export dialog box click the Help button on this dialog box.
You can also select a color using the Color Selector (the "eye-dropper"). Click on the required color in the Preview 

window.

_____________
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Editing colors (bitmap export)



Editing brushes

See also Changing the brush design.

Brushes let you apply patterns to lines and the outlines of shapes. The Line Gallery and the Freehand & Brush Tool have a wide 
selection of predefined brushes or you can create your own. You can edit existing brushes either to modify them or to extend the 
range of brushes available to you.

To edit a brush
1. Make sure there are no selected objects - see Deselecting objects.
2. Select the Freehand & Brush Tool.
3. Select the brush you want to edit from the Select brush drop-down list.
4. Click Edit brush.
5. Make the required changes to the brush - details of available options.
6. To save the changes click Save/Save as new/Close

Note
In step 1 you can also click on a line or shape that uses the brush you want to edit.

Movie

{button ,EF("XaraDemo.exe",`EdBrush Editing a Brush',1,`') } Editing a Brush

_______________

{button ,KL(`brush strokes',0,`____No_Topics_Found',`')}    Related Topics



Editing colors in CMYK

Normal colors and linked colors can be edited in several color models. One of these is CMYK.
To edit a color in CMYK

1. Choose Color Editor from the Utilities menu.
2. Choose the color you want to edit from the menu or drag-and-drop it onto the editor.
3. Right-click on the Color Editor and select CMYK.

When editing a color using the CMYK color model, the Color Editor can be used in two modes:

This mode displays the four component colors as bars (Cyan, Magenta, Yellow and Key (black)). To alter the level of each color, 
drag the marker or type values into the fields below the bars.

This mode displays a slice through a color cube. The small arrow button to the top of the cube changes the component on the 
diagonal axis of the cube, much like rotating it. The small color strip on it indicates the diagonal component.

On the right-hand side of the cube slice is the Key bar, ranging from 0% Key (no black) to 100% Key (black).

To edit the color, drag the marker on the slice, or drag the slice using the handle on the diagonal and move the marker on the Key 
color bar. When the marker on the cube slice is being dragged, the CTRL key can be held down to constrain its movement to 
horizontal and vertical.

The mode used is set using the 3D button. Deselect it for slider editing, select it for color cube editing. Use the mode you find most 
intuitive.

Note

If you are editing a linked color, some of the values will be constrained by white boundaries (shown on the editing area) depending 
on the inheritance scheme in use.

The values can be edited in one of two units, percentages (0% to 100%) or values (0 to 255). Which is used is set by the Color 
Units setting, see Changing the color units. If you need to enter a value in the other format, you can force the units by typing (for 
example) "25%" (for a percentage) or "25d" (for 0 to 255 value).

_______________
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Editing colors in HSV

Normal colors and linked colors can be edited in several color models. HSV is one of these.
To edit a color in HSV

1. Choose Color Editor from the Utilities menu.
2. Choose the color you want to edit from the menu or drag-and-drop it onto the editor.
3. Right-click on the Color Editor and select HSV.

The HSV (Hue, Saturation, Value) model is often found to be the most intuitive color model.

To use this color model, choose the Hue from the rainbow colored strip along the bottom. This represents the edge of a circle, 
hence both ends are red. The Hue is an angle around the circle and can be entered in the Hue field.

The marker in the square panel represents the Saturation and Value components of the color. These values can also be entered in 
fields under the color strip.

The marker can be dragged and will be constrained to the horizontal and vertical axes if the CTRL key is held down during the 
drag.

Note

If you are editing a linked color, some of the values will be constrained by white boundaries (shown on the editing area) depending 
on the inheritance scheme in use. If the Hue has been inherited, the marker on the Hue line will be bound by a white circle and 
cannot be moved.

The Saturation and Value can be edited in one of two units, percentages (0% to 100%) or values (0 to 255). Which is used is set 
by the Color Units setting, see Changing the color units. If you need to enter a value in the other format, you can force the units by 
typing (for example) "25%" (for a percentage) or "25d" (for 0 to 255 value). Hue is always an angle of 0 to 360 degrees.

_______________
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Editing colors in RGB

Normal colors and linked colors can be edited in several color models, one of which is RGB. You have three options in how you 
define RGB colors: 0-100%, 0-255 or as six hex digits (0-9, a-f - see Notes). You can define the same range of colors using any 
option.

To edit a color in RGB
1. Choose Color Editor from the Utilities menu.
2. Choose the color you want to edit from the menu or drag-and-drop it onto the editor.
3. Right-click on the Color Editor and select RGB (for 0-100% or 0-255) or RGB web (for hex digits).

When you edit a color using the RGB color model, the Color Editor looks like this:

Notes:
If you are editing a linked color, some of the values will be constrained by white boundaries (shown on the editing area) 

depending on the inheritance scheme in use.
Many colors on web pages are defined as six hex digits. To create these colors in Xara X use the RGB web option. 

Letters can be upper or lower-case; "abcdef" and "ABCDEF" are identical colors.
To select between 0-100% and 0-255, see Changing the color units. If you need to enter a value in the other format, you 

can force the units by typing (for example) "25%" (for a percentage) or "25d" (for 0 to 255 value).

_______________
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Editing colors in grayscale

Normal colors and linked colors can be edited in several color models. Grayscale is one of these.
To edit a color in grayscale

1. Choose Color Editor from the Utilities menu.
2. Choose the color you want to edit from the menu or drag-and-drop it onto the editor.
3. Right-click on the Color Editor and select Grayscale

The grayscale model defines shades of gray between white (100%) and black (0%) by setting the amount of white (intensity). This 
color model is the easiest to use when creating black-and-white illustrations.

The value can be altered by dragging the marker on the bar, or entering a value into the Intensity field. 3D editing is not available 
for this color model.

The value can be edited in one of two units, percentages (0% to 100%) or values (0 to 255). Which is used is set by the Color 
Units setting, see Changing the color units. If you need to enter a value in the other format, you can force the units by typing (for 
example) "25%" (for a percentage) or "25d" (for 0 to 255 value).

_______________

{button ,KL(`color editor overview',0,`____No_Topics_Found',`')}    Related Topics



Editing colors in the Create Bitmap Copy palette

(Up to 256-color formats only)

If you want full control over the colors in Create Bitmap Copy, you can edit the palette before creating the bitmap. 

Options:
Lock a color - locked colors always appear in the palette even if you reduce the number of colors.
Make a color web-safe - snap the color to the nearest color in the 216-color browser palette. 
Edit a color - change the definition of any of the colors.
Make a color transparent
Delete a color



Editing colors in the bitmap export palette

(GIF, BMP & PNG, up to 256-color formats only)

If you want full control over the colors in exported bitmaps, you can edit the palette before saving to disk. 

Options:
Lock a color - locked colors always appear in the palette even if you reduce the number of colors.
Make a color web-safe - snap the color to the nearest color in the 216-color browser palette. 
Edit a color - change the definition of any of the colors.
Make a color transparent
Delete a color



Editing text

There are two editing modes used with the Text Tool. You can either change the text using the text cursor or by changing a 
selected region of text

To edit text with the text cursor
1. Choose the Text Tool.
2. Click in the text object to insert the text cursor.
3. Edit the text as required (see List of Text Tool Key Shortcuts).

To edit text selections
When a region of text has been selected (see Selecting text) you can:

Apply attributes to the selected region - see Applying attributes to text
Replace the selected region by typing new text.
To scale and stretch text

You can use either the Text Tool (see Changing the size of text or Changing the aspect ratio of text) or the Selector Tool (see 
Scaling objects or Stretching objects).

For information on changing the width of a column text object, see Resizing column text.

Tip
Whenever the text cursor is moved it takes on the attributes of the character to its left.

Movie

{button ,EF("XaraDemo.exe","EditText Editing Text",1,`') } Editing text

_______________

Related Topics

Text Tool
Text objects



 Ellipse Tool - Bounds Creation Button

The Bounds Creation button on the Ellipse Tool Infobar selects Bounds Creation.

_______________

Related Topics

Ellipse Tool
Ellipses



 Ellipse Tool - Diameter Creation Button

This button on the Ellipse Tool Infobar selects Diameter Creation.

_______________

Related Topics

Ellipse Tool
Ellipses



 Ellipse Tool - Mode Indicator

This indicator on the Ellipse Tool Infobar displays the 'mode' of the tool. It displays one of the following:

New:

Any changes you make to the controls on the Infobar will apply to all subsequent ellipses you draw.

Change:

The selection contains at least one elliptical QuickShape. Changes made to the Infobar fields alter the selected ellipse(s).

_______________

Related Topics

Ellipse Tool
Ellipses



 Ellipse Tool - Parameters Field

These fields on the Ellipse Tool Infobar allow the accurate editing of elliptical QuickShape parameters. From the drop-down list 
choose either

The width and height of the ellipse,
The coordinates of the center of the ellipse.

Alter the values by typing into the edit fields and pressing RETURN or using the arrow buttons.

_______________

Related Topics
Ellipse Tool
Ellipses
Units overview



 Ellipse Tool - Radius Creation Button

This button on the Ellipse Tool Infobar selects Radius Creation.

_______________

Related Topics

Ellipse Tool
Ellipses



 

 Ellipse Tool    SHIFT+F4
The Ellipse Tool creates and edits elliptical and circular QuickShapes. It is a customized version of the QuickShape Tool. For 
information about QuickShapes, see the QuickShapes Overview.

Ellipse Tool Infobar Controls
Bounds Creation

Diameter Creation

Radius Creation

Mode Indicator
Parameters

Ellipse Tool Operations

Drawing ellipses and circles

Rotating ellipses

Scaling ellipses

Stretching ellipses

Changing a polygon into an ellipse

Changing a rectangle into an ellipse

Changing an ellipse into a polygon

Movie

{button ,EF("XaraDemo.exe","ellipses Ellipses and Circles",1,`') } Drawing ellipses and circles



Enabling edit handles

Edit handles allow you to edit an object's shape with the Selector Tool.
To enable edit handles

1. Choose the Selector Tool.
2. Select the Edit Handles button on the Selector Tool Infobar or press the 2 key on the main keyboard.

_______________

Related Topics

Selector Tool
Edit handles



Enabling fill handles and fill arrows

Fill handles and fill arrows are used to edit fills in the Fill Tool. If they are enabled in the Selector Tool, you can also use the 
Selector Tool to edit fills.

To enable fill handles and fill arrows
1. Choose the Selector Tool.
2. Select the Fill Handles button on the Selector Tool Infobar or press the 3 key on the main keyboard.

_______________

Related Topics

Selector Tool
Fill handles
Fill arrows



Enabling grid snapping

With grid snapping enabled, you can snap objects to the on-screen grid.
To enable grid snapping

1. From the Window menu, choose Snap to Grid.

Tip:
You can also enable grid snapping by pressing ‘.’ on the numeric keypad. 

Notes:
Scale line width button on the Selector Tool Infobar affects Snap to grid. With this button selected, the edges of lines snap 

to the grid. When deselected, the center of lines snap.
You can change the snapping distance. See Changing the magnetic snapping distances.

Movies

{button ,EF("XaraDemo.exe","Magnet Object Snapping",1,`') } Using object snapping

_______________

{button ,KL(`grid',0,`____No_Topics_Found',`')}    Related Topics



Enabling guide snapping

Enabling guide-snapping means all guidelines and guide objects become magnetic. Dragging a handle or object near a guide then 
snaps it to the guide.

To enable guide snapping
1. From the Window menu, choose Snap to Guides.

Tips
You can also enable guide snapping by pressing 2 on the numeric keypad.
A magnet by the mouse pointer shows when an object is within snapping distance of the guide.
You can change the snapping distance. See Changing the magnetic snapping distances.
Optionally, you can also snap to objects in regular layers. See Enabling object snapping.
Optionally you also snap to points on the on-screen grid. See Enabling grid snapping.

_______________

Related Topics

Guides



Enabling interactive fill and transparency dragging

You can enable interactive editing of fills and transparency so you can see the fill or transparency change instantly as you move 
the mouse. The handles are only displayed on the screen when the mouse is not moving. If the option is not set fills and 
transparencies are edited by moving the handles alone and the changes are only visible when the mouse button is released.

To enable interactive fill dragging
1. From the Utilities Menu, choose Options (see Options).
2. Click the View tab.
3. Select the Interactive Fill Dragging option.

Tip
If you find dragging is sometimes slow with this option turned on, you don't need to turn it off. Pressing the Tab key during 

a drag will change the editing mode to a faster one.



Enabling object snapping 

Enabling object snapping means objects become magnetic. Dragging a handle or object near an object then snaps to that object.
To enable object snapping

1. From the Window menu, choose Snap to Objects.

Tips
You can also enable grid snapping by pressing #.
A magnet by the mouse pointer shows when an object is within snapping distance of an object.
You can change the snapping distance. See Changing the magnetic snapping distances.
Optionally, you can also snap to objects in guides layers. See Enabling guide snapping.
Optionally you also snap to points on the on-screen grid. See Enabling grid snapping.
Snap to Objects is also available from the pop-up menu; just right-click on the page.

Movie

{button ,EF("XaraDemo.exe","Magnet Magnetic Snapping",1,`') } Using magnetic snapping

_______________

{button ,KL(`object snapping',0,`____No_Topics_Found',`')}    Related Topics



Enabling selection handles

Selection handles are used in the Selector Tool and allow objects to be resized, scaled, rotated and skewed.
To enable selection handles

1. Choose the Selector Tool.
2. Select the Selection Handles button on the Selector Tool Infobar or press the 1 key on the main keyboard.

Movie

{button ,EF("XaraDemo.exe","SelHands.avi Selection Handles",1,`') } Using selection handles

_______________

{button ,KL(`tools,selector tool;selecting,selection handles',0,`____No_Topics_Found',`')}    Related Topics



Ensuring the current layer is always editable

When you select a layer in the Layer Gallery as the current layer (the one objects will be created in) you may find the current layer 
has been set so you cannot edit it. You can change this so the current layer is always editable and visible.

To ensure the current layer is always editable
1. From the Utilities Menu, choose Options (see Options).
2. Click the General tab.
3. Set the Current Layer Always Visible and Editable option.

_______________

{button ,KL(`layers',0,`____No_Topics_Found',`')}    Related Topics



Erasing part of a freehand line

Whilst drawing a freehand line with the Freehand & Brush Tool, you can erase backwards along the line to correct a mistake. 
To erase part of a freehand line

1. While you are drawing a line, hold down SHIFT. The pencil reverses so the eraser is downwards.
2. Move the mouse (without releasing the mouse button) backwards along the line.
3. Release SHIFT to continue drawing. 

Tip
You just need to touch the line to erase to the point where you touch.

Movie

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

_______________

Related Topics

Freehand & Brush Tool
Lines



Exit (File Menu)

Choosing Exit from the File menu will close the program. If you have changed any documents, Xara X will ask you if you want to 
save them to disk before the program closes. You can also exit Xara X by doing one of the following:

Open the application control menu, (press ALT+SPACEBAR) and choose Close.
Double-click the Application Control-menu box.

If you are editing a drawing which is embedded in a document in another program, this menu item reads Exit and Return to 
DocumentX where DocumentX is the document in the other program. Selecting this item will return you to the other program after 
updating the drawing in the document.



 Export (File Menu)    CTRL+SHIFT+E

Select Export from the File menu to export your document in any of a wide variety of file formats (see the List of Supported File 
Formats for a complete list). For details on how to export a file, see Exporting documents or Exporting part of a document.

Show Preview in Options

This only applies when exporting bitmaps or saving JPEGs from the Bitmap Gallery. It is dimmed for Image Map exports.

With this option selected, a Preview is automatically generated when you open the Bitmap Export dialog box (when you click 
Save). This can take a few seconds especially on slower machines.

Show preview bitmap

Select this option to preview files as you click their name.

Note
To export an animated GIF file, use Export Animated GIF on the File menu.



 Export Animated GIF (File Menu)

Select this item to export all the frames in the Frame Gallery to create an animated GIF file. For more details, see Creating 
animated GIF files.

Note
This option is dimmed unless there are at least two frames in the Frame Gallery as you need at least two to create an 

animation
You can create animated GIFs using Animation documents. See Drawing and Animation documents for more details.

_______________

Related Topics

Animated GIF files
Frames



Exporting CMX files

You can export files in CMX version 5 format or CMX version 6 format. Using this format you can transfer files from Xara X to 
CorelDRAW (version 5 or later) You can also place CMX files on the Internet as Netscape Navigator has a plug-in that can display 
them. Always use CMX version 6 where possible as it stores the picture more accurately (it is a 32-bit format as opposed to a 16-
bit format).

CMX 5 format has a maximum width and height of 40 inches (just over 1 meter). If your drawing is bigger than this, it is 
automatically scaled down when you create the CMX file (Xara X warns you if this happens.) Note that the page size is irrelevant - 
what matters is objects in the drawing. 

Some Xara X features do not exist in CorelDRAW or are implemented differently:
Transparency. CMX supports only flat transparency. Other transparency types are converted to flat transparency.
Elliptical fills are converted to circular fills.
Bitmap fills. CMX does not support rotated tiles.
Fractal Cloud fills and Fractal Plasma fills. These will transfer fine, but are exported as bitmap fills.
Three Color Fills and Four Color Fills will not export.
Blends. Not part of the CMX format. Blends are exported as individual objects.
Molds. Not part of the CMX format. The correct shape is exported but the mold outline is lost.
QuickShapes. All QuickShapes are converted to simple shapes.

Not all of Xara X fill types have equivalents in CorelDRAW, however most fill types will transfer correctly. If you put a fill handle 
outside a object's bounding box, it will move so it is inside the bounding box. If you use either of the rainbow fill-effects, the two fill 
handles will move so they are the same distance from the edges of the bounding box.

To export a CMX file
1. Open the document you want to export as a CMX file.
2. From the File menu, choose Export.
3. Select CMX 6 (32-bit) or CMX 5 (16-bit) from the list of file types.
4. Choose a filename and location for the file.
Note
Use CMX 5 format to export to CorelDRAW 5. Use CMX 6 for CorelDRAW 6 and later.

_______________

{button ,KL(`exporting,part of a document',0,`____No_Topics_Found',`')}    Related Topics



Exporting Macromedia Flash files

Flash is the most popular vector format for web graphics. You can export graphics in static swf format.
To export a Macromedia Flash file

1. Open the document you want to export as a Macromedia Flash file.
2. From the File menu, choose Export.
3. Select Macromedia Flash from the list of file types.
4. Choose a filename and location for the file.
Limitations:

Some Xara X features do not exist in the Macromedia Flash format:
Bitmap fills. Flash does not support repeat inverted tiling. Other fill features export correctly.
Conical fills, Diamond fills, Three-color fills, Four-color fills. These are simulated as they do not have an exact equivalent 

in Flash.
Brush stroking of lines. 
Feathering. 
Arrow heads and dash patterns on lines.
ClipView
You can export rollover buttons but only with one object as the button design. (That is, you cannot create rollover buttons 

with text on them.)

If you have overlapping bitmaps with transparency, you may find the colors brighten or 'solarize'.
Notes:

You cannot reload Macromedia Flash files into Xara X. If you think you may need to edit the file in future, save it also in 
Xara X format. (Save or Save as on the File menu.)

You can assign web addresses to buttons - the web address is exported as part of the swf file.
The Xara X exporter has been tested with the latest version of the Flash viewer. However the Flash format is beyond our 

control and may change in the future. Please note that our technical support is limited to using the Xara X Flash exporter. We cannot 
offer support on other questions about using Flash.

_______________

{button ,KL(`exporting,part of a document',0,`____No_Topics_Found',`')}    Related Topics



Exporting Window Metafiles

You can export your drawings as Microsoft Window Metafiles or 32-bit Enhanced Metafile format (EMF).
To export a metafile

1. Open the document you want to export as a metafile.
2. From the File menu, choose Export.
3. From the Save As Type field, select either Windows 16-bit Metafile or Enhanced Metafile.
4. Choose a filename and location for the file.

_______________

{button ,KL(`exporting,part of a document',0,`____No_Topics_Found',`')}    Related Topics



Exporting documents
Exporting Bitmaps. For more information see the Bitmaps Overview.
Exporting Xara X EPS. For more information, see Xara X EPS Overview.
Exporting CMX. For more information, see Exporting CMX files.
Exporting WMF and EMF files (see note). For more information, see Exporting Windows Metafiles.
Exporting Version 1.1 XAR Files. You can use this dialog box to export CorelXARA Version 1.1 XAR files.

Note:
EMF export available only with Windows NT/2000.

_______________

Related Topics

Loading documents
Exporting part of a document



Exporting image maps

When you export bitmap files you can create an image map to go with them. You can either create the image map on its own or 
you can create it at the same time you export the bitmap. For more information see Image maps overview.

To export an image map
1. From the File menu, choose Export.
2. Set the File Type to Image Map (*.htm;*.html).
3. Type in a file name and click Export.
4. Enter the image map option. For more details, click the Help buttons in the dialog box.

This is most useful when you want to create an image map for an existing bitmap.
To export an image map at the same time as a bitmap

Simply export the bitmap as normal, but in the export options, set up the image map options in the Image Map section. For more 
help, click the Help button in that dialog box.

Movies

{button ,EF("XaraDemo.exe",`WebAdd Assigning Web Addresses',1,`') } Creating hot-spots

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps

_______________

{button ,KL(`image maps',0,`____No_Topics_Found',`')}    Related Topics



Exporting part of a document

You can easily export a selection of objects from a document.
To export part of a drawing

1. Select the objects you want to export (see Selecting objects).
2. From the Edit menu, choose Copy to copy the objects to the clipboard.
3. From the File menu, choose New to create a new, blank document.
4. Press CTRL+SHIFT+V to paste the objects back in the same position in the new document.
5. Export the new document as normal.

_______________

{button ,KL(`exporting,documents',0,`____No_Topics_Found',`')}    Related Topics



Extending a line with the Freehand & Brush Tool

After you have finished drawing a line you can extend it at any time. You can use any of line drawing tools (Freehand & Brush Tool, 
Pen Tool, Shape Editor Tool).

To extend a line with the Freehand & Brush Tool
1. Select the line (see Selecting objects).
2. Choose the Freehand & Brush Tool.
3. Move the mouse pointer over the end of the line - the pointer will change (see below).
4. Drag and move the mouse to create the new line section.

Dragging will extend an existing line

_______________

Related Topics

Freehand & Brush Tool
Lines



Extending a line with the Pen Tool

After you have finished drawing a line you can extend it at any time. You can use any of line drawing tools (Freehand & Brush Tool, 
Pen Tool, Shape Editor Tool). As the Pen Tool has limited functionality, you may find the Shape Editor Tool easier to use.

To extend a line with the Pen Tool
1. Select the line (see Selecting objects).
2. Click on the end point handle to extend from (the Shape Editor Tool or Selector Tool can be used for this).
3. Choose the Pen Tool.
4. Now click or drag as normal (see Drawing a Line with the Pen Tool) to add the new line section.

_______________

Related Topics

Pen Tool
Lines



Extend a line with the Shape Editor Tool

After you have finished drawing a line you can extend it at any time.
To extend a line with the Shape Editor Tool

1. Select the line (see Selecting objects).
2. Choose the Shape Editor Tool
3. Click on the point handle on the end of the line you wish to extend.
4. The Shape Editor Tool can now be used as normal to draw lines - the first segment of which will be connected to the existing 

line.

Tip
You can also select point handles using the Selector Tool if edit handles have been enabled - see Enabling edit handles.) 

_______________

Related Topics

Shape Editor Tool
Lines



Extending lines

Lines can be extended using the Pen, Shape Editor or Freehand & Brush Tools.
The Shape Editor Tool is the most flexible and can also edit lines.
The Pen Tool is provided for users familiar with programs such as CorelDRAW and Adobe Illustrator.
The Freehand & Brush Tool lets you extend the line by following freehand mouse movements.

What do you want to do?
Extend a Line with the Pen Tool
Extend a Line with the Freehand & Brush Tool
Extend a Line with the Shape Editor Tool



Feather (Arrange Menu)

This option lets you feather the selected objects - see Feathering objects.



Feather Control Bar

This control bar provides the controls you need to feather the edges of objects. For more information see Feathering objects. 

Feather size

Profile

On an 800x600 display the feathering profile button may be off the edge of the display. You may need to move the 
feathering control bar - see Moving control bars.

_______________

Related Topics
Feathering
Displaying or hiding control bars
Control Bars



Feather Control Bar - Profile

Click this to open the Profile dialog box. This lets you control the feathering transition to create the effect you want. You can have a 
linear transition or more change at the edge or in the center. For more information see Feathering objects.

_______________

Related Topics

Feather Control Bar



Feather Control Bar - Feather Size

Drag the slider or type into the text box to apply feathering or change the feather size of the selection. A size of 0 removes any 
feathering. For more information see Feathering objects.

_______________

Related Topics

Feather Control Bar



Feathering Notes:

If you have multiple objects selected, the feather appears around each object. If you group the objects, the feather 
appears around the outside of the group.

Objects with bevels or contours:
Selecting only the object adds the feather to the outside of the object, not to the bevel/contour.
Selecting only the bevel/contour adds the feather to both the inside and outside of the bevel/contour.
Selecting the object and bevel/contour adds the feather to the outside of the object and the inside and outside of the 

bevel/contour.
If you want to feather only the outside of the bevel/contour, group the object and bevel/contour before adding the feather.



Feathering objects

Sometimes you want to blur the edges of an object so it blends into a background object. An example is merging two bitmaps 
together and wanting to avoid a sharp edge between them. To achieve this you can use feathering.

Note that feathering affects only the object's edge and no other part of the object (see Notes).
To feather an object

1.    Select the object you want to feather - see Selecting objects.
2.    Use the size slider on the Feather Control Bar to produce the feathering effect you require - see Changing the feathering size.

You can also change the feathering profile. Normally a linear transition across the feather produces the best effect but you may 
want more change at either the inner or outer edge of the feather. See Changing the feathering profile.

Notes:
On an 800x600 display the feathering profile button may be off the edge of the display. You may need to move the 

feathering control bar - see Moving control bars.
If you have multiple objects selected, the feather appears around each object. If you group the objects, the feather 

appears around the outside of the group.
Objects with bevels or contours:
Selecting only the object adds the feather to the outside of the object, not to the bevel/contour.

Selecting only the bevel/contour adds the feather to both the inside and outside of the bevel/contour.
Selecting the object and bevel/contour adds the feather to the outside of the object and the inside and outside of the 
bevel/contour.
If you want to feather only the outside of the bevel/contour, group the object and bevel/contour before adding the feather.

Example:

In the example below, the flower and landscape are separate bitmaps. The left-hand flower has been feathered. Notice how much 
smoother the edges are, especially in the sky area.

Feathering the flower

All bitmaps have a rectangular shape even if some areas are transparent. Feathering therefore blurs the edge of this rectangle, 
which is not the effect you want. To feather the outline of the flower:
1. Draw around the outline of the flower.
2. Select both the flower and the drawn shape.
3. Choose Combine shapes on the Arrange menu. This opens the Combine shapes menu.
4. Chose Intersect shapes on that menu. This creates a shape which has the outline of the flower and uses the flower bitmap as 

a fill.
5. Feather the edge of this new shape.

Movies

{button ,EF("XaraDemo.exe",`Feather Using Feathering',1,`') } Using feathering

_______________

{button ,KL(`feathering',0,`____No_Topics_Found',`')}    Related Topics



File Control Bar

Close

Save

Save As

            Save All  

Save Template

Import

Import from Web
Export
Document Info

Page Size

Print

Print Setup

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



File Loading Troubleshooter

If you experience problems opening or importing files:
Check the file can be loaded by other programs.
Check that the file format is supported, see the List of Supported File Formats.

_______________

{button ,KL(`importing',0,`____No_Topics_Found',`')}    Related Topics



File Menu

New
Open
Close
Save
Save As
Save All
Save Template
Import
Import from Web
Export
Export Animated GIF
Export Images in Slices
Document Info
Page Options
Printer Setup
Print Options
Print
1,2,3,4 (recently loaded files list)
Exit



 Fill Gallery (Utilities Menu)    SHIFT+F11

Fill Gallery on the Utilities menu and the Fill Gallery button open the Fill Gallery if it is closed and close it if it is open. The button 
remains pressed in if the gallery is open. For more details, see the Fill Gallery Overview.



Fill Gallery - Background

Clicking this button sets the selected fill as the page background. For more details, see Changing the background.



Fill Gallery - Disk Fills Button

The Disk Fills button in the Fill Gallery opens a modified Open dialog box that lets you choose the folder containing the library. 
Usually you would read the folder directly from the Xara X CD, but you can copy the library onto a hard disk if required and use 
Disk Fills to use the fill bitmaps. See Adding fills to the fill gallery.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Empty Web Fonts Cache

When you download files from the Internet with the galleries, the files are kept in a 'cache'. If you later use a file you have 
previously downloaded it is taken from the cache rather than being downloaded again. If you want to free up some disk space, you 
can empty the cache for the Fill Gallery using this option.



Fill Gallery - Fill Button

The Fill button in the Fill Gallery imports and applies the selected bitmap as a bitmap fill to the selection. If no objects are selected, 
the current fill attribute is set to a bitmap fill using the selected bitmap.

You can also drag-and-drop a fill bitmap onto an object to apply it as a fill or double-click it to apply it to all the objects selected. 
CTRL-double-clicking closes the gallery afterwards.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Get Fills

Click this button and Xara X connects to the Internet and downloads any new fills.

_______________

Related Topic

Downloading items



Fill Gallery - Import Button

The Import button in the Fill Gallery imports the selected bitmap(s) into the selected document resulting in it appearing in the 
Bitmap Gallery (see the Bitmap Gallery Overview). You can also drag-and-drop the bitmap onto a blank part of the page to import 
it.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Options Button

Clicking the Options button in the Fill Gallery opens a menu containing the following options:
Add Fills from Disk
Empty Web Fills Cache
Find
Sort
Icon Size

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Pop-up Menu

Right-clicking on the Fill Gallery opens the pop-up menu which contains the following options:

Import Identical to the Import button.

Apply as a Fill Identical to the Fill button.

Apply as Transparency Identical to the Transparency button.

Download Downloads the select fill

Remove Section Identical to the Remove button.

Set page background Identical to the Background button

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Remove Button

The Remove button in the Fill Gallery removes the selected sections from the gallery. You will be asked to confirm the operation.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Fill Gallery - Stop Loading

If Xara X is downloading thumbnails from the Internet it can take some time. If you want to stop it downloading and carry on later, 
click this button.



Fill Gallery - Transparency Button

The Transparency button in the Fill Gallery imports and applies the selected bitmap as a bitmap transparency to the selection. If 
no objects are currently selected, the current transparency attribute is set to a bitmap transparency using this bitmap. This means 
all subsequent objects drawn will have the selected bitmap applied as a transparency.

_______________

{button ,KL(`fill gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



 Fill Gallery Overview
 SHIFT+F11

The Fill Gallery contains bitmap textures suitable for use as bitmap fills and bitmap transparencies. These bitmaps are not loaded 
into memory - only when one is used is it loaded.

Fill bitmaps are normally loaded from the Xara X CD, but you can change to a different drive. You can also add textures to the 
gallery.

Import Import the fill as a bitmap.
Fill Apply the bitmap as a bitmap fill.

Transp Apply the bitmap as a bitmap transparency.

Get Fills Download fills from the Internet.
Background Set the select fill as the page background.

Remove Remove the selected gallery sections.
Disk Fills Add more fills to the gallery from your hard drive.
Options Fill Gallery options.
Stop Loading Stop downloading thumbnails.

Many operations using the Fill Gallery are made easier by the Fill Gallery Pop-up Menu.

Display Options
Large Icons
Full Information
Small Icons

_______________

Related Topics

Fills
Galleries



 Fill Tool - Bitmap Field

The Bitmap field on the Fill Tool Infobar sets the bitmap used in bitmap filled object(s) in the selection. You can preview and select 
any of the bitmaps used in this document or, by clicking More, select from the fills in the Fill Gallery. 

Note

This field only appears on the Fill Tool Infobar when the current Fill Type is set to Bitmap.

_______________

Related Topics

Fill Tool
Changing bitmap in bitmap fills



 Fill Tool - Bitmap Fill Color Field

The Bitmap Fill Color field on the Fill Tool Infobar displays the color applied to the currently selected fill handles.

Notes
This field only appears on the Infobar when the selection contains one bitmap fill.
This field shows Many if the currently selected fill handles have different colors applied.

_______________

Related Topics

Fill Tool
Changing palette in bitmap fills



 Fill Tool - Bitmap and Fractal Fill Resolution Field

The Resolution field on the Fill Tool Infobar sets the resolution (the size) of the currently selected bitmap/fractal fill. You can 
change the resolution by:

Scaling the bitmap/fractal in the fill using the fill handles
Entering a new value in this field and pressing RETURN.

Note

This field only appears on the Infobar when the selection contains only bitmap/fractal filled objects, and there are no selected fill 
handles. Click away from the fill handles with the Fill Tool to deselect all the handles.

_______________

Related Topics

Fill Tool
Changing resolution in bitmap fills
Changing resolution in fractal fills



 Fill Tool - Fill Effect Field

The Fill Effect option on the Fill Tool Infobar defines the way in which the colors change from one to another in a fill. There are 
three effects available:

Fade

Simply fades from the colors of one object to the next.

Rainbow

This is a more colorful fade following the shortest edge of the HSV color wheel.

For example, a fade from yellow to cyan passes through green.

Alternate Rainbow

This acts in the same way as Rainbow except the colors follow the longest edge of the HSV color wheel.

For example a fade from yellow to cyan passes through red, magenta and blue.

_______________

Related Topics

Fill Tool
Changing the fill effect 



 Fill Tool - Fill Type Field

The Fill Type field on the Fill Tool Infobar sets the type of fill applied to the selection.

Options are:
Flat Fill
Conical Fill
Circular Fill
Linear Fill
Elliptical Fill
Diamond Fill
Three Color Fill
Four Color Fill
Bitmap Fill
Fractal Cloud Fill
Fractal Plasma Fill

The field shows Many if the selection contains fills of different types.

_______________

Related Topics

Fill Tool
Changing fill type



 Fill Tool - Fractal Fill Grain Field

The Grain field on the Fill Tool Infobar sets the 'grain' for the currently selected object with a Fractal Cloud fill or Fractal Plasma fill 
applied. Low values gives a smooth, cloud-like effect - higher values give a sharper, more 'grainy' texture.

Note
This field only appears when the selection contains only fractal filled objects, and there are no selected fill handles. (When 

a fill handle is selected, this field shows the handle type and color.) Click away from the handles to deselect them.

_______________

Related Topics

Fill Tool
Changing the grain in fractal fills



 Fill Tool - Profile

The Profile field on the Fill Tool Infobar lets you change the shape (gradient) between the start and end of the fill.

This field is dimmed for flat fills, three color fills, four color fills and bitmap fills (except for contone bitmaps).

For more information see Changing the fill profile

_______________

Related Topics

Fill Tool



 Fill Tool - Selected Fill Handle Color Fields

These fields are on the Fill Tool Infobar. The left hand of the two shows the currently selected fill handle. The right hand field 
shows the color applied to the selected handle.

Note
This field is shown for all fill types if there is a fill handle selected.

_______________

Related Topics

Fill Tool
Changing colors in fills



 Fill Tool - Tiling Field

The Tiling field on the Fill Tool Infobar lets you create repeating copies of the fill (where applicable).

Options:

Flat fill, Conical fill: none - field dimmed.

Fractal Cloud fills, Fractal Plasma fills, bitmap fills: Single tile: a single copy of the fill or bitmap. Repeating tile: multiple copies. 
Repeat inverted: multiple copies but invert (mirror) alternate copies - this is very useful for bitmap textures which you need to tile 
without the joins being obvious

Other fill types: Simple: a single copy of the fill. Repeating: multiple copies of the fill. For Linear fills these copies appear as a 
series of stripes; for circular fills and elliptical fills, as concentric rings; for diamond fills, three color fills and four color fills as a 
repeating pattern.

_______________

Related Topics

Fill Tool
Tiling



 

 Fill Tool    F5
The Fill Tool lets you apply fills to the selected object(s) in a variety of graduated color. Fills are controlled using fill arrows that 
control the position and direction of the fill. The colors of the fill are controlled using fill handles. For information about fills, see the 
Fills Overview.

Fill Tool Infobar Controls

Which fields appear on the Fill Tool Infobar depends on the current fill type.
Fill Type

Tiling
Bitmap and Fractal Resolution

Profile
Bitmap
Bitmap Fill Color

Fractal Fill Grain

Selected Fill Handle Color
Fill Effect

Fill Tool Operations

Applying fills

Changing fills

Enabling fill handles and fill arrows

Movies

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Fractals Fractal Fills",1,`') } Using fractal cloud fills

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills



Fills Overview

You can fill the center of any object in Xara X with any one of a set of different types of fill. You can apply fills to QuickShapes, 
shapes and even text. If you apply a fill to a compound object (a blend, mold or group) it affect all the objects in it.

You can use any of the following types of fill (click for more information):
Linear Fill
Circular Fill
Elliptical Fill
Conical Fill
Diamond Fill
Three Color Fill
Four Color Fill
Bitmap Fill
Fractal Cloud Fill
Fractal Plasma Fill

Using Fills
Applying fills
Changing fills
Creating custom fills
Creating simple pattern fills

Once you have applied a fill to an object you can change its size, position, direction and the colors it uses as well as the way the 
colors change across the fill. With bitmap fills you can change the bitmap used and with fractal fills you can change the properties 
of the fractal.

Tips
You can only apply fills to shapes, not lines. However you can convert a line to a shape. See Converting a line into a 

shape.
If you just want to fill an object with a plain color (a flat fill), see Changing an object's fill color.
If you don't want to see fill arrows and transparency arrows when dragging, press TAB when in the Fill Tool or 

Transparency Tool.

Movies

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Fractals Fractal Fills",1,`') } Using fractal cloud fills

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

_______________

{button ,KL(`tools,fill tool',0,`____No_Topics_Found',`')}    Related Topics



Finding clipart

To find clipart, use the Clipart Gallery. You can find pictures using the file name of the picture, the title of the picture or using 
keywords (words related to the picture). For more details, see Searching a gallery.

_______________

{button ,KL(`clipart,clipart gallery overview',0,`____No_Topics_Found',`')}    Related Topics



 Fit Text To Curve (Arrange Menu)

When the selection consists of one line, shape, bitmap or QuickShape and one text object, selecting Fit Text To Curve fits the text 
along the edge of the object. The text can still be edited as normal after it has been fitted.

When a text object is selected that has been fitted to a curve, the Fit Text to Curve menu item reads Remove Text From Curve - 
selecting it separates the two components leaving a text object and a line or shape.

For more details, see Fitting text to a curve and Removing text from a curve.

Note:
You cannot fit text to a beveled line or shape. 



Fitting text to a curve

Text objects flowing along a curved line or fitted to a shape look impressive and are easy to do in Xara X. If you fit a column text 
object to a line, each line in the column of text will follow the line. If you fit a simple text object to a line, the text will flow off the end 
of the line if it is too long to fit.

To fit text to a curve
1. Select one line (or shape) and one text object.
2. From the Arrange menu, choose Fit Text to Curve.

Tips
You can also type text directly onto a curve. See Typing text onto a curve. 
You can still edit text that is on a curve. The text cursor follows the path of the curve. For more information on how you 

can edit text see Editing text.
When text has been fitted to a curve, applying full justification adjusts the spacing to exactly fit the text on the line. With 

other justifications, if text does not fit on the line it wraps around onto a new line. If the text is fitted to a shape, it will wrap around the 
shape again.

If you fit text to a line and it fills more than one line, the shape of the line may mean that the edge of the column slopes at 
the wrong angle. You can adjust this - see Aligning text on a curve.

You cannot apply a bevel to the curve after fitting text. See Applying a bevel. Nor can you fit text to a beveled line or 
shape.

To reverse the text on the curve (or swap which side it is on) see Reversing text on a curve.
You can make the curve invisible; see Hiding the line.

_______________

{button ,KL(`text objects,fitted to curves',0,`____No_Topics_Found',`')}    Related Topics



Flipping and rotating bitmaps

Although the Selector Tool can rotate and flip objects (see Flipping objects and Rotating objects), you can also create new bitmaps 
with a rotated or flipped image. You can flip the bitmap horizontally or vertically or rotate it by any multiple of ninety degrees.

To rotate or flip a bitmap
1. Select the bitmap (see Selecting objects).
2. From Bitmap Effects & Plug-ins on the Utilities menu, choose Bitmap Effects.
3. Choose Flip & Rotate.
4. Select the option you want.
5. Click OK to insert the new, altered bitmap into the document.

Tips:
You can also select a bitmap in the Bitmap Gallery and then click the Plug-ins button on the Gallery.



Flipping objects

Objects can be flipped around the vertical and horizontal lines passing through the transformation center.
To flip objects

1. Select the object(s) to be flipped (See Selecting objects).
2. Either:

press the Horizontal flip button on the Selector Tool Infobar,
or press the Vertical flip button on the Selector Tool Infobar.

Tip
The transformation center is only visible when selection handles are enabled and in Rotate/Skew mode. The flip normally 

occurs around the center of the selection unless you have moved the transformation center.



 Font Gallery (Utilities Menu) SHIFT+F9

The Font Gallery item on the Utilities menu and the Font Gallery button open the Font Gallery if closed and close if open. The 
button remains pressed in if the gallery is open.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Apply Button

The Apply button in the Font Gallery applies the selected font to the currently selected text objects and regions.

A font can also be applied by dragging a font over a text object and dropping. Dropping onto a selected region applies the font to 
that region otherwise the font is applied to the whole text story.

If you want to apply a font to a single character either:
select the character then drag-and-drop the font onto the character (see Selecting text),
or start dragging the font then hold down CTRL. You can then drop the font onto the character without having to select it 

first.

If the selected font is currently not installed, it is installed when you apply it.

You can also apply fonts by double clicking them in the gallery, this will apply the font to the selection. CTRL-double-clicking will 
apply the font and close the gallery.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - De-install Button

The De-install button in the Font Gallery de-installs all selected fonts. Only those fonts shown in the Installed Fonts section in the 
Font Gallery can be de-installed. See De-installing fonts for more details.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Disk Fonts Button

If you have the Xara X CD, you can use this button to add the fonts on the CD to the Font Gallery. The Disk Fonts button in the 
Font Gallery opens a dialog box from which you can browse to the Fonts folder on the CD. You can only add folders of fonts from 
CDs, not your own folders.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Empty Web Fonts Cache

When you download files from the Internet with the galleries, the files are kept in a 'cache'. If you later use a file you have 
previously downloaded it is taken from the cache rather than being downloaded again. If you want to free up some disk space, you 
can empty the cache for the Font Gallery using this option.



Font Gallery - Get Fonts

Click this button and Xara X connects to the Internet and downloads any new fonts.

_______________

Related Topic

Downloading items



Font Gallery - Install Button

The Install button in the Font Gallery installs all selected fonts, see Installing fonts for more information. Different versions of 
Windows have different suggested limits on the number of installed fonts. Check your Windows User Guide.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Options Button

Clicking the Options button in the Font Gallery opens a menu containing the following options:
Add Fonts from Disk
Empty Web Fonts Cache
Find
Sort
Icon Size

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Pop-up Menu

Right-clicking on the Font Gallery opens a pop-up menu which contains the following options:

Apply Identical to the Apply Button.

Install Identical to the Install button.

De-install Identical to the De-install Button.

Remove Section Identical to the Remove Button.

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.

Using the pop-up menu can be quicker as it allows you to open the menu and select a font at the same time by right-clicking on 
the font.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Remove Button

The Remove button in the Font Gallery removes the selected sections from the gallery. You will be asked to confirm the operation.

_______________

{button ,KL(`font gallery,overview',0,`____No_Topics_Found',`')}    Related Topics



Font Gallery - Stop Loading

If Xara X is downloading thumbnails from the Internet it can take some time. If you want to stop it downloading and carry on later, 
click this button.



 Font Gallery Overview
 SHIFT+F9

The Font Gallery allows you to select fonts visually from a list to use them in your drawings and also allows you to install and de-
install TrueType and Adobe Type Manager (ATM) fonts.

To the left of the font name is an indicator which shows the format of the font:

Adobe Type Manager (ATM) Type 1

TrueType
Apply Apply the font to the selection.

Install Install the selected font(s).
De-install De-install the selected font(s).
Get Fonts Download more fonts from the Internet

Remove Remove the selected gallery section(s).
Disk Fonts Add more fonts to the gallery from a CD.
Options Font Gallery options.
Stop Loading Stop downloading font thumbnails

Many operations using the Font Gallery are made easier by the Font Gallery pop-up menu.

Display Options
Large Icons
Full Information
Small Icons
Icons Only
Text Only

_______________
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 Frame Gallery (Utilities Menu)    SHIFT+F12

Frame Gallery on the Utilities menu opens the Frame Gallery if closed and close if open. The button remains pressed in if the 
gallery is open. For more details, see the Frame Gallery Overview.



Frame Gallery - All Editable Button

Xara X uses frames to create animated GIF files. With the All Editable button in the Frame Gallery selected, all visible objects are 
editable. This is useful for scaling or moving all frames in one operation. When this button is not selected, only the current frame (the 
highlighted frame) is editable. To make even invisible objects editable, click the All Visible button too.
Note that this button only makes the visible frames editable. If you want to edit all the frames in the document including the invisible 
ones, click the All Visible button too.



Frame Gallery - All Visible Button

Xara X uses frames to create animated GIF files. Selecting the All Visible button in the Frame Gallery displays all frames in the 
document. This is often useful when checking frames. With All Visible deselected, the Background and Overlay Settings for 
individual frames control which frames you see.



Frame Gallery - Background and Overlay Settings

Xara X uses frames to create animated GIF files. Next to the frames listed in the Frame Gallery are two columns of switches. For 
each frame the left-hand switch indicates whether the frame is a background frame and the right-hand switch whether it overlays 
earlier frames. The settings of these switches can be changed simply by clicking on them.
Background
If this is set, then the frame covers all previous frames. This is useful if you want to create a background and then build up an 
animation on top of this background. Often the first frame in the animation is a Background frame. 

If the first frame is not a background frame, the Animated GIF uses the page background as its background. In Xara X you can set 
up the document background to the same color or bitmap as the final web page. This lets you create bitmaps that blend 
seamlessly with the web page background. For details see Changing the background.

Overlay

If this is set, then the frame overlays the previous frame.

Possible values are both off or one option on. Both on is invalid because a Background frame covers earlier frames and so nothing 
shows through - there is nothing to overlay.

Background Overlay

Off Off Current frame is rendered over current background.

On Off This frame is rendered on its own overwriting all previous frames. It forms the background for all subsequent 
frames..

Off On This frame is rendered on top of the previous frame.

Examples
An animation that shows ‘A’, ‘B’, ‘C’ in sequence on a colored background. This requires four frames. Frame 1 is just the 

background and has Background on. Frame 2 shows ‘A’ and has both options off. Frames 3 and 4 show ‘B’ and ‘C’ and also have 
both options off.

An animation that builds up ‘A’, ‘AB’ ‘ABC’. Frame 1 shows the background and ‘A’ and has Background on. Frame 2 
shows ‘B’ and has Overlay on. This overlays the frame over frame 1 and you see ‘AB’. Frame 3 shows ‘C’ and also has Overlay on. 
Building up an animation in this way is more efficient than making each frame a Background frame. The final animated GIF only 
needs to store the changes between frames and so frames 2 and 3 require less space than if they were Background frames.

Tip
To make a sequence of frames background or overlay, set the switch for the first frame and SHIFT-click on switch for the 

last frame. The background/overlay settings of all the frames in between change too.



Frame Gallery - Copy Button

Xara X uses frames to create animated GIF files. The Copy button in the Frame Gallery (and on the control bars) copies a frame 
and its contents. For more details, see Copying frames.



Frame Gallery - Delete Button

Xara X uses frames to create animated GIF files. The Delete button in the Frame Gallery (and on the control bars) deletes the 
current frame. If the frame contains objects you will be asked to confirm the deletion. For more details, see Deleting frames.



Frame Gallery - New Button

Xara X uses frames to create animated GIF files. The New button in the Frame Gallery (and also on the control bars) creates a 
new frame in a document. For more details, see Creating frames.



Frame Gallery - Pop-up menu

Right-clicking on a frame in the Frame Gallery opens a pop-up menu which allows you to operate on the frame. The menu 
contains the following options:

New Frame Identical to the New Button.

Copy Frame Identical to the Copy Button.

Delete Frame Identical to the Delete Button.

Preview Frame Identical to Preview Button.

Frame Properties Opens the Animation Properties dialog box.

Show Frame Includes the frame in the animation. Deselecting this item means the frame will not appear in the 
animation.

_______________

{button ,KL(`frames,frames,frame gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Frame Gallery - Preview Button

Clicking this button opens the animation preview dialog box so you can preview your animation. For more details on what the 
buttons do, click the Help button in the dialog box. For more details on how to preview animations, see Previewing animated GIF 
files.



Frame Gallery - Properties Button

This button opens a dialog box that lets you set options for the current frame and the entire animation. For more information, press 
the Help button in the dialog box.



 Frame Gallery Overview
 SHIFT+F12

The Frame Gallery is used to create animated GIF files. The gallery shows each frame in the animation sequence with the last 
frame at the top. (This makes it easier to understand the effect of the Background and Overlay flags, described below.)

Note that the Frame Gallery is only accessible in 'Animated' type documents. See Creating new documents for details of creating 
Animated documents.

New Create a new frame

Copy Copy an existing frame
Properties Frame properties
Delete Delete a frame
Preview Preview the current frame or the complete animation

All Visible Display all frames
All Editable Make all visible frames editable

Background and Overlay Controls the overlaying of frames
Current frame
The current frame is highlighted in the gallery and is the frame into which all newly created objects are placed. To change the 
current frame, just click on a frame in the gallery.

Many operations using the Frame Gallery are more easily accessible using the Frame Gallery pop-up menu.

Tips
If you import Xara X documents containing layers: the Frame Gallery uses layer technology to create the individual 

frames. This means that to preserve the appearance of the import document, Xara X has to move all objects into a single layer. This 
means that when you save the document, you lose any layer information. See Layers and Frames for more information.

To edit all the frames in the document (including the invisible ones) click both the All Visible and All Editable buttons.

Movie

{button ,EF("XaraDemo.exe",`AniGIF Animated GIFs',1,`') } Creating Animated GIFs

_______________

Related Topics

Frames
Animated GIF files



 Freehand & Brush Tool - Create Brush

Click this button to create a new brush shape from the selected objects. The new brush is added to the Select Brush list on the 
Freehand & Brush Tool Infobar and Brush strokes in the Line Gallery.

For more information see Creating a brush.



 Freehand & Brush Tool - Edit Brush

Dimmed when the selected brush pattern is a plain line (as this is non-editable) or when you have two lines selected that use different brushes.

Click this button to open the Edit Brush dialog box. This lets you either edit the brush pattern of the selected line. Optionally you 
can also create a new brush or edit the existing brush. New brushes appear in to the Select Brush list on the Freehand & Brush 
Tool Infobar and Brush strokes in the Line Gallery.



 Freehand & Brush Tool - Pressure recording

This button on the Freehand & Brush Tool Infobar enables Xara X to use pressure information from pressure-sensitive input 
devices such as a graphics tablet. The pressure information can control the rotation or scaling of brush strokes. For more 
information see Edit brush dialog box.



 Freehand & Brush Tool - Re-fit Indicator

The Refit indicator on the Freehand & Brush Tool Infobar shows 'Re-fit' when you can use the Smoothing slider to smooth the 
currently selected line.

_______________

{button ,KL(`tools,freehand tool',0,`____No_Topics_Found',`')}    Related Topics



 Freehand & Brush Tool - Select Brush

This lets you select from the library of brush shapes. These can be either predefined or you can create your won - see Creating a 
brush.

The first item in the library is always a plain line (no brush stroking). Following this are the most recently used brushes; this makes 
it easier to select your favorite brushes.

You can also view the library in the Line Gallery.

See Changing the brush stroke for details of using brushes.

Note:
Applying a brush removes any arrowhead/tail or dash pattern already applied to the line.



 Freehand & Brush Tool - Select Stroke

This lets you select from the library of stroke shapes. You can also view the library in the Line Gallery. For more information on 
using stroke shapes see Changing the stroke shape.

You can also use stroke shapes to simulate a pressure sensitive input device such as a graphics tablet. More details.

Note:
Applying a stroke shape removes any arrowhead/tail or dash pattern already applied to the line.



 Freehand & Brush Tool - Smoothing Slider

The Smoothing slider on the Freehand & Brush Tool Infobar controls how closely a freehand line follows the original mouse 
movements. Setting the slider to 100% smoothing will smooth out your mouse movements as much as possible, generating the 
smallest possible number of points on the resulting line. With the slider set to 0% almost no smoothing is performed, leaving you 
with a very accurate reproduction of your mouse movements and a great many control points.

After you have drawn a freehand line it is possible to modify the smoothing by dragging the slider, until you make further edits (for 
example by dragging a point handle). The Refit Indicator displays 'Refit' when you can still smooth the line.

If no freehand line is selected, the slider sets the smoothing for lines drawn with the Freehand & Brush Tool in future.

_______________

Related Topics

Smoothing freehand lines



 

 Freehand & Brush Tool    F3
The Freehand & Brush Tool allows you to draw freehand lines and shapes as you would with a pen on paper. You can edit 
freehand lines in the same way as those drawn with the Shape Editor Tool or Pen Tool. It can also be used to extend and redraw 
sections of existing lines and shapes. To find out more about lines and shapes, see the Lines and Shapes Overview

Freehand & Brush Tool Infobar Controls

 Smoothing

Refit Indicator
Create brush
Edit brush

Select brush
Select stroke

Freehand & Brush Tool Operations

Drawing a line with the Freehand & Brush Tool

Drawing a shape with the Freehand & Brush Tool

Redrawing part of a line or shape

Extending a line

Joining lines

Smoothing a freehand line or shape

Brushes

Movies

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

{button ,EF("XaraDemo.exe","FreeEdit Editing Lines and Shapes with the Freehand Tool",1,`') } Editing lines with the 
Freehand & Brush Tool

{button ,EF("XaraDemo.exe",`NewBrush Creating a New Brush',1,`') } Creating a new Brush

{button ,EF("XaraDemo.exe",`Pressure Pressure Sensitivity',1,`') } Pressure sensitivity the Freehand & Brush Tool

{button ,EF("XaraDemo.exe",`EdBrush Editing a Brush',1,`') } Editing a Brush

{button ,EF("XaraDemo.exe",`Linstroke Line stroking',1,`') } Line strokes



 Full Screen (Window Menu)      Numeric Keypad 8

Xara X works in two modes. Normal Mode and Full Screen Mode. They have their own settings for the display of the control bars 
and the Status Line and Color Line. The current settings for each mode are remembered and apply whenever you change modes. 
This makes it possible to switch between two customized modes. Full screen mode is also available from the View Pop-up Menu. 
For more details, see Switching to full screen mode.



GIF Animation Control Bar

This Control Bar is dimmed for Drawing documents - see Drawing and Animation documents for details.

New Frame

Copy Frame

Delete Frame

Select Previous Frame

Select Next Frame

Frame Properties

Preview Frame

Animation Properties

Preview All Frames
Export Animated GIF

Preview Animation in Browser

_______________
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GIF Export Dialog Box

The (Compuserve) GIF export bitmap dialog box is opened by selecting GIF as the exported file format from the Export dialog box. 
It allows the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. 
In addition Xara X also allows GIF files to contain simple transparency and interlacing - two facilities of GIF files used extensively 
on the Internet. For details of how to create a GIF file, see Creating GIF files.

Preview boxes
Palette Options
Bitmap Options Tab
Bitmap Size Tab
Image Map Tab
Browser Preview
Export/Apply Button (see Note)

Exporting from the Bitmap Gallery

If you export a bitmap using the Save button in the Bitmap Gallery, only one tab will appear because you can only change the 
basic bitmap settings. You cannot for instance resize it. If you need more options, select the bitmap in the document and use 
Export on the File menu.

Note

This button reads Apply when setting options in the Name Gallery (because you are setting options prior to Exporting a sliced 
image). Otherwise it reads Export. 

_______________
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Gaddesden Place
The home of Xara Ltd

Gaddesden Place was designed by James Wyatt and built between 1768 and 1773. It is reputed to be Wyatt's first country work 
and accurately represents his conformity at the start of his active career to the English Palladian tradition. The house is set in an 
elevated position overlooking the Gade valley near Hemel Hempstead in Hertfordshire and enjoys one of the finest views in the 
Home Counties. The conservatory was added in 1891 and has been extensively restored. The quadrant links and north and 
south pavilions were demolished in 1955 and 1963 because of dry rot. Since becoming the headquarters of Computer Concepts 
and Xara Ltd, the south wing has been rebuilt to provide more office space. The house and its grounds have been frequently 
used as film locations.



Galleries (Utilities Menu)

This displays a submenu listing the Galleries:
Color Gallery
Layer Gallery
Bitmap Gallery
Line Gallery
Font Gallery
Clipart Gallery
Fill Gallery
Frame Gallery
Name Gallery



Galleries Overview

The program includes a set of Galleries for manipulating items you use as you create your documents. Some list items in your 
documents and some list items on disk. All the Galleries support drag-and-drop and are often a quick and easy way to use the 
program. For more information on any of the galleries, click on the gallery name below.

Some of the galleries list items that are in documents:
Color Gallery

Layer Gallery (see note)
Frame Gallery (see note)

Note: depending on the type of document either the Layer Gallery or Frame Gallery button is dimmed. See Drawing and Animated 
documents for more details.

Bitmap Gallery

Line Gallery

Name Gallery

Some galleries list items stored on disk or on the Internet that you can use in a document if you want.
Fill Gallery
Clipart Gallery

The Font Gallery shows fonts which are installed on your computer as well as the fonts you can install.
Font Gallery

The galleries have many common features. The title bar allows you to position the gallery on the screen. You can resize any 
gallery using the window border in the normal way. The close button closes the gallery completely. When you want to reopen a 
gallery use the appropriate button on the control bar or a keyboard shortcut.

All galleries have a row of buttons under the title bar for working on selected items in the gallery and for setting gallery options. 
Note that you can make the buttons at the top of the galleries large or small using the Control Bars dialog box (select Control 
Bars from the Window menu).

The main display area of all galleries is scrollable and contains one or more sections. Each section is shown by a gray "section 
bar" with a folder icon in it and the name of the section written in white. Sections can be folded so that only the section bar is 
showing or unfolded to see all the items within them. To fold or unfold a section double-click on its gray section bar or click on the 
folder icon.

_______________
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Gallery Control Bar

The Gallery Control Bar contains buttons which open and close the Xara X galleries.
Color Gallery

Layer Gallery
Frame Gallery

Bitmap Gallery
Line Gallery
Font Gallery
Clipart Gallery
Fill Gallery

Name Gallery
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Gallery Find Dialog Box

With this dialog box, you can search a gallery. To open this dialog box, click the Options button in the gallery and choose Find from the menu. For more details, see 
Searching a gallery.

Find items including the text
Search Names and Keywords and Search full information
Find first
Find next



Gallery Find Dialog Box - Find First Button

Click this button to start the search. If the gallery does not contain any items that match the search text, a message box will be 
displayed.



Gallery Find Dialog Box - Find Next Button

Click this button to continue a search that has just found an item (or which starts at the currently selected item). If the gallery does 
not contain any more items that match the search text, a message box will be displayed.



Gallery Find Dialog Box - Search Type

Click one of these radio-buttons to either restrict the search to the names (and file names) and keywords of gallery items, or 
search all information available for each item. If you wish to find a piece of clipart from the clipart book, type the name shown by 
the picture into the edit field, and click Find First. There is no need to change the search type as both will search for the name of 
the file.

This table shows which information is searched for the two searching options.

Names and Keywords All Information

Bitmap Gallery file name & title file name & title

Clipart Gallery title, keywords & file name title, keywords, file name, file size & full description (if present)

Color Gallery color name name, definition (for example RGB(255,255,255) ) & 'not in use'

Fill Gallery title, keywords & file name title, keywords, file name, file size & full description (if present)

Font Gallery typeface name & file name typeface name, file name & file size



Gallery Find Dialog Box - Text

Into this field, type the text you want to search for. For example, "dog" in the Clipart Gallery, "Times" in the Font Gallery or "blue" in 
the Color Gallery.



Gallery Icon Size Dialog Box

Use this dialog box to alter the way items are displayed in the Galleries. Open the dialog box by clicking the Options button in a 
gallery and choosing Icon Size from the menu. The options available depend on the gallery.



Gallery Sort Dialog Box

With the Gallery Sort dialog box you can sort the contents of the galleries. To open the dialog box, open the relevant gallery, click 
Options and choose Sort from the menu.

Primary and Secondary Keys
Apply sort to all the gallery sections
Only apply the sort to sections containing selected items

_______________
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Gallery Sort Dialog Box - Apply to All Gallery Sections

Select this option to apply the sort to all the items within all folders contained in the gallery.



Gallery Sort Dialog Box - Only Apply to Some Sections

Click this radio-button to apply the sort to only those sections which have an item selected within them. See Selecting items in a 
gallery.



Gallery Sort Dialog Box - Primary and Secondary Keys

You can choose a sorting-order for items within the gallery from these two drop-down lists. Items can be sorted by name 
(alphabetically), by their size in memory, by their size on disk, by the file type, or by the length of their name (depending on the 
gallery). If the Reversed check box is checked then the items are sorted in the reverse order.

For example, you may have a gallery of bitmaps that you would like sorted according to the type of bitmap, e.g. .BMP or .JPG, and 
within each category of bitmap, alphabetical order. To sort the items this way choose Sort by file type from the Primary Key list 
and Sort by name from the Secondary key.



General Control Bar

Color Editor
Page Options

Web Address
New Frame
Copy Frame
Delete Frame

Select Start Frame

Select End Frame

Move to Previous Frame

Move to Next Frame
Bitmap Tracer

Units Options

Scaling Options

Options
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 General Options

To open the General Options, choose Options from the Utilities menu and click on the General tab.

Save Setting Now

This saves the current settings and overwrites the existing ones.

This button is useful if Save Settings on Exit is not selected. Clicking Save Settings Now makes the current settings the defaults 
(they apply whenever you load Xara X).

Recent File List Size

The File menu contains a list of the most recently loaded files as a quick and easy way to reload them. The number of files shown 
in the File menu can be set (from 1 to 9) using this option.

Save Settings On Exit

With this option selected, the current settings are saved on exit and apply when you next run Xara X. These settings include the 
control bar positions (for normal and Full Screen mode) and the current folders set in the file dialog boxes (Open, Import etc).

Current Layer Always Visible and Editable

With this option selected, selecting a layer in the Layer Gallery automatically makes it both visible and editable. For more 
information, see Ensuring the current layer is always editable.

Give New Objects Most Recent Attributes

With this option set, new objects take the attributes that were most recently applied. So, for example, if a shape is filled with a 
Fractal Cloud fill, the next shape drawn will also be Fractal Cloud filled. Configuring the program so new objects have the most 
recent attributes.

Ask Before Setting Attributes

With this option selected, Xara X asks before changing the current attribute. For more details, see Configuring the program to ask 
before setting the current attributes.

Ask before closing views

With this option selected, when you load a document, Xara X asks if you want to close the existing document. For more details, 
see Configuring the program to ask before closing views.

Import With Layers

Many other programs have layers like this one. This option controls how layers are handled when importing EPS files. For more 
information, see Importing files with layers.

Angle Constraint

You can use the CTRL key to constrain objects and handles when you move them You can change the constraint angle, see 
Changing the constrain angle for more information.

Nudge Size

When you move (nudge) objects and handles using the cursor keys, they move by a set amount. You can change this value, see 
Changing the nudge size.

Duplication Distance

When you use Duplicate (on the Edit Menu) the copy is placed on the page at a different position from the original. The horizontal 
and vertical distances the copy moves can be changed. See Changing the duplication distance for more details.



Getting help

If you need some help using this program, here are some sources of information that may be of use...
Online Help. Choose Help Topics from the Help menu to open Xara X help (containing hundreds of pages of information). 

See How do I...? for more details.
Status Line. Try reading the text on the Status Line at the bottom of the main Xara X window. It always describes what 

actions are currently possible and what they will do, even during drags and so is ideal for learning to use the Xara X tools. It also 
gives details of what buttons and controls do as you move the pointer over them. See Status Line for more details.

ToolTips If you hold the mouse pointer over a button or control for a short while and a small message appears telling you 
what it does.

Menus. If you want to know what a menu item does, highlight it and press F1.
Dialog Boxes. If you want to know what a dialog box does or how to use it, click the Help button.
Internet. You will find the Xara Internet site at www.xara.com 

 packed with useful hints and tips.



 Grid and Ruler Options

To open the Grid and Ruler Options, choose Options from the Utilities menu and click on the Grid and Ruler tab. They control the 
way the grid and rulers appear. 

Grid and Ruler Spacing

Major Spacing defines the distance between the major grid and ruler divisions. The units used for the grid and rulers is defined by 
the units you use for the Major Spacing. For example entering a major grid spacing of "2cm" will set the grid and ruler units to 
centimeters regardless of the page units specified in the Units options. For more details, see Changing the grid spacing.

Grid Type

Xara X allows the use of a standard rectangular grid or an isometric grid. See Changing the shape of the grid for more information.

Origin (0,0 point)

Normally the origin for the grid and rulers is at the bottom left-hand corner of the page. If you wish to move it to a different location, 
change the Origin value. You can also move the origin by dragging on the rulers, see Moving the ruler zero point for more details.



 Group (Arrange Menu)    CTRL+G

Combines all the selected objects into a single group object. For more details, see Grouping objects and Ungrouping objects.



Using Group Transparency

Group Transparency lets you apply a second transparency effect to objects without affecting any transparency effects already 
applied. This second transparency effect is called "Group Transparency". This lets you build up complex transparency effects.

To apply Group Transparency
1. Select the objects (see Selecting objects).
2. From the Arrange menu, choose Group Transparency.
3. Use the Transparency Tool to apply the required transparency effect to the group.

Tips
If you want to change an object inside a transparency group, you do not need to ungroup it. See Selecting objects in 

objects.
You can still apply attributes to individual objects within a group. Just hold down CTRL as you drag-and-drop the attribute. 

See Selecting objects inside objects.
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 Group Transparency (Arrange Menu)

Group Transparency lets you overlay transparency. This menu option combines all the selected objects into a single grouped 
object. For more details, see Using Group Transparency and Removing Group Transparency.



Grouping objects

Grouping lets you select and move several objects as a single object. This is useful, for example, when overlaying objects to 
create reflections and highlights. Grouping associated objects means you cannot accidentally move one of them.

To group objects
1. Select the objects (see Selecting objects).
2. From the Arrange menu, choose Group.

Tips
If you want to change an object inside a group, you do not need to ungroup it. See Selecting objects in objects.
You can still apply attributes to individual objects within a group. Just hold down CTRL as you drag-and-drop the attribute. 

See Apply inside.
Notes on groups and feathering.

Movie

{button ,EF("XaraDemo.exe","Groups Grouping Objects",1,`') } Grouping objects
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Guideline Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a guideline, it contains the following options:
Delete Removes the guideline.
Snap to Guides
- - - - - - - - - -
Properties
Guide Layer Properties

_______________
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Guideline Properties Dialog Box

This dialog box allows you to enter the exact position for the guideline. Type a value (for example "2cm" or "3in") and click OK. If 
you are creating a new guideline, clicking Cancel will stop a new guideline being created.

Tip
The units used for the guideline position are the Page Units set for the document, see Changing the page units. Note 

however that the units used on the rulers (and grid) are set using the Grid and Ruler Options.
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Guidelines and Guide Objects Overview

When you are drawing objects in a document, you can use guides to ensure that what you draw appears in exactly the correct 
position. There are two types of guide - guidelines and guide objects.

Guidelines

Guidelines are vertical and horizontal dotted lines that are displayed on the screen. You can move them by dragging them. If you 
enable Snap to Guides, any objects or handles you drag near the guideline will lock onto it. Guidelines exist in the guides layer. 
This layer is just like a regular layer in a document and can be locked and disabled.

For more information, see the following pages:
Creating guidelines
Deleting guidelines
Moving guidelines
Listing the positions of guidelines

Guide Objects 

Guide objects are normal objects except they live in the guides layer. If you enable Snap to Guides and drag an object or handle 
near a guide object, it will lock onto it. All objects in the guides layer are shown as dotted outlines. For information on creating 
guide objects, see Moving objects to the guides layer.

Tips
If you want to draw a perspective drawing, go to the guides layer and draw a set of straight lines radiating out from a 

vanishing point. If you now move to a regular layer and use guide snapping, you can easily create objects using the perspective 
guides.

Normally the guides layer is a background layer and guides appear behind other objects. If you want guides to appear on 
top of other objects, move the guides layer forward - see Reordering layers for details.

_______________
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Xara X Help (Help Menu)    F1

Choose Xara X Help from the Help Menu or press F1 to open this Help.



Help Menu

Xara X Help
Xara On The Web
Movies
Tip of the Day
About Xara X



Hiding layers

Hiding a layer is useful when you want to include optional information in your documents. For example, a floor plan document can 
have different layers showing cable runs, who is in which office, and so on. You only need maintain one document but by hiding 
and showing different layers you can easily satisfy different requirements. You cannot see or edit an invisible layer.

To hide a layer
1. From the Utilities menu, choose Layer Gallery.
2. In the columns next to the layer name, click in the the left-hand column to swap the layer between visible and invisible.

Tips
You can make all layers visible temporarily by clicking the All Layers Visible button at the top of the gallery. Clicking it 

again sets all the layers back to their previous state.
The current layer (the one highlighted in the Layer Gallery) can be forced to always be editable and visible (see General 

Options).
The visible setting for a layer can also be set by right-clicking on the Layer Gallery and choosing Properties.
To make a sequence of layers visible, set the first to visible and SHIFT-click on the last. The visible setting of all the layers 

in between change too.
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Hiding the Color Line

The Color Line at the bottom of the Xara X window is a convenient way of applying colors. However, you can turn off display of the 
Color Line if you want to maximize the usable area of the window. With the Color Line turned off, you can use the Color Gallery to 
apply colors.

To hide the Color Line

In the Window menu, open the Bars submenu and choose Color Line.

Tip
If you need more screen space, you might like to use full screen mode. See Switching to full screen mode.
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Hiding the Status Line

The Status Line gives you useful information about the current editing options. However, you can turn it off if you want to maximize 
the usable area of the window.

To hide the Status Line

In the Window menu, open the Bars submenu and choose Status Line.

Tip
If you need more screen space, you might like to use full screen mode. See Switching to full screen mode.
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Hiding the line in blend on a curve

When fitting a blend to a curve it is useful to have the line or shape visible so you can edit the shape of the curve if required. When 
you are happy with the results you can make the line invisible.

To hide the line in text on a curve
1. Select the blend on the curve (see Selecting objects).
2. Choose the Shape Editor Tool. This selects the line or shape.
3. SHIFT-click (or right-click) on the No color button on the Color Line. 

_______________
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Hiding the line in text on a curve

When you are placing or typing text on a curve it is useful to have the line visible so you can edit the shape of the curve if required. 
When you are happy with the results you can make the line invisible.

To hide the line in text on a curve
1. Select the text object on the curve (see Selecting objects).
2. Choose the Shape Editor Tool. This selects the line or shape.
3. SHIFT-click (or right-click) on the No color button on the Color Line. 
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Hiding the page shadow

When a document is displayed on screen, a small shadow is shown underneath the edge of the page You can turn this shadow on 
and off.

To hide the page shadow
1. From the File Menu, choose Page Options (see Page Options).
2. In the Spread section, deselect the Show Page Shadow option.

Note:

The page shadow is different from shadows applied to objects using the Shadow Tool.



Hiding the scrollbars

The scrollbars let you move the document within the window. However, you can turn them off if you want to maximize the usable 
area of the window.

To hide the scrollbars

In the Window menu, open the Bars submenu and choose Scrollbars.

Tip
If you disable the scrollbars you can use the Push Tool to move the document. See Moving the page.



How do I ...?

Xara X's help contains hundreds of pages of information. If you need a hand using the program or want to know how to do 
something, try searching the help. Not only are there pages describing what all the parts of the program do, there are overviews, 
pages explaining terms, step-by-step procedures to help you get your work done and many examples.    You will also find that 
many pages have buttons you can click to run movies.

To open the help, just press F1.
To find information in help

1. Click the Index button at the top of this window.
2. Type in a word at the top of the dialog box.
3. The list will move to show the word you typed.

Now just double-click on the index entry that interests you. If the index entry refers to more than one page, a small window 
appears so you can choose which page you want to go to.
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Image Map Export Options

With this dialog box you can set a few options for your image map before it is saved to disk.

Map name

Image maps each have a name and that name must be unique within a web page. Include this name in the USEMAP attribute of 
the <IMG> tag to identify the associated image map. (USEMAP="#example" for an image map called 'example'.)

If you are inserting this image map into an existing file, you can either type in a new image map name or choose the name of an 
existing image map. This will replace the old image map with new data.

Approximate curves with lines

Clickable regions in image maps are made up of straight lines, not curves. That means that any curved objects in your document 
will be approximated by straight-sided shapes in the image map. With this option you can select how closely the curved shapes 
are approximated by straight-sided polygons. For example, the Approximately setting will approximate the curved shapes very 
roughly. If you need a very accurate image map, choose Very Closely, but this adds more sections to each shape in the image 
map and may make the HTML file quite large.

Size of corresponding bitmap

With this option you can adjust the width and height of the image map in pixels. You should adjust these values so they are the 
same size as the bitmap over which you want to put the image map.

The default values for the width and height of the image map will be the width and height of the objects to be exported in pixels 
(the width and height shown in the Selector Tool Infobar).

Area for image map

You can create an image map either for the complete drawing or just the selected objects.

Save all clickable areas as rectangles

This options means all clickable areas are saved as simple rectangles that totally enclose the clickable area.

Copy image map to clipboard

This copies the text of the image map to the clipboard so you can use a text editor to paste it into an HTML page. Note that this 
overwrites anything already on the clipboard.

Movies
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Image Maps Overview

With Xara X, you can create client-side image maps, which are part of the HTML 3.2 specification. Use Web Address on the 
Utilities menu to add web addresses (URLs) to the different parts of your drawing.

When complete, you can then save or export the drawing and save out the associated image map in one operation. For more 
information on this, click the Help button on the Export dialog box. You can also use the Export dialog box to test the image map 
before saving the graphic and the Image Map. For more details, see Exporting image maps.

Each image map in a document must have a unique name. This name is used in both the <MAP> and <IMG> tags to associate 
the image map to its image. For example, for an image map called 'example', the tags would be <MAP NAME="example"> and 
<IMG USEMAP="#example">. (There will be other attributes in the IMG tag such as SRC.) You allocate a name when you save 
the image map from Xara X.

Theoretically the image map could be in a different HTML document to the IMG tag. Most browsers currently don't support this and 
it is not recommended.

Xara X exports the complete image map; that is, including the <MAP> starting tag and the</MAP> closing tag.

Notes
For more information on HTML and image maps refer to a reference book on HTML and the Internet.
You can produce an image map for any type of graphic but they are usually associated with GIF, JPEG and PNG files. 

Movies
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 Export Image in Slices (File Menu)

This exports the selected objects as several sections (or "slices"). This has two main uses:
When exporting bars as each button needs to be a separate graphic
For large, complex graphics for web pages. You can export areas of flat color as, for example, 2-color GIFs and highly 

detailed areas as JPEGs or 256 color GIFs. This can reduce the amount of data the viewer has to download.

Before you can slice an image, you must name the objects you want to use for slicing. Use either the Name Gallery or New name 
on the Selector Tool Infobar.

For more information see Image slicing overview.



Image Slicing Overview

Large, complex graphics for web pages can produce large files, which take a long time to download over the Internet. You can 
"slice" the image into sections, which can download separately. 

Photoshop and Macromedia Fireworks users may prefer this alternative method as it is closer to how these packages slice 
images.

To show how to slice images, we'll use this graphic (in practice you would not slice a simple image like this):

Another use of slicing is optimization. The blue and white circle contains more colors than the surrounding areas of flat red. You 
can optimize the graphic by exporting just the high detail area (the circle) as a JPEG or 256-color GIF and the other areas as a 2-
color GIF. This minimizes the amount of data to download. A separate page describes optimization.

First stage: name the circle

Named objects control slicing so give the circle a Name. Use either the Name Gallery or New name on the Selector Tool Infobar. 
For this example we'll use the name Circle. (For more complicated images you might name more objects.)

Second stage: export the graphic in slices

You do not need to specify how to slice the image as Xara X does this automatically from the information in the Name Gallery.
1. Select both the red rectangle and the blue circle - see Selecting objects.
2. Select Export image in slices on the File menu.
3. Select the file format (usually GIF or JPEG for Internet Graphics).
4. The file name is the HTML file that contains the HTML code for the sliced image. You can change the file name if required.
5. Click Save.
6. Select the required save options. (For more detail on the options in this dialog box, click the Help button.)
7. Click Export to save the sliced image.
8. You can now view the exported bitmaps in your browser.

The example is sliced like this (the slices has been separated so you can see them):

If you don't want some named objects to slice:

1. In the drop-down list in the Name Gallery select Slices.
2. Checked Names slice the graphic    - if necessary, unselect the check box. 

Unchecked Names have no effect on other objects. (That is, they do not affect slicing.)

Using the graphics and HTML code on a web page

To include the sliced image on a web page you need to copy part of the HTML test page into the web page. (Cut-and-paste is the 
easiest way.) This description assumes you know how to edit a web page and have a basic knowledge of HTML. You may also 
need to copy the bitmaps files to your web server.
1. In a text editor, open the .htm file created when you exported the bitmaps.
2. Technical Note: the bar is contained in a Table. This ensures correct formatting.

Copy the entire Table into your web page where you want the bar to appear. The Table starts 
<table    name="XaraTable"... 

and ends
</table>

3. We recommend copying the bitmaps to the same folder as the web page. If you use a different folder to the web page, you 
need to edit the SRC attributes to point to the correct folder.

4. Copy the bitmaps to your web site. The bitmaps have the same name as used in the Name Gallery. (In this example circle.gif) 
There may be other bitmaps with names such as r2c1.gif plus a file called shim.gif. Copy all these to your web site. Technical 
note: Shim.gif is a dummy bitmap used for padding.



Image Slicing Overview (Alternative Method)

Large, complex graphics for web pages can produce large files, which take a long time to download over the Internet. You can 
"slice" the image into sections, which can download separately.

You have two ways of slicing images. This way will be familiar to Photoshop and Macromedia Fireworks users. It uses separate 
slicing objects in a special layer. The alternative method is easier for drawings that are likely to change (because the slicing 
information is part of the objects in the drawing).

To show how to slice images, we'll use this graphic (in practice you would not slice a simple image like this):

Another use of slicing is optimization. The blue and white circle contains more colors than the surrounding areas of flat red. You can 
optimize the graphic by exporting just the high detail area (the circle) as a JPEG or 256-color GIF and the other areas as a 2-color 
GIF. This minimizes the amount of data to download. A separate page describes optimization.

First stage: create a "slicing" layer

The objects that do the slicing need to go in a separate layer. So you need to create a new layer. For full information see Creating 
layers.

1. From the Utilities menu, choose Layer Gallery.
2. Click the New button in the gallery.
3. Give the layer a name (for example Slices). The new layer is the selected layer. (Any objects you create go into the selected 

layer.)

Second stage: create the "slicing" objects

Next step is to create objects over the areas you want to slice - in this case over the circle. Slices are always rectangular so the 
easiest tool to use is the Rectangle Tool.

1. Draw a rectangle over the circle.
2. We suggest making the rectangle semitransparent so you can the circle underneath. This makes sizing and positioning the 

rectangle easier:

3. Give the rectangle a name (as named objects control slicing). Use either the Name Gallery or New name on the Selector 
Tool Infobar. For this example we'll use the name Rectangle. If you had more areas you wanted to export at high quality you would 
also name them in the same way.

Third step: hide the slicing object (the rectangle)

Hide the slicing objects so they are not exported. In this example we want to hide the rectangle covering the circle.
1. In the Layer Gallery deselect the left-hand check box next to the Slices layer. This makes the layer invisible.

Fourth stage: export the graphic in slices

You do not need to specify how to slice the image as Xara X does this automatically from the information in the Name Gallery.
1. Select both the red rectangle and the blue circle - see Selecting objects.
2. Select Export image in slices on the File menu.
3. Select the file format (usually GIF or JPEG for Internet Graphics).
4. The file name is the HTML file that contains the HTML code for the sliced image. You can change the file name if required.
5. Click Save.
6. Select the required save options. (For more detail on the options in this dialog box, click the Help button.)
7. Click Export to save the sliced image.
8. You can now view the exported bitmaps in your browser.

The example is sliced like this (the slices has been separated so you can see them):

Using the graphics and HTML code on a web page

To include the sliced image on a web page you need to copy part of the HTML test page into the web page. (Cut-and-paste is the 
easiest way.) This description assumes you know how to edit a web page and have a basic knowledge of HTML. You may also 
need to copy the bitmaps files to your web server.
1. In a text editor, open the .htm file created when you exported the bitmaps.
2. Technical Note: the bar is contained in a Table. This ensures correct formatting.

Copy the entire Table into your web page where you want the bar to appear. The Table starts 



<table    name="XaraTable"... 
and ends

</table>
3. We recommend copying the bitmaps to the same folder as the web page. If you use a different folder to the web page, you 

need to edit the SRC attributes to point to the correct folder.
4. Copy the bitmaps to your web site. The bitmaps have the same name as used in the Name Gallery. (In this example 

rectangle.gif) 
There may be other bitmaps with names such as r2c1.gif plus a file called shim.gif. Copy all these to your web site. Technical 
note: Shim.gif is a dummy bitmap used for padding.



Imagesetting (Utilities Menu)

This submenu allows you to control the way individual objects are treated when you color separate them.
Overprint Fill
Overprint Line
Print On All Plates



Imagesetting Control Bar

Show Print Borders

Show Printer Colors

Overprint Fill

Overprint Line

Print on All Plates

_______________
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 Imagesetting Options

To open the Imagesetting Options, choose Print Options from the File menu and click on the Imagesetter tab. These options are 
used when outputting either to an imagesetter such as a Linotronic or to a desktop printer for checking. Check with your print shop 
if you are not sure which options are required. 

Printers marks

These are printed in the margins outside of the normal page size. This means that a larger size of paper is required. For example, 
to print a US Letter (8.5 x 11 inches) with printers marks requires a paper size at least 9.5 x 12 inches. (This is often called US 
Letter Extra.) Some printers marks are required for all imageset work - others only for color separations. To check your work to a 
desktop printer may mean printing at less than full size. Full example, print at 89% to fit US Letter Extra on an 8.5 x 11 inch sheet 
of paper.

Note that printers marks do not appear if you print your document as a bitmap.

Crop marks

These are used for jobs that will be trimmed to size after printing. They tell the print shop where to cut the paper.

Plate information

This is information such as plate name, filename and date & time. Useful for all imageset work

Registration targets

Almost essential for color separated work. They appear in the same position on each separation so the print shop can align the 
separations when making printing plates and when printing.

        

Long registration targets

These are an alternative form of Registration targets. Some print shops may prefer to work with this type of target.

Registration stars

These are a further check that the separations are lined up. Also checks how well the imagesetter or printer handles fine detail.

Grayscale bar

This shows that the imagesetter or printer has rendered the full range of gray tones from 10% to 100%. It also provides the print 
shop with useful information during printing. Useful for both monochrome and color work.

Progressive color bar

Similar to the Grayscale bar. Provides the print shop with useful information during printing.

Overprint control bar

Similar to the Grayscale bar. If your document uses overprint, this provides the print shop with useful information during printing.

Emulsion down (Reflect image)

Creates a mirror image. Normally Off for paper or bromide. For film check with your print shop. 

The imagesetting material is coated with photographic emulsion on only one side. With this option Off, the emulsion is on the top 
of the film when you can read it normally. This is often called 'right reading, emulsion up'. With this option On, the emulsion is on 
the back of the film as you read it. Called 'right reading, emulsion down' or 'wrong reading, emulsion up'. This setting only applies 
to PostScript printers.

Photographic negative

Produces a negative image. Normally Off for paper or bromide. For film check with your print shop. Off if you are asked for 
'Positive' or just 'Pos'. On for 'Negative' or 'Neg'. This setting only applies to PostScript printers.

Always overprint black

Overprints any objects that are 95%-100% Key (CMYK black). Black is a relatively opaque ink and overprinting reduces 
registration problems. For more information on registration problems see Overprinting Overview. This option is particularly useful if 
you have a lot of black text.

If your document has large areas of solid black, overprint can cause problems with over-inking on the printing press. Check with 
your print shop if in doubt.



Imagesetting Overview

If you are having large numbers of copies of your document printed, you may need to have the document 'imageset' at a service 
bureau. The bureau will take your document in electronic form, process it and output it to an imagesetter, which is similar to a very 
high quality laser printer. The results then go to the print shop for printing. Xara X can handle the full range of Imagesetting 
options.

The service bureau can probably produce a color proof of your job, if you need one. See Ordering proofs.

We recommend you read the Imagesetting Points to Note before you imageset any Xara X documents. If you experience 
problems, try using the Imagesetting Troubleshooter.

First - ask!

Ask your print shop what they require. They will tell you:
Film or Paper (paper is sometimes called 'bromide').
If film, Positive or Negative.
If film, Emulsion up or Emulsion down.
The screen frequency to use.
The number of copies they require. (Sometimes they can print several copies on one sheet of paper. This can save you 

money.)
If the printed image runs right to the edge of the sheet of paper, you need to continue it over the edge to allow for slight 

errors when the page is cut to size. The extra area you need to allow is called the 'bleed'. See Changing the bleed setting.

Ask your service bureau what they require. This will depend in what format you supply the document. There’s more on formats 
later.

Next - check

Carefully check your document. Mistakes spotted now are easy and cheap to correct. Spotting the mistake later might mean 
scrapping the imageset output which can be expensive and wastes time. Desktop printers will show less detail than the 
imagesetter and there will always be some problems that only show up when imageset.

Prepare your files in a suitable format

Your files can be sent by disk, modem, or removable hard disk cartridge. Check with your service bureau to find out what they are 
equipped to handle. Service bureaus will need either XAR, .PRN, .CMX, or .EPS files. If you are new to imagesetting, we suggest 
trying to find a bureau that can take .XAR or .CMX files.

XAR files. The service bureau may be able to accept Xara X format files. If so, it saves you a lot of work. The service bureau can 
then take your file and make all the necessary settings.

CMX files. If the bureau cannot accept Xara X files, they may be able to take CorelDRAW .cmx files. Again, if they can, it’s less 
work for you. 

PRN files. These are produced using the Print dialog box. But instead of the data going to a printer connected to your computer, 
the data goes into a file on disk. You will need a suitable printer driver. Ask your service bureau what they recommend. (For more 
information on printer drivers see the documentation supplied with Windows.) See Producing a .PRN file for more information. 
Note: Be sure to review and confirm all settings with your service bureau! They will not be able to verify or fix a .PRN file. Any 
mistake you make will only be apparent on output, which could be costly!

EPS files. Other bureaus may accept .EPS files (as exported from Xara X). These files can be taken into other applications by the 
service bureau and handled from there. Again check everything carefully before producing the file as the service bureau usually 
cannot fix any problems in an EPS file.

Print a hard copy

Always provide a final printout of your work to the service bureau, even if it's only a black and white representation. This will help 
them identify and assess what they're working with.

Include print job information

If you are sending .PRN files, include details of the settings that you have used. If you have any doubts, check with your service 
bureau reps. They usually have an order form that you can use.

Fonts

For the output from the service bureau to match your original, they must have the same fonts as you used. If they don’t, convert 
text to editable shapes. See Printing text.

After Imagesetting

If the service bureau send you the output, check it carefully. Spotting a mistake now is better than spotting it after everything’s 
printed. Look for:

Mistakes in the drawing. Sometimes the high quality output shows up problems not previously evident. Is the drawing 
complete? Are all the layers visible?

Check any text is correct. The same name font from two different manufacturers may give different results.
Any physical defects in the material. Rare but not unknown.

Assuming there’s no problems, you can now send the output to the print shop.



_______________
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Imagesetting Troubleshooter

This troubleshooter covers problems associated with imageset and separated output. See the Printing troubleshooter for help on 
general printing problems. Producing imageset output can be complicated. Inexperienced users may find it easier (and cheaper) to 
let the service bureau do more of the work. See Imagesetting Overview for more information.

What is the problem?

{button ,JI(`',`IDH_Trouble_Imagesetting_I_get_more_or_less_output_than_expected')}    I get more pages or fewer pages than I 
expected.

{button ,JI(`',`IDH_Trouble_Imagesetting_The_imagesetter_gives_an_error')}    The imagesetter gives an error.

{button ,JI(`',`IDH_Trouble_imagesetting_The_output_itself_is_wrong')}    The output itself is wrong.

_______________

Related Topics

Imagesetting
Color separating overview



"Path too complex" error message

One or more objects in your drawing has too many points on its outline and the imagesetter has run out of memory. This is most 
likely to happen with freehand lines with little smoothing or traced bitmaps. You need to check your drawing looking for such 
objects. See Smoothing lines and shapes and Bitmap Tracer Troubleshooter.

{button ,CW(`trouble')}    Close this troubleshooter.



Emulsion down / Emulsion up

Some print shops work from emulsion down imageset output, others from emulsion up. That is why we recommend consulting the 
print shop before getting the job imageset. You need to rerun the job. The service bureau may be able to swap between emulsion 
up or down on their imagesetter. If they can, it means you don't have to recreate the file. If not, recreate the file and make sure the 
Emulsion Down button in the Imagesetting Options is correctly set. See Imagesetting Options.

{button ,CW(`trouble')}    Close this troubleshooter.



I get fewer pages than I expected

Possibilities are:
The imagesetter gave an error during processing. See The imagesetter gives an error.
You did not select the required number of separations in the Separations Options.
You are using spot colors but checked the Print Spot Colors as Process Colors option in the Separations Options.

See Separations Options.

{button ,CW(`trouble')}    Close this troubleshooter.



I get more or less output than expected

The imagesetter has produced some output but the number of pages produced is not what you expected.

What output did you get?

{button ,JI(`',`IDH_Trouble_Imagesetting__Only_one_page_is_output_and_nothing_is_separated')}    One page and nothing is 
color separated.

{button ,JI(`',`IDH_Trouble_Imagesetting_I_get_fewer_pages_than_I_expected')}    Fewer pages than expected.

{button ,JI(`',`IDH_Trouble_Imagesetting_I_get_more_pages_than_expected')}    More pages than expected.

{button ,JI(`',`IDH_Trouble_Imagesetting_I_get_multiple_copies_of_each_page')}    Multiple copies of each page.



I get more pages than expected

You probably selected some unwanted separations in the Separations Options. See Separations Options.

{button ,CW(`trouble')}    Close this troubleshooter.



I get multiple copies of each page

You probably selected multiple copies in the Print dialog box. Choose Print from the File menu and change the number of copies.

{button ,CW(`trouble')}    Close this troubleshooter.



Negatives and Positives

Some print shops work from negative imageset output, others from positives. That is why we recommend consulting the print shop 
before getting the job imageset. You need to rerun the job. The service bureau may be able to swap between negative and positive 
on their imagesetter. If they can, it means you don't have to recreate the file. If not, recreate the file and make sure the Negative 
button in the Imagesetting dialog box is correctly set.

{button ,CW(`trouble')}    Close this troubleshooter.



No printer's marks appear

If no printer's marks appear round the edge of the image, it could be because:
Output Printers Marks is unchecked on the Imagesetting Options. This option is automatically unchecked if you uncheck 

Print Color Separations on the Separations dialog box.
You have selected Bitmap printing in the Output Options. Select Normal or PostScript printing mode.
The selected paper size is too small to print the image and printer's marks. Outputting printer's marks requires a larger 

than regular paper size. The paper size is set in the Print Setup dialog box. When proofing to a desktop printer, you may need to 
print at less than 100% to fit on the both the image and printer's marks.

{button ,CW(`trouble')}    Close this troubleshooter.

_______________
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Only one page is output and nothing is separated

You probably forgot to select Print Color Separations in the Separations Options.

{button ,CW(`trouble')}    Close this troubleshooter.



Only partial printers marks appear

Printer's marks are controlled by the Imagesetting Options. Check the settings.

{button ,CW(`trouble')}    Close this troubleshooter.



Only some printer's marks appear

You may have output your drawing on a paper size that is too small. Outputting printer's marks requires a larger than regular paper 
size. The paper size is set in the Print Setup dialog box. When proofing to a desktop printer, you may need to print at less than 
100% to fit on the both the image and printer's marks.

{button ,CW(`trouble')}    Close this troubleshooter.



Paper and Film

Some print shops can only work from film not paper (bromide). The material depends on what the service bureau load into the 
imagesetter and is not something controlled by Xara X. You need to get the job rerun by the service bureau onto the correct 
material.

{button ,CW(`trouble')}    Close this troubleshooter.



Printer's marks appear on only two sides of the image

You may have output your drawing on a paper size that is too small. Outputting printer's marks requires a larger than regular paper 
size. The paper size is set in the Print Setup dialog box. When proofing to a desktop printer, you may need to print at less than 
100% to fit on the both the image and printer's marks.

{button ,CW(`trouble')}    Close this troubleshooter.



Problems with printer's marks

Printer's marks appear around the outside of the image to help the print shop.

What is wrong with the printer's marks?

{button ,JI(`',`IDH_Trouble_Imagsetting_No_printers_marks_appear')}    No marks appear

{button ,JI(`',`IDH_Trouble_Imagesetting_Only_some_printers_marks_appear')}    Only some marks appear

{button ,JI(`',`IDH_Trouble_Imagesetting_Marks_appear_on_only_two_sides_of_the_image')}    Marks appear only on two sides of 
the image

{button ,JI(`',`IDH_Trouble_Imagesetting_Only_partial_printers_marks_appear')}    Only partial marks appear



Some objects appear on all separations

There are two possible reasons:
Black or gray objects appear on all separations if they are defined in RGB or HSV color models. Redefine them as CMYK. 

Note that Black and gray shades on the Color Line are defined in CMYK and so appear only on the Key separation. See Color 
Editor.

Print on all Plates is applied to the object. This option is on the Imagesetting submenu of the Utilities menu. See Print 
on All Plates.

{button ,CW(`trouble')}    Close this troubleshooter.



Some text is in the wrong font

You have used a font that is not available on the imagesetter. There are several options:
Select Print all Text as Shapes in the Output Options. This converts all text to simple shapes for printing, but can make 

the file much larger.
Convert just the affected text objects to shapes. See Converting text to shapes. Note that you cannot later edit text that 

you have converted to shapes using the Text Tool.
Use a different font. There may be a similar font available which the service bureau also have.

{button ,CW(`trouble')}    Close this troubleshooter.



Spot colors separate to CMYK

There are two possibilities:
The Print Spot Colors as Process Colors option is checked in the Separations Options. In this case, all spot colors 

appear only on the CMYK separations.
Either the objects have transparency applied or are covered by a transparent object. See Imagesetting points to note.

{button ,CW(`trouble')}    Close this troubleshooter.



The imagesetter cannot interpret the file correctly

The problem is likely to be that you used the wrong printer driver. Some drivers include extra information suitable for that type of 
printer but which cause an imagesetter to error. Ask your service bureau which printer driver they recommend. 

There are many different types of imagesetter in use world-wide. We regret that we cannot recommend which printer driver is 
suitable for any particular type of imagesetter. However we have found that Linotronic drivers generally give good results on a wide 
range of imagesetters.

{button ,CW(`trouble')}    Close this troubleshooter.



The imagesetter gives an error

The exact wording of any error message depends on the imagesetter. However, there are two basic types of error message you 
may get:

What error do you see?

{button ,JI(`',`IDH_Trouble_Imagesetting_The_imagesetter_cannot_interpret_the_file_correctly')}    "Cannot understand something 
in this file" or "Flushing to end of file".

{button ,JI(`',`IDH_Trouble_Imagesetting_Path_too_complex__error_message')}    "Path too complex" or "Too many points on 
line".



The output itself is wrong

The imagesetter has produced the right number of pages but there is a problem with those pages. If the number of pages is wrong 
see I get more or less output than expected.

What is wrong with the output?

{button ,JI(`',`IDH_Trouble_Imagesetting_Theres_a_physical_defect_in_the_imageset_output')}    There is a physical defect in the 
material.

{button ,JI(`',`IDH_Trouble_Imagesetting_Problems_with_printer_s_marks')}    There’s a problem with Printers Marks around the 
edges.

{button ,JI(`',`IDH_Trouble_Imagesetting_The_proof_colors_don_t_match_those_on_screen')}    The colors on the color proof 
don’t match the colors on screen.

{button ,JI(`',`IDH_Trouble_Imagesetting_Spot_colors_separate_to_CMYK')}    Some objects that should appear on the spot plate 
have been separated to CMYK.

{button ,JI(`',`IDH_Trouble_Imagesetting_Negatives_and_Positives')}    The print shop say they need negatives not positives.

{button ,JI(`',`IDH_Trouble_Imagesetting_Negatives_and_Positives')}    The print shop say they need positives not negatives.

{button ,JI(`',`IDH_Trouble_Imagesetting_Emulsion_down___Emulson_up')}    The print shop say they want emulsion down.

{button ,JI(`',`IDH_Trouble_Imagesetting_Paper_and_Film')}    The print shop say they want film not paper.

{button ,JI(`',`IDH_Trouble_Imagesetting_Some_text_is_in_the_wrong_font')}    Some text is in the wrong font.

{button ,JI(`',`IDH_Trouble_Imagesetting_Some_objects_appear_on_all_separations')}    Some objects appear on all separations.



The proof colors don't match those on screen

The computer screen can display some colors which are impossible to reproduce using the four CMYK inks. You can simulate how 
the printed job should look by selecting Show Printer Colors on the Window menu.

Show Printer Colors is color matched to Cromalin and Matchprint proofs (see Ordering proofs). The output from a desktop color 
printer and other types of color proof may differ from this on-screen simulation. For more details see Displaying a document using 
the printer colors.

{button ,CW(`trouble')}    Close this troubleshooter.



There's a physical defect in the imageset output

These are rare but not unknown. Point out the defect to the service bureau and ask them to rerun the job.

{button ,CW(`trouble')}    Close this troubleshooter.



 Import (File Menu)    CTRL+SHIFT+I
You can import a large number of different types of file into your documents. For a full list, see the List of Supported File Formats. For details on how to import file, see Importing files.

Clicking a XAR or WEB file displays a preview in the dialog box (if the file contains a preview).



    Import from Web (File Menu)    CTRL+W

With Import From Web you can specify a web page and download all the images from that HTML page into your current 
document. For more details see Importing images from the Web.

Note
If the HTML page uses frames, graphics within those frames are not imported.
Any background image becomes the background of the Xara X page.

_______________

{button ,KL(`importing;opening;loading',0,`____No_Topics_Found',`')}    Related Topics



Importing CDR files

You can import CDR files from versions 3, 4, and 5 of CorelDRAW. If you are using CorelDRAW 6 or later use CMX to transfer 
your files - see Importing CMX files. If a CDR file contains a CMX file the CMX file will be loaded (to include a CMX file in a CDR 
file, select the "Include Presentation Data" in the Save dialog box).

As CDR is not Xara X's native file format, some objects may not appear how you expect them to. Note that if the file contains a 
CMX file, the CMX importer will be used so the following does not apply.

Fills. All fill types apart from full color pattern fills are supported. However, custom fills are imported as fills from the start 
color to the end color. Square fills are approximated to radial fills. Full color pattern fills which are just a bitmap (no paths or other 
objects) are imported as bitmap fills.

Text. Text is imported with the font name, font size, bold, italic, underline, super/subscript and line spacing attributes. Only 
the alignment and baseline shift options from the fit path to text roll-up are imported. Text on a path can only be imported if the path 
it is fitted to still exists in the file. If you delete a path in CorelDRAW after fitting text to it, the text will be imported into Xara X as 
normal text in the position it was before this operation. 

Special Effects. Mix, Color limit and ColorAdd Lenses are supported. Other types of Lenses are not supported. Some 
PowerClips may be imported incorrectly. All other effects are supported.

Envelopes. Envelopes are approximated. You will be warned about this after the file has been imported if there were any 
envelopes in the file.

Extrusions. Some extrusions cannot be imported correctly.
Colors. CorelDRAW has no concept of a named color, so all objects have to be imported with local colors applied to 

them. The colors on the Color Line are the default set for CorelDRAW. If you've edited these colors in your copy of CorelDRAW, 
you'll need to import your edited palette file into the document using the CorelDRAW Palette file filter as these colors are not stored 
in CDR files. See Importing colors and palettes.

Lines. If lines are imported which have arrowheads, the object will appear as a group containing two objects, a line and a 
shape (the arrowhead). 

If Problems Occur. If any of these limitations cause problems, try saving the .CDR file from CorelDRAW as EPS and import that 
instead. If a file is found to load incorrectly, please send the file to Technical Support with full details. See Technical Support for 
further details.



Importing CMX files

You can import Corel CMX version 5 and 6 files. As CMX is not Xara X's native file format, the file may contain some objects that 
do not have direct equivalents. Below is a list of objects that may not import as you expect them to.

Fills. Multiple color (custom) graduated fills are imported with just the end colors. Other grad fills work. Postscript and 
Vector (full color) pattern fills are not supported. Any objects imported with them will not be filled.

Bitmaps. Cropped bitmaps will appear as rectangles with a bitmap fill.
Text. Underlined text is not supported by Xara X. Individually rotated letter will not appear rotated.
Molds. CMX does not support molds, the objects will appear as ready-molded shapes.
Blends. CMX does not support blends. All the blend steps will appear as shapes.
Clipping. The outlines of PowerClip and Place Inside containers are approximated.
Lenses. You can only import Transparency, Color Add and Color Limit lenses.
Outlines. If you have an object with a behind fill, Xara X will import the shape without the behind fill.
Tiling. Some tiling options such as offset-tiling will not import correctly.

If Problems Occur. If any of these limitations cause problems, try saving the .CMX file from CorelDRAW as EPS and import that 
instead. If a file is found to load incorrectly, please send the file to Technical Support with full details so we can fix the problem. See 
Technical Support for further details.

_______________
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Importing PhotoCD files

If you have a PhotoCD disk, you can open the files on it individually or add the PhotoCD to the Clipart Gallery so you can preview 
the images on it.

To open a file on a PhotoCD disk
1. From the File menu, choose Open.
2. Browse to the \Photo_cd\Images folder on the CD.
3. Choose "Photo CD (*.pcd)" from the drop-down list.
4. Double-click the image you want to load. You can use the inlay in the PhotoCD case to find the image number.
5. In the dialog box, choose the resolution you want to load.

To add a PhotoCD disk to the Clipart Gallery
1. From the Utilities Menu, choose Clipart Gallery.
2. Click the Disk Clipart button.
3. Browse to the \Photo_cd\Images folder on the CD.
4. Click Add.
5. When the dialog box appears asking if you want to create an index, click the Create button. If this dialog box does not appear, 

there is already an index, you need to update it, see the tips below.
6. As the index cannot be written to the CD, you will be asked if you want to create the index in the temporary folder. Click the 

Create button.

Tips
To open a PhotoCD file, just double-click on it in the Clipart Gallery. A dialog box opens for you to choose which resolution 

you want to open.
If you place another PhotoCD in your CD drive, you need to update the gallery. See Updating a disk-based gallery.

_______________
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Importing animated GIF files

If you import or open an animated GIF file, each frame is imported as a bitmap with all the bitmaps placed in separate frames. 
Each frame is listed in the Frame Gallery with the last frame at the top.

Tip
You can easily alter an animated GIF by loading it into Xara X, altering one or more frames and reexporting the animated 

GIF. For more details, see Creating animated GIF files.

_______________
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Importing colors and palettes

You can import the following color table and palette files.
CorelDRAW Palette .CPL and .PAL
Adobe Color Tables .ACT
Adobe Color Swatches .ACO
PaintShop Pro Palettes .PAL
Microsoft Palettes .PAL

You can import the colors into a document, or place them in the Color Gallery so they are always available.
To import a palette file
Into an existing document - drag the file icon from Explorer or File Manager and drop it onto the document window away 

from the Color Line.
Into a new, blank document - drag the file icon from Explorer or File Manager and drop it on the Color Line.
To add a palette to the Color Gallery

1. Open the folder into which you installed the program.
2. Open the Palettes folder.
3. Copy a palette file into this folder. The file must be in one of the formats described above.

Tips
Imported colors become named colors when you import them and are displayed in the Color Gallery and on the Color 

Line.
For palette files that contain large numbers of colors, it may be easier to import the palette into a blank document and use 

the Color Gallery to move the required named colors from the blank document into your selected document. Using the Color Gallery 
to apply a named color from the blank document automatically copies that named color into the selected document.

To create a palette file from Adobe Photoshop, select Indexed Color from the Mode menu and choose Color Table from 
the Mode menu.

To create a palette file from PaintShop Pro V3, choose Save Palette from the Colors menu.
You can only import colors from palette files when they are defined in color models supported by the program. e.g. 

PhotoColtone colors in ACT files will not import.

_______________
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Importing files

You can incorporate (import) an existing drawing into a document. Note the difference between Opening (which opens the drawing 
in a separate window) and Importing (which loads the drawing into the existing window).

To import a file
1. From the File menu, choose Import.
2. Browse to the folder containing the document file.
3. To display only particular file formats, choose from the Files of type list. (If in doubt, choose All Files.)
4. Double-click on the file.

Tips
For a list of types of file you can load, see the List of Supported File Formats.
Usually the importer automatically determines the type of file format and imports it correctly. In a few cases, this may not 

work and the file is imported incorrectly. If this happens, Undo the import and select the specific file type from the Files of type list. 
Then re-import the file.

Importing files is an easy way of changing a document type from Drawing to Animation (and vice versa). Import an 
existing document into a new document of the required type. Then save out the new document. See Drawing and Animated 
documents for more details.

You can also use the Clipart Gallery to import files.
You can use drag-and-drop to import a file into a document just by dropping it onto the page.
If the file contains layers, you can specify how to handle those layers. See Importing files with layers.

_______________
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Importing files with layers

When importing a file containing layers into a Drawing document, you can control how layers are handled.
To change the setting

1. From the Utilities menu, choose Options.
2. Click the General tab.
3. Change the Import Layers setting:

Import layers into new layers: retain the layer information but create new layers, if necessary changing the layer names from 
the file.
Import layers into the active layer: discard any layer information and import everything onto the same layer (the currently 
selected layer).
Import layers into those layers defined in the file: retain the layer information and names from the file. If a layer already 
exists, use that. Otherwise create a new layer. This is useful if you want to import several files with common layer names into 
one document.

You can then import your file as normal, see Importing files.

Note
Importing files into an Animation document automatically removes all layer information. All objects appear in the same 

frame. See Drawing and Animated documents for more details.



Importing images from the Web

You can import graphics from Web pages directly from the Internet into your document. Notice the difference between this menu 
option which loads all the graphics from the specified web page and Import which loads a single graphic from disk.

To import from a Web page
1. From the File menu, choose Import from Web.
2. Type in the web address (URL) of the page or graphic you want to import. If the URL is a page, all the images on that page will 

be imported.
3. Click Import.

Tips
For a list of types of file Xara X can load, see the List of Supported File Formats.
For details on what URL's you can enter, see the Web Address Overview, but note that you can only use HTTP and FTP 

URLs.
You can paste web addresses from Netscape Navigator and Internet Explorer into the name field of the Import from Web 

dialog box. To do this (1) select the web address in Navigator or Explorer; (2) press CTRL+C to copy the address to the clipboard; 
(3) click in the name field of the Import from Web dialog box; (4) press CTRL+V to paste the address. This is an easy way of copying 
a web address.

If the HTML page uses frames, graphics within those frames are not imported.
Any background image becomes the background of the Xara X page.
If you have problems downloading over the Internet you may need to set up options in the Internet tab. Choose Options 

on the Utilities menu

_______________
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Importing transparent bitmap files

CompuServe GIF files and PNG (up to 256 colors) files support 'masks' which are a very basic form of transparency. When a 
bitmap file with a mask is placed on a background (for example in a web page) some areas of the background show through the 
bitmap. This method is often used to remove the background from pictures so the bitmap doesn't appear rectangular. Importing a 
masked bitmap files retains the transparent mask and you can see through parts of the bitmap when it is in Xara X. For more 
information about masked bitmaps, see the Internet Bitmaps Overview.

PNG (true color) also supports a more advanced form of graduated transparency called "alpha-channel". You can also import 
these files into Xara X.

Note that Simple GIF/PNG Transparency (masking) and Xara X Transparency are different. Simple Transparency means you can 
see through the background of the bitmap and is "on-off". Xara X and PNG alpha-channel Transparency means you can see 
through objects and is variable from fully transparent to fully opaque.

To import a transparent bitmap file

You can import these in the same way as other files. See Importing files.

Tips
You can apply Xara X transparency to any bitmap, including masked bitmaps.
You can create transparent GIF files and PNG (both simple and alpha-channel) files with Xara X. (See Creating GIF Files 

or Creating PNG files).



Increasing the available work area

To help you gain as much screen area as possible, this page lists changes you can make to Xara X so you can see as much of 
your document on the screen as possible. For instance, you can move the control bars around, remove any buttons you do not 
use and turn off the scrollbars.

To increase the work area you can...
Maximize the main document window so it fills the screen. To do this, double-click on the title bar or select Maximize from 

the application control menu.
Remove any buttons from the bars that you do not use (see Removing and restoring buttons).
Move the control bars so they make more efficient use of the area around the edge of your document (see Moving and 

resizing control bars).
Change the size of the buttons on the control bars (the Toolbar has large buttons by default). See Setting the size of 

buttons.
Use the Push Tool (see Moving the page) instead of the scrollbars and turn them off (see Hiding the scrollbars). This 

setting only affects the current document, if you want it to apply to all future documents you'll need to change the template 
document. See Changing the template document.

Turn off the rulers if you do not use them. See Displaying the rulers.
Make the colors on the Color Line smaller. See Changing the size of the Color Line.
Turn off the Status Line. See Hiding the Status Line.

Tips
Xara X has two modes - full screen mode and normal mode. You can change the settings of these two modes 

independently. See Switching to full screen mode. Full screen mode saves even more space as the title bar and menu bar are not 
visible.

You can use Zoom To Page and Zoom to Drawing to fill the screen with your drawing. See Zooming to the whole page or 
Zooming to the whole drawing.



Infobar Overview

The Infobar displays different information and controls dependent on the currently selected Tool. For example, when you choose 
the Text Tool the Infobar contains only text related controls and when you choose the Zoom Tool, the Infobar only shows zoom 
related controls. By doing this, you can easily select which buttons are available and only ever have one set visible on screen - no 
more screen clutter!
  

  

For more information on each of the tools' Infobars, see The Tools.



Installing fonts

This program is supplied with a large range of fonts for you to use. Before you can use a font, you must install it. All the installed 
fonts and all those you can install from the Internet or the CD are shown in the Font Gallery. Fonts come in two formats. Each font 
comes in two formats, TrueType and ATM. You can use ATM fonts only if you have Adobe Type Manager installed. If you are not 
sure which type to use, use TrueType.

To install a font
1. Open the Font Gallery.
2. Find and select the required fonts (see Selecting items in a gallery).
3. Click the Install button in the gallery.

Note:
You cannot use the Fonts Gallery to install or de-install fonts if you have ATM for Windows NT 4. This is an inherent 

problem with the current version of ATM for Windows NT and beyond the control of Xara X. Use the standard Windows Control 
Panel to install and de-install fonts. For details of the Control Panel refer to the Windows documentation.

Tips
Alternatively, clicking the Apply button installs the font and applies it to the selected text/cursor (or sets the current 

attribute if nothing is selected).
Most programs show the installed font(s) in their font list immediately. You may find a few programs that you have to close 

and then reload before they show the new fonts.

_______________
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Installing plug-ins

Plug-ins let you extend the range of effects you can apply to bitmaps. See Bitmap effects plug-ins for details of suitable plug-in 
types.

To install plug-ins
1. Choose Options on the Utilities menu.
2. Click the Plug-ins tab.
3. Click the New button.
4. Browse until you reach the folder containing the plug-ins that you want to add.
5. Click Add.

Note:
The dialog box does not show the files in the folder. You must know the folder in advance of using the Options dialog box.
The folder you specify can itself contain folders. This makes it easier for you to organize your plug-ins on disk by placing 

them in separate folders.
The Plug-ins tab has an option to search for plug-ins at startup. When selected, Xara X scans the listed folders for 

suitable plug-ins when the program starts up. This adds a few seconds to the start-up time. If you prefer not to have this slight delay, 
deselect this option. The scan is then done when you click on Bitmap Effects & Plug-ins on the Utilities menu for the first time.

_______________
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Internet Bitmaps Overview

Xara X redraws pictures at an exceptional quality level and supports both transparency (masking) and interlacing in exported GIF 
files. It can create bitmaps using error-diffused dithering which gives bitmaps of a higher quality than most other programs and can 
also generate bitmaps with a specially chosen optimized palette. It is ideal for creating bitmaps for publication on the Internet. 
Generally when you create bitmaps for the Internet, you will create GIF files because of the extra features they support, but there 
is no reason why you cannot create bitmaps in other formats. For information on how to create a bitmaps for the Internet, see 
Creating GIF files and Creating JPEG files.

When producing bitmaps for the Internet, we suggest basing your document on the '640 by 480 drawing' or '600 by 800 drawing' 
template. These use pixels as their measurement units. See Creating new documents for details.

Use GIF for graphics that are artificial - sharp lines, text and other precise illustrative aspects. Use JPEG for images that are either 
natural - photographs, backgrounds - or other images that don't mind loosing a bit of detail. You should experiment with various 
JPEG compression settings as well.

You have several options for exporting GIFs. Generally, in increasing quality and size, they are:
1. 2 color non-dithered
2. 16 color non-dithered, optimized palette
3. 16 color diffuse dithered, optimized palette
4. 256 color non-dithered, palette optimized
5. 256 color diffused dither, optimized palette

The last one will always give the best quality, but is usually also the largest variant, and you may sometimes find JPEG images 
come out smaller.

GIF and JPEG are the only two formats that will be guaranteed to work with all browsers.

For Really High Quality WWW Bitmaps
Turn the Quality setting to its highest level (see Changing the screen quality of documents for more details).
Use error-diffused dithering, but do not forget this may increase the file size.
Use an optimized palette, but this may increase the file size.
If you are creating a masked GIF, make sure its edges are anti-aliased to the same background as that on the Internet 

page. See Smooth Bitmap Edges below).
You will usually find an interlaced bitmap is more pleasing to the eye, particularly if the image is large.
Keep the bitmaps as small as possible so they download quickly - always use as few colors as you can. For example, if 

your image only contains 10 colors, an optimized palette 16 color (4 bit) bitmap is likely to be as good as a 256 color version but will 
be half the size.

Use the pixel units (see Units Options) to ensure all your objects are aligned on the edges of pixels in the bitmap.

Sometimes experimentation yields even better results. For example for an image composed of many, very similar colors, error-
diffused dithering probably gives no improvement. You may also find with a picture like this that you can create a very high quality 
image using an optimized palette with only 16 colors.

Masked GIFs

GIF bitmaps support masks. This means the bitmap can have areas which are 'see-through'. This simple form of transparency is 
extremely basic, but lets you remove the background from pictures. To create a masked GIF, select Background Transparency 
when you export a GIF; any areas not covered by the selected objects are see-through in the file.

The effect of exporting the red star. On the left without background transparency - the green background and all the blue circle are 
exported. On the right, with background transparency - only the part of the blue circle covering the red star is exported.

Note that the actual bitmap is always rectangular even if it contains transparent areas. Also note that GIF transparency is very 
different from Xara X transparency. Transparency in GIF means a simple 'on-off' transparency. Transparency in Xara X means you 
can make objects semitransparent and apply graduated transparency.

GIF Interlacing

GIF files can be interlaced. This means when you download the image from the Internet it will be drawn on screen in phases as 
the file is downloaded.

How Many Colors Do You Really Need?

If your picture doesn't use many colors, try creating a bitmap that uses less colors. This will make it smaller and so it will download 
faster. If your bitmap is a masked (transparent) GIF, one of the colors is used for the transparency, so a two color transparent GIF 
has only one visible color.

Smooth Bitmap Edges

If your final bitmap has see-through areas, it will look better if the edges of the objects in the drawing are smoothed against the 
background color. See Changing the background. This will create a bitmap with very smooth edges.

To ensure you do not get any strange effects on the edges of your bitmap, align the outlines of objects with the edge of the bitmap 
you are creating. Do not select the background object when you export the bitmaps. You may find it useful to place the background 
object in a new, background layer.

In this example, in the left picture, the purple star was exported as a transparent bitmap with a black rectangle behind it. Notice 
how its edges look great on the black areas. In the right picture, the purple star was exported with a white rectangle behind it, 
notice how much better it looks on the white background.



Palette Options

You can create completely non-dithered images for Netscape and Microsoft Internet Explorer by using colors from the Browser 
section in the Color Gallery This gives you access to a full range of colors which will be displayed without dithering in these two 
browsers (as long as you do not use blends, graduated transparency or graduated fills). 

You may find it easier to use the Color Gallery instead of the Color Line to apply colors as you can resize it to show all the colors in 
a small area.

Alternatively, always create use the bitmap using an optimized palette as this nearly always give exceptional results, but gives 
slightly larger files.

If you create your bitmap using an optimized palette it will look far better in true color (millions of colors) and high color 
(thousands of colors) screen modes. You may also find that it looks better in 256 color modes. You nearly always get better results 
by using an optimized palette, although usually    the file is larger.

Pixel Units

Xara X includes a Pixel unit. If you turn on the grid and use pixels for the page units (see Changing the page units) and for the Grid 
and Ruler units you can move objects by individual pixels and see all measurements measured in pixels.

Animations

For details on creating animated GIF files for the Internet, see Creating animated GIF files and the Frame Gallery Overview.



Internet Options

To open the Internet Options, choose Options from the Utilities menu and click on the Internet tab. With these options, you can 
optimize how Xara X connects to the Internet. If in doubt, use the default settings; they give satisfactory results. Changing the 
values in this tab just lets you get the best possible results.

These options set the global Windows Internet settings used by Internet Explorer. If you change options here, they will also change 
in Internet Explorer. If you have already set up Internet Explorer, you shouldn't need to change these. If you are not using Internet 
Explorer, you will probably need to set these options up as they will not mirror your browser settings.

Internet Cache

When Xara X downloads gallery items off the Internet, it stores them in a reserved area of disk memory called a Cache. When 
Xara X uses these items in the future, it can load them directly from the cache which is much faster than downloading over the 
Internet.

Cache Usage indicates the amount of cache space currently in use. This gives an idea as to whether the cache size is correct. 
That is, if cache usage is consistently nearing 100% the cache size should be increased if possible. A larger cache size does not 
affect the program adversely or take up unnecessary space on the drive. We recommend a cache size of 15 - 20 Mb. The 
minimum cache size is 500Kb, the maximum is the free space on the drive when the size is set. Anything outside these limits 
generates an error.

You can type in byte values directly (800000). For Kilobytes or Megabytes, follow the value with K or M (500K or 8M).

The Empty Cache button removes all files from the cache except a few essential data files needed by Xara X. (This means that 
Cache Usage might not return to 0% after emptying.) To use a file that has been removed from the cache you have to download it 
again.

Connection Type

Over faster modems, ISDN and networks, Xara X can speed up downloads by using multiple connections. These multiple 
connections are invisible to you and you just see an increase in speed.

If you connect to the Internet using a modem, select the appropriate speed option. If you are not sure about your modem, use the 
default setting.

If you connect to the Internet using a LAN (Local Area Network - often called just a ‘Network’), select Dual ISDN or Better. If in 
doubt, contact your System Administrator.

Connect through an HTTP Proxy Server

Home users can ignore this option. It applies only to corporate users who are isolated from the Internet by a firewall. If in doubt, 
contact your System Administrator. Note that Internet Explorer automatically sets up this information. You only need to change 
these entries if you have problems downloading clipart from the Internet.

Note: Use the name of the server, not the numeric IP address. You can find out the server details by checking in the Internet 
section of your Browser. Port is the TCP-IP port number assigned on the server.

_______________
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 Intersect Shapes (Arrange Menu) (Ctrl+3)

Discard those areas of the selected objects not covered by the front object. The front object disappears. The front object may be a 
group for more complex intersection. This operation is the opposite of Subtract shapes. If the intersection results in more than one 
shape they are grouped. For more information see Intersecting shapes.



Intersecting shapes

Intersecting objects leaves only the area where all the selected objects intersect.

To intersect shapes
1. Select the objects (see Selecting objects).
2. On the Arrange menu, choose Combine Shapes then choose Intersect Shapes (or press CTRL+3).

Tip
You can intersect all object types including bitmaps.

Movie

{button ,EF("XaraDemo.exe","IntShape Intersecting Objects",1,`') } Intersecting objects
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Inverting a grayscale bitmap

To reverse the colors in a grayscale bitmap, you contone the bitmap using black and white with the colors the opposite way around 
from normal. You can create a grayscale bitmap by doing this to a color bitmap.

To invert a grayscale bitmap
1. Select the bitmap.
2. Left-click on black on the Color Line.
3. Right-click on white on the Color Line.

Tip
Contoning isn't restricted to black and white; you can fade the colors in the bitmap between any two colors.

_______________
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JPEG Export Dialog Box

The JPEG export bitmap dialog box is opened by selecting JPEG as the exported file format from the Export dialog box. It allows 
the setting of the size/resolution of the exported bitmap, the area to be exported and the 'quality' of the final bitmap. You can use 
the Export dialog box to preview the bitmap using different settings. This lets you change, for example, the number of colors and 
see how this affects the look of the bitmap and its file size. For details of how to create a JPEG file, see Creating JPEG files. 

Preview boxes
Bitmap Options Tab
Bitmap Size Tab
Image Map Tab
Browser Preview
Export/Apply Button (see Note)
Use Original JPEG

Exporting from the Bitmap Gallery

If you export a bitmap using the Save button in the Bitmap Gallery, only one tab will appear because you can only change the 
basic bitmap settings. You cannot (for example) resize it. If you need more options, select the bitmap in the document and use 
Export on the File menu.

Note

This button reads Apply when setting options in the Name Gallery (because you are setting options prior to Exporting a sliced 
image). Otherwise it reads Export. 

_______________
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JPEG Export Dialog Box - Use Original JPEG

This option is available only if you have opened the JPEG Export dialog box by clicking the Save button in the Bitmap Gallery. If 
you select a JPEG in the Bitmap Gallery and click Save, you can select this option to save the JPEG file out again without it being 
re-encoded. This means the JPEG you save is an exact copy of the original file and has not been through the JPEG process a 
second time. You will notice that when you select this option, you cannot change the Quality setting.



 Join Shapes (Arrange Menu)

Join Shapes joins all the shapes and lines in the selection to form a single object. Because overlapping parts of the same shape 
are drawn with no fill color (you can see through the overlapping parts), you can use this effect to create holes in shapes, by 
joining several shapes together.

The Join menu options tie together a number of different shapes into one shape making all the parts that overlap see-through. For 
example, joining an object with a smaller circle on top of it produces an object with a circular hole in it.

_______________
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Joining lines

You can join two separate lines to create a single line.
To join lines

1. Choose the Selector Tool.
2. Click on the first line to select it.
3. SHIFT-click on the second line to select it.
4. (Using either the Selector Tool or the Shape Editor Tool) drag the end point handle of one line over the end handle of the other 

line - the mouse pointer shows a '+' when the two handles are over each other.
5. Release the mouse button and the lines will be joined.

    Release the mouse button to join the lines

_______________
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Justifying text

After creating a text object, you can justify it so each line is aligned on the left, on the right, in the center or on both sides. If you 
want to create a new justified text object, just place the text cursor in the document (or drag to create a column text object) and 
click one of the justification buttons on the Text Tool Infobar. Full justification only works with column text and text on a curve.

To change the justification
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click one of the justification buttons on the Infobar.

_______________
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Kerning text

Kerning alters the horizontal space between two adjacent characters. There are two types of kerning:
Automatic kerning (or "auto-kerning"). If all characters are spaced the same distance apart, some character pairs such as 

"AV" look wrong. To correct this most (but all) fonts have in-built "kerning pair" information that adjust the spacing for particular pairs 
of characters. (Notice how "AV" overlap each other - that is the effect of auto-kerning.)

Manual kerning. With this, you have full control over the distance between characters by inserting a 'kern' character. You 
can use manual kerning for special effects (such as overlapping characters).

To enable automatic kerning
1. Choose the Text Tool.
2. Select Automatic kerning.

Notes:
Not all fonts include kerning pair information.
Auto-kerning applies to the entire text object. You cannot auto-kern just part of a text.
Xara X does not auto-kern where text changes between regular and bold or italic. If necessary, use manual kerning.
To manually kern text

1. Choose the Text Tool.
2. Click between the two characters you want to kern. This inserts the text cursor.
3. Click the buttons on the Kerning control on the right hand side of the Text Tool Infobar.

Kerns are measured in thousandths of em's with positive values moving characters apart and negative values moving them closer 
together.

Notes:
You can also set the kerning by typing a value into the kerning field and pressing RETURN.
To remove the kern, delete it just like any other character.
To change the size of a kern, just click between the two characters and change the value.



 Layer Gallery (Utilities Menu)    F10

Layer Gallery on the Utilities menu and the Layer Gallery button opens or closes the Layer Gallery. The button remains pressed 
in if the gallery is open.

This menu option is dimmed for Animated documents. See Drawing and Animation documents for details.



Layer Gallery - All Editable

When the All Editable button in the Layer Gallery is selected all layers are unlocked and editable so objects in any layer can be 
edited. When this button is not selected the editable status of a layer is set by its own editable setting. For more information, see 
Locking layers.

_______________
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Layer Gallery - All Visible Button

When the All Visible button in the Layer Gallery is selected all layers in the document become visible. When this button is not 
selected, the visibility of a layer is set by its own visibility setting. This button does not affect the guides layer. For more 
information, see Hiding layers.

_______________
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Layer Gallery - Copy Button

The Copy button in the Layer Gallery is used to copy a layer and its contents. Clicking it opens a dialog box from where you can 
type in a    name for the new layer. For more details, see Copying layers.

_______________
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Layer Gallery - Delete Button

The Delete button in the Layer Gallery will delete the current layer. If the layer contains objects you will be asked to confirm the 
deletion. For more details, see Deleting layers.

_______________
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Layer Gallery - Guides Layer

Guidelines and guide objects live within the guides layer which can be locked to prevent editing of guides and also made visible or 
invisible as with any other layer. All objects in the guides layer are shown as dotted outlines. For more information on guides, see 
Guidelines and Guide Objects Overview. Note that locking the guides layer against editing prevents you from moving or deleting 
all guidelines and guide objects.

You can quickly swap the visibility setting for the guides layer using Show Guides on the Window menu.

_______________
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Layer Gallery - Move Button

The Move button in the Layer Gallery moves any selected objects to the current layer. This is a quick way of moving objects 
across several layers.

_______________
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Layer Gallery - New Button

The New button in the Layer Gallery is used to create a new layer in a document. Clicking it opens a dialog box which prompts for 
a name for the layer. For more details, see Creating layers.

_______________
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Layer Gallery - Pop-up Menu

Right-clicking on a layer in the Layer Gallery opens a pop-up menu for that layer. The menu contains the following options:

Copy Identical to the Copy Button.

Delete Identical to the Delete Button.

New Layer Identical to the New Button.

Create Guide Layer Creates the guides layer. For details more details on guides, see Guidelines and Guide Objects 
Overview.

Properties Opens the Layer Properties dialog box.

_______________
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Layer Gallery - Visible and Editable Settings

Next to the layers listed in the Layer Gallery are two columns of switches. For each layer the left-hand switch indicates whether the 
layer is visible and the right-hand switch whether it is editable. The settings of these switches can be changed simply by clicking 
on them.

For details on hiding layers, see Hiding layers.

For details on locking layers, see Locking layers.

_______________
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 Layer Gallery Overview
 F10

The Layer Gallery gives you full control over the layers in a document. This includes the foreground and background layers and 
the guides layer. For more details on layers, see the Layers Overview.

Note that only 'Drawing' type documents can contain layers. See Creating new documents for details of creating Drawing type 
documents.

The gallery shows two sections. The upper section lists all the foreground layers in the selected document, the lower section 
details the background layers which will not print. Note that the guides layer will never print no matter which section it is in.

New Create a new layer
Copy Copy an existing layer

Properties Layer properties
Delete Delete a layer
Move Move selected objects to current layer

All Visible Display all layers
All Editable Unlock all layers

Visible and Editable Hide/lock individual layers
Guides Layer

Current Layer

The current layer is the layer highlighted in the gallery and is the layer into which all newly created objects are placed. To change 
the current layer, just click on a layer in the gallery..

Many operations using the Layer Gallery are more easily accessible using the Layer Gallery pop-up menu.

Movie

{button ,EF("XaraDemo.exe","Layers Layers",1,`') } Using layers
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Layer Properties Dialog Box

With the Layer Properties dialog box you can alter the properties of a layer and change the guides layer settings. The dialog has 
two sections, one for layers and one for guides.

Layer

With the Layer tab in the dialog box you can alter:
The name of the layer. See Renaming layers.
Whether the layer is visible. See Hiding layers. Dimmed for Animation documents.
Whether objects in the layer can be edited. See Locking layers. Dimmed for Animation documents.

These settings are duplicates of those shown in the Layer Gallery itself.

Guides

The Guides tab allows you to create new guidelines and set the color of all the guidelines and guide objects in the guides layer.
The Horizontal\Vertical setting sets whether horizontal or vertical guidelines are shown.
The New button allows you to create a new guideline.
The Delete button deletes the selected guideline(s).
The Properties button opens the Guideline Properties dialog box and allows you to set the exact position of the selected 

guideline.

At the bottom of the dialog box is a drop-down list from which you can select the color used to display the dotted outlines of all 
objects in the guides layer. For more details, see Changing the color of guides.

_______________
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Layers Overview

Note that only 'Drawing' type documents can contain layers. See Creating new documents for details of creating Drawing type 
documents.

When you draw an object in a document it is placed in the current layer (this is usually called Layer 1). All documents are formed 
from a set of layers which act like a series of transparent sheets laid on each other with opaque objects on one layer obscuring 
anything underneath them on lower layers. In a simple drawing all your objects are usually in one layer. 

With layers you can:
Choose which layers can be edited.
Show as many or as few layers as you wish.
Change the order of layers, front to back.
Name layers.
Create and delete layers.

You can manipulate the layers in a document using the Layer Gallery (see the Layer Gallery Overview for more details).

Foreground and Background Layers

There are two types of layer - Foreground and Background. Background layers always sit behind the foreground layers. 
Background layers never print so are ideal for pictures you want to copy or backgrounds you only want visible on the screen.

Button & NavBar Tool

When creating Navigation Bars, this tool creates extra layers as required. These layers are called MouseOff, MouseOver, 
MouseDown, Selected and BackBar. You can view these layers in the Layer Gallery. We do not recommend deleting them or 
renaming them as this could affect bar creation. For more information on bar creation see Creating Navigation Bars.

Tips
Layers can be used to act as overlays to show different levels of detail. For example you could draw a map with different 

levels of detail on different layers and turn the layers on and off individually.
You can use layers to divide an illustration into layers for easy editing. For example a complex drawing of a face might 

have layers for the mouth, nose, eyes and face.
If you place a picture in a background layer and lock it, you can draw over it in an upper layer without affecting it.

Movie

{button ,EF("XaraDemo.exe","Layers Layers",1,`') } Using layers

_______________
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Layers and Frames

You can use Xara X in two ways:
To create normal drawings. To help you when creating complex drawings, you can use layers.
To create animations as Animated GIFs. To do this, you create a series of frames in the Frame Gallery.

For normal drawings use a drawing document; for animations an animated document. You select the type of document when you 
create it. See Creating new documents for details.

For more information on:
Frames: see Creating animated GIFs 
Layers: see Layers overview

_______________

Related Topics

Layers
Frames



 Line Gallery (Utilities Menu)    F12

Line Gallery on the Utilities menu and the Line Gallery button open and close the Line Gallery. The button remains pressed in if 
the gallery is open.

_______________
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Line Gallery - Arrows

The Arrowheads section of the Line Gallery allows you to apply arrowheads (and tails) to lines.

To apply an arrow head or tail to a line:
Drag-and-drop the arrow head or tail from the Line Gallery onto the line. Hold down CTRL to apply the pattern to an object 

inside another object. See apply inside.
Select a line and double-click on the arrow head or tail in the Line Gallery. This will apply the arrow head or tail to the 

appropriate end of the line, for example a rounded arrowhead will be applied to the start of the line while a feathered arrow tail will 
be applied to the end of the line.

Select a line and select an arrow head or tail in the Line Gallery. Click the Apply button.

To apply an arrow head or tail to the other end of a line (for example applying a feathered arrow tail to the start of a line) not the 
end, either drop the arrow head or tail onto the line where you would like it to appear, or use the second and third methods above 
while holding down CTRL. Alternatively you can reverse the line direction.

_______________

Related Topics

Adding arrowheads to lines



Line Gallery - Brush Strokes

Brush Strokes let you change the appearance of lines. (For example, by using a patterned line.) The Line Gallery shows brush 
strokes in several sections:

New brush strokes are custom brush strokes used in loaded documents plus a plain line (no brush).
Other sections contain predefined brushes.

To change the brush stroke either:
Drag-and-drop the required brush design onto the object. Hold down CTRL to apply the pattern to an object inside another 

object. See apply inside.
Double click on the brush design to apply it to the selection.
Click the required brush design to select it and click Apply to apply it to the selection.
To remove a brush stroke (use a simple line) use Default stroke in New brush strokes.

Some brush designs are directional (like arrows along the line). Their direction depends on the direction of the line. If necessary 
you can reverse the line direction.
You can also change the appearance of the line using stroke shapes. See Changing the stroke shape of a line.

The brush stroke sections have a pop-up menu (right-click) with options of:
Rename brush - lets you change the name displayed for the brush
Copy brush graphic to clipboard - copies a single copy of the brush to the clipboard. You can then paste it into a 

document. This lets you create a new brush design with, for example, different colors.
Delete (New brush strokes section only) - delete the brush.

Note that the pop-up menu does not appear if you click on Default stroke.

Note:
Applying a brush removes any arrowhead/tail or dash pattern already applied to the line.

_______________

Related Topics

Changing the brush stroke design
Creating custom brush strokes



Line Gallery - Dash Pattern

The Dash Pattern section of the Line Gallery allows you to apply different dash patterns to objects outlines.

To change the dash pattern:
Drag-and-drop the required pattern onto the object. Hold down CTRL to apply the pattern to an object inside another 

object. See apply inside.
Double click on the dash pattern to apply it to the selection.
Click the required dash pattern to select it and click Apply to apply it to the selection.

Note:
Applying a brush or stroke shape removes any dash pattern already applied to the line.

_______________

Related Topics

Adding dash patterns to lines



    Line Gallery - Join Type

This sets the style of corners on the line or shape. The Join Type also applies to contours and bevels.

Selecting a join type from the menu sets the join type of all currently selected lines and shapes. The join types available are:
Beveled Join
Miter Join
Round Join

_______________

Related Topics

Changing join style



    Line Gallery - Line Cap

This sets the style of the ends of the line.

Selecting a line cap from this menu will set the end type of all currently selected lines and shapes. The line caps available are:
Butt Cap
Round Cap
Square Cap

_______________

Related Topics

Changing line caps



    Line Gallery - Line Width

You can change the line width using the drop-down list at the top of the gallery or using the Line Width section.

If there is a line selected, this field will change the width of the line(s). Otherwise it changes the current attribute for line width so 
the line width is drawn for all newly created objects.

To alter the line width, enter a value into the field and press RETURN or select the required line width from the menu.

Alternatively you can change the line width as follows:
Drag-and-drop the required line width from the gallery onto the object.
Double click on the line width to apply it to the selection.
Click the required line width to select it and click Apply to apply it to the selection.

_______________

Related Topics

Changing line thickness
Units overview



Line Gallery - Stroke Shapes

The Stroke Shapes section of the Line Gallery lets you change the contour (shape) of lines. (For example, to create a tapering 
line.)

To change the stroke shape:
Drag-and-drop the required stroke shape onto the object. Hold down CTRL to apply the pattern to an object inside another 

object. See apply inside.
Double click on the stroke shape to apply it to the selection.
Click the required stroke shape to select it and click Apply to apply it to the selection.

You can also change the appearance of the line using Brush Strokes. See Changing the brush stroke design.

Notes:
Applying a stroke shape removes any arrowhead/tail or dash pattern already applied to the line.
You can also select a stroke shape using the Freehand & Brush Tool.

_______________

Related Topics

Changing the stroke shape design



 Line Gallery Overview
 F12

The Line Gallery gives full control over the appearance of lines and shape outlines. It allows you to alter dash pattern, width, joins 
and ends.

The line attributes that can be set using the gallery are:

Line Width

Join Type
Line Cap

Brush Strokes (arranged in two or more sections)
Stroke shapes
Dash Pattern
Arrows

The Brush Strokes sections have a pop-up menu with options of Rename brush, Export shapes to clipboard and (New brush 
stroke section only) Delete. More details in Brush Strokes.

Movie

{button ,EF("XaraDemo.exe","LineBits Editing Line Width Ends and Joins",1,`') } Editing line widths, ends and joins

_______________
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    Line Width

The line width control sets the width (thickness) of lines (and the outlines of other types of objects). If you change the value with objects selected, their line widths will change. If you change the value with no objects selected, the value you used will be set as a current attribute and used for all lines you draw in future. You can choose a value from the drop-down list or you can type a value and press 
RETURN. For more details, see Changing line thicknesses.

_______________

Related Topics

Changing line thickness
Units overview



Line and Shape Pop-up Menu

Right-clicking on a line or shape pops up a menu with the following options:
Shape Editor Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________
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Lines and Shapes Overview

  

Lines and shapes are the simplest objects you can create in your documents. The difference between the two is that a shape is a 
line with its ends joined together.

Drawing Lines and Shapes

You can draw lines and shapes with either the Freehand & Brush Tool (ideal for freehand drawing), the Shape Editor Tool (the 
usual choice) or the Pen Tool (for those used to the pen drawing facilities of other packages). For more details, see these pages:

Drawing lines
Drawing shapes

Tip
You cannot apply a fill to a line, you must join its ends together and apply the fill to the resulting shape.

Changing the Shape of Lines and Shapes

For details of changing the way lines and shapes look in your document, see the following pages:
Moving a point on lines and shapes
Changing curved lines and shapes
Setting the length and angle of a straight line segment
Straightening curved line segments
Adding points to lines and shapes
Breaking lines and shapes apart
Deleting points on lines and shapes
Changing the thickness of lines and shape outlines
Changing the brush stroke design
Changing the stroke shape

Changing The Ends and Joins of Lines and Shapes

You can change the ends of lines and the way segments are joined together. You can use butt caps, round caps or square caps on 
the ends of the lines and you can use round joins, miter joins or beveled joins for the junctions between segments in lines and 
shapes.

For more information, see these pages:
Changing join style
Changing line ends

Adding Arrowheads and Dash Patterns to Lines and Shapes

You can add a dash pattern to any line or shape outlines (but see Note). You can also add arrowheads and tails to your lines using 
the Line Gallery. For more information, see the following pages:

Adding arrowheads to lines
Adding dash patterns to lines and shapes

Note:
You cannot apply a dash pattern or arrowhead to a line with a brush or stroke shape already applied. 

Movies

{button ,EF("XaraDemo.exe","CurvDraw.avi Drawing Lines and Shapes with the Shape Editor Tool",1,`') } Drawing lines 
with the Shape Editor Tool

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

{button ,EF("XaraDemo.exe","PenDraw Drawing Lines and Shapes with the Pen Tool",1,`') } Drawing lines with the Pen 
Tool

{button ,EF("XaraDemo.exe","CurvEdit Editing Lines and Shapes with the Shape Editor Tool",1,`') } Editing lines with the 
Shape Editor Tool

{button ,EF("XaraDemo.exe","FreeEdit Editing Lines and Shapes with the Freehand Tool",1,`') } Editing lines with the 
Freehand & Brush Tool

{button ,EF("XaraDemo.exe","PenEdit Editing Lines and Shapes with the Pen Tool",1,`') } Editing lines with the Pen Tool

{button ,EF("XaraDemo.exe","LineBits Editing Line Width Ends and Joins",1,`') } Editing line widths, ends and joins

{button ,EF("XaraDemo.exe","Smooth Smoothing Lines and Shapes",1,`') } Smoothing lines and shapes

{button ,EF("XaraDemo.exe","JoinBrk Joining and Breaking Lines and Shapes",1,`') } Joining and breaking shapes

_______________
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Linked stretching (auto-scaling objects)

You can use named objects to stretch other named objects. 

An example is a button with text on it. Changing the text could automatically stretch the button to match the new width. The 
following instructions use this example of text stretching a button. (For a simple example like this you would normally use the 
Button & NavBar Tool and convert them into a button    - more details.)

Naming objects
Both the button and the text must be named objects. So the first step is to give separate names to the text and the button.

1. Select the first object you want to name (for this example either the text or the button). For more information see Selecting 
objects.

2. You can use either the Selector Tool or the Name Gallery.
In the Selector Tool click Create new name. Enter the name you want and click Apply.
In the Name Gallery click New. Enter the name you want and click Apply.

3. Name the other object.
Making named objects auto-stretching

You need to flag the name of the button (as this is the object that stretches). No action is needed for the name of the text.
1. In the Name Gallery select Stretches from the Properties drop-down list.
2. Click the arrow to the right of the button name. This displays the Extend dialog box. Full information on this dialog box.
3. In this dialog box select the check box for the text name.
4. Select how you want the button to stretch.
5. Click OK.

Now when you change the text, the button size automatically changes.

Notes
You can turn off auto-scaling temporarily by deselecting the check box to the right of the button name.
You can still scale the button in the regular way.
Several objects can share a common name. Also an object can have more than one name.
All objects that use the button name stretch as you change the size of the text. 
If more than one object shares the name of the text, stretching occurs when the size of the bounding box changes.
Creating navigation bar buttons with text on them makes the buttons auto-stretching. You can temporarily switch off 

stretching by deselecting Live stretching on the Button & NavBar Tool Infobar.

_______________
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Linked stretching using the Button & NavBar Tool

This is an alternative to using the Name Gallery to control object stretching. If you create a button with text on it using the Button & 
NavBar Tool, the width of the button automatically stretches if you later change the amount of text.

Using linked stretching
1. Create the objects in the regular way.
2. Select the Button & NavBar Tool.
3. If necessary, select the button - see Selecting objects.
4. Click New. This opens the Bar Properties dialog box.
5. Select the required options in the Bar Properties dialog box - more details on these options. Set Number of buttons to 1.
6. Click Create.

Now when you change the text, the button size automatically changes.

Notes
You can combine this method with the Name Gallery method.
You can still scale the button in the regular way.
All objects that make up the button stretch as you change the size of the text. The exception is that optionally groups can 

be non-stretching. To make groups non-stretching select Groups do not stretch in the Bar Properties dialog box.
You can temporarily switch off linked stretching by deselecting Live stretching on the Button & NavBar Tool Infobar.

_______________
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List of Default Control Bars

Xara X contains several default control bars in addition to the Toolbar and the tool-specific Infobar. The button palette contains all 
the buttons available in Xara X. You can copy buttons from the button palette to existing or new control bars. You can also remove 
buttons from control bars (but not from the button palette.) Descriptions of the functions of the buttons can be found in the following 
pages:

Standard Control Bar
File Control Bar
Edit Control Bar
Feather Control bar
Arrange Control Bar
Window Control Bar
Gallery Control Bar
General Control Bar
GIF Animation Control Bar
Imagesetting Control Bar
Button Palette Control Bar

_______________
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 List of Keyboard Shortcuts

This page contains a list of the key shortcuts available in Xara X. If you want any more information on what a shortcut does, click 
on the underlined text next to it.

The Tools

Selector Tool F2 or ALT+S (or the Space Bar if you are not using the Text tool).

Freehand & Brush Tool F3

Shape Editor Tool F4

Pen Tool SHIFT+F5

Rectangle Tool SHIFT+F3

Ellipse Tool SHIFT+F4

QuickShape Tool SHIFT+F2

Text Tool F8

Fill Tool F5

Transparency Tool F6

Shadow Tool CTRL+F2

Bevel Tool CTRL+F3

Contour Tool CTRL+F7

Blend Tool F7

Mold Tool SHIFT+F6

Button & NavBar Tool CTRL+F8

Push Tool SHIFT+F8 or ALT+X

Zoom Tool SHIFT+F7 or ALT+Z

The Galleries

Font Gallery SHIFT+F9

Clipart Gallery SHIFT+F10

Fill Gallery SHIFT+F11

Frame Gallery SHIFT+F12

Color Gallery F9

Layer Gallery F10

Bitmap Gallery F11

Line Gallery F12

Name Gallery CTRL+SHIFT+F9

Zooming

Previous Zoom CTRL+R

Zoom To Selection CTRL+SHIFT+Z

Zoom To Page CTRL+SHIFT+P

Zoom in (enlarge) CTRL + '+' on the numeric keypad

Zoom out (reduce) CTRL + '-' on the numeric keypad

You can also zoom and slide the document using a mouse-wheel.

Manipulating Documents

¶ When in the Text Tool, these shortcuts have a different action - see below.

New documentCTRL+N

New Animated document   CTRL+SHIFT+N

Open document                   CTRL+O

Print document CTRL+P

Save document CTRL+S

Import CTRL+SHIFT+I

Import graphics from Web CTRL+W ¶

Export CTRL+SHIFT+E

Time a document redraw CTRL+SHIFT+T

Snap to objects ' * ' on the numeric keypad

Show Grid #

Snap to grid '.' on the numeric keypad

Show Rulers CTRL+L ¶



Select full screen 8 on the numeric keypad

Undo CTRL+Z or '<' or ','

Redo CTRL+Y or '>' or '.'

Manipulating Objects

¶ When in the Text Tool, these shortcuts have a different action - see below.

Select all CTRL+A ¶

Put object to back CTRL+B ¶

Copy object to clipboard CTRL+C

Duplicate object with offset CTRL+D

Bring object to front CTRL+F

Group objects CTRL+G

Export sliced image CTRL+I ¶

Clone object CTRL+K

Ungroup objects CTRL+U

Paste object from clipboard CTRL+V

Cut selection to clipboard CTRL+X

Paste Attributes CTRL+SHIFT+A

Move object backwards CTRL+SHIFT+B

Create Bitmap Copy CTRL+SHIFT+C

Move object to layer behind (drawing documents) CTRL+SHIFT+D

Move to previous frame (animation documents) CTRL+SHIFT+D

Move object forwards CTRL+SHIFT+F

Open the Alignment dialog box CTRL+SHIFT+L

Convert to Editable Shapes CTRL+SHIFT+S

Move object to layer in front (drawing documents) CTRL+SHIFT+U

Move to next frame (animation documents) CTRL+SHIFT+U

Paste object in original position CTRL+SHIFT+V

Web Address CTRL+SHIFT+W

Add shapes         CTRL+1

Subtract shapes CTRL+2

Intersect shapes CTRL+3

Slice shapes CTRL+4

Delete the selection DELETE ¶

(in the Text Tool, this key deletes the selected characters or the character to the left of the text cursor)

Clear selection ESC

Move the selected objects Cursor (arrow) keys with the Selector Tool

Move the selected handles Cursors (arrow) keys in tools other than the Selector.

Select next object TAB

Nudging objects - see Nudging objects and handles

Text Tool

Cursor keys Move the text cursor one character at a time up, down, left or right.

Home Move the text cursor to the start of the line.

End Move the text cursor to the end of the line.

CTRL+right-cursor Move the text cursor right one word.

CTRL+left-cursor Move the text cursor left one word.

CTRL+HOME Move the text cursor to the start of the first line in a text object.

CTRL+END Move the text cursor to the end of the last line in a text object.

CTRL+A Selects all characters in a text object.

CTRL+B Apply the Bold attribute (see Bold).

CTRL+I Apply the Italic attribute (see Italic).

CTRL+C Copy the selected region of text to the clipboard.

CTRL+L Selects all characters in the line containing the text cursor.

CTRL+V Paste text at the text cursor position (If the clipboard contains text)

CTRL+W Swap the case of the character to the right of the text cursor.



CTRL+equals/plus key Increase kerning/tracking.

CTRL+underline/minus key    Decrease kerning/tracking.

RETURN Start a new line of text.

DELETE Delete the character to the right of the text cursor. If the cursor is on the end of a text line, join this line 
to the line below.

BACKSPACE Delete the character to the left of the text cursor. If the cursor is at the start of a text line, join this line 
to the line above.

SHIFT+cursor keys Select all text between the cursor position and the beginning of the line.

SHIFT+END Select all text between the cursor position and the end of the line.

Other

Color Editor CTRL+E (opens and closes)

Options dialog box CTRL+SHIFT+O

Xara X Help F1

_______________
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List of Menus

The menu bar has these options:
File
Edit
Arrange
Utilities
Window
Help

Note for CorelXARA 2 users:
Plug-ins is now called Bitmap Effects & Plug-ins and has moved to the Utilities menu.

_______________
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List of Supported File Formats

List of Import formats
List of Export formats

_____________________________________

Import formats
It important that you use the three letter file extensions listed below when you load files into Xara X.

Bitmap Import Formats

.301 Brook Trout

.BMP Windows Bitmap

.CAL CALS (2 color)

.CUT Halo CUT (256 color)

.DCX DCX

.GIF CompuServe Graphics Interchange Format (see Importing transparent bitmap files)

.GX2 Storyboard

.ICA IOCA (2 color)

.ICO Microsoft Windows Icon (16 color)

.IFF Amiga IFF

.IMG IMG (16 color)

.JPG JPEG

.KFX KOFAX

.LVLaserView (2 color)

.MAC MacPaint (2 color)

.MSP Microsoft Paint (2 color)

.PCD PhotoCD

.PCT PICT

.PCX PCX Paintbrush

.PBM UNIX monochrome

.PGM UNIX grayscale

.PNG PNG (see Importing transparent bitmap files)

.PPM UNIX color (up to 24 bit)

.PSD Photoshop

.RAS Sun Raster

.TGA TrueVision TARGA

.TIF TIFF (RGB, RGBA with alpha-channel transparency & CMYK)

.WPG Word Perfect Group (256 color)

.XBM X Windows (2 color)

.XPM X Windows (256 color)

EPS Import Formats

.AI Illustrator EPS

.EPS Illustrator EPS

.EPS CorelDRAW 3 & 4 EPS

.EPS FreeHand 3.0 EPS

.EPS ArtWorks EPS

Xara X cannot import Photoshop EPS files; use PSD files instead.

Other Import Formats

.XAR CorelXARA (1.1 and 1.5)

.ART Xara Studio

.WEB Xara Webster files

.AFF Acorn Draw

.CDR CorelDRAW (3,4 & 5) (see Importing CDR files)

.CDT CorelDRAW Template

.CMX Corel CMX 5 & 6 (see Importing CMX files)

.DRW Acorn Draw



.HTM Graphics on HTML pages

.WMF Windows Metafile

.WIX For internal use by Xara

Palette Import Formats

.CPL CorelDRAW Palette

.PAL CorelDRAW Palette

.PAL Microsoft Palette

.PAL PaintShop Pro Palette

.ACT Adobe Color Table

.ACO Adobe Color Swatch

For information on how to import palettes, see Importing colors and palettes.

_____________________________________

Export formats
Bitmap Export Formats

.BMP Windows Bitmap (see Creating BMP files)

.DCX DCX (see Creating DCX files)

.PCX PCX (see Creating PCX files)

.GIF CompuServe GIF (see Creating GIF files)

.GIF Animated GIF files (see Creating animated GIF files)

.JPG JPEG (see Creating JPEG files)

.PCT PICT (see Creating PICT files)

.PNG PNG (see Creating PNG files)

.RAS Sun Raster (see Creating RAS files)

.TGA TrueVision TARGA (see Creating TARGA files)

.TIF TIFF (RGB) (see Creating TIFF files)

.WPG Word Perfect Group (256 color) (see Creating WPG files)

EPS Export Formats

.AI Illustrator EPS

.EPS Illustrator EPS

.EPS ArtWorks EPS

.EPS Xara X EPS (see Xara X EPS Overview)

Other Export Formats

.XAR CorelXARA

.WEB Xara Webster files (see Creating Xara WEB files)

.WMF Windows Metafile (see Exporting Windows Metafiles)

.EMF Enhanced Windows Metafile (see Exporting Windows Metafiles)

.CMX Corel CMX 5 & 6 (see Exporting CMX files)

.HTM Image map

.SWF Macromedia Flash (see Exporting Macromedia Flash files)

.WIX For internal use by Xara



List of Text Tool key shortcuts

Cursor keys Move the text cursor one character at a time up, down, left or right.

Home Move the text cursor to the start of the line.

End Move the text cursor to the end of the line.

CTRL+right-cursor Move the text cursor right one word.

CTRL+left-cursor Move the text cursor left one word.

CTRL+HOME Move the text cursor to the start of the first line in a text object.

CTRL+END Move the text cursor to the end of the last line in a text object.

CTRL+A Selects all characters in a text object.

CTRL+B Apply the Bold attribute (see Bold).

CTRL+I Apply the Italic attribute (see Italic).

CTRL+C Copy the selected region of text to the clipboard.

CTRL+L Selects all characters in the line containing the text cursor.

CTRL+V Paste text at the text cursor position (If the clipboard contains text)

CTRL+W Swap the case of the character to the right of the text cursor.

CTRL+equals/plus key Increase kerning/tracking.

CTRL+underline/minus key    Decrease kerning/tracking.

RETURN Start a new line of text.

DELETE Delete the character to the right of the text cursor. If the cursor is on the end of a text line, join this line 
to the line below.

BACKSPACE Delete the character to the left of the text cursor. If the cursor is at the start of a text line, join this line 
to the line above.

SHIFT+cursor keys Select all text between the cursor position and the beginning of the line.

SHIFT+END Select all text between the cursor position and the end of the line.

For details of how to enter special characters with the Text Tool, see Typing international characters.



List of Text Tool key shortcuts

This is a master list - it does not appear as a public page

Cursor keys Move the text cursor one character at a time up, down, left or right.

Home Move the text cursor to the start of the line.

End Move the text cursor to the end of the line.

CTRL+right-cursor Move the text cursor right one word.

CTRL+left-cursor Move the text cursor left one word.

CTRL+HOME Move the text cursor to the start of the first line in a text object.

CTRL+END Move the text cursor to the end of the last line in a text object.

CTRL+A Selects all characters in a text object.

CTRL+B Apply the Bold attribute (see Bold).

CTRL+I Apply the Italic attribute (see Italic).

CTRL+C Copy the selected region of text to the clipboard.

CTRL+L Selects all characters in the line containing the text cursor.

CTRL+V Paste text at the text cursor position (If the clipboard contains text)

CTRL+W Swap the case of the character to the right of the text cursor.

CTRL+equals/plus key Increase kerning/tracking.

CTRL+underline/minus key    Decrease kerning/tracking.

RETURN Start a new line of text.

DELETE Delete the character to the right of the text cursor. If the cursor is on the end of a text line, join this line 
to the line below.

BACKSPACE Delete the character to the left of the text cursor. If the cursor is at the start of a text line, join this line 
to the line above.

SHIFT+cursor keys Select all text between the cursor position and the beginning of the line.

SHIFT+END Select all text between the cursor position and the end of the line.

For details of how to enter special characters with the Text Tool, see Typing international characters.



Listing the positions of guidelines

The rulers at the sides of the window quickly show you the guideline positions. The Layer Gallery also gives you a complete list. 
Note that the Layer Gallery is    available only in Drawing documents - see Drawing and Animation documents for details.

To list the positions of guidelines
1. Open the Layer Gallery.
2. Select the guides layer.
3. Open the layer pop-up menu.
4. Choose Properties to open the Layer Properties dialog box.
5. Open the Guides tab - it shows the positions of all the guidelines.
6. Click Horizontal or Vertical to show the guidelines.

Tip
To change the position of a guideline, select it and click the Properties button to open the Guideline Properties dialog 

box.
In Animation documents right-click on a guide line to display its exact position.

_______________

{button ,KL(`layers,layer gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Loading files

Note the difference between Loading (which opens the drawing in a separate window) and Importing (which loads the drawing 
into the existing window).

To load a file
1. Click the Open button on the control bars.
2. Choose the location and file name of the file.

Tips
You can also load a file by dragging it from the Explorer (or File Manager) onto Xara X. Drop it onto the control bars or 

anywhere away from the document because if you drop it onto a document it will be imported into that document.
If you have loaded the file recently its name will be on the bottom of the File menu. Click to load it.
If the file is on the Xara X CD you can use the Clipart Gallery to load it. You can add your own files to the Clipart Gallery.
For a list of types of file Xara X can load, see List of Supported File Formats.

_______________

{button ,KL(`importing;loading;opening',0,`____No_Topics_Found',`')}    Related Topics



Locking handles onto the edges of objects

You can easily do this using object snapping.
To lock a handle onto the edge of an object

1. From the Window Menu, choose Object Snapping.
2. Drag the handle near the edge of the object.

If you release the mouse button when the mouse pointer has a small magnet next to it, the handle will rest exactly on the edge of 
the object.

Tip
This also work with the edges of the page.

_______________

{button ,KL(`object snapping',0,`____No_Topics_Found',`')}    Related Topics



Locking layers

You can create complex drawings as a series of layers. As you complete each part of the drawing you can lock the layer (make it 
non-editable). This ensures you cannot accidentally move objects. When a layer is editable, objects on it can be selected and 
edited. If you try to click on an object on a non-editable layer the click will pass straight through it as if it was not there. Even 
Select All will only select object in visible, editable layers.

To lock layers
1. From the Utilities menu, choose Layer Gallery to open the Layer Gallery.
2. In the columns next to the layer name, click the right-hand check box to swap the layer between locked and editable.

Tips
You can make all layers editable temporarily by clicking the All Layers Editable button at the top of the gallery. Clicking it 

again sets all the layers back to their previous state.
The current layer (the one highlighted in the Layer Gallery) can be forced to always be editable and visible (see General 

Options).
The editable setting for a layer can also be set by right-clicking on the Layer Gallery and choosing Properties.
To make a sequence of layers editable, set the first to editable and SHIFT-click on the last. The editable setting of all the 

layers in between change too.

_______________

Related Topics

Layers Gallery
Layers overview



Macromedia Dreamweaver - making Xara X the default editor

Dreamweaver is a popular program for web site design. You can create graphics in Xara X and then import them into 
Dreamweaver. You will probably also want to use Xara X for editing GIFs and JPEGs. The easiest way to do this is to make Xara X 
the default graphics editor for Dreamweaver.

Making Xara X the default editor

These instructions refer to Dreamweaver 3. Macromedia may introduce new versions for which these instructions do not apply.
1. In Dreamweaver, select Launch external editor on the File menu.
2. Select GIF.
3. Click + in the Editors field.
4. Browse to the Xara X folder.
5. Select xarax.exe
6. Select Make primary to make Xara X the default editor for GIFs.

You can repeat steps 2 thru 6 for JPEGs and PNGs.

Movie

{button ,EF("XaraDemo.exe",`Dreamwv Dreamweaver integration',1,`') } Dreamweaver integration
Dreamweaver is a registered trademark of Macromedia Inc.

_______________

{button ,KL(`Macromedia Dreamweaver',0,`____No_Topics_Found',`')} Related Topics



Macromedia Dreamweaver support for Navigation Bars

Dreamweaver is a popular program for web site design. Now you can create navigation bars in Xara X and link them into 
Dreamweaver. Then, if you need to make further edits, Dreamweaver can tell Xara X which source file to load - easy.

A separate page covers Dreamweaver support for single bitmaps. Navigation bars are more complicated than single bitmaps 
because they also require some HTML code - this is also imported into Dreamweaver.

Exporting a file

Dreamweaver version 3 (or later) must be installed on your computer.

See this page for details of creating a navigation bar.
1. Before exporting the navigation bar as bitmaps you must save the Xara X document to disk - see Saving a document. You only 

need to do this once so Xara X knows where to find the document on your computer.
2. Select the Button & NavBar Tool.
3. If necessary, select the entire navigation bar - see Selecting navigation bar objects.
4. Click Export on the Button & NavBar Tool Infobar.
5. Enter a name of the file where you want to save the HTML code. (See Note.)
6. Select the file type for the button bitmaps. Usually you would use either GIF or JPEG.
7. Click Save to move to the second dialog box. For full information on this dialog box, click its Help button.
8. Select options in the regular way for number of colors etc.
9. On the Image map tab select Add design note. This button is dimmed unless (a) you have Dreamweaver installed on your 

computer and (b) you have saved the Xara X document.
10. Click Export. This exports the HTML code, the bitmaps and sets up the links required for Dreamweaver.

Note:

If the HTML file you selected in step 5 already exists, you have two choices:
Overwrite (Replace) all the existing contents.
Insert the navigation bar into the existing page. This overwrites any existing Xara X navigation bar but does not affect 

other parts of the page. A new navigation bar appears at the top of the page and you may need to move it.
Moving the navigation bar in Dreamweaver

Xara X inserts the navigation bar at the top of the web page. If you want it in a different position, just cut the entire navigation bar 
and paste it in the required position. Check the Dreamweaver help for more information.

Editing the navigation bar from within Dreamweaver

These instructions refer to Dreamweaver 3. Macromedia may introduce new versions for which these instructions do not apply.

Before editing the navigation bar, you need to make Xara X the default editor (the 'primary external editor') for Dreamweaver - full 
details.
1. In Dreamweaver, select the navigation bar.
2. In Dreamweaver, click Edit on the Properties palette. The opens the original XAR file in Xara X ready for editing.
3. In Xara X: after making your changes, just click Export on the Button & NavBar Tool Infobar and export the file using the same 

file name. When you get the warning about the HTML file already existing, click Insert. The navigation bar in Dreamweaver 
automatically updates.

Note:
To select the navigation bar you can also right-click on it then choose Edit.

Movie

{button ,EF("XaraDemo.exe",`Dreamwv Dreamweaver integration',1,`') } Dreamweaver integration
Dreamweaver is a registered trademark of Macromedia Inc.

_______________

{button ,KL(`Macromedia Dreamweaver',0,`____No_Topics_Found',`')} Related Topics



Macromedia Dreamweaver Support for Single Bitmaps

Dreamweaver is a popular program for web site design. Now you can create graphics in Xara X and link them into Dreamweaver. 
Then, if you need to make further edits, Dreamweaver can tell Xara X which source file to load - easy. This applies to GIFs, BMPs, 
JPEGs and PNGs.

A separate page covers support for navigation bars.
Exporting a file

Dreamweaver version 3 (or later) must be installed on your computer.
1. Before exporting the bitmap you must save the Xara X document to disk - see Saving a document. You only need to do this 

once so Xara X knows where to find the document on your computer.
2. Choose Export on the File menu.
3. Enter a name and file type. 
4. Click Save to move to the second dialog box. For full information on this dialog box, click its Help button.
5. Select options in the regular way for number of colors etc.
6. On the Image map tab select Add design note. This button is dimmed unless (a) you have Dreamweaver installed on your 

computer and (b) you have saved the Xara X document.
7. Click Export to export the bitmap. This exports the bitmap and sets up the links required for Dreamweaver.

Using the bitmap in Dreamweaver

Import the bitmap into Dreamweaver in the regular way. Check the Dreamweaver help for more information on importing graphics.
Editing the bitmap from within Dreamweaver

These instructions refer to Dreamweaver 3. Macromedia may introduce new versions for which these instructions do not apply.

Before editing the bitmap, you need to make Xara X the default editor for Dreamweaver - full details.
1. In Dreamweaver, select the bitmap.
2. In Dreamweaver, click Edit on the Properties palette. The opens the original XAR file in Xara X ready for editing.
3. In Xara X: after making your changes, just reexport the file using the same file name. This automatically updates the bitmap in 

Dreamweaver.

Movie

{button ,EF("XaraDemo.exe",`Dreamwv Dreamweaver integration',1,`') } Dreamweaver integration
Dreamweaver is a registered trademark of Macromedia Inc.

_______________

{button ,KL(`Macromedia Dreamweaver',0,`____No_Topics_Found',`')} Related Topics



Making a polygon star-shaped

You can easily change a polygon created using the QuickShape Tool into a star shape.
To make a polygon star-shaped

1. Select the polygon.
2. Choose the QuickShape Tool.
3. Click the Star button on the QuickShape Tool Infobar.

Tips
You can also select the polygon and double-click on the edge of the polygon. (Click on the edge, not on a curved corner.)
You can also select the QuickShape, choose the QuickShape Tool and then click the Star Button on the Infobar.
A new set of handles appears on the object between each existing handle. The new handles are inset and can be moved 

independently allowing a massive variety of different shapes to be drawn.

_______________

Related Topics

QuickShape Tool
QuickShapes overview
Polygons



Making a straight line curved

Changing a straight line to curved is simple in Xara X.
To make a straight line curved

1. Select the line or shape (see Selecting objects).
2. Select the two point handles on either side of the straight segment (see Selecting points handles).
3. Choose the Shape Editor Tool.
4. Click the Curved Lines button on the Shape Editor Tool Infobar..

Tips
Now the segment is a curved segment you can shape it as you want. See Changing curved lines and shapes.



Making text bold

Once you have created a text object, you can make all the characters in it bold, or just some of them. If you want to create a new 
text object in bold, just place the text cursor in the document and click the Bold button on the Text Tool Infobar.

To make text bold
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the Bold button on the Infobar.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Making text italic

Once you have created a text object, you can make all the characters in it italic or just some of them. If you want to create a new 
text object in italic, just place the text cursor in the document and click the Italic button on the Text Tool Infobar.

To make text italic
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the Italic button on the Infobar.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Making text superscript and subscript

Once you have created a text object, you can make characters in it superscript or subscript. If you want to create a new text object 
in superscript or subscript, place the text cursor in the document and click the Superscript button or the Subscript button on the 
Text Tool Infobar.

To make text superscript or subscript
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the Subscript button or the Superscript button on the Infobar.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Masking a bitmap

Masking a bitmap lets you discard unwanted areas at the edges. You can even cut out just a part of the bitmap.
To mask a bitmap

Method 1:

This does not need a separate mask.
1. Select the bitmap
2. Choose Convert to Editable Shapes from the Arrange menu.
3. Edit the new shape as you would a normal shape.

This is an easy method for simple cropping.

Method 2:
1. Import the bitmap into Xara X.
2. Choose the Freehand & Brush Tool.
3. Create a mask by carefully draw around the area to be masked. End the line over the start to form a shape.
4. Select the bitmap and the mask.
5. From the Combine Shapes submenu on the Arrange menu, choose Intersect Shapes.

This method is slightly more complex but has the advantage you crop a bitmap to any irregular shape.

Tip
You can also create masks using the QuickShape, Ellipse, Rectangle, Pen and Shape Editor Tools.

With both methods, the bitmap becomes a simple editable shape with a bitmap fill applied. You can then edit the object like any 
other shape. For example by using the Freehand & Brush Tool. See Redrawing part of a line or shape for more details.

_______________

{button ,KL(`bitmaps,bitmaps overview',0,`____No_Topics_Found',`')}    Related Topics



Masking or clipping objects

Xara X has several ways of using objects to "mask" or "clip" other objects. You then see part of the objects through the mask.
Intersect shapes: this uses an object as a "mask". Selecting this menu option discards those areas of selected objects not 

covered by the mask. The mask object disappears. See Intersecting shapes.
ClipView: this uses an object as a "window" onto other objects. You can move or resize the window to change your view 

onto the masked objects. The window object remains visible. See Using ClipView.
(for bitmaps) Convert to editable shapes: the bitmap appears within an arbitrarily shaped object. You can edit the shape of 

the object to mask unwanted areas of the bitmap. See Masking a bitmap.

Notes:
You are not limited to using a single shape as a mask or window. You can also use groups, joined shapes or combined 

shapes.



Menus and Buttons

Xara X has a standard Windows menu bar containing all the options additional to the Tools. Additionally Xara X has a wide range 
of default control bars available which provide buttons to access these options more easily.

List of Menus
List of Default Control Bars

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Message: A bars settings file is invalid or corrupt

Cause

The stored configuration of the control bars and Galleries is corrupted.

What Can I Do?
Click OK to restore the default settings. This loses any customized control bar and gallery settings.

{button                      Close this window                    ,CW(`main')}



Message: A problem occurred when installing or de-installing a font

Cause

You have tried to install a font that is already installed, or you have tried to de-install a font that is currently being used in a 
document. It is also possible the font file itself is corrupt.

What Can I Do?
Installing a font - check that it isn't installed already. 
De-installing a font - make sure it isn't being used in any loaded documents.

If these do not apply, it is likely the font file is corrupt. You need to reinstall the font from a backup using the Fonts section of 
Control Panel.

{button                      Close this window                    ,CW(`main')}



Message: Abort or continue printing

Cause

You have suspended a print job.

What Can I Do?
Click the Abort button to cancel the suspended print job
Click the Continue button to resume printing.

{button                      Close this window                    ,CW(`main')}



Message: Are you sure you want to install or deinstall this font?

Cause

This message is displayed when you install or de-install a font.

What Can I Do?
Click the Install button to install the font or de-install to de-install the font.
Click the Cancel button to abort the operation.

Note
De-installing a font removes it from your system. The font cannot be recovered unless you have another copy.

{button                      Close this window                    ,CW(`main')}



Message: Are you sure you want to print this document as a bitmap

Cause

You have tried to print a document using color separations when you have the option to print the document as a bitmap set. If you 
print color separations with the printing method set to Bitmap or Anti-aliased Bitmap, the following occurs:

All spot colors will be output as process RGB colors. All spot plates will be blank.
All CMYK colors will be converted to RGB color, and thus color-separate differently. See Imagesetting points to note.
Printer's marks are not output to the bitmap separations.

What can I do?
Change the printing method in the Print As section in the Output Options.

{button                      Close this window                    ,CW(`main')}



Message: Objects cannot have both bevels and contours

Cause

You have tried to apply a contour to an object that already has a bevel. You cannot do this.

What Can I Do?
If you want the object to have a contour, you need to first remove the bevel.

{button                      Close this window                    ,CW(`main')}



Message: Bitmap is being used within a document

Cause

You have attempted to delete a bitmap from the Bitmap Gallery. This bitmap is used in a loaded document.

What Can I Do?
Choose Delete to delete the bitmap from the gallery. The bitmap is replaced in the document by the default bitmap.
Choose Cancel to keep the bitmap in the gallery.

{button                      Close this window                    ,CW(`main')}



Message: Bitmap too large

Cause

The bitmap you are trying to create is too large. You can export bitmaps up to 16,000 by 16,000 pixels.

What can I do?

By making some changes to your configuration, you can install a new XaraDraw module that will allow you to export bitmaps up to 
32,000 pixels by 32,000 pixels. Upgrading the program to this new limit will mean Xara X uses another 2Mb of RAM. It is not 
recommended unless you need to create bitmaps this large and your machine has enough RAM.

To increase the bitmap export size
1. Close down Xara X.
2. Go to the folder where you installed Xara X.
3. Rename the 'xaradraw.dll' file to 'xdsmall.dll'
4. Rename the 'xdlarge.dll' file to 'xaradraw.dll'

To reverse the change either do this again, reversing steps 3 & 4 or reinstall Xara X.

{button                      Close this window                    ,CW(`main')}



Message: Cannot close file

Cause
If the file is on a floppy disk, the disk may have been removed from the drive. 
If the file is on a hard disk, the disk structure may be corrupt.

What Can I Do?
If the file is on a floppy disk, check the disk is correctly inserted in the drive.
If the file is on a hard disk, run your disk diagnostic utilities to check for a corrupted disk structure.

{button                      Close this window                    ,CW(`main')}



Message: Cannot create file

Cause

The program tried to create a file but did not succeed. This may be because:
The disk is full.
The drive is read-only (For example, a CD-ROM drive).
A file of that name already exists and is read-only.
You do not have write permission for the folder.

What Can I Do?
Check that the disk is not full - if it is, then choose another disk or delete some unwanted files from it.
Choose another name for the file, or another disk or folder.
Ask your system administrator to change your access permissions.

{button                      Close this window                    ,CW(`main')}



Message: Cannot open web page

Cause

The program could not open the web page you requested. This may be because:

- The web page does not exist.

- You are not connected to the Internet. Connect to the net and try again.

- The weblink utility that Xara X uses to open web pages could not be found.

What can I do?
Ensure the web page exists and ensure your machine is connected to the Internet and try again. If this doesn't solve the 

problem the weblink utility may have been moved or deleted. Try reinstalling Xara X.

{button                      Close this window                    ,CW(`main')}



Message: Cannot read or write Registry entries

Cause

The Registry entries for this program have been deleted or corrupted.

What Can I Do?
This is a serious problem - we recommend reinstalling the program. If the problem persists, contact Technical Support.

{button                      Close this window                    ,CW(`main')}



Message: Close open documents?

Cause

This message is displayed when the Ask about closing document views option is set in the General Options. When ever a new 
document is created or an existing document is loaded the message 'Would you like to keep the existing documents open?' is 
displayed with buttons labeled Keep and Close . 

What Can I Do?
If only the current document is required, and all others can be closed, then click Close. You are warned about documents 

that have been modified and not saved in the usual way.
If all the existing documents should remain open then click Keep. This does nothing to the existing documents open in 

Xara X. This acts the same as if the option is turned off.
If you do not require the warning any more then go to the General Options and turn the option off.

{button                      Close this window                    ,CW(`main')}



Message: Objects cannot have both bevels and contours

Cause

You have tried to apply a bevel to an object that already has a contour. You cannot do this.

What Can I Do?
If you want the object to have a bevel, you need to first remove the contour.

{button                      Close this window                    ,CW(`main')}



Message: CorelDRAW version 6 files are not supported

Cause

You cannot load CorelDRAW 6 (or later) CDR files into Xara X.

What Can I Do?
Resave the file from CorelDRAW in CMX 6 format (or CDR 5 or CMX 5).
Note that a CorelDRAW 6 file will load into Xara X if it contains a CMX file. To include a CMX file in a CDR file, select 

Include Presentation Data in the Save dialog box in CorelDRAW.

{button                      Close this window                    ,CW(`main')}



Message: Creating a new index

Cause

This message is displayed after attempting to create a new index for a folder.

What Can I Do?
Unless otherwise stated, the index and thumbnails will be placed in the XaraInfo subfolder in the selected folder. This will 

require disk-space, and it is left up to you to delete this sub-folder if you require the space back. If this is OK, click Create, otherwise 
click Cancel.

{button                      Close this window                    ,CW(`main')}



Message: Creating remote indexes

Cause

This message is displayed when the selected folder is read-only, but does not have an index.

What Can I Do?
If you are creating an index and thumbnails and the specified location is OK, click Create. If you do not want to create an 

index there, click Cancel.
You can change the location which the program attempts to use for the remote indexes via a setting in the program's 

section of the registry. Details on how to this are below. Do this only if you are familiar with editing registry entries.
Changing the remote index location in Xara X

1. Exit Xara X
2. From the command prompt, type "regedit"
3. Open HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\Libraries\    (where XX is the version you are using).
4. Change the RemoteIndexLocation value, for example "C:\Xara X".
5. Restart Xara X.

{button                      Close this window                    ,CW(`main')}



Message: Do you want to overwrite the old format file?

Cause

The file you loaded was saved by CorelXARA version 1.1. Xara X and later versions of CorelXARA use a new, faster, file format. 
Older files are not automatically replaced by the new format because you may want to load the file into CorelXARA 1.1.

What Can I Do?
To replace the original file with new format, click Overwrite.
To save the file in the new format to a different location, click Save As.
To save the file in the older format, click Cancel and use Export from the File menu to export the file as a CorelXARA 1.1 

file.

{button                      Close this window                    ,CW(`main')}



Message: Do you want to print all these plates?

Cause

You are about to print a document with more than six plates set to print.

Printing a large number of plates can generate a large printout file, and can be very expensive. It has happened because you have 
used many spot colors in your document - each spot color generates a new printing plate.

What Can I Do?
To print anyway, click Print.
To cancel the print job, click Cancel.

To reduce the number of plates
Use the Color Editor to change Spot colors in your document into Normal colors, so that they print as regular process 

colors rather than generating extra plates.
From the print options dialog Separations tab, turn on Print spot colors as process colors - this eliminates all the spot 

plates and just leaves the four process plates.

{button                      Close this window                    ,CW(`main')}



Message: Document file is invalid

Cause

The file you tried to open or import is corrupt or has the wrong format. For a list of file types supported, see the List of Supported 
File Formats.

What Can I Do?
Recreate the document file from a backup or from the original creating program.

{button                      Close this window                    ,CW(`main')}



Message: Document is unsaved

Cause

You have tried to close a document, or exit the program when a document has changed since it was last saved. If you continue 
exiting the program you will lose these changes.

What Can I Do?
Click Save if you want to save your work and keep the changes.
Click Don't Save to discard the changes you have made to the document.
Click Cancel to cancel the operation and leave the program running.

{button                      Close this window                    ,CW(`main')}



Message: Drawing is too large for CMX export

Cause

The drawing you are exporting is more than 40 inches across. You can only save drawings in CMX 5 format if they are smaller 
than 40 inches across.

What Can I Do?
You do not need to do anything. Xara X has automatically scaled your drawing so it fits.
If you do not want the drawing scaled, use another format like CMX 6 which does not have a limit on page size.

{button                      Close this window                    ,CW(`main')}



Message: Peripheral objects overlap

Cause

One or more elements (such as a shadow) associated with a named object overlaps another named object. Normally a object and 
its shadow (and similar elements) are exported in the same slice.

What can I do?
Click Yes to export the shadow (or element) in a separate slice or slices from the object. Visually the exported bitmaps 

look the same; all that changes is how the graphic is sliced. However note that in the HTML code created by Xara X, the shadow 
loses any web address applied to the object. (Normally it takes the same web address as the object.)

Click No to stop the export operation. You can then separate the overlapping objects.

{button                      Close this window                    ,CW(`main')}



Message: Export entire page or spread?

Cause

If you try to export a document as a bitmap when there are no objects in the document, the bitmap is likely to be very large.

What Can I Do?
If you want to create the bitmap, click Export.
If you do not want to create the bitmap, click Don't Export.

{button                      Close this window                    ,CW(`main')}



Message: Export to Existing File

Cause

This message is displayed when you export an image map and the file you are exporting to already exists.

What Can I Do?
To replace the whole file with the image map in a file on its own, click Replace.
To replace just the image map part of the file with the new image map, click Insert. The program will scan through the 

HTML file looking for image maps with the same name as the one you are exporting. If it finds one, it will replace the existing image 
map with the new image map. If it doesn't, it will insert the image map near the bottom of the file.

{button                      Close this window                    ,CW(`main')}



Message: Failed to find the CD

Cause

This message is displayed when the Find CD button is clicked in the Add folder dialog box, and the CD cannot be found.

What Can I Do?
Insert the CD, and click Find CD again.

{button                      Close this window                    ,CW(`main')}



Message: Failed to locate gallery index

Cause

This message is displayed when the program cannot find the index for a section in the gallery (for example if the folder it was 
contained in has been deleted or if you removed the CD).

What Can I Do?
Click Skip to ignore the error. The relevant gallery section will remain in the gallery, but you cannot open it or search it 

until the index is available.
Click Retry to force the program to look for the index again. This is particularly useful if you have put the CD in the drive.
Clicking Quiet will ignore all errors found and will leave all the sections in the gallery even if the index cannot be found.

{button                      Close this window                    ,CW(`main')}



Message: Failed to make transparency mask for GIF

Cause

The GIF file that was being imported or opened has been loaded correctly but it specifies that it requires transparency. When the 
transparency mask was being created, a problem was encountered and the process halted. Therefore, the GIF file will be 
displayed without the transparency mask. The reason for the failure is likely to be lack of memory.

What Can I Do?
Free up some memory by closing documents or quitting other applications and try loading the GIF file again.

{button                      Close this window                    ,CW(`main')}



Message: File already exists

Cause

You have tried to save or export to a file that already exists.

What Can I Do?
Click Replace to overwrite the existing file.
Click Cancel to abort the save or export. You can then repeat the operation using a different file name.

{button                      Close this window                    ,CW(`main')}



Message: File already exists - replace?

Cause

A file already exists with this name.

What Can I Do?
Click Replace to overwrite the existing file.
Click Insert to copy the new HTML into the existing file. This replaces any existing sliced HTML and JavaScript for this 

graphic but retains other HTML code.
Click Cancel to abort the save. You can then repeat the operation using a different file name.

{button                      Close this window                    ,CW(`main')}



Message: File is read-only

Cause

The program attempted to write to:
a file that is read-only, 
a read-only drive, such as a CD-ROM drive.

What Can I Do?
Use the Windows Explorer to check if the file is read-only. If it is, then the file's read-only status can be changed. 

(Although there may be a reason why the file is read-only - if in doubt, then contact your System Administrator.) Alternatively, choose 
another file name or another disk drive.

{button                      Close this window                    ,CW(`main')}



Message: File not found

Cause

The document file name you typed in does not exist.

What Can I Do?
Check that the name, drive and folder path are correct.
Check that the file exists.

{button                      Close this window                    ,CW(`main')}



Message: File-sharing violation

Cause

Another program is already using this file.

What Can I Do?
Often if you wait a few seconds for the other user to finish, you can write to the file yourself. If this fails, contact your 

System Administrator.

{button                      Close this window                    ,CW(`main')}



Message: Font Not Found

Cause

This message is displayed if the XARAFONT.FON font is not installed. This font is required by Xara X to run.

What Can I Do?
Run the Windows Control Panel application to reinstall this font. Double-click the Fonts icon in Control Panel to display the 

fonts installed on your computer. Choose the File/Install New Font... menu option to display a dialog box that will allow you to enter 
the folder path to the font. When Xara X is installed, the font is copied to the Fonts subfolder of your Windows folder. If the font has 
been deleted from there, a backup copy of it can be found in the Xara X folder, where the Xara X program is located.

Alternatively, reinstalling Xara X will solve the problem.

{button                      Close this window                    ,CW(`main')}



Message: Problem creating fractal

Cause

Either the program is short of free memory or the "FractalDPI" setting in the registry is corrupt. This setting is the default resolution 
used for the creation of Fractal Cloud fills or Fractal Plasma fills.

What Can I Do?

Either:
close some other applications to free some memory in your machine,
or reinstall the program,
or check the registry setting as explained below. Do this only if you are familiar with editing registry entries. Making 

an incorrect change could cause serious problems.
Checking the registry setting in Xara X

1. Exit Xara X
2. From the command prompt, type "regedit"
3. Open HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\Attributes\      (where XX is the version you are 

using).
4. Ensure the FractalDPI value is "96".
5. Restart Xara X.

{button                      Close this window                    ,CW(`main')}



Message: General failure to read or write a file

Cause

There may be a number of reasons why it is not possible to read or write the file. If the file is on a floppy disk, the disk may have 
been removed from the drive. If the file is on a hard disk, the disk structure may be corrupt.

What Can I Do?
If the file is on a floppy disk, check the disk is correctly inserted in the drive.
If the file is on a hard disk, run your disk diagnostic utilities to check for a corrupted disk structure.

{button                      Close this window                    ,CW(`main')}



Message: Incompatible processor

Cause

The processor in your computer is not suitable for running this program. You need an i486 processor, a Pentium processor or 
better. If you have an early Pentium processor, it may be a version that exhibits the FDIV floating point division bug.

What Can I Do?
Contact your computer system vendor for an upgrade.

{button                      Close this window                    ,CW(`main')}



Message: Input is invalid

Cause

You have entered a value that is not of the correct format, or is incomplete.

What Can I Do?
The displayed error message explains what is wrong with what you have typed. Please reenter the data and click OK

{button                      Close this window                    ,CW(`main')}



Message: Internal error

Cause

A logical error has occurred.

What Can I Do?

Please note the circumstances that led up to this message being displayed, and report the problem to us. See Technical Support. 

If you click Continue you will usually be able to save your work and restart the program. It is highly recommended that you save 
the file to a different file name. It is possible the file created will be corrupt due to the internal error and saving the document to the 
same file name will delete the old version and possibly remove any chance of data recovery.

After saving the file, exit Xara X and restart.

{button                      Close this window                    ,CW(`main')}



Message: Invalid file name

Cause

You have entered an incorrect name for a file. Often this is because the file name contains characters that are not permitted in file 
names.

What Can I Do?
Reenter the filename without the offending character.

{button                      Close this window                    ,CW(`main')}



Message: File already exists

Cause

You have tried to export a navigation bar to an HTML file that already exists.

What Can I Do?
Click Replace to overwrite the existing file contents.
Click Insert to insert the navigation bar into the existing page. This overwrites any existing Xara X navigation bar but does 

not affect other parts of the page. (See Note.)
Click Cancel to abort the export. You can then repeat the operation using a different file name.

Note:
The navigation bar is formatted in a <TABLE> tag that is inserted immediately after the <BODY> tag. You may need to 

move this if the position is wrong - for more details see Creating Navigation Bars. If you create the more complicated rollover 
buttons, the associated JavaScript is in the <HEAD> tag - you do not need to move this.

If you are using Macromedia Dreamweaver, see this page.

{button                      Close this window                    ,CW(`main')}



Message: No library index file available

Cause

There is no index file in this folder.

What Can I Do?
Choose the correct folder path where the index file can be found, or click the Create button to make a new index file for 

the folder.

{button                      Close this window                    ,CW(`main')}



Message: No plates have been set to print

Cause

You have enabled color separations in the Separations Options, but have not set any plates to print.

What Can I Do?
In the Print dialog box, click the Options button. Click the Separations tab and set which separations you want to print or 

disable color separations.

{button                      Close this window                    ,CW(`main')}



Message: No result on combining shapes

Cause

Either

(a) you have attempted to combine some shapes (see Combine Shapes) that do not intersect, 

or (b) you have subtracted shapes so that no shape will result.

What Can I Do?
Move the shapes so that they intersect.
Change one of the shapes to be different from the others.

If you have tried to slice using a line, ensure both ends of the line are outside the objects being sliced.

{button                      Close this window                    ,CW(`main')}



Message: No suitable texture is available

Cause

You have tried to use an unsuitable bitmap for a fill.

What Can I Do?
Try using a different bitmap.

{button                      Close this window                    ,CW(`main')}



Message: Only named colors can be spot colors

Cause

You have tried to make a local color a spot color. Only named colors can be spot colors. If you want to make a local color into a 
spot color, then it must first be given a name.

What Can I Do?
To create a named spot color, click Make Named. Xara X will automatically turn this local color into a named spot color for 

you. You will be asked for a name for the new color.
To leave the color as it was, click Cancel.

{button                      Close this window                    ,CW(`main')}



Message: Operation canceled

Cause

You canceled the operation.

What Can I Do?
Continue as usual - this message is for your information only.

{button                      Close this window                    ,CW(`main')}



Message: Out of memory

Cause

The program cannot perform the current task because your system does not have enough free memory.

What Can I Do?

Xara X requires a computer with at least 8 megabytes of physical memory and a Windows swap file of at least 10 megabytes of 
virtual memory. If your swap file is too small, then its size can increased by right-clicking on My Computer and selecting Properties. 
For further details, refer to your Windows User Guide.

If you are certain that your computer's memory is adequate then, if feasible, close some other programs you are running, 
particularly graphics applications which generally require a lot of memory to run.

It is also possible to change your computer's screen mode to one with a lower resolution and color depth, for example if your 
computer normally displays 1024 x 768 pixels with a 24-bit color depth (millions of colors), change to an 800 x 600 pixel mode with 
an 8-bit color depth (256 colors).

{button                      Close this window                    ,CW(`main')}



Message: Overrun/truncated file.

Cause

The program has tried to read a file that is incomplete. This usually means that it has been corrupted, possibly by canceling an 
earlier export.

What Can I Do?
Run your system's disk diagnostics - it may be possible to recover the rest of the file.

{button                      Close this window                    ,CW(`main')}



Message: Problems Installing or De-installing an ATM Font

A problem occurred when trying to install or deinstall an ATM font.

Cause

You have tried to install a font that is already installed, or you have tried to de-install a font that is currently being used within a 
document, or by another program. Alternatively, the font file itself is corrupt, or a problem was caused by Adobe Type Manager.

What Can I Do?
Installing a font - check that it is not installed already.
De-installing a font - make sure it is not being used in any loaded documents, or other applications, then try again. If this 

fails, use the ATM control panel to deinstall the font.

{button                      Close this window                    ,CW(`main')}



Message: Problems creating a new index

Cause

This message is displayed if creating a new index file ran into problems. Possible problems include running out of disk-space, or 
writing to a floppy disk which has just been taken out of the drive.

What Can I Do?
Ensure the disk is accessible and contains sufficient free space.

{button                      Close this window                    ,CW(`main')}



Message: Problems creating a thumbnail

Cause

This message is displayed when a problem occurs generating thumbnails for a file. This is likely to be because the type of files is 
not supported by Xara X. It is also possible the file is corrupt or has the wrong file extension.

What Can I Do?
Click OK to ignore this file, or Quiet to ignore all files with this problem. Stop causes the index generation to cease.

{button                      Close this window                    ,CW(`main')}



Message: Program installation incomplete or corrupted.

Cause

Some of the components of the program were not installed, have been moved, or have been deleted. It is possible the program 
will not function correctly.

What Can I Do?
Replace the missing component or reinstall the program.

{button                      Close this window                    ,CW(`main')}



Message: Removing gallery sections

Cause

This message is displayed by one of the following:
Clicking Remove in one of the disk-based galleries (Clipart Gallery, Fill Gallery or Font Gallery) to delete a section from 

the gallery.
Xara X not being able to find the index for a section in the gallery (for example if the folder it was contained in has been 

deleted).

What Can I Do?
If you are trying to remove sections from the gallery, click Remove to delete them (Cancel to leave them).
If Xara X cannot find an index for a section, clicking remove will remove the affected sections (Cancel will leave them).

{button                      Close this window                    ,CW(`main')}



Message: Retain the clipboard contents?

Cause

Some document objects have been placed on the Windows clipboard. On exit from the program, these objects may either be 
converted into a form suitable to be left on the clipboard, or can be discarded. Converting the objects may take some time and 
memory if there are a large number of objects.

What Can I Do?
Click the Keep button to keep the image of the objects in the clipboard after Xara X has closed. You can then paste them 

into another application. 
Click the Discard button to discard the contents of the clipboard.

{button                      Close this window                    ,CW(`main')}



Message: Save new document template

Cause

You are about to overwrite the existing Xara X document template with a revised version.

What Can I Do?
Click Save to replace the existing document template.
Click Cancel to abort the save. The existing template document is unchanged.

The template document is saved in your Xara X folder as template.xar. If you wish to revert to the default template document, 
delete this file.

{button                      Close this window                    ,CW(`main')}



Message: Set current graphic attribute?

Cause

You have attempted to apply an attribute with no objects selected. Applying attributes with no objects selected defines the 
attributes that will be used for all newly created objects (except text objects, see note).

What Can I Do?
If you want to set the current attribute, click Set.
If you want to cancel the operation, click Cancel.
If you do not wish to see this warning in future, click Quiet. This sets the Ask Before Setting Current Attribute option. 

See General Options.

Note

Setting the current attribute with the Text Tool chosen sets the current text attributes (those used for all newly created text objects).

_______________

{button ,KL(`current attributes',0,`____No_Topics_Found',`')}    Related Topics

{button                      Close this window                    ,CW(`main')}



Message: Set current text attribute?

Cause

You have attempted to apply a text attribute with no objects selected. Applying attributes with the Text Tool chosen and no objects 
selected defines the attributes that will be used for all newly created text objects.

What Can I Do?
If you want to set the current attribute, click Set.
If you want to cancel the operation, click Cancel.
If you do not wish to see this warning in future, click Quiet. This sets the Ask Before Setting Current Attribute option. 

See General Options.

_______________

{button ,KL(`current attributes',0,`____No_Topics_Found',`')}    Related Topics

{button                      Close this window                    ,CW(`main')}



Message: Setting a Current Attribute

Cause

This message is displayed when you apply an attribute, such as a fill or a line-width, when no suitable object is selected. For 
example, trying to apply a fill to a blank page, or trying to apply a bold-text attribute to an ellipse. This action changes the current 
attributes.

What Can I Do?
Click the Set button to make the attribute current (the default for all objects subsequently created). For example, if a line-

width of 8 pt is made the current attribute, all the lines you later draw initially have a width of 8 pt. Of course, you can still alter a 
line's attributes to be something different.

Click the Quiet button to set the attribute current, and also suppress future prompts when setting a new current attribute. 
This button is useful when setting a number of current attributes in quick succession.

Clicking the Cancel button prevents the current attribute being set.

_______________

{button ,KL(`current attributes',0,`____No_Topics_Found',`')}    Related Topics

{button                      Close this window                    ,CW(`main')}



Message: Shape not suitable for molding

Cause

When pasting a shape from the clipboard as a mold, the first item on the clipboard which is or can become a shape is used. In this 
case the shape found is unsuitable for use as a mold. If you are pasting as a perspective mold, the shape is restricted to a four 
sided polygon. If you are pasting as an envelope mold the shape must be made up of four sides, be they curves or lines. If the 
shape fails the test for suitability you will get this error. Finally, twisted shapes of four sides such as a bow tie shape where two 
edges intersect cannot be used as a perspective mold. Twists are allowed however in envelope molds.

What Can I Do?
Paste the contents of the clipboard (CTRL+V ) into another document and have a look at the shape, it may be possible to 

edit this shape to make it suitable for use as a mold by using the Shape Editor Tool. Having edited the shape copy it back to the 
clipboard and try pasting again.

{button                      Close this window                    ,CW(`main')}



Message: Some fonts have been substituted

Cause

A document has been opened or imported which contains fonts you do not have installed on your system.

What Can I Do?
From the File menu, choose Document Info. You can use the drop-down list of fonts in the dialog box to look for fonts 

listed with a ' * ' next to them, these are the fonts that have been substituted. You must install each of these fonts (see Installing 
fonts).

If you do not have the fonts used, you can apply a different font to the text objects (see Applying attributes to text) or leave 
them as they are. Note that you can use the Name Gallery to select all the text that uses the missing font.

{button                      Close this window                    ,CW(`main')}



Message: Some of the selected named colors are in use in your document

Cause

You have attempted to delete named colors from the document which are being used.

What Can I Do?
Clicking Delete Unused deletes all the colors you have selected apart from those currently in use.
If you click Delete All, all the colors you have selected will be deleted, including the ones being used. The objects which 

are using these colors will have local colors applied to them. The appearance of the document does not change.

{button                      Close this window                    ,CW(`main')}



Message: Some parts of the document could not be exported

Cause

The export format does not support some of Xara X's unique features. (For example, CorelDRAW format does not support Xara X 
transparency or fractal fills.)

What Can I Do?
This may be an acceptable limitation if you must export in a non-Xara X format. If this limitation is not acceptable, then 

export in Xara X's native format or create a bitmap of the document.

{button                      Close this window                    ,CW(`main')}



Message: Some parts of the document could not be imported

Cause

Parts of an imported file cannot be converted to Xara X document format.

What Can I Do?
If you are familiar with the look of the original document, you can probably reconstruct the missing parts using the tools 

provided in Xara X. You can then save the document as a Xara X document file.

{button                      Close this window                    ,CW(`main')}



Message: Spread too large

Cause

The values that have been entered into the page width, height and margins fields in the Page Options to modify the current page 
size mean that the height and/or width of the page is beyond what Xara X will cope with, which is about 275cm or about 9ft.

What Can I Do?
Reduce the size of the width, height and margin fields.

{button                      Close this window                    ,CW(`main')}



Message: Text to search for is invalid

Cause

You have not entered any text to search for.

What Can I Do?
Reenter the text you wish to search for.

{button                      Close this window                    ,CW(`main')}



Message: The Adobe Type Manager is Not Running

The Adobe Type Manager is not running, or is turned off. Adobe Type Manager is a separate piece of software supplied by Adobe. 
It is not included with Xara X. If you do not have ATM, use TrueType fonts instead.

Cause

The Adobe Type Manager is not running, or is turned off.

What Can I Do?
Install ATM.
If ATM is installed, but is not turned on, enable ATM using the ATM control panel.

{button                      Close this window                    ,CW(`main')}



Message: The appropriate type of object is not selected

Cause

In Xara X, operations are often performed on objects that are selected. You have tried to perform an operation when no object is 
selected, or the wrong kind of object is selected.

What Can I Do?
Select the object you wish to perform the operation on, then try the operation again.

_______________

{button ,KL(`selecting,objects',0,`____No_Topics_Found',`')}    Related Topics

{button                      Close this window                    ,CW(`main')}



Message: This document contains overlapping transparent objects

Cause

The document you are exporting contains transparent objects on top of one another. Exporting transparent objects to a CMX file 
when there are more than three transparent objects in a stack is likely to cause problems for other programs.

What Can I Do?
To limit the transparency to the lower three objects and export the other objects solid, click Limit.
To continue exporting and include all the transparent objects, click Continue. This may cause problems when you import 

the file into other programs.

{button                      Close this window                    ,CW(`main')}



Message: This layer contains objects, are you sure you want to delete them

Cause

You have tried to delete a layer which contains objects.

What Can I Do?
Click the Delete Layer button to remove the layer and the objects in it from the document.
Click the Cancel button if you do not want to delete the layer.

{button                      Close this window                    ,CW(`main')}



Message: This operation will remove a perspective fill

Cause

Displayed when converting an object to editable shapes will discard the object's perspective molded fill.

What Can I Do?
Click the OK button to discard the perspective mounded fill.
Click the Cancel button to keep the perspective mounded fill and therefore not convert the object to editable shapes.

{button                      Close this window                    ,CW(`main')}



Message: Unable to find any files to add to index

Cause

This message is displayed after attempting to generate an index for a folder with no recognized files that can be used in the 
relevant gallery.

What Can I Do?
Check the path is correct. Files are currently chosen by their extensions, if these are incorrect this may explain the 

problem. This error will be given if you attempt to add a folder containing no bitmaps to the fill gallery even if it contains vector format 
files (for example XAR files).

{button                      Close this window                    ,CW(`main')}



Message: Unable to find folder

Cause

Cannot find the required folder for the gallery.

What Can I Do?
If necessary, insert the CD and click Retry. 
If the folder has been deleted, click Add to locate a new folder. 
Cancel opens a, possibly empty, gallery.

{button                      Close this window                    ,CW(`main')}



Message: Unable to find index

Cause

This message is displayed when an index is unavailable.

What Can I Do?
If necessary, insert the CD and click Retry. 
If the folder has been deleted, click Continue to remove the relevant folder from the gallery.
Clicking Quiet removes all the affected folders with no further warnings.

{button                      Close this window                    ,CW(`main')}



Message: Unable to find printer profile

Cause

Profiles are used to match the colors on screen with those that appear on paper when you print. One of the profiles you chose 
cannot be found and neither can the default profile of that type.

What Can I Do?
The printer profile files are installed alongside Xara X. If they are not there you need to reinstall Xara X.

{button                      Close this window                    ,CW(`main')}



Message: Unable to update index

Cause

This message is displayed when you try and update a read-only index.

What Can I Do?
If the index is on a CD, it is not possible to update it - the entire folder must first be copied to a writable drive.
If the index is on a read-only network mount, copy the folder to a different drive or contact your system administrator.

{button                      Close this window                    ,CW(`main')}



Message: Web address is too long

Cause

The web address you have entered is too long. It must be less than 255 characters.

What Can I Do?
Use a shorter form of the address or an alternative address.

{button                      Close this window                    ,CW(`main')}



Message: You cannot create spot colors

Cause

When you have set Print spot colors as process colors in the Separations Options, all spot colors act as regular (process) 
colors. For your protection, this includes not allowing you to create new spot colors.

What Can I Do?
If you wish to create and use spot colors, disable Print spot colors as process colors in the Separations Options.

{button                      Close this window                    ,CW(`main')}



Message: You cannot edit library colors

Cause

The predefined PANTONE® and Web Palette library colors have fixed color definitions - you cannot edit them.

What Can I Do?.
To edit a library color - click Copy. This copies the color into your document; you can then edit the copy. 
Note that editing a PANTONE® color definition may change its color compared to the original PANTONE® color. Your 

service bureau may not be able to correctly match the color.
To see the CMYK definitions of PANTONE® colors, change the Color Gallery to display colors in Full information mode. 

See Changing the way galleries look

{button                      Close this window                    ,CW(`main')}



Message: You cannot load Xara X EPS files

Cause

You cannot load Xara X EPS (or CorelXARA EPS) files into Xara X. You can only use this format for exporting EPS to other 
packages.

What Can I Do?
You must load the file in another format, usually the original Xara X file (XAR extension).

{button                      Close this window                    ,CW(`main')}



Message: Your settings are out of date

Cause

The settings for window position and control bars are out of date for this version of the program. You are likely to see this message 
if you update Xara X.

What Can I Do?
Clicking Default recreates the standard (factory default) settings. You lose current settings, such as the window position 

and the list of recently used files, as well as the settings set in the Options.
If you want to keep your existing settings, then click Current. Any new settings which apply to this version of the program 

are merged into your existing initialization file.

{button                      Close this window                    ,CW(`main')}



Message: About to lose Undo information

Cause

You have changed the maximum size of the undo information buffer. If you continue, you will lose all your undo steps.

What Can I Do?
To discard the existing Undo information click the Resize button. 
To make the Undo information buffer larger and hence preserve the existing Undo information, click Don't Resize and 

enter a higher value.

{button                      Close this window                    ,CW(`main')}



Message: Named objects overlap

Cause

Two named objects overlap each other. Xara X does not know how to slice them for export.

What can I do?

Either:
Move the two overlapping objects apart. You can use the Name Gallery to select one of the names.
Mark one of the overlapping objects as "non-slicing". (Slicing is set "on" by default.) More details.

{button                      Close this window                    ,CW(`main')}



Modifying a bevel

Bevels give objects an appearance of depth instead of being flat on the page. The beveling effect is created by a light shining 
across a shaped, bevel edge. You can change the angle and strength of the light and change the shape (the profile or "Type") and 
size of the bevel edge.

What do you want to change?
the bevel shape (the bevel Type)
the size of the bevel
the direction of the light source
the contrast across the bevel
the bevel color or fill effect 
the bevel join style
whether the bevel is inside or outside the object
Convert to editable shapes (for advanced editing)

Notes on bevels and feathering.

Movies

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

_______________

Related Topics

Applying a bevel
Removing a bevel
Bevel Tool



Modifying contours

You can use the Contour Tool to contour objects creating several intermediate shapes.

What do you want to do?
Change the size of the contour
Swap between inside and outside contours

              Change the number of steps in a contour  
Change the spacing between contour steps
Change the color of a contour
Change the way colors fade in a contour
Convert a contour into editable shapes
Convert to editable shapes (for advanced editing)

Movies

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

_______________

Related Topics

Applying a contour
Removing a contour
Contour Tool



Modifying shadows

The Shadow Tool creates soft shadows, which fade out to totally transparent at the edges. This looks more realistic than a solid 
shadow.

What do you want to do?
Blur the edges of the shadow (change the size)
Change the size or direction of a shadow
Move a Wall shadow
Change the transparency of the center of the shadow

              Change the shadow profile  
Change the color or fill effect of the shadow
Create a glow effect
Convert to editable shapes (for advanced editing)

Note:
Shadows created with the Shadow Tool use bitmap transparency to create the shadow effect. This means you cannot use 

the Transparency Tool to apply a transparency type to a shadow.

Movies

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_______________

Related Topics

Applying a shadow
Removing a shadow
Shadow Tool



Modifying the bevel shape

This describes how to change the shape (profile) of the bevel at the edge of objects.

How to modify the bevel shape:

1. Select the object (see Selecting objects).
2. Choose the Bevel Tool.
3. Choose the bevel shape you want from the Bevel type list.

Notes:
Choosing None removes any applied bevel.
If you have several beveled objects selected, any changes apply to all the bevels.

_______________

Related Topics

Applying a bevel
Modifying a bevel
Removing a bevel
Bevel Tool



Mold Pop-up Menu

Right-clicking on a mold pops-up a menu:
Mold Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 Mold Tool - Banner Envelope Button

The Banner Envelope button on the Mold Tool Infobar applies a banner envelope to the selection. You can edit the envelope as 
required. The selection always remains within the envelope whatever edits you make. 



 Mold Tool - Ceiling Perspective Button

This button on the Mold Tool Infobar applies a ceiling facing perspective to the selection.



 Mold Tool - Circular Envelope Button

The Circular Envelope button on the Mold Tool Infobar applies a circular envelope to the selection. You can edit the envelope as 
required. The selection always remains within the envelope whatever edits you make.



 Mold Tool - Concave Envelope Button

The Concave Envelope button on the Mold Tool Infobar applies a concave envelope to the selection. You can edit the envelope 
as required. The selection always remains within the envelope whatever edits you make.



 Mold Tool - Copy Mold Button

The Copy Mold button on the Mold Tool Infobar copies the mold from the currently selected object (where possible) to the 
clipboard as a shape. For example, if the selection contains an elliptical mold, this button places the ellipse on the clipboard.



 Mold Tool - Default Envelope Button

The Default Envelope button on the Mold Tool Infobar applies a default rectangular envelope to the selection. You can edit the 
envelope as required. The selection always remains within the envelope whatever edits you make.



 Mold Tool - Default Perspective Button

The Default Perspective button on the Mold Tool Infobar applies the default, flat perspective to the selection. You can then edit 
the shape of the mold as required.



 Mold Tool - Detach Mold

With a molded object selected, press the Detach Mold button on the Mold Tool Infobar to 'detach' the mold. You can then edit the 
mold without waiting for the molded object being 'recalculated'. Click the Detach button again to update the display of the molded 
object. A detached mold will not be recalculated until the detach button is pulled out or the document is saved and reloaded.



 Mold Tool - Elliptical Envelope Button

The Elliptical Envelope button on the Mold Tool Infobar applies an elliptical envelope to the selection. You can edit the envelope 
as required. The selection always remains within the envelope whatever edits you make.



 Mold Tool - Floor Perspective Button

This button applies a 'floor' facing perspective to the selection.



 Mold Tool - Left Perspective Button

This button on the Mold Tool Infobar applies a left facing perspective to the selection.



 Mold Tool - Mesh Button

The Mesh button on the Mold Tool Infobar is used to display a mesh over all selected molds. The mesh lets you see the amount of 
distortion applied to the object. The mesh appears only on screen - it is never printed.



 Mold Tool - Paste Envelope Button

The Paste Envelope button on the Mold Tool Infobar takes a shape from the clipboard and pastes it as an envelope over the 
selection. For this operation to succeed there must be a four-sided shape on the clipboard. An error will be reported if the shape is 
unsuitable to be pasted as an envelope. Once pasted, you can edit the envelope as required with this tool or with the Selector 
Tool.

Note
The shape on the clipboard must have four sides. The sides may be curved or straight.



 Mold Tool - Paste Perspective Button

This button on the Mold Tool Infobar applies a perspective to the selection using the contents of the clipboard as a perspective 
mold.

Note
The shape on the clipboard must have four straight sides.



 Mold Tool - Remove Button

This button on the Mold Tool Infobar removes the molds from all molded objects in the selection.



 Mold Tool - Right Perspective Button

This button on the Mold Tool Infobar applies a right facing perspective to the selection.



 Mold Tool - Rotate Contents

This button on the Mold Tool Infobar 'rotates' the contents of the mold. This lets you align one edge of the molded shape with any 
edge of the mold shape.



 Mold Tool        SHIFT+F6
The Mold Tool is used to apply Envelope and Perspective molds to objects to warp, bend and reform them. For more details on 
molds, see the Molds Overview. You can choose the Mold Tool using the Mold Pop-up Menu.

Mold Tool Infobar Controls
Mesh

Remove
Copy Mold
Detach

Rotate Contents
Default Envelope
Circular Envelope
Elliptical Envelope
Concave Envelope
Banner Envelope
Paste Envelope
Default Perspective
Left Perspective

Right Perspective
Floor Perspective
Ceiling Perspective
Paste Perspective

Mold Tool Operations
Applying molds
Reshaping an envelope mold
Reshaping a perspective mold

Movies

{button ,EF("XaraDemo.exe","Envelope Envelope molds",1,`') } Using envelope molds

{button ,EF("XaraDemo.exe","Perspect Perspective molds",1,`') } Using perspective molds



Molds Overview

You can take any object or set of objects and place them inside a mold object. you can then change the shape of the mold object 
which distorts the enclosed objects. There are two distinct types of mold. Perspective molds which have four straight sides and 
envelope molds which have four sides which can be curved. For more details, see Applying perspective molds.

Perspective Molds

Perspective molds are ideal for creating banners and three dimensional effects.

Envelope Molds

With Envelope molds you can distort and warp a shape using the four corners of the mold shape. you can also bend and warp the 
edges of the mold shape to distort the contents even more.

Note:
You cannot mold bevels, contours or shadows independently of the objects to which they are applied. Instead, select the 

object and mold that; any bevel, contour, or shadow then adjusts to the molded shape.

Movies

{button ,EF("XaraDemo.exe","Envelope Envelope molds",1,`') } Using envelope molds

{button ,EF("XaraDemo.exe","Perspect Perspective molds",1,`') } Using perspective molds

_______________

{button ,KL(`tools,mold tool;molds',0,`____No_Topics_Found',`')}    Related Topics



 Mouse Options

To open the Mouse Options, choose Options from the Utilities menu and click on the Mouse tab.

Left and Right Mouse Button Function

The option controls what the left mouse button does. For more information on configuring the mouse, see Configuring the mouse 
buttons. 

Normal Click
SHIFT-click
CTRL-click
ALT-click
Pop-up menu
Enable/disable Full Screen Mode
Zoom In or Out

The Reset Default button returns the settings for left and right mouse buttons to their 'factory' defaults.

Magnetic Snap Radii

These two fields set the magnetic snap distances for grid, guide and object snapping. For more information, see Changing the 
magnetic snap distances.

_______________

Related Topics

Pop-up menus
Object snapping



Mouse-wheel operations

If you have a mouse with a wheel; you can:
scroll the wheel to scroll up and down
hold down SHIFT to scroll left (scroll the wheel up) or right (wheel down)
hold the wheel down to slide the document around in the window
click the wheel to center the view around the mouse pointer
SHIFT-click to zoom out
CTRL-click to zoom in
Hold down CTRL for variable zoom in (scroll the wheel up) or zoom out (wheel down).



 Move Backwards (Arrange Menu)    CTRL+SHIFT+B

Moves every object in the selection backwards in the stack of objects in its layer or frame. For more details, see Moving objects 
backwards and forwards.



 Move Forwards (Arrange Menu)    CTRL+SHIFT+F

Moves every object in the selection forwards in the stack of objects in its layer or frame. For more detail, see Moving objects 
backwards and forwards.



Moving objects in a ClipView

ClipView lets you use an object as a "window" onto other objects. You see only those parts of other objects that are within the 
window. We call this creating a ClipView. You can move the window object to change your view. (The window object remains 
visible.)

To move objects in a ClipView 

You can move a ClipView in the regular way. You can also move the window object relative to the others in the ClipView. This 
changes which parts of the other objects you can see.

The original ClipView (in these examples the blue ellipse is the window object):

To move or change the window object:
1. Using the Selector Tool select the ClipView - see Selecting objects.
2. Click the top-left keyhole 

This selects just the window object. Any changes you now make (such as moves and resizing) apply only to the window 
object.

To move or change the other objects in the ClipView:
1. Using the Selector Tool select the ClipView - see Selecting objects.
2. Click the center keyhole:

This selects all the objects in the ClipView except the window object. Any changes you now make (such as moves and 
resizing) apply only to these objects.

Notes:
You can also select any object in the ClipView using Select Inside.
After using the keyholes or Select Inside, drag the selected objects if you want to move them. Clicking on any other object 

deselects any currently selected objects.

Movies

{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView

_______________

{button ,KL(`clipping',0,`____No_Topics_Found',`')}    Related Topics



Move the shadow

Moving the shadow relative to the object gives the effect of moving the object towards or away from the page (Wall shadow) or 
tilting the page (Floor shadow).

To move a shadow
1. Select the object (see Selecting objects). (See notes.)
2. Choose the Shadow Tool. 
3. Drag over the shadow. 

Or, for precise movements of a Wall shadow, change the values in the X-Y text boxes. Either click the arrows to the right or 
type in new values. X-Y values are the center of the shadow relative to the center of the objects.

Notes:
If you select multiple shadows, a target 

 appears in the center of the selection. Drag the target to move all the shadows. Or you can drag on a shadow to move just that 
shadow.

You can also use the Shadow Tool to select objects - more details.
You cannot move Glow shadows as these are always directly behind the object.
To change the size of the shadow see Changing the blur.

Movie

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

_____________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow
Shadow Tool



 Move to Layer Behind (Arrange Menu)    CTRL+SHIFT+D

Moves all objects in the selection back one layer to the previous visible layer. For more details, see Moving objects between 
layers.



 Move to Layer in Front (Arrange Menu)    CTRL+SHIFT+U

Moves all objects in the selection forwards one layer to the next visible layer. For more details Moving objects between layers.



Move to Next Frame (Arrange Menu)    CTRL+SHIFT+U

Click this button to move the selected objects to the next frame in the animation (the frame above in the Frame Gallery).

_______________

{button ,KL(`frames',0,`____No_Topics_Found',`')}    Related Topics



Move to Previous Frame (Arrange Menu)    CTRL+SHIFT+D

Click this button to move the selected objects to the previous frame in the animation (the frame below in the Frame Gallery).

_______________

{button ,KL(`frames',0,`____No_Topics_Found',`')}    Related Topics



      Available only with CD versions of Xara X

                  Not available with download versions
                                            Click a button to watch a movie

                              For more information, see Viewing the movies

{button ,EF(`xarademo',`Intro XARA X Demonstration',1,`')}    Welcome to Xara X - A brief description of all the facilities 
available

{button ,EF(`xarademo.exe',`Demo XARA X Demonstration',1,`')}    Creating an illustration using Xara X

{button ,EF(`xarademo.exe',`Webpage XARA X Demonstration',1,`')}    Creating a web page using Xara X

      Getting started
{button ,EF(`xarademo',`Selhands Using Selection Handles',1,`')} Using selection handles

{button ,EF("XaraDemo.exe","Select Selecting Objects",1,`') } Selecting objects

{button ,EF("XaraDemo.exe","SelInsid.avi Selecting Objects In Objects",1,`') } Selecting objects in objects

{button ,EF("XaraDemo.exe","SelUnder.avi Selecting Objects Under Objects",1,`') } Selecting objects under objects

{button ,EF("XaraDemo.exe","WYSIWYG Display Quality",1,`') } Changing the display quality

{button ,EF("XaraDemo.exe","ZoomPan.avi Magnifying and Moving a Document",1,`') } Magnifying and moving 
documents

{button ,EF("XaraDemo.exe","FullScrn.avi Full Screen Mode",1,`') } Using full screen mode

{button ,EF("XaraDemo.exe","Magnet Object Snapping",1,`') } Using object snapping

{button ,EF(`xarademo.exe',`ClipGal Clipart Gallery',1,`')} Clipart Gallery

          QuickShapes
{button ,EF("XaraDemo.exe","ellipses Ellipses and Circles",1,`') } Drawing ellipses and circles

{button ,EF("XaraDemo.exe","oblong Rectangles and Squares",1,`') } Drawing rectangles and squares

{button ,EF("XaraDemo.exe","Regular QuickShapes",1,`') } Drawing QuickShapes

          Colors
{button ,EF(`xarademo.exe',`Colours Coloring Objects',1,`')} Coloring objects

{button ,EF("XaraDemo.exe","EditCol Defining Your Own Colors",1,`') } Creating your own colors

{button ,EF("XaraDemo.exe",`Tints Using Tints',1,`') } Using tints

          Moving objects
{button ,EF("XaraDemo.exe","AlgnDist Aligning and Distributing Objects",1,`') } Aligning and distributing objects

{button ,EF("XaraDemo.exe","Arrange Moving Objects Backwards and Forwards within a Layer",1,`') } Moving objects 
backwards and forwards within a layer

{button ,EF("XaraDemo.exe","Moving Moving Objects",1,`') } Moving objects

{button ,EF("XaraDemo.exe","Layers Layers",1,`') } Using layers

{button ,EF("XaraDemo.exe",`Grids Using Grids and Rulers',1,`') } Using grids & rulers

        Changing objects
{button ,EF("XaraDemo.exe","DupClone Duplicating and Cloning Objects",1,`') } Duplicating and cloning objects

{button ,EF("XaraDemo.exe","Groups Grouping Objects",1,`') } Grouping objects

{button ,EF("XaraDemo.exe","AddShape Adding Objects",1,`') } Adding objects

{button ,EF("XaraDemo.exe","IntShape Intersecting Objects",1,`') } Intersecting objects

{button ,EF("XaraDemo.exe","Slice Slicing Objects",1,`') } Slicing objects

{button ,EF("XaraDemo.exe","SubShape Subtracting Objects",1,`') } Subtracting objects

{button ,EF("XaraDemo.exe","mkshape Converting Objects to Simple Editable Shapes",1,`') } Converting objects to 
editable shapes

{button ,EF("XaraDemo.exe",`Bevel Using Bevels',1,`') } Using bevels

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

{button ,EF("XaraDemo.exe",`Feather Using Feathering',1,`') } Using feathering

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

{button ,EF("XaraDemo.exe",`EdNamGal Name Gallery - Editing Properties',1,`') } Editing properties in the Name Gallery

{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView

          Bitmaps



{button ,EF("XaraDemo.exe",`Bexport Exporting Bitmaps',1,`') } Bitmap export

{button ,EF("XaraDemo.exe",`Palette Bitmap Export - Palette Optimization',1,`') } Bitmap Export - Palette optimization

{button ,EF("XaraDemo.exe",`Bxoption Bitmap Export - Option tab',1,`') } Bitmap Export - Options tab

{button ,EF("XaraDemo.exe",`Bxsize Bitmap Export - Size tab',1,`') } Bitmap Export - Size tab

{button ,EF("XaraDemo.exe",`Bxpview Bitmap Export - Preview tab',1,`') } Bitmap Export - Preview tab

{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Tracer Tracing Bitmaps",1,`') } Using the bitmap tracer

{button ,EF("XaraDemo.exe",`Beffects Bitmap special effects',1,`') } Bitmap special effects

{button ,EF("XaraDemo.exe",`AniGIF Animated GIFs',1,`') } Creating Animated GIFs

          Control bars
{button ,EF("XaraDemo.exe","Buttons Moving and Copying Buttons",1,`') } Moving and copying buttons

{button ,EF("XaraDemo.exe","CtrlBars Moving and Resizing Control Bars",1,`') } Moving and resizing control bars

{button ,EF("XaraDemo.exe","MakeBars Creating Control Bars",1,`') } Creating new control bars

          Blending objects
{button ,EF("XaraDemo.exe","Blend Simple Blending",1,`') } Blending objects

{button ,EF("XaraDemo.exe","BlendFun Advanced Blending",1,`') } Blending objects - Advanced

          Using Molds
{button ,EF("XaraDemo.exe","Envelope Envelope molds",1,`') } Using envelope molds

{button ,EF("XaraDemo.exe","Perspect Perspective molds",1,`') } Using perspective molds

          Fills
{button ,EF("XaraDemo.exe","BmapFill Bitmap Fills",1,`') } Using bitmap fills

{button ,EF("XaraDemo.exe","Fractals Fractal Fills",1,`') } Using fractal cloud fills

{button ,EF("XaraDemo.exe","GradFill Linear Circular Elliptical and Conical Fills",1,`') } Using linear, circular, elliptical 
and conical fills

          Transparency
{button ,EF("XaraDemo.exe","Transpar Simple Transparency Effects",1,`') } Using transparency

          Text
{button ,EF("XaraDemo.exe","Text Entering Text",1,`') } Entering text

{button ,EF("XaraDemo.exe","EditText Editing Text",1,`') } Editing text

{button ,EF("XaraDemo.exe","TextFun Advanced Text",1,`') } Advanced text

{button ,EF("XaraDemo.exe",`TextCtrl More on the Text Tool',1,`') } More on the Text Tool

          Lines and shapes
{button ,EF("XaraDemo.exe","CurvDraw.avi Drawing Lines and Shapes with the Shape Editor Tool",1,`') } Drawing lines 
with the Shape Editor Tool

{button ,EF("XaraDemo.exe","FreeDraw.avi Drawing Lines and Shapes with the Freehand Tool",1,`') } Drawing lines with 
the Freehand & Brush Tool

{button ,EF("XaraDemo.exe","PenDraw Drawing Lines and Shapes with the Pen Tool",1,`') } Drawing lines with the Pen 
Tool

{button ,EF("XaraDemo.exe","CurvEdit Editing Lines and Shapes with the Shape Editor Tool",1,`') } Editing lines with the 
Shape Editor Tool

{button ,EF("XaraDemo.exe","FreeEdit Editing Lines and Shapes with the Freehand Tool",1,`') } Editing lines with the 
Freehand & Brush Tool

{button ,EF("XaraDemo.exe","PenEdit Editing Lines and Shapes with the Pen Tool",1,`') } Editing lines with the Pen Tool

{button ,EF("XaraDemo.exe","LineBits Editing Line Width Ends and Joins",1,`') } Editing line widths, ends and joins

{button ,EF("XaraDemo.exe","Smooth Smoothing Lines and Shapes",1,`') } Smoothing lines and shapes

{button ,EF("XaraDemo.exe","JoinBrk Joining and Breaking Lines and Shapes",1,`') } Joining and breaking shapes

{button ,EF("XaraDemo.exe",`LinShape Converting lines to Shapes',1,`') } Converting lines to editable shapes

{button ,EF("XaraDemo.exe",`NewBrush Creating a New Brush',1,`') } Creating a new Brush

{button ,EF("XaraDemo.exe",`Pressure Pressure Sensitivity',1,`') } Pressure sensitivity the Freehand & Brush Tool

{button ,EF("XaraDemo.exe",`EdBrush Editing a Brush',1,`') } Editing a Brush

{button ,EF("XaraDemo.exe",`Linstroke Line stroking',1,`') } Line strokes



{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView

          The Internet
{button ,EF("XaraDemo.exe",`WebAdd Assigning Web Addresses',1,`') } Creating hot-spots

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps

{button ,EF("XaraDemo.exe",`Dreamwv Dreamweaver integration',1,`') } Dreamweaver integration

{button ,EF("XaraDemo.exe",`NavBar Creating Navigation Bars',1,`') } Creating Navigation Bars

{button ,EF("XaraDemo.exe",`Rollover Creating JavaScript Rollovers',1,`') } Creating JavaScript rollovers



Moving QuickShapes

There is a special easy way of moving QuickShapes.
To move a QuickShape

1.    Choose the QuickShape Tool.
2.    Drag the cross in the center of the QuickShape.

Tips
If you want to move an ellipse, you could use the Ellipse Tool. Ditto for the Rectangle Tool.
QuickShapes can also be moved like any other object using the Selector Tool - see Moving objects.

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



Moving a point on a line or shape

You often want to move a point to slightly change a shape or line. Xara X provides several ways of doing this.
To move a point on a line or shape

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool or the Pen Tool (or Selector Tool, see note).
3. Drag the point handle you wish to move. See the Tips below to see how to constrain handle movement to multiples of the angle 

set in the General Options. 

Tips
You can use the Selector Tool if you have enabled edit handles. See Enabling edit handles.
You can also move the point by typing the values into the center Parameter Field on the Shape Editor Tool Infobar and 

press RETURN.
You can also use the arrow buttons on the center Parameter Field on the Shape Editor Tool Infobar.
You can move point handles using the cursor keys. See Nudging objects and handles.
Holding down CTRL when dragging a point handle constrains it around its original position. This makes it easy to move 

the point horizontally or vertically. See Changing the constrain angle.
Holding down CTRL+SHIFT when dragging a point handle constrains it around the previous point handle making it simple 

to create horizontal and vertical lines. Holding down CTRL+SHIFT+ALT is identical, but works with the next point handle.

_______________

Related Topics

Selector Tool
Pen Tool
Shape Editor Tool



Moving and copying buttons

Moving and copying buttons lets you customize Xara X’s control bars to your personal preferences. There is a control bar called 
the button palette which contains a copy of every available button in Xara X.

To move a button
1. Hold down ALT.
2. Drag the button to a different position on the control bar or to a different control bar.
You can put spaces between bars. See Spacing buttons on control bars.

To copy a button
1. Hold down the ALT+CTRL keys.
2. Drag the button to the new position. A copy remains in the original location.

To open the button palette
1. From the Window menu, choose Control Bars.
2. In the dialog box, scroll until you see Button Palette listed.
3. Click the switch next to it.

Notes
You can't move or copy buttons on the Infobar.

Movie

{button ,EF("XaraDemo.exe","MakeBars Creating Control Bars",1,`') } Creating new control bars

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Moving and resizing control bars

You can drag control bars and anchor them to different parts of the Xara X window or convert them into windows which can be 
moved around. You can also change the size of a floating control bar.

To move a control bar
1. Place the mouse pointer over an area of the bar not occupied by buttons or fields.
2. Drag the bar to its new location.

As the bar is dragged it has either a thick or a thin outline. A thick outline means dropping the bar will leave it floating in its own 
window. A thin outline indicates that dropping the bar will become anchored to the edge of the window. If you want the bar to 
remain floating, hold down CTRL while dragging.

To resize a floating control bar
1. Move the mouse pointer over the edge of the control bar window. The mouse pointer changes to a double ended arrow.
2. Drag to resize the control bar.

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Moving and resizing galleries

You can move the galleries so that they do not obscure the part of the drawing you are working on. You can also resize them to 
see more or fewer entries.

To move a gallery
Either:

drag the title bar of the gallery,
or drag the background of the gallery behind the buttons.

To resize a gallery

Drag the outer edge of the gallery as you would with any other resizeable window.

_______________

{button ,KL(`galleries',0,`____No_Topics_Found',`')}    Related Topics



Moving between documents

You can have several Xara X documents loaded in memory at the same time. You can then view any of them in the window and 
swap between them.

To move between documents

At the bottom of the Window menu is a list of currently loaded documents. From this list select the name of document you want to 
view.

Tip
You can also cycle through the currently loaded documents by pressing CTRL+Tab.

_______________

{button ,KL(`documents,viewing several at once',0,`____No_Topics_Found',`')}    Related Topics



Moving bitmap fill handles

Bitmap fills are controlled by two fill arrows joined at the base pointing out from the center of the bitmap. To move the whole 
rectangular bitmap, move the center fill handle. To squash, skew and scale the rectangular bitmap, move the outer handles.

To move bitmap fill handles
1. Select the bitmap filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Drag the fill handle.

Tips
If you hold down CTRL while you drag the fill handle its movement is constrained to 45 degree intervals. This is useful for 

stretching the fill in one direction.
If the SHIFT key is held down whilst dragging a fill arrow, the angle between the two fill arrows is locked during the drag 

preventing the bitmap from being stretched or skewed making it easy to scale it.
You can also use the Selector Tool to move fill handles if you have set up the Selector Tool to show fill handles on objects. 

See Enabling fill handles.
You can move fill handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics
Bitmap fills
Fill Tool
Fills overview



Moving bitmap transparency handles

A bitmap transparency is controlled by two transparency arrows joined at the base pointing out from the center of the bitmap. To 
move the whole rectangular section, move the center handle. To squash, skew and scale the rectangular bitmap, move the outer 
handles.

To move bitmap transparency handles
1. Select the transparent object. (see Selecting objects).
2. Choose the Transparency Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see, Changing the constrain angle.
You can move transparency handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Bitmap transparency
Transparency Tool
Transparency overview



Moving colors on the Color Line

The Color Line is usually arranged in color order. However if you want a different arrangement, you can move colors. Rearranging 
the Color Line also rearranges the Color Gallery.

To move colors on the Color Line
1. Place the mouse pointer over the color you want to move.
2. Hold down CTRL and drag the color.
3. Drop it where you want it. The mouse pointer will show you where it will move to.

Tips
To remove colors from the Color Line delete them using the Color Gallery.
Once you have moved the colors, they will stay in their positions as they are saved in the file.

_______________

Related Topics

Color Line
Color Gallery
Creating named colors



Moving diamond fill handles

Diamond fills are controlled by two fill arrows joined at the base pointing out from the center of the diamond. To move the whole 
diamond shape, move the center fill handle. To squash, skew and scale the diamond, move the outer handles.

To move diamond fill handles
1. Select the diamond filled object (see Selecting objects).
2. Choose the Fill Tool.
3. Drag the fill handle.

Tips
If you hold down CTRL while you drag the fill handle its movement is constrained to 45 degree intervals. This is useful for 

stretching the fill in one direction.
If the SHIFT key is held down whilst dragging a fill arrow, the angle between the two fill arrows is locked during the drag 

preventing the diamond from being stretched or skewed making it easy to scale it.
You can also use the Selector Tool to move fill handles if you have set up the Selector Tool to show fill handles on objects. 

See Enabling fill handles.
You can move fill handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Diamond fills
Fill Tool
Fills overview



Moving fill handles

You can move fill handles to change to appearance of a fill.
To move a fill handle 

1. Select the object with the fill applied. (see Selecting objects).
2. Choose the Fill Tool.
3. Drag the fill handle to its new position.

Tips
If you hold down CTRL while you drag the fill handle its movement is constrained to 45 degree intervals. (The constrain 

angle is customizable - see Changing the constrain angle.)
You can also use the Selector Tool to move fill handles if you have set up the Selector Tool to show fill handles on objects. 

See Enabling fill handles.
You can move fill handles using the cursor keys, see Nudging objects and handles.
If you don't want to see fill arrows when dragging (interactive dragging), press TAB during the drag.

_______________

Related Topics

Fill Tool
Fills overview
Selector Tool



Moving four color fill handles

A four color fill is controlled by two fill arrows joined at the base combined with a fourth fill handle to form a parallelogram. To move 
all four handles, move the handle at the base of the arrows. You can move the other three handles independently but they will 
always appear as a parallelogram.

To move four color fill handles
1. Select the filled object. (see Selecting objects).
2. Choose the Fill Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see Changing the constrain angle.
You can move fill handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Four color fills
Fill Tool
Fills overview



Moving four point transparency handles

A four point transparency is controlled by two transparency arrows joined at the base combined with a fourth handle forming a 
parallelogram. To move all four points, move the handle at the base of the arrows. You can move the other handles freely, but they 
always form a parallelogram.

To move four point transparency handles
1. Select the transparent object. (see Selecting objects).
2. Choose the Transparency Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see, Changing the constrain angle.
You can move transparency handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Four point transparency
Transparency Tool
Transparency overview



Moving fractal fill handles

A pair of fill arrows controls Fractal Cloud fills and Fractal Plasma fills. To move the whole fractal, move the center fill handle. To 
squash, skew and scale the fractal, move the outer handles.

To move a fractal fill handle 
1. Select the fractal filled object. See Selecting objects.
2. Choose the Fill Tool.
3. Drag the fill handle.

Tips
If you hold down CTRL while you drag the fill handle its movement is constrained to 45 degree intervals. This is useful for 

stretching the fill in one direction.
If the SHIFT key is held down whilst dragging a fill arrow, the angle between the two fill arrows is locked during the drag 

preventing the fractal from being stretched or skewed making it easy to scale it.
You can also use the Selector Tool to move fill handles if you have set up the Selector Tool to show fill handles on objects. 

See Enabling fill handles.
You can move fill handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Fractal fills
Fill Tool
Fills overview



Moving fractal transparency handles

A pair of transparency arrows controls Fractal Cloud transparency and Fractal Plasma transparency. To move the whole fractal, 
move the center handle. To squash, skew and scale the fractal, move the outer handles.

To move a fractal transparency handle 
1. Select the transparent object. See Selecting objects.
2. Choose the Transparency Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see, Changing the constrain angle.
You can move transparency handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Fractal transparency
Transparency Tool
Transparency overview



Moving guidelines

Guidelines help you line up objects as you create your drawing. You may find you want to move a guideline to a different part of 
the drawing or change its position slightly.

To move a guideline

The easiest way is to drag the guideline to the required position.
To position a guideline accurately

1. Right-click on the guideline to open the guideline pop-up menu.
2. Choose Properties to open the Guideline Properties dialog box.
3. Type a new position into the field and click OK.

To position several guidelines
You can only use this in Drawing documents.
1. Open the Layer Gallery.
2. Right-click on the guides layer to open the layer pop-up menu.
3. Choose Properties to open the Layer Properties dialog box.
4. Open the Guides tab.
5. Select Horizontal or Vertical.
6. Click Properties (this button is dimmed if you have more than one guideline selected) to open the Guideline Properties dialog 

box.
7. Enter a new value for the position.

Tips
If the Editable setting for the guides layer (set using the Layer Gallery) has been turned off, you will not be able to use the 

first two methods - the guides layer must be unlocked first.
The units used for guideline positioning are the page units, see Changing the page units. Note however that the units 

used on the rulers (and grid) are set using the Grid and Ruler Options.

_______________

Related Topics

Guidelines
Layer Gallery



Moving handles to the center of QuickShapes

You can easily do this using object snapping.
To lock a handle onto the center of an object

1. From the Window Menu, choose Object Snapping.
2. Drag the handle near the center of the object.

If you release the mouse button when the mouse pointer has a small magnet next to it, the handle will rest exactly on the center of 
the object.

_______________

{button ,KL(`object snapping,overview',0,`____No_Topics_Found',`')}    Related Topics



Moving objects

Objects can be moved using the mouse, accurately using the Selector Tool Infobar or in small steps using the keyboard.

What do you want to do?
Move objects by dragging
Move objects accurately

Movie

{button ,EF("XaraDemo.exe","Moving Moving Objects",1,`') } Moving objects



Moving objects accurately

You often want to move objects around your document. Usually you can just drag them to the required position but sometimes you 
want to position them more accurately.

To move an object accurately
1. Select the object (see Selecting objects).
2. Either

enter values in the Position Field on the Selector Tool Infobar and press RETURN,
or use the Position field arrow buttons on the Infobar to alter the values.

Tips
You can move objects using the cursor keys, see Nudging objects and handles.
This moves the object within the document. To move between documents see Cutting and copying objects to the 

clipboard.



Moving objects backwards and forwards

Often you find to want to move objects in front of or behind other objects.
To move objects backwards or forwards

1. Select the object (see Selecting objects).
2. From the Arrange menu, choose 

Bring to Front or Put to Back to move the object to the front or back of the layer/frame.
Move Forwards or Move Backwards to step the object towards the front or back of the layer/frame. 

Tip
The objects only move within a layer or frame. To move them between layers or frames, see Moving objects between 

layers.

Movie

{button ,EF("XaraDemo.exe","Arrange Moving Objects Backwards and Forwards within a Layer",1,`') } Moving objects 
backwards and forwards within a layer



Moving objects between frames

Xara X uses frames to create animated GIF files.
To move objects to a specific frame

1. Select the object.
2. From the Edit menu, choose Cut.
3. From the Utilities menu, choose Frame Gallery.
4. Click on the destination frame to make it the current frame.
5. Press CTRL+SHIFT+V to paste the object back in the same position in the frame.

Tips
You can move whole frames. See Reordering frames.
To move objects to the next or previous frame use Move to Next Frame or Move to Previous Frame on the Arrange 

menu.
To move objects within their current frame, see Moving objects backward and forwards.

_______________

{button ,KL(`frames',0,`____No_Topics_Found',`')}    Related Topics



Moving objects between layers or frames

You may want to move objects into a different layer or frame.
To move objects between layers or frames

1. Select the objects (see Selecting objects).
2. From the Arrange menu, choose Move to Layer in Front or Move to Layer Behind (for a Drawing document) or Move to 

Next Frame or Move to Previous Frame (for an animation document).
To move objects to a specific layer or frame

1. Select the object (see Selecting objects).
2. From the Edit menu, choose Cut.
3. From the Utilities menu, choose Layer Gallery (for a framed document) or Frame Gallery (for an animation document).
4. Click on the layer/frame to make it the current layer or frame.
5. Press CTRL+SHIFT+V to paste the object back in the same position in the layer/frame.

To move objects to the current layer

The current layer is the layer where new objects are created
1. Select the objects (see Selecting objects).
2. From the Utilities menu, choose Layer Gallery.
3. To make a different layer the current layer, click its name in the Layer Gallery.
4. Click Move to move the selected objects to the current layer.

Tips
When you move objects backwards and forwards between frames, the guides layer is ignored and skipped. 
You can move whole layers and frames. See Reordering layers and Reordering frames.
To move objects within their current layer/frame, see Moving objects backward and forwards.

_______________

{button ,KL(`layers,layer gallery overview',0,`',`')}    Related Topics



Moving objects by dragging

You often want to move objects around your document. Dragging is the easiest way to move them.
To move objects by dragging

1. Choose the Selector Tool (see Selecting objects).
2. Drag the object to the new position. If the object is part of the selection, the entire selection moves.

Moving objects using grid locking

When an object is moved with grid locking enabled the leading edge(s) of the bounding box of the selection will lock onto the 
nearest grid points. The normal operation of this feature is the same as with CorelDRAW. It is possible to force the object to remain 
at the same relative position on the grid as it is moved. To do this hold down ALT during the drag. This style of grid locking is the 
same as that used in ArtWorks.

Tips
To constrain the move angle, hold the CTRL key down during the drag. Press CTRL after the mouse click (otherwise the 

action will become a Select Inside operation).
To leave copies of the object as you move it, drag as normal, but click the right mouse button where you want each copy 

(or press ' +' on the numeric keypad).
To move the object but not any fill applied to it, press and release ' - ' on the numeric keypad during the drag. This is very 

useful if you want to move an object with a bitmap fill and you do not want the bitmap to move.
If you want to move the selected objects and for some reason you cannot drag them (for example if they are obscured by 

other objects), ensure the objects are selected, move the pointer anywhere on the page, press ALT+CTRL and drag. You can then 
release CTRL+ALT and move the objects as if you had dragged them normally.

If you want to move objects to a precise position, see Moving objects accurately.



Moving objects to the guides layer

For Drawing documents you can create objects in the guides layer exactly as on other layers.

You can move or copy existing objects to the guides layer using Cut-Copy-Paste. Pasting using CTRL+SHIFT+V (see Pasting 
objects from the clipboard) pastes the object in the same position it was Cut/Copied from (if the object was Cut or Copied in Xara 
X).

To create an object in the guides layer
1. From the Utilities menu, choose Layer Gallery.
2. Click on the guides layer. (See Creating the guides layer if there is no guides layer.)
3. Create the object as normal.

Tips
When objects are created in the guides layer or moved to it, only a dotted outline is shown.
Move To Layer in Front and Move to Layer Behind skip over the guides layer. See Moving objects between layers.
Guidelines and guide objects are non-printing.



Moving points on shapes and lines

When you are changing a a line or a shape you can move point handles individually or several at a time. You can do this using the 
mouse, the controls on the Shape Editor Tool Infobar or with the keyboard.

What do you want to do ?
Move a single point on a line or shape
Move several points on a line or shape
Set the length or angle of a straight line segment

Tip
The Shape Editor Tool is the main line editing Tool in Xara X, but you can use the Selector Tool for simple line editing 

operations if edit handles have been enabled - see Enabling edit handles.



Moving several points on a line or shape

Once you have drawn a line or shape, you can select a set of point handles on it and move them simultaneously.
To move several point on a line or shape

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool or Pen Tool (or the Selector Tool, see tips).
3. Select the point handles to be moved
4. Either:

drag one of the selected handles. Hold down CTRL to constrain handle movement to multiples of the angle set in the 
General Options.

or alter the values in the center Parameter Field on the Shape Editor Tool Infobar and press RETURN.
or use the arrow buttons on the coordinate Parameter Field on the Shape Editor Tool Infobar (the center field).

Tips
You can use the Selector Tool in the same way if you have enabled edit handles. See Enabling edit handles.
You can move point handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Point handles
Selector Tool
Pen Tool
Shape Editor Tool



Moving text around a curve

When you have text on a curve, you may decide you want it in a slightly different position on the curve.
To move text around a curve

1. Select the text object (see Selecting text objects).
2. Choose the Text Tool.
3. Drag either of the red text margin handles.



Moving the page

Often you want to scroll the document around in the window so you can see different parts of it.
To move the page

1. Choose the Push Tool.
2. Move the pointer over the page and drag to slide the page around in the window.

Tip
You can also move the page using the scrollbars. See Using scrollbars.
If your mouse has a wheel, you can:
scroll the wheel to scroll up and down
or hold down SHIFT to scroll left (scroll the wheel up) or left (wheel down)
or hold the wheel down to slide the document around in the window.

Movie

{button ,EF("XaraDemo.exe","ZoomPan.avi Magnifying and Moving a Document",1,`') } Magnifying and moving 
documents

_______________

{button ,KL(`tools,push tool;Push Tool',0,`____No_Topics_Found',`')}    Related Topics



Moving the ruler zero point

It is often easier to measure objects if you align the 0,0 point of the rulers with the object.
To move the ruler zero point

Drag the square shown at the intersection of the two rulers to the new 0,0 point. This also moves the grid origin so the divisions on 
the ruler always align with the grid.

Tips
Moving the zero point on the rulers also moves the grid origin.
You can move the origin more accurately in the Grid and Ruler Options.
To reset the origin to the bottom left corner of the page, double click on the square at the intersection of the two rulers.
If you turn on object snapping (Window menu) you can set the ruler origin exactly on the edge or corner of an object.



Moving the star points on a star-shaped polygon

After creating a star shape using the QuickShape Tool, you can reshape it to make the stellations shallower or deeper.
To move the star points on a star-shaped polygon.

1. Select the polygon or starred QuickShape to select it
2. Choose the QuickShape Tool
3. Drag on one of the 'inner' handles. The handle moves to stay under the mouse pointer. To just move the point in and out, hold 

down CTRL and drag towards or away from the center. To just rotate the point, hold down CTRL and drag the handles radially.

Tip
You can also change a starred polygon using the drop-down list on the QuickShape Tool Infobar. Choose Stellation 

radius and offset from the list and change the values in the fields on the right. Radius sets how far outwards the star points are 
and Offset sets their rotation.

_______________

Related Topics

QuickShape Tool
QuickShapes overview
Polygons



Moving the transformation center

When you rotate an object or skew an object (using the Selector Tool Infobar) the rotation or skew depends on the position of the 
transformation center. For example, if you want to rotate an object around its top left corner, you can move the transformation 
center to the top left corner of the object.

    
To move the transformation center

1. Ensure you are using the Selector Tool.
2. Change the selection handles to rotate/skew mode (see Switching selection handle mode).
3. Drag the transformation center to a new position. If you hold down CTRL whilst dragging the center, it will be constrained to the 

nine points shown on the Transformation Center Grid on the Selector Tool Infobar.

Tip
To move the transformation center quickly, just click on a square on the Transformation Center Grid on the Infobar to 

move the transformation center to a specific position on the selection.

      

_______________

Related Topics

Rotating objects
Skewing objects



Moving three color fill handles

A three color fill is controlled by two fill arrows joined at the base with a line across their ends forming a triangle. To move all three 
handles, move the handle at the base of the arrows. You can move the other two handles independently.

To move three color fill handles
1. Select the filled object. (see Selecting objects).
2. Choose the Fill Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows to 60 degrees, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see, Changing the constrain angle.
You can move fill handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Three color fills
Fill Tool
Fills overview



Moving three point transparency handles

A three point transparency is controlled by two transparency arrows joined at the base with a line across their ends forming a 
triangle. To move all three points, move the handle at the base of the arrows. You can move the other two handles independently.

To move three point transparency handles
1. Select the transparent object. (see Selecting objects).
2. Choose the Transparency Tool.
3. Drag one of the handles.

Tips
To lock the angle between the arrows, SHIFT-drag.
To lock the arrow to the constrain angle, CTRL-drag. Also see, Changing the constrain angle.
You can move transparency handles using the cursor keys, see Nudging objects and handles.

_______________

Related Topics

Three point transparency
Transparency Tool
Transparency overview



Moving transparency handles

You can move transparency handles to change to appearance of transparency.
To move a transparency handle 

1. Select the transparent object.
2. Choose the Transparency Tool.
3. Drag the transparency handle to its new position.

Tips
If you hold down CTRL while you drag the handle its movement is constrained to 45 degree intervals.
You can move transparency handles using the cursor keys, see Nudging objects and handles.
If you don't want to see transparency arrows when dragging (interactive dragging), press TAB during the drag.

_______________

Related Topics

Transparency Tool
Transparency overview



 Name Gallery (Utilities Menu)    Ctrl+Shift+F9

Name Gallery on the Utilities menu and the Name Gallery button opens or closes the Name Gallery. The button remains pressed 
in if the gallery is open.



Name Gallery - Apply Button

Dimmed unless 
· a Name is selected in the gallery,
· and there are selected objects in the document.

Apply the selected name (or names) to the selected objects. (Objects can have multiple names.) For more details see Naming 
objects overview.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Delete Button

Dimmed unless a Name is selected in the Name Gallery.

Delete this name from the Name Gallery and from any objects that use it. Delete does not change the appearance of objects. 
Delete is particularly useful where you have unused Names and you want to tidy the Name Gallery.

If you want to delete a name from objects but keep it in the Name Gallery use Remove.

_______________

Related Topics
Name Gallery Overview
Naming objects overview



Name Gallery - Export Button

Reexport the selected named objects. To select a named object for export click its name, not the circle to the left. (Clicking the 
circle selects the objects in the document, not the name in the gallery.) You can select multiple names by clicking the first name 
then CTRL-clicking the other names.

You can change the export options by selecting Exports from the drop down list - more information on the options.

_______________

Related Topics
Name Gallery Overview
Batch export



Name Gallery - Intersect Button

Dimmed unless more than one item (Name, Bitmap, Font, or Color) are selected in the Name Gallery.

Select only those objects that use all the selected items. Deselect all other objects.

Note the difference between Select and Intersect. For example, if you select a Name and a Color:
· Select - selects objects that use either the Name, or the Color, or both.
· Intersect - selects only objects that use both the Name and the Color.

_______________

Related Topics
Name Gallery Overview



Name Gallery - New Button

Dimmed unless there is a selected object in the document.

Create a new Name and apply that name to the selected objects. For more details see Naming objects overview.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Pop-up Menu

Right-clicking on the Name Gallery opens a pop-up menu which contains the following options:
Find Lets you find items in the Gallery. For more details, see Searching a gallery.
Apply Identical to the Apply Button
Remove Identical to the Remove Button
Redefine Identical to the Redefine Button
Select Identical to the Select Button
Intersect Identical to the Intersect Button
New Identical to the New Button
Rename Identical to the Rename Button
Delete Identical to the Delete Button
Export Identical to the Export Button
(Un)Fold Section Folds up or unfolds the current section
Previous Section Moves to the start of the previous section
Next Section Moves to the start of the next section



Name Gallery - Properties List

Select from the list:
Exports properties
Slicing properties
Stretching properties

_______________

Related Topics
Name Gallery Overview



Name Gallery - Redefine Button

Dimmed unless 
· at least one Name is selected in the gallery,
· and there are selected objects in the document.

Remove the selected name from all objects in the drawing and then apply it to only the selected objects. For more details see 
Naming objects overview.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Remove Button

Dimmed unless a Name is selected in the Name Gallery.

Remove this name from the selected objects. The name remains in the Name Gallery, even if no objects use it.

If you want to delete a name from objects and from the Name Gallery use Delete.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Rename Button

Dimmed unless a single Name is selected in the Name Gallery.

Change the selected name. This has no effect on objects that use this name.    For more details see Naming objects overview.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Select Button

Dimmed unless an item (Name, Bitmap, Font, or Color) is selected in the Name Gallery.

Select all objects that use the selected item. Deselect all other objects.

Note the difference between Select and Intersect. For example, if you select a Name and a Color:
· Select - selects objects that use either the Name, or the Color, or both.
· Intersect - selects only objects that use both the Name and the Color.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Export Properties

These options are used when export graphics as a series of slices - see Image slicing overview.
    Displays a dialog box that lets you select the file format to export in. The file name is the same as the name in the Name Gallery. 

The destination folder you select here is ignored: all the sliced graphics must be in the same folder and so the destination folder is 
that selected when you export the slices. Note that clicking Save just stores the selected options; it doesn't save a bitmap. (That is 
done when you slice the image.) 

 (Wording depends on the file format chosen.) Displays a second dialog box that lets you select number of colors etc. (The 
range of options depends on the file format you selected.) For more information on the available options, click Help on the dialog 
box. Click Apply to store the selected options.

_______________

Related Topics
Name Gallery Overview
Batch export



Name Gallery - Extend dialog box

To display this dialog box select Stretching properties in the drop-down list on the Name Gallery. Then click the arrow to the right 
of the Name you want to change the stretching options. (An example of where to use stretching is a button with text on it. You can 
make the button stretch as you add characters to the text. In this example, you would set stretching options for the button.) Both 
the object that stretches (the button) and the object that controls the stretching (the text) must be named objects.

From the list of Named objects select which names should control the stretching. (In the above example you would select the 
Name for the text.)

Next select what stretching actions you want. Options are None, Extend (stretch from the center of the object) and Stretch 
(stretch the complete object - has the same effect as stretching the object using the Selector Tool). An example of the difference 
between Extend and Stretch is a rectangle with rounded ends. Extend stretches the center of the rectangle; the corner radius is 
unchanged. Stretch elongates the entire rectangle and the round corners become elliptical.

_______________

Related Topics
Name Gallery Overview



Name Gallery - Image Slicing Properties

Slicing is useful when exporting large graphics for use on web pages. Instead of exporting a single large graphic, you can export 
the graphic in sections or "slices". The viewer then sees the image build up as each slice downloads. 

A second use is where a graphic has large areas of flat color. These areas can be exported as slices containing only a few colors 
(which makes the file size smaller). Slices containing detail can be exported with more colors.

Lastly navigation bars automatically export as slices.

When you choose Image slicing properties, a check box to the right of object names shows those named objects that slice 
underlying objects.

_______________

Related Topics
Name Gallery overview
Image slicing overview
Creating Navigation Bars



Name Gallery overview

    CTRL+SHIFT+F9

The Name Gallery gives you information about the current document. It lists:
Named objects in the document - you can name objects using either the Name gallery or the Selector Tool
Fonts used in the document - the Text Tool and Font Gallery control using fonts
Bitmaps used in the document - note that these are bitmaps currently used in the document. The Bitmap Gallery lists 

both currently used and deleted bitmaps. 
Named Colors used in the document - note that only Named Colors are listed, not Local Colors.

Against each item (name, font, bitmap, or color) you can see if the item is used in the current selection.    See below for more 
details.

Apply Used to give names to objects

New Create a new name and apply it to the selected objects

Select Select the objects that have any of the selected items (name, bitmap, color, or color)

Delete Delete a name from the Name Gallery and from any objects using that name

Export Re-export the selected named objects

Remove Delete a name from any objects using that name but do not delete it from the Name Gallery

Rename Change the name shown in the Name Gallery

Intersect Select the objects that have all the selected items (name, bitmap, color, or color)

Redefine Change which objects use a name

 Properties    Display which properties are shown
Against each item:

No objects selected that use this item (name, font, bitmap, color)
Some, but not all, objects that use this item selected.
All objects that use this item selected.

(blank) Unused name.

Using the Name gallery

You can use the Name Gallery in several ways:
to check which items (fonts etc.) are used in the document
to check which items are used in the selected objects
to select the objects that use particular items. (For example to select all objects that use a particular Named Color.)
to name objects for easy reference later

Many operations using the Name Gallery are more easily accessible using the Name Gallery pop-up menu.

Movies
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Naming objects

Selecting objects using the Name Gallery



Name Gallery - Stretching Properties

You can use Named objects to stretch other named objects. An example is the text on a button. Both the text and the button are 
named objects with the text flagged as stretching the button. Then when you change the length of the text (for example by typing 
in more characters), the button automatically resizes to match.

When you choose Stretching properties, a check box to the right of object names shows those objects you want to stretch (like 
the button in the example above). The check box gives a quick way of switching stretching on and off without changing the 
stretching options.
 to the right of the check box shows if the stretching options are set up (solid arrow) or not (hollow arrow). Click the arrow to 

display the Extend dialog box which lets you set the options.

_______________

Related Topics
Name Gallery Overview



Name Layer Dialog Box

The Name Layer dialog box lets you change the name for the layer. Type the name and click OK. For more details, see Renaming 
layers

Note:

Layers MouseOff, MouseOver, MouseDown, Selected and BackBar are used by the Button & NavBar Tool. We do not 
recommend renaming these layers or creating layers with these names as this could affect navigation bar creation. For more 
information on bar creation see Creating Navigation Bars.



Name Objects Dialog Box

This dialog box lets you create a new name in the Name Gallery and assign that name to the selection. Type the name and click 
OK. Naming objects has no effect on the appearance of the document. For more details, see Naming objects overview.



Naming Objects Overview

You can optionally assign names to objects or sets of objects. You can then use the names to:
record information about the objects, for example what they are used for.
select the objects; this is particularly useful if the objects are widely separated in the drawing or in a complicated drawing. 

One click and you can select just those objects that share a name.
selectively export parts of the document. This is particularly useful for web pages with complex graphics, which are often 

split into "slices" (or small parts) on the web page. Some slices are often flat color and can be exported from Xara X at lower quality 
than more complex parts. This can speed up downloading graphics to the web page.

for linked stretching where one named object can automatically stretch another named object. For example, changing the 
text on a button can automatically change the width of the button.

How to name objects:

You can use either:
the Name Gallery: this lets you create, change, and delete names and change which objects names apply to.
the New name button on the Selector Tool; this lets you add a new name to the selected objects. This lets you add a 

name to several objects at once.

Note:
Using the Button & NavBar Tool to convert objects to navigation bar buttons automatically names the objects. An example 

name is Button1.

Movies
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_______________

Related Topics

Name Gallery
Selecting objects using the Name Gallery



NavBar Edit States Dialog Box

To open this dialog box click Create/Delete States on the Button & NavBar Tool Infobar.

These options are used when creating rollovers. Xara X always creates the navigation bar with the MouseOff state. More 
information on rollover states.

MouseOff, MouseOver, MouseDown, Selected: selects the state you want to create or change.

New state looks distinct and Create/Recreate: used when creating or modifying rollover button states. See Creating a rollover 

button state.

Delete state: used to delete a rollover button - see Deleting a rollover button state. Note that deleting the MouseOff state deletes 

the entire navigation bar.

For more information on rollovers see Creating Rollovers.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



NavBar Set New Design Dialog Box

This dialog box lets you change the design of buttons in a navigation bar. For a simple bar this changes all the buttons. For a 
rollover, it changes all the buttons for the selected state. You can always edit individual buttons in the regular way.

To update a button design
1. Select the design you want to use for the buttons - selecting navigation bar objects.
2. For rollovers select the button state you want to change. (Use the drop-down list on the Button & NavBar Tool Infobar.) For 

example to change the design of the MouseOver buttons, select MouseOver from the drop-down list.
3. Open this dialog box by clicking Set new design on the Button & NavBar Tool Infobar.
4. From the drop-down list select the Bar you want to change.
5. Click Set design.

_______________

{button ,KL(`navigation bars',0,`____No_Topics_Found',`')} Related Topics



 New (File Menu)    CTRL+N

New creates a new, blank document based on the template document. 

Choose this menu item to create a new Drawing document. Display the submenu to select from any of the Template documents, 
including the Animation template. For more details, see Creating new documents.



New Named Color Dialog Box

Selecting the shade option sets whether you want the new color to be a shade color of the color you select in the drop-down list 
(see Creating shade colors) or a normal color. If you do not select this option, the new named color will be a stand-alone color 
created as a copy of the color you select in the list. Once you have created the color you can change it to any type of named color 
you like.



 New View (Window Menu)

New View opens another view on the current document. Changes in one view are reflected in all others. The Quality setting (see 
Changing the screen quality of documents) can be different for different views. For more details, see Opening another view on a 
document. New View is also available from the View Pop-up Menu.



Nudging objects and handles

You can move selected objects and handles small distances by using the four cursor (arrow) keys on the keyboard.
To nudge an object

1. Choose the Selector Tool.
2. Select the object (see Selecting objects).
3. Use the cursor keys to move the object.

To nudge a handle
1. Select the object.
2. Choose the relevant tool (for example, Fill Tool, Shape Editor Tool.)
3. Select the handle you want to nudge. (You can't move handles unless they are selected.)
4. Use the cursor keys to move the handle.

Modifiers
SHIFT-nudge moves ten times the normal nudge distance.
CTRL-nudge moves five times the normal nudge distance.
CTRL+SHIFT-nudge moves a fifth of the normal nudge distance.
ALT-nudge moves by one pixel.
ALT+SHIFT-nudge moves by ten pixels.

Tips
If you have several objects selected, you can select all the fill or transparency handles of a particular type (for example all 

end handles) by CTRL+SHIFT-clicking on one of the handles. Use SHIFT-click to deselect a handle or select an unselected handle.
You can change the nudge distance -    see Changing the nudge size.



OLE Overview

OLE provides a convenient way of incorporating Xara X drawings into suitable, OLE-compliant applications such as Microsoft 
Word. Another advantage of OLE is when you want to edit an embedded drawing. All you need do is double-click on the drawing in 
the Microsoft Word window. This loads the drawing into Xara X ready for you to edit it. When you finish, Xara X copies the drawing 
back to Microsoft Word keeping any custom values such as scaling. You can embed Xara X drawings into any OLE-compliant 
application.

To embed a drawing into an application

This describes how to embed a drawing into Microsoft Word (other applications will be similar).
In Xara X copy part or all of the drawing to the clipboard. Then embed it into Microsoft Word using Paste Special on 

Word's Edit menu.
Create the drawing in the usual way and save it to disk. You can then insert it into Microsoft Word by choosing Object on 

Word's Insert menu. Select the Create from File tab and select the name of the file.
Create a new drawing from within Microsoft Word. Choose Object on Microsoft Word's Insert menu. Select the Create 

New tab. Click Xara X Document. This opens a new Xara X window ready for you to create your drawing. When you finish the 
drawing, choose Exit and Return to Word on the File menu in Xara X. This inserts the drawing into the Word document.

Tip
When you embed a Xara X document or Xara X objects in another program, the objects will look best when displayed at 

100%. For example, if you embed some objects in a Microsoft Word document and then change the magnification in Word to 200%, 
the document will not look quite as good.

To edit an embedded Xara X drawing

Just double-click on the drawing in the application. This loads the drawing into Xara X ready for editing. When you finish editing, 
choose either Close and Return to (application) or Exit and Return to (application) on the File menu in Xara X.

Xara X menus and OLE

The File menu changes slightly when you are viewing an embedded drawing:
Save becomes Update. (The embedded drawing is automatically updated every 10-20 seconds. Update lets you update 

sooner if desired.)
Save as becomes Save Copy As. You can use this option to save a copy of the document.
Exit becomes Exit And Return To (Application). Choosing this updates the embedded document in the application and 

closes Xara X 
Close is either dimmed (if the embedded document is the only document) or becomes Close And Return To 

(Application). Choosing this updates the embedded document in the application (Xara X remains loaded in memory).

_______________
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Object Snapping Overview

Object snapping is a very powerful way of accurately aligning objects, lines and points on lines to any other object so they exactly 
touch. So, for example, if you want several lines to start at exactly the same point, or want a line to exactly join the edge of a circle, 
then using snap to objects is the answer. You can even use this to align the centers of objects and lock objects and handles onto 
the edge of the page.

When you drag an object with object snapping enabled, the point under the mouse pointer will snap to the nearest outline or any 
other 'point of interest' on any visible shape just as if it were magnetic. The 'point of interest' is the outline or any handle on the 
outline, and other positions such as the center of objects, it also includes the edges of the page.

For example, you can exactly align the corner of a square to the center of a circle by picking up the corner of square and dragging 
this near the center of the object. When the object has snapped, the mouse pointer will show a magnet and the magnet indicator 
on the Status Line (see Status Line Overview) will light up.

The snapping distance stays the same on screen no matter what zoom factor is used to view the drawing. So, if two potential 
guide objects are very close together and you have difficulty controlling which of them things snap to, zoom in on the two guide 
objects so that you can see the separation between them more clearly. You can then consistently snap to either object. For details 
on altering the magnetic snapping distances, see Changing the magnetic snapping distances.

If you want to drag an object by a corner and lock the corner onto another object using object snapping, you may find that the 
handle moves, rather than the whole shape. To stop this happening, turn off edit handles. See Enabling edit handles. Edit handles 
are very useful as you can use the Selector Tool to change handles, so remember to turn them back on again.

Object snapping is enabled using Snap to Objects on the Window menu. See Enabling object snapping.

Movie
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    Open (File Menu)    CTRL+O

Opens an existing document or file in a supported format in a new window. Xara X can open a wide variety of file formats, for a full 
list, see the List of Supported File Formats. For information on how to open files, see Opening documents from disk.

If you click on a PNG, BMP, GIF, JPEG, XAR or WEB file, you see a preview of it in the dialog box. (WEB files: you see a preview 
only if the file contains a preview - this is a Save option).



Opening another view on a document

You can open more than one view on a document. This is useful so you can see different areas of the document in different views 
at the same time. You may also find it useful as you can have different settings for each view. For example you can set the Quality 
setting differently for each.

To open another document view
1. Click on the document.
2. From the Window menu, choose New View.



Opening documents from disk

When you want to edit a previous saved document, you must load it from disk.
To open a document from disk

1. From the File menu, choose Open.
2. Browse to the folder containing the document file.
3. To display only particular file formats, choose from the Files of type list. (If in doubt, choose All Files.)
4. Double-click on the file.

Tips
To open a document you have recently opened, choose the file name from the list at the bottom of the File menu.
You can also drag-and-drop the file onto the program from the Explorer (or File Manager) or double-click on it. If you drop 

the file onto an existing document, it will be imported into that document. to open it, drop it onto a control bar.
If you want to load a file into an existing document, use Import.
You can also open files with the Clipart Gallery.
If you click on a PNG, BMP, GIF, JPEG, XAR or WEB file, you see a preview of it in the dialog box. (WEB files: you see a 

preview only if the file contains a preview - this is a Save option).



Optimizing Xara X for your Internet connection

Xara X’s default settings give satisfactory download speeds over any type of connection from a slow modem to a fast ISDN 
connection. However for faster connections you can optimize Xara X to increase download speeds.

To optimize Xara X
1. Display the Options dialog box by choosing Options on the Utilities menu.
2. Click on the Internet tab.
      Then.....

If you have a fast modem

3. Select the speed option for your modem. If you are not sure about your modem, use the default setting.

If you are connected over a network (LAN)

3. Select Dual ISDN or Better for Connection Type.

If you are behind a firewall

3. This applies to corporate users. If in doubt, contact your System Administrator. If your browser works correctly but you cannot 
download Xara X clipart into the galleries, you may need to set up details of the proxy server. (This is unnecessary with Internet 
Explorer which automatically sets up the proxy server details.)

Note: Unless you are using Internet Explorer: you may need to set up details of the Proxy Server. Note that you must enter the 
Server Name not the numeric IP address. You can find out the server details by checking in the Internet section of your Browser. 
Port is the TCP-IP port number assigned on the server.



 Options (Utilities Menu)
 CTRL+SHIFT+O

Options on the Utilities menu brings up the Options dialog box. There are two types of option you can set:
Program options
Options for the current document

When options apply only to the current document, the section of the Options dialog box will show the document name (for example 
'Grid options for map.xar'). The program options are saved when you finish using Xara X whereas the document options are saved 
with the document.

If you want to set the default options, see Changing the template document.

The options are divided into the following sections:
General Options
Grid and Ruler Options
Internet Options
Mouse Options
Page Options
Plug-in Options
Scaling Options
Tune-ups Options
Units Options
View Options



 Output Options

To open the Output Options, choose Print Options from the File menu and click on the Output tab. These options control what is 
printed and how it is printed. For information on printing, see the Printing Overview.

Print layers

Only foreground layers are printed - background layers are never printed. You can choose to print what you see on screen (Visible 
foreground layers), or to print all foreground layers, regardless of whether they are visible or not (All foreground layers).

PostScript language level

This option controls the type of PostScript sent to your PostScript printer. You can use Automatic (PostScript that will work with 
Level 1 or Level 2 printers), Level 1 or Level 2. See the Printing Overview for more details.

Print As

This option controls how Xara X prints a document. You can use Normal printing (a combination of normal printing and bitmaps for 
transparent areas), Bitmap or Anti-aliased Bitmap. The last two print the document by creating one large bitmap of it. See the 
Printing Overview for more details. If you are producing imageset separated output, always select Normal or PostScript printing. 
If you select either of the bitmap options, all colors are color corrected and spot colors output to CMYK. Also, no printers marks are 
output. For more details on imagesetting see the Imagesetting Overview.

Transparency resolution

Xara X's transparency effects are created using bitmaps. This option controls the resolution of those bitmaps when sent to the 
printer. Automatic is suitable for most drawings. Xara X then automatically selects a resolution suitable for the current printer.

Resolution of other bitmaps:
Bevels and Shadows: this is controlled by View in the Options dialog box.
Bitmaps created using Create bitmap copy: this is controlled by Bitmap size in the Create Bitmap copy dialog box.

Fill Quality

Dimmed for PostScript printers.

Using this option you can choose how many steps make up the graduated fills in your document when it is printed. The Normal 
setting is suitable for most purposes. See the Printing Overview for more details.

Text Options

If you set the Print All Text as Shapes option, all text will be converted to simple shapes before the document is sent to the 
printer. See Printing text for more details.



 Overprint Fill (Utilities Menu)

This setting is used for multicolor jobs that will be commercially printed. Setting this attribute prints the object over the top of any 
underlying ink colors. Its main use is when printing black text on colored backgrounds. See the Overprinting Overview or 
Overprinting objects for more details.

Overprint Fill is also available on the pop-up menu when you right-click on an object.



 Overprint Line (Utilities Menu)

This setting is used for multicolor jobs that will be commercially printed. Setting this attribute prints the line over the top of any 
underlying ink colors. Its main use is avoiding mis-registration problems with printing presses. See the Overprinting Overview or 
Overprinting objects for more details.

Overprint Line is also available on the pop-up menu when you right-click on an object.



Overprinting Overview

If you are producing color documents that will be printed on litho printing presses, you will often find overprint useful. Printing 
presses are mechanical devices with the inevitable slight misalignments when they are running. Overprinting lets you overcome 
these misalignments. For example, your job may have a black circle on a cyan background. When the document is imageset, the 
circle appears on the black separation and the cyan separation has a non-printing area under the circle. (The technical term is that 
the circle 'knocks-out' the background.) The knock-out is the same size as the circle.

 

If the two plates do not line up exactly during printing, the circle will slightly offset from the knock-out. The technical term is that the 
printing is 'out of register'. A small white gap appears at one edge. (Exaggerated in this example but even thin lines can be 
noticeable with dark colors.)

Overprinting compensates for this. Use overprinting with care. Overprinting large areas can flood the printing press with excess 
ink. Xara X has two type of overprint:

Ink level

Generally used for black ink (which is relative opaque). Underlying colors are not knocked out and black ink is simply printed on 
top. Less opaque inks may show a color shift when overprinted. For example, magenta and yellow overprinted give red. Xara X 
has two ink level overprint options:
1. overprint everything, including tints, in the specified ink color. Objects in other colors do not knock-out on this plate. Set in the 

Separations Options.
2. overprint solid black (everything over 95% Key). Set in the Imagesetting Options.

Object level

You can separately specify overprint for the line and fill colors. Right-click on the object to open the pop-up menu. Then choose 
Overprint line or Overprint fill from the Imagesetting submenu.

To cancel object level overprint, click again on Overprint line or Overprint fill.

Overprinting the fill is most commonly used to overprint dark colored text on a light background.

Overprinting the line is the normal way of avoiding mis-registration. The print shop can tell you the tolerance to allow (usually 0.5pt 
to 1pt).If you add a 1pt line to the black circle and set it to overprint, it extends onto the background by 0.5pt. The line color 
depends on the background and object colors. Unless you want a specific line color, set the line to the lighter color (Cyan in this 
case.) The illustration uses a red line around part of the circle so you can see it.

Note that you can only check overprint by examining the films produced by the service bureau. Ordinary desktop printers ignore 
any overprint settings.

_______________
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Overprinting objects

Overprint can be used in multicolor work that will be litho-printed. See the Overprinting Overview for details of when overprinting is 
useful.

To apply overprint to an object

This is the most useful form of overprint.
1. Select the object (see Selecting objects).
2. On the Utilities menu open the Imagesetting submenu then choose either

Overprint Fill
Overprint Line

Overprinting the fill is most commonly used to overprint dark colored text. Overprinting the line overcomes possible mis-registration 
problems. See the Overprinting overview for more information on mis-registration. To cancel object overprint, click Overprint Fill 
or Overprint Line to unselect.

To overprint everything in a separation

This overprints everything in a particular ink color. It is rarely useful.
1. From the File menu, choose Print Options.
2. Click on the Separations tab.
3. Click on the ink name.
4. Click Properties. This opens a dialog box with options for that ink.
5. Select Overprint this ink.

To overprint solid black

This overprints everything that is 95-100% solid color on the Black separation.
1. From the File menu, choose Print Options.
2. Click on the Imagesetting tab.
3. Select Always Overprint Black.

Tips
Do not apply overprint to large areas as this can flood the printing press with too much ink.
Black ink is relatively opaque and overprints well. Other ink colors can show a color shift when overprinted.

_______________
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PCX Export Dialog Box

The PCX export bitmap dialog box is opened by selecting PCX as the exported file format from the Export dialog box. It allows the 
setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. For details of 
how to create a PCX file, see Creating PCX files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



PICT Export Dialog Box

The PICT export bitmap dialog box is opened by selecting PICT as the exported file format from the Export dialog box. It allows 
the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. For details 
of how to create a PICT file, see Creating PICT files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



PNG Export Dialog Box

The PNG export bitmap dialog box is opened by selecting PNG as the exported file format from the Export dialog box. With it, you 
can set the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. In addition Xara 
X also allows PNG files to contain simple transparency and interlacing. For details of how to create a PNG file, see Creating PNG 
files.

Preview boxes
Palette Options
Bitmap Options Tab
Bitmap Size Tab
Image Map Tab
Browser Preview
Export/Apply Button (see Note)

Exporting from the Bitmap Gallery

If you export a bitmap using the Save button in the Bitmap Gallery, only one tab will appear because you can only change the 
basic bitmap settings. You cannot for instance resize it. If you need more options, select the bitmap in the document and use 
Export on the File menu.

Note

This button reads Apply when setting options in the Name Gallery (because you are setting options prior to Exporting a sliced 
image). Otherwise it reads Export. 

_______________
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 Page Options

Choose Page Options from the File menu . 

You can also access them by right-clicking on the page to open the pop-up menu and choosing Page Options. These options 
control how your document appears on the screen.

Summary Line

This line displays the same information as in the normal Print dialog box - probably the most useful piece of information is how 
many pages will fit onto the piece of paper when printed.

Paper Size

The paper size setting sets the paper size used for the current document.

Centimeters Inches

A0 84.0x118.8 33.07x46.77

A1 59.4x84.0 23.39x33.07

A2 42.0x59.4 16.54x23.39

A3 29.7x42.0 11.69x16.54

A4 21.0x29.7 8.27x11.69

A5 14.85x21.0 5.85x8.27

A6 10.5x14.85 4.13x5.85

US Legal 35.56x21.59 14.0x8.5

US letter 27.94x21.59 11x8.5

International Fanfold 30.48x20.95 12x8.25

To set a size not shown in the drop-down list, choose Custom and enter the required values in the Width and Height fields.

For details of how to to change the paper size, see Changing the paper size. For details of changing the paper size for all new 
documents, see Changing the default paper size.

Orientation

These two buttons allow you to control whether the paper is displayed so that its longest side is vertical (Portrait) or horizontal 
(Landscape). When you come to print the drawing you will have to choose how to fit the drawing onto the paper and the Print 
Layout Options contain controls which allow you to do this.

Outer Margin

This value sets the size of the margin, or pasteboard, around the page. For more information, see Changing the size of the 
pasteboard.

Double Page Spread

You can create a document consisting of two pages, called a double page spread. This option adds a second page to your 
document. See Creating a double page spread for more information.

Bleed

This setting determines the bleed-off around your document. For information about setting the bleed, see Changing the bleed 
setting.

Show Page Shadow

This option sets whether a shadow is displayed under the page. See Hiding the page shadow for more details.



Painting with bitmaps

By combining bitmap fill, transparency and brush stroking you can create the effect of a bitmap painted onto the page. Because 
the brush is semitransparent, you can make parts of the painting semi-opaque.

To paint with a bitmap

There are several distinct steps.

First step: create the brush design
1. Draw the object you want to use as the brush. A circle is the easiest shape to use - Drawing a circle.
2. Make the line around the edge of the object invisible - Changing a line color.
3. Fill it with the bitmap you want to use - Applying a bitmap fill.

If necessary scale the bitmap to the size you want.
Make sure that Fill Tiling is set to Repeating tile or Repeat inverted (depending on which suits the bitmap you are using).

4. Give the object a circular transparency - Applying a circular transparency.
Make the outer edge of the transparency 100% transparent - Changing the transparency levels.
Make the center of the transparency partially transparent. We recommend 70-80% transparent.

Second step: make it into a brush
1. Select the Freehand & Brush Tool.
2. Click Create Brush.
3. Give the brush a name. You can use any unique name.
4. Click OK to create the brush.

Third step: painting with the brush
1. Select the Freehand & Brush Tool.
2. If you have just created a brush it is already selected. If not, select it from the brush drop-down list.
3. Draw a freehand line by dragging the mouse pointer over the page - Drawing a freehand line.

To make areas less transparent drag the line back over the area. This gives overlapping brush patterns and a more opaque 
result.

4. After drawing the line you can edit it if required.

Note:
If you want to change the bitmap used for painting, you need to create a new brush. (You cannot change the bitmap used 

in an existing brush.) Repeat the First and Second steps to create a brush with the new bitmap. Next select the line and then select 
your new brush from the brush drop-down list.

_______________
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 Paste (Edit Menu)    CTRL+V

Paste copies objects from the clipboard into the center of the current view in the current layer. The objects may originally have 
come from the same document, they may have come from another document loaded in Xara X or they may even have come from 
another document in another application. If the clipboard contains text, paste will place the text at the text cursor or overwrite the 
selected region (as appropriate). For more details, see Pasting objects from the clipboard.

Tips
You can paste an object into a document quickly by right clicking on the document to open the pop-up menu and selecting 

Paste.
The Paste menu item displays a brief description of what will be pasted. For example Paste bitmap.
You can also use the key shortcut SHIFT+Insert to paste objects from the clipboard.



 Paste Attributes (Edit Menu)    CTRL+SHIFT+A

This option lets you copy attributes (such as the line pattern or fill color) between objects. It is a quick way of applying multiple 
attributes. When you choose Paste Attributes, the attributes of the objects on the clipboard are applied to all the objects currently 
selected. The objects remain on the clipboard until overwritten by, for example, a Cut or Copy operation so you can repeat Paste 
Attributes many times.

_______________
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Paste Special Dialog Box

If when you Paste with data on the clipboard from another application and there is more than one format that the data could be 
transferred as, the Paste Special dialog box will appear giving you a chance to choose the specific format that you require Xara X 
to import. The highlighted format (always the top item in the list) is the one which is considered the "best" format to paste.

Choose the format which you prefer to paste, and then click the Paste button. Alternatively, you may click Cancel to cancel the 
paste operation entirely.

Note
Once you have pasted something into a document, the pasted data is remembered in order to make subsequent pastes 

faster (as importing some clipboard data formats can take some time). This means the Paste Special dialog box will not appear 
again until you copy new data to the clipboard from another application.

_______________
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    Paste at Same Position    CTRL+SHIFT+V

Paste at Same Position is identical to the normal Paste, but it pastes the clipboard contents into the same X-Y position on the 
page as they were cut or copied from. This is useful for moving items between documents or moving between layers. (This applies 
only to objects cut or copied from Xara X.)

Pasting from Other Applications

Occasionally, when pasting into Xara X from another application, the data you are pasting can be transferred in several different 
formats. For example, text copied from Microsoft Word can be pasted as "unformatted text", or as a "Windows metafile picture". If 
this is the case, the Paste menu items will read Paste... and selecting it will open the Paste Special dialog box so you can choose 
how you want to transfer the data.

_______________
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Pasting attributes from the clipboard

You can apply the attributes of the contents of the clipboard to objects like this:
To apply attributes from the clipboard

1. Select the objects to apply the attributes to.
2. From the Edit menu, choose Paste Attributes.

Tips
Paste Attributes only applies attributes which are identical on all objects on the clipboard. So for example if the clipboard 

contained objects with different fill colors, Paste Attributes would not affect the fill color of the selected objects when chosen.
You can set the current attributes using this method. Just don't select any objects before you click Paste Attributes.

_______________
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Pasting objects from the clipboard

You can put the contents of the clipboard into a document.
To paste objects from the clipboard

From the Edit menu, choose Paste.

The objects will be placed in the center of the document window.

Tips
If you want to paste the objects in the same place you cut or copied them from, press CTRL+SHIFT+V (Paste at same 

position).
You can use copy, cut and paste to move objects between documents and programs.
Sometimes when you paste the contents of the clipboard into a document, it could be inserted using several different 

formats. If this is the case the Paste Special dialog box will appear so you can choose a format.

_______________
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 Pen Tool    SHIFT+F5
The Pen Tool is an alternative way of creating lines and shapes. We recommend using the Shape Editor Tool as it lets you create 
and edit lines using the same tool. The Pen Tool operates in exactly the same way as equivalent tools in other programs such as 
CorelDRAW or Adobe Illustrator. If you are familiar with such programs, you may prefer to use this tool to draw lines and shapes. 
To find out more about lines and shapes, see the Lines and Shapes Overview.

Pen Tool Operations

Drawing a line

Drawing a shape

Extending lines

Changing curved lines and shapes

Breaking lines and shapes apart

Movies

{button ,EF("XaraDemo.exe","PenDraw Drawing Lines and Shapes with the Pen Tool",1,`') } Drawing lines with the Pen 
Tool

{button ,EF("XaraDemo.exe","PenEdit Editing Lines and Shapes with the Pen Tool",1,`') } Editing lines with the Pen Tool



PhotoCD Import Dialog Box

When you open or import a PhotoCD file you will be presented with this dialog box which allows you to choose which resolution 
you would like to load. For details on loading PhotoCD files and adding PhotoCD's to galleries, see Importing PhotoCD files.

PhotoCD files contain up to six versions of the image at differing resolutions, these are defined by Kodak as:

Name Resolution Memory Required

Base/64 96x64 24Kb

Base/16 192x128 96Kb

Base/4 384x256 384Kb

Base 768x512 1.5Mb

Base*4 1536x1024 6Mb

Base*16 3072x2048 24Mb

Base/64 is used for small 'thumbnail' previews of the image. You cannot load Base/64 images into Xara X.



"You must make a selection.." error message

The plug-in is asking for a feature not supported by Xara X.



Wrong number of display colors

Some plug-ins require hi-color (32,000 or more colors) displayed on your monitor. This is a function of the plug-in and beyond the 
control of Xara X. You can use the Windows Control Panel to change the number of colors. Check the documentation supplied 
with your monitor for the correct settings.



Plug-in isn't 32 bit

The plug-in is the older 16-bit type and not 32-bit, which is the modern standard. Xara X works with 32-bit plug-ins only. Check with 
the supplier of the plug-in to see if they have a 32-bit version.



Plug-in had a problem

This error message has two main causes:
The plug-in requires features not supported by Xara X. 
The plug-in does not work with your operating system. This applies particularly to Windows NT 4. Contact the supplier of 

the plug-in to see if they have a later version.



Final bitmap is black and white

This can happen when modifying grayscale bitmaps. The plug-in thinks that it has changed the colors but saves the bitmap out as 
grayscale. This is a function of the plug-in and beyond the control of Xara X.



No new bitmap in the Bitmap Gallery

This happens when the settings you selected in the plug-in do not alter the bitmap. There is no need for Xara X to create a new 
bitmap as nothing has changed.



Object is not a bitmap

You can convert any part of your drawing to a bitmap. See Creating bitmaps from objects.



Plug-ins Options

This dialog box lets you add and remove folders of bitmap effect plug-ins. See Bitmap effects plug-ins for more details.
New - see Installing plug-ins
Download plug-ins - click this to connect to Xara's web site.
Remove - see Removing plug-ins
Search for Plug-ins at Program Startup - when selected, Xara X scans the listed folders for suitable plug-ins when the 

program starts up. This adds a few seconds to the start-up time. If you prefer not to have this slight delay, deselect this 
option. The scan is then done when you click on Bitmap Effects & Plug-ins on the Utilities menu for the first time.



Plug-ins Troubleshooter
This page lists some common problems with plug-ins. You can also try the documentation supplied with the plug-in.

What's the problem?

{button ,JI(`',`Plug_ins_troubleshooter_32bit')} A message tells me the plug-in isn’t 32-bit.

{button ,JI(`',`Plug_ins_troubleshooter_256_colors')} An error message tells me either my monitor is 256 colors or that this 

plug-in requires 16/24-bit color screen modes.

{button ,JI(`',`Plug_ins_troubleshooter_error_message')} An error message tells me the plug-in had a problem.

{button ,JI(`',`Plug_ins_Troubleshooter_No_Selection')} An error message tells me "You must make a selection so this filter will 

know where to work".

{button ,JI(`',`Plug_ins_troubleshooter_mono')} The preview appeared colored but the final bitmap is black and white.

{button ,JI(`',`Plug_ins_troubleshooter_no_new_bitmap')} I’ve used a plug-in but there’s no new bitmap in the Bitmap Gallery.

{button ,JI(`',`Plug_ins_troubleshooter_not_bitmap')} I want to apply a plug-in effect to part of my drawing but it is not a 

bitmap.
Our technical support staff cannot advise on specific plug-in problems.



Point Handle Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a point handle, it contains the following options:
Shape Editor Tool
- - - - - - - - - -
Change to lines
Change to curves
- - - - - - - - - -
Delete points
Break at points
- - - - - - - - - -
Select all points
Deselect all points

_______________
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Pop-up Menus Overview

Many commonly used Xara X functions can be found on the pop-up menu which appears when you right-click on a document. 
Note that you can configure the mouse's right-button click to do other things if you prefer. See Mouse Options for more details. 
Pop-up menus are also available in other areas of Xara X. When you right-click on an object the pop-up menu offers options for 
that object and options about objects in general. Note that right-clicking on an unselected object selects it as well as popping up a 
menu.

Right-clicking on:
blank area of the page displays the View pop-up menu
line or shape displays the Line and Shape pop-up menu
QuickShape displays the QuickShape pop-up menu
blend displays the Blend pop-up menu
mold displays the Mold pop-up menu
text object displays the Text pop-up menu
bitmap displays the Bitmap pop-up menu
point handle displays the Point Handle pop-up menu
guideline displays the Guideline pop-up menu
ruler displays the Ruler pop-up menu
shadow displays the Shadow pop-up menu
bevel displays the Bevel pop-up menu
contour displays the Contour pop-up menu
Clipart Gallery displays the Clipart Gallery pop-up menu
Font Gallery displays the Font Gallery pop-up menu
Fill Gallery displays the Fill Gallery pop-up menu
Frame Gallery displays the Frame Gallery pop-up menu
Layer Gallery displays the Layer Gallery pop-up menu
Color Gallery displays the Color Gallery pop-up menu
Bitmap Gallery displays the Bitmap Gallery pop-up menu
Name Gallery displays the Name Gallery pop-up menu



Pressure sensitivity and brushes

Brushes let you apply patterns to lines and the outlines of shapes. If you have a pressure sensitive input device (such as a 
graphics tablet), you can give the brush design either variable transparency or variable sizing (or both). Even if you don't have a 
graphics tablet you can use stroke shapes to simulate the pressure sensitive effect.

Using a graphics tablet
1. Select the Freehand & Brush Tool.
2. From the Select brush drop-down list select the brush design you want to use (see Notes).
3. Draw the line - more details.

Note:
The default brushes have either transparency or sizing controlled by pressure. (The exception is Normal line which is 

used to remove any applied brush stroke.) 
You can change how much sensitive the brush is to pressure. You can also change whether pressure controls size or 

transparency (or both) - see Editing brushes.
Using stroke shapes

1. Draw the line using any of the drawing tools - see Drawing lines.
2. Select the Freehand & Brush Tool.
3. From the Select brush drop-down list select the brush design you want to use (see Notes).
4. From the Select stroke drop-down list select the stroke shape/pressure profile you want to use.

Note:
The default brushes have either transparency or sizing controlled by pressure. (The exception is Normal line which is 

used to remove any applied brush stroke.) 
You can change how much sensitive the brush is to pressure. You can also change whether pressure controls size or 

transparency (or both) - see Editing brushes.
Using a stroke shape overrides any pressure information from a graphics tablet.

Movie

{button ,EF(`xarademo.exe',`Pressure Pressure sensitivity',1,`')} Pressure sensitivity

_______________

Related Topics

Line
Brushes
Stroke shapes



Preview All Frames (Utilities Menu)

This option is dimmed for Drawing documents.

Choose this item to preview your animation. The Animation Preview dialog box will open and you can start and stop the animation 
to see what it looks like. For more details, see Previewing animated GIF files.

_______________

Related Topics

Frames
Animated GIF files



 Preview Animation in Browser (Utilities Menu)

This option is dimmed for Drawing documents.

Choosing this item creates an animated GIF files from the frames in your document and opens it in your web browser so you can 
see what it looks like. For more details on how to preview animations, see Previewing animated GIF files.

_______________

Related Topics

Frames
Animated GIF files



Preview Dialog Box

This dialog box has two functions:
previewing frames and animations in Animation documents. For more details, see Previewing animated GIF files.
previewing selected bitmaps in the Bitmap gallery

Play Cycle through the selected bitmaps in the Bitmap Gallery or run the animation. (Dimmed if a single 
bitmap or frame is selected.)

Stop

Previous Display the previous bitmap or frame in the animation. (Dimmed if a single bitmap or frame is 
selected.)

Next Display the next bitmap or frame in the animation. (Dimmed if a single bitmap or frame is selected.)

Slider While an animation is running this shows progress through the animation. You can also drag the 
slider to move to any of the frames.

Refresh (Dimmed if displaying bitmaps in the Bitmap gallery.) If you change your drawing, click this button so 
the animation is updated.

Name Displays the name of bitmap or frame currently shown in the Preview window.



Previewing animated GIF files

As you build up the frames for your animated GIF, you can see what the animation will look like using the Animation Preview dialog 
box or in your web browser.

To preview an animated GIF
1. Create your animation.
2. From the Utilities menu, choose Preview All Frames or Preview Animation in Browser.

Tips
When you open the Preview window there is a few seconds delay while Xara X creates the bitmaps that make up the 

animated GIF. There may be a similar delay after you click Refresh.
The preview window always shows the Animated GIF for the current document. If you change documents the Preview 

window shows a cross until you click the Play button.
Display pauses if you drag objects in the main document window. This avoids jerkiness in the animation during dragging.

Movies

{button ,EF("XaraDemo.exe",`AniGIF Animated GIFs',1,`') } Creating Animated GIFs

_______________
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Previewing bitmaps

For fast download over the web, graphics need to be kept small. This often means selecting different options until you find the best 
combination. Xara X speeds up this process by letting you quickly preview what the exported bitmap will look like.

Previewing in Xara X - this is useful when trying different combinations of settings, particularly for formats that let you 
define the number of colors.

Previewing in a browser - how your graphic will look when downloaded over the Internet. The final test.
To preview a bitmap

1. Choose Export on the File menu.
2. Enter the file name and select the required file format
3. Click Save to open the Export dialog box.
4. Set the required options. The preview automatically updates.
5. If required, you can change the options.
6. When you get the required results, click Export to save the bitmap to disk.

You can repeat this as many times as required. As new options give better results, swap between the two previews by clicking on 
them. Xara X remembers the settings associated with each preview, so you can experiment without losing the settings that give 
the best results.

To preview in a browser
1. Choose Export on the File menu.
2. Enter the file name and select the required file format
3. Click Save to open the Export dialog box for that file type.
4. Click the Browser Preview tab.
5. Click Browser preview to view the image in your browser. 

With Show all previews in browser select, any changes you make in this dialog box, automatically updates the preview in the 
browser.

For more information on the options on this tab, click the Help button on the Bitmap Export dialog box.



Previewing bitmaps in a browser

You can preview bitmaps in a web browser. This is a useful final check as browsers sometimes display bitmaps slightly differently 
to Xara X.

To preview a bitmap before export
1. In the Export dialog box, click the Browser preview tab.
2. Select the required options - more information.
3. Click the Browser preview button to display the bitmap in your default browser.

To preview navigation bars

Because navigation bars comprise several bitmaps and some HTML code, you must save them to disk before previewing 
them.

After saving the navigation bar to disk, you are asked if you want to view the bar in your browser.

_______________
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 Previous Zoom    CTRL+R

This option takes you back to the last zoom magnification. It is a very useful way to switch between two magnifications. For more 
details, see Returning to the previous zoom.



 Print (File Menu)    CTRL+P

The Print dialog box is where you control the printing of a document (see Printing documents). It displays basic information on the 
printer and how the drawing will be printed. If you want to change settings for your printer, click the Printer button. If you want to 
change how Xara X will print your drawing, press the Options button. For more information about printing, see the Printing 
Overview. If you have problems printing with Xara X, click the Problems? button to open the Printing Troubleshooter.

Print Objects
Print Pages
Copies
Collate Copies
Print To File
Print
Options
Printer

At the bottom of the dialog box is a brief description of how the document will be printed:
Layout type - Best Fit, Multiple Fit or Custom Fit (see Print Layout Options).
The scaling to be used - 100% means print at normal size, 50% means print half size, 200% means print at twice the 

normal size.
The orientation - Upright or Sideways.
How many pages will fit onto the paper with the current settings. 

_______________
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Print Dialog Box - Collate Copies Option

This option is dimmed except when printing multiple copies of a double page spread as two separate pages. With this option 
selected, pages are printed as left-right-left-right... etc. With this option deselected, all the left-hand pages are printed, followed by 
all the right-hand pages. Printers that hold a page in memory (such as PostScript printers) take some time to process the image. 
The printer can then print multiple copies at its maximum speed. For such printers it is often faster to manually collate the pages 
after printing.



Print Dialog Box - Copies Field

This option specifies how many copies of the drawing will be printed. Note that some printers, such as Laser printers (or similar 
page printers) can support multiple copies of a page directly, whereas other printers, such as ink jet printers, cannot, and must be 
sent multiple copies of the drawing by Xara X. This means that you may run out of disk space if you print many copies to a printer 
that does not support this option directly.



Print Dialog Box - Options Button

This button opens the Options dialog box showing only the printing options.
Imagesetting Options
Print Layout Options
Output Options
Separations Options

_______________
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Print Dialog Box - Print Button

Clicking this button will print the current document using the settings you have chosen.



Print Dialog Box - Print Objects Options

These options are available when any objects in the document are selected. You can choose whether to print all the objects in the 
document, or to print only those objects that are selected (see Selecting objects). When you print selected objects, this means that 
the selected objects are printed, not that all the objects within the bounds of the selection are printed.

Objects in the background layers and the guides layer never print. See the Layer Gallery Overview for more details.



Print Dialog Box - Print Pages Options

If your document is a Double Page Spread (DPS) then you can control which page or pages are printed. You can print the left 
page, the right page, or both pages.



Print Dialog Box - Print To File Option

If this is enabled, then the print job will not be sent to the printer, but will be diverted to a file instead. When you initiate the print by 
clicking on the print button, Xara X will prompt you for the name of the file to redirect the print job to. This option is most useful 
when used in conjunction with PostScript printers, as it enables you to produce a PostScript print file that can then be sent to a 
typesetter.



Print Dialog Box - Printer Button

This button opens the Print Setup dialog box so you can change which printer you are printing to.



 Print Layout Options

To open the Print Layout Options, choose Print Options from the File menu and click on the Print Layout tab. The print layout 
options control how your document appears on paper. For more information on these options and printing in general, see the 
Printing Overview.

All the options in this section apply to the current document. They will be saved with the document.

Summary Line
The type of layout - Best Fit, Multiple Fit or Custom Fit.
The scaling - 100% means print at normal size, 50% means print half size, 200% means print at twice the normal size.
The orientation of the job - Upright or Sideways. This is normally used to fit landscape pages onto portrait pages by 

rotating the drawing when printing (see the orientation buttons below). This effect can also be achieved by changing options in the 
Print Setup dialog box, but it is best to leave these settings alone, and use the controls provided in the Print Layout Options instead.

How many pages, if any, will fit onto the paper with the current settings. This takes account of the print margins of the 
printer (that is, which areas around the edge that the printer is physically unable to print to).

If the summary says 'Page only partially printable', this means that part of the page lies outside the Print Borders. See Displaying 
the print borders.

Paper Size

This field shows the currently selected paper size. (The paper size is defined using the Print Setup dialog box.)

Orientation

These options choose upright or sideways printing. Upright prints without rotating the document, whereas Sideways rotates the 
document through 90 degrees.

For example, to print a landscape page on most printers requires sideways printing. The best way to set the orientation is by using 
the Best Fit option, this will set all the Print Layout Options to the most suitable values. Alternatively, turn on the print borders so 
you can see how the document will print (see Displaying the Print borders). See the Printing Overview for more details.

Note: This option is not the same as the one shown in the Print Setup or the Printer Properties dialog box. Ensure that the printer 
is always set to Portrait printing and that you only use the Print Layout Options orientation buttons to fit the drawing on the paper.

Scale

The document can be scaled for printing. 100% is full size. This can be used to print several copies of a document on a page, see 
Multiple Fit below.

Print Whole Spread

This option is only available when the current document is a double page spread. If this option is set, the spread is printed as one 
page.

Print Individual Pages

This option is only available when the current document is a double page spread. If this option is set, the two sections of the 
spread are printed as separate pages.

Best Fit

If you choose this option, your document will be moved to the center of the page and scaled so it fills the paper (within the print 
borders).

Custom fit

This option allows you set all aspects of the printing manually. The Orientation buttons can be used to choose the orientation of the 
printout. The scale can be altered using the Scale field. The Top and Left margin fields can be changed. These set where the top 
left-hand corner of the page appears on the printer's paper. The Width and Height fields give you an alternative way of setting the 
print scale. When you change one of these settings, the other changes to ensure the page is always printed with a 100% aspect 
ratio.

Multiple Fit

If you change the scaling, you can print multiple copies of the Xara X document on a page. To print multiple copies, choose this 
option, enter a value for the number of copies needed across the page (Rows), the number down the page (Columns) and the 
distance between each (Gutter).

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



 Print On All Plates

This setting is used for multicolor jobs that will be commercially printed. Objects with this attribute set appear on all separations. Its 
main use is creating custom printers marks. Do not apply Print On All Plates to large areas as this can flood the printing press 
with excess ink.

Print on All Plates is also available on the pop-up menu when you right-click on an object.



Print Options (File Menu)

You can display this dialog box by either:
choosing Print Options on the File Menu
or clicking Options on the Print dialog box.

For more information about printing, see the Printing Overview.
Imagesetting Options
Print Layout Options
Output Options
Separations Options



 Print Setup (File Menu)

This dialog box is primarily used to specify which printer you wish to print to. To change the printer, click on the drop-down list and 
choose the printer you require. Assuming your printer is set up correctly, you may also choose what size of paper to print on. Do 
not set the paper orientation here, leave it as portrait and use the orientation setting in the Print Layout Options. You can usually 
change the resolution of the printer from this dialog box, either directly, or by pressing the More button.

Note
The process of installing printers is beyond the scope of this On-line documentation. If you require assistance, please 

consult your Windows User Guide.

_______________

Related Topics

Printing
Show print borders



Print Text As Shapes

Print Text As Shapes on the Text Pop-up Menu converts text to shapes before the document is sent to the printer. This can be 
useful when printing to a PostScript printer that does not have the same fonts installed as are used in your document.

_______________

{button ,KL(`text objects,printing text as shapes',0,`____No_Topics_Found',`')}    Related Topics



Printing Overview

Xara X provides a wide variety of choices for printing your documents. If you need information on imagesetting and commercial 
printing, see Printing multiple copies.

If you experience any problems, try using the Printing Troubleshooter.

Printing Methods

Printers do not support transparency so Xara X sends any areas of your document containing transparent objects to the printer as 
bitmaps. This is why printing takes a little longer for transparent objects and also why print jobs can be larger. When you print a 
document, you can use one of three methods to print the document. One method is just like a normal print from any other 
program, except that transparent areas of the document are sent to the printer as bitmaps. The other two methods both send the 
entire document to the printer as a bitmap. One sends a standard bitmap of the document, the other sends an anti-aliased version. 
The printing method is set in the Output Options.

For most drawings, choose the Normal method (This option reads PostScript if a PostScript printer is selected.). This method 
works well for all drawings except those that include large areas of bitmaps or large areas containing transparent objects. With 
these drawings printing can be slow. If it is slow, choose the Bitmap or Anti-aliased Bitmap option. The resolution of the bitmaps 
is controlled by the Resolution field. Generally Anti-aliased Bitmap gives the best results. Though, you may find drawings 
containing fine lines do not print as well. Try printing in Normal mode and, if you have any problems, try again using Bitmap or 
Anti-aliased Bitmap.

PostScript Options

Xara X supports two types of PostScript, Level 1 and Level 2. All PostScript printers understand Level 1 and more recent printers 
can also understand Level 2 which contains speed and color enhancements. In the Output Options there are options for 
Automatic, Level 1 and Level 2. Leave this option set to Automatic (this produces PostScript that uses the extra features of 
Level 2 but also runs on Level 1 devices) unless you know your printer supports Level 2. If you use Level 2 printing it is likely to be 
faster, particularly if your document contains many bitmaps and large amounts of transparency. If you have problems printing, set 
this option to Level 1.

Paper Orientation

When you create a document you draw objects onto a page which can be either Portrait or Landscape. This setting does not 
affect printing in any way. The setting in the Print Layout Options sets whether the objects in the document are printed upright or 
sideways on the page. Upright means the page is printed the way you see it, sideways means it is rotated by ninety degrees. To 
see how your document will appear on paper, turn on the print borders (see Displaying the print borders). Note there is also a 
setting for paper orientation in the Print Setup dialog box, always leave this set to portrait. 

Fitting Documents on the Paper

When you print a document, you have several choices in the Print Layout Options on how the page is fitted onto the paper. With 
Custom Fit you can choose the size and position of the page on the paper manually. With Multiple Fit you can choose how many 
copies of the page are printed on each sheet of paper and at what size. For many documents, though, the easiest method is to 
use Best Fit. When you choose Best Fit, Xara X will automatically size the page so it exactly fits on the paper. It will even choose 
the most suitable orientation for the page. Choosing Best Fit dims the Scale Field and the Orientation buttons.

If you want to print a page at a different size from the size it is in your document, you can scale it by enter a scaling (as a 
percentage) in the Scale field in the Print Layout Options.

Double Page Spreads

Normally when you create a document it will be a single page. If you want to create a double page spread, set the Double Page 
Spread Option in the Page Options.

When you print a double page spread, you can choose (in the Print Layout Options) either Print Individual Pages or Print Whole 
Spread. The former prints each page in the spread as a separate page, the latter treats each spread as a single page.

The Print dialog box contains options so you can choose whether to print both pages, or just the left or right page.

Layers

When you print a document, you can choose in the Output Options which layers are printed. You can choose to print all the 
foreground layers in a document (background layers never print) or just those layers which are visible. To make layers visible and 
invisible, you use the Layer Gallery. See Hiding layers for more details.

Printing Selected Objects

In the Print dialog box, you can choose whether all the objects in your document are printed or just the selected objects.

Printing Multiple Copies

In the Print dialog box you can choose how many copies of a document you want to print.

Printing to a File

If you want to print to a file, set Print To File in the Print dialog box. When you click the Print button to print the document, a dialog 
box opens so you can enter a filename for the print file and choose where you want it.

Printing Transparency, Shadows, Bevels and Bitmaps

When you print a document containing transparency (transparent areas are printed as bitmaps) you can control the resolution of 
the bitmaps sent to the printer. The higher resolution you choose, the better any bitmaps and transparent areas will look, but 
resolutions over 150dpi are usually not necessary. The Automatic setting is suitable for most drawings - Xara X automatically 
selects a resolution suitable for the current printer. If necessary, type in a value to choose a specific resolution (in dots per inch or 
dpi). The maximum value is 600dpi - this gives very high resolution but can produce very large print jobs that take a long time to 



print.

Xara X uses bitmaps for bevels and shadows. The resolution of these is set when you create them. You can change the current 
value in View in the Options dialog box.

Bitmaps created using Create bitmap copy: the resolution is controlled by Bitmap size in the Create bitmap copy dialog box.

Printing Graduated Fills

When you print a document using Normal mode (this means not PostScript, Bitmap or Anti-aliased Bitmap mode) you can set 
the number of steps in all the graduated fills. Usually you can leave this setting on Normal, but if your drawing uses large numbers 
of graduated fills try using the Low setting to decrease the size of the print job. If you think your graduated fills would look better 
with more steps, try the High setting, but this slows down printing.

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



Printing Troubleshooter

The Xara X printing troubleshooter will help you diagnose problems that may occur when you print documents from Xara X and 
offer solutions.

If you are experiencing problems using a Hewlett Packard printer, click here.

Do other applications print correctly?

{button ,JI(`',`IDH_Trouble_Print_Whats_Wrong')}    Yes. So, what's wrong with Xara X's printing?

{button ,JI(`',`IDH_Trouble_Print_Nothing_Prints')}    No. What could be wrong?

_______________

Related Topics

Printing
Imagesetting



Change the print method in the registry

Do this only if you are familiar with editing registry entries.

There are some settings in the system-wide registry which simplify the way in which Xara X prints (this only applies to Normal and 
PostScript printing).

Changing the print method in Xara X
1. Exit Xara X
2. From the command prompt, type "regedit"
3. Open HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\Printing\      (where XX is the version you are using).
4. Change the PrintMask value to 1 to simplify printing somewhat or to 0 to simplify printing as much as possible.
5. Restart Xara X.

(To put printing back to the normal system set the PrintMask value back to 2.)

New document design rule:

With either form of simplified printing the transparent objects and other objects around them will be printed using a single bitmap. 
This sometimes means that objects which you would prefer to be printed at the best possible resolution get printed at the 
transparency resolution.

Thus, there is a new design rule you should apply to your documents. Try to arrange them so that highly-detailed objects (such as 
text or thin lines) are in front of any transparent objects. This will ensure that these objects are printed at the printer's resolution - 
not the transparency resolution. (See Output Options)

Tips
It's often a very good idea to keep highly detailed objects, such as text, in a layer at the front of the document. That way 

you can't accidentally draw any transparency on top of them.
You can use Bring to Front on the Arrange menu to reorder objects within layers and you can reorder whole layers using 

drag and drop in the Layer Gallery. 

Did this fix the problem?

{button ,CW(`trouble'):Exit()}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Last_Resort')}    No. What else can I try?



Colored text does not print

If you find that your printouts are working fine except any colored text is not printing you are probably suffering from a problem with 
your printer drivers. Your first step is to try and get an updated version of the drivers from the manufacturer. If this is not possible or 
does not solve the problem, do the following:

1. From the File menu, choose Print Options.

2. Open the Output tab.

3. At the bottom of the window, select the Print All Text As Shapes option.

This will convert all text objects into groups of simple shapes before the document is sent to the printer and should resolve the 
problem. Beware though, as the text is now shapes, it may not be of the same quality (particularly if the text is small) as it would be 
if you printed normally.

{button ,CW(`trouble')}    Close this troubleshooter.



Colors in bitmaps are stronger

You've noticed that some areas of your document print using much darker or stronger colors than others or that areas which 
should be white are appearing as light gray. Sadly, this is "normal" behavior for many Windows printer drivers. They purposely 
make the colors "stronger" in bitmaps than in normal shapes.

This problem does not occur on PostScript printer drivers or with EPS export. This can make it difficult to produce meaningful 
proofs of color artwork unless you have access to some kind of color Postscript device.

Suggestion for Windows 95/98:

      Adjust your printer driver's color correction facilities:

1. Click the Start button.

2. Click Settings and then click Printers.

3. Click on the icon for your printer, click the File menu and click Properties.

4. Click the Graphics tab in the Properties dialog box.

5. If your printer has color correction facilities there will be a Color button at the bottom of this tab.

6. Click Color and try adjusting the options presented. It's difficult to be more precise than that because these options will vary 

from printer to printer! Try pressing the Help button and reading the printer manual for more information.

7. If you changed any options click OK and try to print again.

If you're an advanced user:

{button ,JI(`',`IDH_Trouble_Print_INI_File')}    Edit the registry to use alternative print methods that will print more of the document 
as bitmaps and thus lessen the visible differences.

Did one of those suggestions fix the problem?

{button ,CW(`trouble'):Exit()}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else can I try?



Hewlett Packard Printers

Some Hewlett Packard printer drivers (versions 6.1D, 7.0 and 7.1) default to using an old Windows printing method. Xara X (and 
some other applications) does not support this method of printing and output with the standard settings will be wrong. The 
symptoms of these problems appear as:

Very long print times
General Protection errors within an HP module during printing
Xara X locking up when asked to print
The printer spooler failing to respond after Xara X has started printing.
When using the "Normal" output printing type from Xara X, vector images print incorrectly (as though the object is scaled 

by a very large value)

The problem can be solved by altering a value within an INI file. The specific file for users of version 6.1D drivers is called 
DeskJetC.ini (irrespective of whether you have a laser printer or an InkJet printer). Version 7 drivers create an HP**.ini file (where 
** is a number depending upon the type of printer in use). The file is held within the Windows folder:

Version 6 drivers

1. Load Windows\DeskJetC.INI into an Editor (Notepad or WordPad for example).

2. Scroll down through the text until you find the entry "0jumbotechnology=0100".

3. Change this to read "0jumbotechnology=0000".

4. Save the file and restart Windows. Your printer should now produce satisfactory results from Xara X and other packages. (see 

note)

If this does not solve the problem, click here to return to the start of the Printing Troubleshooter.

Version 7 drivers

1. Load Windows\HP**.INI (the ** will be a number depending on the printer in use) into an Editor (Notepad or WordPad for 

example).

2. Scroll down through the text until you find the entry "0jumbotechnology=0100".

3. Change this to read "0jumbotechnology=0000".

4. Save the file and restart Windows. Your printer should now produce satisfactory results from Xara X and other packages. (see 

note).

If this does not solve the problem, click here to return to the start of the Printing Troubleshooter.

Note
Hewlett Packard indicate that this flag switches off the old windows print system, but that some applications may require 

the flag to be reset. This would require altering the above ini file in reverse.

{button ,CW(`trouble')}    Close this troubleshooter.



Turn off error-diffused dithering in Windows 95/98

There is an unhappy interaction between the way Xara X prints and Windows's error-diffused dithering.

1. Click on the Windows Start button then click Settings.

2. Click Printers.

3. Click the printer that you're using then go to the File menu and click Properties.

4. Click the Graphics tab.

5. Ensure that the Error diffused switch isn't checked in the Dithering area. You'll have to choose a different dither mode to 

uncheck it.

6. If you made any changes click OK and try to print again.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Increase the pixel resolution

Objects which have transparent fills or bitmap fills are printed at the Transparency resolution (see Output Options). When the 
Transparency resolution is quite low you can see the square pixels.

      Increase the transparency resolution.

1. Click the File menu.

2. Click Print Options.

3. Click the Output tab.

4. Find the Transparency resolution area and click the Manual switch.

5. Type in a new transparency resolution (not higher than the resolution of the printer). A value between 150 and 300 is usually 

OK.

6. Click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else can I try?



Ensure LaserJet driver is in "Raster" mode

      Under Windows 95/98 set the driver to "Raster" mode instead of "Vector".

1. Click the File menu in Xara X and click Printer Setup.

2. Click the Properties button of the Setup dialog box.

3. Click the Graphics tab and check the Raster graphics switch instead of Vector graphics.

4. If you changed any settings Click OK and try to print again.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_LaserJet2')}    No. What else could be wrong?



Ensure LaserJet driver properties are correct

Make sure the printer driver knows the correct amount of memory in the printer.

      Under Windows 95/98:

1. Click the File menu in Xara X and click Printer Setup.

2. Click the Properties button of the Setup dialog box.

3. Click the Device options tab and alter the value of the Printer memory field to be correct for your printer.

4. Also set the Reserved memory field correctly (refer to your printer's manual for details of how to find the correct values for 

both these fields).

5. If you changed any settings Click OK and try to print again.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Make more room for spooling

The Windows printing system needs space on your hard disk to store a temporary file when Spooling is turned on. It's likely that 
you haven't got enough space at the moment.

Try one or both of these suggestions:

      Make more space on your hard disk by deleting any unwanted files.
      If you are running Windows 95/98 empty the Recycle bin.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Spool2')}    No. What else could be wrong?

Tip
If you have more than one hard drive, try moving your virtual memory swap-file onto a different drive from that used for 

your temporary folder to prevent problems with the two clashing.



Maybe there is something wrong with the printer or the way it is set up?

Suggestions:

      Are you running Windows 95/98? If so, try using its Print troubleshooter.

1. Click the Start button on the task bar and choose Help from the menu.

Windows 95:

2. Double-click Troubleshooters in the Help window.

3. Double-click If you have trouble printing in the Help window.

Windows 98:

2. Click Troubleshooting in the Help window.

3. Click Windows 98 Troubleshooters.

4. Click Print in the list of troubleshooters.
      Check that there's paper in the paper feed.
      Check that the printer isn't warning you of an error such as "out of ink".
      Check for paper jams.
      Check that the printer connectors are plugged in and the printer is turned on.
      Check that the printer is "on-line".

Did that fix the problem?

{button ,CW(`trouble')}    Yes. My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Whats_Wrong')}    No. Try to diagnose the problem.



Objects are missing

Are you using Superprint printer drivers under Windows 95/98?

Suggestion:

      Turn off queuing in SuperQueue.

1. Run SuperQueue

2. Click the File menu and choose Queue setup.

3. Make sure your printer is selected in the list of printers.

4. Press the Unqueue button.

5. If you made any changes click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Spool')}    No. What else could be wrong?



Make sure the paper orientation matches the page

      Firstly, make sure that the printer driver's Paper orientation is correct:

1. Click Xara X's File menu and choose Printer setup.

2. Click the Portrait button.

3. If you changed any settings click OK.

              Portrait page.
      Secondly, make sure the Page orientation is correct inside Xara X:

4. Click Xara X's File menu and choose Print Options.

5. Choose the Print Layout Options.

6. If the page you're trying to print is taller than it is wide, click the Upright button (in Orientation).

7. If the page you're trying to print is wider than it is tall, click the Sideways button (in Orientation).

8. If you changed any settings click OK.

            Upright printing

            Sideways printing

Tip
Turn on Print Borders (Window menu) to see on screen how much of the page will be printed.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_WrongSize')}    No. What else could be wrong?



Use Best Fit to ensure the drawing fits on the paper

      Make sure the Xara X page fits on the paper.

1. Click Xara X's File menu and choose Print Options.

2. Click the Print Layout tab.

3. Click Best fit.

4. If you changed any settings click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Make sure the paper size is correct

      Make sure the printer driver knows about your paper:

1. Click Xara X's File menu and choose Print Setup.

2. Make sure the field labeled Form or Paper size is the same as the size of the paper in your printer. For example if you're 

printing on A4 paper make sure the field says "A4" and not "Letter" or "Legal".

3. If you changed any settings click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_PageScale')}    No. What else could be wrong?



Printing stops part-way down the page

Try these suggestions:

      Lower the transparency resolution.

1. Click Xara X's File menu and choose Print Options.

2. Click the Output tab of the Options dialog box.

3. Find the Transparency resolution or Bitmap resolution area and click Manual.

4. Now type in a lower value into the Pixels per inch field. Any value between 90 and 200 should be OK.

5. Click OK.

Or try this:

      Print the document as a bitmap.

1. Click Xara X's File menu and choose Print Options.

2. Click the Output tab of the Options dialog box.

3. Find the Print as... area and click Bitmap.

4. Click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Print works but nothing happens

Are you printing to a network printer?

Suggestions:

      If the printer is a Postscript printer try using different printer driver. There are often several possible drivers for a given 
Postscript printer and it is possible that one of the alternatives will work better.

      If the printer is a Postscript printer and it supports a language other than Postscript try using that.
      Print your document as a bitmap.
      Print from a computer connected directly to the printer.
      When printing to a network printer, check to make sure the LPT port is actually connected to the network printer.

Did one of these suggestions work for you?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Spool')}    No. It still doesn't print. What else could be wrong?



Printing is very slow

Xara X uses bitmaps to produce its advanced transparency effects. Sending bitmaps to printers is often a time-consuming task. 
For this reason relatively simple documents which use transparency may take longer to print than you would normally expect. 
However, when several transparency effects are overlaid Xara X accumulates them all into one bitmap and sends that to the 
printer. So, as transparent effects in a document become more complex it won't become significantly slower to print.

Other programs that can do simple transparency effects produce exponentially more objects as you overlay transparencies. This 
means that their print times appear to be quite good for simple documents but they take a long time to print complex drawings

Suggestions to improve print times:

{button ,JI(`',`IDH_Trouble_Print_Spool2')}    Turn off spooling

{button ,JI(`',`IDH_Trouble_Print_ReduceRes')}    Reduce the pixel resolution



Reduce the pixel resolution

      Lower the transparency resolution.

1. Click Xara X's File menu and choose Print Options.

2. Click the Output tab of the Options dialog box.

3. Find the Transparency resolution or Bitmap resolution area and click Manual.

4. Now type in a lower value into the Pixels per inch field. Any value between 90 and 200 should be OK.

5. Click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Return the print method to its default by editing the registry

Do this only if you are familiar with editing registry entries.
Checking the registry setting in Xara X

1. Exit Xara X
2. From the command prompt, type "regedit"
3. Open HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\Printing\      (where XX is the version you are using).
4. Set the PrintMaskType setting to "2"
5. Restart Xara X.

When Xara X is using PrintMaskType 2 only those objects which need transparency are printed using bitmaps. This can make 
print jobs larger but it guarantees that non-transparent objects are printed at the best resolution the printer can manage.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Jaggy_Print')}    No. Return to previous page and try other suggestions.



Install the manufacturer's printer driver

Is your printer from Hewlett Packard or Canon?
      If so, then reinstall the printer driver from the disk that came with the printer. Follow the instructions in the printer's manual.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. Still no Print dialog box. What else could be wrong?



Set print method to Normal

Did you change the print method by editing the registry?

{button ,JI(`',`IDH_Trouble_Print_Jaggy_Print2')}    No. Return the print method to the default setting.
      Set the print method to Normal:

1. Click on the File menu and choose Print Options.

2. Click on the Output tab.

3. Ensure that the leftmost switch in the print method area (labeled either Normal or PostScript) is checked.

4. If you changed any options click OK.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_IncRes')}    No. What else can I try?



Tried everything

You've tried the suggestions on other troubleshooter pages but:
They do not apply
They do not help
They are not satisfactory

Here are a few final suggestions:

      Have you tried changing the print method?

If you're using Normal printing try changing to Bitmap printing and vice-versa. (See Output Options for more information.)
      Have you tried reducing the transparency resolution?

If your document contains lots of transparent objects, a high transparency resolution setting may produce too much data for the 
printer to handle. Generally, the transparency resolution only needs to be about half the resolution of your printer. It rarely needs to 
be higher than 300dpi. It should never be higher than the printer's resolution. (See Output Options for more information.)
      Have you tried reducing the fill quality?

Higher fill quality settings send more data to the printer. It's possible that your document will still look good if the quality of the fills 
is reduced. (See Output Options for more information.)
      Windows 95/98 has a Print troubleshooter of its own which may help you to track down your problem. If you haven't already 

tried the Print troubleshooter:

1. Click the Start button on the task bar and choose Help from the menu.

2. Double-click Troubleshooters in the Help window.

Windows 95:

3. Double-click If you're having trouble printing in the Help window.

Windows 98:

3. Click Windows 98 Troubleshooters.

4. Click Print in the list of troubleshooters.

{button ,JI(`',`IDH_Trouble_Print_INI_File')}    If you're an advanced user there are hidden registry settings you can try.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Last_Resort')}    No. What else can I try?



Turn off "Print all foreground layers"

Make sure that Xara X is only printing the layers visible on screen:

1. Click Xara X's File menu and choose Print Options.

2. Choose the Output section.

3. Click the Visible foreground layers switch.

4. If you changed any settings click OK and try to print again.

Did this fix the problem?

{button ,CW(`trouble')}    Yes! My document prints correctly now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



Turn off spooling

The Windows printing system uses a temporary file on your hard disk to queue up printing commands and send them to the printer 
in the background. If you turn off spooling the temporary file is no longer needed (so you won't need lots of space on your hard 
disk to store it) but all applications, including Xara X, will take longer to print.
 On Windows 95/98

1. Select your printer in the Printers window.

2. Choose Properties from the File menu.

3. Open the Details section.

4. Click the Spool Settings button at the bottom of the dialog box.

5. Ensure the Print Directly to the Printer option is checked.

6. If you changed any settings, click OK.
 On Windows NT

1. Select your printer in the Printers window.

2. Choose Properties from the File menu.

3. Open the Scheduling section.

4. Ensure the Print Directly To The Printer option is checked.

5. If you changed any settings, click OK.

Did this fix the problem?

{button ,CW(`trouble'):Exit()}    Yes! My document prints now. Close this troubleshooter.

{button ,JI(`',`IDH_Trouble_Print_Final')}    No. What else could be wrong?



What printer are you using?

{button ,JI(`',`IDH_Trouble_Print_LaserJet')}    HP LaserJet (or compatible)

{button ,JI(`',`IDH_Trouble_Print_No_Error')}    Some other printer



What's wrong with the printout?

{button ,JI(`',`IDH_Trouble_Print_Missing_Objects')}    Some objects are missing from the printout.

{button ,JI(`',`IDH_Trouble_Print_White_Lines')}    There are horizontal white lines across some objects.

{button ,JI(`',`IDH_Trouble_Print_Jaggy_Print')}    Some objects have stepped or jagged edges.

{button ,JI(`',`IDH_Trouble_Print_Orientation')}    The printout doesn't fit on the paper the way it's shown on screen.

{button ,JI(`',`IDH_Trouble_Print_BitmapColours')}    Objects which should be the same color are darker in some places than 
others.

{button ,JI(`',`IDH_Trouble_Print_Layers')}    Objects which aren't shown on screen are on the printout.

{button ,JI(`',`IDH_Trouble_Print_Final')}    None of these.



What's wrong?

{button ,JI(`',`IDH_Trouble_Print_No_Print_Dialog')}    The Print dialog box won't open.

{button ,JI(`',`IDH_Trouble_Print_Remote_Postscript')}    Nothing is printed - not even blank paper appears.

{button ,JI(`',`IDH_Trouble_Print_WhatPrinter')}    Printing partly works but stops before the page is complete.

{button ,JI(`',`IDH_Trouble_Print_WrongPrint')}    A complete page is printed but it looks different on paper than it does on screen.

{button ,JI(`',`IDH_Trouble_Print_Slow')}    Printing is very slow.

{button ,JI(`',`IDH_Trouble_Print_Colored_Text_Not_Printing')}    Colored text is not appearing on the paper



Where to go next

You have found a problem which is not covered by the Xara X Printing Troubleshooter.

{button ,JI(`',`IDH_Misc_Tech_Support')}    Contact our Technical Support service.

{button ,CW(`trouble')}    Close this troubleshooter.



Printing documents

You often want to print out a document, either to check it looks correct or because it is complete and you want a final, printed copy. 
For more information on printing, see the Printing Overview.

To print a document
1. Select the document you wish to print by clicking on it.
2. From the File menu, choose Print.
3. Choose whether to print all objects or just the selected objects.
4. If you are printing a double page spread, choose which pages to print.
5. Choose how many copies to print.
6. Click Print.

Tips
To select a different printer, click the Printer button in the Print dialog box.
To set the printing options, click the Options button in the Print dialog box. These options depend on the type of printer 

selected.
If you have problems printing, refer to the Xara X Printing troubleshooter.
Printing documents containing transparent objects takes longer than printing documents that do not use transparency.
If you want to print a drawing on a page the 'wrong' way around, change the orientation options in the Print Layout 

Options.

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



Printing text

When you print text, you may find that some of the fonts you used are not available on your PostScript printer. This will mean 
some of your text will come out in the wrong font. Also some printers cannot print colored text. This is a printer problem and not a 
Xara X fault. 

To solve these problems, you can convert text to simple shapes before it sends it to the printer. By doing this, the printer does not 
need the font installed.

To print text as shapes

Either:
right click on a text object to open the text pop-up menu and select Print Text As Shapes. You can do this for each text 

object individually.
or in the Output Options, select the Print All Text As Shapes option. This applies to all text objects in the document.

Tip
As your text is printing as shapes rather than text, it may not look as good if the text is small.

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



Printing: Camera-ready copy

If you are having hundreds or thousands of copies of your document printed, your print shop may ask you to supply 'camera-ready 
copy'. How you produce this depends on the document and the print shop’s requirements. Camera-ready copy is sometimes called 
as 'originals' or 'mechanicals'.

For simple jobs

Particularly if your document uses only black and white, a printout from your desktop printer may be suitable. This depends on the 
type of desktop printer you have. PostScript printers often produce excellent results. Show the print shop a sample printout and 
they will tell you whether it is suitable.

If you have a PostScript printer: ask the print shop which Screen frequency to use. See Imagesetting Options for details of how to 
set this in Xara X.

For more complex jobs

The job will probably need to be 'imageset' by a service bureau. The service bureau may be part of the print shop or a separate 
company. The print shop can probably suggest a reliable service bureau. Ask the print shop the type of output they want: 
film/paper. For more information, see Imagesetting Overview.

_______________

Related Topics

Printing
Imagesetting



Printing: Getting Your Job Printed

If you want hundreds or thousands of copies of your document, you will probably need to use a print shop. See Printing multiple 
copies.

Find a print shop that can handle your job

Print shops vary in the type of work they can handle. Some specialize in small, simple jobs, others in long-run, full-color work. If 
you produce a wide range of work, you may need to use three or four different print shops.

Talk to them about the job

It is usually best to talk to them at an early stage. If they are busy, they can schedule your job in. This means you get your job 
turned round quicker. Tell them how many copies you’ll want, the type of paper, and finishing requirements such as folding. Ask 
them about the format they want the job presented in. 

Design the job

The print shop will tell you any special requirements especially with regard to spot colors. See Spot colors versus process colors.

Producing camera-ready copy

Some printers can take your document in electronic form. If so, generate the files in the requested format and send it to the print 
shop.

Often the print shop will ask for camera-ready copy. See Camera ready copy.

Sending the job to them

Before sending the job off, check everything carefully. When everything is correct, send the print shop the camera-ready copy plus 
any requested proofs. Confirm the number of copies you require, the type of paper you want and any finishing instructions.



Printing: Imagesetting Points to Note

Spot Colors
Tint colors based on a spot color output to that spot separation.
Shade colors and linked colors based on a spot color output to the CMYK separations.
Objects with transparency applied always output to the CMYK separations. 
Shadows and Bevels created using the Shadow and Bevel Tools always output to the CMYK separations. 

Intermediate Colors in Blends, Contours and Fills

This information assumes you understand the different color models available in Xara X and have some knowledge of color 
printing.

This section applies to:
All blends and contours.
All Multicolor fills. That is, all fill types except flat.

Normally Fade mixes colors using the RGB color model. The exception is when both end colors are defined as CMYK. In this 
case, colors are mixed in CMYK. One advantage of this for grayscale blends. An RGB gray is printed as a mixture of the four 
CMYK inks. Defining the gray as a tint of CMYK black gives better printed results.

Rainbow and Alt Rainbow mix colors using HSV.

Three color, four-color, fractal cloud, fractal plasma and bitmap fills always output as RGB bitmaps and are color-corrected. This 
means that any spot colors used in these fill types output to the CMYK separations not to the spot separation.

Special rules apply for spot colors: 
In blends and contours: if either end color is a spot color you can do Fade mixes but not Rainbow mixes. (The reason is 

because you cannot alter the hue of a spot color.) 
In fills: if either fill color is a spot color you can do Fade mixes but not Rainbow mixes. 
In blends and contours: If both end colors in a blend are the same spot color (or tints of the spot color), the blend 

outputs only to the spot separation.
In fills: If both the fill colors in a fill are the same spot color (or tints of the spot color), the fill outputs only to the spot 

separation. Note that this does not apply to Three-color, Four-color, Fractal and Bitmap fills which output only to the CMYK 
separations.

If you blend, contour or fill from a spot color to a non-spot color, Xara X creates the requested blend. For example, if you blend 
from Cyan (CMYK color) to Gold (spot color) the Cyan separation shows a blend from 100% color to no color and the Gold 
separation shows no color to 100% color. This is approximately what you see on screen (allowing for differences between screen 
and printer colors).

If you convert the blend or contour to editable shapes, the intermediate shapes lose all spot color information. They separate only 
to CMYK. Only the final object prints as a spot color. 

Transparency, Shadows, Bevels and Color Separations

(This information applies to transparency, shadows and bevels created using the Transparency, Shadow and Bevel Tools.)

It assumes you understand about color models and color separations. Transparency helps create some outstanding illustration but 
can cause unexpected results when color separating. Areas covered by a objects with transparency applied output as an RGB 
bitmap. Similarly shadows and bevels output as an RGB bitmap. This bitmap is then color corrected and separated to CMYK. This 
process happens even to objects with 100% transparency. This means that in shadows, bevels or objects under a transparent 
object:

The CMYK mix in CMYK colors changes. This is particularly noticeable with black and grays which appear on all four 
separations rather than just the black separation.

Spot colors separate to CMYK (with color correction).

Watch out for:
Objects under totally transparent objects. Instead of using 100% transparency you can use No color. (See Coloring 

objects).
Text under a Transparent object. Where possible, have text as the front object so these problems don’t occur.

Bitmaps

Normal bitmaps are always separated to CMYK. If you need to print a bitmap on a single plate (for example on a spot color plate 
or print a grayscale bitmap on the the Key plate) you need to contone the bitmap between two named colors which both print on 
that plate without being separated. For example if you wanted to print a bitmap only on the Key plate, you need to change the 
colors in the bitmap so they range from CMYK Black to CMYK White (note that the default white is not CMYK). To print a bitmap 
on a spot color plate, you need to change the bitmap so its colors range from the spot color to a tint of the spot color. To do this 
you need to create a tint of the spot color. See Creating spot colors. For more details on contoning bitmaps using named colors, 
see Changing bitmap palettes.

_______________

{button ,KL(`imagesetting',0,`____No_Topics_Found',`')}    Related Topics



Printing: Multiple Copies

You can easily print single copies of your drawing using your desktop printer. For larger quantities (tens, hundreds or even 
thousands of copies) you have to decide on the most efficient way of printing.

How many copies?

This is the most important consideration. Some processes are only cost effective for a few copies. Others involve origination and 
setup costs so are economic only for printing 500 or more copies.

Note: this advice is based on our experience and knowledge. Conditions in your locality may be different from ours and so this 
advice might not necessarily apply to you. Also some technologies, such as digital printing, are evolving rapidly and so may 
become economic for larger or smaller jobs than at present. 

What are the choices?

For printing a few copies: Depending on the speed of your desktop printer you might be able to print multiple copies on your 
printer.

For tens of copies: Probably the best option is photocopying. This gives good results especially for black and white copies. Print 
out a single copy (the ‘master’ or ‘original’) on your desktop printer and take the printout to your local copy bureau.

Of course this isn’t possible if your desktop printer is black-and-white and you want a color original. You need to find someone who 
can produce a color printout of your document. Ask the copy bureau (they may know a local company who can do it). A service 
bureau may also be able to help but this could be expensive.

For hundreds or thousands of copies: For large numbers of copies you have to use a print shop who will have the necessary 
equipment to handle your job economically. Some advice: when you have decided which print shop to use, give them details about 
the job. They know their equipment and know any special requirements.

There are currently two main options for printing in volume: digital printing and litho printing. There are other specialized 
processes, such as screen-printing, which are not covered here. If you are preparing work for these processes, you should talk to 
the print shop who will be doing the work. 

At present digital printing is economic for a few hundred copies. There are relatively few print shops who can offer this process. 
Generally the print shop will require your document in electronic form (for example, floppy disk or SyQuest). The print shop can 
give you details relevant to their particular system.

Litho printing is probably the most common volume printing process in most countries. There are probably several print shops with 
litho presses near you. In some cases you can just give them your Xara X document in electronic form and they do everything 
else. Usually though you have to supply them with a printout of your document. For simple work, a printout from your desktop 
printer may be suitable. More complex jobs require the printout on photographic paper or film. For more details, see Camera-ready 
copy.

_______________
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Printing: Ordering Proofs

For color work that will be commercially printed you will probably be asked to supply proofs.

Time, cost, and quality are all factors to consider when you are deciding on a proofing method. Discuss your project with your print 
shop and service bureau. They will help you choose the most appropriate proofing method. There are three categories of color 
proofs to choose from: digital proofs, off-press proofs, and press proofs.

1. Digital proofs

This category includes proofs generated from laser, thermal wax, ink-jet, phase-change, and dye sublimation printers. Data is 
imaged directly from your file onto paper. This method is fast and economical, but it is not usually accepted by printing shops as 
being a good representation of what they are expected to match because the proof is not made from the film that will be used to 
make the printing plates.

Keep in mind:
Digital proofs cannot reproduce press conditions such as screen frequencies and angles.
Not all desktop printers are PostScript compatible.
Not all printers can reproduce spot colors.
Dye sublimation printers are especially well-suited to proofing scans of photographs.

2. Off-press proofs

These are made from the film separations that will ultimately be used to make the printing plates. This category includes 
blueprints, overlay proofs (e.g., Color Key) and laminate proofs (e.g., Cromalin, Matchprint, Agfaproof). 

Note: Laminate proofs are more accurate and more expensive than overlay proofs. Blueprints are used to check 'fit' and to proof 
for imperfections such as broken letters.

Most off-press proofs cannot reproduce spot colors.

3. Press proofs

Because press proofs are produced using the very plates, inks, and paper that will be used for the final print, they are the most 
accurate and also the most expensive. They are generally reserved for high-end projects.

Check and approve the proofs

When you receive the proofs, check them carefully. Adjustments or corrections may be in order. You may have to go through more 
than one proofing cycle. When you are satisfied, you can send the complete job to the print shop.

Turn the approved proofs over to the print shop

These will be considered "contract proofs", which means that this is the output the press operators will strive to match.

_______________
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Printing: Producing a .PRN File

This covers producing a .PRN file ready to send to a service bureau for imagesetting. For general information on imagesetting, see 
Imagesetting Overview.

Producing .PRN files requires some experience and is not recommended if you’re a complete novice to imagesetting. Imagesetting 
overview has information on other file formats you can use.

1. Talk to your print shop and service bureau

There are several settings you have to make. Only the print shop and service bureau can tell you the correct values to use. You 
will need a suitable printer driver. Ask your service bureau what they recommend.

2. Open the Print Setup dialog box

1. From the File menu choose Print Setup.
2. If necessary, change to a suitable printer. Ask your service bureau if in doubt.
3. Check the paper size is correct. Printing crop marks and other imagesetting information requires a larger paper size. For 

example, to print crop mark around an 8x11 inch US letter page requires a paper size at least 9x12 inches (often called US 
Letter Extra). Note that most imagesetters have a maximum printable width which you must not exceed. Ask the service 
bureau if in doubt.

4. Leave Orientation at its default setting.
5. Click OK to close the dialog box.

3. Open the Print dialog box

1. From the File menu choose Print.
2. Usually you want to print All Objects. This depends on how you have designed your document.
3. For double page spreads, choose either both pages or one page, as you require.
4. Usually set Copies to 1. Your print shop will tell you if they require multiple copies.
5. Select the Print to File check box. You will specify a filename later in step 8.

4. Set the Print Layout options

1. Click the Options button on the Print dialog box. This opens a tabbed dialog box.
2. If necessary click the Print Layout tab. 
3. Check the orientation is correct. Ask your service bureau if in doubt.
4. Usually you want to print at 100% scale.
5. If the document is a double page spread, you can either print it as two separate pages or a single page. If in doubt which is 

best, check with your print shop and service bureau.
6. Click the Custom Fit button to select this option.
7. Usually Top and Left are set to 0. Your service bureau will tell you if they require a different setting.
8. Do not change width or height otherwise you will change the scaling.

5. Set the Output options

1. Click the Output tab.
2. Print layers depends on how you have created your drawing.
3. Usually set PostScript Language Level to Automatic. If the service bureau have problems getting your file to run, ask 

them which PostScript level they use.
4. In Print As choose PostScript. This will give you better results than the bitmap options.
5. In Transparency resolution choose Automatic. If areas with transparency applied are printed at lower resolution than the 

rest of the document, retry with Manual. You should not need a resolution greater than 150dpi.
6. Set Fill Quality to Normal.
7. The setting of Text Options depends on whether the service bureau have the same fonts as you. If they do, uncheck this 

box. This creates a smaller file. If you are not sure or you know they don’t have the necessary fonts, check this box.

6. Set the Separations options

1. Click the Separations tab.
2. Some printer drivers let you change the PostScript Options. Ask your print shop which values to use for Screen Frequency 

and Screen/Dot Type. Ask your service bureau which Resolution to use.
3. If the service bureau ask you for a 'composite output' uncheck Print Color Separations. You can go to step 8.
4. If they ask for 'separated output' check Print Color Separations.
5. Select which process colors and spot colors you want to print. You may also need to set Overprint, Screen Angle and 

Screen Frequency for each color. Overprint depends on how you have designed your drawing. Ask your service bureau if 
special angles or frequencies are needed.

7. Set the Imagesetting options

1. Click the Imagesetting tab.
2. Your print shop can tell you which Printers Marks they require.



3. They can also tell you if they require emulsion down and negative film.
4. Some printing processes cannot handle spot colors. To output to these devices, check Print spot colors as process 

colors. This prints all spot colors using the CMYK process inks. Obviously the printed color will differ from the true spot 
color. 

5. Check Always overprint black if you want solid areas on the Black separation to overprint. (Solid in this case means 95% 
to 100% ink.)

8. The final steps

1. Click OK to close the dialog box.
2. On the Print dialog box click OK. This opens a dialog box that lets you specify a name and folder for the .PRN file.
3. Click OK to start printing to file.

When printing is complete you can send the .PRN file to your service bureau.



Printing: Spot Color versus Process Color

If your document will be commercially printed, there are several factors that determine where to use process colors or spot colors 
in the document.

The printing process that will be used

Some processes, such as digital printing, cannot handle spot colors. Some presses can handle a maximum of four ink colors (spot 
or process). Using a fifth, spot color to extend the color range may be either impossible or cost considerably more. Check with 
your print shop on any possible limitations.

The number of colors in the job

The number of colors you plan to use will be the main factor in deciding whether to use process color or spot colors. 

Does your project make use of only one, two or three colors (including black)? Then you'll want to use spot colors. Spot color uses 
a different ink for each color. Note that objects with transparency applied always separate to CMYK (this means you cannot use 
transparency for this type of job). If your budget is limited:

Obtain a two-color look by printing on colored stock and using only one spot color.
Use tints (percentages) of spot colors to create shadows or highlights, thus giving the impression of a broader color range.

Does your project call for full color (e.g., does it contain scans of color photographs)? If so, you will need to use process colors, 
which simulate virtually any color using only the four ink colors, cyan, magenta, yellow, and black (known as CMYK).

Does your project call for both spot and process colors? For example, a marketing brochure may require the use of a spot color to 
faithfully render the corporate color and the use of process color to reproduce scans of photographs. Remember, though, that the 
greater the number of colors used, the more film, plates and ink will be required, which adds to the cost of the job. 

_______________
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Profile dialog box

This is used by several tools to control attribute or color transitions.

You can either:
select a predefined profile from the drop-down list - the top option (the straight line) produces a linear transition
or create a custom transition by dragging the sliders (or type in values). The display and the strip shows the resultant 

profile. For example for a color transition, the display shows how the colors change with the selected slider settings.
Move the top slider towards:

-1 for more change at the end of the transition than at the start.
+1 for more change at the start.

Move the bottom slider towards:
-1 for more change in the center than at the ends.
+1 for more change at the ends.

Movies

{button ,EF("XaraDemo.exe",`Profile Using Profiles',1,`') } Using profiles

____________________

For more information see:

Changing the blend attribute profile
Changing the blend position profile
Changing the contour attribute profile
Changing the contour position profile
Changing the fill profile
Changing the shadow profile
Changing the transparency profile



Purchasing Xara X

This page applies if you are running the time-limited trial version of Xara X:

When you start up Xara X a dialog box reminds you that you are running the trial version - click Purchase on that dialog box. This 
lets you purchase Xara X using a fully secure transaction process, 24 hours a day, 7 days a week.

When you purchase Xara X, we automatically mail you a CD which contains an unlocked copy of the program plus clipart, bitmap 
textures, fonts and the demonstration movies. You should receive the CD within 28 days; if not email xaraclub@xara.com 

If you have already purchased Xara X but get an 'Invalid Key Code' message or need a new Unlock Code:

Look at the Unlock Code page for more details.



 

 Push Tool    ALT+X or SHIFT+F8
The Push Tool lets you use the mouse to move a document within the window. The Push Tool Infobar contains controls for 
zooming on the document.

Push Tool Infobar Controls

Zoom Magnification
Previous Zoom

Zoom To Drawing

Zoom To Page

Zoom To Selection

Push Tool Operations
Moving the page
Returning to the previous zoom
Zooming in and out
Zooming to the selection
Zooming to the whole drawing
Zooming to the whole page

Movie

{button ,EF("XaraDemo.exe","ZoomPan.avi Magnifying and Moving a Document",1,`') } Magnifying and moving 
documents

_______________
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 Put To Back (Arrange Menu)    CTRL+B

Moves selected objects to the back of the layer or frame. For more details, see Moving objects backwards and forwards.



Putting WEB files on WWW pages

Using the Xara plug-in for Netscape Navigator and Microsoft Internet Explorer, you can place Xara WEB files (.web) and Xara X 
files (XAR) directly on pages on the Internet.

Note the difference between this plug-in, which is for viewing .WEB files, and bitmap effects plug-ins, which alter the appearance 
of bitmaps.

To add a WEB files to a WWW page

Include the following in the HTML for the page with a correct filename and correct values for the widths and heights.

    <embed src="xara.web"

                          width=xxx height=yyy

                          pluginspage="http://www.xara.com/plugin/download.html">

    <noembed>

    <img src="alternative_image.gif"

                  alt="[Alternative text]"

                  width=xxx height=yyy>

    </noembed>

This HTML does the following:
Inserts the specified file (xara.web in the example) into the WWW page.
Sets its width and height so the page is correctly formatted before the file has been downloaded.
Allows for automatic download of the plug-in if it is not available.
Inserts details of a GIF to use in place of the WEB file if the plug-in is not available.
Includes text to use in place of the WEB file on text-only web browsers.

Notes
Before you can place WEB and XAR files on the Internet, you need to make a minor change to your web server to support 

the new file types. See Configuring a web server for Xara files.
To be able to view WEB and XAR files on the Internet, you need to download the Xara plug-in from

www.xara.com/plugin/ 

_______________

{button ,KL(`web files',0,`____No_Topics_Found',`')}    Related Topics



 
 

 

 

 Quality (Window Menu)

The Quality submenu on the Window Menu, the Set View Quality slider on the control bars and the Quality buttons on the control 
bars allow you to alter the Quality setting (the way Xara X redraws documents). Low settings show the document in simple 'outline' 
mode and high settings give a full color, anti-aliased view. There are also buttons available (they not on the default control bars - 
see Moving and copying buttons) for each of the four main settings.

The Quality setting is also used when bitmaps are exported from Xara X which means that if the Quality setting is low, any bitmaps 
exported will show the document in outline. For more details, see Changing the quality setting.



Quick Viewing documents

You can view documents without starting Xara X. You can view XAR files, WEB files, .CMX files (versions 5 and 6) and .cdr files 
(versions 3, 4 and 5.). (You can also view .ART files created with Xara Studio).

To view a document
1. Select the document in Explorer.
2. From the File menu, choose Quick View.

For information on using the Quick Viewer, press F1 while you are viewing a document.

Tips
To quickly view a document, right-click on it to open the pop-up menu and choose Quick View.
If Quick Viewing does not work with .cdr or cmx files, run the installer again and select the option to support Quick Viewing 

of these files.
If the Quick View item does not appear on the File menu for any files, you need to run Windows Setup again to install it 

(it's an option when you install so it may not be present on your system).



QuickShape Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a QuickShape, it contains the following options:
QuickShape Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Bounds Creation Button

This button on the QuickShape Tool Infobar selects Bounds Creation.

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Curved Corners Button

This button on the QuickShape Tool Infobar rounds the corners of polygon/starred QuickShapes. It has no effect on ellipses and 
circles.

_______________

{button ,KL(`curved corners;tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Diameter Creation Button

This button on the QuickShape Tool Infobar selects Diameter Creation.

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Ellipse Button

Pressing this button on the QuickShape Tool Infobar:
changes all currently selected QuickShapes to ellipses, 
or, if no QuickShapes are currently selected, sets the tool default so the next QuickShape you draw will be an ellipse.

You can also use the Ellipse Tool to draw ellipses - you may find this more convenient to use.

_______________

{button ,KL(`ellipses',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Mode Indicator

This indicator on the QuickShape Tool Infobar displays the 'mode' of the tool. It shows one of the following:

New:

Changes made to the Infobar fields set the defaults for the tool (the settings that apply to all subsequent QuickShapes you draw).

Change:

The selection contains at least one QuickShape. Changes made to the Infobar fields are reflected in the selected QuickShape(s).

_______________

{button ,KL(`tools,quickshape tool',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Number of Sides Field

The Number of Sides field on the QuickShape Tool Infobar sets the number of sides for all the QuickShapes in the selection 
(excluding ellipses). If no QuickShapes are currently selected, it sets the default. The number of sides can be any value from 3 to 
99.

To set the number of sides, either:
type in a value and press RETURN,
or choose a value from the drop-down list.

_______________

{button ,KL(`polygons',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Polygon Button

Pressing the Polygon button on the QuickShape Tool Infobar:
changes all currently selected QuickShapes to polygons, 
or, if no QuickShapes are currently selected, sets the tool default so the next QuickShape you draw will be a polygon.

The Rectangle Tool can be used for drawing rectangles and squares. It draws QuickShapes, but does not require the setting of 
fields before the shape can be drawn.

_______________

{button ,KL(`polygons',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Radius Creation Button

This button on the QuickShape Tool Infobar selects Radius Creation.

_______________

{button ,KL(`circles',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Restore Edges Button
You can edit the edges of QuickShapes to make them curved. Click the Restore Edges button on the QuickShape Tool Infobar to 
straighten them again.

Note
This button affects only the sides of QuickShapes - it does not affect the corners.

_______________

{button ,KL(`polygons',0,`____No_Topics_Found',`')}    Related Topics



    QuickShape Tool - Shape Parameters Field

These fields on the QuickShape Tool Infobar allow the accurate editing of QuickShape parameters. Choose the values to alter 
from the left hand field and alter the values by typing into the edit fields and pressing RETURN or use the arrow buttons.

_______________

{button ,KL(`quickshapes',0,`____No_Topics_Found',`')}    Related Topics



 QuickShape Tool - Star Button

Pressing the Star button on the QuickShape Tool Infobar:
changes all currently selected QuickShapes polygons to star-shaped polygons, 
or, if no QuickShapes are currently selected, sets the tool default so the next QuickShape polygon you draw will be star-

shaped.

You can click this button only when the Polygon button has been clicked.

_______________

{button ,KL(`quickshapes,star-shaped',0,`____No_Topics_Found',`')}    Related Topics



 

 QuickShape Tool
The QuickShape Tool creates and edits QuickShapes. For information about QuickShapes, see the QuickShapes Overview.

The QuickShape Tool can also be chosen using the Line and Shape Pop-up Menu.
 SHIFT+F2

QuickShape Tool Infobar Controls
Mode Indicator

Radius Creation
Diameter Creation
Bounds Creation
Ellipse

Polygon

Star
Curved Corners

Restore Edges
Number of Sides

Shape Parameters

QuickShape Tool Operations
Adding curved corners to polygons
Adding curved corners to rectangles
Changing curved corners on a polygon
Changing curved corners on a rectangle
Changing the number of sides of a polygon
Drawing polygons
Drawing star-shaped polygons
Making a polygon star-shaped
Moving QuickShapes
Moving the star points on a star-shaped polygon
Rotating ellipses
Rotating rectangles
Scaling and rotating polygons
Scaling rectangles
Rotating rectangles
Scaling ellipses
Warping the edges of polygons

Movies

{button ,EF("XaraDemo.exe","ellipses Ellipses and Circles",1,`') } Drawing ellipses and circles

{button ,EF("XaraDemo.exe","oblong Rectangles and Squares",1,`') } Drawing rectangles and squares

{button ,EF("XaraDemo.exe","Regular QuickShapes",1,`') } Drawing QuickShapes



QuickShapes Overview

QuickShapes are 'intelligent' shapes created using the QuickShape, Rectangle and Ellipse Tools. QuickShapes are different from 
normal shapes as they are not simply a set of points connected by lines. For example, if you draw a polygon QuickShape and you 
drag one of its corners, all the other corners move simultaneously. QuickShapes also contain other useful features. For example 
you can add curved corners to any QuickShape and warp their straight edges.

QuickShapes come in all shapes and sizes including ellipses, circles, rectangles, squares and polygons. Straight-sided 
QuickShapes can be made star-shaped too.

You can alter any QuickShape with the QuickShape Tool or the Selector Tool (if edit handles have been enabled, see Enabling edit 
handles).

Drawing QuickShapes
Drawing ellipses and circles
Drawing rectangles and squares
Drawing polygons
Drawing star-shaped polygons

Changing Ellipses and Circles
Changing an ellipse to a polygon
Scaling ellipses
Rotating ellipses
Stretching ellipses

Changing Rectangles, Squares and Polygons
Changing a rectangle into an ellipse
Scaling rectangles
Rotating rectangles
Adding curved corners to rectangles
Changing curved corners on a rectangle
Stretching rectangles
Scaling and rotating polygons
Changing the number of sides of a polygon
Adding curved corners to polygons
Changing curved corners on a polygon
Warping the edges of polygons
Warping the edges of rectangles
Changing a polygon into an ellipse
Moving the star points on a star-shaped polygon
Making a polygon star-shaped

Tip

If you want to change a QuickShape so it can be edited as a shape built from straight and curved lines, you need to 
convert it to simple shapes. See Converting QuickShapes to editable shapes.

Movies

{button ,EF("XaraDemo.exe","ellipses Ellipses and Circles",1,`') } Drawing ellipses and circles

{button ,EF("XaraDemo.exe","oblong Rectangles and Squares",1,`') } Drawing rectangles and squares

{button ,EF("XaraDemo.exe","Regular QuickShapes",1,`') } Drawing QuickShapes



RAS Export Dialog Box

The Sun Raster export bitmap dialog box is opened by selecting RAS as the exported file format from the Export dialog box. It 
allows the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. For 
details of how to create a RAS file, see Creating RAS files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



 Rectangle Tool - Bounds Creation Button

This button on the Rectangle Tool Infobar selects Bounds Creation.

_______________

{button ,KL(`rectangles',0,`____No_Topics_Found',`')}    Related Topics



 Rectangle Tool - Curved Corners Button

This button on the Rectangle Tool Infobar applies rounded corners to the currently selected rectangle QuickShapes or, if no 
QuickShapes are selected, it sets the rounded corners setting - this default applies when you next draw a rectangle.

_______________

{button ,KL(`rectangles,curved corners',0,`____No_Topics_Found',`')}    Related Topics



 Rectangle Tool - Diameter Creation Button

This button on the Rectangle Tool Infobar selects Diameter Creation.

_______________

{button ,KL(`rectangles',0,`____No_Topics_Found',`')}    Related Topics



 Rectangle Tool - Mode Indicator

This indicator on the Rectangle Tool Infobar displays the 'mode' of the tool. It will display one of the following:

New:

Changes made to the Infobar fields will set the defaults for the tool (the settings will be used for all subsequent rectangular 
QuickShapes drawn).

Change:

The selection contains at least one rectangular QuickShape. Changes made to the Infobar fields will be reflected in the selected 
rectangle(s).

_______________

{button ,KL(`rectangles',0,`____No_Topics_Found',`')}    Related Topics



 Rectangle Tool - Parameters Field

These fields on the Rectangle Tool Infobar allow the accurate editing of rectangular QuickShape parameters. Choose the values to 
alter from the left hand field and alter the values by typing into the edit fields and pressing RETURN or use the arrow buttons.

_______________

Related Topics

Rectangles
Units overview



 Rectangle Tool - Radius Creation Button

This button on the Rectangle Tool Infobar selects Radius Creation.

_______________

{button ,KL(`rectangles',0,`____No_Topics_Found',`')}    Related Topics



 

 Rectangle Tool    SHIFT+F3
The Rectangle Tool creates and edits rectangular and square QuickShapes. It is a customized version of the QuickShape Tool. For 
information about QuickShapes, see the QuickShapes Overview.

Rectangle Tool Infobar Controls
Bounds Creation
Diameter Creation
Radius Creation

Mode Indicator

Parameters
Curved Corners

Rectangle Tool Operations
Drawing rectangles and squares
Changing a rectangle into an ellipse
Adding curved corners to a rectangle
Changing curved corners on a rectangle
Rotating rectangles
Scaling rectangles
Stretching rectangles

Movie

{button ,EF("XaraDemo.exe","oblong Rectangles and Squares",1,`') } Drawing rectangles and squares



Redrawing part of a line or shape

You can redraw any section of an existing line or shape using the Freehand & Brush Tool.
To redraw part of a line or shape

1. Select the line (see Selecting objects).
2. Choose the Freehand & Brush Tool.
3. Place the pointer over the start of the section of the line you wish to redraw. The pointer shows a ~.
4. Drag the mouse to draw the replacement line section.
5. Release the mouse button when the redrawn section is complete. (Ensure the mouse pointer is over the line and the pointer 

shows a '~'.) If you get it wrong, just Undo and try again.

Tips
QuickShapes can be redrawn using the Freehand & Brush Tool only if Convert to Editable Shapes (on the Arrange 

menu) has been applied first.
To redraw part of a character in a text object, convert the text to editable shapes and Ungroup first (see Ungrouping 

objects).

Movie

{button ,EF("XaraDemo.exe","FreeEdit Editing Lines and Shapes with the Freehand Tool",1,`') } Editing lines with the 
Freehand & Brush Tool

_______________

Related Topics

Freehand & Brush Tool
Freehand lines



Reducing the resolution of bitmaps and bitmap fills

If you have any bitmap fills in a drawing, you can reduce the size of the file by reducing the resolution of the bitmaps in the fills. 
This is useful if you are creating images for use on the Web. Images do not need to be displayed at more than 96 dpi and can 
often be much less. In a similar way if your document contains bitmaps that have been masked or converted to shapes, you can 
reduce their size by creating a new bitmap from them discarding any areas you cannot see.

To reduce the resolution of a bitmap fill
1. Select the object with the bitmap fill (see Selecting objects).
2. Choose the Fill Tool and make sure no fill handles are selected. (Click away from the fill handle if necessary.)
3. The Fill Tool Infobar now tells you the resolution of the bitmap. (If you reduce the size of the object you see the bitmap resolution 

go up as you would expect.)
4. From Bitmap Effect & Plug-ins on the Utilities menu choose Bitmap Effects then Resize.
5. The current bitmap will be shown in the dialog box. If not, select the correct one from the drop down list. The dialog box shows 

the current X and Y pixel size.
6. Enter a new pixel size, that is lower than the current size. Halving the size will halve the bitmap resolution. Keep the interpolate 

and lock aspect options selected.
7. Click OK. This inserts the new reduced resolution into the drawing.
8. Select the original shape that had the fill in, and then the Fill Tool again. On the Fill Tool Infobar is a drop down that lists all the 

bitmap contained in the current document. The one at the end of the list will be the resized version of the bitmap. It will say 
(resized) after it.

9. Select this resized bitmap from the list. This will exactly replace the old one.
Note: As this method uses interpolation when it reduces the size of the bitmap, the bitmap may look better on the screen than it 

did before.
To reduce the resolution by creating a new bitmap

1. Select the bitmap.
2. From the Arrange menu, choose Create Bitmap Copy.
3. In the dialog box, select the resolution you need. 96dpi will usually give the best results.
4. SHIFT-click the Create button to create the bitmap. Holding down SHIFT when you click creates the bitmap in the same place 

as the original bitmap.
5. Cut (CTRL+X) the new bitmap to the clipboard.
6. Delete the original bitmap.
7. Press CTRL+SHIFT+V to paste the new bitmap back where it was.
This method works well on masked bitmaps as the areas you cannot see are no longer stored in the file.

_______________

Related Topics

Fill Tool



Remove a ClipView

ClipView lets you use an object as a "window" onto other objects. You see only those parts of other objects that are within the 
window. We call this creating a ClipView. 

To remove a ClipView
1. Select only the ClipView - see Selecting objects.

2. Choose Remove ClipView on the Arrange menu. This restores the objects.

Movies

{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView

_______________

{button ,KL(`clipping',0,`____No_Topics_Found',`')}    Related Topics



Remove Feathering (Arrange Menu)

This option lets you remove feathering from the selected objects - see Feathering objects or Removing feathering.



Removing Group Transparency

This separates objects currently joined as a transparency group. It also removes any transparency effect currently applied to the 
group. (It has no effect on any transparency applied to the separate objects.)

To remove Group Transparency
1. Select the transparency group.
2. From the Arrange menu, choose Ungroup Transparency.

Tips
If you want to change an object inside a transparency group, you do not need to ungroup it. See Select Inside.

_______________

{button ,KL(`transparency',0,`____No_Topics_Found',`')}    Related Topics



Removing a blend

If a blend does not give the desired effect, you can easily remove it.
To remove a blend

1. Select the blend object (see Selecting objects).
2. Choose the Blend Tool.
3. Click on the Remove button on the Blend Tool Infobar.

Tip
You can edit either of the end objects without having to remove the blend. See Select inside for details of how to select an 

end object in a blend.

_______________

{button ,KL(`blends;tools,blend tool',0,`____No_Topics_Found',`')}    Related Topics



Removing a brush stroke

Removing a brush stroke lets you use options such as a dash pattern or arrowheads.
To remove a brush stroke using the Freehand & Brush Tool

1. Select the line (see Selecting objects).
2. Choose the Freehand & Brush Tool.
3. From the Select Brush drop-down list select Normal line (always the first option in the list).

To remove a brush stroke using the Line Gallery
1. Select the line (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the New Brush Strokes section.
4. Double click on Default stroke (the first option).

_______________

{button ,KL(`brush strokes',0,`____No_Topics_Found',`')}    Related Topics



Removing a contour

If a contour does not give the desired effect, you can easily remove it.
To remove a contour

1. Select the contour object (see Selecting objects). (See Note.)
2. Choose the Contour Tool.
3. Click on the Remove button on the Contour Tool Infobar.

Notes
You can also use the Contour Tool to select objects - more details.

_______________

{button ,KL(`contours',0,`____No_Topics_Found',`')}    Related Topics



Removing a mold

If a mold does not give the required results, you can easily remove it.
To remove a mold

1. Select the mold object (see Selecting objects).
2. Choose the Mold Tool.
3. Click the Remove Mold button on the Mold Tool Infobar.

_______________

{button ,KL(`molds;tools,mold tool',0,`____No_Topics_Found',`')}    Related Topics



Removing a shadow

The Shadow Tool creates soft shadows, which fade out to totally transparent at the edges. This looks more realistic than a solid 
shadow.

To remove a soft shadow
1.    Select the object (see Selecting objects). (See Note.)
2.    Choose the Shadow Tool.
3.    Select the No shadow button on the Shadow Tool Infobar.

Note:
You can also use the Shadow Tool to select objects - more details.

____________

Related Topics

Modifying shadows
Applying a shadow
Shadow Tool



Removing a stroke shape

Removing a stroke shape lets you use options such as a dash pattern or arrowheads.
To remove a brush stroke using the Freehand & Brush Tool

1. Select the line (see Selecting objects).
2. Choose the Freehand & Brush Tool.
3. From the Select Shape drop-down list select Constant (always the first option in the list).

To remove a stroke shape using the Line Gallery
1. Select the line (see Selecting objects).
2. From the Utilities menu, choose Line Gallery.
3. Scroll in the gallery to the Strokes Shapes section.
4. Double click on Constant (the first option).

_______________

{button ,KL(`stroke shape',0,`____No_Topics_Found',`')}    Related Topics



Removing and restoring buttons

Removing and restoring buttons lets you customize Xara X’s control bars to your personal preferences.

To remove a button
ALT-drag the button and drop it away from all control bars.

To restore a removed button
1. Choose Control Bars from the Window menu.
2. Scroll the list of control bars until you see the button palette listed.
3. Click the check box next to it to display the button palette.
4. ALT-drag the required button from the button palette back to the control bar.

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Removing a bevel

Bevels give objects an appearance of depth instead of being flat on the page.
To remove a bevel

1. Select the objects you want to remove the bevel from (see Selecting objects).
2. Choose the Bevel Tool.
3. Choose None from the Bevel Type list.

_______________

Related Topics

Applying a bevel
Modifying bevels
Bevel Tool



Removing bitmaps from a document

Unused bitmaps are automatically removed when you close the document. You can also manually remove a bitmap if you are 
running low on memory.

To remove a bitmap from a document
1. From the Utilities menu, choose Bitmap Gallery.
2. Select the bitmap you want to delete.
3. Click the Delete button in the gallery.

Tip
Deleting a bitmap from a document using Delete on the Edit menu will not remove it from the document completely. It will 

remain in the Bitmap gallery until you delete it or save the document.

_______________

Related Topics

Bitmaps overview
Bitmap Gallery



Removing blend from a curve

You can easily remove a blend from a curved line or shape.
To remove text from a curve

1. Select the blend (see Selecting objects).
2. Select the Blend Tool.
3. Deselect the Blend along a curve button.

Tip
You can still edit the blend when it is on a curve. You can also reshape the curve without removing the blend.

_______________

{button ,KL(`blends',0,`____No_Topics_Found',`')}    Related Topics



Removing feathering

If feathering does not give the desired effect, you can easily remove it.
To remove feathering

1. Select the feathered object (see Selecting objects).
2. On the    Feathering Control Bar set the slider to 0.

_______________

{button ,KL(`feathering',0,`____No_Topics_Found',`')}    Related Topics



Removing objects from groups

If you have several objects in a group, you can remove one of them without ungrouping them all.
To remove an object from a group

1. Choose the Selector Tool.
2. CTRL-click on the object in the group you want to remove.
3. From the Edit menu, choose Delete (or Cut if you want to move the object to the clipboard).

Tip
CTRL-click on an object selects it even if it is inside another object (such as a group). This is called select inside.

_______________

{button ,KL(`selecting,objects',0,`____No_Topics_Found',`')}    Related Topics



Removing plug-ins

Plug-ins let you extend the range of effects you can apply to bitmaps.

To remove plug-ins

1. Choose Options on the Utilities menu.
2. Click the Plug-ins tab.
3. Click on the folder of plug-ins you want to remove
4. Click Remove.

_______________

Related Topics

Installing plug-ins
Bitmap effects plug-ins



Removing text from a curve

If you decide you no longer require some text to follow a curved line, you can easily remove it.
To remove text from a curve

1. Select the text object (see Selecting text objects).
2. From the Arrange menu, choose Remove Text From Curve.

Tip
You can still edit text when it is on a curve. You can also reshape the curve without removing the text.

_______________

{button ,KL(`text objects,fitted to curves',0,`____No_Topics_Found',`')}    Related Topics



Removing transparency

If you have made an object transparent using the Transparency Tool, you can make it solid again by removing the transparency.
To remove the transparency from an object

1. Select the transparent object (see Selecting objects).
2. Choose the Transparency Tool.
3. Choose No Transparency from the drop-down list on the Transparency Tool Infobar.

_______________

{button ,KL(`transparency,applying;tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



Removing web addresses from objects

If you have added a web address to an object, you can easily remove it.
To remove a web address from an object

1. Select the object (see Selecting objects). You can select more than one.
2. From the Utilities menu, choose Web Address.
3. Click the Remove button.

_______________

{button ,KL(`web addresses',0,`____No_Topics_Found',`')}    Related Topics



Rename Color Dialog Box

With the Rename Color dialog box you can change the name of a named color. For more details, see Renaming named colors.

To open it, either:
click the Rename button in the Color Gallery,
or select Rename from the Color Editor menu.

_______________

{button ,KL(`color gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Renaming layers

You can easily rename a layer using the Layer Gallery.
To rename a layer

1. From the Utilities menu, choose Layer Gallery.
2. In the Layer Gallery, click on the layer you want to rename.
3. Click the Properties button to open the Layer Properties dialog box.
4. In the dialog box, change the name.

Note:

Layers MouseOff, MouseOver, MouseDown, Selected and BackBar are used by the Button & NavBar Tool. We do not 
recommend renaming these layers as this could affect navigation bar creation. For more information on bar creation see Creating 
Navigation Bars.

_______________

{button ,KL(`layers',0,`____No_Topics_Found',`')}    Related Topics



Renaming named colors

You can easily rename a named color using the Color Gallery.
To rename a color

1. From the Utilities menu, choose Color Gallery.
2. Select the color you want to rename.
3. Click the Rename Color button in the gallery.
4. Type the new name and click Rename.

_______________

{button ,KL(`color gallery overview',0,`____No_Topics_Found',`')}    Related Topics



Reordering frames

Moving frames up or down in the Frame Gallery changes the frame sequence of the animated GIF file.
To reorder frames

1. From the Utilities menu, choose Frame Gallery.
2. The frames are all shown in reverse order (last frame at the top). To move a frame, drag it and drop it at its new position in the 

list. As you drag, the mouse pointer shows whether the frame will be placed above or below the frame the pointer is over.

_______________

{button ,KL(`frames',0,`____No_Topics_Found',`')}    Related Topics



Reordering gallery sections

You may prefer to have the sections of the Fill, Clipart and Font Galleries in a different order.
To reorder a gallery section

1. Drag the title of the section in the gallery to its new position. The mouse pointer shows where the section will be positioned.

Tips
You can also reorder items within each section. See Reordering items in a gallery.



Reordering items in a gallery

Items in galleries can often be reordered simply by dragging the items within the gallery. The gallery contents can also be sorted 
from the Gallery Sort dialog box accessible from the Options button.

Tips
You can also reorder sections within the galleries. See Reordering gallery sections.
Moving layers in the Layer Gallery alters the stacking of layers.
Moving frames in the Frames Gallery alters the sequence of frames in an animation.
You can sort the Color Gallery, the Font Gallery, the Fill Gallery and the Clipart Gallery.
If you sort the Font Gallery by Font Type, set the Secondary key to Font Name.



Reordering layers

Moving layers up or down in the Layer Gallery changes the stacking order of the layers. Objects in the top layer in the Layer 
Gallery appear on top of objects in other layers.

To reorder layers
1. Choose Layer Gallery from the Utilities menu to open the Layer Gallery.
2. The layers are all shown in order. To move a layer, drag it and drop it at its new position in the list. As you drag, the mouse 

pointer shows whether the layer will be placed above or below the layer the pointer is over.

Tip
Layers in the Background section are non-printing.
The guides layer is always non-printing.

_______________

{button ,KL(`layers',0,`____No_Topics_Found',`')}    Related Topics



Reshaping envelope molds

Envelope molds are controlled using four mold handles around the object, each of which has two curve handles attached to it 
which allow you to alter the curvature of the sides of the envelope. Changing the envelope is very similar to editing a shape with 
the Shape Editor Tool.

Moving a mold handle
1. Select the molded object (see Selecting objects).
2. Choose the Mold Tool, Shape Editor Tool or the Selector Tool. If you choose the Selector Tool, you must enable edit handles 

(see Enabling edit handles).
3. Drag the handle to its new position (If several handles are selected, they will all move simultaneously. SHIFT-click to select 

additional handles).
Moving a mold curve handle

1. Select the molded object.
2. Choose the Mold Tool, Shape Editor Tool or the Selector Tool. If you choose the Selector Tool, you must enable edit handles 

(see Enabling edit handles).
3. Click on a mold handle to select it (two mold edit handled will appear).
4. Drag the curve handles to alter the curvature of the side of the mold.

Tips
You can edit a mold without your changes being reflected until you have the required shape. Click the Detach Mold 

button on the Mold Tool Infobar and make your changes. Deselect the button to remold the object.
The Mesh button on the Infobar displays a mesh over the selected molds which you may find helpful to visualize the mold 

shape.



Reshaping perspective molds

Perspective molds are controlled using four mold handles, one on each corner. To reshape the mold either move these handles or 
drag one of the two 'vanishing points'. 

To reshape a perspective mold
1. Select the molded object (see Selecting objects).
2. Choose the Mold Tool, Shape Editor Tool or the Selector Tool. If you choose the Selector Tool, you must enable edit handles 

(see Enabling edit handles).
3. Drag the handle (or vanishing point) to its new position. If several handles are selected, they will all move simultaneously. 

SHIFT-click to select additional handles.

Tips
To edit a mold without your changes being reflected until you have the required shape, click the Detach Mold button on 

the Mold Tool Infobar and make your changes. Deselect the button to remold the object.
You can place a mesh (like a grid) over the selected molds by clicking the The Mesh button on the Infobar.



Reshaping text on a curve

When you have text on a curve, you can still edit the curve. You don't need to remove the text first.
To reshape text on a curve

1. Select the text object (see Selecting objects).
2. Choose the Shape Editor Tool.
3. The line (or shape) will become selected and you can then reshape it as normal (see Changing curved lines and shapes ).
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Resizing column text

Once you have a column text object in a document, you can change its width to reformat it to a different size.
To resize column text

1. Select the text object (see Selecting text objects).
2. Choose the Text Tool.
3. Drag either of the margin handles on either side of the column.

Tip
To constrain the angle of the lines of text to the constrain angle, hold down CTRL as you drag the handle. See also 

Changing the constrain angle.
To rotate the text column as you resize it, hold down SHIFT.
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Returning to the previous zoom

Often you want to zoom into a particular part of a document and then return to the previous zoom value. Alternatively you might 
zoom out to view the entire drawing then return to the previous zoom value.

To return to the previous zoom
1. Click the Previous zoom button on the control bars

Tips
You can toggle between the two zoom values to zoom in and out onto your document.
You can also choose Previous from the Zoom drop-down menu on the control bars. (See Zoom Magnification.)
Previous Zoom is also available on the Zoom Tool and Push Tool Infobars.
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Reverse Text On Curve

 CTRL+SHIFT+R

Reverse Text On Curve on the Text Pop-up Menu flips text fitted to a curve so that the text is on the other side of the curve.

This is particularly useful when fitting text to a circle because it lets you fit the text to either the inside or the outside of the circle.
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Reversing the direction of a line

Sometimes you want to reverse the direction of a line so the start becomes the end and vice versa. Examples are:
To move an arrow head to the other end of the line (see Notes).
If you are using a directional brush pattern and you want the pattern to run the opposite way.
To reverse the direction of a line

1. Select the line or object (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Click the Reverse path button on the Shape Editor Tool Infobar.

Notes:
You can also swap arrow heads and tails using the Line Gallery. The easiest way is to drag the required arrow head to the 

end of the line (or tail to the start of the line).
Reversing the line does not alter its shape. If you want to flip (mirror) a line, use the Flip buttons on the Selector Tool.
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Reversing text on a curve

Sometimes you may want to fit text to the opposite side of the curved line or shape.
To reverse text on a curve

1. Right-click on the text object to open the pop-up menu.
2. From the menu, choose Reverse Text on Curve

This can also be described as "moving the text onto the other side of the curve".
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Rotating column text

Once you have a column text object in a document, you can rotate it using the Text Tool.
To rotate column text

1. Select the text object (see Selecting text objects).
2. Choose the Text Tool.
3. SHIFT-drag either of the margin handles on either side of the column.

Tips
To constrain the angle of rotation to the constrain angle, hold down CTRL. See also Changing the constrain angle.
You can also rotate text objects using the Selector Tool (see Rotating objects).
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Rotating ellipses and circles

After creating an ellipse or circle you can easily change the angle it slopes at.
To rotate an ellipse

1. Select the ellipse (see Selecting objects).
2. Choose the Ellipse Tool or the QuickShape Tool
3. SHIFT-drag a handle to rotate and scale the ellipse.

Tips
As you rotate the ellipse it will also scale, if you do not want it to scale, hold down CTRL too.
Ellipses can also be rotated using the Selector Tool - see Rotating objects.
You can also rotate an ellipse using the drop-down list on the Ellipse Tool Infobar or the QuickShape Tool Infobar. Choose 

Rotation from the list and change the angle on the right (in degrees).
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Rotating objects

Objects can be rotated about their center or about a movable transformation center (see Moving the transformation center):

What do you want to do?
Rotate objects by dragging
Rotate objects accurately



Rotating objects accurately

This method of rotating objects lets you specify a precise angular rotation.
To rotate objects accurately

1. Select the objects (see Selecting objects).
2. Choose the Selector Tool.
3. Enter the required rotation in the Rotation field on the Selector Tool Infobar and press RETURN.

Tips
You can also use the arrow buttons on the Rotation field on the Infobar to rotate the selection in small increments.
The objects will rotate around the transformation center.



Rotating objects by dragging

This is an easy way of rotating objects as you can see the results as you drag.
To rotate objects by dragging

1. Select the object or objects.
2. Ensure the selection handles are in rotate/skew mode (see Switching selection handle mode).
3. Either

drag the corner selection handles to rotate the selection around the transformation center,
or SHIFT-drag the corner selection handles to rotate the selection about its center.

Tips
CTRL-drag to constrain the angle of rotation. See Changing the constrain angle.
To leave copies of the object as you rotate it, drag as normal, but click the right mouse button where you want each copy 

(or press ' +' on the numeric keypad).
To rotate the object but not any fill applied to it, press and release NumPad '-' during the drag. This is useful if you want to 

rotate an object with a bitmap fill and not rotate the bitmap.

Movie

{button ,EF("XaraDemo.exe","SelHands.avi Selection Handles",1,`') } Using selection handles
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Rotating rectangles

The QuickShape and Rectangle Tools provide with an easy way of rotating a rectangle.
To rotate a rectangle

1. Select the rectangle (see Selecting objects).
2. Choose the Rectangle Tool or the QuickShape Tool.
3. SHIFT-drag a corner handle to rotate the rectangle.

Tips
As you rotate the rectangle it will also scale, if you do not want it to scale, hold down CTRL too.
Rectangles can also be rotated using the Selector Tool - see Rotating objects.
You can also rotate a rectangle using the drop-down list on the Rectangle Tool Infobar or the QuickShape Tool Infobar. 

Choose Rotation from the list and change the values in the fields on the right.
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Rotating the contents of a mold

This lets you rotate the object inside the mold without changing the mold shape.
To rotate the contents of a mold

1. Select the mold (see Selecting objects).
2. Choose the Mold Tool.
3. Click the Rotate Mold button on the Mold Tool Infobar to rotate the contents of the mold by ninety degrees.
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Ruler Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a ruler, it contains the following options:
Delete All Guidelines Deletes all the guidelines in the document.
New Guideline Creates a new guideline, see Guideline Properties dialog box.
Guide Layer Properties Opens the Guide Layer Properties dialog box.
Grid and Ruler Options Opens the Grid and Ruler Options.
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 Rulers (Window Menu)    CTRL+L

Rulers on the Bars submenu of the Window menu shows or hides the rulers.
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 Save (File Menu)    CTRL+S

Save saves the current document to a XAR file. The current document is saved to the same file that it was opened from or saved 
to. If the document is a new document that has not yet been saved, the Save As dialog box will appear asking what file name you 
would like to use and where you want to save the file.
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 Save All (File Menu)

Save All is equivalent to selecting Save for each loaded document.
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 Save As (File Menu)

The Save As dialog box allows you to save the current document in a named file. The new file can simply be another file in the same 
folder or you can change the drive and folder so the document is saved in a completely different place. If you want to save the 
document in a different format use Export on the File menu.

If you click on a XAR or WEB file, you will see a preview of it in the dialog box (if the file contains a preview).

If you are editing a drawing which is embedded in a document in another program, this menu item will read Save Copy As. 
Selecting it allows you to save a copy of the drawing to disk without affecting the way it is embedded in the document in the other 
program.

Show preview bitmap

Select this option to preview files as you click their name.
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Save Template Dialog box

Most of the options in this dialog box are standard to Windows Save dialog boxes.

The folder you select in this dialog box is where Xara X looks for templates. If you select a different folder, Xara X will not see any 
templates stored in the old folder. For this reason we suggest always using the default folder.

Save as Type

Xara X Template is the only option. To save your drawing in other formats use Save As or Export.

Show preview bitmap

Select this option to preview files as you click their name.

Use as default template

Xara X has two default templates: one for normal drawings and the second for animated GIFs and Internet graphics. Select this 
option to make this document either the normal drawing default or the animated GIF default (depending on which template you 
originally used for this document). See Creating new documents for details of opening drawing and animated documents.



 Save Template (File Menu)

You can use template documents to create different types of document. Xara X includes two templates; one for normal drawings 
and one for animated GIFs. You can create your own custom templates. Templates appear in the New submenu on the File menu. 
See Creating new documents for more details.
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Saving bitmaps from a document

You can save out any bitmap that is in a document.
To save a bitmap from a document

1. From the Utilities menu, choose Bitmap Gallery.
2. Select the bitmap you want to save.
3. Click the Save button.

Tips
You cannot make any changes to the color or size of the bitmap.
This covers exporting an existing bitmap. You can also export any part of your document as a bitmap. See Creating 

bitmaps.
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Saving documents to disk

Documents are saved by writing them to disk. The first time you save a document, you must give it a name and say which folder to 
save it in. For subsequent saves Xara X remembers the document name and folder.

To save a document
1. Make sure the document you wish to save is the current document. If it is not, click on it.
2. From the File menu, choose Save.

If you have not saved the document before, the Save As dialog box appears. You can then name the document and specify which 
folder to save it in.

Tips
To save a document using a different name, choose Save As from the File menu. This lets you create backups of your 

documents.
To save the document in a different file format, use Export on the File menu.



 Scaling Options

To open the Scaling Options, choose Options from the Utilities menu and click on the Scaling tab. The scaling options control how 
your document is scaled. See Setting a scale factor for more information.

Use Scale Factor

You can use a scaling factor in documents so all the measurements you see on the screen are scaled.

Drawing to Real World

These two fields are only available if the above option has been selected. Values should be entered here to set the scale factor of 
the document. For example 1cm to 1km.



Scaling and rotating polygons

You can use the QuickShape Tool to scale and rotate polygons.
To scale and rotate polygons

1. Select the polygon (see Selecting objects).
2. Choose the QuickShape Tool
3. Drag one of the outer handles. The polygon scales and rotates about its center.

Tips
To just scale the shape, CTRL-drag towards or away from the center of the shape.
To just rotate the shape, hold down CTRL and drag the handle radially.
You can also resize and rotate a polygon using the drop-down list on the QuickShape Tool Infobar. Choose Size and 

Rotation from the list and change the values in the fields on the right.
You can also rotate and scale objects using the Selector Tool . See Rotating objects and Scaling objects.
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Scaling bitmaps

You can use the Bitmap Effects dialog box to resize bitmaps. If you select the Linear Interpolation option, the results will be of 
higher quality than if you scale the bitmap using the Selector Tool as this option scales the bitmap more intelligently.

To scale a bitmap
1. Select the bitmap (see Selecting objects).
2. From Bitmap Effects & Plug-ins on the Utilities menu, choose Bitmap Effects.
3. Choose Resize.
4. Enter the new size.
5. Click the Insert button to insert the new, altered bitmap into the document.

Tips
In most cases it is easier to use the Selector Tool to resize objects (see Scaling Objects). However in some cases you 

may need to alter the actual bitmap. (For example, to reduce the memory needed.)
To keep the bitmap the same shape, select the Lock Aspect Ratio option.
You can also select a bitmap in the Bitmap Gallery and then click the Plug-ins button on the Gallery.
If you want to remove the original bitmap from your document, you can delete it in the Bitmap Gallery.



Scaling ellipses

You can scale ellipses easily using the QuickShape Tool or the Ellipse Tool.
To scale an ellipse

1. Select the ellipse (see Selecting objects).
2. Choose the Ellipse Tool or the QuickShape Tool.
3. Drag a handle on the ellipse.

Tips
To keep the ellipse the same shape, hold down SHIFT.
To resize the ellipse without it rotating or stretching, hold down CTRL.
You can scale ellipses with the Selector Tool - see Scaling objects.
You can also resize an ellipse using the drop-down list on the Ellipse Tool Infobar or the QuickShape Tool Infobar. Choose 

Width and Height from the list and change the values in the fields on the right.
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Scaling objects

Objects can be scaled either by dragging with the mouse or more accurately using the controls on the Selector Tool Infobar. To 
stretch an object, you just need to drag the side handles so the object scales in one direction. Alternatively selected objects can 
auto-scale other objects (for example changing the text on a button might auto-scale the other parts of the button). You can also 
use contours to make objects thicker or thinner and so change their scale.

Note on scaling bitmaps:

When you resize a bitmap, Xara X smooths (interpolates) between the individual pixels to give a smooth look to the bitmap. 
Usually this gives the best result. However you might not want this effect - in this case you can turn off smoothing for either all 
bitmaps in the document or a single bitmap.

What do you want to do?
Scale objects by dragging
Scale objects accurately
Resizing using contours
Linked stretching (auto-scaling objects)



Scaling objects accurately

This method of scaling objects gives you precise size control.
To scale objects accurately

1. Select the object(s) to be scaled (see Selecting objects).
2. Enter the required scaling (%) in the Scaling field on the Selector Tool Infobar and press RETURN.

Tips
To lock or unlock the aspect ratio of the selection click the Aspect Ratio Lock button on the Infobar.
To force line thicknesses in the selection to increase/decrease with the scaling click the Scale Line Width button on the 

Infobar.
If you stretch an object containing a circular fill, the fill will change to an elliptical fill, but an undo will not revert this change 

- the fill will remain elliptical.
You can also enter values in the Dimensions field on the Infobar and press RETURN.
You can also use the arrow buttons on the Scaling Field on the Infobar to change the scaling in small increments.
When you resize a bitmap, Xara X smooths (interpolates) between the individual pixels to give a smooth look to the 

bitmap. Usually this gives the best result. However you might not want this effect - in this case you can turn off smoothing for either 
all bitmaps in the document or a single bitmap. The difference between smoothed and unsmoothed.

Note:
The size of feathering does not change when you scale objects.



Scaling objects by dragging

This is an easy way of scaling objects as you can see the results as you drag.
To scale objects by dragging

1. Select the objects to be scaled (see Selecting objects).
2. Ensure selection handles are in Scale Mode (see Switching selection handle mode).
3. Either

drag a corner selection handle to scale away from the opposite corner,
or SHIFT-drag a corner selection handle to scale around the center,
or drag a side selection handle to stretch in one direction,
or SHIFT-drag a side selection handle to stretch in both directions.

Tips
If you select the Aspect Ratio Lock button on the Selector Tool Infobar, the aspect ratio of the selected object is locked 

when you scale using the corner handles.
To leave copies of the object as you scale it, drag as normal, but click the right mouse button where you want each copy 

(or press ' +' on the numeric keypad).
To force line thicknesses in the selection to increase/decrease with the scaling click the Scale Line Width Button on the 

Infobar.
To scale the object but not any fill applied to it, press and release ' - ' on the numeric keypad during the drag. This is useful 

if you want to scale an object with a bitmap fill and not scale the bitmap.
If you stretch an object containing a circular fill, the fill changes to an elliptical fill. Undo does not revert this change - the 

fill remains elliptical.
When you resize a bitmap, Xara X smooths (interpolates) between the individual pixels to give a smooth look to the 

bitmap. Usually this gives the best result. However you might not want this effect - in this case you can turn off smoothing for either 
all bitmaps in the document or a single bitmap. The difference between smoothed and unsmoothed.

Note:
The size of feathering does not change when you scale objects.

Movie

{button ,EF("XaraDemo.exe","SelHands.avi Selection Handles",1,`') } Using selection handles
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Scaling rectangles

The QuickShape and Rectangle Tools provide with an easy way of scaling a rectangle.
To scale a rectangle

1. Select the rectangle (see Selecting objects).
2. Choose the QuickShape Tool or the Rectangle Tool.
3. Drag one of the corner handles to move it.

Tips
If you want to scale the rectangle away from a corner or side, just drag an opposite corner. You can use CTRL to lock the 

width, height or aspect ratio.
To scale and rotate the whole shape at once, SHIFT-drag. This scales the shape around its center.
To scale the whole shape without it rotating, CTRL+SHIFT-drag.
You can also resize a rectangle using the drop-down list on the Rectangle Tool Infobar or the QuickShape Tool Infobar. 

Choose Width and Height from the list and change the values in the fields on the right.
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Scrollbars (Window Menu)

Scrollbars on the Bars submenu of the Window menu allows the scrollbars around the Xara X window to be turned on and off. 
When it is set, the scrollbars are enabled, otherwise they are not.

Normal mode and full screen mode store this setting separately, so you could have the scrollbars enabled in normal mode, but not 
in full screen mode.
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Searching a gallery

Several Galleries contain many items. You can easily search for the items you want.
To search a gallery

1. Click the Options button in the gallery.
2. Choose Find from the menu to open the Gallery Find dialog box.
3. Type in the text to search for.
4. Choose whether you wish to search just the names and keywords.
5. Click the Find First button to find the first match.

Click the Find Next button to continue searching.

Tip
For more information on the options, click the Help button in the dialog box.
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 Select All (Edit Menu)    CTRL+A

Select All selects (see selection) all visible, editable objects in the current document. For more details on selecting objects, see 
Selecting objects.

Note
Pressing CTRL+A when using the Text Tool selects all the characters in the text object.



Select All Points

This item on the Point Handle Pop-up Menu selects all the point handles on all the selected lines and shapes.



Select End Frame (Control Bars)

Clicking this button selects the last frame in the animation - the one shown at the top of the Frame Gallery.



Select Next Frame (Control Bars)

Click this button to select the frame after the current one. This is equivalent to clicking on the frame above the current one in the 
Frame Gallery.



Select Previous Frame (Control Bars)

Click this button to select the frame before the current one. This is equivalent to clicking on the frame below the current one in the 
Frame Gallery.



Select Start Frame (Control Bars)

Clicking this button selects the first frame in the animation - the one shown at the bottom of the Frame Gallery.



Selecting a member of an object

Xara X has a special form of Select Inside which allows you to select a particular member of a compound object as opposed to the 
normal select inside which will always selects the actual object you click on. With select member, a click selects the object inside 
the compound object which contains the clicked object. If that object is a compound object, another click will select a member in 
that object and so on. When the last selected object is not a compound object the next click will select the outermost object again.

To select a member of an object
1. Choose the Selector Tool (see Selecting objects).
2. Place the mouse pointer over the member of the compound object.
3. Either:

CTRL+ALT-click to select the member object,
or CTRL+ALT+SHIFT-click to swap the member object between selected and not selected.

If the required member object is deeper inside the object, repeat step 3.

 CTRL+ALT-click to select the next member of the selected object.

Notes
When any selected object is inside another one the status line shows, for example "2 shapes selected ("inside")"
Some operations are unavailable when any selected object is inside another one.
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Selecting a single object

Selecting an object is usually the first step in changing one or more of its attributes.
To select a single object

1. Choose the Selector Tool (see Tips).
2. Click on the object.

    Click to select the object under the mouse pointer

Tip
Often you don’t need to select an object. For example, you can change its color by drag-and-dropping the color from the 

Color Line.
When selecting navigation bars and rollovers we recommend using the Button & NavBar Tool. See Selecting navigation 

bar objects.
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Selecting a single point handle

You need to select a point handle before you can delete it or move it to reshape the line or object.
To reshape a single point handle

1. Select the line or shape.
2. Choose the Shape Editor Tool or the Pen Tool (you can also use the Selector Tool, see tip).
3. Click on the point handle on the selected line or shape.

Tip
You can use the Selector Tool if you have enabled edit handles. See Enabling edit handles.



Selecting all objects

This is a quick way to select all the objects in your document. See Selecting objects for details of how to select individual objects.
To select all objects

1. From the Edit menu, choose Select All.

Notes
When creating animations: to select all objects in all frames, click All Visible and All Editable in the Frame Gallery. See 

Frame Gallery for details.



Selecting all point handles

When you are using the Shape Editor Tool to alter a line or shape, you can select all the point handles on the line.
To select all point handles on a line or shape

1. Select the line or shape.
2. Choose the Shape Editor Tool.
3. CTRL-SHIFT-click on a deselected point handle.

Tips
If you select all the point handles on a line, you can smooth it. See Smoothing lines and shapes.
You can select all the points on a line or shape quickly by right-clicking on the line or shape to open the pop-up menu and 

choosing Select All Points.



Selecting characters in text objects

This lets you select one character from a line of text.
To select a character in text objects

1. Choose the Selector Tool.
2. Click on the text object to select it.
3. Either:

CTRL-click on the character,
or ALT+CTRL-click on the character twice. The first click selects the line, the second click selects the character.

Tips
You can also select a character by selecting a region of the text object with only one character in it. See Selecting part of a 

text object.
When a text character is selected, the Text Tool Infobar shows the attributes applied to it.
A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it 

simple to apply fills and transparency to selected text regions.



Selecting difficult objects

If you are having trouble selecting an object, you may like to try the following:
Zoom in on the object so you can click more accurately. See Zooming in and out.
Lower the quality setting to outline and click
If the object is the back object in a blend with many steps, try using a high-zoom on the tiny section of the back object still 

visible.

If you want to select objects that are on top of other objects, marquee-selection (see Selecting several objects) may move the 
other objects. Using SHIFT-drag forces select rather than move.



Selecting items in a gallery

Galleries allow you to perform operations on their contents (for example deleting named colors). Before these operations can be 
applied, the items in the gallery must be selected. Selected items are highlighted.

Selecting a Single Item
1. Click on the item

Selecting Several Items
1. Click on the first item
2. CTRL-click on each subsequent item

Selecting a Block of Items
1. Click on the first item in the block
2. SHIFT-click on the last item in the block. This selects all items between the first and last.
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Selecting lines of text in text objects

This lets you select a single line of text in a text object.
To select a line of text

1. Choose the Text Tool.
2. Place the pointer over the line of text.
3. Triple-click.

Tips
When a region of text is selected, the Text Tool Infobar shows the attributes applied to the region.
A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it 

simple to apply fills and transparency to selected text regions.
You can also use the Selector Tool. Click on the text object to select it, then ALT+CTRL-click on the line to select it inside.
In the Text Tool click in the text object. Then press CTRL+L to select all characters in the current line. See the List of Text 

Tool keyboard shortcuts for a complete list.

_______________

{button ,KL(`text objects,selecting',0,`____No_Topics_Found',`')}    Related Topics



Selecting navigation bar objects

We recommend using the Button & NavBar Tool to select navigation bar objects, especially if the navigation bar uses rollover 
buttons. (Navigation bars use layers, some of which may be invisible - the Button & NavBar Tool selects objects in all layers. The 
Selector Tool ignores invisible layers.)

To select navigation bar objects
1. Choose the Button & NavBar Tool.
2. Drag to form a rectangle that encloses all the required objects. (This is often called "marquee-selection".) Releasing the mouse 

button selects all the objects entirely contained within the rectangle.

_______________

{button ,KL(`objects,selecting',0,`____No_Topics_Found',`')}    Related Topics



Selecting objects

When you want to change an object, you will normally have to select it. Objects are usually selected and deselected using the 
Selector Tool (although other tools provide a limited range of select options). When an object is selected a selection marker is 
shown on it and selection handles, edit handles, fill handles and fill arrows are displayed on and around the selection (if they have 
been enabled, see below).

What do you want to do?
Select a single object
Select several objects
Select all objects
Select objects under other objects
Select objects in objects
Select difficult objects
Change the selection with the Tab key
Selecting navigation bar objects
Select objects using the Name Gallery
Deselect objects

Note:
When selecting navigation bars and rollovers we recommend using the Button & NavBar Tool. See Selecting navigation 

bar objects.

Movie

{button ,EF(`xarademo.exe',`Select Selecting objects',1,`')} Selecting objects

_______________

{button ,KL(`selecting,objects;tools,selector tool;selector tool',0,`____No_Topics_Found',`')}    Related Topics



Selecting objects in objects (Select inside)

Xara X lets you easily select objects that are contained within compound objects. These objects can then be edited as if they were 
not contained. Select Inside is a shortcut to select the object you actually click on, irrespective of whether it inside another object 
or not. If you wish to select a compound object inside another object you must use Select Member. See Selecting a member of an 
object.

To select objects in objects
1. Choose the Selector Tool (see Notes).
2. Place the mouse pointer over the contained object you want to select.
3. Either

CTRL-click to select the object,
or CTRL+SHIFT-click to swap the object between selected and not selected.

CTRL-Click to select the object under the mouse pointer even if it is contained inside other objects

Notes
When an object has been selected inside another object, this information is displayed on the Status Line. For example "1 

QuickShape (inside)"
Some operations are unavailable when any selected object is inside another one.
If you hold down CTRL when you drag-and-drop an attribute onto an object inside another object, the attribute will be 

applied to the object inside the compound object. See apply inside.

When selecting navigation bars and rollovers we recommend using the Button & NavBar Tool. See Selecting navigation 
bar objects.

Movie

{button ,EF("XaraDemo.exe","SelInsid.avi Selecting Objects In Objects",1,`') } Selecting objects in objects

_______________

{button ,KL(`tools,selector tool;selector tool',0,`____No_Topics_Found',`')}    Related Topics



Selecting objects under other objects

Often objects in the document cover all or most of other objects. Use this to select the hidden objects.
To select objects under other objects

1. Choose the Selector Tool (see note).
2. Place the mouse pointer above the hidden object.
3. Either:

ALT-click to select the object underneath,
or ALT-click again to deselect that object and to select the next object underneath.

The first ALT-click will select the object on top first if it is not selected already. Subsequent ALT-clicks will go on to select the 
objects underneath. ALT-clicking with the bottom object selected will reselect the top-most object.

Click to select the object under the selected object. (ALT-click)

Note:
When selecting navigation bars and rollovers we recommend using the Button & NavBar Tool. See Selecting navigation 

bar objects.

Movie

{button ,EF("XaraDemo.exe","SelUnder.avi Selecting Objects Under Objects",1,`') } Selecting objects under objects

_______________

{button ,KL(`selector tool;tools,selector tool',0,`____No_Topics_Found',`')}    Related Topics



Selecting objects using the Contour Tool

Before you can apply or edit a contour on an object, you must first select the object. The regular way of selecting objects is to use 
the Selector Tool but you can also use the Contour Tool.

Selecting a single object
1. Click on an object to select it.    Note that this deselects any other objects that are currently selected.

Selecting several objects
1. Click on the first object to select it. (Any object can be the first.)
2. SHIFT-click on the others.

SHIFT-click on an object to deselect it.
Deselecting all objects

1. Click on a blank area of the page.



Selecting objects using the Name Gallery

You can use the Name Gallery to select objects that use any of the items (Names, Bitmaps, Colors, or Fonts) listed in the Gallery. 
This can speed up making changes (for example, if you want to change from one Named Color to another.)

To add objects to the current selection
1. Click the circle to the left of the item you want to select on.

To select only objects that use specified items in the Name Gallery
1. Click on the first item you want to select on.
2. If you want to select on more than one item, SHIFT-click on the other items
3. Click either 

Select to select objects that use any of the selected items,
or Intersect to select only objects that use all the selected items.

_______________

Related Topics

Selecting objects
Name Gallery



Selecting objects using the Shadow Tool

Before you can apply or edit a shadow on an object, you must first select that object. The regular way of selecting objects is to use 
the Selector Tool but you can also use the Shadow Tool.

Selecting a single object
1. Click on an object to select it.    Note that this deselects any other objects that are currently selected.

Selecting several objects
1. Click on the first object to select it. (Any object can be the first.)
2. SHIFT-click on the others.

SHIFT-click on an object to deselect it.
Deselecting all objects

1. Click on a blank area of the page.

Important:
When selecting or deselecting objects, CLICK on them. Don't DRAG as this creates or moves the shadow.

____________

Related Topics

Modifying shadows
Applying a shadow
Removing a shadow



Selecting part of a text object

By using different options you can select either the whole text object or just a part of it, even down to a single character.
To select part of a text object

1. Choose the Text Tool
2. Either:

to select characters, click and drag over them,
to select a word, double click on it,
to select all the characters on a line, CTRL-click on it,
to extend a select region, SHIFT-click either side of it,
move the text cursor to one end of the required region. Hold down SHIFT and use the cursor keys to select the required 

region.
press CTRL+L to select all characters in the line containing the text cursor,
press CTRL+A to select all characters in the text object,
click in the text to insert the cursor at the start of the region and SHIFT-click at the end of the required region.

Tips
When a region of text is selected, the Text Tool Infobar shows the attributes applied to the region.
A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it 

simple to apply fills and transparency to selected text regions.



Selecting point handles

To move, delete and change points on lines and shapes (point handles) you usually need to select the points.

What do you want to do?
Select a single point handle
Swap the selection of a point handle
Select several point handles
Deselect all point handles
Select all point handles
Cycle which points are selected



Selecting several objects

Xara X lets you select multiple objects. You can then, for example, move them all in one operation.
To select several objects

1. Choose the Selector Tool (see Tips).
2. Either:

drag to form a rectangle that encloses all the required objects. (This is often called "marquee-selection".) When you 
release the mouse button all the objects entirely contained within the rectangle will be selected. (See Tips.)

or click on the first object you wish to select and SHIFT-click on each subsequent object to swap it from not being selected 
to being selected.

Tips
SHIFT-clicking swaps the object under the mouse pointer between selected and not selected.
Marquee-selection: if you drag on an object this moves the object. To force drag-select rather than move, hold down 

SHIFT as you drag.
When creating animations: to select objects in multiple frames, click All Visible and All Editable in the Frame Gallery. See 

Frame Gallery for details.
When selecting navigation bars and rollovers we recommend using the Button & NavBar Tool. See Selecting navigation 

bar objects.

_______________

{button ,KL(`objects,selecting',0,`____No_Topics_Found',`')}    Related Topics



Selecting several point handles

Once you have selected a line or shape you can individually select point handles on it. Once you have selected them you can 
move them, delete them and smooth them.

To select several point handles
1. Select the lines or shapes (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Either:

Dragging creates a selection rectangle around the required point handles on the selected line or shape and selects them.
SHIFT-dragging around points toggles the selection of the point handles within the rectangle.

Tip
You can also select several points by individually swapping the selection of points. See Swapping the selection of point 

handles. This is an ideal way of selecting extra points.



Selecting text

What do you want to do ?
Select a whole text object
Select a line of text in text object
Select characters in a text object
Select part of a text object



Selecting text objects

This selects the entire text object.
To select a text object

Depending on which tool is currently selected, either:
In the Selector Tool, click on the text object.
In the Text Tool, click in the text object and press Escape.

Tips
When text is selected, the Text Tool Infobar shows the attributes applied to the region.
In the Text Tool you can also drag from the start of the text object to the end.



Selection Pop-up Menu

The selection pop-up menu is displayed when the pop-up menu is opened with the mouse pointer over an object. The menu offers 
a set of standard options for manipulating the current selection and a set of options specific to the object under the mouse pointer.

Line and Shape Pop-up Menu
QuickShape Pop-up Menu
Blend Pop-up Menu
Mold Pop-up Menu
Text Pop-up Menu
Bitmap Pop-up Menu

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Aspect Ratio Lock Button

This button on the Selector Tool Infobar locks the aspect ratio of the selected objects when you scale them using the corner 
selection handles. When the button is pressed in, the ratio is locked. When the button is pulled out, the height and width of the 
selection can be altered independently.

_______________

Related Topics

Scaling
Stretching



 Selector Tool - Dimensions Field

The Dimensions Field on the Selector Tool Infobar shows the dimensions of the selection. Its values alter dynamically if you scale 
or stretch the selection.

You can also resize the selection by:
Typing into the fields and pressing RETURN, 
Clicking the arrow buttons.

Note
If the Scale Line Widths button on the Selector Tool Infobar is pressed in, the values in these fields include the line width 

of objects.

_______________

Related Topics

Scaling
Stretching
Units overview



 Selector Tool - Edit Handles Button

This button on the Selector Tool Infobar enables and disables edit handles. With edit handles displayed you can use the Selector 
Tool to edit objects.

The Selector Tool offers the ability to do basic object editing but the more specialized Tools often offer more. For instance the 
QuickShape Tool can bend the edges of a QuickShape whereas the Selector Tool can only perform simple QuickShape editing.

Tip
You can swap the setting of this control using the 2 key on the main keyboard.

_______________

{button ,KL(`edit handles',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Fill Handles Button

This button on the Selector Tool Infobar enables and disables fill handles and fill arrows. When they are enabled you can use the 
Selector Tool to move fill handles on selected objects rather than being forced to choose the Fill Tool.

Tip
You can swap the setting of this control using the 3 key on the main keyboard.

_______________

{button ,KL(`fill handles',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Flip Buttons

The Flip buttons on the Selector Tool Infobar flip the selection either vertically or horizontally. Both horizontal and vertical flips 
reflect the selection about the transformation center. This usually passes through the center of the object unless it has been 
moved.

_______________

{button ,KL(`flipping',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - New Name Button

This lets you add a name to the selection. (Objects can have multiple names.) The name appears in the Name Gallery and you can use the Gallery to select objects or groups of objects that share a name. For more information see Naming objects.

_______________

{button ,KL(`Name Gallery',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Position Field

The Position field on the Selector Tool Infobar shows the coordinates of the bottom left corner of the bounding box of the selection 
relative to the bottom left corner of the page. It updates dynamically as you drag the selection.

You can also move the selection by:
Typing into the fields and pressing RETURN, 
Clicking the arrow buttons.

_______________

Related Topics

Moving objects
Units overview



 Selector Tool - Rotation Field

The Rotation field on the Selector Tool Infobar lets you rotate the selection. To rotate the selection:
Type a value in degrees into the field and press RETURN.
Click the arrow buttons.

Positive angles rotate the selection anti clockwise, negative angles clockwise. The rotation is centered around the transformation 
center. This is usually be in the center of the selection unless it has been moved.

_______________

{button ,KL(`rotating',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Scale Line Width Button

The Scale Line Widths button on the Selector Tool Infobar selects whether scaling the selection also scales the line widths 
(thickness). With the button pressed in, the thickness of the lines changes in proportion as you scale the selection. With the button 
pulled out, line widths are unchanged by scaling. Line widths are not altered when rotating, skewing or stretching objects.

Notes:
With this button selected, the values in the Dimensions fields include the line widths of objects. When deselected, the 

dimensions exclude the outline width.
This button also affects Snap to grid. With this button selected, the edges of lines snap to the grid. When deselected, the 

center of lines snap.

_______________

{button ,KL(`scaling',0,`____No_Topics_Found',`')}    Related Topics



 Selector Tool - Scaling Field

The Scaling field on the Selector Tool Infobar is used to scale the selection. Entering a value into the field and pressing RETURN 
scales the currently selected objects.

The Aspect Ratio Lock button to the right of the Scaling Field locks the aspect ratio of the selected objects. What this means is 
changing one of the scaling vales will change the other by an equal amount so the objects are the same shape. This lets you scale 
objects without distorting them. To scale just the width or height of the selection, turn aspect ratio off.

The scaling is centered around the transformation center. This will usually be in the center of the selection unless it has been 
moved.

_______________

Related Topics

Scaling
Stretching



 Selector Tool - Selection Handles Button

The Selection Handles button on the Selector Tool Infobar enables and disables selection handles. With selection handles 
displayed, you can rotate, scale, stretch and skew the selection by dragging the handles.

Tip
You can swap the setting of this control using the 1 key on the main keyboard.

_______________

Related Topics

Scaling
Stretching
Skewing
Rotating



 Selector Tool - Skew Field

The Skew field on the Selector Tool Infobar is used to skew the selection. To skew the selection:
Type a skew angle and press RETURN.
Click the arrow buttons to skew the selection.

Positive values skew the selection above the transformation center to the right. Negative values skew the selection above the 
transformation center to the right. The skew takes place along a horizontal line through the transformation center. This usually 
means a horizontal line through the center of the selection unless you have moved the transformation center.

_______________

Related Topics

Skewing



 Selector Tool - Rotate/Skew Mode Button

The Rotate/Skew Mode button on the Selector Tool Infobar controls the operation of the selection handles around the selection. 
When the button is pressed in, the selection handles are in Rotate/Skew mode and when the button is pulled out selection handles 
are in scale mode.

If selection handles are not enabled, pressing this button enables them and places them in Rotate/Skew mode.

Clicking on a selected object with the Selector Tool chosen will swap the selection mode between Rotate/Skew mode and Scale 
mode - this is usually easier than using the Rotate/Skew mode button.

Tip
You can swap the setting of this control using the 4 key on the main keyboard.

_______________

Related Topics

Scaling
Stretching
Skewing
Rotating



 Selector Tool - Transformation Center Grid

The Transformation Center Grid on the Selector Tool Infobar is used to move the transformation center. Clicking on one of the nine 
buttons moves the transformation center to the equivalent position on the selection. For example, pressing the central button 
moves the transformation center to the center of the selection.

The same effect can be achieved by CTRL-dragging the transformation center. This constrains the transformation center to one of 
the corners, the center of the edges or the center of the selection, whichever is closer to the mouse.

_______________

Related Topics

Rotating objects
Skewing objects
Flipping objects
Scaling objects



 Selector Tool    F2 or Spacebar or ALT+S
The Selector Tool is the primary tool in Xara X. It is used for selecting, rotating, moving, skewing, stretching, flipping and scaling 
objects as well as other editing.

The Selector Tool can display several types of handle:
Selection Handles, which are used to rotate, scale and skew objects.
Edit Handles, which can be used to edit the shape of objects.
Fill Handles, which can be used to edit fills within objects.

Selector Tool Infobar Controls

Selection Handles
Edit Handles
Fill Handles

Rotate/Skew Mode or Scale Mode
Transformation Center Grid

Position
Dimensions

Scaling
Aspect Ratio Lock

Rotation
Skew

Flip
Scale Line Widths
Create New Name

Selector Tool Operations

Switching selection handle mode

Selecting objects

Moving objects

Rotating objects

Scaling objects

Flipping objects

Enabling selection handles

Enabling edit handles

Enabling fill handles and fill arrows

Stretching objects

Skewing objects

Moving fill handles

Using the Selector Tool temporarily

Moving points on shapes and lines

Selecting point handles

Moving the transformation center

Movies

{button ,EF("XaraDemo.exe","SelHands.avi Selection Handles",1,`') } Using selection handles

{button ,EF("XaraDemo.exe","Select Selecting Objects",1,`') } Selecting objects

{button ,EF("XaraDemo.exe","SelInsid.avi Selecting Objects In Objects",1,`') } Selecting objects in objects

{button ,EF("XaraDemo.exe","SelUnder.avi Selecting Objects Under Objects",1,`') } Selecting objects under objects

{button ,EF("XaraDemo.exe","Moving Moving Objects",1,`') } Moving objects



Separation Properties Dialog Box

With this dialog box you can set options relating to the selected separation color. The Separation Properties dialog box is opened 
using the Properties button in the Separations Options.

Angle

This lets you specify the angle of the halftone screen for the color. Each separation requires a different angle to avoid moiré 
patterns in the printed output. Note that some imagesetters override this setting and use precisely calculated values to eliminate 
moiré patterns.

Frequency

Lets you specify the screen frequency for the color. Normally all the separations use the same frequency. Note that some 
imagesetters override this setting and use precisely calculated values to eliminate moiré patterns.

Print this ink

You may not want to print all the separations and this button lets you select whether to print this separation (ink color). It duplicates 
a check box. on the Separations Options.

Overprint this ink

This option is rarely useful. It lets you specify that everything in this ink color overprints underlying ink colors. See the Overprinting 
Overview for more information on overprinting. It duplicates a check box. in the Separations Options.



 Separations Options

To open the Separations Options, choose Print Options from the File menu and click on the Separations tab. These options are 
used when outputting to a PostScript printer and when producing color separations.

Use printer defaults/Use custom settings

This give you control over a PostScript printer. They are ignored for other types of printer. 

Selecting Use printer defaults uses the standard settings for the selected printer. Generally these give good results but you may 
want greater control. For this choose Use custom settings.

Selecting Use custom settings lets you configure the printer to suit your requirements. Note that no check is made on whether 
the settings you choose are suitable for the type of printer.

Target printer resolution

This is specified in dots-per-inch (dpi). For a local printer check the documentation supplied with the printer. For imagesetters and 
similar machines check with the service bureau.

Default screen frequency

This is specified in lines-per-inch (lpi). Tints of the basic ink color are printed as small dots called 'Halftone dots'. The dots are 
arranged in rows and the number of rows to the inch is the 'screen frequency' (or just 'screen'). The lower the screen frequency, 
the larger the individual halftone dots and the more noticeable they are. For example, the individual dots are noticeable in the 60 
lpi coarse screen often used on desktop printers.

For outputting to a typesetter check with your print shop. They can tell you the best frequency to use for the type of job. For 
example, if they require a '120 line screen' set the screen frequency to 120 lpi.

Screen/dot type

PostScript printers can print halftone dots in a variety of shapes. Generally round dots give the best results but some printing 
processes work better with a different dot shape.

Print color separations

If you want to print all the colors in one pass through the printer, unselect Print color separations. (This full color output is 
referred to as a 'composite output'.)

If you want to produce output separated into the CMYK process colors and any spot colors, select Print color separations. You 
can now set options for the individual separations.

To output a separation for an ink color, select the left-hand check box.

To set an ink color to overprint, select the right-hand check box.

To change the screen angle and frequency, click on the ink name to select it then click Properties. For details on the Properties 
dialog box, click the Help button in it.

Print spot colors as process colors

Desktop printers and some printing processes can only print process colors. Select this option to print any spot colors as their 
equivalent CMYK color. Note that some colors look very different when output as CMYK. The main use of this option is when 
checking your drawing.

When this option is selected, all spot colors will appear as squares (rather than circles as they normally appear) in the Color 
Gallery and Color Editor and on the Color Line.



Setting a scale factor

You can create a document using a scale factor so all measurements are scaled when they are shown on the screen. For 
example, if you create a document on a page which is 21cm across and use a scale factor of 1:100 (1 centimeter on the page is 
shown as a meter) the measurements you see on the Status Line and Selector Tool Infobar will range from 0 to 2100cm. Using a 
scale factor is ideal for drawing scaled drawing like maps.

To set a scale factor
1. From the Utilities Menu, choose Options.
2. Click the Scaling tab.
3. Click the Use Scale Factor option.
4. Enter the scaling values.

Tips
You can define your own units. See Creating a custom unit.



Setting current attributes from an object

You can set the current attributes so they are the same as an object. This is an easy way to create multiple similar objects.
To set the current attributes from an object

1. Copy the object to the clipboard.
2. Deselect all objects.
3. Choose Paste Attributes from the Edit menu to set the current attributes to those used by the object on the clipboard.

Tip
If you want to set the attributes for text, choose the Text Tool first.

_______________

{button ,KL(`current attributes',0,`____No_Topics_Found',`')}    Related Topics



Setting document options

This lets you change the options for documents loaded in Xara X.
To set document options

1. From the Utilities menu, choose Options. See Options for details on the settings available.
2. Change the options as required.
3. Save the document.

Tip
Some of the options in the Options dialog box refer to a specific document and some are general options which apply to 

the program. The ones that apply to the document have the document name written above them.



Setting program options

Program options affect how Xara X works.
To set program options

1. From the Utilities menu, choose Options. See Options for details on the settings available.
2. Change the options as required.

Tip
Some of the options in the Options dialog box refer to a specific document and some are general options which apply to 

the program. The ones that apply to a specific document have the document name written above them.



Setting the color model for local colors

You can change which color model the Color Editor uses when you edit local colors.
To set the color model for local colors

1. From the Utilities Menu, choose Options.
2. Click the View tab.
3. In the Edit Local Colors In section, select a color model from the drop-down list.

_______________

{button ,KL(`color editor overview',0,`____No_Topics_Found',`')}    Related Topics



Setting the current attributes

When you create a new object in your drawing, it uses the 'current attributes'. So, for example, if the current attributes include a 
thick green outline and blue fill color, each new object you draw will appear with these attributes. If you want to draw several 
objects with very similar attributes, you can change the current attributes before you start so all the objects appear with similar 
characteristics. For more information about attributes, see the Attributes Overview.

Because you will rarely need the current attributes to apply to both text and other object types, text has its own current attributes. 
For example, if you change the current attributes to include a white fill, you probably don't want all your text to appear white.

To set the current attributes
Either:

deselect all objects (see Deselecting all objects) and change the attribute. e.g. select a new line width.
or use drag-and-drop to drop the attribute onto an empty part of the page.
To set the current text attributes

1. Choose the Text Tool.
2. Either:

deselect all objects (see Deselecting all objects) and change the attribute. e.g. select a new font.
or use drag-and-drop to drop the attribute onto an empty part of the page.

For example if you want all text to appear at 48pt, ensure there are no objects selected, choose the Text Tool and change the point 
size to 48. If you want text to appear in green, choose the Text Tool and drag green onto the page.

Tip
You can set the program up so each new object uses the attributes from the previous object you changed. So for example 

if you draw a rectangle and fill it with green, the next object you draw will be green. To change the program in this way, choose Give 
New Objects Most Recent Attributes in the General Options (see General Options).

_______________

Related Topics

Setting attributes from an object
Pasting attributes from the clipboard



Setting the current layer

When you create new objects, they are created in the current layer. Note that only Drawing documents use layers - see layers and 
frames for more details.

To set the current layer
1. From the Utilities menu, choose Layer Gallery.
2. Click on the layer.

_______________

{button ,KL(`layers',0,`____No_Topics_Found',`')}    Related Topics



Setting the length and angle of a straight line segment

When you have drawn a line or shape that includes straight segments, you can set the angles of these segments exactly.
To set the length and angle of a segment

1. Select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Select the point handle on one end of the segment.
4. Enter the angle and length into the fields on the Shape Editor Tool Infobar.
5. Press RETURN.



Setting the size of buttons

Buttons on the Toolbar, Infobar and control bars can be small or large. Use the size you prefer.

  

To set the size of buttons
1. From the Window menu, choose Control Bars.
2. At the bottom of the dialog box, select which bars should have large buttons:

Top
Bottom
Left
Right
Floating

Tip
The Floating option also applies to the buttons in the galleries. If you want larger buttons in the galleries, select this 

option.



 Shadow Tool - Profile
This controls the transparency transition between the semitransparent center of the shadow and fully transparent edge of the blur. 
For more information, see Changing the shadow profile.

_______________

{button ,KL(`shadows',0,`____No_Topics_Found',`')}    Related Topics



 Shadow Tool - Shadow Blur

This slider controls the size of the penumbra around the edge of the shadow. The outer edge is totally transparent; the 
Transparency slider controls the transparency of the inner edge.

Either drag the slider or, for precise adjustment, type into the text box.

_______________

{button ,KL(`shadows',1,`____No_Topics_Found',`')} Related Topics



 Shadow Tool - Shadow Transparency

The slider and text box to the right control the transparency level of the umbra (center) of the shadow. (This is how much of the 
background shows through.) The outer edge of the shadow is always totally transparent.

Either drag the slider or, for precise adjustment, type into the text box.

The shadow is always more transparent than the object casting the shadow. For example if the object is 50% transparent, then the 
shadow can be 50% to 100% transparent.

_______________

{button ,KL(`shadows',1,`____No_Topics_Found',`')} Related Topics



 Shadow Tool - Shadow Type

The buttons let you apply or change the type of shadow.
None - remove any existing shadows from the selected objects.
Wall - a shadow thrown onto a vertical surface.
Floor - a shadow thrown onto an angled surface.
Glow - the shadow is immediately behind the selected object. Choosing a suitable color for the shadow lets you create a 

glowing surround or halo effect to the objects. See Creating a glow effect.

_______________

{button ,KL(`shadows',1,`____No_Topics_Found',`')} Related Topics



 Shadow Tool - X-Y

Dimmed except for Wall shadows.

These two fields let you move a wall shadow vertically or horizontally relative to the object producing the shadow. Either type in 
values or click the arrow buttons to the right of the text boxes. This control is dimmed for Glow shadows (because the shadow 
position is fixed) and for Floor shadows (because these always touch the object).

_______________

{button ,KL(`shadows',1,`____No_Topics_Found',`')} Related Topics



 Shadow Tool Overview    CTRL+F2
This tool lets you apply, remove, and modify semitransparent (or "soft") shadows. The transparency of soft shadows increases 
towards the edges, which gives a very realistic effect. Shadows are resolution independent so you can scale them without losing 
quality. 

Shadow Tool Infobar controls:

Shadow Type
 Shadow Blur
 Shadow Transparency

Profile

X-Y

Tip:
Applying a shadow to several objects: 
If the objects are grouped, overlapping shadows merge (they do not get darker if they overlap).
If the objects are ungrouped, each object has a separate shadow. Overlapping areas of shadow are darker.

Movies

{button ,EF("XaraDemo.exe",`Shadows Using Shadows',1,`') } Using shadows

Shadow Tool operations:
Applying a shadow
Removing a shadow
Modifying a shadow
Changing the shadow color
Creating a glow effect
Selecting objects using the Shadow Tool



Shadow Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a shadow, it contains the following options:
Shadow Tool
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate
Clone
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Break Button

 B

The Break button on the Shape Editor Tool Infobar 'breaks' the selected line(s) or shape(s) at each of the selected point handles.

Breaking a shape forms a line and breaking a line forms two lines.

_______________

{button ,KL(`line,breaking',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Curved Lines Button

This button is on the Shape Editor Tool Infobar. If no point handles are selected, it sets the default line type to curved lines. The 
next line segment you draw will be curved.

If a number of point handles are selected (see Selecting point handles), this button will change all the connecting line segments to 
curves. Only those line segments with both point handles selected change - any line segment with only one point handle selected 
does not change.
 C

Note

The keyboard shortcut only works when the Shape Editor Tool is the current tool.

_______________

Related Topics

Drawing lines
Drawing shapes



 Shape Editor Tool - Delete Points Button

This button on the Shape Editor Tool Infobar deletes all selected point handles. If only one point handle is left after the delete 
operation, the entire line or shape will be deleted.
 DEL (Delete)

Note

The keyboard shortcut only works when the Shape Editor Tool is the current tool - normally Delete deletes all the objects selected.

_______________

Related Topics

Deleting points on lines and shapes



 Shape Editor Tool - Mode Indicator

This indicator on the Shape Editor Tool Infobar shows the current state of the tool. It shows:

New:

No point handles are selected, click to start a new line or shape.

Add:

An end point handle is selected. 
Click away from the line to extend the line, 
Click on the line to add a new point handle,
Click on the other end point handle to close the shape.

Change:

An intermediate point handle or several point handles are selected. Click away from the line to start a new line or click on the line 
to add a new point handle.

_______________

{button ,KL(`tools,shape editor tool',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Parameter Fields

The parameter fields on the Shape Editor Tool Infobar display information about the currently selected point handle, the fields are 
blank if more than one point handle is selected.

Left Hand Field

This field displays:
The co-ordinate of the previous curve handle, if the previous segment is a curved line.
The length and angle of the previous segment, if it is a straight line.

Center Field

This field displays the coordinates of the selected point handle.

Right Hand Field

This field displays:
The co-ordinate of the next curve handle, if the previous segment is a curved line.
The length and angle to the horizontal of the next segment, if it is a straight line.

One point handle is 'previous' to another if it is nearer the start of the line.

_______________

Related Topics

Units overview



 Shape Editor Tool - Reverse Path Button

This button on the Shape Editor Tool Infobar reverses the direction of the selected line. (So the start of the line becomes the end 
and vice versa.) Note that the shape of the line does not change, just its direction. Reverse Path has two uses:

When you have an arrowhead applied, you can quickly move it to the other end of the line.
To reverse the direction of a brush stroke; some brush strokes are 'directional' and this lets you reverse that direction.

______________

{button ,KL(`tools,shape editor tool',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Sharp Point Button

This button on the Shape Editor Tool Infobar changes all the selected point handles into sharp (cusp) corner points with 
independently controllable curve handles (not smooth points).

If no point handles are selected it sets sharp points as the default.

Clicking this button retains the existing line shape. CTRL-clicking reshapes the line to show a sharp join.
 Z

Note

The keyboard shortcut only works when the Shape Editor Tool is the current tool.

______________

{button ,KL(`tools,shape editor tool',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Smooth Point Button

This button on the Shape Editor Tool Infobar changes all the selected point handles into smooth points (not corner/cusp points). If 
no point handles are selected it sets smooth points as the default.
 S

Note
The keyboard shortcut only works when you are using the Shape Editor Tool.

_______________

{button ,KL(`point handles',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Smoothing Slider

The Smoothing slider on the Shape Editor Tool Infobar smoothes (simplifies) the currently selected line(s) by removing points 
(see Selecting point handles) and altering the shape of the remaining line to match the original shape as closely as possible.

It is similar to the auto-reduce feature found in CorelDRAW.

Note

The smoothing slider is dimmed when no point handles are selected.

_______________

{button ,KL(`line,smoothing',0,`____No_Topics_Found',`')}    Related Topics



 Shape Editor Tool - Straight Lines Button

This button is on the Shape Editor Tool Infobar. If no point handles are selected, it sets the default line type to straight lines. The 
next line segment you draw will be straight.

If a number of point handles are selected (see Selecting point handles), this button will change all the connecting curved line 
segments to straight lines. Only those line segments with both point handles selected change - any line segment with only one 
point handle selected does not change.
 L

Note

The keyboard shortcut only works when the Shape Editor Tool is the current tool.

_______________

Related Topics

Drawing lines
Drawing shapes



 
 Shape Editor Tool    F4
Unlike other drawing programs, Xara X combines the main shape or curve editing functions and line or shape creation facilities in 
this one tool. The Shape Editor Tool can be used to alter curves or straight lines, insert or delete points, smooth complex curves, 
cut lines, reshape curves and create new lines or shapes. It is often easier to use than the Pen Tool. and provides more accuracy 
than the Freehand & Brush Tool for drawing lines and shapes. To find out more about lines and shapes, see the Lines and Shapes 
Overview.

The Shape Editor Tool can also be chosen using the Line and Shape Pop-up Menu.

Shape Editor Tool Infobar Controls
Mode Indicator

Curved Lines

Straight Lines
Smooth Point
Sharp Point
Break
Delete Point
Reverse Path

Parameters
Smoothing

Shape Editor Tool Operations

Moving points on shapes and lines

Selecting point handles

Deleting points on lines and shapes

Adding points to lines and shapes

Smoothing a line or shape

Joining lines

Breaking a line or shape apart

Adding points into a line or shape

Altering point handles

Changing curved lines and shapes

Drawing a line with the Shape Editor Tool

Drawing a shape

Extend a line with the Shape Editor Tool

Setting the length and angle of a straight line segment

Smoothing lines and shapes

Movies

{button ,EF("XaraDemo.exe","CurvDraw.avi Drawing Lines and Shapes with the Shape Editor Tool",1,`') } Drawing lines 
with the Shape Editor Tool

{button ,EF("XaraDemo.exe","CurvEdit Editing Lines and Shapes with the Shape Editor Tool",1,`') } Editing lines with the 
Shape Editor Tool

{button ,EF("XaraDemo.exe","Smooth Smoothing Lines and Shapes",1,`') } Smoothing lines and shapes



 Show Grid (Window Menu)    #

Show Grid sets whether or not the grid is displayed. A check next to the option denotes that the grid is shown. For more details, 
see Displaying the grid.

_______________

{button ,KL(`grid',0,`____No_Topics_Found',`')}    Related Topics



 Show Guides (Window Menu)    Numeric Keypad 1

Show Guides displays or hides the guides layer which contains all guidelines and guide objects. Show Guides is a quick way to 
change the visibility setting of the guides layer in the Layer Gallery. For more information on guides, see Guidelines and Guide 
Objects Overview.

Note
Selecting this option affects the guides only in the current document.

_______________

{button ,KL(`guides;layers,layer gallery overview',0,`____No_Topics_Found',`')}    Related Topics



 Show Print Borders (Window Menu)

Most printers have a non-printing margin (the print border) around the edge of the paper. With Show Print Borders selected two 
rectangles are displayed on screen. One shows the extremes of the paper, the other shows the printable area. For more details on 
this option and what the print borders mean, see Displaying the print borders.

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



 Show Printer Colors (Window Menu)

Show Printer Colors displays the document on screen so it looks as close as possible to how it will look when you print it. For 
more information, see Displaying a document using the printer colors

_______________

{button ,KL(`printing',0,`____No_Topics_Found',`')}    Related Topics



Showing hidden buttons

If buttons on a control bar are hidden because the window has been scaled and obscured them or you are using a small graphics 
mode, you can:

Set the buttons to 'small' using the Control Bars dialog box (choose Control Bars from the Window menu).
Make the bar float by dragging it away from the window edges. See Moving and resizing control bars
Drag some of the buttons to a new bar. See Moving and copying buttons.



Showing library colors on the Color Line

You can display any of the palettes listed in the Color Gallery on the Color Line or turn off any you do not want to see on the Color 
Line.

To turn on/off a palette
1. From the Utilities menu, choose Color Gallery.
2. Right-click on the library of colors to open the pop-up menu.
3. Select or deselect Show In Color Line.

_______________

{button ,KL(`palettes;color gallery overview;color line',0,`____No_Topics_Found',`')}    Related Topics



Skewing objects

Objects can be skewed along their edges, along a line parallel to their edges passing through the center of the selected objects or 
along a line parallel to their edges passing through the transformation center, either using the mouse or, accurately, using the 
Selector Tool Infobar.

What do you want to do ?
Skew objects by dragging
Skew objects accurately



Skewing objects accurately

This method of skewing objects gives you precise control.
To skew objects accurately

1. Choose the Selector Tool.
2. Select the objects to be skewed.
3. Move the transformation center onto the required horizontal skew axis.
4. Either:

enter a skew angle (in degrees) in the Skew Field on the Selector Tool Infobar and press RETURN
or use the Skew field arrow buttons on the Infobar.

_______________

{button ,KL(`transformation center',0,`____No_Topics_Found',`')}    Related Topics



Skewing objects by dragging

1. Select the objects to be skewed (see Selecting objects).
2. Ensure the selection handles are in Rotate/Skew mode (see Switching selection handle mode).
3. Either:

drag the side selection handles to skew the object with opposite side used as a base line
or SHIFT-drag the side selection handles to skew the selection about its center.

Tips
The skew angle (see General Options) can be constrained by pressing CTRL during the drag.
To leave copies of the object as you skew it, drag as normal, but click the right mouse button where you want each copy 

(or press '+' on the numeric keypad).
To skew the object but not any fill applied to it, press NumPad ' - ' during the drag. This is useful if you want to skew an 

object with a bitmap fill without skewing the bitmap.



 Slice (cut) Shapes (Arrange Menu) (Ctrl+4)

This operation operates much like a pastry or cookie cutter. The object at the front of the selection is used as the cutter to slice 
through the other objects. If the front object is a line, you can slice objects in two. If the slice operation results in more than one 
shape, they will be grouped. For more details, see Slicing shapes.



Slicing shapes

Slicing a collection of objects uses the top-most object as a 'cutter' to slice all the objects under it. Note that Slicing images on 
export is a different operation.

To slice a shape
1. Select the objects.
2. On the Arrange menu, choose Combine Shapes then Slice Shapes (or press CTRL+4).

Tips
You can use with all object types including bitmaps.
If you use a line as the top object you can easily cut objects into pieces.
If you need to slice a line, it is easier to add a point to the line and use the Break button on the Shape Editor Tool Infobar. 

See Breaking lines and shapes apart.
If a line is used to cut an object, the end points of the line must both lie outside the object.

Movie

{button ,EF("XaraDemo.exe","Slice Slicing Objects",1,`') } Slicing objects

_______________

Related Topics

Combining

Moving objects backwards and forwards



Smooth when scaled up

When Xara X enlarges a bitmap it usually smooths (interpolates) between the individual pixels to give a smooth look to the bitmap. 
Usually this gives the best results. However you might not want this effect; in this case uncheck this option. Note that this option 
only affects scaled up bitmaps. Note also that Never smooth in the View tab of the Options dialog box overrides this check box.

The effect of enlarging a bitmap to 300%:

Top: Smooth when scaled up checked.

Bottom: unchecked.



Smoothing a freehand line

The slider on the Freehand & Brush Tool Infobar controls how accurately the final line follows your original mouse movements. At 
0%, the final line closely follows your original movements. This creates a line with many point handles. Higher percentages insert 
fewer point handles and produce a less accurate but smoother line.

Tips
You can smooth a freehand line at any time until you draw another freehand line. The Infobar shows Refit when 

smoothing is possible. 
You can always smooth a line or shape using the Smoothing Slider on the Shape Editor Tool Infobar, see Smoothing lines 

and shapes.

_______________

Related Topics

Freehand lines



Smoothing lines and shapes

You can remove unwanted points from lines by smoothing the line.
To smooth lines and shapes

1. Use the Selector Tool to select the line or shape (see Selecting objects).
2. Choose the Shape Editor Tool.
3. Select the points on the region of the line to be smoothed (or simplified). See Selecting point handles
4. Move the smoothing slider on the Shape Editor Tool Infobar.

Tip
Smoothing only alters selected points. Unselected points are never altered, so if there are areas of the line you do not 

want changed, just make sure the points in these areas are unselected.

_______________

Related Topics

Freehand & Brush Tool
Smoothing freehand lines



 Snap to Grid (Window Menu)    Numeric Keypad .

Snap to Grid sets whether or not objects drawn will automatically lock onto the grid in the document. If the option is selected, 
items will lock onto the grid. Snap to Grid is also available from the View Pop-up Menu. For more details on grid snapping, see 
Enabling grid snapping.

Tip
The key shortcut only works if NumLock is enabled on your keyboard.

_______________

{button ,KL(`grid',0,`____No_Topics_Found',`')}    Related Topics



 Snap to Guides (Window Menu)    Numeric Keypad 2

Selecting this option makes all objects in the guides layer magnetic. This includes all guidelines and guide objects. With the option 
set, dragging objects near guides will result in them snapping onto the guide - the mouse pointer shows a magnet when this 
happens. For more information, see Enabling guide snapping.

_______________

{button ,KL(`guides',0,`____No_Topics_Found',`')}    Related Topics



 Snap to Objects (Window Menu)    Numeric Keypad *

Selecting Snap to Objects enables object snapping. For more information, see Object Snapping Overview. Snap to Objects is 
also available from the View Pop-up Menu.

Tips
The key shortcut only works if NumLock is enabled on your keyboard.
You can press the * key on the keyboard to turn object snapping on and off as you drag objects.

_______________

{button ,KL(`object snapping',0,`____No_Topics_Found',`')}    Related Topics



Spacing buttons on control bars

On the control bars, some buttons are right next to each other, but some are separated by small spaces. You can space any of the 
buttons and controls on the control bars like this.

To space buttons on a control bar

ALT-drag the button a small distance away from the button next to it.



Standard Control Bar

New drawing document

New animation document
Open
Save
Delete

Undo

Redo
Zoom Magnification

Previous Zoom
Zoom To Drawing

Line Width
Quality

Snap to Objects

_______________

{button ,KL(`control bars',0,`____No_Topics_Found',`')}    Related Topics



Status Line (Window Menu)

With Status Line on the Bars submenu of the Window menu you can turn the Status Line on and off. Normal mode and full screen 
mode store this setting separately, so you could have the Status Line enabled in normal mode, but not in full screen mode. The 
settings are saved when you exit the program.

_______________

{button ,KL(`status line',0,`____No_Topics_Found',`')}    Related Topics



Status Line Overview

The Status Line shows you what objects you have selected and described what you can do next. If you perform a longer 
operation, the Status Line will show you its progress. It also shows the mouse position and contains an indicator to help you use 
object snapping. You can change the size of the Status Line using the Control Panel (see Customizing the appearance of the 
program).

The Status Line is an ideal companion to learning how to use Xara X.

Mouse Position

The current position of the mouse pointer in the document relative to the bottom left-hand corner. The units used to show the 
mouse position are the page units. For details of how to change them, see Changing the page units.

Snapping Indicator

This indicator only functions when you are using object snapping or guide snapping. When the handle currently being dragged 
snaps onto an object or a guide this indicator shows a red magnet (in addition to a magnet appearing on the mouse pointer). For 
more details, see the Object Snapping Overview.

_______________

{button ,KL(`status line',0,`____No_Topics_Found',`')}    Related Topics



Straightening curved line segments

You can change the segment of a line between two adjacent point handles in a straight line.
To straighten a curved line segment

1. Select the line or shape (see Selecting objects).
2. Select the two point handles on either side of the curved segment (see Selecting point handles).
3. Choose the Shape Editor Tool.
4. Click the Straight Lines button on the Shape Editor Tool Infobar.

Tips
You can select several line segments and change them in one operation. 
Both point handles must be selected. If only one is selected, the segment doesn’t change.



Stretching or squashing ellipses

You can easily stretch or squash ellipses.
To stretch or squash an ellipse

1. Select the ellipse (see Selecting objects).
2. Choose the Ellipse Tool or the QuickShape Tool.
3. Drag a handle to stretch the ellipse relative to the opposite handle.

Tips
You can also use the Selector Tool - see Stretching or squashing objects.
You can use the drop-down list on the Ellipse Tool Infobar or the QuickShape Tool Infobar. Choose Width and Height 

from the list and change the values in the fields on the right.



Stretching or squashing objects

You can stretch or squash objects by either scaling them in one direction or skewing them.

What do you want to do?
Scale objects in one direction
Skew objects



Stretching or squashing rectangles

You can easily stretch or squash rectangles.
To stretch or squash a rectangle

1. Select the rectangle (see Selecting objects).
2. Choose the Rectangle Tool or the QuickShape Tool.
3. CTRL-drag a corner handle in the direction you want to stretch or squash the rectangle.

Tips
You can use the Selector Tool. See Stretching objects.
You can also use the drop-down list on the Rectangle Tool Infobar or the QuickShape Tool Infobar. Choose Width and 

Height from the list and change the values in the fields on the right.



 Subtract Shapes (Arrange Menu) (Ctrl+2)

Discard those areas of the selected objects covered by the front object and remove the front object. The front object may be a 
group for more complex cut-outs. This operation is the 'opposite' of Intersect shapes. If the subtract results in more than one 
shape, they will be grouped. For more information see Subtracting shapes.



Subtracting shapes

Subtracting objects removes a section of the underlying objects using the outline of the top-most object.

To subtract a shape
1. Select the objects (see Selecting objects).
2. On the Arrange menu, choose Combine Shapes then Subtract Shapes (or press CTRL+2).

Tips
You can use with all object types including bitmaps.

Movie

{button ,EF("XaraDemo.exe","SubShape Subtracting Objects",1,`') } Subtracting objects

_______________

Related Topics

Combining

Moving objects backwards and forwards



Swap between inside and outside contour

Contours can be either inside or outside of objects. (Outside contours make the objects larger.)
To swap the contour direction

1. Select the contoured object (see Selecting objects). (See Notes.)
2. Choose the Contour Tool.
3. Either

drag any of the eight handles that surround the selected objects (drag the handles inside or outside the objects to swap) 
or click the Inner or Outer contour buttons.

Notes
You can also use the Contour Tool to select objects - more details.
Dragging the handles also resizes the contour. Clicking the button keeps the existing size.
If you have several contoured objects selected, any changes apply to all the contours.

_______________

Related Topics

Contours
Contour Tool



Swapping the selection of point handles

You can swap a point handle on a line or shape between being selected and not selected.
To swap the selection of point handles

1. Choose the Shape Editor Tool or the Pen Tool (you can also use the Selector Tool - see tip).
2. SHIFT-click on a point handle on the selected line or shape. If selected the point is deselected, if not selected, the point is 

selected.

Tips
You can also use the Selector Tool to swap the selection of point handles if you have enabled edit handles. See Enabling 

edit handles.

_______________

Related Topics

Point handles



Switching selection handle mode

Selection handles allow basic manipulation of the selected objects. They are enabled using the Selection Handles Button on the 
Selector Tool Infobar (see Enabling selection handles). They operate in two modes, Scale Mode and Rotate/Skew Mode. The 
former allows the selection to be scaled and stretched and the latter allows it to be rotated and skewed.

To swap selection handle mode
Click the Rotate/Skew Mode Button button on the Selector Tool Infobar
or click on one of the objects in the selection.
or choose the Selector Tool and press the 4 key on the main keyboard.

_______________

{button ,KL(`selecting,selection handles',0,`____No_Topics_Found',`')}    Related Topics



Switching to full screen mode

Full screen mode gives you the maximum possible area for the editing window. It does this by using different setting for the display 
of bars, the Status Line, Color Line and scrollbars. In full screen mode the title bar and the menu bar are not visible.

To switch to full screen mode

From the Window menu, choose Full Screen to switch to full screen mode and back.

Tips
The bars settings and the states of the scrollbars, Color Line and Status Line can be different for each mode.
If the scrollbars are disabled, you can use the Push Tool to move around the document. See Moving the page.
You can change to full screen mode quickly by pressing 8 on the numeric keypad (if NumLock is enabled).
All the galleries are closed when you switch modes.
To make the menu bar visible, move the pointer to the top of the screen.
For details on what you can do to increase the area of the screen available to show your drawing, see Increasing the 

available work area.
If you turn off the scrollbars, color line, status line, rulers and all the control bars, you can use full screen mode as a full 

screen viewing mode.

Movie

{button ,EF("XaraDemo.exe","FullScrn.avi Full Screen Mode",1,`') } Using full screen mode



TARGA Export Dialog Box

The TARGA export bitmap dialog box is opened by selecting TrueVision TARGA as the exported file format from the Export dialog 
box. It allows the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the 
bitmap. When a TrueVision TARGA file is saved to disk, the file name will end with TGA. For details of how to create a TARGA file, 
see Creating TARGA files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



TIFF Export Dialog Box

The TIFF export bitmap dialog box is opened by selecting TIFF as the exported file format from the Export dialog box. It allows the 
setting of the size/resolution of the exported bitmap, the area to be exported, the number of colors in the bitmap and the bitmap 
compression. For details of how to create a TIFF file, see Creating TIFF files.

Bitmap Size and Resolution
Color Depth
Area to Save
Compression
Palette
Dithering



Technical Support

We hope you don't have any problems when using Xara X but if you do please contact our Technical Support.

email: support@xara.com

mail: Technical Support
Xara Ltd.
Gaddesden Place
Hemel Hempstead
HP2 6EX
United Kingdom

Phone: +44 1442 35 00 00 (09:00-17:00 UK time, 10:00-18:00 CET, 04:00-12:00 EST)
Fax: +44 1442 35 00 10 (24 hours)

For the latest information see our web site:

www.xara.com 

Related Topics

Before calling Technical Support



Before calling Technical Support

Please have the following information available before calling Technical Support. This will assist the Technical Support 
representative to help you more quickly and efficiently.

A brief description of the problem, including the exact text of any error messages received, and the steps necessary to 
recreate the problem.

The type of computer, monitor, pointing device (for example, mouse, tablet), printer, and video card (display adapter) in 
use.

The version of Microsoft Windows in use. Choose the About Windows command from the Help menu in Explorer to find 
which version of Windows you are running.



Text Overview

You can create text objects in several different forms. Each is a little different, though they all work in much the same way.

Simple Text

This is the original form of text in early versions of the program. With it you can create single or multiple line text blocks. For more 
details, see Creating simple text.

Column Text

This is identical to simple text, but with the added benefit that you set the width of the text block when you create it and the words 
wrap onto the next line when each line is full. You can change the length or angle of the text block at any time. For more details, 
see Creating column text.

Text on a Curve

Text on a curve works just like column text, but the text follows the curve of a line. For more details, see Fitting text to a curve.

Movies

{button ,EF("XaraDemo.exe","Text Entering Text",1,`') } Entering text

{button ,EF("XaraDemo.exe","EditText Editing Text",1,`') } Editing text

{button ,EF("XaraDemo.exe","TextFun Advanced Text",1,`') } Advanced text

{button ,EF("XaraDemo.exe",`TextCtrl More on the Text Tool',1,`') } More on the Text Tool

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Text Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a text object, it contains the following options:
Text Tool
- - - - - - - - - -
Reverse text on curve
- - - - - - - - - -
Print text as shapes
- - - - - - - - - -
Cut
Copy
Paste
- - - - - - - - - -
Delete
Duplicate (see note)
Clone (see note)
- - - - - - - - - -
Convert to Editable Shapes
Create Bitmap Copy
Combine Shapes
- - - - - - - - - -
Imagesetting
- - - - - - - - - -
Web Address
Color Editor

Note: Duplicate and Clone may be dimmed when you have a selected region. Xara X cannot duplicate or clone objects that are 
within other objects (for example. within a text story).

_______________

{button ,KL(`pop-up menus',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Aspect Ratio Field

This field on the Text Tool Infobar shows the aspect ratio of text. 100% is a 1:1 aspect ratio. For information on how to change the 
aspect ratio of text, see Changing the aspect ratio of text.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Automatic Kerning

Kerning alters the horizontal space between two adjacent characters. Select this button to use the "kerning pair" information in the font for automatic kerning. For more information, see Kerning 
text.

Xara X also has Manual kerning.



 Text Tool - Baseline Shift and Manual Kerning

These two fields on the Text Tool Infobar are used to move characters either vertically (baseline shift) or horizontally (kerning).

Baseline Shift

Changing the baseline shift of text moves it vertically. See Changing the baseline shift of text for more information. You can type 
values into this field in any unit, e.g. "2cm".

Manual Kerning

Manual kerning spaces characters by placing an invisible 'kern' characters between them. Kerning is measured in ems. For more 
information, see Kerning text.

Xara X also has Automatic kerning.
 CTRL+ '+' Increase kerning (if the text cursor is present)
 CTRL+ '-' Decrease kerning (if the text cursor is present)

_______________

Related Topics

Units overview



 Text Tool - Bold Button

When this button on the Text Tool Infobar is depressed, the Bold attribute is applied to the text. For more information, see Making 
text bold.
 CTRL+B

Note

The keyboard shortcut only works when the Text Tool is the current tool.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Center Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is centrally aligned around the point 
where you started typing. For more information, see Justifying text.

Note

You can center justify text fitted to a curve.

_______________

{button ,KL(`column text',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Font Field

This field on the Text Tool Infobar shows the current text font (typeface). Choose from the drop-down list to change the font. Note 
that you can also apply fonts using the Font Gallery. For information on changing the text font, see Changing text font.

On the left-hand side of the font is an indicator which shows the format of the font:
Adobe Type Manager (ATM) Type 1
TrueType

If a font is listed with a ' * ' displayed next to it, this means the font required for the current document cannot be found. This may be 
due to it not being installed on your system or the font file being corrupt. It may be possible to solve this problem by reinstalling the 
font. See Installing fonts. For a full list of fonts used in a document, see Viewing document information.



 Text Tool - Font Size Field

This field on the Text Tool Infobar shows the current point size of text. For information on changing the size of text, see Changing 
the size of text. You can type values into this field in any unit, e.g. "2cm".

_______________

Related Topics

Units overview



 Text Tool - Full Justification Button

This button on the Text Tool Infobar sets the justification of column text or text along a curve. When it is depressed, text is justified 
fully between the ends of the line that the text has been fitted to. Full justification works by increasing or decreasing the spacing 
until the text fills the line. For more information, see Justifying text.

If you apply Full justification to text not fitted to a curve or non-column text, the text is left justified. 

_______________

{button ,KL(`column text',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Italic Button

When this button on the Text Tool Infobar is depressed, the Italic (slanted) attribute is applied to the text. For more information, see 
Making text italic.
 CTRL+I

Note
The keyboard shortcut only works when the Text Tool is the current tool.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Left Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is justified so that its left-hand edge 
is aligned with the point where you started typing. For more information, see Justifying text.

Note

You can left justify text fitted to a curve.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Line Spacing and Tracking

Line Spacing

This control on the Text Tool Infobar changes the spacing between lines in text objects. It always affects entire lines of text, so if 
you change the line spacing of a selected section of a text object, it will affect all the lines the selection covers. For more 
information, see Changing the spacing between lines of text

Tracking

This control changes the spacing between the characters (letters) in text objects. For more information about changing the 
tracking, see Changing the tracking of text.
 CTRL+ '+' Increase tracking (if a region is selected)
 CTRL+ '-' Decrease tracking (if a region is selected)

_______________

Related Topics

Units overview



 Text Tool - Right Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is justified to the right of the point 
where you started typing. For more information, see Justifying text.

Note
You can right justify text fitted to a curve.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 Text Tool - Superscript and Subscript Buttons

These buttons on the Text Tool Infobar set the superscript and subscript attribute to text., this results in text which is about half 
size. Subscript is the lower button and places the text at the bottom of the text line, whereas Superscript (the top button) places 
the small text at the top of the text line. For more information, see Making text superscript and subscript.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 

 Text Tool    F8
The Text Tool allows you to create text objects consisting of one or many lines of text which can be placed around a curve if 
necessary and alter existing text objects. The Text Tool Infobar shows the range of text attributes.

If there is a selected region of text, any change to a text attribute applies to that region.
Otherwise, the change applies at the text cursor. Start typing and the text appears with the changed attribute.

If there is a selected region of text, the Infobar shows the attributes that apply to the region. If multiple values for one attribute have 
been applied, the field is blank, for example if the selected region includes both 10pt and 12pt text, the Font Size field is blank. 
When the cursor is visible, the Infobar shows the attributes that will apply when you type a character.

The Text Tool can also be chosen using the Text Pop-up Menu.

Text Tool Infobar Controls
Font

Font Size
Aspect Ratio
Bold
Italic

Left Justification
Center Justification
Right Justification
Full Justification

Superscript and Subscript
Line Spacing and Tracking
Baseline Shift and Kerning

Automatic Kerning

Text Tool Operations

Creating new text

Editing text

Selecting text

Applying attributes to text

Fitting text to a curve

Creating column text

Changing molded text

Typing international characters

Changing text font

Changing the size of text

Changing the aspect ratio of text

Making text bold

Making text italic

Justifying text

Making text superscript and subscript

Changing the tracking of text

Changing the spacing between lines of text

Changing the baseline shift of text

Kerning text

List of Text Tool key shortcuts

Movies

{button ,EF("XaraDemo.exe","Text Entering Text",1,`') } Entering text

{button ,EF("XaraDemo.exe","EditText Editing Text",1,`') } Editing text

{button ,EF("XaraDemo.exe","TextFun Advanced Text",1,`') } Advanced text

{button ,EF("XaraDemo.exe",`TextCtrl More on the Text Tool',1,`') } More on the Text Tool



The Basics

With Xara X you create your documents using a set of tools. Each tool has a specific purpose so its easy to move between them. 
When you select a tool, the Infobar (a special control bar) changes to provide a set of options specific to the tool. This means your 
screen is never obscured by controls and options you do not need.

The Main Areas of Xara X
Bitmaps Overview
Colors Overview
Fills Overview
Attributes Overview
Galleries Overview
Tools Overview
List of Menus
Creating Navigation Bars
Guidelines and Guide Objects Overview
Lines and Shapes Overview
Object Snapping Overview
Pop-up Menus Overview
QuickShapes Overview
Transparency Overview
Internet bitmaps overview
Creating Animated GIFs overview
Units Overview
Printing Overview
Movies

Objects

These are the types of object supported by Xara X:
Lines and shapes
QuickShapes
Text
Mold
Blend
Group

Handles

Xara X uses handles to manipulate (rotate, change shape, etc) objects. There are several different types of handles:
Selection handles
Edit handles
Fill handles
Transparency handles
Mold handles



The Tools

Tools are the main method of drawing objects and editing your documents. When you choose a tool, it customizes the Infobar (see 
the Infobar Overview) to show information and controls relevant to that tool. For example, when you choose the Text Tool, the 
Infobar only shows text controls. The currently chosen tool defines which actions can be performed on the document. Click one of 
these buttons to choose a tool:
              Selector Tool  
              Freehand & Brush Tool  
              Shape Editor Tool  
              Pen Tool  
              Rectangle Tool  
              Ellipse Tool  
              QuickShape Tool  
              Text Tool  
              Fill Tool  
              Transparency Tool  

Shadow Tool

Bevel Tool

Contour Tool
              Blend Tool  
              Mold Tool  

Button & NavBar Tool
              Push Tool  
              Zoom Tool  

To remove a Tool button from the Toolbar, ALT-drag it and drop it away from the control bars. If you like you can copy or move Tool 
buttons to other control bars. See Moving and copying buttons and Removing and restoring buttons.



The program is running slowly

Problem

If you find Xara X is running slowly on your machine (particularly on an 8Mb machine when the current document contains 
transparent objects) you may like to fine-tune the configuration to ensure it makes full use of your machine's resources. For 8Mb 
machines, we recommend at least 20Mb of virtual memory swap space - 30Mb, or larger, if possible.

What Can I Do?

See Changing the program's memory requirements.



Timing redraw

You can easily time how long a document takes to redraw. This is useful for comparing the redraw speed of with other drawing 
packages.

To time redraw
1. Open the document. (See Opening documents).
2. Zoom in and move the document until it is at the required size and position. (See Zooming in and out.)
3. Press CTRL+SHIFT+T.

This redraws the document and then a dialog box appears showing the time taken for the redraw.

To make a fair comparison with other packages
Turn off anti-aliasing by setting the Quality slider to Normal and set the dithering method to Ordered dithering. This sets 

the screen display quality to be the same as other packages. See Changing the screen quality of documents.
Turn off background redraw. See Turning background redraw on and off.
Use a document that does not contain any transparent objects as documents containing them take a little longer to 

redraw.



Tip of the Day (Help Menu)

Choosing Tip of the Day from the Help menu opens the Tip of the Day dialog box containing a tip on how to use Xara X.

Tell Me More

Clicking this button will take you from the Tip of the Day dialog box to a page in the Xara X help which will explain the tip in more 
detail.

Next Tip

Clicking this button takes you to another tip.

_______________

{button ,KL(`tip of the day',0,`____No_Topics_Found',`')}    Related Topics



Tracing bitmaps

If you need to convert a bitmap into shapes, you can use the Bitmap Tracer to do it.
To trace a bitmap

1. Select the bitmap.
2. From the Utilities menu, choose Bitmap Tracer to open the Bitmap Tracer dialog box.
3. Set the values as appropriate.
4. Click the Trace button.
5. Click the Insert button to insert the set of shapes into the document.

Tips
To trace a bitmap quickly, right-click on it to open the pop-up menu and choose Bitmap Tracer.
For details of how all the settings in the dialog box affect the result, click the Help button.
If you do not get the image you want, see Bitmap Tracer Troubleshooting.
You can change the bitmap in the tracer using the drop-down list under the bitmap.

Movie

{button ,EF("XaraDemo.exe","Tracer Tracing Bitmaps",1,`') } Using the bitmap tracer



Transparency Overview

  

You can make any object transparent (including text and bitmaps) using the wide variety of transparency options available. 
Transparency can be used in two ways:

By create semi-opaque objects in your drawing. For example you can use transparency to simulate glass.
By overlaying parts of your drawing with additional objects. These additional objects are like filters or overlays to, for 

example, modify colors or contrast in your drawing.

You can use graduated transparency where the transparency changes across the object from one level of transparency to another.

Drawings containing transparent objects take a little longer to display on screen and to print.

You can use any of the following transparency shapes (click for more details) from the Transparency Tool:
Flat Transparency
Linear Transparency
Circular Transparency
Elliptical Transparency
Conical Transparency
Diamond Transparency
Three Point Transparency
Four Point Transparency
Bitmap Transparency
Fractal Cloud Transparency
Fractal Plasma Transparency

For details on how to use transparency, see the following pages:
Applying transparency
Changing transparency
Creating custom transparencies

If you don't want to see fill arrows and transparency arrows when dragging, press TAB when in the Fill Tool or Transparency Tool.

Movie

{button ,EF("XaraDemo.exe","Transpar Simple Transparency Effects",1,`') } Using transparency

_______________

{button ,KL(`transparency',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Bitmap Name Field

This field appears on the Transparency Tool Infobar for Bitmap Transparency only.

You can preview and select any of the bitmaps used in this document or, by clicking More, select from the fills in the Fill Gallery. 
More more information see Applying bitmap transparency.

_______________

{button ,KL(`bitmaps',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Bitmap and Fractal Transparency Resolution 
Field

This field is displayed on the Transparency Tool Infobar when the selection contains only bitmap/fractal transparencies and no 
transparency handles are selected.

Altering the value in the field changes the resolution of the bitmap/fractal fills in the selection by changing their size.

_______________

{button ,KL(`tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Fractal Transparency Grain Slider

This field only appears on the Transparency Tool Infobar when the selection contains only fractal transparencies and no 
transparency handles are selected.

Moving the slider changes the grain of the fractal fill(s). A low value gives a smooth, cloud-like pattern, a higher value gives a 
sharper, more 'grainy' texture.

_______________

{button ,KL(`tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Profile

The Profile field on the Transparency Tool Infobar lets you change the transition (gradient) between the start and end of the 
transparency.

This field is dimmed for    flat, three color and four color transparencies.

For more information see Changing the transparency profile.

_______________

Related Topics

Transparency Tool



 Transparency Tool - Transparency Shape Field

This field is always present on the Transparency Tool Infobar. It sets the transparency shape of the currently selected objects. For 
more details, see Changing transparency shape.

The options available are:
No Transparency
Flat Transparency
Linear Transparency
Circular Transparency
Elliptical Transparency
Conical Transparency
Diamond Transparency
Three Point Transparency
Four Point Transparency
Bitmap Transparency
Fractal Cloud Transparency
Fractal Plasma Transparency

_______________

{button ,KL(`tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Transparency Level Slider

You can alter the transparency level of the selected transparency handle (described on the left) by dragging the slider. As you move the slider, the transparency level of the handle changes interactively.

Tip

These controls are only displayed on the Transparency Tool Infobar for some types of transparency.

_______________

{button ,KL(`tools,transparency tool',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Tiling Field

This field appears on the Transparency Tool Infobar except for Flat and Conical transparency. (As these cannot tile.) 

With it you can change the tiling of the transparency.

_______________

{button ,KL(`tiling',0,`____No_Topics_Found',`')}    Related Topics



 Transparency Tool - Transparency Type Field

This field is on the Transparency Tool Infobar. It controls how the colors of the selected object affect the colors of underlying 
objects.

The options available are:
Mix
Stained Glass
Bleach
Contrast
Saturation
Darken
Lighten
Brightness
Luminosity
Hue

_______________

{button ,KL(`tools,fill tool',0,`____No_Topics_Found',`')}    Related Topics



 

 Transparency Tool    F6
With the Transparency Tool you can give objects levels of transparency using a wide variety of transparency shapes. It works in a 
similar way to the Fill Tool. For more information about transparency, see the Transparency Overview.

Transparency Tool Infobar Controls

Note that the Infobar shows only those controls relevant to the current Transparency Shape.
Transparency Shape

Transparency Type
Transparency Tiling
Bitmap Name

Profile
Transparency Level

Bitmap and Fractal Transparency Resolution
Fractal Transparency Grain

Transparency Tool Operations
Applying transparency
Changing transparency
Removing transparency
Using transparent lines

Notes
Using transparent objects in drawings may result in slower redraw and printing. Areas containing transparent objects are 

exported as bitmaps in EPS format.
Imagesetting: transparent objects always separate to CMYK. For more details, see Imagesetting points to note.

Movie

{button ,EF("XaraDemo.exe","Transpar Simple Transparency Effects",1,`') } Using transparency



Troubleshooting

Troubleshooters
Printing Troubleshooter
Imagesetting Troubleshooter
File Loading Troubleshooter
Bitmap Tracer Troubleshooter
Plug-ins Troubleshooter

Other Problems
Xara X is running slowly

If you experience a problem which cannot be solved by any of the above, it is possible you are suffering from a fault in Xara X. 
Please refer to Technical Support for details of how to report the problem.



 Tune-ups Options

To open the Tune-ups Options, choose Options from the Utilities menu and click on the Tune-ups tab. The Tune-ups options allow 
various settings to be changed which affect everyday Xara X use.

Redraw

for more information, see Changing the program's memory requirements.

Cache

When displaying items in some galleries, the program reads the information off disk into a cache to alleviate the need to load 
images as the gallery is scrolled. This option sets the number of items to be cached at any one time for each section. For more 
details, see Changing the gallery cache size.

Undo Size

This setting applies only to the selected document. The amount of undo (see Undo) information stored can be unlimited, or a value 
can be set for the maximum amount of space to be taken up by it. See Changing the undo size for more information.



Turning Tip of the Day on and off

When you start Xara X the Tip of the Day dialog box appears showing a tip on how to use the program. If you do not want to see 
Tip of the Day every time you start Xara X, you can turn it off.

To turn Tip of the Day off
1. When the Tip of the Day dialog box appears, deselect the Show tips on startup option.

To turn Tip of the Day on
1. From the Help menu, choose Tip of the Day.
2. Select the Show tips on startup option.



Turning background redraw on and off

You can change the way your documents are redrawn by the program. If background redraw is on, the program redraws your 
document on the screen in slices, one after another. If background redraw is off, the drawing will be redrawn in one go. Although 
using the Xara X with background redraw off is faster, it is usually preferable to leave it on as you can alter your drawing before it 
has been completely redrawn.

To turn background redraw on and off
1. From the Utilities menu, choose Options.
2. Click the View tab.
3. Click the Background Redraw option.



Typing international characters

Xara X includes shortcuts for the following special characters. The characters are entered in the Text Tool by first pressing CTRL 
along with a modifier, releasing both keys and then pressing the letter to which the modifier should be applied. The CTRL-
character key press is called a 'dead-key'. So, for example, to enter an õ, you would hold down CTRL, type a ~ (usually SHIFT+#), 
release CTRL and then press o.

    To produce                            Press

Notes
You can also type in these characters if you know the character number. (Many books list the Windows character set and 

corresponding numbers.) Hold down ALT and type the number on the numeric keypad.
Some keyboards (for example Portugal, German) do dead keys already. Xara X does not affect this.
Some keyboards require you to press CTRL to get an accent character (for example to enter the ' for an è). If your 

keyboard does this, it should provide another way for you to enter international characters.
If you wish to disable this system and you know how to edit the registry, change 

HKEY_CURRENT_USER\Software\Xara\Xara X\Version XX\Options\TextTool\UseDeadKeys (where XX is the version you are 
using) from "1" to "0".

If you are in a country with a keyboard that does not have one of the required keys (for example Portugal does not have a 
^) you must enter the character using ALT+<character number> or use CharMap or a similar program.

_______________

{button ,KL(`tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



Typing text onto a curve

You can create a text object by typing directly onto a line or shape. This is a useful alternative to typing in the text and then fitting it 
to the line.

To type text onto a curve
1. Select a line or shape.
2. Choose the Text Tool.
3. Click on the line or shape. CTRL-click to start the text at the beginning of the line.
4. Type the text. When the text cursor reaches the end of the line, it wraps onto a new line underneath. If you are typing the text 

onto a shape, it will wrap around the line again.
When you click, two handles appear on the line or shape that show the width of the text. The text wraps within this width, just like 

column text.

Tips
Text will always follow the direction in which the curve was drawn. You can reverse the line direction if required. 

Alternatively use the flip buttons in the Selector Tool to flip the line.
If you do not want text wrapping (you want the text continuing off the end of the line), SHIFT-click on the line. This inserts 

a kern character at the beginning of the line.
Text around a curve can be edited and selected as normal. The text cursor follows the path of the curve.
You cannot type onto a QuickShape (including ellipses and rectangles). Either:
(a) type in the text then use fit text to curve 
or (b) convert the QuickShape to an editable shape before clicking on it.

_______________

{button ,KL(`text objects,fitted to curves;tools,text tool',0,`____No_Topics_Found',`')}    Related Topics



 
 Undo and Redo (Edit Menu)    CTRL+Z and CTRL+Y

Undo

Any changes you make to a document can be undone. The recorded undo information is not saved with the document and so, if 
you save a document and later reload it you will no longer be able to undo changes you made before the Save.

Redo

At any time when you have Undone some changes you can choose to redo them again. This is very useful because it gives you 
the ability to change your mind about an edit as many times as you like.

Undo and Redo always show a brief description of what will be undone or redone. For example "Undo Delete".

Tips
Except when using the Text Tool, you can also use the < and > keys to Undo and Redo.
The number of steps you can undo depends on the memory that was available to record them (see Tune-ups Options). 

_______________

{button ,KL(`undo',0,`____No_Topics_Found',`')}    Related Topics



Undoing and redoing operations

As you make changes to your drawing you can undo them to return to an earlier stage. You can also redo changes which you have 
undone.

To undo and redo operations
1. Select the document where you want to undo or redo operations.
2. From the Edit menu, choose Undo or Redo.

Tip
However far you go back through undo steps, as soon as you edit the document yourself you will no longer be able to 

redo any of those steps.



 Ungroup (Arrange Menu)    CTRL+U

Ungroup separates all selected groups into their constituent objects. For more details, see Ungrouping objects or Grouping 
objects.



 Ungroup Transparency (Arrange Menu)

Group Transparency lets you overlay transparency. This menu option separates objects previously grouped using Group 
Transparency. For more details, see Using Group Transparency and Removing Group Transparency.



Ungrouping objects

This separates objects currently joined as a group.
To ungroup objects

1. Select the group.
2. From the Arrange menu, choose Ungroup.

Tips
If you want to change an object inside a group, you do not need to ungroup it. See Selecting objects in objects.

Movie

{button ,EF("XaraDemo.exe","Groups Grouping Objects",1,`') } Grouping objects

_______________

{button ,KL(`groups',0,`____No_Topics_Found',`')}    Related Topics



Unit Properties Dialog Box

Unit Name
Abbreviation
Prefix or Suffix
Unit Definition

_______________

{button ,KL(`units',0,`____No_Topics_Found',`')}    Related Topics



Unit Properties Dialog Box - Abbreviation

This is the abbreviation used for the unit, for example n.m., US$, dm.



Unit Properties Dialog Box - Prefix or Suffix

Prefix. If this option is set, the abbreviation is shown before the numeric measurement, for example £14.

Suffix. If this option is set, the abbreviation is shown after the numeric measurement, for example 12n.m.



Unit Properties Dialog Box - Unit Definition

Is Equivalent To. These three fields are used to define the size of the new unit in terms of one of the existing units. For example, 
for nautical miles you would fill the fields to read "1 nautical mile is equivalent to 1852 metres".



Unit Properties Dialog Box - Unit Name

This is the full name used for the new unit, for example Nautical Miles.



 Units Options

To open the Units Options, choose Options from the Utilities menu and click on the Units tab. This section allows the control of the 
use of units in Xara X and the definition of new, custom units. See units overview for a list of standard units. You can also define 
your own.

Default Units
Page Units

These are the units used for most measurements in Xara X. For more information, see Changing the page units.

Font Units

These units are used by Xara X for text measurements. For more information, see Changing the font units.

Color Units

These are used by the Color Editor when you are editing colors. For more information, see Changing the color units.

Unit Definition
This section displays the custom units you have created and allows you to add and delete units. For information on this, see 
Creating a custom unit.

New Unit

Click this button to create a new custom unit. It opens the Unit Properties dialog box.

Delete Unit

Click this button to delete the custom unit selected in the list.

Properties

Click this button to alter the properties of the unit selected in the list. It opens the Unit Properties dialog box.

_______________

{button ,KL(`units',0,`____No_Topics_Found',`')}    Related Topics



Units Overview

Xara X has a high level of support for units of measurement. Units are used widely throughout the program and you can define 
additional custom units as required (see Creating a custom unit). Whenever a field is visible showing a measurement in units, you 
can type in a value using any unit. For example, you can type "1pt" or "2cm" or even "10mi" into the Font Size field on the Text Tool 
Infobar.

The default Xara X units are:
pix Pixels (1/96 inch)

mm Millimeters

cm Centimeters

m Metres

in Inches

ft Feet

yd Yards

pt Points            (1,000 mp or 1/72 inch)

pi Picas              (12,000 mp 1/6 inch)

mp Millipoints (1/72,000 inch)

mi Miles

km Kilometers

A millipoint is 1/72000 in. and is used for all internal measurements.

Tip
You can use a scale factor with your document. For example you could draw a map at a scale of 25,000 to 1 with the units 

appearing on the Status Line and Infobar in Kilometers. See Setting a scale factor.

_______________

{button ,KL(`units',0,`____No_Topics_Found',`')}    Related Topics



Unlocking Xara X

When you purchase, we mail you a CD. When you receive the CD, reinstall the program from the CD as this doesn't need an 
unlock code.

However, when you first purchase Xara X, the CD takes a few days to arrive. So you need to unlock your existing downloaded or 
trial version. (Note that this unlocks the program for a maximum of eight weeks.)

Purchasing over the Web uses two keys:
a nine letter Key code
a seven letter Unlock code

The Key code changes if you change or reformat your hard drive or change to a new computer. You will need a new 
Unlock code.

If you have already purchased Xara X, you will not be charged for getting a new Unlock code. However, you will need your 
XaraClub user name and password. Forgotten your password? You can find help at: 
secure.commerce.xara.com/registration/passwordhint.asp  

To generate a new unlock code:
1. If necessary, reinstall Xara X trial on the machine you want to use it on.
2. Run Xara X and click Purchase.
4. Click Purchase Online.
4. Enter your XaraClub user name and password and click Go to Unlock Page - it will generate a seven letter Unlock code.
6. Type that seven letter Unlock code into the Purchase dialog box in Xara X. Note: use upper case letters - type 'ABCDEFG' not 

'abcdefg'.

Remember: this Unlock code applies only to your current set-up. Changing the hard disc or computer means you need a new 
Unlock code.

To unlock a trial version on a machine without an Internet connection repeat steps 1. and 2. as above. Make a note of the nine 
letter Key code displayed in the title bar of the Purchase dialog box. You can generate a matching unlock code from a machine 
that is online, by logging into your XaraClub account from our home page www.xara.com     

_______________

Related Topic

Purchasing Xara X



Updating a disk-based gallery

You can add folders of extra items to the Clipart and Fill Galleries (see Adding clipart to the clipart gallery or Adding fills to the fill 
gallery). If you later change the contents of these folders (e.g. by editing them or replacing a CD), you need to update the gallery 
so any new files are shown and the thumbnail images updated to show your changes.

To update a disk based gallery
1. From the Utilities menu, choose Clipart Gallery or Fill Gallery.
2. Click on the heading of the section you want to update. You can CTRL-click on additional sections.
3. Click the Disk button.
4. Click the Update button.
Updating a folder will usually involve updating the index and creating new thumbnail images.



Use Help from the Web

Dummy topic to create an entry in XSHELPID.H - this was originally used by Xara Webster.



Use Hints, Tips and Movies from CD

Throughout the help are Web Links which you can click to open hints and tips pages on the Internet. If you have installed Xara X 
from a CD, you can select this option so Xara X does not connect to the Internet, but takes the hints and tips pages and movies 
from the Xara X CD. Remember to put the Xara X CD in your CD drive before you click any Web Links.

If you select this option, both the Movies and Hints and Tips Pages items on the Xara On the Web submenu (on the Help menu) 
will work without connecting to the Internet.

As this option takes the hints, tips and movies from the CD, you won't see any updates we make to the pages on the web unless 
you turn this option off.

Note
This option is not present unless you have installed Xara X from a CD.



Using ClipView

ClipView lets you use an object as a "window" onto other objects. You see only those parts of other objects that are within the 
window. We call this creating a ClipView. You can move the window object to change your view. (The window object remains 
visible.)

The original objects:

With ClipView applied (the blue ellipse is the window object):

Note:
"Paste inside" is the term used in some other packages for this feature.

What do you want to do?
Create a ClipView
Remove a ClipView
Move objects in a ClipView

Movies

{button ,EF("XaraDemo.exe",`ClipView Using ClipView',1,`') } Using ClipView

_______________
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Using Contours to Resize Objects

You can use contours to change the size of objects by making the outline thicker or thinner. This has advantages over resizing for 
complex shapes like the letter "C":

Left: the original object

Center: resized using a contour

Right: resized by scaling the object up
To resize using contours

1. Select the object (see Selecting objects) (see Note).
2. Choose the Contour Tool.
3. Give the object a contour of the required size - see Contouring objects for details.
4. Click Inset path on the Contour Tool Infobar. The contour steps disappear and the object is now the size of the contoured 

object.

Note
You can also use the Contour Tool to select objects - more details.

Movie

{button ,EF("XaraDemo.exe",`Contour Using Contours',1,`') } Using contours

_______________
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Contours
Contour Tool



Using Templates

The Clipart Gallery includes sets of professionally designed template sets for use on web pages and elsewhere. You can also 
create your own template sets.

Viewing the Template sets
1. Open the Clipart gallery.
2. Select Web themes from the drop-down list.
3. Each section in the Gallery contains a set of templates (those designed around a common theme). Open a section to view the 

individual graphics. To open or close a section double-click on its gray section bar or click the folder icon.
To load a graphic:

1. Click the graphic you want to load.
2. Click Open or Import.

For more information see Selecting items in a gallery.



Using rulers

As you create or scale objects you can use the rulers to check their size. If you need to size or scale objects more accurately, you 
can use the Selector Tool.

Tip
The units and number of divisions on the rulers are the same as those for the on-screen grid. These are set in the Grid 

and Ruler Options. The right-hand end of the top ruler shows the units currently in use.

_______________
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Using scrollbars

Scrollbars allow you to move the page around in the Xara X document window. The Scrollbars in Xara X are proportional. For 
example if the current zoom on your document means you are looking at half the workspace, the scroll bar will take up half of the 
bar. This makes it easier to see, at a glance, at what scale the document is being viewed. The scrollbars are also interactive 
meaning that the page scrolls as you move them, rather than waiting until you release the mouse button.

Tips
Clicking the right mouse button on scrollbars moves in the opposite direction from normal. For example, right-clicking 

above the scroll box scrolls down. This makes it simple to move backwards and forwards using the scrollbars without having to 
move the mouse.

You can change the size of the scrollbars. See Customizing the appearance of the program.

_______________
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Scrollbars
Moving the page



Using Slicing to optimize web graphics

For fast download over the Internet you want to create the smallest possible files. Sometimes you can achieve the best results by 
exporting part of a graphic as a JPEG (which is best for photographs and areas of complex color changes) and part as a GIF 
(which is best for areas of flat color). An alternative would be to export detailed parts of the graphic as a 256-color GIF and the 
other areas as 2-color. Image slicing overview describes the basics of image slicing but this page describes exporting in differing 
file formats and color depths.

To show you how, we'll use this graphic (in practice you would not slice a simple image like this):

The blue & white circle can be exported as a JPEG; the surrounding areas of flat red as a GIF.
First stage: name the circle
Named objects control slicing so give the circle a Name. Use either the Name Gallery or New name on the Selector Tool Infobar. For 
this example we'll use the name Circle. If you had more areas you wanted to export at high quality you would also name them in the 
same way.

Second stage: set the export options
1. In the drop-down list in the Name Gallery select Exports.

2. Click  to the right of Circle and select the required format (JPEG in this example). The file name is the same as the Name 
in the Name Gallery. (Changing the file name also changes the name shown in the Name Gallery.)

3. Click Save to save the settings. (This does not save a bitmap at this stage.)

4. Click  (wording depends on the format chosen in step 2) and select the required save options (such as color depth). 
(For more detail on the options in this dialog box, click the Help button.)

5. Click Apply to save these settings. (Again, this does not save a bitmap)

Third stage: export the graphic in slices

You do not need to specify how to slice the image as Xara X does this automatically from the information in the Name Gallery.
1. Select both the red rectangle and the blue circle - see Selecting objects.
2. Select Export image in slices on the File menu.
3. Select the file format for the other parts of the graphic (in this case the red rectangle). For this example of exporting the 

circle as a JPEG and the rectangle as a GIF, you would select GIF as the file type.
4. The file name is the HTML file that contains the HTML code for the sliced image. You can change the file name if required.
5. Click Save.
6. Select the required save options. (For more detail on the options in this dialog box, click the Help button.)
7. Click Export to save the sliced image.
8. You can now view the exported bitmaps in your browser.

The example is sliced like this (the slices has been separated so you can see them):

Image slicing overview has full details of how to use the bitmaps and HTML code on a web page.



Using the Push Tool temporarily

The Push Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
To use the Push Tool temporarily

1. Press and hold down ALT+X to swap to the Push Tool.
2. Use the Push Tool as required. See Moving the page.
3. Release ALT+X to return to the previous tool.
or
1. Press and release ALT+X to swap to the Push Tool.
2. Use the Push Tool as required.
3. Press and release ALT+X again to return to the previous tool.

_______________
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Using the Selector Tool temporarily

The Selector Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
To use the Selector Tool temporarily

1. Press and hold down ALT+S to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Release ALT+S to return to the previous tool.
or
1. Press and release ALT+S to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Press and release ALT+S again to return to the previous tool.
or (except from the Text Tool)
1. Press and hold down the Space Bar to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Release the Space Bar to return to the previous tool.
or (except from the Text Tool)
1. Press and release the Space Bar to swap to the Selector Tool.
2. Use the Selector Tool as required.
3. Press and release the Space Bar again to return to the previous tool.

_______________
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Using the Zoom Tool temporarily

The Zoom Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
To use the Zoom Tool temporarily

1. Press and hold down ALT+Z to swap to the Zoom Tool.
2. Use the Zoom Tool as required.
3. Release ALT+Z to return to the previous tool.
or
1. Press and release ALT+Z to swap to the Zoom Tool.
2. Use the Zoom Tool as required.
3. Press and release ALT+Z again to return to the previous tool.

_______________
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Using the keyboard

This Help uses these conventions for showing keyboard Shortcuts:

Keys are shown in upper case. For example CTRL is the Control key.

Combinations of keys are shown like this: CTRL+A. This means:
1. Press and hold down the CTRL (Control) key.
2. Press and release the A key.
3. Release the CTRL key.

The Constrain Key

The CTRL (Control) key has a special function in Xara X. It constrains the action of the current operation in some way. For 
example, normally you can rotate an object through any angle. Hold down CTRL and the rotation is constrained to preset angles 
(defined in General Options). Similarly constraining the creation of an ellipse creates a circle.

The ALT keys

Most keyboards have two ALT keys. The right-hand ALT key is interpreted by Windows as CTRL+ALT. Xara X cannot alter this 
behavior. As a result Xara X operations involving the ALT key only function using the left-hand ALT key.

_______________

Related Topics

Mouse clicking and dragging
List of keyboard shortcuts



Using the mouse

Click

Press and release the mouse button. This is usually the left mouse button, but this is configurable. See Configuring the mouse 
buttons.

Double Click

Click twice in quick succession.

Drag

Hold down the mouse button whilst moving the mouse.

Drag-and-drop

Move the mouse over an item, drag the item to the required position and release the mouse button to drop it. Xara X uses drag-
and-drop extensively. You can drag colors from the Color Line and drag any item from a gallery onto your document.

CTRL-Click

Hold down the CTRL key during the click.

SHIFT-Click

Hold down the SHIFT key during the click.

ALT-Click

Hold down the ALT key during the click.

Mouse with wheel

See this page.

Note
CTRL, SHIFT and ALT can be held down in any combination during an operation.

_______________
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Using transparent lines

If you apply flat transparency to an object with an outline (or simply a line) the transparency will also affect the outline, but if you 
remove the transparency from the object, the outline will also lose its transparency. If you need to achieve the effect of a shape 
with a solid fill, but a semi-transparent outline, you can do it like this.
1. Select the object.
2. Choose the Transparency Tool.
3. Set the required transparency level for the line.
4. Remove the fill from the object by clicking on the No Color button on the Color Line.
5. Clone the object. See Copying objects.
6. Reapply the original fill to the cloned object.
7. Remove the outline from the cloned object by right-clicking on the No Color button on the Color Line.
8. Choose No Transparency from the Transparency Tool Infobar to remove the transparency from the cloned object.

Note
Lines and outlines are only transparency when flat transparency has been applied to the object. The other transparency 

types (linear, conical etc) do not affect lines or outlines of objects.



Utilities Menu

Galleries
Color Editor
Imagesetting
Web Address
Bitmap Tracer
Bitmap Effects & Plug-ins
Animation
Options



 View Options

To open the View Options, choose Options from the Utilities menu and click on the View tab. They control a large array of options 
concerned with the way you use Xara X.

Show Progress Bar

When Xara X is performing long operations, it can display a progress bar on the Status Line. Selecting this option will enable the 
display of this bar. The bar shows how far the operation has progressed.

Interactive Fill Dragging

This option turns on interactive fill and transparency dragging so you can see how fills and transparency look as you drag the fill 
handles. For more information, see Enabling interactive fill and transparency dragging.

Dithering

These options set the dithering method used to display your document on the screen. See Changing the screen dithering.

Bitmaps

These options apply only to the current document. They have no affect on any other documents currently loaded.

Never smooth

When Xara X scales a bitmap it usually smooths (interpolates) between the individual pixels to give a smooth look to the bitmap. 
Usually this gives the best results. However you might not want this effect; in this case check this option. Note that this overrides 
any Smooth when scaled up settings for individual bitmaps.

Dpi of auto-generated types

Some features such as shadows and bevels are created using bitmaps. For on-screen use (such as web page graphics) 96 dpi is 
the best value. For printed work, you may need a higher resolution so you cannot see the individual pixels in the bitmap. Changes 
to this value apply to new auto-generated bitmaps; it has no effect on existing bitmaps.

Color Line Size

This option allows the display of colors on the Color Line to be altered. When the full set of named colors no longer fits on the 
screen, scrollbars appear on the Color Line. See also, Color Line Overview.

Edit Local Colors In

This option sets the color model used when editing local colors using the Color Editor. It can be set to any of the available color 
models or to Automatic Color Model which will use the appropriate model. See also Color Editor.

Automatic Scroll to Selected Color

When this option is set, the Color Line and Color Gallery will automatically scroll as necessary to ensure the fill colors of the 
currently selected object(s) are in view where possible.

If this option is not set, the Color Line and Color Gallery will not scroll. The colors of the selection may not always be visible on the 
Color Line or in the Color Gallery.

The following options apply only to the current document. They will not affect any other documents currently loaded.

Proportional Scrollbars

When this option is set, the scrollbars around the document window are shown proportional to the visible portion of the document 
rather than being of a fixed size as is usual with Windows. Scrollbars can be disabled completely using the Scrollbars option on 
the Window menu.

Background Redraw

When this option is set, redraw is slowed down, but the drawing can be edited while redraw takes place. For maximum redraw 
speed, disable this option. Turning background redraw on and off.



View Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a blank area of the document or an unselected handle, it contains the 
following:

New View
Full Screen
- - - - - - - - - -
Quality
Show Grid
Show Guides
- - - - - - - - - -
Snap to Grid
Snap to Guides
Snap to Objects
- - - - - - - - - -
Default Page Background
Page Options

_______________
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Viewing document information

You can view a dialog box that gives you a variety of information about the current document.
To view the document information

1. Ensure the document is the current document. If it is not, click on it.
2. From the File menu, choose Document Info.

Tips
This dialog box lists all the fonts used in the document. An * by the name of a font means it is not installed on your 

computer.
You can type into the Comments field. Comments are saved with the document and are an easy way of including notes 

with a document

_______________
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Viewing several document at once

Either:
from the Window menu, choose Arrange Views. This places all the document views so you can see them all at once.
or from the Window menu, choose Cascade. This places all the document views in a diagonal line so you can see all their 

title bars.
or drag the title bars of the document views and resize them so you can see the ares you need to.

Tip
If you have a document open, but don't need to see it, minimize it to an icon. If you use Arrange Views now, the 

minimized document stays at the bottom of the screen.



Viewing the movies

Available only with CD versions of Xara X

Not available with download versions

The CD includes a large number of multimedia movies. To look in the Movie Library click here.
To start a movie

The movie starts automatically as soon as you click the movie button.
To pause a movie

Click the Pause (bottom left-hand) button. Click again to restart.
To rewind or advance a movie

Drag the slider at the bottom of the window
To resize the movie window

(Not applicable to Windows Media Player 7.) You cannot drag the edges of the window to resize. (This would distort the image in 
the window and give poor quality results.) Instead, click the Menu button (to the right of the Pause button) and choose from the 
View options.

To close the movie window

If you let the movie run to the end and stop, the movie window will close down automatically after a few seconds. If you rewind the 
movie the window will only close when you close it manually.



WPG Export Dialog Box

The WPG export bitmap dialog box is opened by selecting WPG as the exported file format from the Export dialog box. It allows 
the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. For details 
of how to create a WPG file, see Creating WPG files.

Bitmap Size
Color Depth
Area to Save
Palette
Dithering



Warping the edges of polygons

You can curve the sides of polygons created using the QuickShape Tool.
To warp the edges of a polygon

1. Select the polygon (see Selecting objects).
2. Choose the QuickShape Tool
3. Move the mouse pointer over a side of the QuickShape. (The pointer changes to an arrow.)
4. Drag to reform the sides of the polygon.

Tips
The sides of a QuickShape can be made straight again using the Restore Edges Button on the QuickShape Tool Infobar.
If you hold down CTRL as you drag the edges of a starred polygon, both sides of each star point will move in parallel.
If you hold down CTRL+SHIFT as you drag the edges of a starred polygon, both sides of each star point will move 

symmetrically.

_______________
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Warping the edges of rectangles

You can curve the sides of rectangles created using the QuickShape or Rectangle Tool.
To warp the edges of a rectangle

1. Select the rectangle (see Selecting objects).
2. Choose the QuickShape Tool
3. Move the mouse pointer over a side of the rectangle, the pointer changes to an arrow.
4. Drag to reform the sides of the rectangle.

Tip
The sides of a QuickShape can be made straight again using the Restore Edges button on the QuickShape Tool Infobar.

_______________
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QuickShapes overview
Rectangles



    Web Address (Utilities Menu)    CTRL+SHIFT+W

With this dialog box you can add web addresses to objects in documents so when the document is displayed on a web page, 
clicking on objects takes you to other pages. For more information, see Adding web addresses to objects. For details on what you 
can type into this dialog box, see the Web Address Overview.

URL
Correct URL automatically
Target frame for URL
Clickable area
Add / Change
Remove

Note
You can also open the Web Address dialog box by right-clicking on an object to open the pop-up menu and choosing Web 

Address.

Movies

{button ,EF("XaraDemo.exe",`WebAdd Assigning Web Addresses',1,`') } Creating hot-spots

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps

_______________
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Web Address Dialog Box - Add/Change Button

Clicking the Add button sets the web address of the selected objects to the address shown in the dialog box.

If the object already has a web address assigned to it, this button is labeled Change.



Web Address Dialog Box - Clickable area

These option buttons let you specify what area of the object must be clicked on to fetch the URL. There are two choices:

Object shape The user must click on the exact shape of the object to fetch the URL

Rectangle surrounding object The user can click anywhere in the rectangle surrounding the object (the bounding box) to 
fetch the URL.

The 'default clickable area' is the value that is shown in the Web Address dialog when there is no Web Address attribute on the 
selection. If the selection consists only of text, the default clickable area is Rectangle surrounding object. Otherwise, the default 
clickable area is Object shape. The Object shape option is fairly straightforward (only clicking on the exact object shape will fetch 
the URL).



Web Address Dialog Box - Correct URL automatically

URL's / web address need to be in the right format. Because there are so many ways of typing URL's, this option ensures your 
URL is correct. When it is enabled it looks at what you have entered (when you close the dialog box or apply your changes) and 
corrects the URL. For example, if you enter "www.xara.com" it will correct it to "http://www.xara.com/". The URL is corrected when 
you click the Add or Change button.



Web Address Dialog Box - Remove Button

Clicking this button removes the web address from all the selected objects.



Web Address Dialog Box - Target frame for URL

If you want the URL in the URL field to be fetched into a specific frame in the browser, type the name of the frame in this field.

For example, if you type 'http://www.xara.com' into the URL field and 'RIGHT' into the Frame field, then this tells the browser to 
fetch the URL 'http://www.xara.com' into the frame called 'RIGHT'. By default, the value in this field will be '_self'. This means that 
the URL in the URL field is fetched into the same frame as the current document.

The drop-down list of this combo box contains four frame names that cause the browser to do special things:

_self Fetch the specified URL into this frame. (The frame that contains this object.) This is the best option to use if you are not 
sure which to use.

_parentFetch the specified URL into the parent window or frameset that contains this frame.

_top Fetch the URL into the main browser window, replacing any existing frames.

_blank Fetch the URL into a new window.

default Do not include a TARGET attribute in the image map entry for this object. This has the same effect as _self unless you 
have used a BASE TARGET= tag in the document.

You can either select one of these, or type in the name of another frame.



Web Address Dialog Box - URL

In this field, type the URL you want to be associated with the selection. This URL can be a relative URL (e.g. '../file.htm') or an 
absolute URL (e.g. 'http://www.xara.com'). The URL can refer to any sort of file (e.g. 'file.gif', 'file.htm' or 'file.web'). For more 
details, see the Web Address Overview.



Web Address Overview

You can add web addresses to objects so when the file is displayed on a web page, you can click on the objects to take you to 
other locations. You can also add a web address that opens an email form when it is clicked on or one that opens a newsgroup. 
For more details on how to add a web address to an object, see Adding web addresses to objects.

Types of Web Address

Absolute web addresses consist of the full address for a location. They usually start with the type of location followed by a colon 
(e.g. 'http:'). Examples are:

"www.xara.com" - the Xara Ltd web site. "http://" is automatically inserted in front of "www.xara.com".
"file:///c|/picture.xar" - picture.xar on the C drive.
"D:\picture.web" - picture.web on the D drive. This is an alternative format using a '\'.

Relative web addresses are shortened web addresses which specify locations relative to current location. This means you can 
specify files that are in the same folder or in subfolders easily. Examples are:

"pictureWEB" - the pictureWEB file.
"pictures/pictureWEB" - the pictureWEB file in the pictures subfolder.
"../page.html" - the page.html file in the folder above.
"/picture.xar" - picture.xar in the root folder of the web site.

There are also some other types of web address used for special purposes. Examples are:
"ftp://ftp.abc.xyz/pub/file.txt" - open file.txt in the pub folder on the ftp.abc.xyz ftp server.
"news:uk.music.rave" - open the uk.music.rave newsgroup.
"mailto:info@xara.com" - send email to info@xara.com.

How Web Addresses are treated
If a web address consists of three groups of letters separated by dots, e.g. "www.xara.com", Xara X treats it as 

"http://www.xara.com".
If a web address starts with a '/' it is assumed to be an absolute web address starting from the root of the drive containing 

the HTML file.
If a web address starts with some letters followed by a colon, Xara X will assume it is an absolute web address. If it does 

not, Xara X will assume it is a relative web address.

Target frame

If you want the web address to display in a specific frame in the browser, you can specify the "target" frame.

For example, if you type 'http://www.xara.com' into the URL field and 'RIGHT' into the Frame field, then this tells the browser to 
display the page 'http://www.xara.com' in the frame called 'RIGHT'. By default, the value in this field will be '_self'. This means that 
the page displays in the same frame as the current document.

The drop-down list contains four frame names that cause the browser to do special things:

_self Fetch the specified web page into this frame. (The frame that contains this object.) This is the best option to use if you are 
not sure which to use.

_parentFetch the specified web page into the parent window or frameset that contains this frame.

_top Fetch the web page into the main browser window, replacing any existing frames.

_blank Fetch the web page into a new window.

default Do not include a TARGET attribute in the image map entry for this object. This has the same effect as _self unless you 
have used a BASE TARGET= tag in the HTML document.

You can either select one of these, or type in the name of another frame.

Tips
Wherever possible, use relative addresses to link between files. This means the files can be moved without breaking links.
If you have an address like "abc.com" rather than "www.abc.com" you should enter "http://abc.com" as the "http://" is not 

added automatically.

Movies

{button ,EF("XaraDemo.exe",`WebAdd Assigning Web Addresses',1,`') } Creating hot-spots

{button ,EF("XaraDemo.exe",`Imagemap Image maps',1,`') } Image maps
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Welcome to Xara X
Xara X is an advanced graphic illustration package for Windows computers. You will find producing illustrations quick and easy. 
You just choose the drawing tools you want from the on-screen toolbar and draw. Relevant information about the current tool is 
also displayed on-screen. You can customize the bars to show as many or as few functions as you wish.

Every change you make is recorded by Xara X. So, if you make a mistake or change your mind, you can step backwards undoing 
previous operations. You can experiment knowing you can always return to an earlier stage. Using Xara X could not be easier.

Xara X also provides many advanced features such as graduated fills, transparency, multi-stage blends and fills, semitransparent 
(soft) shadows, enveloping and perspective.

Xara X Basics
Purchasing Xara X
Unlocking Xara X
Using the Mouse
Using the Keyboard
What's new in this release

Movies (not available for the download version)

{button ,EF("XaraDemo.exe","Intro XARA X Demonstration",1,`') }    Welcome to Xara X - a brief description of all the 
facilities available

{button ,EF(`xarademo.exe',`Demo XARA X Demonstration',1,`')}    Creating an illustration using Xara X

{button ,EF(`xarademo.exe',`Webpage XARA X Demonstration',1,`')}    Creating a web page using Xara X
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What's New - Improved display of resized bitmaps

Resizing bitmaps (to less than or more than 100%) often dramatically reduces the quality.    Xara X has improvements to the 
display of resized bitmaps to minimize the quality loss. This is especially true for highly detailed bitmaps such as screen grabs. It's 
all done automatically when you resize the bitmap so all you notice is the improved quality. (And the quality is better than almost 
any other product around.)

And when you export the bitmap, Xara X improves the quality still more. (The process requires complex calculations and is too 
slow for general on-screen display.)

This example shows a bitmap scaled to 80% in Xara X (top) and in a comparable package (bottom):

      



What's new - Automatic Kerning

Kerning alters the horizontal space between two adjacent characters. Xara X supports automatic kerning (or "auto-kerning"). If all 
characters are spaced the same distance apart, some character pairs such as "AV" look wrong. To correct this most (but all) fonts 
have in-built "kerning pair" information that adjust the spacing for particular pairs of characters. (Notice how "AV" overlap each 
other - that is the effect of auto-kerning.) See Kerning text.



What's New - Batch Export

You might create a drawing containing a set of themed graphics (such as all the graphics on a web site). These may use a 
common color. In the future you might decide to change the color, which means you need to re-export all the graphics. In Xara X 
you can use the Name Gallery to batch export all the graphics - see Batch exporting.



What's New - Bevel Tool

A new tool that lets you add shaped bevel edges to objects to create a three-dimensional look to your drawing. Full control over 
the bevel size, lighting direction and color contrast across the bevel. Bevels are resolution independent so you can scale them 
without losing quality. For more details see Bevel Tool overview.



What's New - Blend Tool

An existing tool that has some new features. For full information see Blend Tool overview.

Distance between steps

In previous releases you could only specify the number of intermediate steps in the blend. In Xara X you can also specify the 
distance between steps. See Blend Tool Number of steps.

Blend along a curve

Now the blend can follow an arbitrary curve. The intermediate objects can be oriented to follow the curve or keep their straight line 
orientation. See Blending along a curve.

Profile the blend steps

In previous releases the blend steps were regularly spaced. Now you can adjust the spacing so that most intermediate steps are 
towards one end or towards the center of the blend. See Changing the blend position profile.



What's New - Brush Stroking

Previous versions were limited to plain lines. Now you can apply brush patterns (including air-brush effects) using either the 
Freehand & Brush Tool or the Line Gallery. Xara X includes a range of predefined brushes or you can create your own. See 
Changing the brush stroke design.



What's New - Button & Bar Tool

A new tool that lets you create the multi-button bars commonly used for navigating between web pages. You can also create 
rollover buttons (that is, buttons that change state when you select them or move the mouse over). These look great but can be 
complicated to produce. Now Xara X makes the process as easy as possible. Xara X also creates the required buttons and even 
the HTML code ready for use on your web page. (And the JavaScript needed for rollovers - no need to learn JavaScript.) For more 
information see Button & NavBar Tool overview, Creating Navigation Bars and Creating Rollovers.



What's New - ClipView

A new way of clipping or masking objects. Select multiple objects and apply ClipView. One object (the back object) becomes a 
window onto the other objects. Unlike other clipping methods, you can easily move the window object or the other objects so you 
can change which parts of the objects are clipped. See Using ClipView.



What's New - Contour Tool

A new tool that lets you create concentric rings inside or outside shapes, and outside lines. You can also use contours to thicken 
the outline of objects. A tool that opens up a wide range of interesting effects to the creative user. For more information see 
Contour Tool overview.



What's New - Convert lines to shapes

You can now convert a line into an editable shape. This means you can edit its outline or apply complex fills and transparency to 
the line. Because it is a shape, you can also give it an outer line. See Converting lines to shapes.



What's New - Slice Option

In previous versions a line used to slice an object had to extend beyond the bounding box of the object. (The bounding box is an 
imaginary box enclosing the whole object.) This has been improved so that the only requirement is that both ends of the line must 
lie outside of the object. This is particularly useful for objects such as the letter "C". See Slicing shapes.



What's New - Macromedia Dreamweaver support

Dreamweaver is a popular program for web site design. Now you can easily use the power of Xara X to create the graphics you 
need and then integrate them into Dreamweaver (version 3 or later). Just set a flag when you export the graphic and Xara X sets 
up the necessary links. Then if you need to make more edits to the graphic, you can quickly reload the original file into Xara X. See 
Macromedia Dreamweaver support.



What's New - Export Color Control

Xara X provides greater control over the colors in exported GIF, BMP, and PNG bitmaps. Now you can select which colors to 
include in the palette of the exported bitmap, lock colors to the nearest color in the 216-color Netscape or Internet Explorer palette, 
and choose which color to make transparent. For more information click Help on the Export Bitmap dialog box. Note that these 
options do not apply to BMP and PNG True-color formats. More details on the Bitmap Export dialog box.



What's New - "Color Picker"

A new option on the Color Editor for selecting colors. You can use the Color Picker ("eye-dropper") to select colors from the screen 
(even colors in other windows). As you move over an object or over the Color Line, the Color Editor updates to the color the Color 
Picker is over. Just release the mouse button when over the color you want to select. (This also changes the color of any objects 
that use the color shown in the Color Editor.)



What's New - Feathering

Sometimes you want an object to merge into the background or other objects. For example, when overlaying two bitmaps, you 
want to avoid a sharp edge to the top bitmap as this makes the join obvious. Feathering blurs the edge of an object to remove the 
sharp edge. For more information see Feathering objects.



What's New - Fill Tool

An existing tool that has some new features. For full information see Fill Tool overview and Fills overview.

Repeat fills

This applies to most fill types and greatly increases the effects you can create. Previous the fill pattern appeared once. Now you 
can repeat the fill pattern to create, for example using a linear fill, a series of stripes. See Fill Tool Tiling field.

Bitmap fill selection

You can now use a drop-down list in the the Fill Tool to preview and select the bitmap used in a bitmap fill.    The drop-down also 
shows a preview of the available bitmaps. This saves time especially when using a bitmap that is already used in the document. 
See Fill Tool Bitmap.

Color profile

In previous releases the color change across the fill was linear. Now you can select more change towards one end or towards the 
center of the fill. See Changing the fill profile.



What's new - Font drop-down list

A new feature in the Text Tool. When you display the font drop-down list, type a letter on the keyboard. The list then scrolls to show 
fonts starting with that letter.



What's New - Freehand & Brush Tool

An existing tool with some new features. For full information see Freehand & Brush Tool overview.

Pressure recording

If you are using a pressure-sensitive input device such as a graphics tablet, Xara X can record the pressure information. This can 
be used for:

varying the thickness of freehand lines
varying the rotation and scaling of brush stokes.

Brush control

In Xara X you are not restricted to plain lines and object outlines. You can also apply patterns and effects. Xara X refers to these 
as "brushes". The Freehand & Brush Tool now includes options to create, select and modify brushes.



What's New - Multi-stage Graduated Fills

Applies to Linear, Circular, Elliptical, Conical and Diamond fills.

You can drag and drop colors onto the Fill arrow to create multi-stage fills. For more details see Creating multi-stage fills.



What's New - Group Transparency

You can now overlay transparency effects applying transparency to objects (as before) and applying a second transparency effect 
on top. This second transparency is called "Group Transparency". See Applying Group Transparency.



What's New - Image Slicing

Even complex graphics often include large areas of flat color. These areas could be exported as separate bitmaps containing just 
a few colors to give a small file size. 

Also, for web pages, large graphics can take a long time to download and display. It is sometimes better to separate a large 
graphic into sections and download several, smaller files.

For both these uses you "slice" the image into smaller parts. For more information see Image slicing overview.



What's New - Macromedia Flash Export

Macromedia Flash (.swf) format is the most commonly used vector format for use on web pages. Now you can create static .swf 
files using Xara X. See Exporting Macromedia Flash files.



What's New - Drag-Selection

You can select several objects by choosing the Selector Tool and then dragging. This displays a rectangle (often called a 
"marquee"). Releasing the mouse selects all objects inside the marquee. Previously you had to start dragging with the mouse over 
a blank area of the page. Dragging with the mouse over an object moved that object. Now holding down SHIFT and dragging, 
forces marquee select even if you start dragging with the mouse over an object.. See Selecting several objects.



What's New - Name Gallery

A new Gallery that lets you name objects or groups of objects and also provides a quick way of selecting objects that use a 
particular Name, Bitmap, Color, or Font. For example you could use the Name Gallery to select all uses of Arial font and then 
change just that text to Times Roman. Also selects how to slice images and the file format to use.

See Name Gallery and Naming objects.



What's new - PNG alpha-channel transparency

The PNG bitmap true-color (millions of colors) format allows graduated transparency (256 levels); this is called "alpha channel" 
transparency. Xara X now includes this option in the PNG Export dialog box. See Exporting PNG files. Xara X can also import 
alpha-channel PNGs.



What's New - Profile Transitions

In many places in Xara X there are transitions. For example in a fill, there is a color transition across the fill. In previous versions 
the colors changed linearly. Now you can profile the transition to have greater change at the edges or in the center. You can either 
select from predefined transition profiles or create a custom profile. For information see Profile dialog box.



What's New - "RGB web color" model

A new color model in the Color Editor Advanced options. Previously you could define RGB colors as percentages (0-100%) or 0-
255. However color on web pages are often defined as six hex digits (0-9, a-f) and the RGB web color model lets you define 
colors in this way. You can use either upper or lower-case letters: "abcdef" and "ABCDEF" produce identical colors. See Editing 
colors in RGB.



What's New - Selector Tool

An existing tool with a new feature. For full information see Selector Tool overview.

New Name Button

Lets you add a new name to the Name Gallery and assign that name to the selected objects. See Naming objects.



What's New - Shadow Tool

A new tool that lets you create "soft" (semitransparent) shadows. Because they get more transparent towards the outer edges, soft 
shadows are more realistic than the "hard" shadows usually associated with drawing programs. You can create wall shadows (the 
shadow thrown onto a vertical surface) or floor shadows (the shadow thrown onto a slanted surface). You can also create a "glow" 
effect of a backlit object. Shadows are resolution independent so you can scale them without losing quality. For more information 
see Shadow Tool overview.



What's New - Stroke Stroking

Previous versions were limited to constant width lines. Now you can have shaped lines (such as tapering) using either the 
Freehand & Brush Tool or the Line Gallery. See Changing the stroke shape.



What's New - Swap Bitmap Format

A new option for GIF, BMP, PNG, and JPEG export. Previously you selected the format (GIF, BMP, PNG, or JPEG) before seeing 
the previews (the second page of the Export dialog box). Now you can swap between formats while previewing. This makes it 
easier to decide, for example, whether GIF or JPEG formats give the best results for a particular graphic. More details on the 
Bitmap Export dialog box.



What's New - Web templates

The Clipart Gallery now contains sets of themed graphics for use on web pages. These let you create web pages with a consistent 
look-and-feel to the graphics. To see the templates, select Web themes in the Clipart Gallery drop-down list. More details of using 
Templates. 



What's new - Mouse operations

Xara X now supports a mouse with a wheel. Moving wheel scrolls the window or gallery. Clicking the wheel centers the view on the 
part of the drawing under the mouse pointer. You can also use the wheel to zoom in and out onto the drawing. See Mouse-wheel 
operations.



What's New - Transparency Tool

An existing tool that has some new features. For full information see Transparency Tool overview and Transparency overview.

Transparency types

These control how semitransparent objects alter the colors of underlying objects (so you can create filters). The options have been 
expanded. See Changing transparency type.

Repeating transparency

This applies to most transparency types. Previously the transparency pattern appeared once. Now you can repeat the pattern to 
create, for example using circular transparency, a series of concentric semitransparent rings. See Transparency Tool Tiling field.

Bitmap selection

You can now use a drop-down list in the Transparency Tool to select the bitmap used in bitmap transparency. The drop-down also 
shows a preview of the available bitmaps. This saves time especially when using a bitmap that is already used in the document. 
See Transparency Tool Bitmap.

Profile

In previous releases the change across the transparency was linear. Now you can have more change towards one end or towards 
the center of the transparency. See Changing the transparency profile.



What's New - Updated Adobe Illustrator EPS export

The import and export filters have been updated to work with Adobe Illustrator 8. This means you can now import and export 
gradient fills.



What's New - Updated Corel CMX import/export

These have been updated for the latest version of CMX.



What's new - WebSnap palette option

This is a new palette option on the Bitmap Export and Create Bitmap Copy dialog boxes. Any colors in the bitmap that are close to 
an entry in the 216-color Internet Explorer and Netscape ("web-safe") palette snap to that entry. It has no effect on other colors. 
(Web-safe colors are not dithered when viewed in 256-color screen modes; this improves the appearance of areas of flat color.)

Note the difference between this option which snaps close colors and Browser palette which snaps all colors.

More details on the Bitmap Export dialog box.



What's New in This Version?

Xara X is a major upgrade from CorelXARA 2 with significant enhancements to the tools and the user interface, especially in the 
area of web graphics creation.    Here is a list of the main differences:

New tools:
Button & NavBar Tool - simplifies the creation of web page navigation bars and JavaScript rollovers. Automates the 

creation of the button graphics and produces the associated HTML and JavaScript for you. You don't even need to know JavaScript!
Shadow Tool - create semitransparent ("soft") wall and floor shadows and glow effects. Soft shadows fade out at the 

edges and are much more realistic than hard shadows usually associated with graphics packages.
Bevel Tool - create an illusion of depth by adding shaped bevels to objects.
Contour Tool - create concentric rings around lines and shapes (inset path operations).

Extra features for existing tools:
Fill Tool - repeating fill patterns, color profiling and easier selection of bitmaps for fills.
Transparency Tool - extra transparency types added, repeating transparency patterns, easier selection of bitmaps for 

transparency; and transition profiling.
Freehand Tool (now the Freehand & Brush Tool) - real-time brush stroking, including simulated air brushing, with fully 

editable strokes.
Blend Tool - can now profile the blend steps, plus blend along a curve with control over the spacing between blend steps.
Selector Tool - new button lets you assign names to objects - see Name Gallery for how you can use names.

New Gallery:
Name Gallery - assign names to objects (multiple names permitted). Shows and lets you select bitmaps, fonts, and colors 

used in the document. You can use the names to control batch export or to edit groups of related objects. Also controls image slicing 
and batch exporting.

New features for existing galleries:
Line Gallery - new sections for brush strokes and stroke shapes - see Line Gallery for details.
Clipart Gallery - a new drop-down list to select between regular clipart and themed template sets.

Drawing features:
Support for non-linear profiles (the transition or rate of change) for the position and attributes of blends, transparency, 

color fills, contours and shadows.
Multi-stage graduated fills - allows multiple color changes in fills.
Brush stroking of lines - create patterned lines and object outlines using either predefined brushes (including air-brush 

effects) or by creating your own.
Pressure-sensitive graphics tablet support for brush strokes.
Stroke shaping of lines
Fully automatic on-screen bitmap anti-aliasing for rotated and scaled bitmaps .
ClipView - a new way of clipping objects, sometimes called "paste inside".
Feathering - blur the edges of objects so they merge smoothly into the background or objects behind them.
Convert lines to shapes - you can applies complex fills to lines.
Improved drag-select (marquee selection)
Batch export of bitmaps
Improvements to Cut option in Combine Shapes.

Web graphics support
Easy creation of rollovers and navigation bars. Creates the necessary graphics and HTML. For rollovers also creates the 

necessary JavaScript.
Macromedia Flash exporter - lets you export graphics in Flash format, the most popular vector format for the web.
Macromedia Dreamweaver support
Image slicing - lets you export web graphics as a series of slices. Also exports the necessary HTML code to reweave the 

slices on the web page.
"RGB Web Color" lets you define colors as six hex digits (0-9, a-f) to match how colors are usually defined in HTML on 

web pages.
WebSnap palette option on export.
Linked stretching of objects, a real time saver for linking the scaling of text to a graphic, typically a button or heading
A set of professionally designed web graphic templates (all user-editable)

Color handling:
"Eye-dropper" tool makes it easy to select colors from on-screen objects.
"RGB Web Color" lets you define colors as six hex digits (0-9, a-f) to match how colors are usually defined in HTML on 

web pages.

Import/Export:
(PNG, BMP, GIF, & JPEG formats) ability to swap formats in the Export Preview dialog box - makes comparing results far 

easier.
(PNG, BMP, GIF, & JPEG formats) preview in the Import dialog box - makes it easier to find the file you want.



Greater control over colors for PNG, BMP, and GIF export (formats up to 256 colors). Includes options to selectively 
delete or lock colors in the palette and to define which palette entry to make transparent.

WebSnap palette option on export.
Image slicing - lets you export web graphics as a series of slices. Also exports the necessary HTML code to reweave the 

slices on the web page.
Macromedia Flash exporter - lets you export graphics in Flash format, the most popular vector format for the web.
PNG import/export now supports alpha-channel (graduated) transparency
Improved TIFF support including importing alpha-channel (graduated) transparency
Updated AI
Updated CMX

Text handling:
Font list in Text Tool auto-scrolls if you type on the keyboard.
Automatic kerning of pairs of characters.

Menus:
Plug-ins is now called Bitmap Effects & Plug-ins. It has moved from the main Menu bar to the Utilities menu.

Mouse operation:
Xara X supports a mouse-wheel.



What's new - TIFF import & export

The TIFF bitmap format from revision 6 allows graduated transparency (256 levels); this is called "alpha channel" transparency or 
RGBA format. Xara X can import RGBA TIFFs.

Xara X can also import CMYK TIFFs.



What's New - Linked Stretching

Often complex graphics contain a text message. Change the text and you have to resize the other elements in the 
drawing. Not with Xara X's linked stretching. Now stretching can be automatic whenever you change the text. By far the 
most common reason for wanting linked stretching is in a button or heading. The simple way of linking two objects such as text 
and graphic together is to just convert them into a button using the Button & NavBar Tool - that does the job automatically for you.

For more complicated linking you can use the Name Gallery. See Linked stretching for more details.



Window Control Bar

Zoom To Page
Zoom To Selection
Previous Zoom
Zoom To Drawing
New View
Full Screen Mode
Show Grid
Snap to Grid
Print Borders
Show Rulers
Snap to Guides
Show Guides

 Anti-aliased Quality
 Normal Quality
 Simple Quality
 Outline Quality

_______________
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Window Menu

New View
Arrange Views
Cascade
Arrange Icons
Control Bars
Bars
Full Screen
Quality
Show Printer Colors
Show Grid
Show Guides
Show Print Borders
Snap to Grid
Snap to Guides
Snap to Objects



    Wizard Properties (Utilities Menu)

Click here for more information on Wizard Properties    



Xara On The Web

The items on this submenu take you to pages on the Xara Ltd. web site.

Web Link
Xara Home Page 



Xara File Export Dialog Box - Export Size

This controls how much of the drawing you want to export. 

Selection (dimmed unless you have selected objects) exports just the selected objects. Note that this exports only the selected 
objects and not any objects on top of the selected objects.

Drawing exports all the objects, selected or not.



Xara WEB File Export Dialog Box

Xara WEB format is a compact but editable vector graphics format. For information on creating Xara WEB files, see Creating Xara 
WEB files.

When you export a WEB file, you have several options which allow you to remove information from the WEB file to make it even 
smaller.

Convert text to outlines
Remove preview bitmap
Remove extra editing information
Remove invisible layers
Remove unused colors
Use JPEG on compatible bitmaps
Export size
Viewport size



Xara WEB File Export Dialog Box - Viewport size

The Viewport is the area shown when the Xara WEB file is viewed on a web page. 

Selection (dimmed unless you have selected objects) fills the whole WEB file area with the selected objects.

Drawing displays the entire area of the original drawing.



Xara WEB File Export Dialog Box - Convert text to outlines

The program loading the file may not have all the fonts used in your document. Selecting this option converts all text in fonts other 
than Times, Arial and Courier (which all computers should have) to simple editable shapes. This makes the file larger but means 
that the viewing program displays the text correctly. Note that converting text to outlines means you cannot load the WEB file and 
use the Text Tool to edit converted text.



Xara WEB File Export Dialog Box - Remove Invisible Layers

This option discards any hidden layers. For information on hiding layers, see Hiding layers.



Xara WEB File Export Dialog Box - Remove Preview Bitmap

Xara X XAR files include a preview bitmap which adds about 5Kb to the size of the file. The advantage of including a preview 
bitmap is that, for example, the Clipart Gallery and Open dialog box can show a thumbnail of the document.

If you want very small files, select this option.



Xara WEB File Export Dialog Box - Remove Unused Colors

Retains only colors that are used in the document. The parent colors of shades, tints and linked colors are also retained.



Xara WEB File Export Dialog Box - Remove extra editing information

Selecting this option makes the exported WEB file even smaller.
Color definitions are reduced to simple RGB definitions.
All unused colors are removed.
All invisible layers are removed.
The guides layer is removed.
Layer names are removed.
The page size information is removed.
The document comments are removed.
Document scaling information is removed.
Custom units are removed.
Printing settings are removed.
Grid settings are removed.
Ruler settings are removed.
Guides are removed.

This option makes little difference to larger files, but can be very useful for making small files even smaller.



Xara WEB File Export Dialog Box - Use JPEG on compatible bitmaps

When you export a document to a Xara WEB file all the 1 bit and 4 bit bitmaps in the document are automatically compressed 
using lossless compression. All 8 bit and 24 bit bitmaps are compressed using JPEG compression. JPEG is a more efficient way 
of compressing bitmaps of this type but it does discard some information in the process. This is generally not noticeable, especially 
when using high JPEG Quality settings. If you want to export your 8 and 24 bit bitmaps using lossless compression, deselect this 
option.

When you create a WEB file with this option selected, all the 8-bit and 24-bit bitmaps in the document not already in JPEG format 
are converted before they are saved in the file. The JPEG Quality slider controls the amount of compression. Low values give the 
greatest compression but the most information loss. If you set the value to the highest, the bitmaps do not compress so well, but 
are very high quality. The slider is dimmed if there are no bitmaps in the document that can be converted to JPEGs.

You can experiment to get the best setting for the bitmaps by creating several WEB files from the original XAR document using 
different JPEG Quality setting and loading them back into Xara X. You can then compare the file size and the quality of the WEB 
file with the original XAR file. Remember that once you close the original XAR file, you retain only the JPEG compressed versions 
of the bitmaps in the WEB file.

Important: Once you have exported a WEB file with this option set, you cannot reload it and export it again at a different JPEG 
Quality setting as all the suitable bitmaps have been converted to JPEG bitmaps already. When you reexport a file like this all the 
JPEG bitmaps stay the same. Bitmaps are never recompressed using JPEG compression as this causes quality loss.

Tip
If you want to change the JPEG Quality for an individual bitmap, export it from Xara X as a JPEG file. Vary the JPEG 

Quality in the bitmap export dialog box until you get the file size you want at the quality level you want. You can then re-import the 
bitmap and export the WEB file.

_______________
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Xara WEB Files Overview

You can use the Xara plug-in for Netscape Navigator and Internet Explorer to display WEB vector files (and Xara X XAR files) on 
the Internet. With Xara WEB Format (WEB) files you can make the files smaller by optionally excluding invisible information. This 
can lead to a significant saving in file size. You can download the plug-in from 

www.xara.com/plugin/    

These two formats have several advantages for both web designers and web readers. The biggest advantage for web designers is 
that you can always reload the file and make edits to it. You don't need to maintain a source file and a separate GIF or JPEG 
bitmap. You can reload the file and move things around, scale and rotate parts, change the text etc. Secondly, being high-
resolution object based, you can zoom in and out on the image without losing detail. Indeed you can zoom into any region by up to 
25,000% to examine the most minute details in illustrations. A good example of where this is useful is a map. The reader can zoom 
in from viewing the entire country to view a city and then to view individual districts - all on the same map. 

A vector format also means that, for example, company logos can be accurately represented, rather than just being a low-
resolution approximation.

The ability to display objects without them going jaggy or pixelated like all bitmap formats is also useful for printing a quality image 
on high resolution printers. Or for images that you'd like to be able to resize for different screen or window sizes and still look pixel 
perfect.

Another major point about WEB files is that many typical Internet style graphics can be far smaller than either GIF files or JPEG 
files. As the biggest problem with the Internet is lack of speed, which is almost entirely due to the number and size of JPEG and 
GIF files, this is a very significant point.

Image Quality

Because of Xara's anti-aliased rendering, graduated transparency, fractal textures etc., WEB files are the only vector formats that 
can accurately simulate the best quality obtainable from GIF and JPEG images - and often better.

What goes in the file?

The table shows what goes in a WEB file compared with what goes in a XAR file. A Small WEB File is one exported with the 
Remove Extra Editing Information option set. For details of the options available when you create a WEB file, click here.

Normal WEB Small WEB XAR

Objects Yes Yes Yes

Area to View Yes Yes     -

Quality Setting Yes Yes Yes

Text Text or Outlines Text or Outlines Text

Used Colors Full definitions Simple RGB Full definitions

Preview bitmap Optional Optional Yes

Unused Colors Optional No Yes

Invisible Layers Optional No Yes

Guide Layer Yes No Yes

Layer names Yes No Yes

Page Size Yes No Yes

Comments Yes No Yes

Document Scaling Yes No Yes

Custom Units Yes No Yes

Printing Settings Yes No Yes

Grid Settings Yes No Yes

Ruler Setting Yes No Yes

Guides Yes No Yes

_______________

Related Topics

Web files
Web addresses



Xara XAR File Export Dialog Box

This is an alternative to Save As for saving Xara X files. The advantage of using this dialog box is that you can export just a part of 
the drawing. 

Export size



    Zoom Magnification

This drop-down list allows you to choose a a predefined zoom, or type in a user defined zoom value. It also contains options for 
zooming to the page, drawing and selection and returning to the previous zoom. It is available on the control bars and the Zoom 
Tool Infobar and Push Tool Infobar.

The top part of the list shows different percentage magnification (100% is full size)
Page
Drawing
Selected
Previous
Names



 Zoom To Drawing

Zoom To Drawing changes the zoom magnification so your drawing fills the window. See Zooming to the whole drawing for more 
details.



 Zoom To Page    CTRL+SHIFT+P

Zoom To Page changes the zoom magnification so the entire page area is visible in the window. For more information, see 
Zooming to the whole page.



 Zoom To Selection
 CTRL+SHIFT+Z

Zoom To Selection changes the zoom magnification so the selected objects fill the window. See Zooming to the selection for 
more details.



 

 Zoom Tool    ALT+Z or SHIFT+F7
The Zoom Tool allows you to alter the magnification of the current document view. It only affects the view on screen - the 
document itself does not change.

Zoom Tool Infobar Controls
Zoom Magnification

Previous Zoom
Zoom To Drawing
Zoom To Page
Zoom To Selection

Zoom Tool Operations

Returning to the previous zoom

Zooming in and out

Zooming to the selection

Zooming to the whole drawing

Zooming to the whole page

Using the Zoom Tool temporarily

Movie

{button ,EF("XaraDemo.exe","ZoomPan.avi Magnifying and Moving a Document",1,`') } Magnifying and moving 
documents



Zoom to Name

At the bottom of the zoom options is a list of names used in the document. You can select from this list to display the objects using 
that name.



Zooming in and out

You often want to view part of a document in greater detail or view the entire document to see how the complete drawing looks. To 
achieve this, you can zoom in and out of the document. If you want to zoom in on your whole drawing, see Zooming to the whole 
drawing. If you want to zoom in on the selected objects, see Zooming to the selection.

To zoom in or out
1. Choose the Zoom Tool.
2. Either:

to zoom in, click on the document (see less of the document but in greater detail),
or to zoom out, SHIFT-click on the document (see more of the document in less detail),
or to view a specific area, drag across the area.

Tips
Zooming just changes your view onto the document. It does not change the actual size of objects in the document.
You can also zoom in or out using CTRL and '+' or '-' on the numeric keypad. You do not have to be in the Zoom Tool.
The text on the Status Line shows the zoom in and out values. This tells you the effect of a click or SHIFT-click.
You can also choose a zoom value from the Zoom drop-down list on the control bars. (See Zoom Magnification.)
You can easily go back to the last zoom magnification by using Previous Zoom. See Returning to the previous zoom.
If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the 

Zoom Tool temporarily.
If your mouse has a wheel:
click the wheel to center the view around the mouse pointer
or SHIFT-click to zoom out
or CTRL-click to zoom in

or hold down CTRL for variable zoom in (scroll the wheel up) or zoom out (wheel down).

Movie

{button ,EF("XaraDemo.exe","ZoomPan.avi Magnifying and Moving a Document",1,`') } Magnifying and moving 
documents

_______________

{button ,KL(`zooming;tools,zoom tool',0,`____No_Topics_Found',`')}    Related Topics



Zooming to the selection

It is often useful to zoom in on your document so the selected objects fill the document view.
To zoom to the selection

1. Choose the Zoom Tool.
2. Click the Zoom to Selection button on the Zoom Tool Infobar.

Tips
To quickly zoom to the selection, press CTRL+SHIFT+Z
You can also choose Selected from the Zoom drop-down menu on the control bars. (See Zoom Magnification)
The Zoom to Selection button is also on the Push Tool Infobar.
You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the 

previous zoom.
If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the 

Zoom Tool temporarily.

_______________

{button ,KL(`zooming',0,`____No_Topics_Found',`')}    Related Topics



Zooming to the whole drawing

It is often useful to scale your view (zoom) so the complete drawing fills the document view. Zoom To Drawing ignores any invisible 
layers in the document.

To zoom to the drawing
Click the Zoom to Drawing button on the control bars.

Tips
This button is also on the Push Tool Infobar and Zoom Tool Infobar.
You can also choose Drawing from the Zoom drop-down menu on the control bars. (See Zoom Magnification)
You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the 

previous zoom.
If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the 

Zoom Tool temporarily.

_______________

{button ,KL(`zooming',0,`____No_Topics_Found',`')}    Related Topics



Zooming to the whole page

It is sometimes useful to change the zoom magnification so you can see the entire page (or spread) in the document view.
To zoom to the page

1. Choose the Zoom Tool.
2. Click the Zoom to Page button on the Zoom Tool Infobar.

Tips
The Zoom to Page button is also on the Push Tool Infobar.
You can also choose Page from the Zoom drop-down list on the control bars. (See Zoom Magnification)
To quickly zoom to the page, press CTRL+SHIFT+P.
You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the 

previous zoom.
If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the 

Zoom Tool temporarily.

_______________

{button ,KL(`zooming',0,`____No_Topics_Found',`')}    Related Topics



This shortcut has a different action when in the Text Tool - List of Text Tool shortcuts.




